Notation Composer 3
User Guide
# Table of Contents

## Foreword

### Part I Introduction

1. What's New in Version 3
2. Getting Started
   - About the Trial Version of Notation Composer
   - Using Helps Provided in the Documentation and Software
   - Printing This Documentation
   - Installing, Backing up, and Reinstalling Notation Composer
   - Finding and Starting Notation Composer on Your System
   - Setting up Your Default MIDI Playback Device
   - Getting Free Software Updates to Composer
   - Uninstalling Notation Composer
   - Transferring Your Composer License to a Different Machine
   - How to Buy Notation Composer
3. The Purpose of Notation Composer
   - Preparing and Printing Sheet Music from the Internet
   - Studying and Enjoying Music
   - Practicing Music
   - Rearranging Music for Your Particular Instrument
   - Arranging Music According to Your Performance Skills and Taste
   - Arranging Music for Your Group of Musicians
   - Preparing Lessons for Music Students
   - Composing Music
4. Comparison Between Notation Composer and Notation Musician
5. Quick Start Tutorial
   - Tutorial: Opening a File on Your System
   - Tutorial: Playing the Song
   - Tutorial: Using a Playlist of Multiple Songs
   - Tutorial: Correcting the Notes and Accidentals
   - Tutorial: Adding Lyrics
   - Tutorial: Saving Your Work in a File
   - Tutorial: Working with Parts
   - Tutorial: Creating a New Song
   - Tutorial: Adding Notes to a New Song
   - Tutorial: Adding Annotations
   - Tutorial: Viewing and Quantizing the Performance

## Part II Opening, Transcribing, Printing, Playing, and Saving Songs

1. Music File Formats That You Can Use in Composer
2. Opening a MIDI or Karaoke File Already on Your System
3. Opening a MusicXML File Already on Your System
4. Opening Multiple Files at Once
5. Associating Notation Composer with Compatible Filetypes
6. Searching for and Downloading Song Files from the Internet
   - Using Composer's Internet Browsing Window
   - Specifying the Initial Web Page for Browsing
Part III Navigating through Composer and the Score 165

1 Parts of the Composer Window ............................................. 166
   Customizing Colors in Composer ........................................ 167
   Showing and Hiding Parts of the Composer Window .......... 169

7 Transcribing MIDI Files and Recordings to Notation ......................... 91
   Transcription Options ................................................... 94
   Re-Transcribing a MIDI File or Recording ...................... 98
   ReBar: Correcting the Barlines for Files Recorded Without a Metronome ..... 100
     How to Determine a "Metronomeless" File ....................... 101
     Summary of Steps for Correcting Barlines Using the Rebar Feature .... 103
     Using the Rebar Tools to Correct Barlines ................... 104

8 Creating a New Song File ................................................................ 116

9 Creating Your Own Song Templates ........................................... 120

10 Editing the Song Title and Author Information ................................ 121

11 Saving Your Work in a Notation .not ........................................ 121

12 Exporting Your Work in Other File Formats .................................... 122

13 Sharing Your Music With Others so They Can View, Play, and Print Your Songs .................................................................... 128

14 Backing Up Your Work with Automatic Backup ................................ 129

15 Opening a Notation .not File .................................................. 130

16 Viewing Multiple Song Files at a Time ........................................ 131

17 Printing the Score ....................................................................... 132

18 Playing the Song ......................................................................... 134
   Playback Location and Staff Focus Markers ................. 135
   Starting and Stopping Playback .................................... 136
   Fast Forwarding ................................................................. 137
   Using Staff Setup To Change Instruments and Settings .......... 137
   Setting Up the Metronome .............................................. 139
   Jumping to or Previewing Another Location in the Song During Playback ...... 142
   Setting the Focus on a Staff During Playback .................. 142
   Anticipating Page Turns .................................................. 143
   Playing or Ignoring Repeats and Endings ...................... 143
   Highlighting Active Notes and Lyrics ............................... 143
   Turning Off Stuck Notes ................................................... 144
   Viewing and Adjusting the Tempo .................................... 145
   Controlling the Overall Volume Level .................................. 146
   Muting and Soloing Staves .............................................. 147
   Adjusting the Volume Level of Selected Staves During Playback ...... 148

19 Using Playlists (Jukebox) ............................................................. 149
   Organizing Songs in a Playlist ......................................... 150
   Playing Songs in a Playlist ............................................. 152
   Moving Playlists ................................................................. 154

20 Practicing Music with Accompaniment ........................................ 154
   Playing Along with Your MIDI Instrument ...................... 155
   Setting up Practice Loops ............................................... 157
   Starting and Stopping a Practice Session ...................... 159
   Advancing to the Next (or Previous) Rehearsal Mark .......... 160
   Practicing a Part While Singing or Playing a non-MIDI Instrument ...... 160
   Practicing a Part Using Your MIDI Keyboard or MIDI Instrument ........ 161
   Controlling Notation Composer from Your Music Keyboard .......... 163
Part IV  Editing Staves and Formatting Parts  195

1  Understanding Tracks, Staves, and Parts ................................................................. 195

2  Editing Staves ........................................................................................................... 198

   Adding New Staves ......................................................................................................... 198
   Deleting Staves ................................................................................................................ 201
   Editing Instrument (Staff) Names ..................................................................................... 202
   Changing the Instrument Sound of a Staff ...................................................................... 204
   Assigning MIDI Channels ................................................................................................. 209
   Cloning a Staff .................................................................................................................. 210
   Merging Staves ................................................................................................................. 211
   Adjusting Per-Staff Volume Level and Left-to-Right Pan .............................................. 212
   Transposing a Staff ........................................................................................................... 213
   Splitting Staves ................................................................................................................ 213
      Splitting a Staff into Right- and Left-Hand Staves ....................................................... 214
      Splitting the Drum Staff into Individual Drum Staves ............................................... 215
      Splitting a Staff into Melody and Accompaniment .................................................... 217
   Splitting Double-Played Notes from Solo Instrument .................................................. 217
   Rearranging the Order of Staves ...................................................................................... 218
   Shifting Notes Between Staves ......................................................................................... 219

3  Preparing Parts ............................................................................................................ 220

   Automatically Creating Parts ......................................................................................... 221
   Creating a New Part .......................................................................................................... 221
   Selecting a Part .................................................................................................................. 222
   Renaming a Part ................................................................................................................. 223
Part V Editing the Music Notation

1 Basic Editing Procedures ................................................................. 274
   General Method for Adding, Changing, and Deleting Objects .......... 275
   Adding Objects Using Palettes ..................................................... 277
   Selecting One or More Objects Before Editing Them ..................... 278
   Changing Object Properties Using Palettes ................................. 279
   Selecting and Editing Regions of a Score ..................................... 280
   Using the Clipboard ...................................................................... 282
      Copy, Cut, and Paste ............................................................... 282
      Clearing a Region of the Score ................................................ 283
      Creating a New Song from the Clipboard ................................. 284
   Undoing Editing Operations ......................................................... 284
   Recovering Interrupted Song File Editing ..................................... 286

2 Editing Measures .............................................................................. 287
   Inserting and Adding Measures ................................................... 287
Deleting Measures ......................................................................................................................... 288
Splitting Measures ....................................................................................................................... 289
Joining Measures .......................................................................................................................... 290
Creating Upbeat Measures ........................................................................................................... 291
Shifting Barlines ............................................................................................................................ 295
Editing Measure Numbers ............................................................................................................. 296

3 Adding Notes ............................................................................................................................. 297
Adding Notes with the Mouse ......................................................................................................... 298
  Adding Notes with Mouse by Choosing Durations from the Note Palette .................................. 299
  Selecting the Note Duration ........................................................................................................ 301
  Using the Beat Ruler .................................................................................................................. 303
  Adding Notes Using the Sequential Note Entry Mode ............................................................... 305
  Specifying the Stem Direction (Voice) ........................................................................................ 309
  Determining the Pitch of a New Note ......................................................................................... 312
  Determining the Loudness of a New Note .................................................................................. 313
Adding Notes Using Only Your Computer Keyboard .................................................................... 314
Adding Notes Using Your Music (MIDI) Keyboard ........................................................................ 315
  Recording Your Performance at MIDI Keyboard to Enter Notes .......................................... 316
  Adding Notes Using Step-Time Recording Mode .................................................................. 318
  Using Step-Time Recording and Sequential Note Entry Modes Together ......................... 319

4 Selecting, Editing and Deleting Notes ....................................................................................... 323
Alternative Methods for Selecting Notes ...................................................................................... 324
Selecting Notes and Advancing to the Next or Previous Note ..................................................... 325
Automatically Playing Notes When Selected .............................................................................. 326
Deleting Notes ............................................................................................................................... 326
Removing Silent Notes .................................................................................................................. 326
Editing Note Pitch .......................................................................................................................... 327
8va Octaves .................................................................................................................................. 328
Editing Note Accidental (Sharp, Flat, etc.) .................................................................................... 330
Editing the Rhythms of Notes ......................................................................................................... 332
  Editing Note Location (Attack) ............................................................................................... 333
  Editing Note Duration ............................................................................................................. 335
  Editing Triplets and Quintuplets .............................................................................................. 338
  Editing Swing Notation .......................................................................................................... 342
  Combining Separate Notes into Chords .................................................................................. 344
Editing Accent Marks .................................................................................................................... 345
Editing Beams ............................................................................................................................... 348
Editing Ties .................................................................................................................................... 351
Editing the Note Voice (Stem Direction) ..................................................................................... 354
Editing Drum Notes ....................................................................................................................... 355
Editing Notehead Shape ................................................................................................................ 356

5 Transposing Notes .................................................................................................................... 358
Transposing Actual Pitches ............................................................................................................. 360
Transposing to the Key of an Instrument ....................................................................................... 362

6 Doubling and Scaling Note Durations ....................................................................................... 365

7 Editing Rests ................................................................................................................................ 367
Deleting Rests to Extend the Duration of Previous Notes .............................................................. 368
Dividing and Combining Rests ....................................................................................................... 368
Changing the Voice of a Rest ......................................................................................................... 370
Using Rests to Erase Notes ........................................................................................................... 371
Eliminating Small Rests .................................................................................................................. 372
Using Multiple Measure Rests ....................................................................................................... 373
Hiding Rests .................................................................................................................................... 373

8 Editing Grace Notes .................................................................................................................... 375
Understanding the Two Types of Grace Notes .............................................................................. 376
Part VI Editing Types of Text

1 General Procedures for Editing Text

2 Adding Text

3 Editing Text

4 Deleting Text

5 Selecting Font Type, Size, and Properties

6 Moving a Text Object

7 Copying and Pasting Text

8 Showing and Hiding Types of Text

9 Adding International Characters in Text

10 Claude de Boey: A Life in Music

11 Editing Ornaments

12 Adding Ornaments

13 Converting Written-Out Performances to Ornaments

14 Reverting Ornaments to Written-Out Notes

15 Deleting an Ornament

16 Viewing and Editing the Written-Out Performance of Ornaments

17 Editing and Transcribing Trills

18 Editing Turns

19 Editing Mordents

20 Editing Arpeggios

21 Editing and Transcribing Tremolos

22 Changing the Extent or Angle of a Line or Glissando

23 Adding Slurs

24 Dynamic Marks

25 Hairpin Crescendo Marks

26 Special Symbols

27 Slurs (Phrase Marks)

28 Adding Slurs

29 Deleting a Slur

30 Changing the Shape and Extent of a Slur

31 Lines and Glissandos

32 Adding Lines and Glissandos

33 Deleting a Line Or Glissando

34 Changing the Extent or Angle of a Line or Glissando

35 Sustain Pedal Marks

36 Converting Pedal Performance to Pedal Marks

37 Converting Pedal Marks to Pedal Performance

38 Notation Composer 3 User Guide
Part VII  Recording from a Music Keyboard  499

1  Setting Up Your Music Keyboard................................................................. 499
2  Recording in Step-Time.............................................................................. 500
3  Setting the Tempo for Real-Time Recording with a Metronome................. 501
4  Setting Up Pickup Beats.............................................................................. 503
5  Recording Without the Metronome.............................................................. 503
6  Setting the Instrument Sound for Recording............................................... 505
7  Setting Up Transcription Options for Recording......................................... 506
8  Starting and Ending the First Recording (Using the Metronome).................. 507
9  Recording Into a Selected Region (Punch-In)............................................. 508
10 Recording from a Keyboard with Two Hands............................................. 509
11 Recording Multiple Alternative Takes......................................................... 510
12 Recovering an Interrupted Recording......................................................... 511
13 Cleaning up the Performance and/or Notation after a Recording............... 511

Part VIII  Viewing and Editing the Music Performance  513
# Part IX Configuring Your Soundcard and MIDI Equipment

1 Notation Software Internal Synthesizer .......................................................... 587

2 Quick MIDI Device Setup .................................................................................. 593

3 What To Do If You Hear Static or Crackling ....................................................... 598

4 What To Do If You Do Not Hear Any Sound ....................................................... 598

5 What To Do If Recording Does Not Work .......................................................... 602

6 Procedures for Common MIDI Configuration Tasks ........................................... 606

   Assigning Device Names That Make Better Sense to You ................................ 606

   Changing the Default Playback Device ............................................................. 609

   Installing a USB or MIDI Cable Between Your Soundcard and Keyboard ....... 611

   Adding a New MIDI Keyboard to Your Configuration ....................................... 615

   Deciding Whether or Not Your Keyboard Should Directly Produce Sound ..... 615

7 Procedures for Advanced MIDI Configuration Tasks ......................................... 619

   Installing a Software Synthesizer ..................................................................... 619

   Preparing Bank, Patch, and Drum Note Names for a MIDI Device .................. 619

      Adjusting for the Delay of Some MIDI Output Devices ............................. 621

   Configuring a New External MIDI Output Device ............................................. 623

   How to Handle Devices Connected with MIDI Thru Cables ............................. 627

   How to Save Effort If You Rearrange Your MIDI Equipment Often ............... 628

8 Using the MIDI Device Configuration Window .................................................. 629

   Understanding the Details of the MIDI Device Configuration Window .......... 630

      Understanding Ports and Devices in the MIDI Device Configuration Window 630

      Common MIDI Device Configurations ......................................................... 633

      Recording Indicator in the MIDI Device Configuration Window .................. 637

      Menus in the MIDI Device Configuration Window ....................................... 637

      Testing Playback and Recording Devices .................................................... 637
Managing MIDI Ports ........................................................................................................................................ 638
    Connecting and Disconnecting Devices from an External Port............................................................... 639
    Specifying Whether a Port Is Internal or External................................................................................. 639

Managing MIDI Devices ................................................................................................................................ 640
    Importing from a MIDI Device Description (.mdd) File........................................................................ 641
    Importing from a Cakewalk Instrument Description (.ins) File............................................................. 643
    Adding an External Device....................................................................................................................... 646
    Removing a Device................................................................................................................................. 647
    Renaming a Device................................................................................................................................ 648
    Specifying Properties of a Device.......................................................................................................... 648
    Specifying the Default MIDI Output Device.......................................................................................... 652
    Specifying a General MIDI (GM) Device............................................................................................... 653
    Tuning a Device to Specific MIDI Channels........................................................................................... 655
    Exporting to a MIDI Device Description (.mdd) File............................................................................ 657

Assigning Bank, Patch, and Drum Note Names to a MIDI Device................................................................. 658
    Assigning a Bank to a MIDI Device......................................................................................................... 660
    Removing a Bank from a MIDI Device..................................................................................................... 661
    Assigning Patch Names for a MIDI Device or Bank of a Device.......................................................... 662
    Managing Drum Note Lists..................................................................................................................... 663

Managing Alternative MIDI Device Configurations ...................................................................................... 669
    Saving a Configuration............................................................................................................................ 669
    Selecting a Configuration......................................................................................................................... 669
    Creating a New Configuration.................................................................................................................. 670
    Re-Initializing a Configuration.............................................................................................................. 670
    Cloning a Configuration.......................................................................................................................... 670
    Renaming a Configuration...................................................................................................................... 670
    Deleting a Configuration.......................................................................................................................... 671
    Restoring A Configuration...................................................................................................................... 671

Part X Band-in-a-Box® Plugin: Summary and QuickStart ........................................................................... 672

1 Using the Band-in-a-Box® Plugin to Generate
    Auto-accompaniment ............................................................................................................................. 673

Part XI Appendices........................................................................................................................................... 685

1 Appendix A: Notation Composer Keyboard Shortcuts................................................................................ 685
2 Appendix B: What is MIDI? ....................................................................................................................... 692
3 Appendix C: Technical Support ................................................................................................................ 693
4 Appendix D: Notation Composer License Agreement .............................................................................. 694
5 Appendix E: 3rd Party Libraries and Acknowledgements ......................................................................... 702

Index ................................................................................................................................................................ 705
1 Introduction

Welcome to Notation Composer!

In this documentation we will refer to this music software program as Composer for short.

Composer is a tool for creating and arranging music—both the sound and the printable notation. You can create music with your mouse and keyboard, or by recording from a music keyboard connected to your computer. Composer helps you find and download MIDI (.mid) and Karaoke (.kar) files from the Internet, and converts them to sheet music with amazing accuracy. You can use MIDI files that you find on the Internet as a starting point for preparing arrangements that suit your musical tastes, your playing ability, or the membership of your band or choir. You can print the music you have created or imported, view it on the screen, and sing or play along with it as the score is played. You can also extract particular parts for performers in your ensemble.

You likely will be able to learn how to use most of Composer’s features by simply trying out menu commands and clicking buttons here and there. However, for a quick start in learning how to use Composer, we recommend going through the Quick Start Tutorial.

TIP: The most important tip we can offer you for getting started with Composer is to have fun exploring it! Explore Composer’s menus, toolbar, and palettes by clicking items to learn what happens. If you do not like a result, you can always undo it.

Composer has a large number of options, but they are well organized to help avoid overwhelming you. You probably won’t need all of the features of Composer. Don’t worry that you’re not using all of the features and options. When you accomplish your musical goals with Composer, and have fun doing so, then you will have taken full advantage of Composer. Many unexplored features of Composer will remain waiting for you for a later project!

For information about Notation Software Germany GmbH, our Privacy Policy and Disclaimer, please visit our Imprint Page.

1.1 What’s New in Version 3

The following new features and improvements are included in Notation Composer version 3.

MusicXML Import and Improved Export Support

- MusicXML import (File/Open) and export (File/Export) is now supported for filetypes .xml, .musicxml, and .mxl (compressed MusicXML). Please note that due to the dynamic nature of the MusicXML protocol, not all features for score annotations are available as yet, but we will continue to work on these different aspects of the MusicXML protocol set as they are solidified in the MusicXML community. See the section on MusicXML for details. Composer has the fastest and cleanest MusicXML import and export of any music notation software product with this feature set.

Sound Enhancements

- Notation Software Synth - an internal sound synth using a General MIDI (GM) soundfont to guarantee sound on any machine. Composer allows you to select the GM soundfont you would like to use for your sounds, and now includes SF2 and SF3 capability.
- Export Audio files as .WAV, .MP3, .OGG, or .FLAC - lets you export an audio version of your arrangements and compositions to share with others.
- ASIO driver support, eliminates latency (delay) issues. Selecting the ASIO driver and the Notation Software Synth for playback and recording assures you of good sound and no latency for more accurate recording and transcription.
• Sounds of original imported MIDI files supported, especially useful for devices that use specific extended bank voices.

• Recovers "select" sound sets from original MIDI files created using device-specific banks and instrument patches. If you have a Yamaha (or other keyboard/synthesizer/library) that generates files with special sound sets, Notation Composer can now find and preserve those special sounds, even from older saved .not files, and put them back in so that your songs sound great when you play them, or when you export a MIDI (.mid) file to play on your keyboard or other device.

**Band in a Box® plugin**

• A plugin for Band in a Box® is available as an additional license purchase for notation composer. The plugin will automatically generate accompaniment for your song using the chord names in the song, allows multiple "takes", and integrates them with tools already available in notation composer. The trial version has 25 styles; the fully purchased version has 150 styles, as well as the capability to use styles you may already have or acquire.

**Direct Image Export**

• Specific pages or the entire score can be exported as High Resolution image files for use in other documents. BMP, PNG, JPG, and GIF export are supported (.gif is not available yet for Mac and Ubuntu systems).

**Direct PDF Export**

• Notation music sheets can be exported directly using our High Resolution PDF Export for crisp notation sheets.

**More Language Versions**

• Now available in German and Spanish versions.
• QuickStart Guides available for each language version.
• German version uses German style notation.
• A German version of the website is also in place to support German-speaking/reading customers.
• A flexible upgrade path to switch the language variant of the software when upgrading your product.

**New platforms supported**

• Mac - Founded on the Wine HQ environment, the latest version is enhanced to provide the best experience on Apple MACs. See our MAC installation guide at [www.notation.com/MAC.php](http://www.notation.com/MAC.php)
• Linux's Ubuntu and openSUSE are now supported, also founded on the WineHQ environment. See our Ubuntu installation guide at [www.notation.com/Ubuntu.php](http://www.notation.com/Ubuntu.php)

**Detection of Modern Keyboards**

• Modern keyboards today have a certain structure through their USB interface. Version 3.0.2 and later detects those accurately.

**Improved User Interface**

• More streamlined user interface for fast and effective work with the software
• Better feedback for correcting musical problems with song files
• Enhanced color scheme

**Yamaha XF Chord Format Support**
• **Full implementation of Yamaha’s XF format for chord names**, both for importing from .mid files and exporting to .mid files.

**Chord Name Enhancements**

• Chord names are compared to the underlying notation and checked for validity. Chord names that are "suspect" are marked for easy correction using the Chord Name tools.

• MusicXML export of chord names

• Verification of chord name compatibility with different MIDI export filetypes and for the Band in a Box® plugin.

**MIDI Device Configuration Manager (DCM) Enhancements**

• Improved interface for easier access and use

• New folder structure for saving and restoring backup configuration files

**MIDI Enhancements**

• GraphOverNotes - better integration with Staff Setup

**Quality and Security Initiative**

• Many bugs corrected in Version 3

• Security enhancements to protect users who purchase a license

• **Easy installation procedure with "Readme" guides**

• Easy update process for free updates

• Easy restoration later if a problem should occur requiring reinstallation of the software.

• Improved service support with real-time logging and fault diagnosis for better customer service

• Backup installation is saved in a zip folder for easy user storage and recovery.

**Technology**

• Enhanced User Interface libraries from Microsoft, Inc. and FOSS Software, Inc.

• New user-friendly grids using the modern grid technology of Ultimate Grid

• Version 3 has been developed with Microsoft's modern development environment to provide support for future operating systems

• **ASIO** integration for better visual and sound experience.

**Tutorial Videos**

• **Tutorial videos** are available on the website to help you get going fast

### 1.2 Getting Started

If you have already successfully installed Composer, and are already comfortable using this documentation, you might want to skip this Getting Started section. Before beginning the **Quick Start Tutorial**, you might find it helpful to read about **The Purpose of Notation Composer**, so that you will have a better idea about what you should expect in this music software.

This Getting Start section offers the following introductions and instructions:

- About the Trial Version of Notation Composer
- Using this Documentation
1.2.1 About the Trial Version of Notation Composer

The trial version of Notation Composer is functional for 30 days from the installation date. The trial version offers all features of Composer available in the full version, except printing and saving files.

To determine what version you are using of Notation Composer, choose the About command from the Help menu. A window will display the Notation Composer graphics logo and the version number of Composer. This window also displays "Trial Version" if you are using the trial version rather than the full purchased version of Composer.

With the trial version of Composer you can edit the score and play it back, work with the practice features, and see how it can help you with your music.

If you have enjoyed using the trial version of Composer, we hope you will consider purchasing the full version of the software, which removes the 30-day trial period limitation and allows you to save and share your work. To purchase the full version of Composer, please visit our website at www.notation.com/Buy.php to review your options.

1.2.2 Using Helps Provided in the Documentation and Software

This Composer documentation is organized according to tasks that you can do, and will want to learn about, in Composer rather than "reference" documentation, which is organized according to the structure of the software program--menus, toolbars, dialog boxes, etc. We hope this helps you get things done quicker.

To learn how to accomplish a certain task:

   In Help/User's Guide:

   - You will see the Table of Contents on the left side of the help window. Navigate through the Table Contents until you find the category and sub-category of documentation that is relevant to your need
     -- OR --

   - (Better) Click on the Index or Search tab in the left side of the help window. If you are interested, for example, in help topics that specifically focus on preparing piano scores or parts, then look up "piano" in the Index, or use "piano" as the keyword for Search.

To learn about a particular menu item:

- While holding the mouse over the menu item, hit the F1 key. Composer will display this help window, presenting the topic that describes the situations in which you might want to use that menu command, and the overall procedures in which you would use that command.

To learn about a button or control in the main toolbar or a button in one of the palettes:

- While holding the mouse over the button or control, hit the F1 key.
To learn about the details of a dialog box:
- Click the Help button in the dialog box.

To learn about keyboard shortcuts in Composer:
- See Appendix A: Keyboard Shortcuts.
- You can find out what the keyboard shortcut for a command is by placing the mouse over the menu item or palette button, and Composer will display a tip describing the command and its keyboard shortcut.

1.2.3 Printing This Documentation

If you would like to print out portions of this documentation then we suggest that you download the documentation available in Adobe Acrobat PDF file format. You can then use your favorite PDF reader or editing program to print out the pages you would like. Alternatively you can purchase a bound book copy of this documentation.

1.2.4 Installing, Backing up, and Reinstalling Notation Composer

You may have received the installation file for Composer either via download from the Internet or on a CD-ROM. Either way, the setup program will be named something like Inst_NS_Composer_3_English.msi.

The number "3" in the setup file name represents the Composer version number 3.0. Newer versions of the Composer software and setup program might be released before this documentation is updated. In that case, the number in the setup program might be something like "302" for Composer version 3.0.2.

Installing on Windows

The following three platforms require Wine HQ to be installed first, and which you can download directly by clicking here.

Installing on a Mac
Installing on Ubuntu
Installing on openSUSE

For all installations you should be sure to backup your installation immediately after installing the software. In the event that your computer should suffer any disruption that causes you to lose the functionality of the software you can then use the backup that you made to reinstall the software and get going again quickly.

For Windows machines

To install Composer using the installation file downloaded from the Internet:

We strongly encourage you to select "Download" and not "Run" when downloading the software.

After downloading the installation file simply double-click it to begin the installation.
If you did not immediately run the setup program after downloading it, then you will first need to find it on your system. One way to do this is as follows:

1. At the lower, left corner of the screen, click the Windows button:

   OR

2. In the Search field, type in the word "Composer".

   Windows will find NotationInst_NS_Composer_3_English.msi file in your Internet download directory, and display it in the right panel of the Search Results window.

3. With the mouse, double-click the name of the found file. That will start the setup program.

4. Follow the steps in the Notation Composer setup program. These will include entering your registered name, email address, mailing address, and your license number.

5. IMPORTANT: We recommend that you restart Windows after finishing the installation. It might not be necessary for you to do this. But if you have any problems initially running Composer after installing it, then it is highly recommended that you restart Windows.

To start Composer installation from the CD-ROM:

1. Insert the Notation Composer CD-ROM into your computer's CD-ROM drive. Normally the setup program will start automatically.

2. If the setup program does not start automatically:
   (a) At the lower left corner of the screen, click the Windows button:

   OR

   (b) Choose (or type) "Run".

   (c) In the Run dialog, type "D:\setup.exe" if your CD-ROM is the "D:" drive. If you do not know the drive letter for your CD-ROM, then click the Browse button to find letter for your CD-ROM drive.

3. Follow the steps in the Notation Composer setup program. These will include entering your registered name, email address, mailing address, and license number. It is probably a good idea to have your receipt email handy so you can simply copy/paste this information into the fields and avoid any problems.

4. IMPORTANT: We recommend that you restart Windows after finishing the installation. It might not be necessary for you to do this. But if you have any problems initially running Composer after installing it, then it is highly recommended that you restart Windows.

Always backup your installation:

When you first install Notation Composer using either method above, or when you update your software, the installation file creates a backup installation folder. In the event that you have a problem with your machine (e.g. a viral infection which has to be cleaned up, a hard drive crash, etc.) which requires the re-installation of your software, you can use this folder of files to reinstall the software on the same machine. Therefore, we strongly recommend that you make a copy of this folder and save it in a safe location (e.g. memory stick, external hard drive, etc.)

1. Use Windows Explorer to navigate to the folder C:\Users\Public\Documents\Notation_3\Composer_3\Installation For systems that use the WineHQ paradigm, this folder will be located within the "Wine" folder on your machine.
2. Copy the entire "Installation" folder to a backup drive or other secure media backup that you may have. Alternatively, you can make a copy to a CD or DVD disc if your machine has the capability to "burn" CDs or DVDs. You may also wish to copy the MidiDev_Config folder or other files that are contained here if you have a complicated MIDI Device Configuration that you want to preserve in case of problems later.

To reinstall the software on the same machine:

1. If you find that you need to reinstall the software on the same machine that you originally installed it on, you can use the backup that you created above. Copy the entire "Installation" folder that you saved in the steps above to your computer's hard drive.

   IMPORTANT: the files
   
   o Inst_Notation_Composer_3_English_Backup_303.zip (or whichever language and version variant you have)
   
   o Notation_Installation_LOG.log
   
   both need to be located in the "Installation" folder on your hard drive for reinstallation to be successful!

2. Unzip the file Inst_Notation_Composer_3_English_Backup_303.zip to its own folder within the /Installation folder.
3. Follow the instructions in the "Read_me_to_reinstall_Notation.txt" for the reinstallation.

4. In the folder "Inst_NS_Composer_3_English_Backup_303" is a file named "Installation_Notation_Composer_3_English.msi" - double-click the filename to start the reinstallation.

5. Run Notation Composer to make sure that everything has reinstalled correctly.

If you wish to transfer your license to a different machine:

Please use the form at our website to Request a Redownload.

1.2.5 Finding and Starting Notation Composer on Your System

Once you have installed Composer, there are a couple of ways you can start the program.

On most systems you can simply double-click the Composer icon Composer 3 on your desktop to start the program.

To start Composer from its Windows program folder:

1. At the lower left corner of the screen, click the Windows Start or Home button:

2. In the Start menu, choose Programs, or type "Composer" in the search field. A submenu with various programs on your system will be listed, or a list with your search results will show Notation Composer 3, which you can just click and start enjoying the software.

3. If you're using the submenus, then in the submenu, choose Notation Composer. A second submenu will be displayed, showing various tools available for Composer.

4. Select Notation Composer from the submenu:
Alternatively, just double-click the Composer icon on your desktop to start the program.

▶ To start Composer on a Mac:

Double-click the Composer icon on your desktop to start the program.

▶ To start Composer on Ubuntu:

Simply double-click the Composer icon on your desktop to start the program.

▶ To start Composer on openSUSE:

Simply double-click the Composer icon on your desktop to start the program.

1.2.6 Setting up Your Default MIDI Playback Device

Beginning with the version 3.0.3 release, the default MIDI playback device is the Notation Software Synth. Unless you have other “specialty” synths or sound libraries, or an external unit you want to use for playback, you won’t need to read any further in this section.

If you have a previous version of Composer the default device was the GS Wavetable Synth. This synth is turned off by default with later releases of Composer because many later Windows operating systems do not have the synth. If you would like to turn the GS Wavetable Synth back on, please see GS Wavetable Activation.

However, your computer may have more than one MIDI device that can be used for listening to your files. You will be able to hear the difference in how one MIDI device versus another plays, for example, a grand piano sound.

A MIDI device can be “software synthesizer” on your system, or a physical device, most commonly an external MIDI keyboard that is connected to the computer via a MIDI cable or USB cable.

The Quick MIDI Device Setup command in Composer’s Setup menu offers you an easy way to choose the default MIDI device that will be used for playback.

Most MIDI devices offer a list of 128 different instrument sounds, and certain drum sounds, which together are called the "General MIDI" sounds. Many MIDI devices also offer one or more additional "banks" of sounds, where each bank can have up to 128 sounds. If your MIDI device has additional banks of sounds besides General MIDI sounds, you can also use the Quick MIDI Device Setup command to inform Composer about what particular MIDI device manufacturer and model you are using. With that information, Composer lets you select instrument sounds by meaningful names, such as "pizzicato violin" instead of MIDI "patch" numbers.
To set up the default MIDI playback device in Composer:

1. In the Setup menu, choose the Quick MIDI Device Setup command.

   -- OR --

   Type “qqds” for (Quick command) quick device setup.

Composer will display the Quick MIDI Device Setup dialog box:

![Quick MIDI Device Setup dialog box]

2. Select one of the MIDI playback devices in the list.

   To use an external MIDI device that is connected to your system via a MIDI cable or USB cable, select a MIDI device that has "MIDI Out" or "Out" in its name.

3. To test the sound for the selected playback device, click the Test Playback button.

   Composer will display and play a 12-note chromatic scale. The notes will be highlighted as they play. Also, the green playback indicator in the Quick MIDI Device Setup window will display a bright green color as the notes are played. Upon completion of the playback, Composer will close the window that displays the notes.

   If the device is an "internal" device on your Windows system, then you should hear sound through the speakers connected to your sound card. If the device is "external", such as a MIDI keyboard capable of producing its own sound, then you should hear that device play the sound.

4. If you do not hear sound for a device when you choose the Test Playback option, then some possible explanations and remedies are discussed in What To Do If You Do Not Hear Any Sound.

5. Click the OK button when you have selected the desired playback device.

6. After you click OK, if you have already opened a song, Composer will display a simple dialog box that offers you the option to reassign all of the staves of that song to the newly assigned default device.

If your MIDI device has additional MIDI sound banks besides the General MIDI sounds, then it is a good idea to import the sound names, as described in the next procedure. Once you have done this, you can refer to instrument sounds according to names, such as "pizzicato violin", rather than MIDI patch numbers.

You can import instrument sound names from either of two types of files: (1) a Cakewalk Instrument Description (.ins) file, or (2) a Notation Software MIDI Device Description (.mdd) file. The .ins and .mdd
Notation Composer 3 User Guide

files are available at the web site of, respectively, Cakewalk and Notation Software, as described in the procedure below. An .ins or .mdd file usually is named according to a MIDI device manufacturer’s name, as in yamaha.ins or roland.ins. The file typically has descriptions for several MIDI device models offered by the manufacturer.

To set up sound names for a device that has additional MIDI sound banks besides the General MIDI sounds:

1. Find a Cakewalk .ins file for the manufacturer of your MIDI keyboard or device from our collection in our User Forum’s "Instrument Definition" list.
   -- OR --
   Find a file using your internet browser and searching for "INS" and the name of your device.

2. In your Internet browser, download the .ins or .mdd file to a directory that you can easily remember.

3. In the Quick MIDI Device Setup dialog, select a MIDI output port under Select MIDI Playback Device.
   A MIDI output port will include "MIDI Out" or "Out" in its name. If your device is connected via a USB cable, then the MIDI output port will also have "USB" in its name.

4. Click the Import Sound Names button.
   Composer will display the Import Sound Names from File dialog box:

   ![Import Sound Names from File dialog box]

   5. In the dialog box, navigate to the directory where you downloaded the .ins or .mdd file, and select the file. Click the Open button.
Composer will display the Select Manufacturer and Model dialog box:

![Select Manufacturer and Model](image)

6. Select your particular manufacturer / model in the list, and click the OK button.

Composer will then return you to the Quick MIDI Device Setup dialog box.

7. Click the OK button in the Quick MIDI Device Setup dialog box.

To reactivate the GS Wavetable Synth:

Important note: If you want to playback with or record into Composer using your MIDI instrument, do NOT enable the Microsoft GS Wavetable. It interferes with the ASIO drivers that are used to reduce latency (delays) in the sound you hear when playing your keyboard. We encourage you to use the built-in Notation Software Synth as your default playback device, or any other ASIO-enabled device, to avoid latency issues when playing along with or recording into Composer.

1. Run Composer and click "Setup / MIDI ... configuration."

2. Now click "Device" in the menu heading, and "Enable Microsoft GS Wavetable Synth" at the bottom of the menu list.

3. A dialog box telling you that the change will take effect when you restart the software will come up. Click "Ok."

4. Exit the program and restart it for the change to take effect. The GS Wavetable will now show up in your MIDI playback devices list.

1.2.7 Getting Free Software Updates to Composer

From time to time, Notation Software provides free updates to the Notation Composer software. These updates offer new features, usability enhancements, and bug fixes.

If you have an Internet connection, it is easy for you to find out whether there is a free software update and then immediately download and install it.
To review the feature enhancements and bug fixes available in recent Composer software updates:
1. Click on Help / Software Updates
2. Click the link for "Review Update":

That will take you to a page at Notation Software’s web site where you can review descriptions of recent feature enhancements and bug fixes in Composer.

To check on updates/upgrades for Notation Composer and to download and install it:
1. Click on Help / Software Updates
2. Click the link for "Upgrade/Update Assistant":

Composer will display the Web Upgrade/Update Assistant window.
3. The Web Update Assistant will inform you whether an update for Composer is available. If so, just follow the instructions on the page to receive your download link.
4. Upon completion of the update, the program will offer you the option to immediately restart the newly updated Composer software.

1.2.8 Uninstalling Notation Composer

To uninstall Composer:
1. If the Composer program folder is on your Windows desktop, simply click the Uninstall Composer icon in that folder.
   -- OR --
2. In the Windows Start menu, navigate to the Composer Uninstall program and run it, as follows:
   (a) Click the Windows Start button at the bottom left corner of the screen. Windows will display the Start menu.
   (b) In the Start menu, choose Programs.
   (c) In the Programs submenu, choose Notation Composer.
   (d) In the Notation Composer submenu, choose Uninstall Notation Composer.
   -- OR --
3. Use the Remove option of the Windows Control Panel as follows:
   (a) Click the Windows Start button at the bottom left corner of the screen.
   (b) In the Start list, select the main Settings option. On Windows 7, Vista, XP, 2000, Me, or 98, choose the Control Panel sub-option.
In the Control Panel folder, choose Add/Remove Programs.

Scroll down in the list of currently installed programs on your system to the entry for Composer.

Click the Add/Remove button to remove Composer from your system.

1.2.9 Transferring Your Composer License to a Different Machine

Composer's licensing agreement states that one license is for one machine. If you wish to have multiple licenses, please contact Support at support@notation.com for help in purchasing a second license.

If you wish to transfer your license to a different machine, please follow the next steps.

To transfer your license to a different machine, simple click on Help -> Transfer license to another computer.

The software will walk you through the process of the transfer process.

1.2.10 How to Buy Notation Composer

We will be delighted if you choose to purchase Notation Composer. Your purchase will support our dedicated efforts to continue developing and supporting this software.

To review the price of Notation Composer and purchase it please visit us at www.notation.com/Buy.php

1.3 The Purpose of Notation Composer

Notation Composer is a software tool that offers you an efficient and enjoyable way to prepare music-- both the sound and the notation-- for your own use, for performance by other musicians, and for visually interactive listening.

Although ”Composer” is in the name Notation Composer, using it as a tool for composing is just one of several ways that Composer can help enrich your musical creativity.

With Notation Composer, you can:

- find music (MIDI) files on the Internet and convert them to printable sheet music
- study and enjoy music
- practice music on your instrument or practice singing
- arrange music for your particular instrument
- arrange music that matches your performance skills, voice range, or stylistic taste
- arrange parts to match the makeup of your group of performing musicians
- if you are a music teacher, prepare lessons for your students
- compose music and write songs from scratch
- save audio files to share with others for practice or enjoyment

1.3.1 Preparing and Printing Sheet Music from the Internet

You can use Notation Composer to prepare and print sheet music that it helps you find on the Internet:

- Use Composer’s built-in Internet browser and directory of MIDI file web sites to search the Internet for a MIDI file of the music you want.
When you find the MIDI file at a web site, click its name, and Composer will download it and open it as sheet music.

- Print the sheet music.
- If the music is for multiple instruments or voices, extract the parts and print them individually or all together with one command.

### 1.3.2 Studying and Enjoying Music

Composer adds an extra visual dimension to your study and enjoyment of music. Whatever song or piece of music you are interested in, you will likely be able to find it as a MIDI file on the Internet. Download it using your favorite browser and open it in Composer, or use Composer’s built-in Internet browser.

When you open the MIDI file in Composer, it will immediately display the sheet music. Although with Composer you can change the notes or any detail of the music or notation, in many cases you might just want to use Composer as a tool for visually studying and enjoying music as it plays:

- You can easily follow the music as it plays because a blue vertical cursor shows the current playback position, and actively playing notes are highlighted.
- Slow down the music so that you can hear the details of rhythms.
- Select a particular instrument and increase its volume level, so that you can focus on the role of that instrument in the harmony and orchestration.

If you have never followed a score while listening to music, Composer might open up a whole new way for you to enjoy and experience music, with your eyes as well as your ears.

### 1.3.3 Practicing Music

You can use Composer as a tool for practicing on your instrument or with your voice in several ways:

- Play along with your acoustic instrument, or sing along, as you read the notes from your part on the screen.
- Let Composer play the accompaniment for other instruments.
- Slow down the tempo when you are first learning the music.
- Temporarily increase the font size of the notes so that you can comfortably read them.
- Turn off the volume (that is, "mute") the part that you are performing, so that only your "live" performance is heard.
- Let Composer automatically turn pages for you.
- Set up practice loops. You can specify:
  -- the number of lead-in measures
  -- the range of measures in the loop, or the starting and ending rehearsal marks
  -- how many times the loop should repeat
  -- how much the tempo should increase in each repeated loop

### 1.3.4 Rearranging Music for Your Particular Instrument

Sometimes you might find a MIDI file that has approximately the right notes, but they are not arranged well for your particular instrument. You can use Composer to rearrange the music to meet the requirements of your instrument:
Transpose the notation according to the key of your instrument. For example, if your instrument is a Bb clarinet, transpose the shown notes up a whole step, so that a 'C' in the score is heard as the Bb a whole step below.

- Transpose the actual pitches up or down to fit within the range of your instrument.
- Change the pitches of individual notes to stay within the range of your instrument, or to avoid awkward fingerings.
- Prepare a piano reduction of an ensemble or choral score.
- Prepare fake book lead sheets for guitar or keyboard. Composer automatically analyzes the harmonies of the song for chords and displays them.

### 1.3.5 Arranging Music According to Your Performance Skills and Taste

When you find a MIDI file for the music you want to learn, the notes might not be arranged exactly as you want them. Perhaps the arrangement is too demanding on your skills as a musician. Or the other way, perhaps the arrangement is too simple, and you want to "jazz it up".

With Composer, you can quickly rearrange the music to meet your needs. It is easy and fun to add and change notes.

After you have rearranged the music, you can play it back to hear whether it is the way you want to learn to perform the music yourself. Then print a copy of your arrangement so that you can practice and study it away from the computer. Or practice along with accompaniment by Composer as it plays the other parts.

### 1.3.6 Arranging Music for Your Group of Musicians

If you are responsible for finding arrangements for your group of musicians, then you likely have discovered that it is difficult to find arrangements that exactly match the makeup of your group. There are several ways that you can use Composer to arrange parts that match the number of musicians in your group, the instruments they play, their voice ranges, and their skill levels:

- Start with a MIDI file for the music. Some parts might already be a good match for the players in your group.
- Copy one part to create a second doubling part for another instrument voice.
- Consolidate two parts into one part, and delete the least important notes.
  -- OR --
- Create an extra part from scratch to supplement the conductor's score and parts that you purchased from a sheet music dealer.

### 1.3.7 Preparing Lessons for Music Students

If you are a music teacher, then Composer is an excellent tool for preparing customized lessons for your students:

- For beginning students, create music exercises from scratch, according to your own teaching methods.
- Start with an arrangement that is close to what you want to offer to your students, but rearrange it so that it better matches the playing level and musical tastes of your students.

  The arrangement that you start with might be a MIDI file that you find on the Internet. Or, you might start with some already printed sheet music that, if you have music keyboard skills, you can quickly play into Composer in real-time or step-time.

- Add annotations to the music such as fingerings, rehearsal marks, and textual instructions such as "play evenly here".
1.3.8 Composing Music

Notation Composer is an ideal tool for composing. Whereas most music notation programs focus on the printing aspect of music that has already been composed, Notation Composer focuses on the actual activity of composing and arranging music. Notation Composer offers many ways that you can quickly record or enter the notes of your musical ideas. In a rapid interactive process, you can improvise musical ideas on your music keyboard, or enter the notes on the screen. Then, immediately play back your work in progress, and refine your musical ideas with convenient editing tools.

Here are some typical steps you might take in composing or arranging music with Composer:

- Create a new song file, with a specified meter, and instrument sound.
- Set the tempo for the final performance speed. You can temporarily adjust the tempo to a slower value (as a percentage of the normal tempo), if you want to record at a slower pace.
- Set the metronome sound, or turn off the metronome if, for example, you have already laid in the percussion staff.
- Start recording. Improvise your musical ideas at a music keyboard, or on your MIDI guitar or other MIDI input device.
- Stop recording. Composer will immediately transcribe your performance to notation, using the best MIDI-to-notation transcription available in any music software.
- Play back your improvisation to hear which parts you want to keep and which parts you want to discard.
- If desired, completely record a section as another "take" on top of the previous one. If you want to go back to the previous one, use the Undo command.
- If desired, save multiple takes on additional staves that you can clone from the recorded staff with a single Clone Staff command.
- If you want to change just a section of a part, then select that region of the score with the mouse, and then "punch in" a new recording for just that section.
- If you do not have keyboard skills to improvise the music live, then use the Step-Time Entry Method, where you can quickly enter notes from your music keyboard at your own pace.
  -- OR --
  With your mouse, add notes on the screen. With the Sequential Note Entry Method, you will usually not have to choose a note duration before you add the note with the mouse. When you add a second note, the duration of the first note will be automatically adjusted to end at the beginning location of the second note.
- Copy and paste one section of the song to another, and to other staves.
- Correct individual notes that you performed with an unintended rhythm or pitch, and delete unwanted notes.
- Build up the song with multiple instrument staves. While you record the part for a new instrument, let Composer play back the already recorded instrument parts as accompaniment.
- Use the Band-in-a-Box® plugin (available as a separate license purchase) to create accompaniment parts. The Band-in-a-Box® plugin has a wide variety of music styles to select from, and you can easily try out different styles, and "mix and match" different instruments from different "takes" to create your own unique composition.

After you have prepared a rough draft of the composition or arrangement, you can refine the performance in many ways:

- Change the exact timing (attack and release times) of individual notes, or several at a time.
- Change the exact loudness of individual notes.
- Mix the volume and pan levels of staves throughout the song.
- Edit the tempo throughout the song with graphical drawing tools, or numerically.
- Add or edit pitch bends, sustain pedal on/off events, and other MIDI controller events, using intuitive graphs that are drawn on top of the notes.

You can also refine the printed score in many ways:
- Add lyrics.
- Add annotations, such as accent marks, dynamic marks, hairpin crescendo marks, tempo marks, free text, and slurs (phrase marks).
- Format the score with choices for:
  -- font faces and sizes for different types of annotations
  -- page size and margins
  -- page title, header, and footer
  -- horizontal and vertical spacing
  -- line (system) breaks and page breaks
  -- formatting templates that you can prepare for reuse
- Produce individual instrument or vocal parts. Extracted parts are always kept fully integrated with the conductor’s score, so that changes in either an extracted part or the conductor’s score are always faithfully replicated in the other.

1.4 Comparison Between Notation Composer and Notation Musician

The following chart compares the purposes and features of Notation Composer and Notation Musician. For ordering and pricing information for these two products, see [How to Buy Notation](#).

<table>
<thead>
<tr>
<th>Purpose and Features</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download MIDI files Internet and transcribe them to sheet music that you can print or view on the screen as the notes play.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Search the Internet for MIDI files, download, and unzip them using a built-in Internet browser.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transcribe MIDI file to sheet music with excellent accuracy, including detection of swing rhythms, grace notes, trills and tremelos.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Correct any errors that might be made in the transcription of the note rhythms.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically analyze and display chord names.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enjoy and study the music notation a song as it plays.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Purpose and Features</td>
<td>Notation Musician</td>
<td>Notation Composer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Highlight the notes and lyrics as they play [143]</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Slow down the tempo [143] so that you can hear the rhythms more clearly.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Temporarily increase the volume of one staff while decreasing the volume of other staves, so that you can focus your listening on a particular instrument or voice. &quot;Solo&quot; a staff while the others are muted [147]</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Organize songs into playlists and play them back with Notation's built-in jukebox.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Practice music as you sing along or play your instrument with accompaniment</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transpose the pitch of a vocal part [166] to match your voice range.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatically turn pages [147]</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Set up practice loops [151] to repeat a section of the song at optionally increasing tempos.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Remotely execute commands from your keyboard [162] such as Start Playback, End Playback, and Fast Forward.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Quickly prepare parts from a MIDI file, for use by yourself or musicians in a performing group.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prepare an &quot;Easy Notes&quot; part [227] for student musicians, showing note letters (for example &quot;C&quot;) in the noteheads.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prepare a &quot;Sing-Along&quot; vocal part [228] for easy sight-reading from the screen while the song plays.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prepare a fake book lead sheet part [229] with melody and chords.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Prepare piano reduction of a score [227] that has multiple instruments or voices.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Extract individual parts [228] for the players or singers in your music group.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transpose an instrument's part to its natural key [164], such as for a Bb clarinet,</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Split a single piano/keyboard staff into right- and left-hand staves [217]</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Purpose and Features</td>
<td>Notation Musician</td>
<td>Notation Composer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------------</td>
<td>------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Split a MIDI drum staff into separate one-line drum instrument staves</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Split a staff into melody and accompaniment parts</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Annotate the sheet music that has been transcribed from a MIDI file.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add lyrics</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Edit note beams</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Transcribe the following types of ornaments:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- grace notes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>- trills</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- tremelos</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Temporarily display an ornament as written-out notes or revert it to a</td>
<td></td>
<td></td>
</tr>
<tr>
<td>written-out performance</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add accent marks and articulations, dynamic marks, hairpin crescendo marks, slurs,</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>pedal marks and other special music symbols</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add staff symbols, brackets and braces, clefs, key signatures, and barline types</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add free text anywhere in the score.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add rehearsal marks</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add 8va octave marks</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add repeat barlines and endings, which will be interpreted during playback.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add special repeat directives, such as “D.C.”, for which you can specify the</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>destination measure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Format and print the score and parts.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Choose the default font size, face, and style for various categories of music symbols and types of text</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Specify the default horizontal spacing (degree of stretch or compression) and</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>default vertical spacing between staves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control the layout of each page</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
## Purpose and Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="264" alt="page breaks" /> system (line) breaks</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>number of measures on any given system</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>number of systems on any given page</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>vertical spacing between any pair of staves</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>vertical spacing between adjacent systems</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>relative horizontal spacing of individual measures within a system (line)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Add and control the placement of page title, footer and header text</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Optionally hide resting staves</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Expand or collapse multiple-measure rests</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Format parts using templates</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Display one-line drum instrument staves using special percussion noteheads</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Export a High Resolution PDF for sharing your score</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Export a High Resolution image (.png, .jpg, .bmp, .gif) for sharing your score</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Purpose: Re-arrange the notes of an existing song, or create music from scratch.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a new song using a pre-defined template for a variety of solo instruments, duet pairs, small ensembles, and large ensembles. Or, use a custom song template that you have previously prepared.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Add notes by whatever method is most convenient for you:</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>with the mouse and computer keyboard</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>using the Sequential Note Entry method, whereby where you rarely have to select the note duration, even when the sequence of notes has different note duration.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>using Step-Time recording, one note or chord at a time, from your MIDI keyboard or input device.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Change pitches of notes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Add staves (instrument parts)</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Add measures</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Purpose and Features

<table>
<thead>
<tr>
<th>Add ornaments</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>graces notes</em></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>trills</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>turns</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>mordents</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>arpeggios</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>tremelos</em></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Change the meter and barline positions</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MusicXML - Transfer your score to other popular music notation programs, such as Finale(tm) and Sibelius(tm), using the MusicXML file format</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Purpose: Record music from your MIDI keyboard or input device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The recording of your performance is transcribed using the same excellent MIDI-to-notation transcription technology that Notation uses to transcribe MIDI files to sheet music.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set up the tempo for recording</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Set up the number of pick-up measures</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Record (punch in) into a selected region of a staff</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add (punch in) a recording of pitch bends or MIDI controllers on top of notes previously recorded.</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Purpose: Edit the performance (MIDI) of the song.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notation Composer offers the features of a typical MIDI sequencer program but in a more musically oriented way. Editing of the music performance is highly integrated with the music notation. Notation Composer offers an intuitive and fun way to refine the details of the performance without requiring that you know details about MIDI nor requiring you to work with tedious numbers.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit the exact as-performed rhythms of notes while viewing Piano Roll Notation that is drawn on top of the notes.</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Edit the loudness of individual notes while viewing &quot;vectors&quot; (lines drawn at an angle from each notehead) that graphically show the loudness of each note.</th>
<th>Notation Musician</th>
<th>Notation Composer</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
1.5 Quick Start Tutorial

The following tutorial will get you started quickly in enjoying some of Composer’s main features. This tutorial can typically be completed in about 40 minutes, but much more quickly if you just read it on the screen rather than actually do the tutorial steps yourself.

As you follow the steps of this tutorial, you should feel free to explore side tours on your own. Click buttons; try menu commands; add, change, and delete music symbols. To return to the place where you were in the tutorial, use the multiple-level Undo command in the Edit menu, or type CTRL+Z, as many times as you need. Also, at various points in the tutorial, you might want to save your work, using the Save As command in the File menu.

After completing this tutorial, you should be able to successfully explore many of Composer’s features on your own without needing to refer to this User Guide.

1.5.1 Tutorial: Opening a File on Your System

Notation Composer can open any MIDI .mid or Karaoke .kar file, and transcribe it to notation. If you wish to arrange some existing music for your own purpose, then the easiest way to get started is to find a MIDI file of the song, and then modify it to suit your needs. You can also open MusicXML files (.xml, .mxml, or .musicxml) that you may have.

This first step of the tutorial illustrates how you would open a MIDI file that you had previously downloaded from the Internet to your system. Or, perhaps you have a file that you have created, and now you wish to work with it further in Notation Composer.

This tutorial will work with the simple children’s tune, Twinkle Twinkle Little Star. You can find the MIDI file for it, twinkle.mid, in your C:\Users\Public\Documents\Notation_3\Songs directory.

To open the file on your system:

1. Start Notation Composer, as described in Finding and Starting Notation Composer on Your System.
2. If no files are currently opened, then click the following icon or text, displayed in Notation's front panel:

OPEN A MIDI, XML OR .NOT FILE

-- OR --

(If at least one file is opened, you will not see the above front panel.)

In the File menu, choose the Open command.

Composer will present you with the File Open dialog box.

3. By default, the C:\Users\Public\Documents\Notation_3\Songs directory will already be opened. If another directory is opened, then navigate to the Notation\Songs directory.

4. Open the file twinkle.mid

Composer will display the following Recommended Corrections dialog box:

Composer has detected that the following are probably keyboard tracks in the newly imported MIDI file which will need the following corrections for better display as music notation. Which corrections would you like Composer to make now?

MIDI files are often not ideally created for transcription to sheet music. One of the most common examples of that is a MIDI file which combines the right- and left-hand notes of a keyboard part into one staff (track). Composer detects these kinds of problems in MIDI files and automatically fixes them. (You can also manually do any such score fixing with commands such as, for this example, the Split Hands command.)

5. Click the OK button in the Recommended Corrections dialog box.

Composer will display as many measures of the song as will fill the window. If you want to see more measures in the window, click the Zoom Out button in the main toolbar. Notice how the piano staff has now been split into right- and left-hand treble and bass staves:
1.5.2 Tutorial: Playing the Song

If your computer has a sound card, it is likely that Composer will be able to immediately play through your computer’s sound card to the speakers. Composer requires that the sound card support MIDI, which is a certain computer music standard that almost all of today’s sound cards support.

To play back the currently opened song:

- Hit the SPACE key.
  -- OR --

- Click the Play button in the toolbar at the top of the window.

To close a song file:

- Choose the Close command in the File menu.
  -- OR --

- Type CTRL+F4, the standard Windows shortcut for Close Window.
Playback starts wherever the green playback marker is currently located. A vertical blue cursor moves along in the score as the song plays, to indicate the current playback position. The currently playing notes are highlighted in a bright pink color.

**TIP:** Do you hear the Twinkle Twinkle Little Star playing? If so, then Composer will not need any assistance from you in setting up the MIDI sound card. If you do not hear the song play, then follow the instructions in Quick MIDI Device Setup. If after using the Quick MIDI Device Setup option you still do not hear sound, then read about What To Do If You Do Not Hear Sound.

To temporarily fast forward through the song during playback:

1. Click the Fast Forward button once to increase the playback speed by a factor of five.
2. Click the button a second time to resume the original playback speed.

To stop playback:

- Hit the SPACE key.
  -- OR --

- Click the Stop button.
  -- OR --

- Toggle the Playback button in the toolbar at the top of the window.

The green playback marker will be moved to the song location where you interrupted playback.
To jump to a different location in the song during playback:

- Click the mouse wherever you want the playback to jump to.
- If you want to jump ahead a few pages, use the PAGEDOWN key to preview the page. Composer will continue playing where you left it, uninterrupted, while you look ahead. If you wait for about 5 seconds, Composer will return to the page that it is currently playing. However, if you click somewhere on the look-ahead page, then playback will immediately jump to the location of your mouse click.

To change the location of the playback marker before you start playback:

- While holding down the "P" key, click the mouse where you want to set the playback marker.

To change the location of the playback marker to the beginning of the score, even during playback:

- Type CTRL+HOME.
- OR --

- Click the Start of Song button.

### 1.5.3 Tutorial: Using a Playlist of Multiple Songs

Sometimes you may want to keep an ordered list of songs in a playlist, where the playback of each song continues after the previous song. The most obvious use of a playlist is for listening enjoyment, to listen to several songs—perhaps ones you have arranged yourself—in sequence.

Another use of a playlist is to play different parts of a larger musical piece, where each part is kept in a separate Notation .not file. These might be movements of a sonata or orchestral piece. Or, they might be numbers of a simple suite of children's music.

In the following example, we will create a playlist of three songs that are installed by default in the C:\Users\Public\Documents\Notation_3\Songs directory.

**To create a playlist of songs:**

1. Turn on the Show Playlists option in the View or File menu.

2. In the Playlists panel, click the Add button.
   
   Composer will present a File Open dialog box

   Note, the << Add button is for adding to the playlist a song you've already opened and are currently viewing.

3. In the File Open dialog box, navigate to the C:\Users\Public\Documents\Notation_3\Songs directory or whatever folder you have your song files in. Select one or more songs (Notation .not, MIDI .mid, or Karaoke .kar) that you want to add to the playlist. To select multiple, non-adjacent songs, hold down the CTRL key as you click the file name. Please note that MusicXML files cannot be added to a Playlist.
4. Click the OK button in the Open dialog.

You will see that the select songs have been added to the current playlist, which currently is named "New". You can use the Rename... button to change the name of the playlist from "New" to something like "Tutorial Examples".
To play the songs in the playlist, one after another:

1. Turn on the check mark for "Auto play next song", as illustrated above.
2. If you want the playback to continuously cycle through all of the songs, starting at the first again after playing the last, then turn on the check mark for "Loop songs in playlist".
3. If you want to start at a song other than the currently selected song, click its name in the playlist.
4. Click the button in the Playlist panel.

Playback of the currently selected song will begin. Notice that the highlighting of the select song in the playlist changes from blue to green. Also, the next song to be played after the completion of the currently selected song will be highlighted in a light green.
5. While any song in the playlist is playing, you can click any other song, out of sequence, to play next, upon completion of the currently playing song.

1.5.4 Tutorial: Correcting the Notes and Accidentals

Composer usually does an excellent job of transcribing a MIDI performance into notation note rhythms and spellings of accidentals. The MIDI-to-notation transcription technology in Notation Composer was first developed in 1994 and 1995, and has been improving ever since. Notation Composer and Notation Musician offer the highest quality of transcription available in any music software program.

However, the transcription of note rhythms and spellings of accidentals by Composer is not perfect. After you open a MIDI file in Composer, you may need to correct some notation errors.

The following are some of the common types of corrections you might want to make after Composer has transcribed a MIDI File:

- Change the displayed and performed duration of a note.
- Change the displayed and performed starting location of a note.
- Shift a note between the left and right hands of a piano or keyboard part.
- Change a small note to a grace note, or vice versa.
- Change the enharmonic spelling (such as C# versus Db) of notes.
- Undo one or more editing changes.

In Composer you can change the song in any way you want, including changing the pitches of notes and adding new notes. Composer offers many convenient tools for editing the notation only or the
Notation Composer 3 User Guide

underlying performance only, that is, the MIDI data, as described in Viewing and Editing the Music Performance.

If you are eager to learn about adding notes, jump ahead to the tutorial step Adding Notes to a New Song.

To change the displayed and performed duration of a note:

Suppose you want to change the notated duration of the last quarter note in the second measure of the melody *Twinkle Twinkle Little Star* to be a half note instead, thus replacing the quarter note rest after it:

```
Melody
```

Here are two ways you can do this.

**Method 1: Change the duration of a note by explicitly giving it a new duration value**

1. If you are not already in Select Mode, click the Select Mode button in the main toolbar.
   -- OR --
   Hit the ENTER key.
   -- OR --
   Click the right mouse button anywhere.
2. Select the note whose duration you wish to change.
   Composer highlights the selected note. The detail palette indicates the duration of the currently selected note. The illustration below shows the palette in a horizontal orientation. By default, Composer displays the palette horizontally across the top of the window, but you can drag the palette wherever you want.
```
[Image showing the palette]
```
3. Click the half note button in the Note Palette to change the duration of the note.
   -- OR --
Type "22" on your keyboard, which is the shortcut for half note.

Examples of other shortcuts are "4", "8", "16", and "32" for quarter, eighth, sixteenth, and thirty-second notes. The shortcuts for one or two dots are "1d" and "2d". The reason that the shortcut for half note is "22" instead of "2" is so that it is not confused with "2d" for "two dots".

To find out what the keyboard shortcut for a palette button is, hold the mouse cursor briefly over the button:

Method 2: Change the duration of a note by extending it in increments with D+→ or D+←

If you have already tried Method 1, then undo the most recent command by choosing Undo Set Note Duration command in the Edit menu, or by typing CTRL+Z.

1. Enter Select Mode as described in step #1 for Method 1.
2. Select the note whose duration you wish to change.
3. While holding down the "D" key (for "duration"), type the → or ← key one or more times.

Each time you type D+→, the duration will be increased by some amount according to the current Beat Ruler setting.

TIP: If you do not know or recall the keyboard shortcut such as D+→ for the Increase Duration command, you can look it up in the menu for the type of object you have selected. In this case, you can look up the shortcut in the Note menu.

To change the displayed and performed starting location of a note:

In the last measure of the melody of Twinkle Twinkle Little Star, the first note was performed so late that Composer perhaps too literally interpreted the rhythm of that note to be intended as a 16th note after the start of the measure. If you play this part of the song, you will indeed hear the delayed note, and may or may not agree that Composer should have notated the rhythm the way it did:

In this example, the starting location ("attack") of the note should be moved to the beginning of the measure.

1. Select the note whose attack location you wish to change.
2. While holding down the "A" key (for "attack"), type the ← or → key one or more times.
In this example, you need only type A+ once. The result is:

![Melody Example](image)

Notice that in moving the attack to the left by a 16th duration, the total duration of the note increases by a 16th duration. If you had typed A+ instead of A+, the result would be as shown here:

![Example Note Movement](image)

To shift a note between the left and right hands of a piano or keyboard part:

Composer's automatic splitting of the keyboard staff into right- and left-hand (treble and bass clef) staves generally does an excellent job determining which notes are most likely to be played by the right or left hand. Sometimes, however, Composer might make mistakes. You can quickly correct a mistake by shifting a note between the right- and left-hand staves of a piano or keyboard part.

For the fairly simple piano accompaniment for the Twinkle Twinkle Little Star, Composer made no mistakes in assigning notes to the right and left hands. For purposes of illustration, we will intentionally create such a mistake and then correct it.

1. Select the note that you intend to shift to another staff.
   In this example, select the 'A' note in the left-hand staff in the third measure.

2. Type SHIFT+ to shift a note to the staff above, and SHIFT+ to shift a note to the staff below.
   In this example, first type SHIFT+ to shift the 'A' note in the left-hand staff to the right-hand staff. The result will look like the first of the two above examples. This is a fairly realistic example of the kind of mistake that Composer might make, because the two hands are
playing very closely together. In fact, the right hand has just played the same 'A' note one quarter note beat earlier. Yet, Composer was smart enough to determine that the left hand should be playing the note.

3. While the 'A' note is still selected, now type SHIFT+ to shift it back to the correct left-hand staff.

To change a small note to a grace note, or vice versa:

In the third measure of the right-hand piano staff, Composer's transcription correctly identified a grace note and displayed it so. Before you open a MIDI file, you can set up transcription options, including an option regarding whether grace notes should be displayed as grace notes or written out as short notes, such as 32nd notes. By default, the grace note transcription option is turned on.

Sometimes Composer might not correctly identify a grace note, or it might display a note as a grace note, but you would prefer to have it written out as a short note.

We will use the example of the grace note in the third measure to show how you can change a note back and forth between being displayed as a grace note and being written out as a short note.

1. Select the grace note which you wish to convert to a written-out note.

When you select a grace note, Composer automatically displays the Grace Note Palette, as illustrated above.

2. Click the Convert Grace Note to Written-Out Note button in the Grace Note Palette.

-- OR --

Hit the BACKSPACE key.

3. Select the short note which you wish to convert to a grace note.

In this example, the short note is already selected.
4. Click the Grace Note Left button if this grace note borrows its time from the note on the left.

Click the Grace Note Right button if this grace note borrows its time from the note on the right. For an explanation of Grace Note Left versus Grace Note Right, see Understanding the Two Types of Grace Notes.

To change the enharmonic spelling (such as C# versus Db) of a note:

In this simple *Twinkle Twinkle Little Star* song in the key of F-major, there was only one note that required an accidental, namely Eb in measure 9 for the left-hand piano part. Composer correctly determined that the spelling of the note was Eb rather than D#.

When a song has complex harmonies, Composer might sometimes incorrectly spell a note. In such cases, you will find it easy to correct the mistake.

For purposes of illustration, we will intentionally make a spelling mistake and then correct it.

1. Select the note for which you wish to change its spelling.
   In this example, select the Eb in measure 9 of the piano left-hand staff.

2. Type E+ to lower the enharmonic spelling.
   A good way to think about "lowering" versus "raising" the enharmonic spelling is to think about which direction the notehead moves. When you lower the enharmonic spelling, the notehead always moves down a step lower on the staff. When you raise the enharmonic spelling, the notehead always moves up a step higher on the staff.
   In this example, the Eb will be changed to D#.

3. Type E+ to raise the enharmonic spelling.
   In this example, the D# will be changed back to the originally correct spelling Eb.

To undo and redo editing changes:

Earlier in this step of the tutorial, you probably already had a little practice using the Undo command, to try out the different ways to change a note duration.

Composer supports multiple level undo. You can go back as many steps in your editing as there is memory on your system to keep the history of changes. Composer is efficient about storing the history of changes; so it supports a large number of undo requests.

1. Click the Edit menu to view all your editing activities, the most recent one listed at the top of the Undo list.
2. Click any item in the Undo list to undo all of the commands from the most recent, at the top of the list, down to and including the item you select.

-- OR --

Type CTRL+Z to undo the most recent command. This is the standard Windows shortcut for the Undo command.

3. If you have undone some commands, they will be listed as Redo commands in an additional section of the Edit menu. You can redo commands you previously requested to be undone by selecting them in the Edit menu.

-- OR --

Type CTRL+Y to redo the most recent command for which you requested Undo.

1.5.5 Tutorial: Adding Lyrics

Some MIDI files include lyrics, and all Karaoke (.kar) files include lyrics, but many MIDI files do not. You can quickly add lyrics to a song, as illustrated in this step of the tutorial.

So far in this Twinkle Twinkle Little Star tutorial, we have edited existing notes, but we have not added any new notes, new music symbols, or text to the score. This step of the tutorial provides an introduction to adding “objects” to a score.

To add lyrics to a song:

1. With the mouse, navigate to the Lyrics Palette, as illustrated here:

Click any undo item in the list to undo all of the commands from the most recent, at the top of the list, down to and including that item.

Click any undo item in the list to undo all of the commands from the most recent, at the top of the list, down to and including that item.

Type Ctrl + Z to undo the most recent command.

Type Ctrl + Z to undo the most recent command.

Composer will automatically enter Add Mode. 

Composer will automatically enter Add Mode.

Type SHIFT+L. The shortcut for all palettes is Shift and some letter, such as SHIFT+N for Note Palette.

Composer will automatically enter Add Mode.
So far, you have been working in Select Mode, where you click the mouse to select an "object". An object is a note, a music symbol, or some text. In Add Mode, you click the mouse to add an object. Composer will automatically display the palette for that type of object, which, in this case, is the Lyric Palette.

In Add Mode, the mouse cursor usually changes to this shape: 

2. Click the mouse where you want to add the first lyrics.
   In this example, click somewhere below the first note in the melody.
   Composer will display a blinking text cursor, where you can start typing text.

3. Type the one word or syllable of the lyrics for the current note. If you want an dash "-" character to appear after a syllable, then type it after the syllable.

4. To advance to the next note, hit the SPACE or TAB key.
   The blinking text cursor will now be located under the second note.

5. Type the second word or syllable of the lyrics.

6. Repeat steps #4 and #5 as many times as desired.

7. To complete the entry of lyrics, hit the ESC key.
Click the Select Mode button in the toolbar to prepare to select some object for editing.

Navigate to another palette, or type SHIFT+Letter to select a different type of object, or to start adding a different type of object.

Many options available for editing lyrics, which are not illustrated in this simple example include:

- Common text editing operations, such as supported by the DEL and BACKSPACE keys and the \[←\] and \[→\] keys.
- Copying and pasting of lyrics from one section of the song to another.
- Copying and pasting of lyrics via the Windows text clipboard so that, for example, you can type lyrics in Windows NotePad and paste the lyrics into the song.
- Editing of multiple verses of lyrics.

For a more thorough overview of Composer's lyrics features, see the documentation section on Lyrics.

### 1.5.6 Tutorial: Saving Your Work in a File

Composer's multiple level undo feature, which you have already explored in this tutorial, offers a certain degree of protection against mistakes that you might want to undo.

In addition, Composer has an auto-recovery feature. Periodically (by default every 10 minutes), Composer makes a backup copy of your work. If your system fails, you can return to a recent state of the song, using the Open Files from automatic backup command in the File menu.

There are also various other formats in which you can save your song.

- Saving as a NoteSoft (.not) file
- Exporting a MIDI (.mid) or Karaoke (.kar) file
- Exporting a High Resolution PDF (.pdf) file
- Exporting a High Resolution Graphic (.bmp, .png, .jpg, or .gif) file
- Exporting an audio (.wav, .mp3, .ogg, or .flac) file
- Exporting a Music XML (.xml, .musicxml, or .mxl) file

Notation Composer and Notation Musician use and share a music file format that includes not only MIDI performance data but also notation data. Normally, you should save the song in the Notation file format, used by Notation Software's Notation family of music software products. A Notation file has the .not filename extension.
To save your work in a .not file:

1. Choose the File / Save As command.
   Composer will present the File Save As dialog box.
   -- OR --
   Type CTRL+S, which is the standard Windows shortcut for File Save.
   A default directory will be opened. It will be C:\Users\Public\Documents\Notation_3\Songs unless you installed Composer in a different directory. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default".

2. Enter a new file name or, use the same file name. The .not file that is saved will not overwrite your .mid file.
   For example, use Twinkle1 as the file name. Composer will automatically add the Notation .not file name extension.

3. Click the OK button.
To Export your work to share with others:

Exporting a MIDI file (.mid) or Karaoke (.kar) file - MIDI (.mid) files can be used in sequencers and other MIDI software. Karaoke (.kar) files have some special text formatting, and can be used in Karaoke machines or other MIDI playback software. The options for exporting either filetype are the same.

1. Select "File / Export ... MIDI (.mid) file (or "File/Export...Karaoke(.kar)" ) and the Export dialog box will open (the dialog for Karaoke is the same, only it will have "Karaoke" and ".kar")

![Export as MIDI File](image)

2. Enter the filename (probably different than the original file)

3. Select the performance options you want for the MIDI (or karaoke) file. For example, if your file has repeats, you will want to check the "Write out repeats" box so that the repeats are played correctly in the exported .mid file. If the device that you will be using the MIDI (or karaoke) file on needs to have the MIDI Controllers reset before the new file is played, check the "Force MIDI Controller Reset at the start of the song" box.
4. Select the MIDI format you wish to save in. XG format saves the most information, such as bank and patch information for the song. GS or GM2 format is required for some devices. GM MIDI format is the most basic format, and may be desired if you'd like to change the format later to another MIDI format.

5. After making all the appropriate selections, click "Save".

Exporting a PDF - PDF files can be shared with others who want to see the finished print version of your music. Composer's High Resolution PDF export gives you great crisp sheets to share or print anywhere.

1. Select "File / Export... PDF" and the "Save Parts to PDF file" dialog will appear. It will show all the Parts that have been created for the song file.

2. Click on each part to select it and export a pdf, then click "Ok."

3. Each exported Part file will have the Part name appended to it so that you can easily see which file is for which part.

Exporting an Image (.png, .jpg, .bmp, or .gif) file:

Please note that if you export multiple pages of a Part as an image file, that all those pages will appear in the same image file. If you plan to use the exported image to insert in a document (e.g. as a musical "snippet" example), then you probably want to just export the page where your example occurs and then use your favorite editor to crop the image.

To export an image file of your score:

1. In the File menu, choose Export, then select "Image..." The "Save Parts to Image file" dialog will come up:
1. After selecting the Part(s) you want to export an image from, click "Ok."
2. You can then select the page range that you wish to export in the image file(s) then click "Ok." The default range is the entire score.

1. The "Save in:" dialog will then come up, where you can navigate to the folder you wish to save the file in, as well as select the image filetype you want to export. The default directory is C:\Users\Public\Documents\Notation_3\Songs. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default". Click "Save" to save the image file(s) in the selected folder. For each Part a progress window will come up showing you the progress of the export, and will close when the Part is done.

Click on specific parts to select them. A separate image file will be exported for each Part that is selected.

or click on "Select All Parts" to export page(s) from each Part to individual image files.

Enter the numbers of the First page and Last page in the appropriate fields. The default is the entire score.
Click the drop list to select the type of image file you wish to export.
Exporting an audio (.wav, .mp3, .ogg, .flac) file - audio files can be shared with others who want to hear your finished work. The audio for these exported files is provided by the internal Notation Software Synth.

1. Select "File/Export ... Audio" and the dialog will appear.

2. Select the filetype you wish.

3. Name the file (if you want it to be different) and optionally navigate to the location you want to save the file, then click "Ok" to export the audio file. Please note that while Composer exports audio files, it does not open them to transcribe sheet music.

Exporting a Music XML (.xml, .musicxml, .mxl) file - MusicXML is a filetype that can be imported into other music notation programs and preserves more of the score the way that you have it set up in Notation Composer.

1. Select "File/Export ... MusicXML" and the dialog will appear.
2. Select the filetype you wish for Music XML export
3. Click "Save" to export the Music XML file of your song.
See the topic of "Exporting Your Work in Other File Formats" for more details.

1.5.7 Tutorial: Working with Parts

The *Twinkle Twinkle Little Star* song has two parts: the vocal melody and the piano accompaniment. The score that you have been working is called the "conductor's score" in Composer, although that term might seem too grand for this 16-measure children's song. But imagine instead that you are working with a larger score with multiple parts for a small group of musicians, or choir members, or an ensemble as large as a school band or symphony orchestra. Or, you might be working on a score for a duet for two instruments. In all of these cases, it is likely that you will want to print separate parts to be read by each musician in the ensemble rather than all of the staves together as the conductor's score.
Although you can view and print parts separately, they are always integrated with the conductor's score. If you change notes, lyrics, or music annotations in the part, they are automatically reflected in the staff for that instrument or voice in the conductor's score. Conversely, if you edit notes, lyrics, or annotations in a staff in the conductor's score, those changes are automatically reflected in the individual instrument or vocal part.

We will see how this works, using the Twinkle Twinkle Little Star song.

To view a part:

- Select the part in the part list in Composer's menu:

Composer displays the melody part:

![Twinkle Twinkle Little Star melody](image)

To learn how editing in a part is automatically reflected in the conductor's score:

1. In the Melody part that you just extracted in the above procedure, make some change, such as changing the period to an explanation point in the last lyric:

![Twinkle Twinkle Little Star melody with explanation point](image)

2. Choose the Conductor's Score in the part list in Composer's main menu to view it again.

Composer will now display both the Melody and Piano parts together:
Notice how the change you made to the lyric in the Melody part is now reflected in the conductor's score. This also works for most other types of objects, such as notes and dynamic marks.

You might want to preview on the screen what the part will look like before you print it. Composer offers many options for formatting the printed page, setting up page titles and headers, changing the font size, and so on. Composer's default choices for these formatting options offer an excellent starting point. You can customize your own templates that will determine how scores and parts will be formatted.

In this step of the tutorial, we will preview on the screen what Composer's default formatting choices look like, and then print the individual parts for the voice (melody) and accompaniment of *Twinkle Twinkle Little Star*.

To preview what a printed score or part looks like:

- Choose the Page View command in the View menu.

  -- OR --

  Type "qpv" for Quick Page View.

Many menu commands in Composer offer such keyboard shortcuts that begin with the letter "q" and are acronyms of the command.

In the last step, we were most recently viewing the extracted piano part. In Page View, this is what it looks like:
If you want to preview the whole page on the screen, then hit the Zoom Out button as many times as necessary.

In the above example, the Zoom Out button was clicked a couple of times.

Notice in the above example how Composer has already formatted the top of the page with the song title "Twinkle". Composer chooses the default paper size for your printer.

Note that you can edit the score in Page View, just as in Window View. For example, you can add and change notes, lyrics, and chord names.

To print the currently viewed part:

1. Choose the Print command in the File menu.
   -- OR --
   Type CTRL+P, which is the standard Windows shortcut for the Print command.

2. In the Print dialog, select the destination printer, and range of pages you wish to print, the number of copies, and other common printing options.

To print several parts at one time:

1. Choose the Print Parts command in the File menu.
Composer will present the following dialog box:

![Print Parts Dialog Box]

2. Select the parts you wish to print, and click the OK button. Composer will present the Print dialog box.

3. In the Print dialog box, select the destination printer and other printing options. Note that you will not be offered the choice for a range of pages. All pages for each selected part will be printed. Each part might have a different number of pages.

1.5.8 Tutorial: Creating a New Song

Up to now you have been working with the Twinkle.mid MIDI file that someone else created. You might want to compose or arrange your own song from scratch.

Composer’s New Song Wizard offers you an easy way to start a new score for any instrument, voice, or ensemble you want. In a short series of New Song Wizard steps, you will specify the following important details of the song:

- instrument(s) or ensemble
- meter (time signature)
- key signature
- number of measures
- song title

Of course, you can later change any of these details of the song, or insert meter and key signature changes throughout the song.

The New Song Wizard offers blank scores prepared for a wide variety of instrumental and vocal ensembles. If you do not find a prepared blank score that exactly matches your musical group, then you can prepare your own customized song template. A song template is simply another Notation .not file that serves as the initial blank score with the list of instruments and/or voices you need.

To create a new song:

1. If no files are currently opened, then click the Sheet Music icon or the text "Create a New Song", which is displayed in the main part of Notation's window:
CREATE A NEW SONG

-- OR --

Choose File -> New.

-- OR --

Type CTRL+N, which is the standard Windows shortcut for File Open.

Composer will display the first step of a 5-step New Song Wizard.

2. At the first step of the New Song Wizard, select the ensemble, instrument, or voice that most closely matches your needs.

Composer shows you the results of your choices as you go through the steps in the New Song Wizard. The above example illustrates how the choice of the Voice and Piano ensemble is immediately reflected in the score underneath the wizard window. You can move the wizard window out of the way if you need to see different parts of the initial score.

3. If you are creating a score for some solo instrument other than one in the list, then follow instructions in the topic Creating a New Song File.

4. Click the Next button in the wizard window, and continue through each of the steps to enter:
   - meter (time signature)
   - key signature
   - number of measures
5. In the last step of the wizard, in addition to entering the song title, also specify whether the song should initially be displayed in **Window View** or **Song View**. Use the Set As Default option to save this selection for future new songs.

### 1.5.9 Tutorial: Adding Notes to a New Song

Having just created a new song in the previous step of the tutorial, you might be eager to start adding new notes. You might have already explored this on your own already. There is a good chance, however, that you have not discovered some of the ways that you can add notes in Composer other than choosing notes from the Note Palette and clicking the mouse where you want to add them.

Overall, there are three different physical devices you can use to enter notes in Composer, and using each of these various devices there are alternative methods you can use for entering notes:

1. **With the mouse:**
   - (a) Point and click the mouse to add new notes, choosing their durations from the Note Duration Palette.
   - **OR**
   - (b) Point and click the mouse to add new notes in the score from left to right, such that the duration of each note is determined by the location of the next note. This Sequential Note Entry Method is particularly useful if the notes have frequently changing durations. You will not have to select different duration values from the Note Palette, because the duration of each note automatically extends to the beginning of the next note, whether that next note is a 32nd duration later or, say, a dotted quarter note duration later.

2. **With the computer keyboard:**
   - Use only your computer keyboard to enter notes, by typing the duration of the note you wish to add, such as "8" for 8th note, "16" for sixteenth note, or "41d" for a quarter note with one dot. Use the , , , and keys to determine the position of the note to be added. Then hit the key to add the note. If you tend to prefer using the computer keyboard over using the mouse, you will like this method.

3. **With a music keyboard that is connected to your computer via a MIDI cable:**
   - (a) In synchronization with Composer’s metronome, record your performance on your music keyboard in real time to quickly enter the notes. Perhaps you will want to record your performance at a slower tempo which you can later set to a faster speed.
   - **OR**
   - (b) Use your music keyboard instead of the mouse to determine the pitches of notes; but enter the notes at your own pace, without regard to a metronome. This is called Step-Time Recording, as opposed to real-time recording.
   - **OR**
   - (c) Use both your music keyboard and computer keyboard together. Point the mouse in the score at the location where you want to add a note or chord, and play it on your music keyboard. Hit the key one or more times to advance the cursor that many positions in the Beat Ruler. The next time you play a note, the duration of the previous note will terminate at the location of the newly added note. This method combines Step-Time Recording with the Sequential Note Entry Method.
The procedures below illustrate each of the above six methods of entering notes—1(a), 1(b), 2, 3(a), 3(b), and 3(c). If you do not have a MIDI keyboard or input device, then skip the last two illustrations.

Method 1(a): Point and click the mouse to add notes, choosing their durations from the Note Duration Palette.

This is the most obvious way to add notes. First, you choose the duration of the note you wish to add. Then you click the mouse where you wish to add the note.

To add a note by first choosing its duration:

1. With the mouse, navigate to the Note Duration Palette.
   -- OR --
   Type SHIFT+N.

   ![Note Duration Palette]

   In most cases, Composer will automatically switch to Add Mode. The mouse cursor will turn to the shape of a red note, which duration value represents the current to-be-added note duration.

   ![Red Note Cursor]

   In the above example, the main Beat Ruler marks are at every quarter note beat, and the smaller ruler marks are at eighth note sub-beats between the quarter note beats. At any time you can change the Beat Ruler resolution.

2. In the Note Duration Palette, choose some combination of base duration (such as quarter, eighth, half), dotted value and tuplet (or no tuplet).
   -- OR --
   Type a keyboard shortcut for the duration, such as "4", "8", "16", "81d", or "833" for quarter, eighth, sixteenth, dotted eighth, and eighth triplet. To learn what the shortcuts are, hold the mouse over the buttons to view the button tips. Note that the shortcuts for whole note and half note are "11" and "22" rather than the expected "1" and "2", and the shortcuts for triplet and quintuplet are "33" and "55".

3. Move the mouse to the horizontal position where the start of the note should be located. At the same time, move the mouse to the vertical position that determines the pitch of the note.
As you move the mouse around, the red note snaps to precise horizontal beat locations and vertical pitch locations, thus offering you certainty about where the note will be added when you click the mouse button.

4. Click the mouse in the score where you wish to add the note.

When you add the note, Composer will automatically fill in rests around the newly added note, as illustrated here:

![Note Snap Example]

5. If the note is not in the 7-note scale of the current key signature, you can raise or lower the pitch of the selected note by typing P+\[\text{\textasciitilde}\] or P+\[\text{\textasciitilde}\] -- OR --

Type "b" or "#" to add a flat or sharp. Other shortcuts are available for other accidentals.

![Pitch Adjust Example]

As you add more notes, Composer will automatically beam them together, and change stem directions if appropriate, as illustrated here:

![Beam Example]

Method 1(b): Enter notes one after another with the mouse in Sequential Note Entry Mode.

With this method, you point and click the mouse to add new notes in the score from left to right, such that the duration of each note is determined by the location of the next note.

To add notes using the Sequential Note Entry Mode:

1. With the mouse, navigate to the Sequential Note Entry Palette.
The palette will then change to the Beat Ruler Palette, and the Sequential Note Entry button will be shown in the "down" position:

\[
\begin{array}{cccccc}
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\, & \, & \, & \, & \, & \, \\
\end{array}
\]

Sequential Note Entry Mode.

The mouse cursor will change to a red whole note, which suggests that when you initially add the note, it will have a long note value (unless you add the note in front of another note). Here is what the red to-be-added note looks like before it is clicked into the score:

2. Click the mouse where you want to add the first note.

It may surprise you that the first time you do this, the duration of this newly added note will be large. The duration of the note will extend to the second barline after the location of the note. Don't worry.

Newly added note in Sequential Note Entry Mode.

3. Move the mouse to where you want to add the next note in the sequence, and click the mouse button.

Notice how the duration of the previous note is now terminated at the location of the next newly added note:

Move the mouse to the position where you want to add the next note.

4. To terminate the duration of the last note, or to make the duration of an intermediate note shorter:

- Click the Cut Duration button in the Sequential Note Entry Palette.
- OR -
- Type "cut".
The mouse cursor will temporarily change to the shape of a razor, suggesting the idea of cutting:

- Move the cursor to the location where you want to terminate the duration of a note or chord, and click the mouse button.

Method 2: Enter notes using only your computer keyboard

The above heading is not entirely accurate, because you will need to use the mouse to add the first note, or to select an already added note, as the starting point for adding new notes via your computer keyboard.

To add a note using the arrow keys and **Ins** key:

1. If you have been following the previous tutorial steps, undo the most recently added notes by typing CTRL+Z a few times until the first measure is empty. Then add the following note with the mouse:

2. OR -----------------------------------------

   Undo the most recently added notes until only the above first note is left. If it is not already selected (highlighted in blue), then temporarily switch to Select Mode by hitting the ENTER key; select the note with the mouse; and then go back to Add Mode by hitting the ENTER key again. The ENTER key always toggles between Select Mode and Add Mode.

2. Hit the **↓** key to move the red to-be-added note to the next ruler position:

3. Hit the **↓** key three times to move the red to-be-added note to the following location:

4. Hit the **Ins** key to insert (add) the new note:
To create a chord using the arrow keys and and \(\text{ins}\) key:

1. Add the first note of the chord.

2. Hit the \(\uparrow\) or \(\downarrow\) key one or more times to move the red to-be-added note to another staff position at the same measure beat.

3. Hit the \(\text{ins}\) key to insert (add) the new note:

To add an accidental (sharp or flat) to a newly add note:

- Type "#" or "b" to add a sharp or flat, or one of the other keyboard shortcuts for accidentals, listed here:

<table>
<thead>
<tr>
<th>keyboard command</th>
<th>accidental</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ss&quot; or &quot;#&quot;</td>
<td>sharp</td>
</tr>
<tr>
<td>&quot;f&quot; or &quot;b&quot;</td>
<td>flat</td>
</tr>
<tr>
<td>&quot;na&quot;</td>
<td>no accidental</td>
</tr>
<tr>
<td>&quot;ds&quot; or &quot;d#&quot; or &quot;x&quot;</td>
<td>double sharp</td>
</tr>
<tr>
<td>&quot;df&quot; or &quot;db&quot;</td>
<td>double flat</td>
</tr>
</tbody>
</table>

- OR -

- Type the NumPad + or - key one or more times to raise or lower the pitch one half-step at a time.

- OR -

- While holding the "P" key, hit the \(\uparrow\) or \(\downarrow\) key one or more times to raise or lower the pitch one half-step at a time.

The remaining procedures rely on the use of a MIDI keyboard or input device. If you do not have one, then you can skip the remaining procedures in this topic, unless you would like a glimpse of how much fun it can be to have a MIDI keyboard and use it with Composer.
Method 3(a): Record the notes in real-time from your MIDI keyboard or input device.

To record in real-time from your music keyboard:

- Follow the instructions in Recording from a Music Keyboard.

With Composer's real-time recording features, you can:

- Record at a temporarily reduced tempo.
- Record one staff while you listen to others being played as accompaniment.
- Optionally select a pair of keyboard right- and left-hand staves, into which Composer will automatically distribute notes according to the same logic as you saw illustrated with the Split Hands command.
- "Punch in" the recording for a section of the staff. Composer will give you a "running start", so that you can hear the staff play back up to the place where you want to record, and then you can jump in with your new recording.
- Do multiple "takes" by simply recording on top of a previous take. If you want to go back to a "take" that you made one or more times earlier, then use the Undo command that many times. If you would like to archive your takes, copy the staff to temporary backup staves using the Clone Staff command in the Staff menu.

Method 3(b): Use your music keyboard instead of the mouse to determine the pitches of notes, but enter the notes at your own pace, without regard to a metronome.

This is called the Step-Time Recording method of entering notes.

To add notes from your MIDI keyboard in Step-Time Recording Mode:

1. Click the Step-Time Recording button in the main toolbar.
2. Follow the steps in the first procedure, "To add a note by first choosing its duration". However, instead of clicking the mouse at some vertical position in the score to determine the pitch of the new note, play the note on your keyboard.

You need only move the mouse to the horizontal position in the Beat Ruler, where you want to add the note. It does not matter where the mouse is located vertically, because the pitch of the note will be determined by what you play on the keyboard.

3. To add a chord instead of a single note at the location of the mouse, play the chord on your music keyboard.

Method 3(c): Use your music keyboard and computer keyboard together.

To add notes from your MIDI keyboard with the combination Step-Time Recording Mode and Sequential Note Entry Mode:

1. Click the Step-Time Recording button in the main toolbar.
2. Follow the steps in the above procedure 1(b) for the Sequential Note Entry method of adding notes. However, instead of clicking the mouse at some vertical position in score to determine the pitch of the new note, play the note on your keyboard, or play a chord on your keyboard.

After you add the second note, Composer will automatically advance the insertion location by an amount equal to the duration of the most recently completed note. For example, if the second note is a quarter note after the first note you added, then the first note will have a quarter note duration, and Composer will advance the insertion point to a quarter note duration beyond the location of the second note.
3. As long as each new note or chord has the same duration as the previously completed note or chord, you do not have to leave your music keyboard. Just keep playing more notes and chords.

4. If the next to-be-added note does not have the same duration as the most recently completed note, then move the mouse to the location for that next note before playing it at your music keyboard.

1.5.10 Tutorial: Adding Annotations

In this step of the tutorial, we will "dress up" a score with several types of annotations, which offer the musician reading the score instructions and suggestions for performing the music:

- accent marks
- dynamic marks
- hairpin crescendo marks
- tempo marks
- slurs (phrase marks)

Please note that if you plan to export your work as a MusicXML file to share with others that the MusicXML protocol associates annotations and dynamic markings with specific notes. Composer has the capability to associate some markings either with a note OR with a staff. If you plan to share your song file using a MusicXML filetype, then make sure that when adding dynamic markings that they are associated with a particular note, and not just the staff, so that they will show up properly in the receiving program.

We will start with an excerpt from the main theme of George Gershwin's Rhapsody in Blue. The starting file RhapsodyInBlueWithoutAnnotations.not will include only the notes, and no annotations. We will add one of each type of annotation listed above. To see what the completely annotated score looks like, you can open and view the file RhapsodyInBlue.not.

To open the starting file for this step of the tutorial:

1. Choose the Open command in the File menu, and open the file RhapsodyInBlueWithoutAnnotations.not in the directory C:\Users\Public\Documents\Notation_3\Songs

To add an accent mark:

1. With the mouse, navigate to the Accent Palette.

OR
Type SHIFT+A.

Technically, some of the symbols in the Accent Palette are not accents. Rather, these marks are annotations that are displayed immediately above or below notes.

2. In the Accent Palette, choose the type of accent you wish to add.

You can add two accents for the same note or chord by selecting two symbols in the Accent Palette.

3. Choose the Accent Palette option that determines whether the accent is displayed at the notehead or at the end of the stem.

4. Click the mouse somewhere near (on top of, above, or below) the note or chord where you want to add the accent.

5. To add more accents of the same type, click the mouse at other notes and chords. To add more accents of a different type, select a different accent from the palette, and then continue clicking the mouse where you want to add those accents.

To add a dynamic mark:

1. With the mouse, navigate to the Dynamic Mark Palette.

   -- OR --

2. Type SHIFT+D.
2. In the Dynamic Mark Palette, choose the first letter of the type of dynamic mark you wish to add.

   -- OR --

   Type the shortcut for the dynamic mark. For example, the shortcut for \( \text{mf} \) is "mf". The shortcut for \( f' \) is "f1", and for \( ff' \) is "f2".

3. Specify whether the dynamic mark should be placed above the staff, below the staff, between two staves, above a note, or below a note.

4. Click the mouse where you want to add the dynamic mark.

To add a hairpin crescendo mark:

1. With the mouse, navigate to the Crescendo Mark Palette:

   -- OR --

   Type "<" for a crescendo, or ">" for a decrescendo mark.

2. In the Crescendo Mark Palette, click the Crescendo Mark button or Decrescendo Mark button.

   This step is not necessary if you typed "<" or ">" in the previous step.

3. Click the mouse where you want the beginning of the crescendo mark to start. Do not release the mouse button yet.
Composer will add a new crescendo mark, which will initially extend to almost the barline of the same measure.

3. While still holding down the mouse button, drag the end of the crescendo mark to the left or right. Then release the mouse button.

4. Adjust the position of the crescendo mark by dragging the red handles.

Other options are available in the Crescendo Mark Palette for vertically centering the crescendo, or extending the start or end of the mark to an adjacent measure which is perhaps on a different line (system) or page of the score.

To add a tempo mark:

1. With the mouse, navigate to the Free Text Palette.
   -- OR --
   Type SHIFT+F.

2. Click the mouse where you want to add the tempo mark.
   Composer will display a blinking text cursor.

3. Type the tempo mark text, and optionally use any text editing keys, such as \text{Del} and BACKSPACE, in the same way that you edit lyrics.

4. Optionally, click buttons on the Free Text Palette to increase \text{A} or decrease \text{A} the font size of the text, or to make it bold \text{B} or italic \text{I}.
   -- OR --
Type CTRL+ or CTRL+ to increase or decrease the font size, and CTRL +B or CTRL+I for bold or italic.

5. Hit the ESC key when you are done typing and editing the tempo mark text.

6. To move the free text object, unselect it first by typing ESC or clicking elsewhere in the score. Then click the mouse on the text, and without releasing the mouse button, drag the text to a new position.

It is also possible to mix music symbols with normal text in free text objects. For example, you can create a tempo mark that looks like this:

\[ \text{Andante moderate } \left( \frac{d}{8} = 78 \right) \]

For instructions, see Mixing Music Symbols and Normal Text.

To add a slur (phrase mark):

1. With the mouse, navigate to the Slur Palette:

   -- OR --

   Type SHIFT+S. If the Sustain Pedal Palette is displayed first, type SHIFT+S a second time for the Slur Palette.

2. To add a slur across several notes:
   - Click the mouse where you want the slur to start, but do not release the mouse button yet.
   - Drag the end of the slur to the last note that should be under the slur.
   - Start and end the slur above the notes to draw the slur above the notes. Start and end the slur below the notes to draw the slur below the notes.
   - Release the mouse button to complete the addition of the slur.

Composer will automatically fit the slur to the contour of the notes above or below, and will adjust the start and end of the slur to appropriate positions relative to the first and last notes under the slur.
In many cases, you will likely find Composer's automatic placement of the slur quite acceptable. However, if desired, you can adjust the start and end position of the slur, and the shape of the slur.

3. Adjust the position and shape of the slur by dragging the red handles.

Try dragging the four red handles to get a feel for how they work. For details, see Changing the Shape and Extent of a Slur.

1.5.11 Tutorial: Viewing and Quantizing the Performance

In the previous step of the tutorial, you added some "polish" to the sheet music notation with annotations such as accent marks, dynamic marks, and slurs. In this final of the tutorial, you will add some polish to the playback performance of the song. In Composer, you can have an equally high level of control over both what the music looks like and what it sounds like.

This step of the tutorial describes one way that you can edit the performance of a song that you have opened as a MIDI file, or recorded from your keyboard, or for which you have manually entered notes. Even if you do not intend to edit the performance of the song, you might find it entertaining and educational to view the performance of the notes with various features offered by Composer. This step of the tutorial describes how you can view the performed timing of notes.

Composer also offers other ways that you can view and change the individual loudness of notes, pitch bend of notes, tempo changes, per-staff volume changes, and other aspects of the performance. For details, see Viewing and Editing the Music Performance.

The MIDI file Twinkle.mid was originally prepared by recording live improvisations of keyboard accompaniments, using Composer's recording feature. Although about ten recording "takes" for different sections of the song were made to try out different ideas for the piano accompaniment, there has been no editing of the actual performed rhythms. The melody staff of Twinkle.mid uncannily has an appropriate child-like quality, due to the imprecision with which the melody was originally performed.

For many styles of music, and perhaps this Twinkle Twinkle Little Star song, it is desirable to preserve the original performed timing of the notes-- starting location (attack) and ending location (release). When initially editing notes of any song, Composer changes both the notation and the performance. You can, however, edit only the notation or only the performance if you desire.

For some styles of music, it is indeed desirable to "clean up" the performance so that the performed timings of notes are exactly on the beat, that is, so that the timings of the notes are exactly as notated. This procedure of cleaning up the performance is typically called "quantization", especially in MIDI sequencing software and hardware. In Composer, the term "snap" is often used instead of "quantize". The performed attacks of notes can be "snapped" to the notated rhythms. And the performed durations of notes can be "snapped" to the notated durations.

Quantizing a performance can have the undesired effect of draining the life out of a performance, so that it sounds too mechanical. You can avoid this by snapping only the attacks of notes but leaving the duration of the notes as originally performed. In a MIDI performance, the "articulation" of a note is mostly determined by (1) the loudness of that note and (2) its duration. If you leave the originally performed duration of the note unchanged, then the human feel-- the articulation-- of the note will be partly preserved, even when you snap the performed attack of the note to its notated location.

In this step of the Twinkle Twinkle Little Star tutorial, we will follow the guideline suggested in the previous paragraph, in order to preserve most of the human feel of the performance. That is, we will quantize only the attack location of the notes, but leave the performed durations unchanged. Said more accurately, we will leave the performed release times of the notes unchanged.

The first procedure shows you how to view the performed timing of notes, before you change the timings.
To prepare to edit the performed timings of notes:

1. Click the Piano Roll tab in the main palette. Please note: clicking on View/Show Piano Roll will NOT allow editing; it is just for viewing while doing other edits such as adding annotations to the score.

Composer displays the score as shown below. The rectangles drawn on top of the notes show the actual performed timing of the notes. These rectangles are called "Piano Roll Notation". This graphical representation resembles the hole cutouts for notes in piano rolls of mechanical player pianos that were popular in the late 1800's and early 1900's.

The left and right edges of a piano roll rectangle represent the actual performed timing of the note attack and release. The left edge of the rectangle divides the width of the notehead in half if the performed attack of the note is exactly at the notated rhythm. The right edge of the rectangle extends exactly to the middle of the next notehead if the performed release of the note is exactly at the notated location of the next note.
2. Click the Edit As-Performed button in the Piano Roll palette.

That instructs Composer that you intend to edit the as-performed rhythms of the notes without changing how they are notated in the sheet music. In response, Composer now displays the notes in a lighter gray color, to confirm that you will be editing just the performance (piano roll rectangles) of the notes, and not the sheet music notation of the notes.
To get a report of the exact performed timings of notes:

- Select one or more notes.

Composer will report the average offset of the as-performed timing of the note from the as-notated attack and release locations of the selected notes, as illustrated below:

The unit of measurement here is a tick. There are 480 ticks per quarter note (regardless of the tempo or meter of the song).

To snap (quantize) the performed attacks of notes to their as-notated locations:

Before following these steps, first play the song, and listen to the timing of the notes. Especially, listen to the first note of the last measure in the melody. Remember, in an earlier step of this tutorial, that note was performed so late that Composer originally notated it as a sixteenth note past the beginning of measure. Even though we corrected the notation for that note, so that it starts at the beginning of the measure, the performance of the note was left unchanged. The note still sounds somewhat late.

1. Select the notes whose performed attacks you wish to snap to their as-notated locations.

   There are several ways you can select notes, To select a few adjacent notes, just drag the mouse over them.

   To select all of the notes for the entire score, type CTRL+A, which is the standard Windows shortcut for Select All. Then choose the Convert Region to Notes command in the Region menu, or type "qcrn" for Quick Convert Region to Notes.

2. Click the Piano Roll tab in the main palette.

3. Click the Snap As-Performed Attack to As-Notated Attack button.
Now play "Twinkle Twinkle Little Star" again. It is now played with a very precise rhythm, even though much of the expression of the song is preserved because the note releases were not quantized. We only quantized the note attacks in the above procedure. Listen again to the last measure of the melody. Notice how the first note in the last measure is now played exactly on the beat. It is no longer delayed as it was in the original performance.

You now have briefly explored how you can polish the sound of the song as well as the sheet music notation of the song.

Congratulations! You now know the basic procedures to accomplish most common tasks in Composer. Now, explore Composer on your own to learn about the many more types of notation and performance editing you can do. And, of course, read other parts of this Composer documentation for a more structured exploration of Composer’s features.
2 Opening, Transcribing, Printing, Playing, and Saving Songs

This section of the Composer documentation describes how to work with song files as a whole. Other sections of the documentation describe how to edit details of the music and the score.

Composer reads and writes the following file formats: MIDI (.mid), Karaoke (.kar), and the Notation (.not) file type used by Notation Musician and Notation Composer. Composer imports and exports music scores as MusicXML (.xml) files that can be read by other music notation programs, such as Finale™ and Sibelius™ as well as exports audio files using the Notation Software Synth...

2.1 Music File Formats That You Can Use in Composer

The following table identifies common music file formats that Composer does and does not support.

<table>
<thead>
<tr>
<th>File Type</th>
<th>Description</th>
<th>Extension</th>
<th>Opens</th>
<th>Saves/Exports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notation</td>
<td>Special format for music notation and performance used by all software programs by Notation Software.</td>
<td>.not</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>MIDI</td>
<td>Music performance data, not music notation data.</td>
<td>.mid</td>
<td>MIDI File Type 0 and 1</td>
<td>MIDI File Type 1 (but not Type 0)</td>
</tr>
<tr>
<td>Karaoke</td>
<td>A version of MIDI file that includes specialized lyrics information.</td>
<td>.kar</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>MusicXML</td>
<td>A standard file format for exchange music scores between music notation programs.</td>
<td>.xml</td>
<td>.musicxml</td>
<td>.mxl</td>
</tr>
<tr>
<td>Wave</td>
<td>An audio sound wave file format.</td>
<td>.wav</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>MP3</td>
<td>A compressed audio sound wave file format.</td>
<td>.mp3</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>OGG</td>
<td>A compressed audio sound wave file format.</td>
<td>.ogg</td>
<td>no</td>
<td>yes</td>
</tr>
<tr>
<td>FLAC</td>
<td>A compressed lossless audio sound wave file format.</td>
<td>.flac</td>
<td>no</td>
<td>yes</td>
</tr>
</tbody>
</table>

"Does Composer transcribe audio files or CD music to notation?" Composer does not do this. Some music software can do this only for very clear single note instruments and voice. Many audio engineers have spent years attempting to develop software that can identify what pitches are being
played by what instruments at what times in an audio recording. But there has been very little success
for music in which more than one note is played at a time.

2.2 Opening a MIDI or Karaoke File Already on Your System

Composer not only helps you compose music, but one of the most powerful features of Composer is
that it can open MIDI and Karaoke files and transcribe them into music notation with amazing
accuracy.

A MIDI file usually has a .mid or .midi file name extension.

A Karaoke file is a special type of MIDI file, which has a lyrics staff normally intended to be
displayed as text without notes. A Karaoke file usually has a .kar file name extension. Most Karaoke
playing programs display only the lyrics; but Composer displays both the lyrics and the notes. Since a
Karaoke is technically only a special type of MIDI file, this Composer documentation will sometimes
use the terminology MIDI file to refer to both MIDI and Karaoke files.

When Composer opens the MIDI or Karaoke file, it preserves all of the fine details of the musical
performance. Even though Composer nicely rounds off notes to readable note durations, the
underlying exact timings of the notes are preserved and accurately performed by Composer during
playback. If Composer does not perfectly transcribe the note locations, durations, and rests, you can
edit them without changing the underlying performance. However, you can also fully edit the underlying
performance, including note locations, durations, rests, loudness, along with fancier details such as
pitch bends.

After you open a MIDI or Karaoke file, you may want to rearrange the parts to match those in your
ensemble. If you are a pianist or keyboardist, you might want to condense several instrument parts into
a keyboard arrangement. Composer is particularly well-designed for such purposes.

If you do compose music, Composer is an ideal tool for quickly recording your musical ideas from a
music keyboard or from the mouse and computer keyboard. However, you may have already
composed your music using another MIDI software program. In that case, you can easily open the
MIDI file that you originally created with another program. Thereafter, you can use Composer to
continue your work using tools that are particularly intended for composers who enjoy working with
music notation.

To open a MIDI or Karaoke file on your system using "Drag and drop":

1. Open Composer.
2. With a Windows Explorer window open to your file location, or from the desktop if that's where
   the file is, click and hold the file, and then drag it over to the open Composer window and
   "drop" it there.

To open a MIDI or Karaoke file on your system using the File Open dialog:

1. Choose the Open command from the File menu.
   -- OR --
   Type CTRL+O, the standard Windows shortcut for the File Open command.
   -- OR --
   Type ALT+F to open the File menu, followed by "O", for the File Open command.
Composer will display the File Open dialog box. By default, Composer will show you files in the C:\Users\Public\Documents\Notation_3\Songs directory, as illustrated here:

2. If the MIDI file you want to open is in another directory, navigate to that directory in the File Open dialog box.

3. If your MIDI files are usually located in a particular directory, then you may find it convenient to specify that one as the default directory in the File Open dialog box. After navigating to your directory of choice, add a check mark to the box labeled "Set as default directory".

4. Optionally click the Transcription Options to specify how Composer should transcribe the MIDI data into music notation. Otherwise, Composer will use the transcription options you have most recently specified.

The transcription options determine whether:

- Standard versus jazz (swing) rhythm notation will be used.
- Single voices or split (upper and lower) voices will be detected and notated.
- Grace notes, trills, and tremolos will be detected and notated.
- Overlaps of notes will be removed to reduce the number of ties in the score.
- Rests smaller than a specified size (quarter, eighth, or sixteenth) will be removed.
- Certain types of adjustments to the staves will be recommended, such whether single-track keyboard parts are automatically split into right- and left-hand staves.
- Lyrics greater than a certain length (default 12 characters) are hidden, which is what you'll typically want to do for lyrics that really are MIDI file author comments and copyright notices.

For details about the above options, see Transcription Options.

5. If the file is a Karaoke file, then after transcribing the file Composer will immediately present you with Step 1 of the Prepare Part Wizard. In Step 1, you will usually want to accept the default option for "Sing-Along" part. The Sing-Along part will display the Karaoke lyrics in a large font size, for easy reading from the screen.
If, after displaying the Karaoke lyrics part, you find that Composer chose the wrong staff for melody notes, then you can redo the preparation of the Karaoke part by using the Prepare Sing-Along Part command in the Staff menu. The dialog box for the Prepare Sing-Along Part is very similar to the above Prepare Karaoke Part dialog.

If you would like to view all of the accompaniment staves, as well as the lyrics staff, of the Karaoke file, then hit the Cancel button in the Prepare Part Wizard.

If you initially choose to display just the Karaoke part but then decide you would like to view the entire score, use the Undo command in the Edit menu to undo the operation "Prepare Karaoke Part."

For details about using the Prepare Part Wizard, see Preparing Parts.

To open a MIDI file from the Windows desktop Explorer or File Manager:

- If during the Composer installation you chose to associate the Composer program with MIDI files (*.mid or *.kar file name extension), then in the Windows desktop explorer or File Manager you can double-click a MIDI file name to automatically start Composer and open the file.

**TIP:**
If you want to change the association of Composer with MIDI files (.mid or .kar extension), you can remove or add the file association using the Associate Composer with .MID Files command in the Setup menu.

### 2.3 Opening a MusicXML File Already on Your System

When opening a MusicXML file (.xml, .mxl, or .musicxml), Composer brings in the notation, the annotations, and the dynamic marks of the file.

You can select whether you want the opened file to use the original fonts that are in the MusicXML file, or if you want to use the default fonts that you have set up already in Composer. You can review the default font settings you have by clicking Format -> Font...Styles. See the section on "Assigning font attributes" for details on editing these.

**To select whether to use the original fonts or your default font settings in the MusicXML file you are opening:**

1. Before opening a file, on the Menu bar click on Setup
2. Then click to "check" the "Import fonts from MusicXML file" if you want to keep the original fonts from the MusicXML file. To use your default fonts in Composer when you open a MusicXML file, be sure there is no "check mark" by the option to "Import fonts from MusicXML file."

3. After opening the file, you can still use Composer's font editing capabilities to make any further changes.

To open a MusicXML file on your system using "Drag and drop":

1. Open Composer.

2. With a Windows Explorer window open to your file location, or from the desktop if that's where the file is, click and hold the file, and then drag it over to the open Composer window and "drop" it there.

To open a MusicXML file on your system using the File Open dialog:

1. Choose the Open command from the File menu.
   -- OR --
   Type CTRL+O, the standard Windows shortcut for the File Open command.
   -- OR --
   Type ALT+F to open the File menu, followed by "O", for the File Open command.
Composer will display the File Open dialog box. By default, Composer will show you files in the Default directory, and will be set to open any of the filetypes that it can handle.

2. If the song you want is not in the folder, navigate to the file's location, then click on it and then the "Open" button. You can set any folder you wish as the Default folder for opening simply by clicking in the box for "Set this directory as default folder for song files."

3. You can select whether to import the

The song should appear very much like it did in the original music program that created it, and you can review, edit, and play it using all the tools available in Composer.
Also note that volume changes that are associated with dynamic marks (eg. ff, p, etc.) will be incorporated into the newly opened file IF there was a corresponding MIDI volume change in the score. Most other music notation programs are score writing only, and so won’t include the MIDI performance data for such performance changes.

Please note that the MusicXML protocol is not perfectly defined and is an ongoing combined effort of many collaborating developers. If you should find any problems with opening a MusicXML file, please let us know at support@notation.com

2.4 Opening Multiple Files at Once

Notation Composer does not natively open multiple files at once, but you can set up the Windows® "Send to" feature to allow you to open multiple files at once (you can also use this method to set up other software as well.)

To set up "Send to" for Notation Composer on your machine:

1. Click on Windows Explorer and open a dialog.
2. In the address field, type "shell:sendto"

3. Right-click your mouse in the right-hand panel and select "New -> Shortcut".
4. Click the “Browse” button, and navigate to "C:\Program Files (x86)\Notation_3\Composer_3\Composer.exe" and click "Ok".
5. Click "Next" to continue.
6. Now enter a name for the shortcut - here we have named it "notation composer 3."
7. Then click "Finish."
8. Now when you are using Windows Explorer, you can select multiple files in any folder, right click and choose "Send to -> notation Composer 3" (or whatever you named the shortcut), and all the files will open in Composer.
2.5 Associating Notation Composer with Compatible Filetypes

You can set up Windows to always use Composer to open a MIDI (.mid), NoteSoft (.not), MusicXML (.xml, .mxl, .musicxml) or Karaoke (.kar) file when you open it from Windows Explorer, or download it using Internet Explorer™ or another browser.
To associate Composer with compatible files:

1. In Windows Explorer, navigate to a .mid, .not, MusicXML (.mxl, .xml, .musicxml), or .kar file on your computer.
2. Right-click on the filename, and select "Open with..." then "Choose default program" from the list.
3. Select Composer from the list, and set a checkmark for "Always use the selected program to open these files."
4. Click "Ok" to save and exit.

To remove the association of Composer with specific types of files:

1. Follow the same procedure as above, but remove the check mark(s).
2. After you remove the association of Composer with the filetype, the next time you open one of these files Windows might ask you to choose which new program to associate with it. You should follow Windows instructions for making the new file association.

For internet browsers, you will need to follow the instructions for the particular browser to set Notation Composer as the default program to open compatible files. These options are typically in "Options" or "Preferences", and are related to "Programs" or "Applications."

2.6 Searching for and Downloading Song Files from the Internet

You can use your favorite Internet browser, such as Chrome, Firefox, or Microsoft's Internet Explorer to search for and download song files from the Internet. If you have associated the compatible filetypes with Composer, then as soon as the download of the file has completed, Composer will automatically start up and open the file. You will see the MIDI or Karaoke file transcribed to sheet music, or the MusicXML file opened and converted to an editable file in Composer.

Also, you can use your favorite Internet browser to download song files to a folder on your system. Then you can use Composer's File Open command to open any of the compatible downloaded song files.

2.6.1 Using Composer's Internet Browsing Window

In order to download a MIDI file, Karaoke file, MusicXML, or Zip file from the Internet, you need to first navigate to a web site that offers these files.

TIP: Due to the ongoing enhancements and updates of modern browsers, we strongly encourage you to use your favorite browser for finding and downloading music files. You can set this option by clicking File...choose internet browser. Then click to check "Your system internet browser" to have Composer use your usual browser to look for files.

To start browsing for MIDI files on the Internet:

- Click File -> Download MIDI files from the internet.

You can instruct Composer to always initially open some particular web page by using the Set Initial Web Page command.
The following instructions are for using the built-in web browser in Composer.

To navigate to other web pages on the Internet:

- Position the mouse over highlighted text. Near the bottom of the browse window, you will see a web page location. If you click the mouse on the highlighted text, the browser will take you to that location.
  -- OR --

- Type in the location (URL) of the web page in the "Location" box near the top of the page. It is not necessary for you to type in the leading "http://" characters. Press the ENTER key to complete the entry of the location.
  -- OR --

- To view the previous web page that you last visited, click the Back button. If you have browsed back to a previous web page and want to return to the more recently reviewed page, click the Forward button.
  -- OR --

- Click the down arrow at the right side of the "Location" box to list the most recent web pages you have visited. Then click one of the web page locations in the list to view the page again.

To interrupt the downloading of a web page:

- Click the button. This option is handy if the web page is taking too much time to download, which sometimes happens if the web site offering the page is temporarily not working or too busy.

To exit the browser:

- Click the button.
  -- OR --

- In the Window menu or File menu, choose the Close Window command.
  -- OR --

  2.6.2 Specifying the Initial Web Page for Browsing

This information is only when using Composer's built-in internet browser. For other browser's you can simply use bookmarks or whatever settings you have available for visiting favorite sites.

When you use the Browse Internet for MIDI Files command in the File menu to start searching for MIDI files on the Internet, Composer will first take you to Notation Software's web page with suggestions for searching for MusicXML, .mid and .kar files. You can specify a different default web page. Then, whenever you use the Browse command, Composer will first take you to that web page instead.
To specify the initial web page for browsing:

1. In the browser window, navigate to the web page that you wish to establish as the initial web page for browsing.
2. In the Preferences menu of the browser window, choose the Set Initial Web Page command.
3. The dialog box will display the web page location (URL) for the page you are currently viewing. You can enter a different web page location if the currently viewed page is not the one you want.
4. Click the OK button.

### 2.7 Transcribing MIDI Files and Recordings to Notation

If you use Composer to record your performance on a MIDI keyboard, Composer will automatically display your performance on the screen as music notation. The process by which Composer converts your performance into notation is called transcription.

When you open a MIDI file, Composer transcribes the performance in the MIDI file to notation. The data stored in the MIDI file is basically a recording of what notes (pitches) are played at what exact times by various instruments (in staves). The process that Composer uses to transcribe your performance at your music keyboard to notation is exactly the same transcription process that Composer uses to convert MIDI files to notation.

A good way to understand transcription is to think of the MIDI performance as a piano roll used on player pianos that were popular in the late 1800's and early 1900's. The holes in the piano roll determine what notes are played at what times. If you unroll the piano roll horizontally, you will observe that the holes mark the beginning and ending times of played notes. The vertical position of the holes determine the pitch of the notes.

Here is an example of a piano roll:

Basically, the above piano roll is all that Composer is given when it must transcribe your recording at the keyboard, or a MIDI file, to notation. Composer is able to transcribe the above piano roll information into notation. This example happens to be the Bach Minuet file, minuet.mid, that is installed in the C:\Users\Public\Documents\Notation_3\Songs directory. The result of the transcription looks like this:

In Notation Composer, you can see the Piano Roll Notation that underlies the notation. This is particularly useful when you want to edit the exact timing of notes without changing the notation. Here is what the above example looks like when you click the piano roll button in the main toolbar:
Composer must make many decisions about how to transcribe any given MIDI performance to notation. These decisions are similar to those that a trained musician would make when he or she hears music and writes down the notes on paper. (Very few musicians have this special training in "music dictation").

Some decisions about how to transcribe the music are closely related to the style of the music. Composer does not attempt to determine what the style of music is, in order to make the appropriate decisions in transcribing the MIDI performance to notation. Instead, Composer lets you make a few simple choices about how to transcribe the music.

In particular, you can instruct Composer to:

- Choose either Standard or Swing style in determining how to display rhythms such as illustrated here:
  
  **Standard Rhythm**
  
  ![Standard Rhythm](image1)
  
  **Swing Rhythm**
  
  ![Swing Rhythm](image2)

- Detect and display split upper and lower voices as opposed to single voice, as illustrated here:
  
  **Split Upper and Lower Voices**
  
  ![Split Upper and Lower Voices](image3)
  
  **Single Voice**
  
  ![Single Voice](image4)

- Remove overlapping notes in order to reduce the number of ties, as illustrated here:
  
  **Transcription Without Removal of Note Overlaps**
  
  ![Transcription Without Removal of Note Overlaps](image5)
  
  **Transcription With Removal of Note Overlaps**
  
  ![Transcription With Removal of Note Overlaps](image6)
- Remove rests smaller than some size you specify, such as a quarter rest, as illustrated here:

  **Transcription With Eighth Rest**
  **Transcription With Quarter Rest**
  **Minimum Size**
  **Minimum Size**

- Detect grace notes, trills, and tremolos.

  **Transcription Without Detection of Ornaments**

  **Transcription With Detection of Ornaments**

The options described above are offered in the Transcription Options dialog described in the next topic. **Composer** offers you the opportunity to specify the transcription options in several circumstances:

- When you open a MIDI file, click the Transcription Options button in the File Open dialog box.
- As you download a MIDI file from the Internet, click the Transcription Options button in the File Save As dialog box.
- Before you record from your MIDI keyboard, choose the Transcription Options command in the Setup menu.
- When you use the Split Hands command, click the Transcription Options button in the Split Hands dialog box.
- When you use the Merge Staves command, click the Transcription Options button in the Merge Staves dialog box.

Also, after you have opened a MIDI file, or recorded a performance at your music keyboard, you can re-transcribe the performance using a different set of transcription options, by using the **Re-Transcribe** command.

---

**About Quantization**

If you have used other music notation programs with a transcription feature, that feature very likely includes an option for specifying the "quantization level". Such an option tells the program to round note duration values and attack times to the nearest, say, thirty-second note, or sixteenth note. Rather than using "quantization", **Composer** has a better way of determining note durations and attack times than simply rounding to some nearest value. Such quantization only works well for fairly simple rhythms. Notes with long values tend to be "over-enthusiastically" notated with extra dotted values and ties. Separate notes with short values and small differences in attack times may be incorrectly collapsed into chords. **Composer** does a much better job at transcribing rhythms than notation programs that use a simple quantization approach. **Composer** analyzes the rhythmic context of each note to determine what quantization level to apply to the note.
2.7.1 Transcription Options

For an overview of how Composer transcribes an opened MIDI file, or the recording of your performance at the music keyboard, to music notation, see the preceding overview topic, Transcribing MIDI Files and Recordings to Notation.

The Transcription Options dialog box offers you the opportunity to determine how Composer transcribes an opened MIDI file, or the recording of your performance at the music keyboard, to music notation:

There are several ways that you can access the Transcription Options dialog box:

- Choose the Transcription Options command in the Setup menu.
- Click the Transcription Options button in any of the dialog boxes for File Open, Split Hands, or Merge Staves, and also the File Save As when downloading a MIDI file from the Internet.
- Choose the Re-Transcribe command in the Format menu.

The transcription options you choose will be applied in all subsequent transcriptions, not only in the current session in which you are running Composer, but also in future sessions. The transcription options will apply to newly opened MIDI files and recordings from your keyboard, as well as the Split Hands and Merge Staves commands.

Each of the transcription options are described below. To Retranscribe a song that is already open, you can use the Format / Retranscribe command.
Detect and Display Voices

The difference between the two voice options is illustrated here:

**Split Upper and Lower Voices**

![Split Upper and Lower Voices](image1)

**Single Voice**

![Single Voice](image2)

Choose the Split (Upper and Lower) Voices option under these circumstances:

- The MIDI file includes keyboard parts, or your recording is at a music keyboard.
- You want the notation to clarify how some notes are held for longer durations while other notes played at the same time are held for shorter durations.

You can simplify the notation by choosing the Single Voice Only option, but only if you also choose the Remove Overlaps of Notes option. The above single voice example is actually more difficult to read than the split voice example, because the overlappings of notes has not been removed.

Remove Overlaps of Notes

The result of choosing the Remove Overlaps of Notes option is illustrated here:

**Transcription Without Removal of Note Overlaps**

![Transcription Without Removal of Note Overlaps](image3)

**Transcription With Removal of Note Overlaps**

![Transcription With Removal of Note Overlaps](image4)

Removing overlaps of notes reduces the number of ties, and thus simplifies the overall notation. However, this also results in notation that less accurately represents the actual duration of notes.

If you are working with keyboard parts and find that transcriptions have too many ties, you first should consider choosing the Split (Upper and Lower) Voices options. Then, if there are still too many ties, use the Remove Overlaps of Notes option.

If you are working with single-note instrument or vocal parts, then choose the Single Voice Only option and the Remove Overlaps of Notes option.

Reduce Rests Smaller Than...

If you find that Composer transcribes with too much accuracy with respect to the use of dotted note values and rests, then you can instruct Composer to eliminate any rest that is smaller than a certain size (quarter rest, eighth rest, or sixteenth rest), as illustrated here:

**Transcription With Eighth Rest Minimum Size**

![Transcription With Eighth Rest Minimum Size](image5)

**Transcription With Quarter Rest Minimum Size**

![Transcription With Quarter Rest Minimum Size](image6)

In general, you should choose a smaller minimum rest size for slow tempos, and a larger minimum rest size for fast tempos. In slow tempos, you may want the notation to clarify the duration of notes.
and rests. In fast tempos, you may want to reduce the complexity of the notation by eliminating smaller rests.

Rhythm Style

In jazz and swing styles of music, triplets with a missing middle member are quite common. There is a convention in jazz and swing notation that simplifies the notation of such partial triplets by displaying the two members of the triplet as a simple pair of notes with equal durations. You can instruct Composer which style of rhythm notation to use, as illustrated here:

![Standard Rhythm vs Swing Rhythm](image)

Transcribe Ornaments

Composer recognizes grace notes, trills and tremolos. Instead of literally writing the notes of the ornamented performance, Composer displays the standard notation for the type of detected ornament. All of the details of the ornament's performance are preserved— the exact timing of the notes and the loudness of each note. You can view the written-out performance at any time, and edit the performance. While viewing the written-out performance you can edit details of the performance— the timing and loudness of the notes.

Transcription Without Detection of Ornaments

Transcription With Detection of Ornaments

Staff Adjustment Recommendations

Composer recognizes certain common problems in MIDI files, and offers you the opportunity to immediately fix those problems when opening the MIDI files. The most common problem is that a keyboard part in a MIDI file might have only one track, so that the notes for the right- and left-hand staves would otherwise be mixed together into a single, unplayable staff. If you choose the Transcription Option for Composer to automatically detect when a keyboard track probably needs to be split into right- and left-hand staves, then when Composer opens such a MIDI file, you will be presented with a dialog box such as the following:
If you do not correct these kinds of problems with the MIDI file when you first open it, don’t worry, you still have another chance to fix the problems later. The following table indicates what commands you can use that accomplish the same thing as the automatic corrections:

<table>
<thead>
<tr>
<th>Transcription Recommendation</th>
<th>Alternative Command You Can Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard staff probably should be split into RH and LH staves.</td>
<td><strong>Split Hands command in the Staff menu</strong></td>
</tr>
<tr>
<td>The order of a pair of keyboard staves probably should be switched from LH/RH to RH/LH.</td>
<td><strong>Move Up and Move Down buttons in the Staff Setup window (Staff menu, Setup command)</strong></td>
</tr>
<tr>
<td>The keyboard RH/LH staves should be ordered before other instrument staves.</td>
<td><strong>Move Up and Move Down buttons in the Staff Setup window (Staff menu, Setup command)</strong></td>
</tr>
<tr>
<td>Two-note chords in a staff that has mostly solo notes should be sequenced as two separate notes.</td>
<td><strong>Convert To Solo Notes command in the Staff menu</strong></td>
</tr>
</tbody>
</table>
Transcription of Lyrics

Many MIDI files have one or more tracks with no notes but with a "lyric", which is actually some notice that the author of the MIDI file wishes to be kept with the file, such as a "by line" or copyright notice. Notation Composer respects the intention of the author of the MIDI file to preserve this information with the file. However, it is typically distracting to see a newly opened MIDI file with one or more empty tracks with these notices.

Composer offers you the option to temporarily hide this information. It is still kept in the song file, and will be included when you resave the file in any of the file formats: MIDI (.mid), Karaoke (.kar), or Notation (.not). This information will only not be saved if you choose to delete the track (staff) that holds this "lyric" information.

You can view such temporarily hidden lyrics by going to the Lyrics palette, and turning on Reveal Hidden Lyrics button, as illustrated here:

![Diagram showing how to reveal hidden lyrics](image)

2.7.2 Re-Transcribing a MIDI File or Recording

When you open a MIDI file, or record from your music keyboard, Composer applies the transcription options that you have most recently specified in the Transcription Options dialog. If you are not satisfied with the results of the transcription, you might be able to improve the results by choosing different transcription options. You can select specific staves to which the new transcription options are applied.

**NOTE:** The Re-Transcribe command keeps notes and lyrics in the re-transcribed staves, but discards all other kinds of editing you may have made after the original transcription of the MIDI file or recording of your performance at your music keyboard. Some examples of editing changes that will be discarded are editing of: enharmonic spellings, beams, dynamic marks, free text, and crescendo marks.

Therefore, it is a good idea to review the transcription of a song or staff immediately after you have opened the MIDI file, or recorded a performance on your music keyboard. If you want to re-transcribe the song or staff, do that before you start editing it.
To re-transcribe specified staves in a song:

1. Choose the Re-Transcribe command in the Format menu.
   -- OR --
   Type "qrt" for Quick Re-Transcribe.
   Composer will display the Re-Transcribe dialog box, such as the following:

2. Select the staves that you wish to re-transcribe. Click a staff name to toggle its selection. Use the buttons below the list of staves to select all of the staves, or to unselect all of the staves so that you can then select individual staves.

3. The re-transcription options are the same as those in the Transcription Options dialog box. Refer to the Transcription Options topic for a description of the options for voices, overlaps of notes, minimum rest size, and rhythm style.

4. If you wish to set the new transcription options as the default for future transcriptions, click the Set As Default button. This is equivalent to choosing the Transcription Options command in the Setup menu, and selecting the same options.

NOTE: Some MIDI files are recorded without reference to a metronome. Composer cannot correctly analyze the rhythms in such MIDI files on its own, nor can most other music notation programs.

You can tell whether a MIDI file has been recorded without reference to a metronome by following this simple procedure: After Composer has opened the MIDI file, start playback. Watch the vertical playback cursor (blue, by default) move along with the playback. Listen to playback and start tapping the beats with your hand or foot. Does the playback cursor move in synchronization with the beats you hear? If so, the MIDI file was indeed recorded with reference to a metronome. If the beat movements of the playback cursor do not relate to the beats you hear, then the MIDI file was recorded without reference to a metronome. For such files you can use the Rebar feature to adjust the barlines correctly, to get readable sheet music from the file, as well as preserve the nuances of the performance.
2.7.3 ReBar: Correcting the Barlines for Files Recorded Without a Metronome.

Sometimes you may find a file that was recorded, or may want to record a new song, without the constraints of a metronome. Notation Composer’s Rebar feature allows you to get excellent sheet music from such “metronomeless recording” files, while preserving the performance nuances of such files.

With Composer’s Rebar feature, you can:

- Play the song and then tap in the downbeats for each bar in the file. Composer then uses your recorded downbeat to correct the placement of the barlines in the song so that the notation will be properly transcribed for easy reading and playing.
- Use the "Beat zoom" to tap in individual beats for measures that have pronounced tempo changes, giving finer resolution for the notation transcription.
- Composer preserves the nuances of the song’s performance by keeping track of the performed tempos throughout the rebar process. This is a great way to create backing tracks that feel "live" and have the sheet music to go along with them.
- Get sheet music for MIDI (.mid) files you find that have a great performance, but were recorded without reference to a metronome. Such song files will have a much more "live" feel to them than one that is locked in with a metronome, and can be used for accompaniment tracks or other live performance opportunities.

Using the Rebar feature, you can start with a song that looks like this:

And turn it into this:

The topics in the following sections of the Users Guide will help you get quality sheet music while maintaining the fine performance of your song files.

How to determine if you have a "Metronomeless" file
2.7.3.1 How to Determine a "Metronomeless" File

How to determine if you have a "metronomeless" file that needs to be rebarred

Sometimes you will find a file where the beat cursor keeps time with the playback of the notes, but the barlines are misaligned with the downbeats. Please see the section on how to shift barlines to the right to correct those files.

The typical signs of a "metronomeless" file are:

- When opening the file in Composer the notation is very complicated or messy, and is quite likely unplayable.
- When you play the file in Composer, you will notice that the beat cursor does not "hit" on the beats of the actual performance.

The following screen shot shows what a rather simple file that was recorded without reference to a metronome might look like on first opening it in Composer. Notice the multiple dotted notes, chord notes that don't begin measures, and many excess ties in the notation:
Composer helps you get quality, playable sheet music from such files, while keeping the playing nuances for playback of these files by using the innovative Rebar feature to adjust the barlines appropriately. You can transform the above notation to get notation that looks like this:
2.7.3.2 Summary of Steps for Correcting Barlines Using the Rebar Feature

The Rebar Palette

The Rebar tool palette (keyboard shortcut "|") is located in the Staff Symbols tab. This picture shows how it typically appears, when the detail palette is "docked" horizontally at the top of Composer's window.

The main steps in the Rebar process are:

1. **Enter rebar lines**: You can quickly convert all the barlines in the opened score to editable barlines using the "Make barlines editable" button (keyboard shortcut "e"). This is the easiest method to start with for files that have barlines that are close, but not quite correctly placed.

    -- OR --

    Record rebar lines into the score using the "Record Barlines or Beats" button on the Rebar detail palette (keyboard shortcut "r") and tapping the Insert (INS) key on your computer keyboard. This method is useful for files that have tempo changes. If one or more measures has a substantial tempo change within the measure, you can turn "on" the Beat Zoom button to record in beats within the selected measure. Note that this "Record barlines or beats" button is not the same button as the main transport control "Record" button on the main toolbar.

    -- OR --

    Enter rebar lines using your mouse in "Add" mode. You can also enter beat markers with your mouse when the Beat Zoom is "on".

2. **Edit the rebar lines**: Change the meter associated with a rebar line, move, delete, or otherwise edit the rebar lines and meters using the Rebar tools on the detail palette.

3. **Review the notation**: After any editing step, you can see what the notation in the adjusted score will look like by using the "Show barline adjustments" button. The rebar lines are still editable at this point, and can be further adjusted and reviewed using the Rebar tools and "Show barline adjustments" until you are satisfied with the results.

4. **Finalize the score**: When you are satisfied with the notation that you see, use the "Finalize" button. This step changes all the rebar lines back to regular barlines, and shows you the final notation using the adjustments you made.

You can always go back through the rebar process any time you want but do be aware that any other types of edits you have done to your score will be lost if you use "Show adjustments" or "Finalize". If you stop working on your Rebar edits, Composer will save your rebar work at the point you stopped.
Tips while using the Rebar tools:

- We strongly suggest that you perform any rebar adjustments as the first editing that you perform on a file. Just as for Re-Transcribing a MIDI (.mid) file, using the Rebar feature's "Show barline adjustments" button or the "Finalize" button will lose any other scoring edits you may have made (e.g. enharmonic spellings, beams, free text), except lyrics.

- Using the Rebar feature to adjust the barlines (and thus the notation) is a step-wise process. Therefore, unlike other palettes, you cannot select other objects (such as notes or chord names) to work on while you are in the Rebar palette. You can still switch to another tab by clicking the other tab (e.g. Notes and Rests) and then working on those aspects of the score. However, trying to select other objects in the score while you are working in the Rebar palette will not automatically change the working tab.

- Like other editing palettes, you can use the Edit / Undo command at any point during your work in the Rebar palette. If you leave your file, or close Composer and save the file, your rebar editing will be saved at the point you closed the file. When you open the file next time to continue editing, you can resume where you stopped previously.

- Rebar objects show up red in the score. To select an object to edit, just use the mouse to click on it. The selected object will then turn blue, and you can use the Rebar palette tools to edit the rebar line and its associated meter. After editing and then finalizing the barlines, the red rebar objects will be erased to leave a "clean" score.

To see how to specifically use the Rebar tools for each of the above main steps, you can click the links above for each step, or go to the next page.

2.7.3.3 Using the Rebar Tools to Correct Barlines

The Rebar Palette

The Rebar tool palette (keyboard shortcut "|") is located in the Staff Symbols tab. This picture shows how it typically appears, when the detail palette is "docked" horizontally at the top of Composer's window.
We strongly suggest that you perform any rebar adjustments as the first editing that you perform on a file. Just as for Re-Transcribing a MIDI (.mid) file, using the Rebar feature's "Show barline adjustments" button or the "Finalize" button will lose any other scoring edits you may have made (eg. enharmonic spellings, beams, free text), except lyrics.

Using the Rebar feature to adjust the barlines (and thus the notation) is a step-wise process. Therefore, unlike other palettes, you cannot select other objects (such as notes or chord names) to work on while you are in the Rebar palette. You can still switch to another tab by clicking the other tab (eg. Notes and Rests) and then working on those aspects of the score. However, trying to select other objects in the score while you are working in the Rebar palette will not automatically change the working tab.

Like other editing palettes, you can use the Edit / Undo command at any point during your work in the Rebar palette. If you leave your file, or close Composer and save the file, your rebar editing will be saved at the point you closed the file. When you open the file next time to continue editing, you can resume where you stopped previously.

Rebar objects show up red in the score. To select an object to edit, just use the mouse to click on it. The selected object will then turn blue, and you can use the Rebar palette tools to edit the rebar line and its associated meter. After editing and then finalizing the barlines, the red rebar objects will be erased to leave a "clean" score.

You can always go back through the rebar process any time you want but do be aware that any other types of edits you have done to your score will be lost if you use "Show adjustments" or "Finalize". If you stop working on your Rebar edits, Composer will save your rebar work at the point you stopped.

Entering Rebar Lines

Sometimes the transcribed barlines of a file may be almost correct, and only need some slight adjustments to line up the barlines properly and give correct sheet music. Composer does put "reference" barlines in any file when the song is first opened, and these can be used as beginning points for lining up the barlines in a metronomeless recording. One of the easiest ways to adjust the barlines for measures is to make all the barlines into editable rebar lines and then quickly edit them.

To use existing barlines as starting points:

1. After opening the .mid file, or finishing recording, navigate to the Rebar palette in the Staff Symbols tab.
   -- OR --
   Type "|" to bring up the Rebar palette.

2. Click the "Make barlines editable" button (keyboard shortcut "e"). The score will now show the rebar lines and meters, which are now ready to edit, as in the following score, which is the same file as the picture above, but now with the rebar lines displayed:
Other files may have more complex tempo changes, or may just be so completely "off" from the transcribed barlines that it would be simpler to record in the correct (or nearly correct) placement of barlines using the "tap in" recording method.

1. It will probably be helpful to listen to the file a few times, so that you can hear and get a better understanding of where the tempo changes occur. This will help you to more accurately tap in the rebar lines during recording. Keep in mind that the rebar lines don’t have to be placed perfectly the first time you record. You can re-record the rebar lines for an entire song, or re-record just a selected region of the score ("punch in"). You also have many tools and options available for finely adjusting the rebar lines so that your notation will be correct when you finish.

2. After listening to the song a few times, and perhaps practicing tapping your computer keyboard’s "Insert" (INS) key on beat "one", you will be ready to record the rebar lines. To begin recording the rebar lines, click the "Record barlines or beats" button in the Rebar palette.

3. Composer will give you a couple of seconds to find the "Insert" (INS) key on your keyboard before the file begins to play. As the file plays, tap the "Insert" key (INS) button on your computer keyboard on every beat "one". You will notice that there will be a red rebar line inserted into the score at each place you tap.
4. When you are done, hit the Spacebar on your computer keyboard, or click the "Record barlines or beats" button again to stop recording.

At the end of recording, Composer will automatically re-transcribe the notation for the file according to the rebar lines that you have recorded. If you are not satisfied with your rebar line recording, you can re-record the entire song, or you can "punch in" a select region of the score. You can also see below for adjusting the rebar lines manually with the toolbar tools.

**Tip:** What if you notice that the rebar lines you record are not where you thought you tapped, or you see that each note highlights before you hear the note play? In this case, your MIDI playback device may have a problem with latency. "Latency" means that there is some time between when Composer "requests" the sound from the MIDI device, and the time you actually hear it. Composer now allows you to calibrate your MIDI Device using the same "Insert" (INS) key tap-in procedure as for recording rebar lines or beat marker lines. Just click the "Calibrate MIDI Device" button in the Rebar palette, or the command in the menu list, and follow the directions in the dialog box that appears. After calibrating your MIDI device, Composer will then save that setting, and adjust for the latency of that MIDI device when you play a file using that device or use the tap-in recording method for rebar lines or beat markers.

**To record rebar bar lines in a specific region ("punch in")**

1. Click on the "Select Region Mode" button in the main toolbar (or right-click your mouse to change modes).

2. Click-drag the mouse to select the region you would like to re-record.
3. Now click the "Record Barlines or Beats" button in the Rebar palette, to hear a short lead-in section, and then use your "Insert" (INS) key to tap in the first beat for each measure in the selected region as you listen.

4. When you are finished, Composer will automatically stop recording, and retranscribe the notation according to the new rebar lines you have just recorded.

You can also use your mouse to enter rebar lines. Using this method will not automatically display the change in the notation after each entry, but you can use the "Show Barline Adjustments" button to retranscribe the score and see the corrected notation whenever you want.

To Enter Rebar lines using the mouse

1. From the Rebar palette, click the "Add mode" button in the main tool bar (or right-click your mouse to change modes)

2. Now click in the score at the location (typically on a note) for the first beat of the measure where you want to enter a barline.

The meter that is associated with a rebar line affects how the notes of that measure are transcribed. In some cases you may need to change the meter associated with one or more rebar lines for the notation to be transcribed properly.

Correcting the meter of a measure

1. Select a rebar line by clicking on it and then click the "Change Meter" button in the palette

   -- OR --

   Double click the meter of a rebar line that you want to change.

2. In the Change Meter dialog, click the radio button of the meter you want for that measure, or click "Other" and enter the custom meter you want for the measure.
3. After selecting the meter you want for the measure (e.g., 3/4), click "Ok".

4. To see the corrected notation, click the "Show adjustments" button. **Composer** will then retranscribe the notation using the new meter for that measure.

**Beat Markers Within a Measure**

Some files may contain more dramatic changes in tempo within a single measure. Such tempo changes cannot be accurately transcribed to good notation just by adjusting the barlines.

For these situations, you can use the Beat Zoom button to enter individual beats in a selected measure or measures. Turning "on" the Beat Zoom means that beat marker lines can be added by using the same methods as for adding rebar barlines, but with the resolution adjusted to beats rather than barlines.
To Record Beat Markers

1. Using Region Select (the same as for selecting a region in "punch in recording" above), select the measure(s) that you want to record beat markers into.

2. It will probably be helpful to listen to the passage a few times, so that you can hear and get a better understanding of where the tempo changes occur. This will help you to more accurately tap in the beat marker lines during recording. Keep in mind that the beat marker lines don't have to be placed perfectly the first time you record. You can re-record the beat marker lines for the measure(s) you have selected as many times as you wish. You also have many tools and options available for finely adjusting the beat marker lines (such as "Shift to nearest next note") so that your notation will be correct when you finish.

3. After listening to the passage a few times, and perhaps practicing tapping your computer keyboard's "Insert" (INS) key on the beats you hear, you will be ready to record the beat marker lines. To begin recording the beat marker lines, click the "Record barlines or beats" button in the Rebar palette.

4. Composer will play a short bit before your selected region, to give you a couple of seconds to find the "Insert" (INS) key on your keyboard before beginning recording. As the file plays, tap the "Insert" key (INS) button on your computer keyboard on the beats. You will notice that there will be a red dashed beat marker line inserted into the score at each place you tap.

5. When you are done, hit the Spacebar on your computer keyboard, or click the "Record barlines or beats" button again to stop recording.

To Enter Beat markers using the mouse:

1. From the Rebar palette, click the "Add mode" button in the main tool bar (or right-click your mouse to change modes)

2. Make sure that the Beat Zoom button is "on".

3. Now click in the score at the location (typically on a note) for the first beat of the measure where you want to enter a barline.
4. Continue clicking on the specific notes that should be "on the beat".

5. When you are done entering beat marker lines, then click the "Show Adjustments" button. Composer will retranscribe the notation to adjust it for your beat markers.

---

Editing Rebar Lines
Composer Makes it easy for you to fine-tune the rebar line and beat marker adjustments so that the notation for your file will be playable and the performance will remain faithful to the recording when you play the file back.

*Please note that all the editing tools of the Rebar palette work the same for rebar bar lines or for beat marker lines.*

If you use the "Make barlines editable" command or button (keyboard shortcut "e"), you may find that there will be "extra" rebar lines that need to be removed, or rebar lines that need to be shifted to a previous or next note.
To delete a rebar line:

1. Click on the barline to select it.

2. Click on the "Delete" button to remove the rebar line (or press the "Delete" key on your keyboard).
Deleting all Rebar and Beat Marker Lines and Meters
If you want to remove all the rebar lines for a fresh start at entering and editing them, simply click on the "Delete All" button (or type "Shift + Del"). All rebar objects (rebar lines, meters, and any beat marker lines) will be removed from the score. No transcription changes will be made, and you can begin the process of editing the barlines from scratch.

Moving a Rebar line to the next note on the right
In this particular file the left-hand (bass clef) chords were intended to sound on beat 1. To edit any rebar line, simply click on it to select it for editing. Click on the rebar line to edit it, and then click the "Shift rebarline to next note" button (or type "Shift + right arrow key")

Moving a Rebar line to the previous note on the left
The process for shifting a rebar line to the left to correct the notation is similar to that for shifting the rebarline to the next note to the right. Using the "Show adjustments" button after either type of rebar line shift will then show you the newly transcribed notation. You can do the same type of shift for a beat marker line as well.
Moving the selection of a Rebar line

Using the "Select previous" button (left arrow key) or "Select Next" button (right arrow key) will change the selected object to the next rebar line or beat marker line in their respective direction.

Shifting the selected Rebar or Beat Marker line

In addition to shifting a rebar or beat marker line to the nearest note on either side of the line, Composer allows you to make adjustments that do not fall directly on a note. These types of adjustments are useful for songs that are syncopated or have other rhythmic variations.

- **Shift to Left** - When a rebar line is selected, clicking this button will shift the rebar line slightly to the left. This is handy for fine adjustments of intricate passages. (keyboard shortcut "Ctrl + Left Arrow")

- **Shift to Right** - When a rebar line is selected, clicking this button will shift the rebar line slightly to the right. This is handy for fine adjustments of intricate passages. (keyboard shortcut "Ctrl + Right Arrow")

Reviewing the notation after editing rebar and beat mark lines

If you choose to use the "Record rebar lines or beats" method of entering editable rebar lines or beats, then Composer will automatically retranscribe the notation after your recording to show you how the new rebars or beats will adjust the notation. If you manually enter rebar lines or beat markers with your mouse, you can use the "Show adjustments" button at any time to see how your edits affect the transcription of the notation. Using this command often will give you a good idea of how changes you make will affect the notation, and help you learn what steps will quickly give you the notation you want for your songs.
Opening, Transcribing, Printing, Playing, and Saving Songs

When you are satisfied with the positions of the rebar lines and any beat adjustments that you have made within measures, and have checked them using the “Show adjustments” command, then you are ready to Finalize your changes to the score. Using the “Finalize” command or button will (1) commit all notation changes to the score (2) preserve the original playback of the score by keeping the tempo changes of the performance and (3) remove the rebar and beat marker lines from the score.
After finalizing your barline and beat adjustments, you can now go on to do any further note editing or score annotations that you need to complete your score for great sheet music of your song. Just click another tab such as “Text” to leave the Rebar feature, and enjoy working on your score!

2.8 Creating a New Song File

Composer's New Song Wizard offers you an easy way to start a new score for any instrument, voice, or ensemble you want. In a short series of New Song Wizard steps, you will specify the following important details of the song:

- instrument(s) or ensemble
- meter (time signature)
- key signature
- number of measures
- song title

Of course, you can later change any of these details of the song, or insert meter and key signature changes throughout the song.
The New Song Wizard offers blank scores prepared for a wide variety of instrumental and vocal ensembles. If you do not find a prepared blank score that exactly matches your musical group, then you can prepare your own customized song template. A song template is simply another Notation file that serves as the initial blank score with the list of instruments and/or voices you need.

After you have created a new song, that might be a good time for you to add the song title and author information.

1. If no files are currently opened, then click the Sheet Music icon or the text "Create a New Song", which is displayed in the main part of Notation's window:

   CREATE A NEW SONG

   -- OR --

   Choose the New command in the File menu.

   -- OR --

   Type CTRL+N, which is the standard Windows shortcut for File Open.

   Composer will display the first step of a 5-step New Song Wizard.

2. At the first step of the New Song Wizard, select the ensemble, instrument, or voice that most closely matches your needs.

Composer shows you the results of your choices as you go through the steps in the New Song Wizard. The above example illustrates how the choice of the Voice and Piano ensemble
is immediately reflected in the score underneath the wizard window. You can move the wizard window out of the way if you need to see different parts of the initial score.

3. If you are creating a score for some solo instrument other than one in the list, then choose the ensemble named "Blank (one unknown instrument)":
Then click the Staff Setup button:

In the list of instruments at the bottom of the Staff Setup window, choose the desired type of instrument. Then click the OK button in the Staff Setup window.

**TIP:** If you intend to create several songs for this solo instrument, then create a song template for it. A good time to do that is immediately after you complete the New Song Wizard steps and have a blank score.

4. If you chose one of the ensembles, but it did not have exactly the list of instruments or voices you need, then click the Staff Setup button. That will display the Staff Setup window, such as illustrated above, except that it will list all of the instruments and voices in the ensemble. In this Staff Setup window, you can add and remove instruments, and optionally change their order.

**SIMILAR TIP:** If you intend to create several songs for this same revised list of instruments, then create a song template for it. A good time to do that is immediately after you complete the New Song Wizard steps and have a blank score.

5. Click the Next button in the wizard window, and continue through each of the steps to enter:
   - meter (time signature)
   - key signature
6. In the last step of the wizard, in addition to entering the song title, also specify whether the song should initially be displayed in Window View or Song View. Use the Set As Default option to save this selection for future new songs.

2.9 Creating Your Own Song Templates

If over time you intend to create several songs for the same ensemble, or even for a solo instrument for which there is not a pre-defined blank score, then it is a good idea to create your own customized song template. This is easy to do. A song template really is nothing more than a Notation (.not) file that you have chosen to reuse often as a starting point for a new song.

A song template is kept in a special directory, which is typically \Users\Public\Documents\Notation_3\Templates. When you use the New Song Wizard, Composer offers you the list of Notation (.not) files in this directory as candidate templates for your new song. You can prepare and add your own song template to this list.

Note that you can use song templates not only when you are creating a new song, but also when you want to apply formatting to an existing song. See the description of the Format Part Using Template command in the Format menu.

To create a song template:

1. Create a new song file.

   -- OR --

   Open a song file that already has the intended list of instruments. Remove all of the notes and musical annotations in it.

2. Add, modify and delete instrument staves to create the list of instruments you intend for the template.

   See, Adding New Staves, Changing the Instrument Sound of a Staff, and Deleting Staves.

3. Add or modify any page text that you want to appear in the score created from the template. For example, add your own name to the title page. See Adding and Editing Page Text and Specifying Page Text in Templates.

   Note that if you remove all page text from a song template, Composer automatically adds certain page text to any new score created from the template. On the first page, Composer will add a song title. On subsequent pages, Composer will add a page header, consisting of the song title and page number.

4. Save the song as a Notation (.not) file in the C:\Users\Public\Documents\Notation_3\Templates directory.

To edit an existing song template:

1. Use the Open command in the File menu, and choose a template (.not) file in the C:\Users\Public\Documents\Notation_3\Templates directory.

2. Edit the template file just as though you were editing a normal song file. The details of the template file that will be copied to a newly created song file are: the list of staves; the instrument sound assignments (MIDI device, bank, and patch) for each staff; and page text.

3. Save the template (.not) file using the Save command in the File menu.
2.10 **Editing the Song Title and Author Information**

After you have created a new song, you can add the song title and author information.

The song title is displayed on the title page of the song, if you choose to display it as *standard page text*. The author information, such as your name and copyright notice, is kept in a special place that can be viewed by another Notation Composer or Notation Musician user with the Song Titles and Authors command in the File menu.

- **To edit the song title and author information:**
  1. Choose the Song Title and Authors command in the File menu.
     - Composer will display the Song Title and Authors dialog box.
  2. In the dialog box, enter text for the:
     - song title
     - composer
     - arranger
     - lyricist
     - copyist
     - copyright notice
     - other information

2.11 **Saving Your Work in a Notation .not**

Notation Composer and Notation Musician use and share a proprietary music file format that includes not only MIDI performance data but also notation data. Normally, you should save the song in the Notation file format, used by Notation Software’s Notation family of music software products. A Notation file has the `.not` filename extension. You can export the music performance of a song as a MIDI file, but this is only the performance and not the annotations you may have added. Composer also allows you to export MusicXML files to share with others.

Only Notation music software programs can read and write files in Notation Software’s Notation .not file format.

**NOTE:** MIDI files contain almost no information about the notation of the music. If you wish to save your music notation and annotations, then you need to save it as a Notation .not file (preferred) or export it as a MusicXML file rather than export it as a MIDI .mid file.

You can save the music notation details of a score as a MusicXML file, and import it into another music notation program, such as Finale™ or Sibelius™. For details, see the section on exporting MusicXML files.

- **To save your work in a Notation .not file:**
  1. Choose the Save As command in the File menu.
     - Composer will present the File Save As dialog box.
     - You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default".
2. Enter a file name, or use the same file name if you are certain that you want the newly saved file to replace the old. Composer will automatically add the Notation .not file extension if you do not provide it at the end of the file name.

2.12 Exporting Your Work in Other File Formats

To export your song as a MusicXML file:

1. In the File menu, choose Export, then select "MusicXML" and the specific sub-type of MusicXML file you want to export. Composer can export MusicXML as .xml, .musicxml, or .mxl filetypes.
2. The default directory is \Users\Public\Documents\Notation_3\Songs. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default".

3. Select the MusicXML filetype you want to save from the drop list. If the exported score will be used in Sibelius, be sure to check the radio button in the lower left for “Export for Sibelius.”

4. Click "Save" to save the MusicXML file. When exporting MusicXML or other export filetypes, be sure to also save your work in a .not filetype for any future editing by using File/Save or File/Save as.

If you have volume changes that you want to save in your MusicXML file, you can insert dynamic markings where the volume changes occur. In these cases, Composer will save the volume at the dynamic mark and it will be saved in the exported MusicXML file.

To export your song as an audio file:

1. In the File menu, choose Export, then select "Audio" and the specific type of audio file you want to export. Composer can export .wav, .ogg, .flac, and .mp3 filetypes.

2. The default directory is \Users\Public\Documents\Notation_3\Songs. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default".

3. If after exporting you find that the exported file is either too loud or too low, please see how to adjust the gain for exported audio.
To export your song as a PDF .pdf:

Before exporting a PDF of your song it's a good idea to check each part you want to export in Page View first to make sure that all formatting is the way you want it to look.

Please note that when saving PDF files, each Part is saved in its own file and will be in the filename format "SongTitle_PartName.pdf" to make it easy for you to keep PDF Parts of the same song together in your folders.

1. In the File menu, choose Export, then select "PDF." The "Save Parts to PDF file" dialog will come up:

   ![Select specific parts to export](image1)
   
   Click on specific parts to select them to be exported as individual PDF files.
   
   ![Select all parts](image2)
   
   or click on "Select All Parts" to export all Parts to individual PDF files.

2. After selecting the Parts you wish to export (save) as PDF files, click "Ok."

3. You can then select the page range that you wish to export in the PDF then click "Ok." The default range is the entire score.

![Select range of pages](image3)

   Enter the numbers of the First page and Last page in the appropriate fields. The default is the entire score.

4. The Export as PDF File dialog will then come up, where you can navigate to the folder you wish to save the files in. The default directory is `C:\Users\Public\Documents\Notation_3\Songs`. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default". Click "Save" to save the PDF files in the selected folder. For each Part a progress window will come up showing you the progress of the export, and will close when the Part is done.
To export your song as an Image (.png, .jpg, .bmp, or .gif) file:

Please note that if you export multiple pages of a Part as an image file, that all those pages will appear in the same image file. If you plan to use the exported image to insert in a document (e.g., as a musical "snippet" example), then you probably want to just export the page where your example occurs and then use your favorite editor to crop the image.

To export an image file of your score:

1. In the File menu, choose Export, then select "Image...." The "Save Parts to Image file" dialog will come up:

   Click on specific parts to select them. A separate image file will be exported for each Part that is selected.

   or click on "Select All Parts" to export page(s) from each Part to individual image files.

1. After selecting the Part(s) you want to export an image from, click "Ok."
2. You can then select the page range that you wish to export in the image file(s) then click "Ok." The default range is the entire score.

Enter the numbers of the First page and Last page in the appropriate fields. The default is the entire score.

1. The "Save in:" dialog will then come up, where you can navigate to the folder you wish to save the file in, as well as select the image file type you want to export. The default directory is C:\Users\Public\Documents\Notation 3\Songs. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default." Click "Save" to save the image file(s) in the selected folder. For each Part a progress window will come up showing you the progress of the export, and will close when the Part is done.
To export your song as a MIDI .mid or Karaoke .kar:

1. In the File menu, choose Export, then select "MIDI".

For MIDI and Karaoke filetypes, Composer will present the Export MIDI File dialog box:
The default directory is C:\Users\Public\Documents\Notation_3\Songs. You can change the default directory, if desired, by navigating to another directory and then setting a check mark by "Set directory as default".

2. Enter the name of the MIDI or Karaoke file you wish to export, and select either "MIDI (*.mid)" or "Karaoke (*.kar)" from the "Save as type:" drop list.

3. If your keyboard or synthesizer needs to have the MIDI controllers cleared before a song begins playback, check the "Force MIDI Controller Reset at the start of the song" box.

4. Optionally set a check mark by "Quantize the note locations and durations as notated". Choose this option if you are using Composer as a tool for transcribing MIDI-to-notation, and wish to import the results into another music notation program. This will have the undesirable effect of making the MIDI performance sound very mechanical. However, this will adjust the notes so another music notation program can more successfully import and transcribe the MIDI performance. Said another way, Composer will do the hard work in transcribing the MIDI to notation, and the other music notation program can take advantage of Composer's MIDI-to-notation transcription. If the other program you are working with can import MusicXML files, then you might first try transferring the score from Composer to the other music program using MusicXML for better results.
5. Optionally set a check mark by "Write out repeats and separate lyric verses." For example, if your song has repeat instructions to play four verses, and four lines of lyrics are included, then this option will expand the song into four written-out sections of the verse, each time with one of the four verses. Karaoke players will need this setting.

6. Select the MIDI file format that will best suit the device you will play your exported .mid file on. The XG format is recommended as it has the most capabilities and flexibility. However, some equipment can only handle other MIDI file formats, and so Composer offers the option of saving in the file format that you need. Please note that if a MIDI .mid file that you have opened in Composer is a particular MIDI format, then you cannot change the MIDI format to a different type on export. There are other software tools available elsewhere for making such format changes.

### 2.13 Sharing Your Music With Others so They Can View, Play, and Print Your Songs

Once you have prepared a song with Notation Composer, you might want to share it with others.

- **Share your Notation .not file, which can be viewed, played, or printed by the free Notation Player.**

  Others can download the free Notation Player from [www.notation.com/DownloadNotationPlayer.php](http://www.notation.com/DownloadNotationPlayer.php) to see and hear your files.

  The free Notation Player lets the user view and play your music exactly as you saved it.

- **Share your song as a MIDI .mid or Karaoke .kar file.**

  The MIDI file format is the most common format supported by Composer for sharing your song with others. On most Windows systems, the user can double-click the MIDI file name and it will immediately start playing.

  The MIDI file format directly supports only playing, not viewing and printing.

  To **export your song as a MIDI file**, use the File menu’s Export as MIDI command, and choose MIDI File as the save-as file type.

- **Share your song as a MusicXML .xml file.**

  MusicXML is a standard file format for sharing the notation of music scores between different music software programs. Many of the most popular music notation programs can import MusicXML files that have been saved by Notation Composer.

  To **export your song as a MusicXML file**, use the File menu’s Export as MusicXML File command.

- **Share your song as an audio file: wav, mp3, ogg, or flac**

  Notation Composer can export both uncompressed and compressed files for use in audio production software or audio devices. To **export an audio file** of your music, just use the "File / Export / Audio command and select the type of audio file you wish to export. If you find that you need to change the loudness or softness of the exported file, please see the section on **setting the gain for audio exported files**.
• Share your song as a PDF .pdf file.

PDF files are easily shared between computer platforms, making them a great way to share music sheets with friends.

To export a high resolution copy of your song in PDF format, simply use the File / Export...PDF command.

• Share your song, or parts of it, as an image (.bmp, .jpg, .png, or .gif) file.

Image files can be easily inserted into other document types which makes them a great way to share snippets or examples from your work.

To export a high resolution image from your song, simply use the File / Export...Image command.

2.14 Backing Up Your Work with Automatic Backup

Composer will back up your work on a song file at a periodic interval, such as every 10 minutes. It will do this without any interruption to your editing work. This Automatic Backup feature helps protect you against loss of much work if your computer system fails or even if Composer itself fails. If there is such a failure, it is easy to recover a very recent backup of your work, such that you will lose no more than a few minutes of work, depending on the time interval you set.

TIP: Although Composer's Auto-Save feature offers you protection against loss of work, you should not rely on it as the only means of backing up your work. You should still periodically back up your song files to a safe, external backup media, such as CD ROM. In addition, even as you are working in a single Composer session, if it is a long session last, say, 20 or 30 minutes or longer, you should also manually back up your work, using some file naming convention such as MySongBk1.not, MySongBk2.not, etc. This is a good habit for any type of work you do stored in a file by a software program. It offers you not only additional protection against failure of your computer system, or failure of the software program, but also protection against yourself— that is, in case you make a mistake deleting a large portion of a song that you would later regret.

To set up Composer to periodically back up your song file as you edit it:

1. In the File menu, choose the Automatic Backup Options command.

Composer will display the following dialog box:
2. Set a check mark for "Enable auto-save".

3. Specify the frequency at which you wish the automatic backups to be done. Ten minutes is a good compromise between (1) minimizing how much work you might lose in the event of a computer or software failure and (2) not over-burdening your computer with too much background work backing up your song files.

4. Specify how many backups per song file will be done before recycling the files.
   If your song is named MySong.not, then the backup files will be named MySong-1.not, MySong-2.not, etc., up to the number of backups per song that you specify. These files are saved in the C:\Users\Public\Documents\Notation_3\Composer_3\Recover directory. If you have a lot of disk space, you might want to specify a larger number than the default 5 for the number of backups per song file.

To recover an Automatic Backup file:
1. In the File menu, choose the "Open files from automatic backup" command.
   Composer will display a File Open dialog box listing all of the backup files in your \Notation\Composer\Recover directory.

2. In the File Open dialog box, find the files that have the same name as the file you want to recover, differing only with the suffix "-1", "-2", as explained above.
   These backup files are numbered so that the most recent backup file is "-1", and the second is "-2", etc.

3. Select the backup file with the "-1" suffix, such as MySong-1.not.
   Usually, this file will open without any problems. However, if it does not open, perhaps because it was not completely saved at the time of the software failure, then try opening the "-2" file.

4. Review your newly opened backup file carefully. Make sure that it reflects your most recent work.

5. Manually back up the older copy of the song file that you are about to replace with the restored Auto-Save backup file. Do this just in case there is a problem with the Auto-Save backup file that you have not yet discovered.

6. Save the Auto-Save backup file using the name and directory location of your older file. Save it in a location where you will remember that you saved your more recently edited and restored backup file.

7. Continue working now with the restored file.

2.15 Opening a Notation .not File

To open a previously saved Notation .not file:
1. If no files are currently opened, then click the folder icon or the text "Open a MIDI or Notation file on My Computer", which is displayed in the main part of Notation's window:

   ![OPEN A MIDI OR .NOT FILE]

   -- OR --

   Choose the Open command in the File menu.

   -- OR --

   Type CTRL+O, the standard Windows shortcut for File Open.
Composer will present the File Open dialog box.

2. If the file is not in the default directory, navigate to the directory where it is located.
3. Select the file in the directory.
4. Click the Open button.

### 2.16 Viewing Multiple Song Files at a Time

You can open multiple songs in Composer and view them in separate sub-windows. Normally, you will see one song at a time. You can quickly switch from one song to another using the Song Tabs. You can also view and work with multiple songs at a time, for example, to compare the notes in two songs, or to copy portions of one song to another.

- **To open a second song in Composer:**
  - Open the file as usual, using the Open command in the File menu, or download and open a MIDI file from the Internet.

- **To switch from one opened song to another:**
  - If the Song Tabs are not already visible, turn on the check mark for Song Tabs in the View menu. Then click the tab for the song you wish to view.

- OR -
  - Type CTRL+F6 or SHIFT+CTRL+F6 to cycle forward or backward through the list of songs currently opened. This strange shortcut is a standard one defined by Windows for Next Window and Previous Window.

- OR -
  - Open the Window menu, and select one of the opened songs listed at the bottom of that menu.

- **To view multiple opened songs at the same time:**
  - In the Window menu, choose the Cascade, Tile Horizontally, or Tile Vertically command. These are standard Windows commands for organizing multiple windows within a single application. Try them out to see how they work.

After you have used one of these commands, you can resize the individual song windows within Composer's overall window by dragging sides or corners of the windows with the mouse.
To maximize, minimize or close these song windows, just use the standard Windows control buttons in the upper right of each open song window.

### 2.17 Printing the Score

The procedures below describe how to:

- print a single part from a score
- print some range of measures for a single part
- print multiple parts with one command

Be sure to review your score in Page View before printing to make sure that any Instrument Sound Changes, Band-in-a-Box® Style Names, or other unwanted elements are not showing. To hide various elements so that they will not print, please see the section on **Showing and Hiding Types of Music Annotations**.

To print a single part from a score:

1. If you are not already viewing the score part you wish to print, use the **Select Part** command in the Part menu.

2. Choose the Print command in the File menu.

   -- OR --

   Type CTRL+P, the standard Windows shortcut for File Print.

Composer will present a Print dialog box such as the following:

#### Print

**Printer**

- Name: hp LaserJet 3030 PCL 6
- Status: Ready
- Type: hp LaserJet 3030 PCL 6
- Where: DOT4_001
- Comment: Print to file

**Print range**

- All
- Pages from: 1 to: 5
- Selection

**Print odd or even numbered pages**

- All
- Odd-numbered pages only
- Even-numbered pages only

**Copies**

- Number of copies: 1

3. In the Print dialog box, select options:

   - which printer you want to use, if you have more than one printer
what range of pages should be printed, or all of them
-- how many copies
-- for purposes of two-sided printing, whether to print odd-numbered or even-numbered
pages only (some printers offer this option)

If you have previously prepared a part for a given paper size (such as 8-1/2x11, Legal, or A4) and
orientation (portrait versus landscape), then you should use the same page size when printing the
current page. By default, Composer will offer the paper properties that you have previously specified
for the part. This way, any special formatting you have prepared for the part that is dependent on the
paper size and orientation will correctly match the paper for the print job.

To print a range of measures instead of all of the measures in the score:
1. Choose the View Measures command in the Measure menu. The View Measures menu item
indicates what range of measures are currently being displayed, such as "View Measures 25
to 49".
   -- OR --
Type "qvm" for Quick View Measures.
2. Composer will present a View Measure Range dialog. In the dialog, specify the starting and
ending measures that you wish to display or print. The measure numbers of a score start at 1
(not 0), unless you have specified a different starting measure with the Measure Numbers
command in the Score menu.
3. Then print the score using the Print command in the File menu, or by typing CTRL + P.
4. If after printing the score you wish to view the entire score again on the screen, use the View
Measures command again to reset the range from the first measure to the last measure of the
score.

To print several parts at one time:
1. Choose the Print Parts command in the File menu.
   Composer will display the simple Print Parts dialog box. Initially, all parts of the song will be
pre-selected.
2. In the Print Parts dialog box, unselect any parts that you do not wish to print, by clicking the
highlighted part name. Selected parts are highlighted, and unselected parts are not, as
illustrated below:
3. Hit the OK button.

Composer will display the Print dialog box.

4. In the Print dialog box, choose options as described earlier in this topic.

Note that the Print dialog box will not offer you the option to print a range of pages. The Print Parts command supports printing only of the entire range of pages of each part. For the same range of measures, each part can require a different number of printed pages. To print the parts for only a selected range of measures, use the View Measures command in the Measure menu, as described earlier in this topic.

2.18 Playing the Song

With Composer you can play back a song while viewing the score on the screen. Composer highlights notes as they are played, and automatically turns pages.

This section describes:

- Playback Location and Staff Markers
- Starting and Stopping Playback
- Fast Forwarding
- Setting Up the Metronome
- Changing the Song Position During Playback
- Setting the Focus on a Staff During Playback
- Anticipating Page Turns
- Playing or Ignoring Repeats and Endings
- Highlighting Active Notes and Lyrics
- Turning Off Stuck Notes
- Viewing and Adjusting the Tempo
- Controlling Overall Volume Level
- Muting and Soloing Staves
- Adjusting the Volume of Selected Staves During Playback
In another section, see also:

- Changing the Instrument Sound of a Staff
- Using Playlists (Jukebox)

2.18.1 Playback Location and Staff Focus Markers

The score window displays two green playback markers.

The \( \text{playback location marker} \) indicates where playing will begin the next time you start playback. Once you stop playback, the \( \text{marker} \) will be automatically moved to the location where the playback stopped.

The \( \text{staff focus marker} \) indicates the staff on which Composer will attempt to stay focused during playback. When a staff has the focus, and Composer turns a page during playback, Composer will attempt to keep that staff in exactly the same vertical position in the window by scrolling the window up or down as necessary. This feature helps you better follow a particular instrument part during playback.

You can temporarily hide the display of these playback markers.

You can set the playback markers either before playback or while playback is in progress.

To change the position of the \( \text{playback location marker} \) before playback:

- While holding down the "P" (for "position") key, click anywhere in the score. The horizontal position where you click the mouse will determine the playback location.
To move the playback location marker to the beginning of the score, choose Rewind from the Perform menu.

-- OR --
Type CTRL+HOME.

-- OR --
Click the Rewind button.

To set the playback marker to one beat before the end of the score, choose the Last Page command in the Go To submenu of the View menu.

-- OR --
Type CTRL+END.

To change the positions of the staff focus marker before or during playback:

- While holding down the 'V' (for "vertical") key, click somewhere in the score. The vertical position where you click the mouse will determine which staff has the playback focus. If playback is in progress, when Composer turns a page, the staff where you click the mouse will maintain the same vertical position in the window.

To change the both positions of the playback location and the playback staff marker during playback:

- Double-click the mouse at the horizontal position where you want the playback to jump to, and at the vertical position where you want the staff focus to be held.

To hide the display of the and playback markers:

- Turn off the check mark for the Show Playback Position command in the View menu.

-- OR --
- Type "qspp" for Quick Show (or Hide) Playback Position.

To turn back on the display of the playback markers, repeat (toggle) the Show Playback Position command.

You can also hide the vertical line that is displayed during playback, or you can change its color. See Highlighting Active Notes and Lyrics.

2.18.2 Starting and Stopping Playback

The playback location marker indicates where playback will begin when you hit the SPACE key. You can also start playback at the beginning of the current list of selected notes and rests, or at the beginning of the current region selection, by holding down the SHIFT key when you hit the SPACE key. This feature is quite handy when you have added or edited some notes. You can immediately hear the notes you are working with. If you want to start the playback a few beats before the notes you are working with, then hit the key a few times, before hitting SHIFT+SPACE, to select some previous notes.

To start playback at the playback location marker:

1. Hit the SPACE key.

-- OR --

2. Click the Play button in the toolbar at the top of the window.
3. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first F# above Middle C. See Controlling Composer From Your Keyboard.

To start playback at the current selection of noteheads and rests, or the current selection region:
- Type SHIFT+SPACE. That is, while holding down the SHIFT key, hit the SPACE key.
- If some noteheads or rests are selected, and a region is also selected, Composer starts playback at the first of the noteheads or rests rather than at the start of the region.

To stop playback:
1. Hit the SPACE key.
- OR -
2. Click the Stop button in the toolbar at the top of the window.
- OR -
3. Toggle the Play button in the toolbar at the top of the window.
- OR -
4. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first F# above Middle C. See Controlling Composer From Your Keyboard.

2.18.3 Fast Forwarding

To temporarily fast forward through the song during playback:
1. Click the Fast Forward button once to increase the playback speed five times as fast. Click the button a second time to resume the original playback speed.
- OR -
2. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first Bb above Middle C to fast forward, and play it a second time to end fast forward. See Controlling Composer From Your Keyboard.

2.18.4 Using Staff Setup To Change Instruments and Settings

Notation Composer gives you multiple ways to control various aspects of the instruments and their playback settings for each staff (which corresponds to a MIDI "track").

You can use either the Single Staff Setup, or the "big" Staff -> Setup dialog to:
- Edit the instrument name(s) as it appears on the score
- Change the instrument sound of a staff or staves
- Adjust the Volume level and Pan
- Rearrange the order of the staves
- Set whether a staff shows normal noteheads or drum notation noteheads.
To access the Staff Setup for a single staff

In Window View, the Staff Control buttons are visible. Clicking on the Staff Setup button for any staff will bring up the Staff Setup dialog for that staff.

Clicking the Staff Setup button will bring up the dialog for that staff, where you can make changes for just that staff.

To access the Staff Setup for all the staves of your song

On the menu bar, select "Staff", and then select "Setup" from the menu list.
You will then be able to edit all the staves of your song in one location.

Please note that if you want to change the soundfont for the Notation Software Synth for your instruments, you will need to do that in Setup/MIDI Devices Configuration/Notation Software Synth/Properties dialog. Composer does not currently support loading different fonts at the staff level.

For details, see the following topics:

- Edit the instrument name(s) as it appears on the score
- Change the instrument sound of a staff or staves
- Adjust the Volume level and Pan
- Rearrange the order of the staves
- Set whether a staff shows normal noteheads or drum notation noteheads

### 2.18.5 Setting Up the Metronome

The Composer metronome produces a sound at major and minor beats in measures as you play or record music. You can define the specific metronome sounds, typically various types of percussion notes, for the major and minor beats.

When you first record into an empty section of a song, you will almost always want Composer to play the metronome, so that you can synchronize your performance with barlines and beats within
measures. You can specify how many measures and beats of pickup the Composer will play on the metronome before beginning the song that you are recording.

When you play back a song, you might want to turn off the metronome.

The metronome appropriately stays in synchronization with any tempo changes in the song.

To turn off or on the metronome:

- Toggle the metronome button in the toolbar to the down or up position for on or off.
  -- OR --
- Type CTRL + M.

To specify whether the metronome should be on or off by default:

1. In the Perform menu, choose Metronome Setup command.
  -- OR --

   While holding down the CTRL key, click the button in the toolbar.

   Composer will display the Metronome Setup dialog box, as illustrated in the next procedure.

2. Set a check mark or not for the two options at the top of the dialog box, for "Metronome is on during playback" and "Metronome is on during recording".

To select the sounds used by the metronome for the major and minor beats:

1. In the Perform menu, choose Metronome Setup command.
  -- OR --

   While holding down the CTRL key, click the button in the toolbar.
Composer will display the following Metronome Sound dialog box:

2. If you wish to use your Windows system default beep sound instead of your sound card for metronome sounds, then select "Use computer beep sound". Then click the OK button. No other options apply to the beep sound.

In general, you should avoid the computer beep sound option unless you have a good reason, because that option gives you very little control over the volume level and type of sound that is used.

3. Choose the Use MIDI Device option for Metronome Sound Source, and choose a MIDI Device that you know will produce sound - the default Notation Software Synth is a good choice. (However, if you are not sure, you can use the Audition option described below.)

4. For almost all playback devices, choose 10 for the MIDI Channel if you want to use percussion sounds for the metronome beats.

5. Enter the Length of Metronome Sound, as measured in ticks. There are 480 ticks in a quarter note. So, 120 ticks is equal to a sixteenth note, which is usually a good length for percussion sounds.

6. For the Down Beat, Primary Beat, and Secondary Beat, select a Percussion Sound and Loudness.

The down beat is the beat at the beginning of each measure. The primary beat is a major beat within the measure. The second beat is a minor beat between major beats in the measure. For example, in a 4:4 meter, there is a down beat at the beginning of the measure; a primary beat at the middle of the measure; and a secondary beat at the second and fourth quarter note beats of the measure. In a 9:8 meter, there is a down beat at the beginning of the measure; primary beats at the second and third dotted quarter note beats; and secondary beats at each eighth note beat between the dotted quarter note beats.

For almost all sound cards, if you specify MIDI channel 10, then the percussion sounds will be those indicated in the lists. If you do not specify MIDI channel 10, then the sounds will be actual
pitches on some instrument such as a piano—which is probably not what you want. So, be sure to choose MIDI channel 10 unless you have a good reason not to.

For the loudness value, specify a number between 1 and 127. (This is the MIDI velocity value.)

7. If you want to hear what the metronome beats sound like, hit the Audition button. Composer will display and play a score for a 12-note chromatic scale in a 4:4 meter with the metronome playing in the background. Composer will automatically close the audition score when the playback has completed. You can also close the audition score by clicking the Audition button a second time.

8. Set a check mark by "Metronome is on during recording". Optionally, set the check mark for "Metronome is on during playback."

9. Click the OK button to save the metronome settings.

2.18.6 Jumping to or Previewing Another Location in the Song During Playback

While the song is playing back, you can immediately jump to another location in the song by clicking the mouse elsewhere on the same page or on another page. This action also causes playback to proceed from the point where you clicked.

Alternatively, during playback you can preview another page in the score without disrupting the current playback. Use the Next Page or Previous Page commands of the Page menu, or hit the PAGEDOWN or PAGEUP keys. Playback will continue uninterrupted, without changing its song position. This feature is intended to offer you the opportunity to look ahead (or behind) in the score, without having to commit to a decision to change where the song is currently playing.

If you then click somewhere on the currently displayed page, playback will immediately jump to that position.

When you click on a page during playback, the staff focus will also change. If you want to change the playback position in the song without changing the staff focus, then hold down the ‘P’ click when you click the mouse.

If you do not click anywhere after moving to another page, Composer will, after a few seconds, return to the page that is currently playing.

2.18.7 Setting the Focus on a Staff During Playback

During playback, Composer displays the measure and beat location of the score that is currently playing. If Composer’s window is not tall enough to display all of the staves (staves) for the current measure, then Composer must decide which staves to display.

You can instruct Composer where to vertically scroll the window, according to which staff you want to keep in focus during playback. You may wish to do this while you are studying the role of a particular instrumental part or voice during playback.

You can assign the playback focus to a staff by setting the playback staff focus marker, as described in Playback Location and Staff Focus Markers. To set the focus on a staff either before playback starts or during playback, click the mouse anywhere in that staff while holding down the “V” (vertical) key.

If you scroll the window during playback, then the focus will shift to another staff, approximately in the middle of the window. Afterwards, that staff will remain in the same vertical position upon subsequent page turns.

If the Hide Resting Staves option is in effect, then the staff with the playback focus might temporarily drop out during playback, if there is no staff for the instrument. In this case, Composer attempts to find a nearby staff to temporarily assume the role of playback focus. As soon as the originally focused staff has notes, its staff will reappear, displayed in the same position as before.
2.18.8 Anticipating Page Turns

During playback, Composer automatically turns pages, just as though someone were turning the pages for you as you read the music. If you are singing or playing an instrument while sight-reading music, you usually will want the page to be turned a short time ahead of the first beat on the next page. Even if you are just listening to the score, you may want the pages to turn ahead of time.

Composer lets you specify how many beats ahead of time it will turn pages. You can specify the page turn value for each song.

To choose how many beats ahead of time pages will be turned:

1. Choose the Playback / Page Turns command in the Perform menu.

Composer will display the following dialog box:

![Anticipate Page Turn dialog box](image)

2. Specify the beat value for which page turns will be anticipated, by clicking one or more times on the up or down scroll buttons.

-- OR --

Enter the page turn anticipation value in ticks. In Composer, there are 480 ticks per quarter note.

3. Click the OK button to apply the new page turn anticipation value to the current song.

4. If you wish the newly entered page turn anticipation value to be applied to any subsequently opened MIDI file, or any newly created song, then hit the Save As Default button.

To recall the most recent page turn anticipation value that you saved with Save As Default, click the Restore Default button.

2.18.9 Playing or Ignoring Repeats and Endings

Composer enables you to add repeat marks \( \text{Re} \) and endings \( \text{End} \) in a song. By default Composer performs repeats and endings during playback. However, you can instruct Composer to ignore these.

To perform or ignore repeats and endings during playback:

- Toggle the Ignore Repeats and Endings option in the Perform menu.

2.18.10 Highlighting Active Notes and Lyrics

While Composer plays a song, it normally highlights those notes and lyrics that are currently playing, and it displays a vertical line, called the playback cursor \( \text{Play} \). The playback cursor indicates the currently playing beat within some measure. You can choose what colors Composer uses to highlight the
notes, lyrics, and the playback cursor. You can optionally suppress the highlighting of any of these cues. You can also specify whether, and by how much, lyrics are displayed in advance of the time that they are normally sung.

To change the color used to highlight actively playing notes, lyrics, or the playback cursor:

1. Choose the Playback Highlighting Options command in the View menu.

Composer will display the following Playback Highlighting Options dialog box:

2. Click the Color example box for Notes, Playback Cursor, or Lyrics.

Composer will present you with a Color dialog box. Select the color to be used for the active notes, playback cursor, or lyrics. Click OK in the Color dialog box. The above Playback Highlighting Options window will immediately display the new color you have chosen.

To suppress the highlighting of actively playing notes, lyrics, or the playback cursor:

1. Choose the Playback Highlighting Options command in the View menu.

2. Remove the corresponding check mark in the left portion of the window for Notes, Playback Cursor, or Lyrics.

To specify the lead time for the highlighting of lyrics:

1. In the Lyrics portion of the window, use the ↑ and ↓ buttons to select a note duration for the lead time.

-- OR --

2. Manually enter a tick value for the lead time. In Composer, there are 480 ticks per quarter note.

2.18.11 Turning Off Stuck Notes

Occasionally, you may hear stuck notes that continue sounding indefinitely. This can happen if the connection to your MIDI device is temporarily disrupted, so that it does not signal the "note-off" corresponding to a preceding "note-on".

If you hear stuck notes, you can turn them off, either during playback, or after playback has completed.

To turn off stuck notes:

1. Type SHIFT + CTRL + S.
2. Choose the Turn Off Stuck Notes command from the Perform menu.

Note that this command not only turns off the stuck notes but also turns off any other notes that happen to be playing.

2.18.12 Viewing and Adjusting the Tempo

The toolbar indicates the tempo at the current playback location marker, as shown below:

If you do not see the toolbar in the window, then choose Show Toolbar from the View menu, or type "qstb" for Quick Show Toolbar.

The tempo is indicated in beats per minute. The example illustrates 160 quarter notes per minute. The note duration used for the tempo beat is determined by the meter, and in some cases also the speed of the tempo, as specified in the following table:

<table>
<thead>
<tr>
<th>Meter</th>
<th>Tempo Speed</th>
<th>Tempo Beat Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2:4, 3:4 or 4:4</td>
<td>Any</td>
<td></td>
</tr>
<tr>
<td>2:4 or 4:2</td>
<td>Any</td>
<td></td>
</tr>
<tr>
<td>3:8, 6:8, 9:8, or 12:8</td>
<td>Slow</td>
<td></td>
</tr>
<tr>
<td>3:8, 6:8, 9:8 or 12:8</td>
<td>Medium or Fast</td>
<td></td>
</tr>
<tr>
<td>irregular N:8, such as 5:8</td>
<td>Any</td>
<td></td>
</tr>
</tbody>
</table>

During playback, the tempo value is constantly updated if the tempo changes throughout the song.

Composer enables you to change the tempo of the song before you start playback, or dynamically during playback. The tempo adjustment is measured as a percentage of the tempo as originally recorded in the song. The displayed tempo reflects the percentage adjustment. For example, if the percentage adjustment in the above example is set at 75%, then the tempo during playback is displayed as:

\[\text{Tempo} = 118 \quad 75\%\]
To change the tempo before or during playback:

1. Click the up or down arrow button next to the percentage value displayed in the toolbar.  
   -- OR --  
2. Type in a number for the tempo percentage.  
   -- OR --  
3. While holding down the 'T' key, press the ↑ or ↓ key to increase or decrease the tempo.  
   Or, type T+ENTER to reset the tempo to 100%.  
   -- OR --  
4. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the second Eb above Middle C to increase the tempo, or the second C# above Middle C to decrease the tempo. See Controlling Composer From Your Keyboard.

With Composer you can also add tempo changes throughout the song, and view them graphically. For details, see Editing Tempo.

To save a percentage tempo change to the song:

1. Follow the above procedure for temporarily changing the tempo. Play back some of the song to make sure you are happy with the revised tempo.  
2. Choose the Keep Adjusted Tempo command in the Tempo submenu of the Perform menu.  
   -- OR --  
   Type "qkte" or "qktm" for "Quick Keep Tempo".

To make tempo changes that vary over the course of the song, please see Composer's GraphOverNotes capability that allows you to edit the tempo graphically.

### 2.18.13 Controlling the Overall Volume Level

If you do not hear any sound during playback, then see What To Do When You Do Not Hear Any Sound.

There are several ways that you can control the volume level for playback:

1. Turn the volume level up or down on the speakers connected to your computer.  
2. Use Composer’s volume control, located in the main toolbar:

```
[Vol-] [Vol+]  
```

With Composer’s volume control, you can dynamically change the volume level of one or more selected instruments during playback.

3. Individually set each staff's volume level before starting playback.
4. Use the Windows volume control in the Windows task bar:

Windows will then display the following sound volume level control:

Move the volume lever up and down to increase and decrease the volume level.

**2.18.14 Muting and Soloing Staves**

There are a variety of occasions in which you might want to listen only to certain staves of a song while other staves are muted (silenced). For example, if a song has a melody staff played by some instrument, but you want to sing the melody yourself, then you can mute the melody staff. Or, you might want to study the composition and arrangement of a song and focus on how a particular instrument part is written by "soloing" that instrument part, thus muting all of the other staves.

Composer enables you to play any combination of staves while muting other staves. You can even do this while the song is playing back. There are two places where you can see whether a staff is muted or not. If the staff controls are visible, you can tell that a staff is muted if the top-left button is not pressed down and has a dull light instead of the normal bright green light:

- **staff playback is active**
- **staff is muted**

If the staff controls are not visible, then you can set the Mute check mark for the staff in the Staff Setup window, as described later in this topic.

If you save the song as a MIDI file, any muted staff will be restored as an audible staff when you reopen the MIDI file. If you wish the staff to remain muted, you should save the file as a Notation (.not) file. If you save a muted staff in a Notation file, you have the option to later open the Notation file and unmute the staff.

- **To toggle the play/mute status of a staff using the staff control:**
  1. If the staff controls are not already visible, set the Show Staff Controls option in the View menu. Note that the Show Staves Controls option is not available in Page View.
  2. In the group of four staff controls, toggle the play/mute button to active or muted.

- **To toggle the play/mute status of a staff using the Staff Setup window:**
  1. Select the Staff Setup command from the Staff menu. Composer will display the Staff Setup window.
  2. In the Mute column of the Staff Setup window, set or unset the check mark for the staff.
    -- OR --
    Click the Mute column header to change the status of play/mute for all staves at once.

Another option allows you to mute all staves except one staff that you wish to "solo". The play/mute status of the other staves are only temporarily changed. Once you turn off the solo option for the staff,
any staff that was previously playing will continue to play, and any staff that was previously muted will continue to be muted.

- To toggle the solo status of a staff:
  - Toggle the solo button to a down or up position.

You can temporarily solo any number of staves together by setting their respective solo buttons to the down position.

2.18.15 Adjusting the Volume Level of Selected Staves During Playback

During playback you can increase the volume of selected staves relative to other non-selected staves, so that you can focus your listening on these staves. This is a useful aid for studying orchestrations and arrangements.

You can control volume with your mouse and the volume control in the toolbar; or by typing V+ or V-; or by playing special notes on your keyboard, using the Pitch-to-Command feature.

The volume control is in the toolbar and looks like this:

![Volume Control](image)

Normally, when no staves are selected, the volume control applies uniformly to all of the staves in the score.

When one or more staves are selected, and you move the volume control to the right of center, the selected staves will sound louder, while the non-selected staves will remain at their normal level.

When one or more staves are selected, and you move the volume control to the left of center, then the behavior is probably not initially what you would expect. You might expect the volume level of the selected staves to decrease. Instead, the volume level of the selected staves remains at the normal level, and the volume of the non-selected staves decrease.

When you move the volume slider to the left, why does Composer decrease the volume level of the non-selected staves instead of decreasing the volume level of the select staves?

Consider why it is you would usually want to change the volume level of some staves but not others. It is probably so that you can hear one or a few staves better than all of the others. You want sound of that staff to stand out.

One way you can do this is to select the staff in make it louder. But maybe it is already set at a maximum volume level. Or maybe the overall sound level is already loud enough that you don't want it any louder.

You have an alternative: Select the staves for which you want their sound to stand out, but instead of increasing the volume level of those staves, instead you can decrease the volume level of the non-selected staves. Do this by moving the volume slider to the left. Try it out so your ears can learn how this works. Your ears might be grateful that the overall sound level is decreasing rather than increasing!

If you are familiar with the distinction between MIDI staff volume control events and individual MIDI note-on velocities, then you might find it useful to know how Composer's volume control is implemented. The volume control affects both individual MIDI note velocities and the overall MIDI staff volume (via controller event 7). The reason for this design is that some sound cards do not implement
Opening, Transcribing, Printing, Playing, and Saving Songs

staff volume controller events well or at all. Composer's design, which relies on both MIDI note-on velocity adjustments and staff volume controller events, produces more reliable volume control across a wider variety of sound cards.

If you find that the overall volume level is too soft, then you might find it preferable to increase the volume level of your computer speakers, or use the Windows volume control, rather than to use Composer's control. Some of the expressiveness of volume changes in the song, as well as some instrument panning, will be lost the more you increase Composer's volume level.

To change the volume of selected staves relative to other staves:

1. Select one or more staves as follows: Choose Show Staff Controls from the View command. Click the staff selection button to select a staff. While holding down the SHIFT key, click the staff selection button to extend the range of staves.

2. Increase (or decrease) the volume of the selected staves, using one of these methods:
   
   (a) Drag the volume control button to the right (or left).
   
   -- OR --

   (b) Type V+ (or V+).
   
   -- OR --

   (c) If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first Eb above Middle C to increase the volume, or the C# to decrease the volume. See Controlling Composer From Your Music Keyboard.

To reset the volume level back to normal:

1. Type V+ENTER.

   -- OR --

2. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first D above Middle C. See Controlling Composer From Your Keyboard.

2.19 Using Playlists (Jukebox)

Sometimes you may want to keep an ordered list of songs in a collection, where the playback of each song continues after the previous song. Such a collection of songs is called a playlist in Composer.

The most obvious use of a playlist is for listening enjoyment, to listen to several songs—perhaps ones you have arranged yourself—in sequence.

Another use of a playlist is to play different parts of a larger musical piece, where each part is kept in a separate Notation file. These might be movements of a sonata or orchestral piece. Or, they might be numbers of a simple suite of children's music.

The Playlist feature is also very helpful for organizing your practice sessions. You can keep groups of songs together in separate playlists to quickly access them for practice sessions. Composer keeps the last saved version of the songs as the one in the playlist, so you will have instant access to the last settings for each song in your playlist.
The following screen shot shows the first song ("Minuet") in the playlist playing. The next song ("RhapsodyInBlue") will play immediately after the first song completes.

The topics that follow describe:
- How to organize songs in a playlist.
- How to play songs in a playlist.
- How to move playlists.

2.19.1 Organizing Songs in a Playlist

A playlist is a collection of Notation .not, MIDI .mid, and/or Karaoke .kar files, which will automatically play one after another. Ideally, these should be Notation .not files, because then they do not need to be re-transcribed each time they are opened and played.

You will probably want to have multiple playlists. Each playlist might have a group of songs that you like to listen to together. Or, a playlist might have parts of one larger piece of music, such as multiple sections of an instrumental or vocal suite, or multiple movements of a classical style composition.

To view a playlist:

1. If the Playlist Panel is not already showing, set a check mark by Show Playlists in the View menu.

Composer will display the Playlist Panel, which looks like this:
2. If the playlist you want to see is in a different directory (folder) than the current one listed at the top of the Playlist Panel, then click the Folder button, and choose another directory. The default directory for playlists is C:\Users\Public\Documents\Notation_3\Songs. You will probably find that there is no need to keep playlists in any other directory than this default directory, unless you intend to move playlists and their song files to other directory locations or to another computer.

3. In the upper panel, click the mouse on the name of the playlist you wish to view.

   In the lower portion of the Playlist Panel, the songs belonging to that playlist will be displayed, as illustrated above.

   To create a new playlist:

1. If you want to add the new playlist to a different directory (folder) than one one currently listed at the top of the Playlist Panel, then click the Folder button, and choose another directory.

2. Click the Add button in the upper half of the Playlist Panel, not the same-named button in the lower half.

   Composer will display a small Add Playlist dialog box.

3. In the Add Playlist dialog box, enter the name of the new playlist, such as "Susan's Favorites".

   Composer will add the new playlist to the list of playlist names at the top of the Playlist Panel. The list of songs in the lower half of the Playlist Panel will initially be empty for this new playlist.

4. Add songs to the new playlist as described in the next procedure.
To add songs to a playlist:

1. Click the Add button in the lower half of the Playlist Panel. Composer will display a File Open dialog box.
2. In the File Open dialog box, navigate to the directory where the song files are located.
3. Choose one or more files listed in the File Open dialog box. You can select multiple adjacent songs in the File Open dialog box by selecting the first one, and then while holding down the SHIFT key, click the mouse on the last song. You can also select multiple non-adjacent files by holding down the CTRL key as you click the mouse on each file name.

-- OR --

Instead of the above three steps:

- If you have already opened the song and are currently viewing it, click the << Add button.

To change the order of songs in a playlist:

1. Click the mouse on the name of the song in the lower half of the Playlist Panel. The selected song will be highlighted with a blue background.
2. Hit the Up or Down button to move the song up or down in the playlist.

To remove a song from a playlist:

1. Click the mouse on the name of the song in the lower half of the Playlist Panel.
2. Hit the Remove button.

2.19.2 Playing Songs in a Playlist

After you select a playlist in the Playlist Panel, you can:

- Start playback at any song.
- Automatically play each of the songs in their order in the playlist.
- Loop through the songs in the playlist multiple times.
- Dynamically queue a different song to be played next after the completion of the currently playing song, as a disc jockey might do so.

To start playback in a playlist:

1. Click the mouse on the song you want to play first. That song will be highlighted with a dark blue background to indicated that it has been selected.
   If you want to start playback with the first song, and no song has been previously selected, then you can skip this step: the first song will automatically be selected.
2. Click the Play button.
   The song you selected will start playing. You will see the notes highlighted as they play, just as in normal playback. The currently playing song will be highlighted with a dark green
Opening, Transcribing, Printing, Playing, and Saving Songs

The next song to be played will be highlighted with a light green background.

To stop playback:

- Click the Stop button in the Playlist Panel.

- OR -

- Use any other method you normally use to stop playback of a single song, such as by hitting the SPACE key, or by clicking the Stop button in the toolbar, or toggling off the Playback button in the toolbar.

To play the songs one after another in their order in the playlist:

- Turn on the "Auto Play Next Song" check mark at the bottom of the Playlist Panel.
To play all of the songs as an endless loop, restarting with the first after completing the last
song in the playlist, turn on the "Loop Songs in Playlist" check mark.
You can toggle either of the above options during playback as well as before playback.

To dynamically queue a different song to be played next after the completion of the
currently playing song:

- While the current song is playing, simply click the next song in the playlist that you wish to play
  next.

This will not interrupt the playback of the current song. The song that you selected to play next
will be highlighted with a light green background. After it plays, the playback will continue with
the next song after it.

2.19.3 Moving Playlists
This is an advanced topic.

By default, playlists will reside in your C:\Users\Public\Documents\Notation_3\Songs
directory. The playlist is actually just a simple text file with the list of songs in it. The playlist has a .ply
file name extension. If a song in the playlist belongs to the same directory as the playlist .ply file itself,
then just the name of the song is listed. Otherwise, the full path name of the song is listed in the .ply
file.

If you intend to move a playlist and its song files to another directory, perhaps on another computer,
then it is a very good idea to keep all of the songs in the same directory as the playlist. That way, when
the playlist .ply file is moved to the new directory, the song files it refers to will be assumed to be in the
same directory, which is what you’ll want.

You can optionally archive a playlist .ply file, along with the song files that belong to it, in a .zip file or
other type of archive file. You might find that to be a handy way to send a list of your songs to another
person. Note, the recipient of your song files does not need to own a copy of Notation Musician or
Composer. He or she can view, print, and play your songs using the free Notation Player.

Why are the song file names in a playlist .ply file missing the file name extension .not, .mid, or .kar?

Suppose you add a MIDI file to a playlist. Later, you might decide to edit the song, and save it
as a Notation .not file in the same directory. It would be inconvenient if you had to remove the
MIDI file from the playlist and add its corresponding Notation .not file back to the playlist.
Instead, the playlist .ply file stores just the name of the song, such as "Minuet", without the file
name extension, such as "Minuet.mid". When you resave Minuet.mid as Minuet.not, the
playlist .ply file will automatically refer to Minuet.not instead of Minuet.mid. When
Composer looks for a song file referred to in the playlist, it always looks for the file name with
the Notation .not extension first.

2.20 Practicing Music with Accompaniment

Composer provides useful and entertaining features to help you practice music with your voice, your
music keyboard, MIDI instrument, or acoustical instrument. Composer’s central features are that it
displays a score as it plays the notes, highlights notes and lyrics, and automatically turns pages.
Composer lets you set up a section of the song that you can practice in a loop with optionally
increasing tempo. If you have a MIDI keyboard, then you can control some of Composer's playback features remotely from your music keyboard.

This section describes:

- Playing Along with Your MIDI Instrument
- Setting up Practice Loops
- Starting and Stopping a Practice Session
- Advancing to the Next (or Previous) Rehearsal Mark
- Practicing a Part While Singing or Playing a non-MIDI Instrument
- Practicing a Part Using Your MIDI Keyboard or Midi Instrument
- Controlling Composer From Your Music Keyboard

### 2.20.1 Playing Along with Your MIDI Instrument

If you have a MIDI keyboard or other MIDI controller such as a MIDI guitar, then you can play along while Composer plays the song. Composer will route your MIDI performance to a MIDI output device and channel that you specify; and it will use an instrument sound (MIDI patch) that you specify.

This topic describes how you can play along, or "jam", with Composer's playback of a song, if you have a MIDI keyboard or controller. If you are interested in practicing a part in the song, where you perform it rather than Composer, then see Practicing a Part Using Your MIDI Keyboard.

If you want to play along, or jam, using the instrument sound of one of the staves in the song, then there is a quick way for you to select that sound, by double-clicking the solo button, as described in the first procedure below. If you want to play along using an instrument sound that is not associated with any staves in the song, then follow the second procedure below.

You can also set up Composer to produce a selected sound as you play at your keyboard, even while Composer is not playing any song. Just follow the same instructions below.

To play along with your MIDI instrument, using an instrument sound that is already assigned to one of the song staves:

1. **Open the MIDI** file or **Notation** file that you want to play along with.

2. Double-click the solo button at the left side of the staff. If the **staff controls** are not visible, you can make them visible using the Show or Hide Staff Controls command in the View menu.

When you double-click the solo button, it will turn to red, and a red arrow will be displayed to the left of the staff, as illustrated below.

In addition, the selected staff will be muted, as indicated by the playback button in the up position.

3. If you now play back the song, the staff that you selected will be muted (silenced). If you play along on your music keyboard, the notes you play will be heard using the instrument sound of the selected staff.
4. If you do not want the selected staff to be muted, just click the solo button again, to its up position. The instrument sound for that staff will continue to be used for your play-along performances.

To play along with your MIDI instrument, using any available instrument sound:

1. Open the MIDI (.mid) file or Notation (.not) file that you want to play along with.

2. Choose the Select Play-Along Sound command in the Perform menu.

Composer will display a Select Play-Along Sound dialog box such as the following:

3. Specify the MIDI device and bank that you want to produce the sound for notes that you play on your MIDI keyboard or controller.

   **NOTE:** Do not choose a MIDI device that has a built-in delay. Otherwise, there will be a frustrating delay between the time you play a note on your MIDI keyboard or controller and the time you hear it played. You can review the delay for a MIDI output device in the Device Properties dialog.

4. To play drum sounds instead of note-pitch sounds, check the "Pitch determines drum sound ..." checkbox.

5. To play note-pitch sounds, turn off the check mark in the "Pitch determines drum sound ..." checkbox. Choose the instrument sound (MIDI patch) that you want to use.

6. If you want this Play-Along Sound selection to be used by default when you run Composer at later times, then click the Save As Default button.

7. Click the OK button when you are done selecting the Play-Along Sound.

8. Start playback of the song.
10. Play your MIDI keyboard or controller to accompany Composer's performance of the song. You will hear the instrument sound you have selected for the notes that you play.

2.20.2 Setting up Practice Loops

You can sing or play along with Composer as you read the music from the screen. Composer highlights the active notes and lyrics and automatically turns pages for you. In addition to adding accompaniment and fun to your singing and playing, Composer can also help you practice part of the song with your voice or instrument. You can set up sections in your song to practice in a loop, for a specified number of repeats, with pauses between each repeat, and with an optionally increasing tempo in each repeat.

You can specify a practice loop for a specific range of measures. You can also specify a practice loop between any two rehearsal marks that you add to the score. With rehearsal marks, you can specify starting and ending locations in the middle of measures instead of at barlines. Also, you can define rehearsal marks with names that are easy for you to remember for sections of the song that you want to practice. For more information, see Editing Rehearsal Marks.

Composer automatically turns pages for you during a practice session. You can instruct Composer to turn the pages ahead of time, so that you can look ahead in your performance. For instructions, see Anticipating Page Turns.

To set up the section of the song you wish to practice, and to set up the number of repeats and tempo:

```
TIP: For a quick way to set up a practice loop without using the Practice Setup dialog box, see the next procedure after this one.
```

1. Choose the Practice Setup command in the Perform menu.

   -- OR --

   Type "qpra" for Quick Practice.
Composer will display the Practice Setup dialog, such as the following:

2. In the Practice Range section of the dialog, specify the section of the song you wish to practice. You can specify the section of the song with measure numbers or rehearsal marks.

Composer initially sets the "from" measure to 1 and the "to" measure to the last measure in the score. Or, if you previously have selected a range of measures with CTRL+Drag (holding down the CTRL key while you drag the mouse), then the measures will be pre-selected to the range of measures you have selected.

The Rehearsal Mark list displays a list of rehearsal marks that you have previously defined. The rehearsal marks are listed in the order in which they are located in the song.

3. In the Practice Settings section of the dialog, specify how many seconds you want Composer to wait before playing after you click the Start Playback button or hit the SPACE key. This pause will give you time to get your instrument into position for playing, for example, if you are playing a guitar or clarinet.

Also, specify how many seconds you want Composer to wait between each practice loop. This pause will give you a chance to catch your breath between each practice repeat.

4. In the Practice Settings section of the dialog, specify how many times you want the practice section to repeat. Also, if you want the tempo to increase during each repeat, specify the tempo of the first and last repeats in terms of percentage of the song’s tempo.

Composer remembers the tempo setting before you start a practice session. Once the practice session completes, Composer resets the tempo to what it was before the practice session.
5. Click the Save As Default button to set the current Practice Settings as the default for any subsequently opened song.

6. Click the Save and Begin Practice button if you wish to begin practicing immediately with the specified settings. Or, click the Save and Exit button to save the settings without starting a playback session.

7. The easiest way to start the practice loop after you have set up the practice section is to type ALT+SPACE. Stop the practice by hitting the SPACE key, or by clicking the Stop button, or toggling off the button. More more details, see the next topic, Starting and Stopping a Practice Session.

To quickly set up the section of the song and start practice:

1. Use CTRL+Drag to select the range of measures you wish to practice.
2. Start the practice session by typing ALT+SPACE.

For this practice session, Composer will use the practice settings that you most recently entered in the above Practice Setup dialog box.

2.20.3 Starting and Stopping a Practice Session

Use the Practice Setup command in the Perform menu to set up the section of the song you want to practice, to specify the number of repeats of the practice section, and to set the tempo. Or, if you have already used the Practice Setup command to practice another section of the song, and now you just want to practice a new section of the song with the same settings (for number of repeats and tempo), then select the range of measures you wish to practice with CTRL+Drag; that is, hold down the CTRL key while dragging the mouse over the range measures.

Once you have chosen the range of measures to practice, and have specified the options for number of loops and tempo, you can practice the same section of the song as many times as you would like.

To start practicing:

1. After you have filled out the options in the Practice Setup dialog, press the Begin Practice button in the dialog.
   -- OR --
2. Type ALT+SPACE.
   -- OR --
3. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the second F# above Middle C. See Controlling Composer From Your Music Keyboard.

To stop practicing:

Stop playback just as you would stop normal playback, as follows.

1. Hit the SPACE key.
   -- OR --
2. Click the Stop button in the toolbar at the top of the window.
   -- OR --
3. Toggle the Playback button in the toolbar at the top of the window.
4. If you have enabled Composer’s Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first F# above Middle C. See Controlling Composer From Your Music Keyboard.

2.20.4 Advancing to the Next (or Previous) Rehearsal Mark

If you have added rehearsal marks to the score, then you can practice from one rehearsal mark to the next as many times as you want, and then with a simple command, advance to the next rehearsal mark. Using the practice commands described here, you can practice from one rehearsal mark to the next one in the score.

If you wish to set up a practice loop that crosses over one or more intermediate rehearsal marks, then you can identify the starting and ending rehearsal marks, as described in Setting Up Practice Loops.

To advance to the next (or previous) rehearsal mark and start practicing:

1. In the Perform menu, choose the command Set Practice Loop at Next Rehearsal Mark or Set Practice Loop at Previous Rehearsal Mark command.

   -- OR --

   Type "qpnr" or "qppr" for Quick Practice Next Rehearsal Mark or Quick Practice Previous Rehearsal Mark.

   -- OR --

   If you have enabled Composer’s Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the second Bb above Middle C to advance to the next rehearsal mark, or the second Ab above Middle C to go to the previous rehearsal mark. See Controlling Composer From Your Music Keyboard.

2. Choose the Start Practice command in the Perform menu.

   -- OR --

   Type ALT+SPACE.

   -- OR --

   If you have enabled Composer’s Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the second F# above Middle C. See Controlling Composer From Your Music Keyboard.

2.20.5 Practicing a Part While Singing or Playing a non-MIDI Instrument

This topic describes how to use Composer to practice a section of a song if you want to practice singing or playing with an acoustical instrument while reading notes from the screen. If you have a MIDI keyboard or other MIDI input device such as a MIDI guitar that you wish to use, then see Practicing a Part Using Your MIDI Keyboard or MIDI Instrument.

To practice a section of a song while singing or playing your instrument:

1. Choose the Practice Setup command in the Perform menu to specify the section of the song you wish to practice; the number of times you wish the practice section to repeat; and the optional increase of tempo for each repeat of the practice loop. For detailed instructions, see Setting up Practice Loops.

2. You can optionally mute the sound of the part you will be practicing so that your singing or instrument playing will replace the sound of the part played back by Composer.
To mute the part, click the play/mute staff control button to change it from to . If the staff controls are not visible, turn on the Show Staff Controls option in the View menu, or type "qssc" for "Quick Show Staff Controls".

-- OR --

While holding down the ‘S’ (staff) key, click somewhere in the staff. Composer will display a pop-up menu. Choose the Mute Staff command in the pop-up menu.

3. Choose Start Practice in the Perform menu.

-- OR --

Type ALT+SPACE.

Before each practice loop, Composer displays (in the status bar) the number of remaining practice loops, and a countdown in seconds to the start of the practice loop, such as the following:

Remaining practice loops: 3 COUNT DOWN: 7

To stop a practice session in progress:

1. Hit the SPACE key.

-- OR --

2. Click the Stop button in the toolbar at the top of the window.

-- OR --

3. Toggle the Playback button in the toolbar at the top of the window.

-- OR --

4. If you have enabled Composer's Pitch-to-Command feature, while holding down the "trigger key" on your music keyboard, play the first F# above Middle C. See Controlling Composer From Your Music Keyboard.

2.20.6 Practicing a Part Using Your MIDI Keyboard or MIDI Instrument

This topic describes how to use Composer to practice a section of a song if you have a MIDI keyboard or other MIDI input device, such as a MIDI guitar. You can play a part "live" through your MIDI keyboard or other input device. Composer will produce the instrument sound assigned to the part through your sound card or external MIDI sound module.

If you do not have a MIDI keyboard or MIDI instrument, then see Practicing a Part While Singing or Playing a non-MIDI Instrument.

To practice a section of a song using a MIDI keyboard or MIDI instrument:

1. Choose the Practice Setup command in the Perform menu to specify the section of the song you wish to practice, the number of times you wish the practice section to repeat, and the optional increase of tempo for each repeat of the practice loop. For detailed instructions, see Setting up Practice Loops.

2. Double-click the solo staff control button to change it from to . If the staff controls are not visible, then set the Show Staff Controls option in the View menu, or type "qssc" for Quick Show Staff Controls. Note that the Show Staff Controls option is not available in Page View.

-- OR --

While holding down the 'R' key, click anywhere in the staff for the part you want to practice.
NOTE: If the MIDI device for this staff is one that has a build-in delay, the procedure described here will not work successfully. There will be a frustrating delay between the time you play a note on your MIDI keyboard or controller and the time you hear it played. You can review the delay for a MIDI output device in the Device Properties dialog. Instead of using the procedure described here, you should mute the staff for the part you want to practice. Then you should use the “jam along” feature described in Playing Along with Your MIDI Instrument. Also, for the “play along sound”, you should assign a MIDI device that does not have a delay.

3. Composer displays a red arrow to the left of the part you will practice.

![Melody](image)

If you are practicing a part with two or more staves, such as the right- and left-hand staves for a keyboard part, then double-click the solo button of each part; or while holding down the ‘R’ key, click anywhere in each additional staff. For each staff you will be practicing, Composer will turn the solo staff color to red and will display a red arrow to the left of the staff, as illustrated above.

4. To unselect a staff, double-click the red solo button, or while holding down the ‘R’ key, click anywhere in the staff.

5. If the staff controls are visible, you might want to hide them while practicing, so that more of the screen will be used for the score. To do so, toggle the Show Staff Controls option in the View menu.

6. To begin the practice session, choose Start Practice in the Perform menu.

   -- OR --

   Type ALT+SPACE.

Before each practice loop, Composer displays (in the status bar) the number of remaining practice loops, and a countdown in seconds to the start of the practice loop, such as the following:

```
Remaining practice loops: 3  COUNT DOWN: 7
```

As you play from your MIDI keyboard or other MIDI input device, the notes you play will be routed by Composer through the MIDI output device and channel assigned to the part you selected, or the first staff if you selected more than one staff. Also, Composer will use the instrument sound (MIDI patch) assigned to that staff. Note that you can change the sound for the staff if desired.

To stop a practice session in progress:

1. Hit the SPACE key.

   -- OR --

2. Click the Stop button in the toolbar at the top of the window.

   -- OR --

3. Toggle the Playback button in the toolbar at the top of the window.
2.20.7 Controlling Notation Composer from Your Music Keyboard

When you are practicing at your music keyboard, you may find it convenient to control Composer directly from your music keyboard rather than switching back and forth between it and your computer keyboard or mouse.

Composer’s Pitch-to-Command feature associates certain keys (pitches) on your music keyboard to commands that you are most likely to want to use while you are working at your music keyboard:

- Start and stop playback.
- Rewind.
- Fast forward.
- Increase, decrease, and reset tempo.
- Increase, decrease, and reset volume level.
- Start a practice loop.
- Advance to the next or previous practice loop.

When you play one of the keys on your music keyboard to execute one of the above commands, Composer needs some way to determine whether you intend it to be interpreted as a command versus a normally detected pitch. For this purpose, you need to (1) define a "trigger key" and (2) enable the Pitch-to-Command feature.

The "trigger key" is a key on your music keyboard that is reserved specifically for the purpose of informing Composer that you are "playing a command" rather than "playing a note". We recommend that you define the highest or lowest note on your keyboard as the trigger key, whichever of the two you are least likely to need during normal playing. When you want to "play a command" at your music keyboard, you simultaneously hold down the trigger key and play the particular command key, as described later in this topic.

You can enable or disable the Pitch-to-Command feature. When the Pitch-to-Command feature is enabled, the trigger key will not be available for normal performance or recording. When the Pitch-to-Command feature is enabled, if you play the trigger key, you will hear nothing. Nor will you hear anything when you play any other notes while the trigger key is down. When you do not need the Pitch-to-Command feature, and you need to perform or record the trigger key as a normal pitch, then you should disable the Pitch-to-Command feature.

To identify the trigger key on your music keyboard:

1. Choose the Set Up Pitch-to-Command command in the Setup menu.

Composer will display the Set Up Pitch to Command dialog box:

![Set Up Pitch to Command dialog box](image)

- **Enable pitch-to-command feature**: A checkbox to enable or disable the feature.
- **Trigger Key (Pitch)**: B6

**NOTE**: When the pitch-to-command feature is enabled, the trigger key is reserved for this purpose, and so will not produce sound as you play it, and will not be recorded.
2. At your music keyboard, play the key that you wish to serve as trigger key. You will see the pitch letter and octave displayed in the dialog box. If it does not change as you play a key on your music keyboard, then see What To Do If Recording Does Not Work.

3. Set the check mark for Enable Pitch-to-Command Feature.

4. Click OK to commit the settings.

**To play a command from your music keyboard:**

1. Hold down the trigger key that you specified above.

2. While holding down the trigger key, play one of the keys identified in the music keyboard diagram below:

3. Release the trigger key.

**To enable or disable the Pitch-to-Command feature:**

- Toggle the check mark for Enable Pitch-to-Command in the Setup menu.

  -- OR --

- Type "qpc" for Quick Pitch-to-Command.
Navigating through Composer and the Score

The previous section of this Composer documentation describes how you can download from the Internet, open, view, print, and play MIDI files or previously created Notation .not files. You can accomplish those tasks without needing to understand details about how Composer’s window, menus, toolbar, and palettes are arranged.

After you have gained some experience and enjoyment viewing and playing existing MIDI files, you will likely want to start editing them. To edit music in Composer, you will need to understand how Composer’s window is basically arranged.

If you like to "learn by doing", then you will probably have success learning how Composer works by simply exploring on your own the menus, the toolbar, and the palette. There is little harm you can do by exploring Composer this way. If you ever accidentally delete or change part of the score, you can always undo the change. Composer offers multiple-level undo, that goes back for as many operations as can be held in your computer’s memory.

Alternatively, if you like to learn by reading first, then read this introductory section. It provides an overview of all of the parts of Composer’s window, and details about how to navigate through a score.

This section is organized as follows:

Parts of the Composer Window
- Showing and Hiding Parts of the Window
- Menus
- Toolbar
  - Play and Record Buttons
  - Metronome Button
  - Tempo and Volume Controls
  - Zoom-In and Zoom-Out Buttons
  - Mouse Mode Buttons: Add, Select, and Step-Time Record
- Show/Hide Palette Button

Where Are All of the Buttons?

Palettes
- Keyboard Commands
  - Executing Commands from Your MIDI Keyboard

Window View and Page View

Staff Control Buttons
- Play, Mute, or Solo Staff
- Instrument Sound Selection
- Select Staff

Scrolling, Resizing and Zooming the Window
- Scrolling the Window
- Automatic Scrolling During Playback
- Resizing the Window
3.1 Parts of the Composer Window

The following picture identifies the main elements of Composer's window:

[Diagram of Composer window with labels for different sections such as Toolbar, Playback Location marker, Main palette, Staff focus marker, Status bar, Page scroller, and others.]

Each part of Composer's window is briefly described below. Some parts of the window are described in more detail throughout the remainder of this section.

- **Toolbar**
  The toolbar offers a variety of buttons and controls for recording and playing back songs; setting the metronome; controlling the volume level; zooming in and out; showing or hiding Piano Roll Notation; switching between Select Mode and Add Mode; and displaying or hiding the palettes. For details, see the Toolbar topic.

- **Playback Location and Staff Focus Markers**
  The playback location marker indicates where playback will start the next time you press the Playback button, or hit the SPACE key.
  The staff focus marker indicates the staff that Composer will focus on during playback. For details, see Playback Location and Staff Focus Markers.
Staff Controls

The staff controls for each staff enable you to:

- mute (turn off the sound) of a staff.
- solo it, so that no other staves are heard.
- set the instrument sound for the staff.
- select the staff for a global editing operation.

For details, see Staff Controls.

Main Palette and Detail Palette

The main palette and detail provide a uniform way to add or edit any type of musical data with just a few mouse clicks.

When you click on an object such as a note, clef, or dynamic mark, Composer automatically displays the palette that offers choices for editing that type of object.

To add a new object, you can easily "drill down" through the three levels of palettes to select the type of object you wish to add. For details about using the palette, see the Palettes topic.

Status Bar

The status bar shows:

- the most recent tip or error message.
- the characters of a command you are typing, such as "qpv" for Quick Page View.
- the name of the staff at the current mouse position.
- the measure and beat at the current mouse position.
- the page number of the currently displayed page.

Page Scroller

Use the page scroller if you prefer to use the mouse rather than keyboard shortcuts, such as PAGEDOWN and CTRL+END, for example, to go to the next page or end of the score.

3.1.1 Customizing Colors in Composer

You can easily change the overall color scheme in Composer, and also the colors using for highlight the music during playback.

To change the overall color scheme:

1. Choose the Color Theme command in the Setup menu.
Composer will display the Color Theme window:

2. In the list at the bottom of the window, choose one of the standard color themes pre-defined by Composer.

-- OR --

Change the background color, used for the background of palettes and windows, or the button color (of buttons in palette), by selecting clicking a color "of the rainbow" at the bottom of the color palette, and then selecting a shade of the color in the main portion of the color palette.

You can immediately preview your color selection by observing Composer's palettes and menus.

3. Click the OK button to save the new color theme, or Cancel to return to the most recent color theme.

To change the colors used to highlight the score during playback:

1. Choose the Playback Highlighting Options in the Perform menu.

2. In the Playback Highlight Options dialog, choose the colors that are used during playback:
3.1.2 Showing and Hiding Parts of the Composer Window

Composer offers options to show or hide most of the parts of the window described in the previous topic: the toolbar, palette, staff controls, and status bar.

To show or hide parts of the Composer window:

1. In the View menu, choose the Show Multiple Selections command.
   -- OR --
   Type "qsh" for Quick Show Hide.
   Composer will display the following dialog box:

   ![Show and hide window components dialog box]

   Add or remove check marks for the types of window components you wish to show or hide.
   -- OR --

2. In the View menu, toggle the check mark for, as example, the Show Song Tabs menu item.
3.1.3 Menus (But Not Too Much)

First, here's some advice about how you might use Composer's menus. In general, menus provide a reliable way to find commands that accomplish your music editing goals. However, for many commands you also have the alternative of using toolbar and palette buttons or keyboard shortcuts. For commands that you use often, such as Page View, consider using the Page View button in the toolbar, or the shortcut command characters "qpv" for Quick Page View. Composer's menus show the keyboard shortcuts so that you can easily learn the ones you use often. When you use a menu command, just take a brief look at its corresponding Quick command letters. The next time you may find it more convenient to just type the command letters.

Composer offers a convenient way for you to learn about the purpose and use of any menu command.

To display Help for a menu command:

1. Click the menu, and submenu if needed, that has the command.
2. Hold the mouse over the text of the command name.
3. Without clicking the mouse, hit the F1 key. This will display the on-screen help topic that describes the purpose and use of the selected menu command.

-- OR --

Instead of the above steps, use the Index option in this Help to look up the name of the menu, such as "Staff menu", and then choose the name the comment.

Listed below is a summary of each main menu selection in Composer. This summary is intended to help you to better anticipate where a command for a given operation might be found.

- **File**
  - *Open*, create, close, save or download (from the Internet), or *print* songs.

- **Edit**
  - Copy and paste to and from the *clipboard*, *Undo and redo* transactions.

- **View**
  - Determine how the Composer window displays the score and shows or hides *window parts*, such as the palettes and staff controls.

- **Measure**
  - *Edit measures*, add and insert measures; temporarily *view a range of measure* rather than all measures of the score; display measure numbers; add *barlines*, *repeats*, and *endings*.

- **Staff**
  - *Edit staves*, add and delete staves; *merge* and *clone* staves; *split a staff* into two staves for piano right- and left-hand, for drum instruments, and for melody and accompaniment; and *transpose notes*.

- **Part**
  - Prepare separate instrumental and vocal parts that are fully integrated with the main score, so that changes you make in the main score are reflected in the parts, and vice versa. *Prepare special parts* (sing-along, fake book lead sheet, Easy Notes, and piano reduction).

- **Region**
  - *Select a region of the score*, which is a range of measures or beats in one or more staves. Manipulate the selected region with commands in this menu, as well as with clipboard commands in the Edit menu.
- Object (renamed according to currently selected type of musical object)
  
  In Select Mode, the Object Menu changes according to the type of object selected.
  
  In Add Mode, the Object Menu provides options for the type of object that will be added when the mouse is clicked somewhere. In Add Mode, you can determine the type of object that will be added by navigating through the palettes with the mouse, or by using palette keyboard commands such as SHIFT+N for the Notes Palette or SHIFT+D for the Dynamic Mark Palette.

- Perform
  
  Play, record, and practice portions of a song.

- Setup
  
  Configure Composer to work with Windows, and in particular, the MIDI devices under the control of Windows.

- Window
  
  Within Composer's window, arrange the size and positions of score windows for multiple songs.

- Help
  
  Get help from Composer's online documentation or from Frequently Asked Questions (FAQ) or other resources at Notation Software's web site.

- Bring up any menu by using the Windows shortcut "Alt + underlined letter"

  You can bring up the command list for any menu by using the Windows shortcut "Alt + underlined letter". For example, to bring up the command list for "Region" you can use the keyboard combination "Alt + R"

  Similarly, you can use "Alt + x" to open the "Text" menu command list.

3.1.4 Toolbar

The toolbar is displayed along the top of Composer's window. The buttons and controls in the toolbar are grouped as indicated:
Each group of buttons and controls are described in the topics that follow:

- **Song Time**
- **Playback and Paging**
- **Metronome Button**
- **Tempo and Volume Controls**
- **Window and Page View Buttons**
- **Mouse Mode Buttons: Add and Select**
  - Add, Select, and Step-Time Record
- **Zoom-In and Zoom-Out Buttons**

3.1.4.1 **Song Time**

The song time indicator in the main toolbar shows how far along the playback of a song is, measured in minutes and seconds from the beginning of the song:

The song time indicator reflects elapsed time for repeated sections of the song.

3.1.4.2 **Playback and Paging Buttons**

The following buttons for controlling playback and recording are located in Composer's toolbar:

- **Start of Song**
  - Go to the start of the song.
- **Previous Page**
  - Go to the previous page.
Start/Stop Playback
Click this button to start playback at the current location of the Playback Location Marker. The Play button is shown in a down position if playback is in progress. If playback or recording is in progress, click either this button or the Stop button to stop playback or recording.

Start or Stop Recording
Click this button to start or stop recording. See Starting and Ending the First Recording.

Stop
Click this button to stop playback or recording that is in progress. To pause button, use this Stop button, and then resume playback with the Play button.

Next Page of Fast Forward
If playback is in progress, click this button to quickly play through the song at five times normal speed.

End of Song
Go to the end of the song.

3.1.4.3 Metronome Button

To turn off or on the metronome for playback or recording:

- Toggle the metronome button in the toolbar to the down or up position for on or off.

To specify whether the metronome should be on or off by default:

1. In the Perform menu, choose Metronome Setup command.
   -- OR --

   While holding down the CTRL key, click the metronome button in the toolbar.

   Composer will display the Metronome Setup dialog box, as illustrated in Setting up the Metronome.

2. Set a check mark or not for the two options at the top of the Metronome Setup dialog box, for "Metronome is on during playback" and "Metronome is on during recording".

To specify how many measures and beats the metronome should lead in before the start of playback or recording:

- Choose the Pickup Beats command in the Perform menu.

For more information, see Setting Up Pickup Beats.
3.1.4.4 Tempo and Volume Controls

The following buttons for tempo and volume level are located in Composer's toolbar:

![Tempo and Volume Controls Buttons]

**Beats Per Minute**

The tempo of the song is displayed in beats per minute. For many meters, the beat is a quarter note. For a 6:8 meter, the beat is indicated as a dotted quarter note if the tempo is fast, or an eighth note is the tempo is slow. You can click either the note duration symbol for the beat, or the tempo value (160 quarter notes per minute in this example), to change the tempo value for the entire song, or for any selected range of the song.

![Click here to change the tempo via a dialog box.]

The song may have several tempo changes throughout. During playback, the Beats Per Minute value shows the tempo at the current location. If playback is not in progress, the indicated tempo is that where the playback marker is located.

For details, see Viewing and Adjusting the Tempo.

**Tempo Adjustment**

During playback you can temporarily increase or decrease the tempo as a percentage of the underlying tempo in the song. You can adjust the tempo by clicking up the arrow buttons at the right of the tempo adjustment number. Or, you can type T + Up (or Down) Arrow. Type T + Enter to reset the tempo to normal (100%).

To save a file with the adjusted tempo, click on the Perform menu item, and select "Tempo / Keep adjusted tempo".

For further details, see Viewing and Adjusting the Tempo.

**Volume Control**

During playback you can adjust the overall volume level of all staves. Also, if one or more staves are currently selected, the volume control changes the volume level of these staves relative to other non-selected staves. This feature is useful for focusing on certain instruments during playback. For details, see Adjusting Volume of Selected Staves During Playback.

3.1.4.5 Window and Page View Buttons

In Window View, Composer arranges the pages of the score as though the page size were exactly the size of the window. If you change the window size, Composer will automatically and quickly repaginate the score for the new "page size", which is, in this case, the window size.
In Page View, Composer displays an image of the page as it would be printed, which is usually larger than what can be seen all at once in the window. Therefore, in Page View, Composer usually displays scrollbars that enable you to scroll horizontally and/or vertically in the page. In Page View you can view the entire printed page by using the **Zoom Out** command.

You can toggle between Window View and Page View using these two buttons in the toolbar:

![Window View](image1) ![Page View](image2)

For more information, see the topic on **Window View and Page View**.

3.1.4.6 **Mouse Mode Buttons: Select and Add**

When you click here and there in the score, do you intend to select something that you want to edit, or do you want to add something new in the score? The way you indicate your intention is to choose Region Select Mode, Select Mode, Add Mode, or Step-Time Record. You can choose which mode using these buttons in Composer's toolbar:

![Region Select Mode](image3) ![Select Mode](image4) ![Add Mode](image5) ![Step-Time Record Mode](image6)

- Region Select Mode -- drag mouse to select a region for operations such as copy and paste.
- Select Mode -- mouse-click to select objects for editing.
- Add Mode -- mouse-click to add objects.
- Step-Time Record Mode -- mouse-click to determine the song location where notes and chords you enter via your music (MIDI) keyboard will be added.

Switching between Select Mode and Add Mode is such a common operation that Composer has reserved one of the most convenient keys on the keyboard (ENTER), and one of the most common mouse operations (Right Click), for this purpose.

To switch between Add Mode and Select Mode:

- Click the Select Mode button or Add Mode button in the main toolbar.
- OR
- Hit the ENTER key.
- OR
- Right-click the mouse anywhere on the score.
In Select Mode, when you select one (or more) objects of the same type, Composer displays a palette that offers options for changing the properties of that object. For example, when you click the mouse on a clef in Select Mode, Composer displays the clef palette. You can use this palette to change the clef from, say, a treble to bass clef. For details, see Selecting One or More Objects Before Editing Them.

In Add Mode, you can navigate through palettes to determine the type of object you wish to add. Once you have chosen the type of object you wish to add from a palette, click the mouse where you want to add it. For details, see Adding Objects Using Palettes.

Use the Step-Time Record Mode to enter notes one at a time, or one chord at a time, from a music (MIDI) keyboard connected to your computer.

To switch to Region Select Mode:

- Click the Region Select Mode button in the main toolbar.
- OR —
- Double right-click the mouse anywhere on the score.

To switch to Step-Time Record Mode:

- Click the Step-Time Record button in the main toolbar.
- OR —
- Type CTRL+Enter.

For details about Step-Time Record Mode, see Recording in Step-Time.

### 3.1.4.7 Undo and Redo Buttons

Use the following two buttons on the main toolbar to undo your most recent editing operation, and to redo the most recent editing operation you have undone:

Composer keeps a long list of editing operations in its undo history. You can view the names of the undoable editing operations in the Edit menu. You can also undo or redo several editing operations with one click in the Edit menu. For details, see Undoing Editing Operations.

### 3.1.4.8 Zoom-In and Zoom-Out Buttons

The following buttons in Composer's toolbar let you temporarily enlarge or shrink the size of the score notation viewed on the screen:
Zoom In makes everything look bigger, and Zoom Out makes everything look smaller.

It is important to understand that zooming in and out does not affect the size of what is printed. To change the size of what is printed, use the Font Size and Spacing command in the Format menu. For details, see Overall Font Size.

3.2 Palettes

Composer’s palette offers a large number of choices for adding and editing music symbols.

The palettes are organized in a 3-level hierarchy. If you wish to add a music symbol of a certain type, you “drill down” through the three level to select the type of object you wish to add. When you select a music symbol in Select Mode, then Composer automatically drills down to the palette for the type of object you have selected.

Navigating Through Palettes in Add Mode

The following example shows how you would navigate through the three levels of palettes to start adding lyrics:
TIP:

In **Add Mode**, you need to select the palette of the type of music symbol you wish to add before you click the mouse where you wish to add the music symbol.

In contrast, in **Select Mode**, you just click the mouse on the music symbol you wish to select: *Composer* will automatically display the palette for that type of symbol.

If you wish to edit an music symbol of a particular type, it is a bad idea to click around in the palettes, because when you change palettes, *Composer* will automatically switch from Select Mode to Add Mode, because it figures the only reason you have for navigating in the palettes is to add a music symbol, not select it. Again, if you want to edit a music symbol already in the score, just click it with the mouse in Select Mode.

Using the Palettes to Edit Music Symbols and Text

In Select Mode, use the third-level (detail) palette to edit music symbol or text you have selected.

- To edit a music symbol or text using the palette:
  - Enter **Select Mode**.
  - Click the music symbol or text to select it.
Navigating through Composer and the Score

The object will be highlighted in blue. Composer will automatically select the third-level (detail) palette for the type of selected object.

- Click one or more buttons in the detail palette to edit the selected object.

Keyboard Shortcuts for Palettes

In Add Mode, you can quickly navigate a third level palette with a keyboard shortcut, which is SHIFT+{letter}, such as SHIFT+L for the Lyrics palette.

You can learn the SHIFT+{letter} shortcut for a palette by holding the mouse over the second-level palette button for that third-level palette, as illustrated in the above example for the Lyric palette.

Note, some palettes share the same SHIFT+{letter} shortcut. For example, the shortcut for the Rehearsal Mark palette and the Rest palette are both SHIFT+R. If you type SHIFT+R and the wrong palette comes up, just type SHIFT+R a second time. We figure it is easier for you to type SHIFT+R twice than it is to type something like CTRL+SHIFT+R, which is both difficult to type and difficult to remember.

Hiding Palettes

When you are first learning Composer, it is a good idea to leave all three levels of the palettes displayed. After you learn the simple SHIFT+{letter} shortcuts for the palettes, you might prefer to free up some of Composer’s window by hiding the first two levels of the palettes, leaving only the third-level palette showing. You can switch between different third-level palettes by typing the SHIFT+{letter} shortcut.

Also, you might want to temporarily hide all levels of the palettes, when you are just viewing or singing or playing along with the score, but not editing it.

The first two levels of the palette—the palette tabs and the intermediate palette buttons—are together called the main palette. The third-level palette is called the detail palette.
To show or hide the main palette or detail palette:

- Toggle the Show Main Palette or Show Detail Palette command in the View menu.
- OR --
- Choose the Show Multiple Selections command in the View (or type "qsh") and toggle the check mark for main palette or detail palette.
- OR --
- Type "qsmp" for Quick Show (or hide) Main Palette, or "qsp" for Quick Show (or hide) Palette for the detail palette.

**Moving Palettes**

You can dock the main palette or detail palette to any of the four sides of Composer's window according to your personal preference. Also, you can "float" the palette in the middle of the window and drag it around with the mouse on the window, close to where you are working.

To move or "float" the detail palette or main palette:

- Press down the left mouse button on the dotted lines along the left edge of the palette, or top edge of a vertically oriented palette.

- While holding down the left mouse button, drag (move) the palette to another edge of Composer's window, or to the middle of the window.
- Release the left mouse button.

### 3.3 Keyboard Commands

Composer enables you to edit music using your computer keyboard without having to use awkward and difficult-to-remember key combinations such as CTRL+ALT+N. Instead, most commands in Composer are typed not by holding down two or three keys at a time but, rather, by typing a sequence of keys, such as "qp" for "Quick Page View".
Quick "Q" Commands

Many keyboard commands in Composer begin with the letter "q" for "Quick". Many other commands do not. The "q" commands are for commands that are listed in the top menus and tool bar, such as View or Staff commands. Commands that occur within palette tabs do not begin with the letter "q". For example, when the clef palette is showing, you can type "t" to prepare to add a treble clef - you do not use a "q".

As you type command letters,Composer displays them in the status bar. For example, this is what the status bar looks like when you have typed the first two letters of the Page View command, before typing the last letter of "qpv":

You can quickly learn the Quick command letters for commands you use frequently by observing them in Composer's menu. The following example shows that "qpv" are the Quick command letters for the Page View command:

A summary of all of the Quick command shortcuts is provided in Appendix A: Keyboard Shortcuts. 

Shortcuts for Object-Specific Commands

Commands specific to a given type of object do not begin with the letter "q". For example, if in Add Mode you are preparing to add a bass clef, then you can type "b" for bass clef.
There are two ways that you can learn the keyboard shortcuts for object-specific commands. The first way is to hold the mouse cursor over the palette button for the command, as illustrated here:

The second way to learn the keyboard shortcuts for object-specific command is to review it in the Object Menu. At any given time, the Object Menu is named according to the type of object you are working with:

Here is a fairly easy way to remember whether a command begins with a "q" or not. If the command has a corresponding palette button, then it will not begin with the letter "q". If the command is found in the Object Menu (which will be renamed to whatever type of object you are working with, such as Note or Clef or Accent), then the command also will not begin with the letter "q". Otherwise, if the command is only available in some other menu— not in the Object Menu, and not in a palette— then the command will begin with the letter "q".

How is Composer able to offer such simple keyboard shortcuts compared to other programs?

The reason that Composer is able to offer you convenient keyboard commands is that, with one exception, you do not need the keyboard for other purposes. Normally you do not need to enter text as you would in a word processor or an email program. The exception, of course, is that sometimes you do need to enter text, such as for lyrics or textual annotations in the score.

When you add a new lyric or text annotation, you just click the mouse where you want to add it, and then you start typing. When you are done typing, hit the ESC key. Similarly, if you want to edit text, just click the lyric or text object. hit the ENTER or ESC key when you are done editing the text.

In all circumstances other than the editing of lyrics and text annotations, Composer interprets your keystrokes as Quick commands when they begin with "q", and otherwise as palette shortcut commands. You don't have to use awkward and difficult-to-remember combinations of ALT, CTRL, and SHIFT keys!

For more details about editing lyrics and text annotations, see Editing Types of Text.

Using the ALT Key for Menus

Alternatively, while holding down the ALT key, type the letter of the menu, such as "V" for the Staff menu. That sequence displays the menu. Then type the letter that is underlined in the command name, such as the P in the Page View command name.
You might find this alternative method particularly useful for commands you are used to using in other programs, such as ALT+F and "O" for the File Open command.

If the menu has more than one command with the same letter, then type the letter once for the first command, or a second time for the second command, followed by the ENTER key.

A Few CTRL+Letter Commands

Composer does use a few CTRL+letter commands according to conventions you have likely learned in other Windows programs.

There are only a few, all of which are listed here:

File Commands
CTRL+N create a new file
CTRL+O open an existing file
CTRL+P print the currently viewed score
CTRL+S save the currently viewed score

Clipboard and Region Editing
CTRL+X cut (remove) and copy to the clipboard
CTRL+C copy to the clipboard
CTRL+V paste from the clipboard
CTRL+D delete (clear) selected region of score

Undo and Redo
CTRL+Z undo most recent transaction
CTRL+Y redo most recent undone transaction

Window and Page Navigation
CTRL+G go to measure, page, or rehearsal mark
CTRL+F6 show next window when viewing multiple opened songs
CTRL+F4 close score (song) window
ALT+F4 exit Composer

Miscellaneous
SHIFT+CTRL+S turns off stuck notes that will not otherwise stop sounding.

Arrow Key Commands

Composer does use some two-key combination commands, where one of the letters is an arrow key and the other is a letter. Hold down both the letter key and the arrow key, just as you are probably used to doing with CTRL and ALT. These arrow key combination commands all make good sense because the directions of the arrows are meaningful, and the letters relate to the purpose of the two-key arrow commands.

For example, while holding down the 'T' key, hit the ↑ (or ↓) key to increase or decrease the tempo during playback. In this documentation, that two-key combination is indicated as T+↑ (or T+↓).

Another example is D+→ to increase the duration of a selected note.

This makes sense, doesn't it? These Letter + Arrow combinations are easy to learn and remember. For a list all of Letter + Arrow commands, see Appendix A: Keyboard Shortcuts.
3.4 Executing Commands from Your MIDI Keyboard

Composer When you are practicing or playing along with Composer at your music keyboard, you may find it convenient to control Composer directly from your music keyboard rather than switching back and forth between your music keyboard and your computer keyboard or mouse.

Composer's Pitch-to-Command feature associates certain keys (pitches) on your music keyboard to commands that you will most likely want to use while you are working at your music keyboard, such as Start Playback and Stop Playback. You specify a "trigger key" on your music keyboard, typically the highest or lowest note. When you hold down the trigger key, Composer will not play that note. Instead, while you are holding down the trigger key, you simultaneously play another key to instruct Composer to perform a command, such as starting playback.

For details about Composer's Pitch-to-Command feature, see Controlling Notation Composer from Your Music Keyboard.

3.5 Window View and Page View

Composer offers two ways to view a score on the screen: Window View and Page View.

In Window View, Composer arranges the pages of the score as though the page size were exactly the size of the window. If you change the window size, Composer will automatically and quickly repaginate the score for the new "page size", which is, in this case, the window size.

In Page View, Composer displays an image of the page as it would be printed, which is usually larger than what can be seen all at once in the window. Therefore, in Page View, Composer usually displays scrollbars that enable you to scroll horizontally and/or vertically in the page. In Page View you can view the entire printed page by using the Zoom Out command.

NOTE: Page View is the same thing as Print Preview

Some software programs offer a Print Preview command, which enables you to preview pages exactly as they would be printed. Composer's Page View command offers you everything that a Print Preview command does, and a lot more. In Composer's Page View you can not only preview the printed pages but also edit them.

In Window View, Composer evenly spaces the measures so that the barline of the last visible measure is right-justified in the window. As many measures are displayed as can comfortably fit horizontally. If more than one system (also called a "line", which includes multiple staves) can be displayed in the window, then multiple systems are displayed. If only one system can be displayed, but it has more staves (staves) than can be shown without crowding, then the window adds a vertical scrollbar that enables you to view the lower staves.

In Page View, Composer simulates the layout of the notation symbols as they would appear on a printed page. Because the size of various symbols are not exactly proportional as rendered by the printer versus the monitor, the image displayed by Page View cannot exactly represent the spacing of the printed page. Therefore, whereas the spacing between accidentals and noteheads, for example, may look ideal when printed, the spacing may seem less than perfect on the screen. Usually the difference is insignificant, but we mention the issue here in case you do notice any difference.

- To view the score in Window View:
  - Click the Window View button in the main toolbar.
  - OR
  - Type "qvw" for Quick Window View.
Navigating through Composer and the Score

To view the score in Page View:

- Click the Page View button in the main toolbar.
- **OR**
- Type "qpv" for Quick Page View.

For either view you may want to "Refresh" the page to make sure that you are seeing the score properly. To do this, you can use the "View / Refresh Current Page" or "View / Refresh Entire Score" menu command. This is especially helpful if you have made many edits and want to review your pages for printing.

3.6 Staff Controls

Along the left-side of each staff you will see a group of four staff control buttons, as shown:

- **Play or mute**: turn the staff sound on or off during playback.
- **Solo**: play only this staff while muting all other staves (except other soloed staves).
- **Instrument sound**: assign a new device, MIDI bank, MIDI patch, or name to the staff.
- **Select the staff**: prepare for a Staff menu command such as Split Hands, or a Region menu command such as Remove Inaudible Notes.

You can use any of these controls during playback.

You may not always want these staff controls to use up space on the screen. In such cases, follow this next procedure.
To show or hide the staff control buttons.

- Turn off the Show Staff Controls check mark in the View menu.
  -- OR --
- Type "qssc" for Quick Show Staff Controls, to toggle between show and hide.

If the staff controls are not currently visible, there is an alternative way you can accomplish the same tasks as offered by the staff controls.

To do staff control tasks when the controls are not visible:

1. While holding down the 'S' key, click the mouse anywhere in a staff. Composer will display a pop-up menu, such as illustrated here:

   ![Soprano Sax Staff Controls](image)

2. Choose the equivalent staff control command from the pop-up menu.

3.6.1 Play, Mute or Solo Staff

There are a variety of occasions where you might want to listen to only certain staves of a song while other staves are muted (silenced). For example, if a song has a melody staff played by some instrument, but you want to sing the melody by yourself, then you can mute the melody staff. Or, you might want to study the composition and arrangement of a song and focus on how a particular instrument part is written by "soloing" that instrument part, thus muting all of the other staves. If you have a MIDI keyboard, you can temporarily mute a staff and perform the part yourself; Composer will assign the instrument sound of the staff to the notes you play.

Composer enables you to play any combination of staves while muting other staves. You can even do this while the song is playing back. If the staff controls are visible, you can tell that a staff is muted if the top-left button is not pressed down and has a dull light instead of the normal bright green light:

- staff playback is active
- staff is muted

Note that you can also mute staves using the Staff Setup command in the Staff menu.

If you save the song as a MIDI file, then any muted staff will be restored as an audible staff in the MIDI file; the staff will not be deleted.

To toggle the mute status of a staff:

- If the staff controls are not already visible, choose the Show Staff Controls option in the View menu. Note that the Show Staff Controls option is not available in Page View.

  In the group of four staff controls, toggle the play/mute button between and .

  -- OR --

- If the staff controls are not visible, and you do not wish to display them, then while holding down the "T" key, click anywhere in a staff. Composer will display a pop-up menu offering choices
Navigating through Composer and the Score

for Select Staff, Mute Staff, Solo Staff, and Instrument Sound. In the pop-up menu, choose the Mute Staff command.

Another option allows you to mute all staves except one (or a few) staff(s) that you wish to temporarily "solo". The play/mute status of the other staves are only temporarily changed. Once you remove the solo status of all staves, any staff that was previously playing will continue to play, and any staff that was previously muted will continue to be silent.

- To temporarily solo one staff so that no other staves are heard:
  - Toggle the solo button from the up position (in which two musicians are shown) to the down position: (in which a solo musician is shown).
  - OR --
  - While holding down the 'S' key, click anywhere in a staff belonging to that staff. Composer will offer a pop-up menu. Choose the Solo Staff command.

- To temporarily solo multiple staves so that only they are heard:
  1. Click the solo button for one staff.
  2. While holding down the SHIFT key, click the solo button for additional staves.

- To temporarily solo all of the staves in the current part, while muting all accompaniment staves not included in the part:
  - While holding down the SHIFT key, click the solo button for one staff.
  - OR --
  - Type "qsolo" for Quick Solo.

- To remove a staff from the list of solo staves:
  - While holding down the CTRL key, toggle the solo button from the down position to the up position:.

- To resume playback of all staves, and turn off the solo of any staves:
  - While holding down the SHIFT key, click the play/mute button for any staff. It does not matter whether that particular staff has been previously muted.

Yet another option lets you temporarily mute a staff and assign the sound of that staff to any notes you play at your music keyboard. This option is useful when you want to play one of the instrument parts of a song instead of having Composer play it. Composer will still play the other parts as accompaniment.

- To temporarily mute a staff and assign its instrument sound to notes that you play on your music keyboard:
  - Double-click the solo button for the staff.
  - OR --
  - While holding down the "R" key (for "record", although you will not actually be recording), click anywhere in the staff of the staff.

Composer indicates that this staff has been muted by changing the staff play button to the up position:
At the same time, Composer indicates that this staff has been selected to provide the instrument sound for your music keyboard by changing the solo button from green to red:

In addition, Composer indicates that this staff has been so selected by drawing a red arrow right before the beginning of the first staff shown in the window for this staff:

To return the staff to normal playback:
- Just click the staff’s solo button again.

If the part you want to play has two staves, such as a piano or keyboard part, then you will find the following procedure useful.

To temporarily mute more than one staff and assign the instrument sound of one of the staves to notes that you play on your music keyboard:

1. Double-click the solo button for the staff whose instrument sound you want to assign to your music keyboard.
   -- OR --
   While holding down the "R" key (for "record", although you will not actually be recording), click anywhere in the staff for that staff.
2. For the other staff(s) that you want to play instead of Composer, toggle the playback button to the up position.

### 3.6.2 Instrument Sound Selection

Among the staff controls, the Instrument Sound Selection button lets you change the instrument sound of a staff. You can change the instrument sound even while the song is playing.

If the staff controls are not visible, and you do not wish to display them, then while holding down the 'S' key (for 'staff'), click the mouse somewhere in the staff. Composer will display a pop-up menu such as illustrated here:

In the pop-up menu, choose the Instrument Sound command.

For details, see Changing the Instrument Sound of a Staff.

### 3.6.3 Select Staff

If you click the Select Staff button among the staff controls, Composer will select the entire staff as the current region.
Navigating through Composer and the Score

Alternatively, if some notes are already selected in a staff, or if some region of the staff is already selected, you can use the Select Staff command in the Note or Region menu, or type "st" for "select staff".

As another alternative, if the staff controls are not visible, and you do not wish to display them, then hold down the 'S' key (for 'staff'), and click the mouse somewhere in the staff. Composer will display a pop-up menu in which you can choose the Select Staff command:

Composer displays a light blue background for the entire selected staff. You can then use commands that edit the entire staff. Commands that edit the entire staff are located in the Edit, Region, and Staff menus.

If you want to apply commands to more than one staff at a time, you can select more than one adjacent staff using the Select Staff controls for the respective staves.

To select the entire range of one or more adjacent staves:
- Click the Select Staff button among the staff controls to select one staff. While holding down the SHIFT key, click another staff to select it and all of the other staves between it and the first selected staff.

3.7 Scrolling, Resizing and Zooming the Window

The Composer window shows some portion of the score at any given time. In Page View, the window shows some or all of one printed page of the score. In Window View, the window shows some range of measures of the score— as many as will fit in the window.

The window will display a vertical scrollbar in the following circumstances:
- In Page View, if the entire height of the page does not fit in the window.
- In Window View, if only part of one system fits in the window.

The window will display a horizontal scrollbar in the following circumstances:
- In Page View, if the entire width of the page does not fit in the window.
- In Window View, if only part of one measure fits in the window.

If a vertical and/or horizontal scrollbar is present in the window, then you can use it to scroll the window to see other parts of the page in Page View, or other staves of a system in Window View, or other beats of a measure in Window View. You can also scroll from one page to the next page or the previous page. If your mouse has a scroll wheel, you can use it to scroll the window. You can also use keyboard shortcuts, such as PAGEDOWN to scroll down through a large portion of the page, and SHIFT+PAGEDOWN to advance to the top of the next page.

During playback, Composer automatically scrolls the window to show the current position in the song, and to keep the focus on the staff that you have selected.

If you want to see a larger portion of the score in the window, you can resize the window to see more. Or you can use the Zoom Out command to make the notes smaller and therefore view more notes at once.
If you are editing the score and need to increase the accuracy of the placement of objects in the score, you can use the **Zoom In** command to make the notes and annotations larger.

Options summarized above are described in detail in the topics that follow.

### 3.7.1 Scrolling the Window

Composer displays a horizontal and/or vertical scrollbar along the right and bottom edges of the window if the page does not fully fit within the window.

- **To scroll the current page displayed in the window:**
  - If there is a vertical scrollbar, hit the PAGEDOWN or PAGEUP key to scroll the window by almost the full height of the window. Alternatively, click the mouse cursor in an empty area of the scrollbar.
  - OR --
  - To scroll by smaller amounts, move the horizontal or vertical scrollbar button with the mouse.
  - OR --
  - If your mouse has a scroll wheel, scroll it up or down to scroll the window vertically.
  - OR --
  - Type `CTRL +`, `CTRL +`, `CTRL +`, or `CTRL +` to scroll the window down, up, left, or right by relatively small increments.

- **To continue scrolling to the next or previous page:**
  - Hit the PAGEDOWN or PAGEUP key for the next or previous page.
  - OR --
  - When you reach the bottom of a page, click the bottom vertical scroll button ; or when you reach the top of the page, click the top vertical scroll button.
  - OR --
  - If your mouse has a scroll wheel, continue scrolling it up or down to scroll the window vertically.

Composer will hesitate for about a half second between each page, so that you do not unintentionally overshoot the next page.

- **To advance to the top of the next or previous page, without scrolling through the rest of the current page:**
  - Type `SHIFT+PAGEDOWN` for the next page, or `SHIFT+PAGEUP` for the previous page.

Also see [Navigating through Pages of the Score](#).

### 3.7.2 Automatic Scrolling During Playback

During playback, Composer automatically scrolls the window vertically and horizontally to show the current position in the song. It scrolls horizontally a few extra beats ahead of the current playback position so that you can see the notes ahead. Composer also turns the page a few beats ahead of the current playback position. You can specify the exact number of beats for the **page turn anticipation**.

If Composer's window is not tall enough to display all of the staves for the current measure, then Composer automatically scrolls the window vertically to a position that maintains the focus on some staff that you have selected, or which otherwise Composer selects by default. You can assign **playback focus to a staff** thus setting the playback staff marker, by clicking the staff while you hold down the "V" key (for "vertical focus").
3.7.3 Resizing the Window

To resize Composer's window:

1. If the window occupies the full screen, then you will first need to toggle the Maximize button at the top, right corner of the window:

   ![Maximize button]

   Click this button at the top, right corner of the window to change window size from "maximized" to a smaller size that you can adjust by dragging the corners of the window.

2. "Drag" the window's corner or edge: hold the mouse down, starting at the corner or edge, and move the mouse to the new position before releasing the mouse button.

   In Window View, Composer automatically and quickly repaginates the score so that each page exactly fits the window size.

3.7.4 Zooming the Window

Composer enables you to change the magnification of the score displayed on the screen. "Zooming in" increases the magnification so that the music symbols appear larger. "Zooming out" makes the symbols appear smaller, so that more of the musical score appears at once in the window.

Although you can specify exact zoom percentage levels with the Zoom Percentage command in the View menu, Composer may limit small zoom values to 30% or 40% if you are using Windows 95, 98, or Millennium. On Windows NT, 2000 and XP, Composer can handle arbitrarily small zoom levels.

NOTE: Changing the zoom level affects only the size of music symbols as displayed on the screen. To change the size of music symbols as printed, use the Font Size and Spacing command in the Format menu.

To change the zoom level:

1. Choose the Zoom command in the View menu, and the Zoom In or Zoom Out command from the Zoom submenu.

   -- OR --

2. Type Z+ to zoom in, or Z+ to zoom out.

   -- OR --

3. In the toolbar, click the button to zoom in, or the button to zoom out.

   -- OR --

4. To change the zoom level to a specific percentage magnification, choose the Zoom command in the Zoom menu, and the Zoom Percentage command in the Zoom submenu.
To reset the zoom level back to 100%:

1. Choose the No Zoom command from the Zoom submenu.
   -- OR --
2. Type Z+ENTER.

3.8 Navigating through Pages of the Score

You can go to different pages of the score by referring to any of the following:

- Page number
- Measure number
- Rehearsal mark

You can do this by using:

- Commands in the Go To submenu of the View menu.
  -- OR --
- Keyboard shortcuts, such as CTRL+PAGEDOWN for next page.
  -- OR --
- The Fast Forward and Rewind buttons in the main toolbar. Using these will move
  the Playback Position Marker to the top of the page.
  -- OR --
- The Page Scroller in the lower right of the Status Bar. Using this scroller allows you to view other pages
  without changing the position of the Playback Position Marker when play is stopped, as well as when the file is playing.

You can also temporarily view and print a range of measures in the score rather than all of the measures.

For details about the above navigation and viewing options, see the topics that follow.

3.8.1 Viewing a Range of Measures

To display or print a range of measures instead of all of the measures in the score:

1. Choose View Measures in the Measure menu. The View Measures menu item indicates what
   range of measures are currently being displayed, such as "View Measures 25 to 49".
   -- OR --
   Type "qvm" for Quick View Measures.
   Composer will present a View Measure Range dialog.

2. In the dialog, specify the starting and ending measures that you wish to display or print. The
   measure numbers of a score normally start at 1, unless you have specified a different starting
   page number in the Page Setup dialog box.

3. To then print the score, use the Print command in the File menu.
3.8.2 First Page, Next Page, Previous Page, and Last Page

In Page View, the page on the screen is an image of the page as it would be printed. In Window View, the page on the screen simulates a printed page that is exactly the size of the window. In either Page View or Window View, you can advance forward and backward through the pages.

If the song is currently playing when you use any of the First Page, Next Page, or Previous Page commands, then the song will continue playing where it was, without jumping to the new page. After a few seconds, Composer will return to the page that is currently playing. However, if you use one of these commands during playback and you decide you would like playback to jump to the new page, just click on that page.

If an object is currently selected, and you use the Next Page or Previous Page command, then the page will be vertically scrolled so that staff of the selected object will have the staff vertical position in the window. This is done so with the assumption that you will want to continue working in the same staff as that of the most recently selected object, as you go to the next or previous page.

To advance to the next or previous page:

- Type SHIFT+PAGEDOWN for next page, or SHIFT+PAGEUP key for previous page.
- Click the ">>" or "<<" areas in the Page Slider in the status bar at the bottom of Composer’s window for the next or previous page:
- Click the Next Page or Previous Page button in the main toolbar.

To go to the first or last page of the score:

- Type CTRL+HOME for first page, or CTRL+END key for the last page.
- Double-click the Start of Song or End of Song button in the main toolbar.

3.8.3 Go to a Measure or Page

To go to specific measure number:

1. Choose the Go To command in the View menu, and Measure in the Go To submenu.
- Type "qgm" for Quick Go to Measure.
Composer will display the Go To Measure dialog box.

2. In the dialog box, enter the measure number that you want to go to.

**To go to specific page number:**

1. Choose the Go To command in the View menu, and Page in the Go To submenu.
   -- OR --
   Type "qgp" for Quick Go to Page.
   Composer will display the Go To Page dialog box.

2. In the dialog box, enter the page number that you want to go to.
   -- OR --

3. In the status bar at the bottom of the window, drag the Page Scroller button.

### 3.8.4 Go to a Rehearsal Mark

You can add any number of rehearsal marks in a score, as described in [Rehearsal Marks](#). Rehearsal marks help ensemble musicians to easily refer to locations in a score during rehearsals. You can also use rehearsal marks as bookmarks while you are composing or editing the song. Once you have added a rehearsal mark, you can quickly go to it from wherever you are in the score.

**To go to a previously added rehearsal mark:**

1. Choose the Go To command in the View menu, and Rehearsal Mark in the Go To submenu.
   -- OR --
   Type "qgr" for Quick Go to Rehearsal Mark.
   Composer will display the Go To Rehearsal Mark dialog box.

2. In the dialog box, select the rehearsal mark that you want to go to.
4 Editing Staves and Formatting Parts

In Composer, the largest unit of musical data is the song. (The term "song" is admittedly inappropriate for many types of music compositions, but it is a convenient term to use.) A song is all of the music—the performance and the notation—that you can save and later retrieve from a Notation .not file.

TIP: Actually, the largest unit of musical data in Composer is a playlist. You might find it handy to break up a musical composition into multiple Notation .not files, perhaps one for each major section of a composition or arrangement.

The next largest unit of musical data is a "staff". A staff is the line of music throughout the song performed by one instrumentalist or vocalists, or group of musicians sharing the same notes. Some instruments have multiple staves, such as a pair of piano right-hand and left-hand staves. In Composer, a staff also holds underlying MIDI performance details. If you are familiar with MIDI sequencing software, a staff is similar to a MIDI track, except that a staff also includes notation details.

In Composer, the concept of a "part" is similar to what you would think of as an individual part that lies on a music stand as an instrumentalist or vocalist reads it. A part shows one or more staves. The part for an oboe or saxophone has only one staff. The part for a piano or keyboard instrument typically has two staves for the right and left hands.

If the song has multiple instruments or vocal parts, then the score that shows all of the instruments and vocal parts together is called the "conductor's score". In Composer, the conductor's score is treated just like another instrument part; it just happens to show all of the staves for all of the instruments.

NOTE: Instrument and vocal parts are integrated with the conductor's score. For example, if you change a note in a part, it is automatically reflected in the conductor's score; or if you change a note in a staff in the conductor's score, that change is automatically reflected in the instrument or vocal part.

In Composer, you can format a part or layout pages of a part for printing using a wide variety of options, whether the part is for a single instrument or voice, or whether it is the overall conductor's part. The main idea here is that a "part" is a primary unit in Composer that you can format independently of other parts.

The above introductions to the terms "staff" and "part" are far from adequate to help you understand their central roles in Composer. It is highly recommended that you read the topic Understanding Staves, Staves and Parts before exploring these major areas of Composer:

- Editing Staves
- Preparing Parts
- Formatting Parts
- Laying out Pages of a Part

4.1 Understanding Tracks, Staves, and Parts

It is important to understand how Composer defines the terms staff and part. These two terms are closely related, yet they have distinct meanings in Composer, and are used extensively in Composer's user interface. For example, Composer's main menu includes both a Staff menu and a Part menu.

If you have worked with MIDI sequencing software, then you are probably familiar with the term track. The relationship between a staff in Composer and a MIDI track is explained at the end of this topic.
The following excerpt from the string section of Tchaikovsky's 1812 Overture illustrates the relationships between staves and parts. The remainder of this topic explains these terms.

System
A system is one line of music played together by possibly multiple instruments and voices. In the top half of the above example, there are two systems, that is, two lines of music. A system break is like a line break in a text documentation, where a sentence ends at the right side of the page and continues below on the page or at the beginning of the next page.

Staff
In strict music terminology, a staff is the set of five (or sometimes a different number of) staff lines that hold the notes for a particular instrument or voice in one system (line of music). Music software programs have traditionally departed from this strict definition of the term staff, and so does Composer. A staff is defined as all of the music (and all MIDI details) played by given instrument or voice across all of the systems and pages in the score.
Part

In Composer, the most common example of a "part" is the music played by one instrumentalist or vocalist (or multiple musicians performing the same part). The part is the sheet music that lies on the music stand in front of the musician.

Vocal parts and single-melody instruments usually have just one staff. Piano parts usually have two staves for the right and left hands.

The "conductor's score" is a special part that shows all of the staves in the score.

The currently selected part is displayed in the main menu. You can view a different part by selecting in the dropdown list of part names:

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>View</th>
<th>Measure</th>
<th>Staff</th>
<th>Part</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Conductor's Score</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1st Trumpet Bb</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2nd Trumpet Bb</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Horn in F</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Trombone</td>
<td></td>
</tr>
</tbody>
</table>

A part can be formatted and paginated independently of other parts extracted from the conductor's score. You can choose special formatting options for the display of a given part. You can also control the page breaks and system breaks (at particular measures) for that part. You can assign a name to that part and later recall it, so that only the staves assigned to that part are displayed, and the saved formatting options and pagination details are restored.

One of the powerful features of Composer, which you will not find in many other music notation programs, is that all "extracted" parts of a score remain perfectly synchronized with the full conductor's score. If you add a note for, say, the Violin 2 part in the conductor's score, it will also be added in the separately extracted, formatted and paginated Violin 2 part. Conversely, if you are viewing the Violin 2 part, and add a note to it, the next time you view the conductor's part, you will see that the note was added there also.

Potential Confusion between the Terms 'Staff' and 'Part'

This terminology is potentially confusing, because Composer's definition of staff is what some musicians might say is a "part". When a musician talks about a "part", is he referring to his lines (staves) of music in the conductor's score, or is he referring to the sheet music on his music stand that he plays from? Both concepts of the music are commonly called "part", but Composer needs to distinguish the two concepts.

If at first you are confused about the difference between the terms staff and part, you might find it helpful to think about piano music. A solo piano piece has just one part-- the piano part. But the solo piano piece has two staves-- the right- and left-hand staves.

Relationship between Staff and MIDI Track

In Composer, there is exactly one MIDI track for each staff. If an instrument has two staves, then it has two MIDI tracks. If you are familiar with MIDI and MIDI sequencers, you can think of "staff" as being a MIDI track for which the music notation is displayed.

Some other music software programs, called "MIDI sequencers", offer a "staff view", which is an automatic transcription of the notes in the MIDI track. In Composer, the notes displayed in the staff are similarly automatically transcribed. However, after the notes have been recorded and transcribed, in Composer you can further refine the notation (such as the interpretation of rhythms) while optionally leaving the underlying MIDI performance unchanged.
4.2 Editing Staves

A staff is a storage area within a song, that collects all of the notes and musical performance details (such as volume level and pan) that are associated with a particular instrument or vocal part. If you have not done so yet, it is highly recommended that you read the previous topic Understanding Tracks, Staves, and Parts.

This section is organized as follows:

- Adding New Staves
- Deleting Staves
- Editing Instrument (Staff) Names
- Changing the Instrument Sound of a Staff
- Assigning MIDI Channel
- Cloning a Staff
- Merging Staves
- Adjusting Per-Staff Volume Level and Pan
- Transposing a Staff
- Splitting Staves
  - Splitting a Staff into Right- and Left-Hand Staves
  - Splitting the Drum Staff into Individual Drum Staves
  - Splitting a Staff into Melody and Accompaniment
- Removing Double Played Notes from Solo Instrument
- Rearranging the Order of Staves
- Shifting Notes Between Staves

4.2.1 Adding New Staves

For most types of instruments, there should be one staff in the song for each instrument. For piano, keyboard, organ, and some other instruments, there should typically be two staves-- one for the right hand, and one for the left hand. If the song is written for a large ensemble, then one staff might produce the sound for a "section" of instruments, such as cellos in an orchestra.

A newly added staff is initially added only to the currently selected part. The next time you view any other part, Composer will ask you whether you would like to make the newly added staff visible that part.

There are three ways you can add new staves in Composer:

1. Add a new staff immediately below a currently selected staff, or at the end of the list of staves.
2. Add several staves and rearrange their order in the Staff Setup dialog box.
3. Add a pair of piano, keyboard, or organ right- and left-hand staves, for which a brace will be automatically added to the left.

**NOTE**: When you add a staff, Composer will automatically create a corresponding part, which you can later selected in the part dropdown list in the main menu. When you add a keyboard part, Composer will automatically add both the right- and left-hand staves to it.
To add a new staff immediately below a currently selected staff, or else at the end of the list of staves:

1. Select the staff below which you wish to add the new staff. Select this staff by clicking the Select Staff button among the staff controls. If no staff is selected, this procedure will result in adding the new staff at the end of the list of staves.

2. Choose the Add Staff command in the Staff menu.

   -- OR --

   Type “qas” for Quick Add Staff.

Composer will display a Staff Setup dialog box, such as the following:

This is the same Staff Setup dialog that is displayed when you click the Instrument Sound button among the staff controls.

If you selected a staff in step #1, then the Staff Setup dialog box will be preset with the staff name, device, channel, bank, and instrument sound of the staff that you selected. This allows you to quickly duplicate the properties of a staff when creating a second staff.

3. Fill out the Staff Setup dialog box according to how you want the instrument sound to be produced by Composer. For details, see Changing the Instrument Sound of a Staff.

4. Click the OK button to complete the adding of the new staff.

Composer will display the new staff in the score at the position you selected in step #1.

To add one or more new staves using the Multiple Staff Setup dialog:

1. Choose the Staff Setup command in the Staff menu.

   -- OR --

   Type “qsus” for Quick Set Up Staves.
Composer will display the Multiple Staff Setup dialog, such as illustrated below:

**NOTE:** The Staff Setup window lists all of the staves, regardless of whether they happen to be included in the current part you are working with, which is the conductor's score in the above example. The 'In Part' check mark indicates whether a staff is included in the current part, which is identified and which can be selected using the Display or Define Part button at the top of the Staff Setup window.

2. In the list of staves, click on the staff number above which you wish to add a new staff. (If you wish to add a staff at the top of the list, add it initially in the second position in the list, and then use the Move Up button to move it to the first position.)

3. Click the Add button.

Composer will add a new staff in the list, immediately below the currently selected staff.

4. You can rearrange the order of the new staff in the list by clicking the Move Down or Move Up button. The Move Down and Move Up buttons apply to the currently selected staff.
5. You can also change the staff name, instrument sound, and other properties of the staff as listed in the columns. Details about the staff properties in each of the columns are described in the following topics:

- **Staff and Abbr columns**: [Editing Instrument (Staff) Names](#)
- **Show column**: [Showing and Hiding Instrument Names](#)
- **Mute column**: [Muting Staves](#)
- **Volume column**: [Per-Staff Channel Volume Level](#)
- **Pan column**: [Left-to-Right Pan](#)
- **Device, Channel, Bank, and Instrument columns**: [Changing the Instrument Sound of a Staff](#)

6. If this is a drum staff, then set a check mark for Drum Instrument, and specify the Drum Instrument Properties, as described in [Changing the Instrument Sound of a Staff](#). See also [Editing Drum Notes](#).

7. Click the OK button to complete the adding of staves and editing of staff properties.

To add a pair of piano, keyboard or organ right- and left-hand staves:
1. Choose the Add Keyboard RH and LH Staves command in the Staff menu.
2. Follow the same instructions as above for adding a single-staff instrument.

Composer will create a pair of right- and left-hand keyboard staves, and will create a new part to which these two staves belong. The name that you give to this instrument will be displayed on the left side of the brace that is automatically created for the two staves.

### 4.2.2 Deleting Staves

In Composer you can either delete a staff or temporarily hide a staff. If you delete a staff, it is permanently removed from the song. If you save the song as a MIDI file or Notation file, the deleted staff will not be included in the file.

In contrast, if you "hide" a staff, it is only temporarily removed from the current part. If you save the song as a MIDI file or Notation file, the hidden staff will also be saved. If the MIDI file is later reopened, the hidden staff will displayed again.

To delete a staff:
1. Select a staff by clicking the Select Staff button.
2. Choose the Delete command in the Staff menu.
   - or -
   Type "qds" for Quick Delete Staff.

Composer will display the Delete Staff dialog box.
3. Select a staff in the Delete Staff dialog box. To select a set of adjacent staves, hold down the SHIFT key as you click a second staff name. To select non-adjacent staves, hold down the CTRL key as you click the staff names.
   - OR -
1. Choose the Staff Setup command from the Staff menu.
   - or -
   Type "qsus" for Quick Set Up Staves.
Composer will display the Staff Setup window with a list of staves.

2. In the left-most column of the staff list, click the number of the staff you wish to delete. This will highlight the row of information for that staff.

3. Click the Delete button on the right side of the Staff Setup window.

4. Click OK in the Staff Setup window to delete the staff.

To temporarily hide a staff:

1. Click "Staff/Setup"

2. In the dialog click in the staff's "Hide" box to temporarily hide the staff in that Part. This does not delete the staff, but only hides it temporarily. If the file is closed and then re-opened, the staff will again show in the displayed Part.

3. To show the staff again for that Part in the same session, simply uncheck the "Hide" box.

4.2.3 Editing Instrument (Staff) Names

Composer optionally displays instrument names in the left margin of the window or printed page. Each staff has a "long name" and an abbreviated name. Many MIDI files have staff names that are so long that too much of the printed page or viewing area of the screen would be wasted. Therefore, you might want to abbreviate the staff names. In addition, you can specify a long staff name for the beginning of the score, and an abbreviation for subsequent pages of the score. This is a common practice in orchestral scores.

Composer allows you to specify whether a long name or short name is displayed after the first page of a given part. Or, you can omit the display of staff names altogether. Look further down this topic for details.

If two or more staves are grouped together in the left margin with a brace or bracket, then you can assign an instrument name or instrument group name, as explained at the end of this topic.

To change a staff name:

1. Enter Window View by choosing the Window View command in the View menu.
   
   -- OR --
   
   Type "qwv" for Quick Window View.

2. Make sure that the staff controls are visible at the start of the staff, by choosing the Show Staff Controls option from the View menu. The staff controls look like this:

3. Click the instrument sound button for one of the staves.
Composer will display a Staff Setup dialog box such as the following:

4. Type in a new long name and an abbreviation.
5. Click OK to save the change(s).

Alternatively, if you need to change the names of several staves at once, you can use the multiple Staff Setup window.

To change several staff names at once:
1. Choose the Staff Setup command from the Staff menu.

Composer will display the Staff Setup dialog box, such as below:

2. Change the staff name and/or abbreviation in the first and second columns of the upper panel.
3. Click OK to complete any staff name change(s).

To specify whether the staff name and/or abbreviation (or neither) are to be displayed on pages and staff systems throughout the current part:
- Follow instructions in the topic Showing and Hiding Instrument Names.

To add an instrument name or instrument group name to the left of a brace or bracket for multiple staves:
1. Add the brace or bracket, and extend it vertically across all of the staves it belongs to.
2. If the brace or bracket is not already selected, then click it in Select Mode.
3. In the Bracket Palette, click the Bracket Group Name button. Composer will display the Bracket Staff Group Name dialog box.

4. In Bracket Staff Group Name dialog, enter the "long" name and the abbreviation for the instrument or instrument group. In determining whether to display the long or abbreviated name at the left of the bracket or brace, Composer applies the same rules as it does for determining whether the long or abbreviated name of individual staves are displayed, as described in Showing and Hiding Instrument Names.

4.2.4 Changing the Instrument Sound of a Staff

For each staff, you can specify what kind of instrument sound will be used by specifying the MIDI device, channel, bank, and instrument sound (MIDI program number). You can change the sound of a staff while the song is playing.

Typically, a staff uses a single instrument sound throughout the entire song. But you can also insert instrument sound changes (MIDI program changes) at any time locations throughout the staff. Also, some MIDI files that you import will have such mid-staff instrument changes. You can make these instrument sound changes temporarily visible in the score, and change or delete them, or insert additional sound changes. For details, see Inserting a Sound Change in the Middle of a Staff.

Use the MIDI Device Configuration Window to determine what devices, banks, and patches are available in your current configuration of MIDI devices.

NOTE: If this is your first time using Composer, and it does not produce sound from your sound card, then follow the procedure as described in Quick MIDI Device Setup.

There are two ways you can change the instrument sound of a staff. The first method is convenient for changing the sound for one staff. The second method is convenient for changing the sounds for several staves. The first method has the advantage that you can change instrument sounds while a song is playing.

To change the instrument sound for a single staff (even during playback):

1. Make sure that the staff controls are visible at the start of the staff, by choosing the Show Staff Controls option from the View menu, or by typing "qssc" for "Quick Show Staff Controls". The staff controls look like this:
Then click the Staff Selection button.  

- OR -

If you do not wish to display the staff controls, use the right mouse button to click any empty area in the staff’s staves.

Composer will display a pop-up menu such as illustrated here:

In the pop-up menu, choose the Instrument Sound command.

Composer will display the Staff Setup dialog, such as shown below. The most important setting that determines the sound of a staff is the “instrument sound”. Select the instrument sound from the list at the bottom of the window.

3. Choose a device from the list of choices. The available devices will be those MIDI output devices in the current MIDI device configuration.

4. Choose a MIDI channel, 1 to 16, or Auto Channel. Here are some important guidelines in choosing the right MIDI channel:
If the MIDI file plays well, and you only intend to change the patch for a staff, then you probably should not change the MIDI channel.

If the device is a General MIDI (GM) device, and the staff is intended to play General MIDI drum sounds, then assign channel 10.

If your song has more than 16 staves that must share the same MIDI output port, then assign all of the staves to Auto Channel. One exception is that the General MIDI drum staff must still be assigned to channel 10. For more information, see Assigning Auto Channel.

5. Choose a bank from the list of choices, which will depend on the type of device selected.

6. Choose an instrument sound from the Patch table. The list of available patches will depend on the type of device and specific bank selected.

TIP: To search for an instrument sound, click anywhere in the list of patch names. Then type the first letter of the instrument name, such as “V” for Viola. If another instrument is selected, such as “Violin”, then type “V” again for the next instrument name that begins with that letter.

7. If this staff is for one or more drum instruments, then following these steps:

(a) Set a check mark by Drum Instrument. The bottom of the Staff Setup dialog box will expand, offering extra choices for the drum instrument.
If the playback device is a General MIDI (GM) device, then channel 10 will be automatically assigned-- the standard channel for GM drum tracks.

The patch selection will remain unchanged. For GM devices, you can ignore the patch selection.

(b) For some devices, select from the Patch list a patch that specifies one of possibly several available "drum kits". For other devices, it does not matter which patch you select. For more information about this, see Managing Drum Note Lists.

(c) Choose one of the following three options for 5-line or 1-line drum staff:
   - 5-line staff with multiple drum pitches: Use this for a "drum kit" that assigns pitches to distinct drum sounds. For example, the General MIDI drum kit specifies the "Hi Bongo" drum sound for pitch 60 (middle-C), and "Tambourine" sound for pitch 54 (F# below middle-C). The pseudo drum pitches are indicated on a treble or bass clef staff, like normal pitches. A pseudo drum pitch might have an accidental. Note, this version of Composer does not offer an option with which you can reassign drum instruments to specific lines of the 5-line drum staff.
   - 1-line staff with multiple pseudo drum pitches: This option collapses a 5-line drum staff into a 1-line drum staff. The distinct drum sounds are still heard during playback. But the 1-line staff places the noteheads all on the same single staff line.
   - 1-line staff for this drum instrument: The 1-line drum staff plays a single drum instrument sound for a specific pseudo drum pitch in the drum kit.

(d) If you choose either of the two 1-line staff options, then choose the drum sound, that is, one of the drum notes that has been specified for this device. For information about how to configure drum notes for a device, see Managing Drum Note Lists.

(e) Optionally, choose a percussion notehead style for the drum staff.

8. Click the OK button to complete the assignment of the instrument sound to the selected staff.

To change the instrument sounds for several staves at a time:

1. Choose the Staff Setup command from the Staff menu.
   -- OR --
   Type "qsus" for Quick Set Up Staves.
Composer will display a Staff Setup window, such as the following:

2. Each row in the Staff Setup table offers the same choices as those described above for the single staff setup procedure: device, channel, bank, and patch. When you click one of the cells, Composer will display a list of choices for the device, channel, bank, or patch.

3. Click the OK button to complete the new sound assignments.

To assign all staves to the same device and MIDI bank:

1. Choose the Staff Setup command from the Staff menu. Composer will display a Staff Setup window, such as shown above.
2. Click the column header for Device. Composer will display the following dialog box:

![Assign Device to All Staves](image)

3. Select the device and MIDI bank to be assigned to all staves, and click the OK button.

   Note, non-General MIDI patches generally differ among alternative devices and MIDI banks. Therefore, after you assign the new device and bank, you will also probably need to reassign patches on a per-staff basis.

- To automatically reassign staves to a new default MIDI device when you reopen Notation .not files:
  - See Changing the Default Playback Device.

### 4.2.5 Assigning MIDI Channels

In the Staff Setup dialog, you can assign a staff either to a specific MIDI channel, 1 to 16, or to Auto Channel. When a staff is assigned to Auto Channel, Composer may assign different notes in the same staff to different MIDI channels during playback. Auto Channel is explained later in this topic.

- To change the MIDI channel for a single staff:

  1. If the staff controls are visible, click the Instrument Sound button. To display the staff controls, choose the Show Staff Controls command in the View menu, or type "qssc for Quick Show Staff Controls.

     -- OR --

     While holding down the 'S' key, click anywhere in a staff of the staff. Composer will display a pop-up menu. Choose the Instrument Sound command in the pop-up menu.

  2. Composer will display a Staff Setup dialog, such as the following:
3. In the Staff Setup dialog, select a channel number, 1 to 16, or select "Auto" for automatic channel assignment. Automatic channel assignment is explained below. For General MIDI devices, assign channel 10 to drum staves.

To change the MIDI channel for several staves at a time:

1. Choose the Staff Setup command from the Staff menu.

Composer will display a Staff Setup window, such as the following:

2. For each staff row, click the Channel cell. In the Channel cell, select a channel number, 1 to 16. For General MIDI devices, assign channel 10 to drum staves.

3. Click the Exit button to complete the new channel assignments.

To assign MIDI channels to all staves in one step:

1. Choose the Staff Setup command from the Staff menu.

Composer will display a Staff Setup window, such as illustrated above.

2. Click the Channel column header.

Composer will display the following dialog box:

3. If you click "Ok", then channel 1 will be assigned to the first staff, 2 to second, and so forth; but channel 10 will be skipped if the lower checkbox has a check mark. Using this method of assigning channels to staves all at once can be useful if you have a single MIDI playback device, but the original file used multiple devices and had the same channel numbers assigned to multiple staves.

4.2.6 Cloning a Staff

Sometimes you may want to clone (copy) an entire staff, such as to back up a staff before you experiment with some new musical ideas for that staff. Or, you may want to make a copy of a recording "take" before you record a second take. The procedure for cloning a staff is simple.

To create a new staff as a copy of another:

1. If the staff controls are visible, then click the Staff Selection button to select the first staff:
2. Choose the Clone Staff command from the Staff menu. Composer will display the Clone Staff dialog box.

3. In the Clone Staff dialog box, confirm the staff you selected in step #1.
   -- OR --
   Select a staff that you wish to copy.

4. If you are cloning the staff for backup purposes, then you will likely want to mute the newly cloned staff. See Muting and Soloing Staves for instructions.

4.2.7 Merging Staves

Sometimes you may find it useful to merge two or more staves. For example, some MIDI files for Baroque keyboard pieces assign a separate staff to each voice in a hand, rather than just a right- and left-hand staff. You will want to merge these staves into a single staff, and then use the Split Hands command to separate the now single staff into right- and left-hand staves.

If you intention is to produce a piano reduction of a score of multiple instruments or vocal parts, then you can use the Prepare Piano Reduction command in the Part menu. It basically combines the Merge Staves command and the Split Hands command into one easy step. For details, see Preparing a Piano Reduction of a Score.

When Composer merges staves, it merges both the underlying MIDI performance and the visible notation. The merging of the notation can become complicated. For example, if one staff has triplets, and another quintuplets, and another dotted rhythms, the merging of the rhythms could result in more than the maximum of two voices (upper and lower voices with stems pointing up and down) supported by Composer. In this case, Composer attempts to simplify the displayed rhythms; but it will not change the underlying MIDI performance-- the actual timing of the played notes.

To merge two or more staves:

1. If the staff controls are visible, then click the Staff Selection button to select the first staff. Then while holding down the SHIFT key, click the Staff Selection button for another staff. These two staves and all of the staves in between will be selected.

2. Choose the Merge Staves command from the Staff menu.
   -- OR --
   Type "qms" for Quick Merge Staves.
   Composer will display the Merge Staves dialog box.

3. In the Merge Staves dialog box, confirm the staves you selected in step #1.
   -- OR --
   Select the staves that you wish to merge.

4. Also, in the Merge Staves dialog box, you may wish to click the Transcription Options button. The transcription options will apply to the newly merged staff. The determine whether:
   - Standard versus jazz (swing) rhythm notation will be used.
   - Single voices or split (upper and lower) voices will be detected and notated.
   - Overlaps of notes will be removed to reduce the number of ties in the score.
Rests smaller than a specified size (quarter, eighth, or sixteenth) will be removed.
Grace notes, trills and tremolos will be detected and notated.
For details about these options, see Transcription Options.[94]

5. Click the OK button.
Composer will merge the selected staves.

4.2.8 Adjusting Per-Staff Volume Level and Left-to-Right Pan

You can independently adjust the volume level and left-to-right pan for each staff. Adjusting the left-to-right pan is similar to setting the balance between the left and right speakers on a stereo audio system.

The range of volume level is 0 to 127. This is the "MIDI channel volume", controlled by MIDI controller number 7.

The range of the left-to-right pan value is also 0 to 127. This is the "MIDI pan", controlled by MIDI controller number 10.

Composer lets you temporarily adjust the volume of one or more selected staves during playback. See Adjusting Volume of Selected Staves During Playback.[95]

You should be aware that some sound card drivers cleanly separate sounds into the left and right speakers when you assign the maximum left and right values, 0 and 127. Other sound card drivers bleed the sounds to some degree between the left and right speakers, even when the maximum left and right values (0 and 127) are used. Other sound card drivers do not support left-to-right pan at all.

The staff for an imported MIDI file may have varying per-staff volume and pan values throughout the song. Or, you may add varying per-staff volume level and pan values throughout the song using graph editing tools, as described in Per-Staff Channel Volume[96] and Left-to-Right Pan[97].

To determine whether a staff has a constant volume level or left-to-right pan, versus a varying volume or pan throughout the song:
1. Choose the Staff Setup command from the Staff menu. Composer will display a Staff Setup window, such as the following:

   ![Staff Setup window]

2. Observe the values in the Volume and Pan columns of the Staff Setup table for each staff. A number for the volume or pan indicates that the staff has a constant value for the volume or pan throughout the entire song. If the value is displayed as "Var" (for "varying") then the volume or pan changes at one or more places in the song.

To change the volume level or left-to-right pan for one or more staves:
1. Choose the Staff Setup command from the Staff menu, as above.
2. For each staff row, click the Volume or Pan cell. In the Volume or Pan cell, enter a value 0 to 127.

**NOTE:** If the value was "Var" and you enter a number, then the varying volume or pan level will be replaced with a constant level throughout the entire song. Once you have entered a number, you cannot restore the varying volume or pan levels in the song by typing "Var" back into the table cell. To restore the varying volume or pan level, hit the Cancel button to exit the dialog box without saving the changes.

3. Click the OK button to complete the new volume or pan assignments.

**To assign a volume level or left-to-right pan value to all staves in one step:**

1. Choose the Staff Setup command from the Staff menu.

   Composer will display a Staff Setup window, such as illustrated above.

2. Click the column header for Volume or Pan.

   Composer will display the following dialog box (or a similar one for Pan):

   ![Assign Volume Level to All Staves](image)

   3. Enter a value from 0 to 127.

4.2.9 Transposing a Staff

If you wish to transpose all of the notes in a staff, you should first ask yourself these questions: Do you wish to change actual as-heard pitches of all of the notes in the staff? Or, do you wish to transpose the staff according to the natural key or clef of the instrument? For example, do you wish to transpose the notes for a Bb clarinet up by two half-steps, or transpose the notes for a guitar up by an octave?

If you wish to transpose the actual as-heard pitches of all of the notes in the staff, then select all of the notes in the staff, and then raise or lower the pitches of all of the notes with one Change Pitch command. For details, see Editing Note Pitch.

If you wish to transpose the as-notated pitches according to the natural key or clef of the instrument, then use the Transpose Instrument Key command in the Staff menu.

Please see the details in the above two referenced topics for further details.

4.2.10 Splitting Staves

Composer offers the following commands in the Staff menu to split a staff into two or more staves, with certain ways of distributing the notes between the staves:

- If a piano or keyboard staff combines the notes for both the right and left hands, then use the Split Hands command to divide the notes into right- and left-hand staves.

- A MIDI file normally combines the notes for all drum instruments on one staff, and misrepresents the notes as pitches on a 5-line staff. You can use the Split Drums command to divide the percussion notes into separate one-line staves per each instrument.
If a staff combines a melody and accompaniment, use the **Split Melody and Accompaniment** command to separate them into two staves.

### 4.2.10.1 Splitting a Staff into Right- and Left-Hand Staves

In a MIDI file, the notes for a keyboard instrument are often kept in one staff, combining the notes of both the left and right hands. When Composer first transcribes the keyboard staff, it might display the notes for both hands in a single staff, such as the following:

![Example Staff](image)

At your request, Composer will split the notes into left- and right-hand staves. Composer makes intelligent guesses about the distribution of notes between the two hands, based on an analysis of hand positions, finger positions, and hand motions. If Composer makes an error in determining which hand a particular note is assigned to, you can easily reassign it to the other hand.

**Tip:** You can instruct Composer to automatically recognize tracks in imported MIDI files that probably need to have the Split Hands command applied. Use the Transcriptions Option command in the Setup menu, and set a check mark for the automatic recommendation named: "Keyboard staff probably should be split into RH and LH staves." For more information, see **Transcription Options**.

To split notes in a keyboard staff into left- and right-hand staves:

The remaining steps of this procedure will replace the original staff that you are splitting. If you want to preserve a copy of the original staff, then use the **Clone Staff** command in the Staff menu to make a copy of the staff.

1. If the staff controls are visible, then click the Staff Selection button to select a staff.
   - If the staff controls are not visible, you can make them visible by choosing the Show Staff Controls option from the View menu.

2. Choose the Split Hands command from the Staff menu.
   - **OR**
   - Type "qsplh" for Quick Split Hands.
     - Composer will present you with the Split Hands dialog box.

3. In the Split Hands dialog box, confirm the staff you selected in step #1, or select a staff.

4. Also, in the Split Hands dialog box, you might wish to click the Transcription Options button.
   - The transcription options will apply to the two newly created right- and left-hand staves, and determine whether:
     - Standard versus jazz (swing) rhythm notation will be used.
Single voices or split (upper and lower) voices will be detected and notated.

Overlaps of notes will be removed to reduce the number of ties in the score.

Rests smaller than a specified size (quarter, eighth, or sixteenth) will be removed.

Grace notes, trills and tremelos will be detected and notated.

For details about these options, see Transcription Options.

5. Click the OK button to confirm the Split Hands command.

Composer will replace the single selected staff with two staves, one for the left hand and one for the right hand. It will also add a brace along each pair on the left side of the right- and left-hand staves. For the above example, the result will look like this:

You might notice that the first measure distributes the notes between the left- and right-hand differently than as scored by Bach. Of course, Bach is right, and Composer is wrong. You can quickly correct such mistakes.

To correct the placement of one or more notes between the right- and left-hand staves:

1. Select one or more notes: Click a note with the mouse. Or click and drag the mouse cursor across multiple notes. Or click one note with the mouse, and to select additional separate notes, hold down the SHIFT key while clicking them.

2. While holding down the SHIFT key, hit the key to move the selected note(s) from the left-hand staff to the right-hand staff above, or the key to move the note(s) down to the next staff.

Here is what the same example looks like after the three notes in the left hand of the first measure are selected and then moved to the right-hand staff with SHIFT+:

4.2.10.2 Splitting the Drum Staff into Individual Drum Staves

In MIDI files, the notes for drum kit instruments are typically kept in a single staff. Even though most percussion instruments do not have pitches, the various instruments are assigned unique pseudo
pitches to distinguish the multiple percussion instruments that can be simultaneously playing in a staff. To learn about viewing and editing the drum note pitches for a MIDI device, see Managing Drum Note Lists.

When Composer first transcribes a percussion staff, it will display the drum notes as though they have pitches, as illustrated here:

![Drum Note Example](image)

**NOTE:** Most drum sounds do not have pitches. However, in MIDI files, different types of drum sounds are distinguished by pseudo pitches. Instead of displaying sharps and flats in front of the drum notes, Composer uses a upward \( \triangle \) triangle to indicate that the pseudo drum pitch is to be raised by a sharp, and a downward \( \nabla \) triangle to indicate that the pseudo drum pitch is to be lowered by a flat.

A drum player will not want to try to play from a part notated like the above. The drum player will prefer to play from a part in which the notes for each instrument are displayed on a separate staff line.

Composer offers an easy way for you to change a drum pitch staff such as the above to one or more single-line staves, one per each unique percussion instrument.

To split a drum note pitch staff into single-line staves, one per each drum instrument:

1. The remaining steps of this procedure will replace the original staff that you are splitting. If you want to preserve a copy of the original staff, then use the Clone Staff command in the Staff menu to make a copy of the staff.

2. If the staff controls are visible, then click the Staff Selection button to select a staff. If the staff controls are not visible, you can make them visible by choosing the Show Staff Controls option from the View menu.

3. Choose the Split Drums command from the Staff menu.
   
   -- OR --
   
   Type "qspld" for Quick Split Drums.

   Composer will present you with the Split Drums dialog box.

4. In the Split Drums dialog box, confirm the staff you selected in step #1, or select a staff.

5. Click the OK button to confirm the Split Drums command.

Composer will replace the original drum staff with one or more staves, one per each unique percussion instrument. For the above example, the result will look like this:

![Split Drums Example](image)
Composer will assign each percussion instrument the instrument name (such as "Side Stick") that is associated with the pseudo pitch of the drum sound. For more information, see Managing Drum Note Lists.

4.2.10.3 Splitting a Staff into Melody and Accompaniment

Sometimes it is useful to split the notes in a staff into two staves, one for melody notes and a second staff for accompaniment notes. For example, you might want to do this to prepare a melody vocal staff to which you will add lyrics.

To split a staff into two staves with melody notes and accompaniment notes:

1. The remaining steps of this procedure will replace the original staff that you are splitting. If you want to preserve a copy of the original staff, then use the Clone Staff command in the Staff menu to make a copy of the staff.

2. If the staff controls are visible, then click depress the Staff Selection button to select a staff. If the staff controls are not visible, you can make them visible by choosing the Show Staff Controls option from the View menu.

3. Choose the Split Melody and Accompaniment command from the Staff menu.

   -- OR --

   Type "qsplm" for Quick Split Melody.

Composer will present you with the Split Melody and Accompaniment Notes dialog box.

4. In the dialog box, confirm the staff you selected in step #1, or select a staff.

5. Click the OK button to confirm the Split Melody and Accompaniment Notes command.

Composer will replace the original staff with a pair of melody and accompaniment staves, as illustrated below:

4.2.11 Splitting Double-Played Notes from Solo Instrument

When Composer transcribes a track from a MIDI file, it makes many decisions about the timing of notes, including whether two notes are played together or not. For some instruments such as a piano, guitar, and violin, it is possible to play two notes simultaneously. For other instruments, such as an oboe or saxophone, it is not possible for two notes to be played at the same time.

Composer offers two way to clean up a staff for single-note instruments.
To split double-played notes in the staff for one or more solo instruments:
1. Choose the Convert to Solo Notes command in the Staff menu.
2. In the Convert Staff to Solo Notes dialog box, select one or more staves.

To instruct Composer to recognize solo instrument staves (tracks) in imported MIDI files and automatically split double-played notes:
1. Choose the Transcription Options command in the Setup menu.
2. Under the Automatic Recommendations section, set a check mark for "Two-note chords in a staff that has mostly solo notes should be sequenced as two separated notes."

When Composer detects a solo track, it will give you an opportunity to confirm that the double-notes in the staff should be split.

4.2.12 Rearranging the Order of Staves

If you create a new song from scratch, you can control the order of staves as you add new staves. If you have imported a MIDI file, Composer orders the staves in the score according to how they were ordered in the MIDI file. If you are not pleased with the order of the parts, you can change the order. If you have created multiple parts and then rearrange the order of staves, the new order of the staves will be applied to all parts, not just the part you are currently viewing.

To change the order of the staves:
1. Choose Staff Setup from the Staff menu.
   -- OR --
Type "qsus" for Quick Set Up Staves.
Composer will display the Staff Setup dialog box, filled out with a list of staves as illustrated below:

2. The order of the staves in the top panel determines the order of printing of parts in the conductor score. To move a part up or down in the conductor score, click the staff name, and then click the Move Up or Move Down button.
3. Click the OK button to commit the changes.
4.2.13 Shifting Notes Between Staves

Composer lets you move selected notes between adjacent staves. This option is particularly useful after you have used the Split Hands command to split a keyboard part into left- and right-hand staves. Although Composer does a good job splitting hands, it may not do it perfectly. Composer lets you correct any mistakes the Split Hands command might make in distributing notes between the left and right hands.

You can optionally change the voice (upper, lower, or single voice) of a note at the same time that you shift it to an adjacent staff.

To move one or more notes between adjacent staves, without changing the voice:

1. Enter Select Mode.
2. Select one or more notes by clicking or click-dragging the mouse.
3. Choose the Move Up One Staff or Move Down One Staff command in the Staff Assignment submenu Note menu to move the selected notes to an adjacent staff.
   -- OR --
   Type Shift+ (or Shift+) for Move Up One Staff (or Move Down One Staff).

To change the voice of one or more notes while moving them between adjacent staves:

1. Enter Select Mode.
2. Select one or more notes by clicking or click-dragging the mouse.
3. Choose the one of the following commands in the Staff Assignment submenu Note menu, or type its equivalent shortcut:

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move up one staff to lower voice</td>
<td>ul</td>
</tr>
<tr>
<td>Move up one staff to upper voice</td>
<td>uu</td>
</tr>
<tr>
<td>Move up one staff to single voice</td>
<td>us</td>
</tr>
<tr>
<td>Move down one staff to upper du voice</td>
<td>du</td>
</tr>
<tr>
<td>Move down one staff to lower dl voice</td>
<td>dl</td>
</tr>
<tr>
<td>Move down one staff to single ds voice</td>
<td>ds</td>
</tr>
</tbody>
</table>
4.3 Preparing Parts

In Composer, a part is a set of one or more staves throughout the song, that are view or printed together. In the simplest case, a part is for a solo voice or instrument for which the musician plays from only one staff at a time, such as an oboe or saxophone. Another case is a part for a keyboard instrument that has two staves for the right- and left-hands. In Composer, the conductor's score, which shows staves for all of the instruments and/or voices, is treated as a part.

A part can be formatted and paginated independently of each other, and independently of the formatting of the conductor's score.

A given staff can be displayed in more than one part. For example, usually a staff is shown in both the conductor's score and a separately formatted part for just that instrument.

All of the parts of a score are integrated so that if you, for example, add a note to a staff that appears in more than one part, the note is automatically added to all of the parts. If you add a note in the conductor's score, that note also shows up in the instrument part that the staff belongs to. Or, if you add a note in the instrument part, that note will automatically show up in the conductor's score.

If you have not done so yet, it is highly recommended that you read the topic Understanding Staves, Staves, and Parts.

This section on Preparing Parts is organized as follows:

- Automatically Creating Parts
- Adding a Part
- Selecting a Part
- Renaming a Part
- Changing Which Staves Are Displayed in a Part
- Deleting a Part
- Printing Parts
- Wizard for Preparing a Part
  -- Sing-Along Part
  -- Easy Notes Part
  -- Fake Lead Sheet Part
  -- Customized Part
- Preparing Parts for Piano, Voice, Drums and Guitar
  -- Preparing Piano or Keyboard Part
  -- Preparing Piano Reduction of a Score
  -- Preparing a Vocal Part
  -- Preparing a Drum Part
4.3.1 Automatically Creating Parts

Composer automatically creates parts under the following circumstances:

1. When you import a MIDI file, one part is created for each track, except for tracks with no notes. Said another way, one part is created for each staff in the score. Also, a conductor's part is created, which has all of the staves.

2. When you create a new song with the New Song Wizard, parts are automatically created. Actually, the parts have already been prepared for the song templates that are used by the New Song Wizard.

3. When you add a new staff, a corresponding new part is automatically created. If you use the Add Keyboard RH and LH Staves command in the Staff menu, then a single new part is created that has the pair of right- and left-hand staves.

4. The Prepare Part Wizard automatically creates the Sing-Along part, Easy Notes part, or Fake Book Lead Sheet part.

5. The Split Hand command automatically creates a new keyboard part with the pair of right- and left-hand staves.

6. The Split Drums command automatically creates a new drum part has all of the split one-line percussion staves.

7. The Prepare Piano Reduction command creates a single new keyboard part.

4.3.2 Creating a New Part

In Composer, a part displays the staves for one or more instruments or voices. A part can be formatted and paginated independently of other parts and the conductor's score. However, any changes to notes and annotations in a part are always reflected in the conductor's score, and vice versa.

Tip: Be sure to read the topic on Understanding Tracks, Staves and Parts.

Usually, Composer automatically creates parts for you as you import a MIDI file, create a new song, add staves, or prepare parts. However, there may be circumstances in which you will want to create additional parts with some combination of instrument staves that you select. For example, if you have an arrangement with a vocal choir section and instruments, you might want to prepare a separate choir section part for rehearsing the choir separately from the orchestra, and a separate orchestra section part for rehearsing the orchestra separately from the choir.

To add a new part:

1. Choose the Display or Define Part command in the Part menu.

2. In the list of Staves in Part, select and unselect staves according to which you wish to be included in the new part.

3. In the Part Name field, enter the name for the new part.
4. Click the Add Part button.

You can also start this procedure by first clicking the Add Part button. In that case, a new part will be created with the name "New Part". Replace that with the name you want, and then click the Change Part Name button.

5. Click the Display Part and Exit button to display the newly created part.

**NOTE:** When you add a part, Composer automatically applies the formatting and page text that is specified in the template file named "Extracted Part.not" in the C: \Users\Public\Documents\Notation_3\Templates directory. To control the automatic formatting and page text for extracted parts, you should directly edit this "Extracted Part.not" file, according to the procedure described in [Creating Your Own Song Templates](#).

### 4.3.3 Selecting a Part

In Composer, a part displays the staves for one or more instruments or voices. Usually, Composer automatically creates parts for you as you import a MIDI file, create a new song, add staves, or prepare parts. You can also create additional parts with some combination of instrument staves that you select.

**To view a part:**

- Select the name of the part from the list of parts in Composer’s main menu:
4.3.4 Renaming a Part

To rename a part:
1. Choose the Display and Define Parts command in the Part menu.
2. In the Display and Define Parts dialog box, select the part you wish to remain.
3. Enter the new name in the Part Name field.
4. Click the Change Part Name button.

4.3.5 Changing Which Staves Are Displayed in a Part

In Composer, a part displays the staves for one or more instruments or voices. You can create a new part for some combination of staves you want to view and print together. For example, if you have an arrangement with a vocal choir section and instruments, you might want to prepare a separate choir section part for rehearsing the choir separately from the orchestra, and a separate orchestra section part for rehearsing the orchestra separately from the choir.

You can temporarily or permanently change which staves are displayed in a part. A temporary change in the list of staves that are displayed in a part lasts only as long as you are viewing that part. If you select another part, and then return to the former, the original list of staves for that part will be restored. Or, if you exit Composer and return, the temporary changes in the list of staves for that part will similarly be discarded.

To permanently change the list of staves in a part:
1. Choose the Display or Define Part command in the Part menu.
   The Display and Defined Parts dialog will be opened, as illustrated in Creating a New Part.
2. Select the part you wish to edit.
3. In the list of Staves in Part, select and unselect staves you wish to show and hide in the part.
4. Click the Change Staves Assigned to Part button.

To temporarily change the list of staves in a part:
1. Choose Setup command in the Staff menu.
2. Toggle the check mark for Show for each of the staves you wish to temporarily show or hide in the part.

NOTE: The check mark for 'In Part' indicates whether the stave is normally (permanently) included in the part. You cannot directly change the check mark for 'In Part'. If you wish to change whether a staff is permanently included in the part, then follow the previous procedure.
4.3.6 Deleting a Part

In Composer, a part displays the staves for one or more instruments or voices. You may decide that you no longer need a part, even though you want to keep the staves that it displays.

- To delete a part without deleting the staves that it displays:
  1. Choose the Display or Define Part command in the Part menu.
  2. In the Display or Define Part window, select the part you wish to delete.
  3. Click the Delete Part button.

4.3.7 Printing Parts

Typically, a song has one part for each instrument and/or voice. To print each part, you can individually select each one and then use the Print command in the File menu. But there is an easier way.

- To print several parts at one time:
  1. Choose the Print Parts command in the File menu.

Composer will display the simple Print Parts dialog box. Initially, all parts of the song will be pre-selected.
2. In the Print Parts dialog box, unselect any parts that you do not wish to print, by clicking the highlighted part name. Selected parts are highlighted, and unselected parts are not, as illustrated here:

![Print Parts dialog box]

3. Hit the OK button.

Composer will display the Print dialog box.

4. In the Print dialog box, choose options the same way as you would if you were printing a single part.

Note that the Print dialog box will not offer you the option to print a range of pages. The Print Parts command supports printing only of the entire range of pages of each part. For the same range of measures, each part can require a different number of printed pages. To print the parts for only a selected range of measures, use the View Measures command in the Measure menu.

### 4.3.8 Wizard for Preparing Part

In Composer, a part displays the staves for one or more instruments or voices. A part can be formatted and paginated independently of other parts extracted from the conductor's score.

Composer's Part Preparation Wizard offers a quick and easy way to create three standard parts with certain formatting options. These parts are named: the Sing-Along Part, the Easy Notes Part, and the Fake Book Lead Sheet Part. The purpose of each of these three parts, and their formatting characteristics, are summarized in the following table:

<table>
<thead>
<tr>
<th>Purpose of a part.</th>
<th>Sing-Along Part</th>
<th>Easy Notes Part</th>
<th>Fake Book Lead Sheet Part</th>
<th>Chord Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Easy sight-reading of a Karaoke part (with notes) or vocal part from the screen from a distance of about 2</td>
<td>Easy sight-reading of an instrumental part, by beginner musicians.</td>
<td>&quot;Short-hand&quot; notation for the lead melody instrument of a small band, or for a keyboard instrument, where just the melody notes and chord names are displayed.</td>
<td>Mostly used by guitarists, to play chords while accompanying their own voice or while following the lyrics sung by another musician in the group.</td>
<td></td>
</tr>
</tbody>
</table>
The Part Preparation Wizard lets you override the default characteristics for any of these three types of parts. For example, you can include lyrics in an Easy Notes Part, or remove lyrics from a Fake Book Lead Sheet Part. The only exception is that easy notes are displayed only for the Easy Notes Part.

If you override a default setting for one of the part types, Composer will remember your override and use it as the default the next time you prepare a part of that type.

Composer defines a fourth part type named the "Customized Part". You can choose whatever options you want for this part. The next time you prepare another Customized Part, Composer will offer the previous options you chose as defaults.

To prepare one of the special parts, or a customized part:

1. Choose the Part Preparation Wizard command in the Part menu.
   Composer will display Step 1 of the 5-step Part Preparation Wizard.
   After each step, click the Next button.

2. Select Type of Part (Step 1 of 5):
   - Choose which of the four types of parts you wish to create.

3. Lyrics Options (Step 2 of 5):

<table>
<thead>
<tr>
<th></th>
<th>Sing-Along Part</th>
<th>Easy Notes Part</th>
<th>Fake Book Lead Sheet Part</th>
<th>Chord Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>yards or meters.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lyrics included in the part?</td>
<td>Yes.</td>
<td>Optional.</td>
<td>Yes.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Just the melody notes displayed, and not the accompaniment notes?</td>
<td>Yes.</td>
<td>Yes.</td>
<td>Yes.</td>
<td>No notes are displayed.</td>
</tr>
<tr>
<td>Chord names included in the part?</td>
<td>No.</td>
<td>Yes. The chord style named &quot;Easy Chords&quot; is used.</td>
<td>Yes. The chord style named &quot;Fake Book&quot; is used.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Lyrics displayed in a large font size?</td>
<td>Yes.</td>
<td>No.</td>
<td>No.</td>
<td>No.</td>
</tr>
<tr>
<td>&quot;Easy Note&quot; pitch letters displayed in the noteheads?</td>
<td>No.</td>
<td>Yes.</td>
<td>No.</td>
<td>No.</td>
</tr>
</tbody>
</table>
- Optionally check the box for "Include lyrics in the newly prepared part."
- If you have check marked lyrics, then select the staff that has the lyrics. Composer will pre-select the staff that has the most lyrics in it.

4. Melody Options (Step 3 of 5):
- Select the staff that you know has the melody notes. If you selected a lyrics staff in Step 2, then Composer will pre-select a staff that has notes most closely matching the timing of the lyrics. Composer's guess is not always correct. So, if you are certain about which staff has the melody notes, then select that staff.
- If the melody staff has both melody notes and accompaniment notes, Composer will remove the accompaniment notes by default. Two other options are also available. You can keep the melody staff as it is, by not removing any melody notes. Or, you can split the melody staff into two staves, one staff having just the single line of melody notes, and a second staff with accompaniment notes. This last option is equivalent to separately using the Split Melody and Accompaniment command in the Staff menu.
- This option is disabled for chord charts, which do not display melody notes.

5. Chord Names Options (Step 4 of 5):
- Specify whether you want chord names in the part or not.
- If you choose to include chord names, then specify how the chord names should be transcribed, and specify which staves should be used for analyzing the chord harmonies. These options are the same as for the Transcribe Chord Names command in the Format menu and Chord Name Menu. For details about the chord name transcription options, see Transcribing Chord Names.

6. Font Options (Step 5 of 5):
- Select the various font sizes for notes, lyrics, and chord names.
- Click the Finish button to complete the preparation of the part.

### 4.3.8.1 Sing-Along Part

You can quickly prepare a Sing-Along part, which is formatted for easy sight-reading of a Karaoke part (with notes) or vocal part off the screen from a distance of about 2 yards or meters. The Sing-Along Part includes the lyrics and melody notes, which are displayed in a large font size.

You can manually prepare a Sing-Along part in several steps, that include using: the Select Part command, the Split Melody and Accompaniment command; merging a lyrics staff with a melody staff; the Transcribe Chord Names command; and changing the font size of the notes and lyrics. But it is a lot easier to do this with the Prepare Sing-Along Part command in the Part menu.

To prepare a Sing-Along part:

1. Choose the Prepare Sing-Along Part command in the Part menu.
   This will take you to Step 1 of 5 of the Part Preparation Wizard. The part type will be pre-selected to Sing-Along Part.
2. Follow the instructions for the wizard Steps 2 through 5 in the Part Preparation Wizard.

### 4.3.8.2 Easy Notes Part

You can quickly prepare an Easy Notes part for easy sight-reading of an instrumental part by beginner musicians. The Easy Notes Part displays notes in a large font size, and displays pitch letters in the middle of the notes. The Easy Notes Part displays chord names that are analyzed from the song using the "Easy Chords" chord style. By default, lyrics are not displayed, but have the option to include lyrics in the Easy Notes Part.
You can manually prepare an Easy Notes part in several steps, that include using: the **Select Part** command; **Display Easy Notes** command; and **changing the font size of the notes**. But it is a lot easier to do this with the **Prepare Easy Notes Part command** in the Part menu.

- **To prepare an Easy Notes part:**
  1. Choose the **Prepare Easy-Notes Part command** in the Part menu.

     This will take you to Step 1 of 5 of the Part Preparation Wizard. The part type will be pre-selected to Easy Notes Part.

  2. Follow the instructions for the wizard Steps 2 through 5 in the **Part Preparation Wizard**.

### 4.3.8.3 Fake Book Lead Sheet Part

You can quickly prepare a Fake Book Lead Sheet part. A fake book lead sheet is "short-hand" notation for the lead melody instrument of a small band, or for a keyboard instrument, where just the melody notes and chord names are displayed. The actually performed, written-out notes may be different.

You can manually prepare a Fake Book Lead Sheet part in several steps, that include using: the **Select Part** command; the **Split Melody and Accompaniment** command; merging a lyrics staff with a melody staff; and the **Transcribe Chord Names** command. But it is a lot easier to do this with the **Prepare Fake Book Lead Sheet command** in the Part menu.

- **To prepare a Fake Book Lead Sheet:**
  1. Choose the **Prepare Fake Book Lead Sheet command** in the Part menu.

     This will take you to Step 1 of 5 of the Part Preparation Wizard. The part type will be pre-selected to Fake Book Lead Sheet Part.

  2. Follow the instructions for the wizard Steps 2 through 5 in the **Part Preparation Wizard**.

### 4.3.8.4 Chord Chart

Guitarists use chord charts to play chords as they sing lyrics, or accompany the singing of a vocalist in the group. You can quickly prepare a chord chart, such as the one illustrated here:
Composer arranges the chord names and lyrics according to standard conventions used among chord charts on the Internet, and in printed chord chart books. A chord name is vertically aligned with the corresponding lyric when the chord change and lyric occur at the same measure and beat in the song. Otherwise, the chord name is displayed before or after the lyric, depending on its relative timing.

To prepare a chord chart:

1. Choose the Prepare Chord Chart command in the Part menu.
   This will take you to Step 1 of 5 of the Part Preparation Wizard. The part type will be pre-selected to Chord Chart.
2. Follow the instructions for the wizard Steps 2 through 5 in the Part Preparation Wizard.

The chord chart is prepared using a fixed width font, so that the relative positions of chord names and lyrics are preserved when you use clipboard copy/paste to copy the chord chart to another text editor, and when you save the chord chart in a text file. You can edit the chord chart in its window, and change some simple formatting. However, please note that formatting changes are preserved only when you save the chord chart in the RTF (rich text format) file format, not in the text (.txt) file format.

To edit the prepared chord chart:

- Insert and delete characters as you would in a simple text editor, such as NotePad or WordPad.
- Drag the mouse over characters, and choose commands in the Edit menu, or equivalent toolbar buttons, or command shortcuts, to make the font bold, or a larger or smaller size.
- Use the Edit Undo or Redo command, the toolbar button for Undo, or Ctrl+Z, to undo or redo the most recent command. Note, this simple text editor supports only one level of undo.

To copy the chord chart to another text editor:

1. Choose the Select All command in the Edit menu.
2. Choose the Copy to Clipboard command in the Edit menu, or type Ctrl+C.
3. In your text editor, such as NotePad or WordPad, choose the Past command in its Edit menu, or type Ctrl+V.

Note:
If the other text editor supports only text, not "rich text", then the formatting (bold, and font size) will not be carried over in the copy/paste.

If the alignment of chord names and lyrics is disrupted when you paste the chord chart in the other text editor, then use an option in that text editor to change the font to a fixed-width style of font, such as Courier.

To save the chord chart in an RTF or text file:

1. Choose Save Chord Chart command in the File menu.
2. In the Save As dialog box, the default file type is RTF (rich text format), which is the file type necessary to preserve formatting (bold and font size). The file will be saved with an .rtf file extension. If you do not need to preserve formatting, you can choose the alternative, simpler text .txt file type.
To print the chord chart:
- Choose the Print Chord Chart command in the File menu.

4.3.8.5 Customized Part

Composer offers options to prepare three specially formatted parts: the Sing-Along Part, Easy Note Part, and Fake Book Lead Sheet Part. These three standard types of parts specify certain combinations of options for:
- whether lyrics should be included in the part and merged with notes in a melody staff
- whether accompaniment notes in the melody staff should be sorted out into a separate accompaniment staff, or removed altogether
- whether chord names should be transcribed and included
- the font sizes for notes, lyrics, and chord names

You can override any of these options when preparing one of the three standard types of parts with the Part Preparation Wizard. If you do so, then the next time you run the Part Preparation Wizard, it will offer the options you most recently selected as defaults for that type of part (e.g., Sing-Along).

You might want to create a special part, with combinations of the above options, without disrupting the default values for the three standard types of parts. In this case, you can choose a fourth type of part, called the "Customized Part" in the Part Preparation Wizard.

To prepare a customized part:
1. Choose the Part Preparation Wizard command in the Part menu.
2. In Step 1 of the Part Preparation Wizard, choose the Custom part type.
3. Follow the instructions for the wizard Steps 2 through 5 in the Part Preparation Wizard.

4.3.9 Preparing Parts for Piano, Voice, Drums, and Guitar

This section offers tips for preparing special instrument parts:
- piano or keyboard part
- piano reduction of a score
- vocal part
- drum part
- guitar part

4.3.9.1 Preparing a Keyboard Part

If you are preparing a part for the piano or keyboard, here are several tips that you should find useful.

To add a pair of right- and left-hand staves with one command:
- Use the Add Keyboard RH and LH Staves command in the Staff menu.

If you have imported a MIDI file, and the left-hand and right-hand notes for the keyboard part are combined in one difficult-to-read staff:
- Use the Split Hands command in the Staff menu to sort out the notes into right- and left-hand staves.
- If Composer does not do a perfect job of distributing the notes between the right- and left-hand staves, then select notes and type SHIFT+ or SHIFT+ to move the notes between the staves.
To instruct Composer to automatically recommend to you adjustments to keyboard tracks while importing a MIDI file:

- Use the Transcription Options command in the Setup menu. Set check marks for these automatic recommendations:
  - Keyboard staff probably should be split into RH and LH staves.
  - The order of a pair of keyboard staves probably should be switched from LH/RH to RH/LH.
  - The keyboard RH/LH staves should be ordered before other instrument staves.

If the notes in a right-hand or left-hand staff are too far above or below the staff (there are too many ledger lines):

- If the notes are too high in the bass clef, then insert a treble clef in front of the notes.
- If the notes are too low in the treble clef, then insert a bass clef in front of the notes.
- If the notes are too high in the treble clef, then insert an 8va octave notation across the span of high notes.
- If the notes are too low in the bass clef, then insert an 8va basso octave notation across the span of low notes.

To prepare a simple piano part with a single line of notes with “easy note” pitch letters displayed in the noteheads in a large font size, such as for a beginner pianist:

- Use the Prepare Easy Notes command in the Part menu.

If there are too many ties in the part because some notes overlap with different attacks or durations:

- Re-transcribe the right- and/or left-hand piano staff, with the Split (Upper and Lower) Voice option turned on. This will result in some notes with upward stems, and some with downward stems, so that the independent note attacks and durations are more clearly distinguished without the use of ties.
- Re-transcribe the right- and/or left-hand piano staff, with the Remove Overlaps of Notes option turned on.

To prepare a piano reduction of an instrument ensemble score (such as a string quartet or even orchestral score):

- Use the Prepare Piano Reduction command in the Part menu.

If Composer does not do a perfect job of distributing the notes between the right- and left-hand staves for the reduced score, then select notes and type SHIFT+ or SHIFT+ to move the notes between the staves.

To prepare a “third hand” staff, for passages in which the right or left hand is frequently jumping two octaves or more:

- Use the Add Staff command to add the third hand adjacent to the right- or left-hand piano staff.
- Move extreme notes from the right- or left-hand staff to the new third hand staff, by selecting them and typing SHIFT+ or SHIFT+. See Shifting Notes Between Staves.
- Apply the Hide Resting Staves command to this new third hand staff, so that it is displayed in the score only when there are notes in it.
4.3.9.2 Preparing a Piano Reduction of a Score

With Composer, you can quickly prepare a piano reduction of an instrument ensemble or choral score.

There are many uses for piano reductions of scores:

- For your own enjoyment, transcribe an instrumental or choral piece so that you can play it.
- If you lead an instrument or choral group and have piano skills, convey your musical ideas to your group by playing the score reduction on a piano or keyboard.
- If you compose, prepare the reduction as a "digest" of your score that a conductor can easily review.

To prepare a piano reduction of an instrumental or choral score:

- Use the Prepare Piano Reduction command in the Parts menu. Select the instrument and vocal parts you wish to merge into a piano reduction part.
- If this newly created piano reduction has too many notes, delete the extra, unnecessary notes.
- If you want to play a note in the right or left hand instead of the other, select it, and type **SHIFT+↑** or **SHIFT+↓**.

4.3.9.3 Preparing a Vocal Part

If you are preparing a part for voice, here are several tips that you should find useful.

To prepare a chord such that below, see instructions for **Chord Chart**:

```
To display a Karaoke or voice part on the screen in a large font size for easy reading from a distance:

- Use the **Prepare Sing-Along Part** command in the Part menu.

To add one or more verses of lyrics by typing them in, directly inside the Composer window:

- Follow the instructions in the beginning of **General Procedures for Editing Lyrics**.

To merge lyrics with notes, from an external text editor, or from the Window text clipboard:

- Follow the instructions for **Editing Lyrics Using an External Text Editor**.

To extract the lyrics from a Composer score, for pasting into an external document:

- Follow the instructions in **Copying and Pasting Lyrics**.
To place a pair of parentheses around a note, to show that it is sung in some verses, and not others:

- Add the left and right parentheses as two separate free text objects, as shown below.

![Diagram showing how to add parentheses around a note]

To instruct Composer to repeat a section during playback according to the number of verses:

- Follow the instructions for Repeat Instructions for Performances.

To display the first verse of lyrics under the vocal melody notes, but display remaining verses at the bottom of the page:

- Enter the first verse lyrics under the vocal melody notes, as described in the instructions in the beginning of General Procedures for Editing Lyrics.
- With the Page Layout tool, reserve enough room at the bottom of each page for the additional lyric verses.
- Add the additional verses as page text at the bottom of the page. You should add this as page text rather than as free text because free text is anchored to specific beats in measures, which might shift around as you refine the score.

To open, edit, and save Karaoke (.kar) files:

- To open a Karaoke file, use the Open command in the File menu, and select a file that has the Karaoke .kar filename extension.
- To view Karaoke formatting, such as line breaks for phrases of lyrics, choose the Show Karaoke Line Breaks command in the Lyric Menu.

-- OR --

In the Lyrics Palette (SHIFT+L), click the Show Karaoke Line Breaks button.

- To add or change Karaoke line breaks and paragraph breaks, add backward or forward slash characters ("/" or ") at the end of the lyric in each verse for the line or paragraph break. For details, see Working with Karaoke (.kar) Files.
- To save a Karaoke file, use the Export as MIDI or Karaoke File command in the File menu, and choose Karaoke (.kar) as the file type.

### 4.3.9.4 Preparing a Drum Part

If you are preparing a drum part, here are several tips that you should find useful.

**NOTE:** Most drum sounds do not have pitches. However, in MIDI files, different types of drum sounds are distinguished by pseudo pitches. Instead of displaying sharps and flats in front of the drum notes, Composer uses a upward ▲ triangle to indicate that the pseudo drum pitch is to be raised by a sharp, and a downward ▼ triangle to indicate that the pseudo drum pitch is to be lowered by a flat.
If a drum part shows different pitches and accidentals for different drum instruments, like this...

and you want to rearrange the drum part so that each drum instrument has its own separate staff line, like this:

- Follow the instructions for [Splitting Drum Staff Into Individual Drum Staves](#).

To merge multiple single-line drum parts back into a combined drum part:
- Apply the [Merge Staves](#) command to the multiple single-line drum staves.

To change the notehead shape for a single-line drum instrument to an X, +, ▲, ■, or ◆:
- Click the [Instrument Sound Selection](#) staff control.
  Composer will display the Staff Setup dialog box.
- In the bottom, left corner of the Staff Setup dialog box, turn off the check mark for Notehead Style / Use Default.
- In the selection box next to the Notehead Style / Use Default option, choose the notehead shape.

To change the notehead shape for individual notes:
- Follow the instructions in [Editing Notehead Shapes](#).

To change the volume levels and pan of drum instruments throughout the song:
- If your MIDI playback device is a General MIDI (GM) device, then it will require that all of the drum kit staves be assigned to channel 10. If you use the [Split Drum Staves](#) command, the resulting individual drum instrument staves will each be assigned to the same channel 10. You should choose just one of the individual drum instrument staves to serve as a master staff for graphically editing [volume levels](#) and [pan levels](#) throughout the song for the drum instruments. You will not be able to independently control the MIDI volume levels and pan levels for the individual drum instruments assigned to General MIDI channel 10. However, you can still [change the loudness of each individual note](#). This way, you can still edit independent volume levels for each drum instrument. However, you will not be able to set independent pan levels for each drum instrument.
- If your MIDI playback device is not General MIDI, and its drum kit allows you to use multiple MIDI channels, then assign the different drum instruments to different MIDI channels if you want independent volume and pan graphs for the different drum instruments.
To add specific drum symbols to the score, such as rim hits:

- Use the Add Symbol command and in the Select Symbol dialog box, choose "Drum Symbols" for the Symbol Category, and select among the drum symbols available in the Harmony font.

4.3.9.5 Preparing a Guitar Part

If you are preparing a guitar part, here are some tips that you should find useful.

To prepare a guitar chord such that below, see instructions for Chord Chart:

```
Home on the Range

Bb    C7    F
     Bb    Bbm
where the bui- fa- lo roam,
     F    G7    Gm7    C
and the deer and the an- te- lope play.
     F    Bb    Bbm
where sel- dom is heard a dis- cour- a- ging word.
     F    Gm    F
and the clouds are not clou- dy all day.
```

Note that Composer does not support display or editing of guitar fret diagrams, nor tablature notation.

If the guitar notes are displayed one octave too low, perhaps in the bass clef instead of treble clef:

- Follow the instructions in Transposing Key of an Instrument. Guitar notes are normally shown one octave higher than their actual pitch. In the Transpose Instrument Key step of the Transpose Wizard, set the transposition for the guitar staff to "Note read as 'C' actually sounds as 'C' below plus 1 octave".
- When you display the guitar part, make sure that there is no check mark by the Show Concert Pitches menu item in the Staff menu.
If after transposing the guitar part, some bass clefs are left in the part, and you want to change them to treble clefs, add a treble clef at the beginning of the measure for the guitar part, and delete any subsequent bass clef in the guitar part.

To display chord names above the melody notes:
- Determine which staves in the song have mostly notes that belong to the chord harmonies, as opposed to staves that have “passing notes” between chord notes, and other notes that do not belong to chord harmonies. Use the Transcribe Chord Names command, and select these staves as the ones that Composer will use to analyze and display the chord names.

To display rolled out chords as vertical chords rather than written-out arpeggios:
- Follow the instructions in Editing Arpeggios.

To notate harmonics such as the following:

```
Guitar
```

- Follow the instructions in Editing Notehead Shapes.

To add a pitch bend to a note, such as the following:

```
Pitch bend.
```

- Follow the instructions for graphical editing the pitch bend curve in Note Pitch Bend.

To add a vibrato to a note, such as the following:

```
Modulation wheel curve (for vibrato).
```

- Follow the instructions for graphical editing the Modulation Wheel Controller curve in MIDI Controller Data.

### 4.4 Formatting Parts

In Composer, a part displays the staves for one or more instruments or voices. A part can be formatted and paginated independently of other parts and independently of the conductor's score.

The conductor's score is itself also a part, which typically shows all of the instrument and/or vocal stave. You can format and print the conductor's score with a different paper size or orientation (landscape versus portrait) than the paper size and orientation that you intend for the individual instrument or vocal parts.
If you are pleased with the formatting of a part and would like to apply the same formatting to other parts, you can quickly do this with the Copy Formatting to Other Parts command in the Format menu. You can also save the formatting in a template file and later use the Format Part Using Template command to apply the saved formatting to a current part.

The topics that follow describe how you can individually format the following details of each part:

- **page setup**: paper size and orientation; margins; and page numbering (determine the starting page number, and assignment of even or odd numbers to the left pages)
- **page title, headers and footers**: text that is displayed on the first page, or at the top or bottom of each subsequent page of the part or score
- **overall font size**: the point size used for notes and text, except where overridden for types of text or particular text objects
- **horizontal and vertical spacing**: the amount of horizontal stretch or compression, and the minimum amount of vertical spacing between staves and between systems
- **font size for types of text**: each category of text, such as lyrics and chord names, can have its own unique font size
- **show or hide types of music annotations**: optionally hide lyrics, chord names, rehearsal marks, ornaments, or instrument sound change marks
- **show or hide instrument names**: show long instrument names, or abbreviations, on every system of each page, or just the first system of each page, or not at all
- **Hide Resting Staves**: optionally hide any staves in the part that have no notes and lyrics
- **"Easy Notes"**: display note letters (C, D, E, etc.) inside each notehead

### 4.4.1 Page Setup

Composer offers several familiar options for setting up the printed page, such as the paper size, orientation (portrait or landscape), and margins.

Composer saves the page setup settings in the Notation (.not) file, so that when you later reopen the file and prepare to print, you do not have to re-enter the page settings.

You can specify and save the page settings on a per-part basis. For example, you might want the conductor's part to be printed on tall legal size paper, and print the individual instrument parts on normal letter size paper. You only have to prepare the page setup once for the conductor part, and once for the instrument parts. As you are working on your music project and switch back and forth between printing the conductor's part and instrument parts, you will not have to manually switch the page setup each time. Composer will remember the page setup for each part.

When you create a new song, or import a MIDI file, Composer will apply the most recent page setup settings that you have entered as a default.

To choose page setup options:

1. Choose the Page Setup command in the Format menu.
   -- OR --
   Type "qpgs" for Quick Page Setup.
Composer will display the following Page Setup dialog box:

2. Choose the options as described below, and then click the OK button.

**Apply to which part arrangements?**

This option determines whether the page settings you entered will be applied only to the current part that you are viewing or, alternatively, to all parts of the song.

**Paper**

**Size**

Use this option to specify the size of the paper on which you intend to print the score. The paper sizes available are dependent, of course, on the type of printer you have.

**Source**

Some printers offer you the option to feed papers from different physical locations on the device. Use this option to specify, for example, "manual" versus automatic "feeder".

**Margins**

The example page shown in the top-left corner of the dialog provides a preview of the various margin settings.

**Units**

Specify here whether you prefer to enter the margin values in inches or millimeters.

**Top, Bottom, Left, Right**
These margins are applied to every page, except as overridden by the Gutter setting.

**Gutter**

If you intend to staple or tape pages of the score together as right and left pages, then it is a good idea to allocate some extra space at the right side of the left pages, and at the left side of the right pages. This extra space is called the "gutter".

**Page numbering**

**First page number**

This option is useful if you split up a large score into multiple Notation .not files. Suppose the first .not file holds the first 60 pages of the part. Then for the same part in the second .not file, you would specify 61 for the first page number. Each part in the second .not file might start with a different first page number. Since the Page Setup settings apply on a per-part basis, you can set different first page numbers for each of the parts in the second .not file.

**Odd-numbered pages on left**

This setting is relevant only if you assign a Gutter value. If your pages are to be arranged as right and left pages with a gutter, then set the check mark if the first page is to be arranged as a left page in the score.

**Orientation**

The Portrait orientation arranges the page upright. The Landscape orientation arranges the page on its side. The preview picture of the page at the top-left corner of the dialog box illustrates the orientation.

### 4.4.2 Adding Page Title, Headers and Footers

The overall procedure for adding a page title, header, or footer has two steps. First, reserve an area on the page for text. Then add the text.

1. **To reserve space for the page title, header and footer:**
   1. Choose the Page Setup command in the Format menu.
      -- OR --
   2. Type "qpgs" for Quick Page Setup.
      Composer will display the Page Setup dialog box.
   2. In the Page Setup dialog box, enter a value for the First Page Top margin, which will be a larger value than that for Other Pages Top.
To add a page title on the first page of the score:

1. Navigate to the Page Text Palette.

   -- OR --

   Type SHIFT+P. If the Page Layout Palette is displayed instead of the Page Text Palette, then type SHIFT+P a second time.

2. Follow instructions for adding Standard Page Text for the standard page text type "song title".

To add page headers and footers:

1. Follow step #1 in the above procedure.

2. Follow the instructions for adding Standard Page Text for the standard page text types: song title, part name, file name, and page number.

### 4.4.3 Overall Font Size

Composer enables you to change the overall font size for each score part. You can specify different font sizes for different parts. For example, if you are preparing a piano and flute duet, where the music teacher plays the piano part and a student plays the flute part, you might choose a normal font size for the piano part, but a larger, easier-to-read font size for the student's flute part.

It is important to understand that changing the font size is different than zooming in or out in the window. Zooming only temporarily changes the magnification of notes and other music symbols in the score, as viewed in the window. Zooming does not affect the size of notes and music symbols for the printed score. In contrast, when you decrease the font size, notes and music symbols not only look smaller on the screen but also look smaller when printed. When you choose a smaller font size, more measures can be printed on each page.

This help topic describes how you can change the overall font size that applies to notes, music symbols and text in one or more selected parts. Composer also enables you to set different font sizes and faces for specific categories of music symbols and text, such as for lyrics and chord names. See [Font Size for Types of Text](#).
You might find it more convenient to change the overall font size in Page Layout View, rather than follow the procedure below. In Page Layout View, you immediately see the effects of incrementally increasing or decreasing the font size as you click the Increase Font Size button or Decrease Font Size button. For details, see Changing the Font Size in Layout View.

To change the overall font size for one or more selected parts:

1. Choose the Font Size and Spacing command in the Format menu. Composer will display the following dialog box:

   - **Font Size**: The default font size is applied to all types of objects (music symbols, lyrics, chord names, etc.) except for those types of objects which sizes are overridden in Font Setup.
     - Default font size: 10 points
   - **Font Setup**: Click to display the Fonts dialog box, as described in Font Size for Types of Text.

2. Select one or more parts for which you wish to apply the new font size. Composer will pre-select the part that you are currently viewing.

3. Enter a value for the default font size.
   - The default font size is applied to any type of music or text object that is not otherwise specified.

4. To find out what types of objects (such as lyrics or chord names) might override the default font size, click the Font Setup button. Composer will then display the Fonts dialog box, as described in Font Size for Types of Text.

5. For an explanation of the remaining portion of the dialog box, see the next topic Horizontal and Vertical Spacing.
To set a default font size for any subsequently created song or imported MIDI file:

- After step #3 in the above procedure, click the Save As Default button.

### 4.4.4 Horizontal and Vertical Spacing

Composer enables you to change the overall horizontal and vertical spacing in each score part. You can apply the horizontal and vertical spacing values to one or more score parts in one step.

By default Composer applies spacing to the score part according to the following rules:

- Avoid overlapping music symbols and text, such as lyrics.
- Arrange the horizontal positions of notes within measures according to "engraving rules". The horizontal space occupied by a note or chord is not proportional to its duration in the measure. Rather, longer notes or chords are assigned relatively less horizontal space, and shorter notes or chords are assigned relatively more horizontal space. These "engraving rules" are designed to produce the most readable and pleasing layout of notes.
- Print as much music as possible on a page, subject to the above constraints.

You can instruct Composer to pack the notation more closely together to get more music on a page. In this case, Composer will compromise the normal music engraving rules, but it will always attempt to avoid overlapping of music symbols.

You can also instruct Composer to pack the notation less closely so that, for example, there is extra room on the printed page for you to add hand-written notes or text.

Note that you should not expect to be able to anticipate what change in the horizontal or vertical spacing value will be necessary to pack more or fewer measures on any given page. The purpose of the Font Size and Spacing command is to establish the overall spacing—compressed or expanded—for all pages of a part. For example, if there are 21 measures on a given page at 100% spacing, and you want to display 22 measures instead, it is difficult to predict whether 99% horizontal spacing will be necessary, or whether a smaller horizontal spacing percentage will be needed, such as 98% or 95% or 90%. You will need to try out different spacings, and see what happens. Also, changing the horizontal spacing percentage will affect the number of measures on each page differently, according to how much "slack" is currently distributed in any given page.

If you need to control exactly how many measures are on a specific page, then you will need to go to the Page Layout Palette and use some combination of these Page Layout commands: System Break, Page Break, Keep Measure With Previous, and Keep System With Previous.

To change the overall horizontal and vertical spacing for one or more selected parts:

1. Choose the Font Size and Spacing command in the Format menu. Composer will display the following dialog box:
2. Select the part(s) for which you wish to apply the new font size. Composer will pre-select the part that you are currently viewing.

3. In the middle portion of the dialog box, enter a horizontal spacing percentage, where 100% is Composer's default horizontal spacing. Smaller values will compress more measures per system (line) on the pages. Values larger than 100% will spread out fewer measures per system (line) on the page.

4. In the lower portion of the dialog box, you can enter different values for the Vertical Spacing between adjacent staves or adjacent systems if you would like more or less spacing between staves or systems.

5. For an explanation of the top portion of the dialog box, see the previous topic, Overall Font Size.

To set a default horizontal and vertical spacing for any subsequently created song or imported MIDI file:

- After step #3 in the above procedure, click the Save As Default button.

4.4.5 Font Type and Size for Types of Text

Composer defines several categories of music symbols and types of text, such as lyrics and chord names. You can specify a distinct font style, point size (with optional digit after decimal point, as in 8.5),
and styles (bold or italic) each type of text. You can also specify the point size for the music symbols (noteheads, clefs, etc.). For example, you can display lyrics using a bold Arial 9 point font, and instrument names (displayed along the left side of the staves) using a normal Times New Roman 8 point font.

Composer uses a default font for any type of text that is not specified elsewhere.

In addition to specifying font characteristics for various categories of text, you can also individually change the font size and styles (bold or italic) for individual text objects, such as a specific lyric, page text item, or chord name. See Editing Types of Text.

You can specify different font styles, sizes, and characteristics for different score parts. For example, suppose a voice teacher is preparing a piano and voice duet, where the teacher plays the piano part and a student sings the vocal part. The voice teacher’s part might include both the piano accompaniment and the student’s part, so that the teacher can follow the student’s part as she plays the piano accompaniment. The teacher’s part might have a normal font size and characteristics for the notes in the piano and vocal staves, as well as the lyrics in the student’s staves. The student’s part might have an overall larger font size, for easier reading, and also use a bold font characteristic for lyrics, for yet easier reading of the lyrics. This can be accomplished by applying different font styles to the two separate parts—the teacher’s part and the student’s part.

If you only need to change the overall font size for certain parts, and do not need to change individual font characteristics for specific categories of text, then follow the procedure in Overall Font Size.

To view the font settings for the current part:

1. Choose the Text Fonts command in the Format menu.

Composer will display the following Fonts dialog box:

2. Composer will pre-select the part that you are currently viewing, as indicated under “Apply to Selected Parts”.

   ![Fonts dialog box](image)
If you want to view the font attributes for another part, then Cancel this dialog box, use the Select Part command in the Part menu to select another part, and then use the Text Fonts command to reopen the dialog box for the newly selected part.

3. Click any entry in the Text or Symbol list to review the current font type, point size, and bold or italic style.

The Fonts dialog box will indicate the Font Type, Point Size, and Style (bold and italic) for the category of text or music symbol you have selected. If there is a check mark by "Use default font type", then the selected category of text or music symbol will assume the font type that you see in the Font Type box. Similarly, if there is a check mark by "Use default point size", then the selected category of text or music symbol will assume the font size that you see in the Point Size box.

4. If you only intend to view the font styles and not change any, then click the Cancel button.

To set the default font type and point size that are shared by any types of music symbols and text that are not specified elsewhere:

1. Choose the Text Fonts command in the Format menu.

Composer will display the Fonts dialog box, as illustrated above.

2. Under "Apply to Selected Parts", select one or more parts for which you wish to apply the new font size. Composer will pre-select the part that you are currently viewing.

3. Click "Default Font" at the top of the Text or Symbol Text list, as illustrated in the first of the two above pictures.

4. Select the desired Font Type and Point Size from the drop down lists.

Note that the default font type does not define the Bold and Italic style.

Note also that specifying the point size for the "Default Font" is equivalent to setting the overall font size using the Font Size and Spacing command in the Format menu.

5. If you change the Point Size for the Default Font, then Composer will display an extra option for "Scale Non-Default Font Sizes Proportionally":

Typically you will want to set a check mark for this option. As example, if the default point size were 10 and you change it to 12 (a 20% increase), and if the point size for lyrics were 9, then
this option would increase the lyrics font size by 20% of 9, or 1.8, to point size 10.8. Composer maintains font sizes with 1/10th point size accuracy.

6. Select each entry in the Text or Symbol Type list, and review the settings for Font and Point Size. If you wish the type of music symbol or text to derive its font type or point size from the default font, then set a check mark for "Use default font type" or "Use default point size".

7. Click OK.

To override the default font characteristics for a type of music symbol or text:

1. Choose the Text Fonts command in the Format menu.
   -- OR --
   Type "qtr" for Quick Text Font.
   Composer will display the Fonts dialog box.

2. Under "Apply to Selected Parts", select the part(s) for which you wish to apply the new font size. Composer will pre-select the part that you are currently viewing.

3. Click an entry in the Text or Symbol Text list.

4. Specify the Font Type, Point Size, Bold, and Italic fields, as illustrated in the second of the two pictures above.

5. If you wish to override the default font characteristics for other types of music symbols or text, then repeat steps 3 and 4.

6. Click OK.

To specify the font attributes that will be applied to any newly opened MIDI file, or any newly created song:

1. Using the Select Part command in the Part menu, select a part that has the font attributes that you wish to establish as the default.

2. Choose the Text Fonts command in the Format menu.
   Composer will display the Fonts dialog box.

3. Click the Save As Default button.

   Any MIDI file that you subsequently open, or any song that you newly create with the File New command, will use the font styles that you saved here.

4. If you have changed any font styles while the Fonts dialog box was opened, then click OK to save the changes. Otherwise you can click Cancel to exit the dialog box.

To apply the most recently saved default font styles to selected parts:

1. Choose the Text Fonts command in the Format menu.
   Composer will display the Fonts dialog box.

2. Under "Apply to Selected Parts", select the part(s) for which you wish to apply the most recently saved default font styles. Composer will pre-select the part that you are currently viewing.

3. Click the Restore Default button, and then the OK button.

### 4.4.6 Showing and Hiding Types of Music Annotations

You can specify whether Composer should display (or print) versus hide any of the following types of music annotations:

- lyrics
- chord names
- rehearsal marks
- instrument sound change symbols

Composer can show and hide different combinations of these types of music annotations for different parts. For example, you might want to show chord names only in a guitar part, but not in other parts.

To show or hide all occurrences of one of the above types of music annotations:

1. Choose the Show or Hide Types of Objects command in the Format menu.

Composer will display the following Hide Types of Objects dialog box:

   ![Hide Types of Objects dialog box]

2. Under "Apply to which part arrangements?", choose whether the options will be applied to all parts or only to the currently selected part.

3. Set a check mark by the type of annotation(s) that you want to hide in the selected part(s).

4. If the part does not show chord names, and if you open the Hide Types of Objects dialog box and find that there is no check mark next to "Hide chord names", you might wonder why chord names are not displayed. This probably happens because Composer has not yet analyzed your song for chord names. If you want to analyze the chord names now, then set a check mark by "Transcribe chord names". When you click the OK button, Composer will close the Hide Types of Objects dialog box, and then take you to a second Chord Name Transcription dialog box. Follow the instructions in Transcribing Chord Names for selecting options in the Chord Name Transcription dialog box.

If you have the Band-in-a-Box® Plugin

When you use the Band-in-a-Box® plugin the style names that you insert will show in your score.
To hide these Style Names for printing or working on your score:

1. Click the Band-in-a-Box® tab (if not already in it).
2. Click the "Sty" button
3. Click the "spectacles" button This will hide the Style names if they are showing, or show them if they have been hidden.

4.4.7 Showing and Hiding Instrument Names

Composer optionally displays instrument (staff) names in the left margin of the window or printed page. Each staff has a long name and an abbreviation. Many MIDI files have staff names that are so long that too much of the printed page or viewing area of the screen would be wasted. Therefore, you may want to make the staff names shorter. In addition, you can specify a somewhat longer staff name for the beginning of the score, and a shorter staff name for subsequent pages of the score. This is a common practice in orchestral scores.

Composer allows you to specify whether a long name or an abbreviation is displayed after the first page of a part. Or, you can omit the display of instrument names altogether.

You can specify how instrument names are displayed on a per-part basis. For example, in a conductor's score you might want to display the instrument name abbreviations; whereas in individually printed parts, you might want to display no instrument name at all, except as page text at the top of the first page of the instrument part.

To change the long name (or abbreviation) of an instrument name for a given staff:

- See the topic Editing Instrument (Staff) Names.

To show (or hide) instrument names in the current score part:

- Toggle the check mark for the Show or Hide Instrument Names command in the Format menu.
  
  -- OR --

  Type "qsin" for Quick Show Instrument Names.

To specify whether short or long instrument names are displayed or printed in the current score part, and whether they should be left- or right-justified or centered:

  
  -- OR --

  Type "qin" for Quick Instrument Names.
Composer will display the following Instrument Name Options dialog box:

2. Set the check mark for Hide Instrument Names according to whether you wish instrument names to be shown or not. Setting a check mark here has exactly the same effect as turning off the check mark for Show Instrument Names in the Part menu.

3. Choose options under "How Instrument Names are Displayed" to distinguish whether long or short (abbreviated) instrument names are displayed in Window View versus Page View and on the printed page. The following example, shows how the above settings are reflected in the first and second systems of a score:

Note that you can edit the long and short instrument names for each individual staff using the Staff Setup command in the Staff menu.
4. Choose the option for Instrument Name Text Alignment: left-, center, or right-justification.

5. Click OK to save the changes.

To specify the instrument name display options that should be applied to any newly opened MIDI file or any newly created song:

1. In the Format menu choose the Instrument Names Display Options command.

   -- OR --

   Type "qin" for Quick Instrument Names.

2. In the Instrument Name Options dialog box, select the options that you wish to apply to subsequently opened MIDI files or newly created songs.

3. Click the Save As Default button.

4. If you have changed any settings while the Instrument Names Display Options dialog box was opened, then click OK to apply the changes to the currently viewed score part. Otherwise you can click Cancel to exit the dialog box.

If you create a new song using a template, then Composer will use the instrument name display options saved with the template. If you want to apply to this song the instrument name display options that you most recently saved as a default, then after you create the song you will need to follow the next procedure. If you want to always use the same instrument name display options with the template, then open the template file, and edit its instrument name display options.

To apply the most recently saved Instrument Name Options the current score part:

1. In the Format menu choose the Instrument Names Display Options command.

   -- OR --

   Type "qin" for Quick Instrument Names.

2. In the Instrument Names Display Options display box, click the Restore Default button, and then the OK button.

4.4.8 Hiding Empty Staves

In a conductor's score, it is common practice to present staves only for those instruments that are playing. For example, if a system in the score displays measures 10 through 14, and the flutes are not playing in these measures, then the conductor's part omits the flute staff in this system.

Composer offers an option to Hide Resting Staves, according to this common practice for a conductor's part. If a staff has lyrics, but no notes, Composer will still display the staff. If no staves in a system have notes or lyrics, then Composer displays only the first staff.

Composer's option for hiding empty staves works on a per-part basis. Usually, you will want to use the Hide Resting Staves options for the conductor's part, but not other parts.

To Hide Resting Staves in the current part.

- In the Staff or Format menu choose the Hide Resting Staves command.

   -- OR --

   Type "qhrs" for Quick Hide Resting Staves.

To control which staves are hidden in the current part.

1. In the Staff or Format menu choose the Hide Resting Staves Options command.

   Composer will display the Hide Resting Staves dialog, filled out with a list of staves as illustrated below:
2. Turn on the first check mark for "Hide Resting Staves for staves selected below."

3. Select the staves for which you wish to Hide Resting Staves. You can individually select or unselect a staff by clicking its name in the list box. Empty staves will be hidden only for the staves you select.

4. Click OK to complete the operation.

In **Window View**, you have the option of showing or hiding staff controls, which include the Mute and Solo buttons. If you choose to show the staff controls, then you may want to set this check mark: "Do not Hide Resting Staves when staff controls (play, solo, etc.) are shown." If you do not set this check mark, on some pages the staff controls for some staves may be hidden along with the empty staves, so that you will then have no visible means of controlling (muting, etc.) the hidden staff.

To change the behavior of hidden empty staves in Window View:

1. Turn off the second check mark if you want empty staves to always be hidden in Window View, the same way that they will be hidden in the printed score (as shown in **Page View**). By default, the check mark is off.

2. If you do not want empty staves to be hidden in Window View when the staff controls are visible then turn on the second check mark.

   If the staff controls are not visible, then the first option determines the visibility of empty staves regardless of whether you set the second check mark in the Hide Resting Staves dialog or not. For instructions on showing or hiding the staff controls, see **Staff Control Buttons**.

### 4.4.9 Displaying Pitch Name (Easy Note) Letters in Noteheads

Beginning music students may find Composer's "easy note" notation a helpful way to associate pitch names with note positions in a staff. Composer gives you the flexibility to display these noteheads with or without a key signature, and with or without courtesy accidentals. This flexibility gives the aspiring musician just enough help at each stage of learning to encourage their musical growth.

There are two ways that you can prepare a part that displays the pitch names in the noteheads. The first method uses the Part Preparation Wizard, and creates an Easy Notes part that does not show a key signature, and shows all accidentals beside their notes. The second method can optionally show courtesy accidentals, and retains the key signature in either case.
To prepare an “Easy Notes” part:

In the Part menu, select Prepare Easy Notes part. The Wizard for Preparing Parts will then walk you through the steps for preparing a part containing a single staff with melody notes only, or a simple two-hand part with melody notes in one staff and accompaniment notes in a second staff. You can also select whether or not to include any lyrics that may be in the song file.

To display pitch names in the noteheads for selected staves in the current score:

You can use this method to show pitch names in the noteheads for a single or for multiple staves. You can use this option at any time after you’ve prepared a part using other options, in a multi-instrument score, or after selecting a Part from the Part drop list in the main toolbar.

1. In the Format menu, select "Display pitch names in noteheads..."

   OR

   use the keyboard shortcut "qdpn".

2. In the "Pitch Names in Noteheads" dialog, select whether or not you want to show courtesy accidentals (to help with correctly playing key signatures in the early stages of learning).

3. Select the staff or staves for which you want to show pitch names in the noteheads.

4. Click "Ok."

The screen shot below displays the pitch names in the noteheads for a single staff, but without the courtesy accidentals.

4.4.10 Formatting a Part Using a Template

Using commands in the Part menu, you can specify many details about how a part is formatted: the page setup, overall font size, horizontal and vertical spacing, font size for types of text, showing or hiding types of music annotations, showing or hiding instrument names, hiding empty staves, and displaying "easy notes."
You can save this formatting as a template that is offered by the New Song Wizard when you create a new song. You can also use apply your template to other songs using the Format Part Using Template command in the Format menu.

**TIP:** When you import a MIDI file, Composer uses the template file `C:\Users\Public\Documents\Notation_3\Templates\MidiFileDefault.not` to format the transcribed score. You can customize the default formatting of MIDI scores by editing that this `MidiFileDefault.not` file.

You might also want to modify some of Composer’s default templates to adopt the formatting you want. You can directly edit the formatting of Composer’s templates. You can also open one of Composer’s templates and copy the formatting from your own template.

**To save the formatting of a currently viewed part as a template:**

1. Use the Save As command in the File menu, and save the current song with a new name in the `C:\Users\Public\Documents\Notation_3\Templates` directory. Save the file with a `.not` filename extension, just like a normal Notation song file. This step assures that you will not alter your original file as you make a template file.

2. Any notes, lyrics, free text, and most of the content of the template file should be removed, since it will be ignored when the template is applied to a new song, or when it is used to format another song. It is not necessary for you to remove this extra content, but the template will open more quickly each time you use it, if you do the following:
   - Delete all of the measures except the first few measures.
   - Remove all of the notes, lyrics, and free text in these remaining measures.
   - Delete all parts except the one that has the formatting you wish to use as a template. You can do this by selecting each part, one at a time, using the Select Part command in the Part menu, and deleting the unwanted parts with the Delete Part command.

3. Use the Save command in the File menu to resave the template `.not` file that you prepared above. Now you can use this version of the file as a format template.

**To apply the formatting of a template to a currently viewed part:**

1. Choose the Format Part Using Template command in the Format menu. Composer will display a File Open dialog box, and will initially display the files in the `C:\Users\Public\Documents\Notation_3\Templates` directory.

2. Choose a template `.not` file in the template directly, and click the OK button. Composer will apply the formatting of the most recently opened part in the template to the part that you are currently viewing.

**To apply the formatting of a template to multiple parts in a song:**

1. Follow the above procedure to apply the formatting of a template to one part.

2. Follow the directions in the next topic, **Copying the Format of a Part to Other Parts**, to format all of the remaining parts in the current song.

**To customize the formatting of one of Composer’s default templates:**

1. Open the template file, such as `Voice and Piano.not`, in the `C:\Users\Public\Documents\Notation_3\Templates` directory.

**To quickly customize the formatting of Composer’s default templates:**

1. Prepare your own template `.not` file as described above.
2. Open each of Composer's template files in the C:\Users\Public\Documents\Notation_3\Templates directory, using the Format Part Using Template command to copy the formatting of your template to Composer's default templates.

For example, if you use Composer's "Voice and Piano" template when you create new songs, then apply this procedure to the file C:\Users\Public\Documents\Notation_3\Templates\Voice and Piano.not.

4.4.11 Copying the Format of a Part to Other Parts

Using commands in the Part menu, you can specify many details about how a part is formatted: the page setup, overall font size, horizontal and vertical spacing, font size for types of text, showing or hiding of types of music annotations, showing or hiding of instrument names, hiding empty staves, and displaying "easy notes".

Some of the Part menu commands let you apply formatting characteristics not only to the currently viewed part, but also to other parts that you specify in a dialog box. Some other Part menu commands let you apply formatting characteristics only to the currently viewed part.

If you have prepared a part with formatting characteristics that you would like to apply to other parts, there is an easy way to do that.

- To copy the format of one part to other parts:
  1. Select the part you want to copy, using the Select Part command in the Part menu.
  2. Choose the Copy Formatting to Other Parts command in the Format menu.
    Composer will display the Copy Formatting to Other Parts dialog box.
  3. In the dialog box, select the parts to which you wish to copy the formatting, and click OK.

4.5 Laying out Pages of a Part

Composer offers you convenient options for controlling how a part or score is separated into pages, and how each page is separated into systems (lines of measures). On each page, you can control the spacing between staves and between systems. You can also stretch or compress the horizontal spacing of individual measures within systems. All of these options are available in Page Layout View.

- To enter Page Layout View:
  1. If the palettes are not already shown, turn on the check marks for Show Main Palette and Show Detail Palette in the View menu.
  2. Click the Layout tab in the main palette.
  3. Click the Page Layout View button.

- OR -

- Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.

Composer will display the Page Layout palette:
The various options in the Page Layout palette are summarized here:

Composer will also display the score in Page Layout View, as shown below. The score will turn gray, and red "handles" (boxes for dragging staves and barlines) might be displayed.

To move systems, staves, and barlines using the Page Layout handles:

1. Click the Move Barlines and Staves button in the Page Layout Palette.
2. Follow the instructions in Changing Vertical Spacing Between Systems and Staves and Moving Barlines Within a System.

To specify a fixed number of bars per line:

- Click the Fix Number of Bars Per Line button in the Page Layout Palette, and then respond to the Fix Number of Bars Per Line dialog box.

To insert a system break or page break:

- Click the System Break button or Page Break button in the Page Layout Palette. Then click anywhere in the measure where you want the new system or page to begin. For further instructions, see Forcing a Page Break or System Break.

To move a measure at the beginning of one system to the end of the previous system:

- Click the Keep Measure With Previous button in the Page Layout. Then click the measure you want to move to the previous system. For further instructions, see Moving a Measure to the Previous System.
To move a system at the top of one page to the bottom of the previous page:

- Click the Keep System With Previous button in the Page Layout Palette. Then click anywhere in the system that you want to move to the previous page. For further instructions, see Moving a System to the Previous Page.

To restore a page, or all pages of a score part, to the default pagination:

- Click the Default Pagination button in the Page Layout Palette. For further instructions, see Restoring Default Pagination.

To increase or decrease the overall font size:

- Click the Increase Font Size button or the Decrease Font Size button. For further instructions, see Changing Font Size in Layout View.

To compress or expand the overall horizontal spacing of notes and measures:

- Click the or button to increase or decrease the horizontal spacing in large increments, or the or button to increase or decrease the spacing in small increments. For further instructions, see Changing Horizontal Spacing in Layout View.

To freeze all of the line breaks and system breaks in a part or conductor's score:

- Click the Freeze All Page and Line Breaks button. For further instructions, see Freezing Line Breaks and System Breaks for Entire Score.

To increase or decrease the default vertical spacing between staves and systems:

- In the Part menu, choose the Font Size and Spacing command. Use the Vertical Spacing option in the Font Size and Spacing dialog box.

### 4.5.1 Tip: Postpone Doing Page Layout

It is a good idea to postpone work on page layout until you have completed all other tasks:

- compose or arrange the notes of the song
- add lyrics
- add annotations such as accent marks, dynamic marks, and phrase marks

After your are done writing and editing the music, then:

- set up the page size, orientation, and margins for the various parts
- set the overall font size and perhaps also font sizes for different types of text
- set the horizontal spacing (percentage compression or expansion)
- add the page title and headers or footers

After you have completed all of the above tasks, and are fairly certain that you will not change the work, only then should you then work on the page layout: adding page and system breaks, rearranging measures of systems, changing the vertical spacing of staves and systems, etc. If you start working prematurely on the page layout, you may have to discard some of your page layout effort. For example, if you add some introduction measures at the beginning of the music, then this might disrupt the pagination of the entire score.

Nevertheless, Composer's page layout mechanism can be forgiving about how changes you make to the music might impact pagination. Try using the Keep Measure With Previous and Keep System With Previous options, instead of "hard" system and page breaks.
4.5.2 Changing Font Size in Layout View

Before you work on the details of laying out pages of a score part, you should choose the font size and overall horizontal spacing (compressed or expanded). This topic describes how to choose the font size for the score part. The next topic describes Changing Horizontal Spacing in Layout View.

By default, all music symbols and text share the same font size and style (such as Times New Roman). In Page Layout View, you can change the font size for all music symbols and text by simply clicking the Increase Font Size button or Decrease Font Size button.

You can specify different font sizes for different types of text. For example, the font size for notes and music symbols might be 9 points, but the font size for lyrics might be a larger 10 or 12 points. To assign different font sizes to different categories of text or symbols in Composer, follow the instructions in Font Size for Types of Text.

The procedure below describes how to change the default font size. The default font size applies to any category of text or music symbol when you have not specified an overriding value via the Text Fonts command in the Format menu.

Note that the procedure for changing the default font size, using Page Layout commands, has exactly the same effect as using the font size option in the Font Size and Spacing Command in the Format menu. The font size option is provided redundantly in Page Layout View so that you can adjust the font size and other aspects of page layout all in one place in Composer.

To change the default font size:

1. Navigate the Page Layout palette.
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.

   Composer will display the score in Page Layout View.

2. In the Page Layout Palette, click Increase Font Size button or Decrease Font Size button.
   -- OR --
   Type F+ or F+ to increase or decrease the font size.
   -- OR --
   Choose the Increase Font Size or Decrease Font Size command in the Layout Menu.

4.5.3 Changing Horizontal Spacing in Layout View

Before you work on the details of laying out pages of a score part, you should choose the font size and overall horizontal spacing (percentage compression or expansion). This topic describes how to change the horizontal spacing. The previous topic describes how to change the font size.

By default, all music symbols and text share the same font size and style (such as Times New Roman). In Page Layout View, you can change the font size for all music symbols and text by simply clicking the Increase Font Size button or Decrease Font Size button.

You can specify different font sizes for different types of text. For example, the font size for notes and music symbols might be 9 points, but the font size for lyrics might be a larger 10 or 12 points. To assign different font sizes to different categories of text or symbols in Composer, follow the instructions in Font Size for Types of Text.
The procedure below describes how to change the default font size. The default font size applies to any category of text or music symbol which you have not specified using the Text Fonts command in the Format menu.

Note that the procedure for changing the horizontal spacing, using Page Layout commands, has exactly the same effect on horizontal spacing as using the horizontal spacing option with the Font Size and Spacing Command in the Format menu. The horizontal spacing option is provided redundantly in Page Layout View so that you can adjust the horizontal spacing and other aspects of page layout all in one place in Composer.

To change the horizontal space:

1. **Navigate to the Page Layout palette**.
   - OR — Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette. Composer will display the score in Page Layout View.

2. In the Page Layout Palette:
   - To increase the horizontal spacing in large increments, click the button, or type H + .
   - To decrease the horizontal spacing in large increments, click the button, or type H + .
   - To increase the horizontal spacing in small increments, click the button, or type H + .
   - To decrease the horizontal spacing in small increments, click the button, or type H + .

To find out what the current horizontal stretch percentage is:

- Hold the mouse over any of the four horizontal spacing buttons. Composer will report the horizontal stretch percentage in the button tip, as illustrated here:

Note that you should not expect to be able to anticipate what change in the horizontal or vertical spacing value will be necessary to place more or fewer measures on any given page. For example, if there are 21 measures on a page at 100% spacing and you want to display 22 measures instead, it is difficult to predict whether 99% horizontal spacing will be necessary, or whether a smaller horizontal spacing percentage will be needed, such as 98% or 95% or 90%. You will need to try out different spacings, and see what happens. Also, changing the horizontal spacing percentage will affect the number of measures on each page differently, according to how much "slack" is currently distributed in any given page.

If you need to control exactly how many measures are on a given page, then you will need to use some combination of these Page Layout commands: System Break, Page Break, Keep Measure With Previous, and Keep System With Previous.
4.5.4 Specifying the Number of Bars Per Line

By default, Composer determines how many bars are displayed in each line of the score. The number of bars per line can vary among the different lines of the score. Composer offers you control over how many bars are in any given line so that, for example, you can arrange for convenience page breaks in an instrument part.

In some types of music, such as Broadway musicals and jazz, it is common practice that each line of the score has a fixed number of bars, typically four. With a single command, you can specify or change the number of bars per line at any time, for the entire score (or part) or any range of measures in the score.

If you try out Composer’s command for specifying a fixed number of bars per line, you will quickly gain insight into how you can also move the measure at the beginning of one line to the each of the previous line. Composer’s Number of Bars Per Line command is actually a short-cut for adding Keep Measure With Previous locks on all of the measures of each line.

To specify a fixed number of bars per line for some range of measures in a score or page:

1. Navigate to the Page Layout palette.
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.
   Composer will display the score in Page Layout View.

2. In the Page Layout Palette, click the button.
   -- OR --
   Type "bpl" for bars per line.
   Composer will display the Number of Bars Per Line dialog box.

3. In the Number of Bars Per Line dialog box, specify the number of bars per line, and the range of measures.

4.5.5 Forcing a Page Break or System Break

A page break forces a new page to start at a specified measure. A system break forces a new system (line of measures) to start at a specified measure.

To add a system break:

1. Navigate to the Page Layout palette.
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.
   Composer will display the score in Page Layout View.

2. Click the System Break button in the Page Layout Palette.
-- OR --
Choose the System Break command in the Layout Menu.
-- OR --
Type "sb" for System Break.

3. Click anywhere in the measure that you want to push to the beginning of a new system.

To remove a previously added system break:

1. Enter Page Layout view, as above.

2. Enter Select Mode by clicking the Select Mode button in the main toolbar, or by hitting the ENTER key, or by right-clicking the mouse anywhere on the page.

3. Click the mouse cursor somewhere on the "system break" text in Page Layout View.
The "system break" text will be displayed in the color blue, as shown:

4. Hit the DEL key.
   -- OR --

   Click the Default button.

To add a page break:

- Follow the same procedure as the one above for adding a system break, except:

   Click the Page Break button instead of the System Break button.
   -- OR --

   Choose the Page Break command in the Layout Menu.
   -- OR --

   Type "pb" for Page Break.

The page break will look like this at the top of the new page:

### 4.5.6 Moving a Measure to the Previous System

In **Page Layout View**, the System Break option enables you to move one or more measures from one system to the next system. This results in fewer measures on the original system.

Sometimes you want to do the opposite. That is, you may want to place more measures on a system, thus packing them together more tightly. You can do this with the Keep Measure with Previous command.

When you apply the Keep Measure with Previous command to a measure, Composer will keep that measure on the same system as the previous measure. If the previous measure is on the previous system, then it will shift to the next to last position on that system, and the last measure on that system will be the "keep with previous" measure.

If you keep two adjacent measures with the previous, then all three measures will be forced onto the same system, along with any other measures that would have been on the same system before the
first of these three measures. In this way, it is possible to force the assignment of more measures to a
system than can be spaced without overlapping of notes and symbols. Composer will obey your
request to do so.

If a measure has been designated to be kept with the previous measure, and that previous measure is
already on the same system, then the measures are left together on the same system without change.

To move the first measure of a system to the last measure position on the previous system:

1. Navigate to the Page Layout palette.
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second
time to go to the Page Layout Palette.
   Composer will display the score in Page Layout View.

2. Click the Keep Measure With Previous button in the Page Layout Palette.
   -- OR --
   Choose the Keep Measure With Previous command in the Layout Menu.
   -- OR --
   Type "km" for Keep Measure With Previous.

3. Click the mouse cursor anywhere in the measure that you want to move to the previous
   system.
To remove the "keep measure with previous" control:

1. Enter Page Layout view, as above.

2. Enter Select Mode by clicking the Select Mode button in the main toolbar, or by hitting the ENTER key, or by right-clicking the mouse anywhere on the page.

3. Click the "keep measure with previous" lock symbol.
   The lock symbol will become highlighted in blue to show that it is selected.

4. Hit the DEL key.
   -- OR --
   Click the Default button.
4.5.7 Moving a System to the Previous Page

In **Page Layout View**, the Page Break option enables you to move a system from the bottom of one page to the top of the next.

Sometimes you may want to do the opposite. That is, you may want to move a system at the top of one page to the bottom of the previous page. You can do this with the Keep System with Previous command.

When you apply the Keep System with Previous command to a system, Composer will keep that system on the same page as the previous system. If the previous system is on the previous page, then it will shift to the next to last position on that page, and the last system on that page will be the “keep with previous” system.

If you keep two adjacent systems with the previous, then all three systems will be forced onto the same page, along with any other systems that would have been on the same page before the first of these three system. In this way, it is possible to force the assignment of more systems to a page than can be spaced without overlapping of systems and staves. Composer will obey your request to do so.

If a system has been designated to be kept with the previous system, and that previous system is already on the same page, then the systems are left together on the same page without change.

To move the top system of a page to the bottom of the previous page:

This procedure is quite analogous to the procedure for Moving a Measure to the Previous System. See that topic for more details.

1. **Navigate to the Page Layout palette.**

   -- OR --

   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.

   Composer will display the score in Page Layout View.

2. Click the Keep System With Previous button in the Page Layout Palette.

   -- OR --

   Choose the Keep System With Previous command in the Layout menu.

   -- OR --

   Type "ks" for Keep System With Previous.

3. Click anywhere in the page’s first system, which you want to move to the bottom of the previous page.

To remove the “keep system with previous” control:

1. Enter Page Layout view, as above.

2. Enter Select Mode by clicking the Select Mode button in the main toolbar, or by hitting the ENTER key, or by right-clicking the mouse anywhere on the page.

3. Click the “keep system with previous” lock symbol.

   The lock symbol will become highlighted in blue to show that it is selected.

4. Hit the DEL key.

   -- OR --

   Click the Default button.
4.5.8 Moving Barlines Within a System

In general, Composer does a good job of horizontally spacing measures, and systems with measures, to evenly distribute space according to standard music engraving practices. There may be reasons, however, that you will want to override Composer’s default horizontal spacing.

You can move a barline within a system to add more horizontal spacing to the measure on one side, and less horizontal spacing on the other side. For example, if one measure is too horizontally crowded, compared to other measures on the same system, you can move its left barline to the left, or its right barline to the right. This may, in turn, crowd the adjacent measure. So you may need to move the opposite barline of the adjacent measure to evenly space the system.

To move a barline:

This procedure is quite analogous to the procedure for Moving a Measure to the Previous System. See that topic for more details.

1. Navigate to the Page Layout palette. See that topic for more details.

2. Click the Move Barlines and Staves button in the Page Layout Palette.

3. Click the red box handle on the barline you want to move. Keep the left mouse button down. The color of the handle and the barline will be highlighted as blue, to show that you have selected the barline.

4. While holding down the left mouse button, drag the barline to the left or right with the mouse. Then release the mouse button.
The barline’s handle will be filled solid red to indicate that the barline has been moved from its default position:

To restore a barline to its default horizontal position:

1. Enter Page Layout view, as above.

2. Enter Select Mode by clicking the Select Mode button in the main toolbar, or by hitting the ENTER key, by right-clicking the mouse anywhere on the page.

3. Select the barline’s solid handle by clicking it.

   The barline and the handle will be highlighted in blue to indicate the selection:

4. Hit the DEL key.
   -- OR --

   Click the Default button.

   This restores the barline to its default position.

4.5.9 Changing Vertical Spacing Between Staves and Systems

In general, Composer does a good job of vertically spacing staves within systems, and systems on a page, to evenly distribute space according to standard music engraving practices. There may be reasons, however, that you will want to override Composer’s default vertical spacing of staves and systems.

Composer offers the following ways to change the relative spacing of staves and systems on a page:

- Move a single staff up or down, relative to the position of the adjacent staves in the same system.
Move an entire system up or down, relative to the position of adjacent systems on the same page.

Stretch or compress the height of a system, so that staves within that system are evenly spread out or compressed together.

To change the vertical spacing between staves and systems:

1. Navigate to the Page Layout palette.[264]
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.
   Composer will display the score in Page Layout View.

2. Click the Move Barlines and Staves button in the Page Layout Palette.
   -- OR --
   If you are not already in Select Mode, click the button in the main toolbar.
   -- OR --
   hit the ENTER key.
   -- OR --
   Right-click the mouse anywhere on the page.

3. Click one of the system or staff handles, and while holding down the left mouse button, drag the handle of the system's or staff's vertical position, or the height of the system.
After you have moved a system or staff, or stretched a system, the handle will be filled with a solid color, as illustrated here:

To restore a staff’s or system’s vertical position, or a system’s vertical stretch, to the default:

1. Enter Page Layout view, as above.

2. Enter Select Mode by clicking the Select Mode button in the main toolbar, or by hitting the ENTER key, or by right-clicking the mouse anywhere on the page.

3. Select the staff’s or system’s handle by clicking it.

   The staff or system, and its handle, will be highlighted in blue:

4. Hit the DEL key.

   -- OR --
Click the Default button.
This restores the staff or system to its default vertical position, or the system to its default vertical stretch.

4.5.10 Freezing Line Breaks and Page Breaks for Entire Part

After you have prepared the page layout of a part or conductor's score, there are some good reasons why you might want to "freeze" the line (system) breaks and page breaks:

- If you send your Notation .not file to someone else who has Notation Composer, or another Notation product, or the free Notation Player but a different printer than yours, then you can ensure that the parts and conductor's score will look very similar when printed by a different printer using the same paper size.

- As you continue to make small changes to your score, there is the possibility that some changes may disrupt the line breaks and page breaks that you wish to preserve.

IT’S GOOD THAT... Any page layout changes you have made before you froze the part or score will be restored after you unfreeze it. That is, the freeze is just temporary. Also, you can make further page layout adjustments after you freeze the part or score, such as moving staves and systems and barlines. If you later unfreeze the part or score, any page layout changes you made after the freeze will also be preserved.

To freeze the line breaks and page breaks for an entire part or score:

1. Navigate to the Page Layout palette.

   -- OR --

   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.

   Composer will display the score in Page Layout View.

2. Click the Freeze Page Break and System Breaks button in the Page Layout palette.

   You will see that Composer adds a Keep Measure With Previous lock on every measure except the first in each line (system); and it adds a Keep System With Previous lock on every system (line) except the first one on each page:
Really, that's all that Composer does when it freezes pages. You could do the same thing by adding the locks to every measure; but, of course, that would be a lot of work.

This method of freezing the layout of pages offers an excellent balance by freezing the pages just enough to ensure that the overall pagination of the part or score doesn't change, and yet offering plenty of "breathing room" for you to add and edit music symbols and text within the pages, without causing the symbols to overlap. Even when a page is frozen, when you add, edit, and delete music symbols and text, Composer will continue to dynamically format the page so that symbols are evenly and aesthetically spread out on the page without collision or overlapping.

To unfreeze the line breaks and page breaks:

- Toggle of the Freeze Page Break and System Breaks button in the Page Layout palette.

4.5.11 Restoring Default Pagination

The previous topics describe how you can refine the layout of a page in many ways:

- force a page break or system break
- move a measure at the beginning of one system to the end of the previous system
- move a system from the top of one page to the bottom of the previous page
- move a barline in a system to horizontally stretch the spacing of the measure on one side of the barline, and compress the spacing of the measure on the other side of the barline
- move a system up or down on the page relative to other systems
- move a staff up or down in a system relative to other staves in the system
- stretch or compress the total height of a system, evenly moving the staves in the system further apart or closer together

You can individually remove any of the adjustments, as explained in the topics for each of the above tasks, and summarized here.
In addition, you can restore the default page layout for an entire page in one step, or for an entire score part in one step, as described in the second procedure of this topic.

To remove specific page layout adjustments:

1. Navigate to the Page Layout Palette.
   -- OR --
   Type SHIFT+P. If this takes you to the Page Text Palette instead, type SHIFT+P a second time to go to the Page Layout Palette.
   Composer will display the score in Page Layout View.

2. Click the Move Barlines and Staves button in the Page Layout Palette.
   -- OR --
   If you are not already in Select Mode, click the button in the main toolbar.
   -- OR --
   hit the ENTER key.
   -- OR --
   Right-click the mouse anywhere on the page.

3. Select one or more of the following Page Layout objects by clicking on or dragging the mouse cursor over them. After you select the first object, Composer will subsequently select only additional objects of the same type.
4. Hit the DEL key.

-- OR --

Click the Default button.

This removes the Page Layout object, thus removing its adjustment to the page layout.

To remove the page layout adjustments for an entire page, or for all pages of the score:

1. Make sure that no Page Layout objects are selected. You can do this by clicking anywhere on the page except where a Page Layout object is located.

2. Click the Default button.
Composer will display the following dialog box:

![Set Page Layout to Default dialog box]

3. Choose one of the two options to remove the page layout adjustments for either the currently viewed page or for the entire score part.
5 Editing the Music Notation

The previous major sections of this Composer documentation describe how to edit the largest units of music data: the song, staves, and parts. This section, Editing the Music Notation, describes how to edit the symbol symbols that are displayed in a score or part.

If you have imported a MIDI into Composer, you can then quickly correct any transcription errors it might have made in determining note rhythms and accidentals. You can rearrange the music by adding and deleting notes, or changing note pitches. You can also add lyrics and a wide variety of annotations, such as accent marks, dynamic marks, slurs, ornaments, and free text.

Composer is an ideal tool for composing new music. You can enter notes with the mouse, or from your music keyboard via real-time or step-time recording.

If your style of learning is to read about it first, then it is suggested that you read the introductory section on Basic Editing Procedures. It offers an overview of how to add and edit music symbols, and alerts you to the ways that Composer might differ from other software applications with which you are familiar.

The remaining sub-sections describe how you can add and edit all of the music symbols supported by Composer:

- Editing Measures
- Adding Notes
- Selecting, Editing, and Deleting Notes
- Transposing Notes
- Editing Rests
- Editing Grace Notes
- Editing Ornaments
- Editing Staff Symbols: brackets and braces, clefs, key signatures, meters, barlines, repetition marks, 8va octaves, and rehearsal marks
- Editing Music Annotations: accents and articulations, dynamic marks, hairpin crescendo marks, special symbols, slurs, and sustain pedal marks

Separate major sections of this Composer documentation describe how to edit text and how to edit the underlying MIDI performance of the music.

5.1 Basic Editing Procedures

As you explore how to edit various types of music symbols and text, you might find it helpful to gain an understanding of the overall procedures for editing music symbols. Most of these procedures are consistent with other Windows applications, but Composer does have a few relatively unique user interface methods.

A central concept in Composer’s user interface is that of the "object". Examples of objects are noteheads, accent marks, dynamic marks, clefs, key signatures, lyrics, and free text. This documentation usually refers to objects as "music symbols", to describe them in musical terms rather than technical software terms. If you are a student of software user interfaces, Composer’s user interface is "object-oriented". This simply means that an object, or musical symbol, is something that you can individually select on the screen by clicking it with the mouse.
You select a music symbol by clicking it with the mouse. You also add a music symbol by clicking the mouse on the screen where you want to add it. How does Composer know whether you are selecting a music symbol already on the screen, or adding a new one? You tell it so by clicking either the Select Mode or Add Mode button in the main toolbar. In Select Mode, after you select a music symbol by clicking it, you can then change details about that symbol, or you can delete it. See General Method for Adding, Changing, and Deleting Objects.

As in other software applications with "object-oriented" user interfaces, you can select multiple objects by dragging the mouse over them, select additional objects by clicking them with the mouse while holding down the SHIFT key, and so on.

A major component in Composer's window is the palette. A palette offers you a choice of music symbols that you can add or edit. Composer's palettes are organized in a three-level hierarchy that offers you a good overview of where you are located within the overall Composer user interface. No palette is more than a couple of mouse clicks away. However, we recommend that you learn the shortcuts for the most common palettes. All palette shortcuts are Shift and some letter, such as SHIFT+N for the Note Palette and SHIFT+A for the Accent Mark Palette.

You have probably had experience using palettes in other software applications; but you should be aware that palettes in Composer take on a broader role than palettes do in some other software applications. Like other applications, you can use palettes to add objects. Unlike many other applications, however, you can also use palettes to change the properties of objects. For example, if you have selected a quarter note, you can click the eighth note button in the Note Duration Palette to change the quarter note to an eighth note.

As in most Windows applications, you can, of course, use menu commands to add and edit objects. In general, however, menus do not offer the most convenient way to add and edit objects. You will find it easier to use either the palettes or keyboard shortcuts. You will nevertheless find menus useful for looking up keyboard shortcuts.

In addition to being able to select multiple objects by dragging the mouse over them, you can also select a region of the score by holding down the CTRL key while you drag the mouse cursor over the region. The selected region then has a blue background, as shown here:

You select regions this way to prepare for clipboard operations, such as Copy, Cut and Paste. For example, you can copy several measures from one part of the score to another, including notes, dynamic marks, slurs, and so on.

You can experiment with musical ideas and editing operations with the confidence that you can undo recent changes in reverse order, to restore your previous work. Also, Composer periodically (by default, every 10 minutes) completely backs up a copy of your work to a file, from which you can restore your work in the event of a system failure.

All of the basic editing procedures introduced above are described in detail in the topics that follow.

5.1.1 General Method for Adding, Changing, and Deleting Objects

In general, there are three things you can do with any type of musical object or symbol, such as a note or dynamic mark. You can add, change, or delete it.
The general procedures for accomplishing each of these three tasks in Composer are outlined below.

Note that some editing operations, such as copy and paste, are based not on selected objects but on selected regions of the score such as a range of measures in one or more staves. For details, see Selecting and Editing Regions of a Score.

To add an object:

1. Enter Add Mode by one of the following methods:
   - Click the Add Mode button.
   - OR -- Hit the ENTER key.
   - OR -- Right-click the mouse anywhere in the score, except on a lyric or text object.

   The mouse cursor will change to this shape:  

2. Choose the type of object you want to add from a palette. Use the mouse to navigate through the palettes, or type the SHIFT key plus the letter for the palette, such as SHIFT+D for the Dynamic Mark Palette.

3. Move the cursor to where you want to add the object and click the mouse.

   This procedure for adding objects is described in more detail in the topic Adding Objects Using Palettes.

To change an object:

1. Enter Select Mode by one of the following methods:
   - Click the Select Mode button.
   - OR -- Hit the ENTER key.
   - OR -- Right-click the mouse anywhere in the score, except on a lyric or text object.

   The mouse cursor will change to this shape:  

2. Click on the object you want to change.

   The palette and the Object Menu will be updated to offer you editing options specific to the type of object you have selected. A selected object is highlighted in blue.

3. Choose options in the palette or Object Menu to change the properties of the selected object.

   The procedure for changing objects is described in more detail in the topic Changing Object Properties Using Palettes.

To delete an object:

1. Enter Select Mode as described above.

   -- OR --
Hit the ENTER key to switch from Add Mode or Step-Time Record Mode.

2. Click the object you want to change. The selected object will be highlighted in blue.

3. Hit the Del key.

5.1.2 Adding Objects Using Palettes

The following general procedure for adding objects via palettes can be used for most types of objects.

To add notes and symbols:

1. If Select Mode is currently active, switch to Add Mode by pressing the button, or by pressing the ENTER key, or right-clicking the mouse.

   For most types of objects, the mouse cursor will change to this shape: .

   As you add notes in Add Mode, the cursor will change to a red note such as . The red note indicates the note value (duration) that you have selected from the Note Palette. When you click the mouse, a note of that duration will be added to the score.

   As you add rests in Add Mode, the cursor will change to a red rest such as: .

2. Make sure that the palettes are visible.
   - Turn on the check mark for Show Main Palette and Show Detail Palette in the View menu.
   - OR --
   - Type "qspl" for Quick Show Palette.

3. Navigate through the palettes to the one that offers options for the type of musical object you wish to add.

   For general instructions about navigating through palettes, see the introduction for Palettes.

   To learn about what palettes are available, explore through the palettes with the mouse.
   - OR --

   While holding down the SHIFT key, type the letter for the type of palette you wish to display, such as SHIFT+N for the Note Palette.

4. In the palette, select the attributes of the particular type of object you wish to add. For example, if you wish to add a bass clef, click the bass clef button in the palette.

   In some palettes you can choose multiple options at the same time. For example, in the accent palette, you can choose any two accents to be displayed above or below a note at the same time:

5. Click the mouse where you want you the selected type of object.

   The type of object you just added will remain selected.
6. To delete the object you just added:

- Hit the Delete key.

  OR

- Use the Undo command in the Edit menu, or type CTRL+Z.

To add lyrics or other types of text:

1. Follow the above steps 1 through 3, for selecting the type of text you wish to add.

2. Click the mouse where you want to add the text.

If you have added a new text object (lyric, free text, rehearsal mark, etc.), Composer will display a text entry box and a blinking cursor at the location of the new lyric or chord name, such as illustrated below:

3. Type in the text. For lyrics or page text, use the ENTER key to start a second line of text.

4. Complete the entry of the text by hitting the ESC key, or by clicking the mouse somewhere else to start another new text object of the same type.

5. If you are adding lyrics or chord names, you do not have to click the mouse again to add the next lyric or chord name. Instead, hit the TAB key. Or in the case of lyrics, you can also press the SPACE key, to advance to the next note.

For more details, see Adding Text.

### 5.1.3 Selecting One or More Objects Before Editing Them

An object must be selected before it can be edited or deleted. You can simultaneously select and edit multiple objects of the same type.

**To select an object:**

1. If the current mode is Add Mode, then enter Select Mode by clicking the select button, by pressing the ENTER key, or by right-clicking the mouse anywhere in the score.

2. Place the mouse over the object, and click the left mouse button.

**To select multiple objects of the same type:**

1. Click on an object, hold down the left mouse button and drag the mouse over the score. Composer will select objects of the same type during the drag. For example, if you start the mouse drag at a note, then only more notes will be selected, not other types of objects such as lyrics.

2. To select an additional object of the same type, hold down the SHIFT key and click the object.

3. To add several more objects to the list of already selected objects, hold down the SHIFT key and drag the mouse over the additional objects.

4. To remove some objects from the list of selected objects, hold down the SHIFT key and click them individually, or drag the mouse over them.
5.1.4 Changing Object Properties Using Palettes

The following procedure applies to most types of objects.

To edit one or more selected objects (of the same type) using the palette:

1. Follow one of the two procedures described in the previous top for selecting one or more objects.

Select two notes of different durations.

The Note Palette palette shows buttons "half on" for the different note duration values. The color for "half on" will depend on your Color Theme.

Both the quarter note and eighth note buttons are "half on", to indicate that notes of different durations have been selected.

2. Click buttons in the palette to change the attributes of the currently selected object(s).

Continuing with the above select, click the sixteenth note button, both notes will change to sixteenth notes:

Such changes will affect both the notation and the sound of the notes. If you wish to change just the notation and not the performance, you will need to first go to the Piano Roll palette and select the "Edit as notated" button before making your editing changes to just the notation.
5.1.5 Selecting and Editing Regions of a Score

Editing a score usually involves adding, selecting, modifying, and deleting objects, such as notes and lyrics. However, some methods of editing a score, such as Edit Copy and Paste, are based on selecting a region of the score. A region may cover a range of measures and beats, and a range of one or more adjacent staves.

Composer displays a light blue background for the currently selected region, as illustrated below:

![Score with selected region]

**NOTE:** The background color for the region will be light red instead of blue if you are working with performance (MIDI) graphs.

To select a region of the score:

Method 1
1. In the main toolbar, click the Region Select Mode button.

-- OR --

Double right-click the mouse anywhere in the score.

2. While holding down the mouse button, drag the mouse from the start to the end of the region you wish to select.

Method 2
1. Hold down the CTRL key.
2. While holding down the CTRL key, point the mouse at the beginning of the region, and press down on the mouse button.
3. While holding down both the CTRL key and the mouse button, drag the mouse to the intended end of the region.
4. Release the mouse button and the CTRL key.

Method 3
1. Choose the Select Region command in the Region menu. It will present the following dialog box, in which you can enter the range of measures and beats for the selection, and the range of staves:
To select the entire score (all of the measures in all of the staves):

- Choose the Select All command in the Edit menu.
- OR
- Type CTRL+A.

To remove the region selection:

- Hit the ESC key.

To extend the region selection:

1. If you wish to extend the region to another page of the score, use the Page Down key to go to that page.

2. If the Region Select Mode button in the main toolbar is select, then hold down the Shift key and click where you want the region to be extended to.
   - OR
   - Hold down both the CTRL and Shift keys.
   - OR
   - While holding down the mouse button and CTRL key, drag the mouse to the intended end of the region. Then release the mouse button and CTRL key.

To select the entire range of one or more adjacent staves:

- Click the Select Staff button among the staff controls to select one staff. While holding down the SHIFT key, click another staff to select it and all of the other staves between it and the first selected staff. For details, see Select Staff.

Once you have selected a region, many commands in the Region and Edit menus are available. For example, you can Remove Inaudible Notes in a Selected Region, or Remove Rests Smaller Than a rest duration that you specify. You can also use the Edit menu clipboard commands Cut, Copy, Paste, and Clear, as described next.
5.1.6 Using the Clipboard

Similar to clipboards in other Windows programs, Composer's clipboard is a place off the screen where you can temporarily save some region of a score. Later you can paste the temporarily saved region of the score into a new location in the same score, or in another score.

Note that Composer's clipboard is used only for moving regions of a score within Composer. Composer's clipboard does not support transferring music notation or performance data, nor bitmap images, to and from other Windows applications. There is one exception: you can use the clipboard to exchange lyrics between Composer and an external text editor.

Instructions for using the clipboard are described in the topics that follow.

5.1.6.1 Copy, Cut, and Paste

With Composer's clipboard, you can move all details—both notation and performance—from one region of a song to another. You can do this for just a few beats in a measure, or you can do this for large regions, including one or more entire staves of the score. You can move the region of music not only to some other location in the same song, but also to another song.

Composer's clipboard serves as a powerful tool for composers and arrangers. For example, using the clipboard and a few commands, a composer can copy a 16-bar section of a song to a new second section, and then transpose the notes up, say, two half-steps.

You can copy a region and then paste it on top of another region or, alternatively, you can insert the copied measures somewhere in the middle of the song or at the end of the song.

As you copy and paste measures, you can use the Paste Repeated Loop command to fill the destination multiple repeated times. For example, you might use the Paste Repeated Loop command to fill in a repeated percussion pattern.

Composer's clipboard also enables you to copy music from one region to another even if the meter and barlines do not match. For example, you can move notes from measures in a 4:4 meter to measures in a 6:8 meter. However, there is one restriction: If there are triplets or quintuplets in the region, then they must be moved in such a way that they do not straddle beats at their destination. For example, an eighth note triplet can be moved to a quarter note beat in the destination measure, but not to a minor eighth note beat in the destination measure. If you attempt to do this, Composer will display the following error message in the status bar:

Action would result in misalignment of tuplet members

All clipboard operations begin with selecting the region to be copied, as described in Selecting and Editing Regions of a Score.

NOTE: If you are currently viewing a MIDI graph, then the region copy and paste commands will apply only to the type of MIDI data currently displayed in the graph, and will not copy, for example, notes and text.

The following commands in the Paste Special submenu of the Edit menu are described in other topics:

- Paste Tempo: Copying Tempo Changes from One Region to Another
- Paste Lyrics: Copying and Pasting Text

To copy a region from one location on top of another region in the same song:

1. Select the region you wish to copy.
2. Choose the Copy command in the Edit menu.
Editing the Music Notation

-- OR --
Type CTRL+C.

3. Select the region where you wish to paste the music.

4. Choose the Paste command in the Edit menu.
   -- OR --
   Type CTRL+V.

To copy a region from one location on top of another region in a different score:

- Follow the same instructions as above, except in step 3 open another song if it is not already
  opened and select a region in it as the destination for the Copy/Paste operation.

To move a region from one location to another:

- Follow the same instructions as above, except in step 2 choose the Cut command instead of
  the Copy command in the Edit menu.
  -- OR --
  Type CTRL+X (instead of CTRL+C).

To insert a copy of some measures elsewhere in the score:

1. Select the region you wish to copy.

2. Choose the Copy command in the Edit menu.
   -- OR --
   Type CTRL+C.

3. Optionally select a region before which you wish to insert the copied measures. It does not
   matter where this destination region starts. It only matters where it ends.

4. Choose the Insert New Measures from Clipboard command in the Paste Special submenu of
   the Edit menu.

   If you skipped Step #3, then you will be asked in a dialog box to specify the number of the
   measure where the copied measures will be inserted.

To copy region multiple times to a destination region, repeating as many times as
necessary to fill the destination region:

1. Select the region you wish to copy.

2. Choose the Copy command in the Edit menu.
   -- OR --
   Type CTRL+C.

3. Select the destination region.

4. Choose the Paste Repeated Loop command in the Paste Special submenu of the Edit menu.

5.1.6.2 Clearing a Region of the Score

Clearing a region of the score leaves the measures and staves in place, but removes all notes,
performance data, and music annotations such as dynamic marks. If you also want to remove the
measures or staves, follow the instructions in Deleting Measures and Deleting Staves.

To clear a region of the score:

1. Select the region, as described in Selecting and Editing Regions of a Score.

2. Choose the Clear command in the Edit menu.
5.1.6.3 Creating a New Song from the Clipboard

Sometimes it is useful to create an entirely new song file, borrowing some portion of an existing song. This is easy to do using Composer's clipboard.

To create a new song by borrowing a portion of an existing song:

1. Select the region in the current song that you wish to use for the new song file. See Selecting and Editing Regions of a Score.
2. Choose the New Song from Clipboard command in the File menu.

5.1.7 Undoing Editing Operations

Composer supports multiple level undo. For example, if you transpose the score up a whole step, then add a clef in some staff, and then delete some notes, you can undo all of these editing operations, called transactions, one by one in reverse order. Further, you can undo several transactions at once. Also, once you have undone a transaction, you can change your mind and redo it again.

Note that if you make some change to the score after undoing a transaction, then the undo of that transaction is committed. That is, you can no longer redo that undone transaction.

Composer's multiple level undo feature requires the allocation of additional memory for each transaction that is saved. Eventually, if little memory is available on your system, Composer will display the following message in the status bar:

Memory is low. Use 'Clear Undo History' command in Edit menu to free memory.

When you see this message, you should use the Clear Undo History command in the Edit menu. If you need to undo any recent editing operations, you should undo them first before using the Clear Undo History command. After you use the Clear Undo History command, the "memory is low" message will usually go away. If the message is still displayed, then you may need to exit other programs that are running at the same time as Composer. If that does not work, then save your work with the Save or Save As command in the File menu; exit Composer; then run Composer again and reopen the file.

To undo one or more of the most recent editing operations (transactions):

1. Click the Edit menu in the main menu bar. Beneath the Edit menu label, a command name for undoing the most recent transactions will be listed, such as "Undo Set Key Signature." The undo command for the first most recent transaction will be listed first; the undo command for next most recent transaction will be listed second; and so on.
2. Click the first Undo transaction command listed to undo the most recent transaction.
   -- OR --
   Click some other Undo transaction command further down the list. All of the transactions from that point through the most recent will be undone.
   -- OR --
   Type CTRL+Z. This is a standard keystroke combination for the Undo command in most Windows software applications.
After you undo one or more transactions, the next time you view the Edit menu, it will display Redo transaction names for each of the most recently undone transactions. The following example shows four transactions that can be undone, the most recent being a "Delete Note" transaction:

In the above example, suppose you undo the two most recent transactions, by undoing them one at a time, or by clicking "Undo Set Clef" below "Undo Delete Note". That action will undo those two transactions. The next time you view the Edit menu, it will display the following:

The first transaction that can be redone is "Set Clef", and the second "Delete Note".

To redo one or more of the most recent undone operations (transactions):

1. Click the Edit menu in the main menu bar. Beneath the Edit menu label, review the list of Redo command names, such as "Redo Set Clef" and "Redo Delete Note" in the above example.

2. Click the first Redo transaction command listed to redo the most recently undone transaction.

   -- OR --

   Click some other Redo transaction command further down the list. All of the transactions from the first up to the one you clicked will be redone.

   -- OR --

   Type CTRL+Y. This a standard keystroke combination for the Redo command in most Windows software applications.
To free memory used to support the undo of transactions:

1. Make sure that you do not want to undo any previous transactions, because once you follow this procedure, you will no longer be able to undo them.

2. Choose the Clear Undo History command in the Edit menu.

5.1.8 Recovering Interrupted Song File Editing

If you are editing a song and your computer system or Composer program is abnormally terminated for any reason, you can still recover most of the work in progress on the song.

Composer completely backs up your work periodically, which is every 10 minutes by default. You can set the backup frequency to a shorter or longer period, according to instructions described later in this topic. Composer backs up your work with a minimal interruption to your keyboard or mouse activity. You will probably never notice that the back up is in progress. Composer will display "Auto-save <filename>..." in the status bar at the bottom of Composer's window, probably faster than you will be able to read it.

Composer stores backup files in the C:\Users\Public\Documents\Notation_3\Composer_3\Recover directory. The backup file will have the same name as the file you are working on, except that "-Recover", plus a number (e.g., -Recover-2) will be added to the end of the file name. For example, if you are working on MySong.not, the backup file will be named MySong-Recover-1.not. The recovery files are renumbered upon each backup, so that the most recent is always the one numbered 1.

Note that this backup and recovery system is not intended as a solution for normal backup of your music work in progress. If you are composing and arranging a song, and are about to make some major changes to the song that you are not sure you want to keep, then you should explicitly save a backup copy of the song using the File / Save As.

The Undo command is useful for reversing recent changes you have made to the song. Manually saving and restoring a backup copy using the File menu Save As and Open commands is the appropriate procedure for saving and returning to a major earlier juncture in your song composing or arranging project. Composer's file recovery feature is useful in the case that your system or Composer abnormally terminates.

The Auto Save Recovery option is enabled by default when you first install Composer.

To enable Composer's file recovery feature or change the frequency or number of backup copies kept:

1. Use the File / Open files from automatic backup... Options command.

Composer will display the following dialog box:

![Automatic Backup Options](image)

2. Turn on the check mark for "Enable auto-save (backup) of song data."

3. Edit the settings for frequency and number of backups you want to keep per song.

4. Click 'Ok' to save your changes.
To recover a file after your computer system or Composer has abnormally terminated:

1. Click "Files / Open files from automatic backup". Composer will display a File Open dialog box, and will pre-select your C:\Users\Public\Documents\Notation_3\Composer_3\Recover directory.

2. In the Recover subdirectory, search for the files that match the name of the file you were working on when Composer was interrupted. Open the recovery file with the same name, with "-Recover-1" at the end of the name, as that usually will be the most recently backed up copy of your file.

3. Review the opened recovered file. Compare it with the original file. Do not replace the original file if the recovered file is not newer. You can determine this by recalling what changes to the song you recently made, or by checking the date/time stamp of the file.

4. Optionally, rename the original file, or make a backup copy of it, just in case you have made a mistake in assessing that the recovered file is more recent.

5. While viewing the recovered file, use the Save As command in the File menu to rename it to the original file name, and to save it in the original file's directory.

**IMPORTANT:** Do not forget step 5! If you skip this step, and later use the File Save command, your work will be saved in the MySong-Recover.not file instead of the original file.

### 5.2 Editing Measures

Composer defines a measure as all the music that is played from one barline to the next, across all staves. Composer enables you edit measures as a whole in the following ways:

- **Insert measures** in the middle or at the end of the song.
- **Delete measures**
- **Split a measure** with a new barline into two smaller measures.
- **Join two measures** by removing the barline that separates them.
- **Create an upbeat measure** which has less than the full count of beats for the following meter.
- Specify the periodic numbering of measures, such as showing the measure number of every fifth measure.
- **Use multiple measure rests** to collapse two or more measures that are rests only.

#### 5.2.1 Inserting and Adding Measures

To insert new measures at the beginning or middle of the score, or add new measures at the end of the score:

1. Optionally, **select a score region**. The new measure(s) will be inserted before the selected region. Select the region by holding down the CTRL key while you drag the mouse.

2. Choose the Insert Measures command in the Measure menu.
   -- OR --
   Type "qim" or "qam" for Quick Insert Measure or Quick Add Measure.
Composer will display the following Insert Measures dialog box:

![Insert Measures Dialog Box]

If you selected a region in step #1, then Composer will pre-select the choice "Insert measure at measure number" and the measure number.

3. For the Where option, choose according to whether you want to insert the measure in the middle (or beginning) of the score, or at the end of the score.

4. Specify how many measures you want to insert or add.

5. Choose the meter for the new measures. The instructions for selecting the meter in this dialog are the same as for changing a meter; see topic Meters (Time Signatures).

6. Normally, you can accept the default Beam Groups pattern offered by Composer. The instructions for overriding the beaming pattern in this dialog are the same as for changing the beaming of existing measures; see topic Beams.

5.2.2 Deleting Measures

You can delete one or more measures with the Remove Measures command in the Score menu.

Beat zero of the first measure of a MIDI file typically contains MIDI data that must be transmitted at the start of the song. If you delete the first measure, or a range of measures starting at the first measure, Composer will move this data to the new first measure of the score.

To delete one or more measures:

1. Optionally, select a range of measures that you wish to delete. Select the measures by holding down the CTRL key and dragging the mouse across them.

2. Choose the Remove Measures command in the Score menu.

-- OR --

Type "qrm" or "qdm" for Quick Remove Measures or Quick Delete Measures.

Composer will present a Remove Measures dialog box.

3. In the Remove Measures dialog box, specify the measure number of the first measure to be deleted, and the number of measures to be removed. If you selected a range of measures in step #1, the values in the dialog box will be pre-selected.

4. Click the OK button to commit the deletion of the measures.
5.2.3 Splitting Measures

Composer enables you to insert a barline into the middle of a measure, thus splitting the measure either into two parts divided by a dotted barline, or into two smaller measures. Some reasons that you might want to split a measure are:

- Insert a dotted barline in the middle of a measure to emphasize the rhythmic structure of the measure. This just splits the measure in half: it does not divide the measure into two new measures.
- If the first measure of the song is an upbeat, you can split the first measure exactly at the first upbeat note, and then delete the left measure of the two newly created split measures.
- If an upbeat at the beginning of a section of the song is paired with a partial measure at the end of the section, then you may need to split a measure at the end of the section in order to create the partial measure. The procedure for Creating Upbeat Measures includes the procedure described in this topic for splitting a measure.

The barline can be inserted at any beat within the measure such that the newly created smaller measures do not necessarily have equal lengths. If the barline is inserted at a minor beat in the measure, Composer arranges the beams for the second of two smaller measures according to the same pattern as in the original measure. For example, if you split a 4:4 measure into 5:8 and 3:8 measures, the last two eighth notes of the second 3:8 measure will remain beamed together, and the first of the three eighth notes in the 3:8 measure will not be beamed.

To split a measure by inserting a barline in the middle of the measure:

1. With the mouse, navigate to the Barline Palette.

2. In the Barline Palette, select the type of barline you wish to insert in the middle of some measure.

3. Click the Insert Barline button.

4. The mouse cursor will change to .

--- OR ---

Type the vertical line character "|", which suggests the shape of a barline. This is the uppercase for the backward slash "\" character on many keyboards.
As you move the cursor around on the score, a dark red barline of the type you have selected will indicate where the new barline will be inserted if you click the mouse:

4. Click the mouse where you want the new barline to be inserted.

Composer will add a new double barline where you clicked the mouse, and will indicate the meters (time signatures) of the newly created left and right measure, as illustrated using the above example:

In this example, if you want to convert the 1/8 measure into an upbeat measure, and delete the 7/8 measure, then follow the instructions in Creating Upbeat Measures.

5.2.4 Joining Measures

By removing a barline, you can join two measures. The meter of the resulting new measure will have a total number of beats equal to the sum of the beats of the two measures.

For example, the barline between these two measures will be removed:

This is the result after the barline is removed:

The meter of the two measures before the barline was removed was 3:4. The meter of the resulting joined measure is 6:4, which is the sum of the 3:4 and 3:4 meters.
To join two measures:

1. Enter **Select Mode**.
2. Select the barline between the two measures by dragging the mouse across it horizontally. Composer will highlight the selected barline in the color blue.
3. Hit the **Del** key to remove the barline.

--- OR ---
Choose the **Join Measure With Next** command in the **Barline Menu**.

### 5.2.5 Creating Upbeat Measures

An upbeat measure begins a section of a song with fewer beats than the full count of beats in the meter.

This topic describes how to create an upbeat measure if the barlines in your song are already correctly aligned with the downbeat of measures. If you have imported a MIDI file, or recorded MIDI, such that the barlines are misaligned with the downbeat of measures, then you can shift the barlines, as described in the separate topic, **Shifting Barlines**.

If a section of a song begins with an upbeat measure, and that section has repeats, then the section normally ends with a partial measure. The total number of beats in the upbeat measure and the last measure of the section equals the total number of beats in the meter of the section.

The procedure in this topic shows how you can create an upbeat measure, and corresponding last measure of the section, with repeat marks. In the example, we will start with the following score:

![Score Example](image)

We will change the first measure to an upbeat measure; split the third measure to create the section's last measure, which complements the first measure; and add repeat marks.

![Score with Upbeat Measure and Repeat Marks](image)

If you need only to create an upbeat measure, you need only follow the first few steps in the following procedure.

**To create an upbeat measure and a corresponding trailer measure with repeat marks:**

1. Split the first measure where you want the upbeat to start. Usually you will want to split the measure where the first note follows preceding rests. See **Splitting Measures** for instructions.
2. Delete the left half of the split measure. See Deleting Measures for instructions.

3. Hide the meter of the upbeat measure, as follows:
   (a) Type SHIFT+M to display the Meter Palette.
   (b) Click the meter button in the palette.
   The mouse cursor will turn into this shape:
   (c) Click the upbeat measure.
   Composer will display the Change Meter dialog, as shown here:
   (d) Add a check mark for "This is an upbeat Measure". Then click the OK button.
4. Skip the remaining steps of this procedure if your goal is only to create the upbeat measure.

5. Split the last complete measure of the section so that the right half has the same number of beats as the upbeat measure. See Splitting Measures for instructions.

6. Select the barline after the upbeat measure, and change its type to a start-repeat. Select the barline at the end of the repeated section, and change its type to an end-repeat. See Barlines for instructions in changing the barline type.

7. Hide the meter in the newly split measure at the end of the repeated section. Follow the instructions in step #3 to display the Change Meter dialog for the section's last measure, which is the 7:8 measure in this example. Set a check mark by the hide button.
8. Hide the meter in the newly split measure that follows the end of the repeated section, following the same instructions as Step 7 above.

**NOTE:** Do not attempt to hide the meters in both measures with one visit to the Change Meter dialog, because that will incorrectly make the meter for both measures the same.

The result of this step completes the overall task:
5.2.6 **Shifting Barlines**

It is common that a MIDI file prepared by another MIDI program will have barlines that are misaligned with the downbeat of measures. This problem particularly happens if the song has an upbeat measure, which has a duration less than the meter of the song. This problem arises not because **Composer** cannot correctly interpret the barlines in the MIDI file, but because the barlines are misplaced in the MIDI file.

Here is an example of misaligned barlines:

You can readily fix this problem by using the Shift Barlines command. The result will be this:

> To shift multiple barlines to the right:

1. While holding down the CTRL key, drag the mouse over the range of measures for which you wish to shift the barlines. It does not matter which staff you select.

   -- OR --

   Use the Select Region command in the Region menu to select a range of measures.

   -- OR --

   Select the entire range of measures by clicking the Select Staff button among the staff control buttons. (Please note that the actual selection color will be light blue.)

2. Navigate to the **Barline Palette** with the mouse.

   -- OR --
Type ‘|’ (which is probably Shift + ‘\’ on your keyboard).

3. In the Barline Palette, click the Move Barlines button.
   – OR –
   Choose the Shift Barlines command in the Barline menu.
   The mouse cursor will change to show a red double-barline, which you can move around on the score:

4. Move the red double-barline to where you want the first barline to be shifted:

   ![Red double-barline moved](image)

5. Click the mouse button.
   A barline will be inserted where you clicked the mouse, and all of the remaining barlines in the selected region will be shifted by the same number of beats as those in the first partial measure that you have created:

   ![Inserted barline](image)

   ![Shifted barlines](image)

   This will create a partial measure at the beginning of the selected region. If this is at the beginning of the song, you probably want this to be an upbeat measure, and do not want to see the partial meter, which is the 1:8 meter in this example. Also, this will create a corresponding partial measure at the end of the selected region, which is the 7:8 meter in this example.

6. To correctly display the meter in the upbeat measure, double-click it. That will bring up the Change Meter dialog box. Set a check mark for “This is an upbeat measure.”

7. Optionally delete the trailing partial measure, which is the 7:8 meter in this example.
   – OR –
   Change the meter value for that partial measure.

The final result of the above procedure is as displayed at the top of this topic.

### 5.2.7 Editing Measure Numbers

Composer offers several options for displaying measure numbers, such as at every 5th measure, or at the first measure of every system.
If you break up a large musical work into more than one Notation .not file, then you might want the measure number of the second .not file to follow the last measure number of the previous .not file. You can do this as described below.

To choose a measure numbering option:

1. In the Measure menu choose the Measure Numbers command.

   -- OR --

   Type "qmn" for Quick Measure Numbers.

Composer will display the Measure Numbers dialog:

2. Choose one of the options in the dialog, and click OK.

   All of the options are self-explanatory except perhaps for the first one: "first measure of every system". A system is one line of measures on a page. The line of measures includes the staves for all of the instruments or voices that are playing. Thus, this option displays a measure number at the first measure of each line (system) on each page of the score.

To specify some starting measure number, other than 1, for the continuation of a song in a second Notation .not file:

- Follow the same procedure as above. Enter the starting measure of the second .not file in the "First measure number" field of the Measure Numbers dialog box. Please note that this number cannot be negative.

5.3 Adding Notes

Composer offers many methods for adding notes to a score, to suit varied preferences among a wide variety of users, as well as to suit different needs that you may have at different times.

Overall, there are three different physical devices you can use to enter notes in Composer, and using each of these various devices there are alternative methods you can use for entering notes:

1. With the mouse:

   (a) Point and click the mouse to add new notes, choosing their durations from the Note Duration Palette.

   -- OR --

   (b) Point and click the mouse to add new notes in the score from left to right, such that the duration of each note is determined by the location of the next note. This Sequential Note Entry Method is particularly useful if the notes have frequently changing durations. You will not have to select different duration values from the Note Palette, because the duration of each note automatically extends to the beginning of the next note, whether that next note is a 32nd duration later or, say, a dotted quarter note duration later.
2. With the computer keyboard:

   Use only your computer keyboard to enter notes by typing the duration of the note you wish to add, such as "8" for 8th note, "16" for sixteenth note, or "41d" for a quarter note with one dot. Use the , , , and keys to determine the position of the note to be added. Then hit the key to add the note. If you tend to prefer using the computer keyboard over using the mouse, you will like this method.

3. With a music keyboard that is connected to your computer via a MIDI cable:

   (a) In synchronization with Composer's metronome, record your performance on your music keyboard in real time to quickly enter the notes. Perhaps you will want to record your performance at a slower tempo which you can later set to a faster speed.

   -- OR --

   (b) Use your music keyboard instead of the mouse to determine the pitches of notes; but enter the notes at your own pace, without regard to a metronome. This is called Step-Time Recording, as opposed to real-time recording.

   (c) Use both your music keyboard and computer keyboard together. Point the mouse in the score at the location where you want to add a note or chord, and play it on your music keyboard. Hit the key one or more times to advance the cursor that many positions in the Beat Ruler. The next time you play a note, the duration of the previous note will terminate at the location of the newly added note. This method combines Step-Time Recording with the Sequential Note Entry Method.

   The topics that follow explain all of the many methods of entering notes. You'll almost certainly find one or more methods that suit your preferences.

   Tip: For a quick overview of the above methods of adding notes, see the tutorial step on Adding Notes to a New Song.

5.3.1 Adding Notes with the Mouse

   There are two quite different ways to add notes with the mouse in Composer. The first way is the most obvious way: point and click. Choose a note duration value from the Note Palette, or use a keyboard shortcut such as "4" for quarter note and "16" for 16th note. Then click the mouse where you want it to be added. This point-and-click method for adding notes "feels good" because as you move the mouse around, the notes snap to the grid of the Beat Ruler, which lets you know with more confidence where the note will be added when you click the mouse.

   The second method of adding notes with the mouse is not so immediately obvious because, for one thing, you may not have seen this feature in other music programs: the Sequential Note Entry Method. With this method, the duration of a newly added note is determined by where you add the next note. Initially, the duration of a newly added note extends to the end of its measure, and also to the end of the next measure. This is probably not the duration you intend for the note. However, as soon as you add the next note after the first note, the duration of that first note will be changed so that it ends where the next note begins. The term "sequential" is used here to suggest how one would add notes sequentially, from left to right, in the score, where each note usually follows the previous. (It's easy, however, to create chords with multiple notes, as well as to include rests between notes.)

   Tip: Many Composer users tend to initially overlook this useful Sequential Note Entry Method, because the Note Duration Palette draws their attention first, and they quickly develop the habit of point-and-click for adding notes. However, many users have discovered the Sequential Note Entry Method with delight and wish they had been using it all along. We suggest that you briefly try it out so that you can decide whether it suits your working habits.
5.3.1.1 Adding Notes with Mouse by Choosing Durations from the Note Palette

The basic method for adding notes uses the mouse, and optionally the computer keyboard, but not the music keyboard. The overall procedure for adding notes this way is:

1. Enter **Add Mode**.
2. **Select the note duration** value from the Note Palette.
3. **Specify the voice of the note**, which determines the direction (up or down) of the stem attached to the note.
4. **Use the Beat Ruler** to determine the location where you want the note to be added, and click the mouse at the desired location.
5. **Determine the pitch of the new note** by the vertical position of the mouse click on the staff, and optionally, by later dragging the pitch up or down with the mouse.

This basic method for adding notes is illustrated in the following example, where an eighth note is added below a quarter note.

Practice adding notes with different note durations and voices (stem directions):

1. Create or open a song file.
2. Enter **Add Mode** by clicking this button in the toolbar:
3. If the Note Palette is not already showing, type SHIFT+N to display it:

4. Prepare to add a quarter note to the score by clicking the quarter note button in the Note Palette, or by typing "4".
5. Move the mouse to the measure where you want to add the quarter note. Use the Beat Ruler to determine the exact beat location within the measure for the new note:
6. Click the mouse at the beat location and the staff line or staff space where you want to add the note. The note will be added to the score, and will automatically be selected for further editing, as indicated with the blue highlighting of the notehead:

Notice that Composer automatically adds rests surrounding the newly added note.

7. Prepare to add an eighth note by clicking the eighth note button in the Note Palette, or by typing "8" for eighth note:

8. Click the Lower Voice button, to prepare to add the eighth in the lower voice.

   -- OR --

   Type "lv" for lower voice.

9. Move the mouse to one eighth note past the quarter note added above, and at a lower staff position:

10. Click the mouse. Notice how the new eighth note has a downward pointing stem. and how the quarter note's stem direction has been automatically changed to an upward direction. Composer also fills in the extra eighth note rest in the lower voice below the quarter note. This is the proper way to separate voices singing or playing different note durations in the same staff:

11. Change the pitch of the newly added note up a half-step by typing "#" to add a sharp accidental, or by hitting the key while holding down the "P" key for "pitch up":

In the topics that follow, the above basic procedure for adding notes is described in further detail.
5.3.1.2 Selecting the Note Duration

Unless you are using the Sequential Note Entry Mode, you should normally specify a note duration value before you add the note to the score with a mouse click. You can specify a note duration value by using (1) the Note Palette, (2) an equivalent keyboard command, or (3) the Note menu (not recommended except for learning the keyboard shortcuts).

By default, the as-performed duration of the newly added note will be only slightly less than the annotated duration. The result of this is that notes following one another be played in a connected legatto style. Often this is not what you will want. You may want a more crisp sound, with brief gaps of silence between them. You can individually adjust the as-performed duration of each note, or of several selected notes at a time. Also, Composer enables you set a default as-performed duration corresponding to each standard note value, so that whenever you add a note, its as-performed duration will automatically be adjusted. For example, you can set the as-performed duration of a quarter note to be the equivalent of, say a dotted eighth note, every time you add a quarter note. For details, see Saving and Applying Note Duration Adjustments.

To select the note duration value from the Note Palette:

1. Type SHIFT+N to display the Note Palette. Composer will automatically switch from Select Mode to Add Mode.

The Note Palette looks like this:

```
[Note Palette Image]
```

A note duration is specified as a combination of these three things:

(1) The base (round) duration, such as:

```
\(\frac{\text{1}}{\text{4}}\) \text{ or } \frac{\text{1}}{\text{8}}
```

(2) The dotted note value, such as:

```
\(\frac{\text{1}}{\text{8}}\) \text{ or no dot}
```

(3) The triplet or quintuplet value, such as:

```
\(\frac{\text{1}}{\text{12}}\) \text{ or no triplet or quintuplet}
```

2. Click options from each of the above three groups in the Note Palette.
Here are some examples:

1. Type SHIFT+N to display the Note Palette so that you can see the current note duration value.
2. To select the base (round) note duration, type its 1- or 2-digit value, as indicated below:

   Keystrokes:  11  22  4  8  16  32  64
   Note Value:  \( \text{o} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)

   Note that the whole note keystrokes are "11" and "22" instead of "1" and "2". Why? Because "1d" and "2d" are used for single and double dots. If you just typed "1" or "2", Composer would not know if you wanted to add a whole or half note, or whether you wanted to type a "d" character to indicate "dot", as described next.

3. To change the dotted note value, type "0", "1" or "2", followed by "d", for zero, one or two dots:

   Keystrokes:  0d  1d  2d
   Note Value:  \( \text{o} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)

4. To select the tuplet style, type "00", "33" or "55" for no tuplet, triplet, or quintuplet, as indicated below:

   Keystrokes:  00  33  55
   Note Value:  \( \text{o} \)  \( \text{\textbullet} \)  \( \text{\textbullet} \)

5. To add the first note of a triplet swing:
   - Click the triplet swing button.
   - OR --
   - Type "3s" for triplet swing.
5.3.1.3 Using the Beat Ruler

The previous topic, Adding Notes with the Mouse, introduces using the Beat Ruler for adding notes. This topic describes more details about the Beat Ruler.

The Beat Ruler has an appearance similar to that of a normal desk ruler. It is drawn in the background behind the notes and rests in the measure where the mouse is currently pointing:

As you move the mouse from one measure to another, the Beat Ruler follows to the new measure. The red to-be-added note "snaps" to positions in the Beat Ruler. This snapping behavior of the note helps you gain certainty about where it will be added when you click the mouse.

At any time you can change the resolution of the Beat Ruler so that the Beat Ruler marks are as small as 64th notes, or as large as 8th notes. If you are adding triplets or quintuplets, the Beat Ruler resolution will automatically, temporarily, be set to the triplet or quintuplet duration. If you find that the Beat Ruler marks are so close together that it is difficult to position the mouse at the correct beat position, you can stretch the Beat Ruler. These procedures are described later in this topic.

You may want to add notes between the minor beats indicated by the Beat Ruler. Although you can change the resolution of the Beat Ruler, usually you will not find that necessary. When you add a note with a duration that ends in between two minor beats of the Beat Ruler, Composer will automatically add a rest. You can then add a note to replace some or all of the rest. The location of the rest serves as an additional subdivision of the Beat Ruler, as illustrated here:

If you need to add a note in between two ruler positions that is spanned by a rest, then you can first divide the rest. The division of the rest will provide you a place to subsequently add the note between the Beat Ruler beat positions. For details, see Dividing and Combining Rests.

If you are adding triplet or quintuplet members, the Beat Ruler marks will temporarily change to triplet or quintuplet increments.
To change the Beat Ruler resolution to 8th, 16th, 32nd or 64th:

1. Navigate to the Note Duration Palette, or type `SHIFT+N`.
2. In the Note Duration Palette, click the Beat Ruler Palette button. 
   -- OR --
   Type "ru" for ruler.

That will take you to the Beat Ruler Palette:

3. Click some resolution value, such as 16th note intervals, illustrated here:

   To automatically, temporarily, change the Beat Ruler resolution to a triplet or quintuplet resolution:
   - When you select a triplet or quintuplet note duration in Add Mode, the Beat Ruler resolution will be automatically set to the triplet or quintuplet note duration:
To stretch the Beat Ruler marks farther apart, or to compress them closer together:

1. Navigate to the Beat Ruler Palette, as described above.
2. Click the Increase Ruler Spacing button or Decrease Ruler Spacing button one or more times.
3. Choose one of the commands in the Spacing Between Ruler Marks submenu of the View menu. One of these commands is Specify Minimum Pixels Per Ruler Mark.
4. Type S+ or S+ to increase or decrease the ruler resolution. Type S+ENTER to set the ruler resolution to the default.

5.3.1.4 Adding Notes Using the Sequential Note Entry Mode

The basic method of adding notes with mouse point-and-click requires that you select a note duration before adding a note. If you are adding a series of notes with frequent changes in durations, it may become somewhat tedious to have to select varying note durations before you add notes. You may find that using keyboard shortcuts, such as "81d" for "dotted 8th note" will make selecting note durations much easier. But there is an alternative method of entering notes, named the Sequential Note Entry Mode, where you do not have to specify the note duration before you add it.

With the Sequential Note Entry Mode, the duration of a newly added note is determined by where you add the next note. Initially, the duration of a newly added note extends to the end of its measure, and also to the end of the next measure. This is probably not the duration you intend for the note. However, as soon as you add the next note after the first note, the duration of that first note will be changed so that it ends where the next note begins. The term "sequential" is used here to suggest how one would add notes sequentially, from left to right, in the score, where each note usually follows the previous. (It's easy, however, create chords with multiple notes, as well as to include rests between notes.)
TIP: Many Composer users tend to initially overlook this useful Sequential Note Entry Method, because the Note Duration Palette draws their attention first, and they quickly develop the habit of point-and-click for adding notes. However, many users have discovered the Sequential Note Entry Method with delight and wish they had been using it all along. We suggest that you briefly try it out so that you can decide whether it suits your working habits.

To add notes with varying durations using the Sequential Note Entry Mode:

1. Enter Add Mode by clicking this button in the toolbar:

2. If the Note Palette is not already showing, type SHIFT+N to display it:

The palette will then change to the Beat Ruler Palette, and the Sequential Note Entry button will be shown in the "down" position:

3. Move the mouse cursor in the score to the horizontal measure and beat location where you want to add the first note, and the vertical pitch position of the first note. Then click the mouse. The newly added note will have a duration that extends to the next note, or to the second barline, which ever is first.
4. Optionally, change the pitch of the newly added note by dragging it up or down before releasing the mouse button. Or, type P+ \( \uparrow \) or P+ \( \downarrow \). Or add an accidental, such as "#" for sharp. See Determining the Pitch of a New Note.

5. With the mouse, move the red to-be-added note to the measure and beat and pitch for the next note; and then click the mouse. The duration of the second newly added note will extend to the second barline. The duration of the previously added note will extend to the location of the second added note, as illustrated below:

The result of clicking the red to-be-added note at its location in the above example will be:

To create chords:
- Click a new note at the same location as another note. For example, here is the result of adding a second note to the first note in the above example:

To add notes between other notes:
- Simply click the mouse somewhere between two notes. The previous note will be shortened, so that its duration ends at the location of the newly inserted note. The duration of the newly inserted note will extend up to the next note after it:
In the above examples, the spacing between notes was limited to no smaller than 8th notes. You can change the spacing to a smaller (or larger) value, according to the next procedure.

- To determine how far apart the notes are, in terms of note length:
  - Choose one of the resolutions in the Beat Ruler, as illustrated below:

In the above examples, we have created different note duration values without having to explicitly specify them in the Note Duration Palette. Instead, the duration of each note is determined by the location of the next note in the sequence, which is why we call it the "Sequential Note Entry Mode".

Suppose you would like to terminate the last note at the barline, rather than have it extend across the barline. This is easy to do with the Cut Duration Tool.

- To shorten the duration of a note or chord:
  1. Select the note or chord. If you just added it, then it is already selected.
2. Click the Cut Duration Tool button in the Beat Ruler Palette.

-- OR --

Type "cut".

The mouse cursor will change to a razor shape.

3. Move the mouse so that the razor is located where you want to end the previous note or chord, as illustrated below. It does not matter where you place the razor vertically.

4. Click the mouse to complete the "cutting" of the note duration. The result for the above example is:

After using the Cut Duration Tool once, Composer will automatically return to Sequential Note Entry Mode.

You can also use the Cut Duration Tool for a note in the middle of a sequence, as illustrated here:

5.3.1.5 Specifying the Stem Direction (Voice)

With Composer, the direction of a stem attached to a note is determined by the voice of the note. The term voice has musical meaning. The stem direction indicates the voice according to common music notation practice, as described below.

If a part in the score is for a single instrument or human voice, which can only play or sing one note at a time, then all of the notes in that part are said to have a single voice. If the part is played or sung by two or more individuals, but they all play the same notes, and only one note at a time, then that part is also said to have a single voice. The stem directions for notes in a single voice may be upward or downward. If a note is above the middle staff line, the stem direction is downward; if the note is below the middle staff line, the stem direction is upward.
If a part is for two players, and if the notes they play have different rhythms, then the part is said to be split with upper and lower voices. Upper voice notes always have upward stems; and lower voice notes always have downward stems.

Piano and keyboard parts also indicate upper and lower voices to clarify and simplify the notation of notes simultaneously played with different rhythms. When all of the notes have the same rhythms, they typically use stem direction rules for single voice. These rules for keyboard voice notation are illustrated below:

If a pair of notes—one in the upper voice and one in the lower voice—share the same pitch, then Composer will display the two notes using a single notehead with one upward stem for the upper voice and a second downward stem for the lower voice. This will be done unless there would be ambiguity about the duration of the note in either voice. Two shared noteheads are illustrated below:

In Composer, you do not directly edit stem directions. Instead, you indirectly edit them by specifying the voice of notes. However, if Composer chooses a stem direction that is the opposite of what you want, you can force it in the opposite direction according to a procedure at the end of this topic.

To select the voice for notes that you subsequently add:

1. Type SHIFT+N to display the Note Duration Palette.

2. Click one of the three buttons in the palette to choose the voice.

   -- OR --

   Type "sv", "uv" or "lv" for single, upper or lower voice.
In Add Mode, as you move the mouse around, you will notice that the stem direction of the moving note is consistent with the voice you have chosen. For example, if you have chosen lower voice, then even if you move the mouse below the middle staff line, the stem direction of the moving note will remain downward:

![Stem Direction Example](image)

When you add a new note to a location in the score where another note has a different voice, Composer may change the voice of the other note in a way that should usually please you. In the following example, an eighth note is added one eighth note beat past the beginning of a quarter note that has a single voice:

![Voice Change Example](image)

When Composer adds the eighth note, it automatically reassigns the adjacent quarter from single voice to upper voice:

![Voice Change Example](image)

This works the other way, too. If you add a single voice note such that it overlaps some upper or lower voice notes already in the score, then Composer will automatically reassign those overlapping notes to a single voice.

To force the stem direction to be the opposite of its natural direction:

1. To set the stem direction up, assign the note to upper voice. To set the stem direction down, assign the note to lower voice. If the note already exists, select it, and then click the Upper Voice or Lower Voice button in the Note Palette, or type “uv” or “lv” for upper voice or lower voice.

   The score will then show a rest in the opposite voice, as illustrated here:

   ![Rest Direction Example](image)

2. Select the rest in the opposite voice.

   To select many rests, you may find it convenient to select a region using Ctrl+Drag, or by selecting an entire staff, and then use the Convert Region to Selection or Rests command in the Region menu.

3. Choose the Hide Rest command in the rest menu.

   -- OR --

   Click the Hide Rest button in the Rest Palette.
-- OR --

Type "h" for "hide rest".
The rest will be temporarily reveal in gray rather than black:

4. To return the hidden rests back to invisible, toggle off the check mark for Reveal Hidden Rests in the Rest menu.

-- OR --

Toggle of the Reveal Hidden Rests button in the Rest Palette.

-- OR --

Type "r" to toggle off "reveal hidden rests".

5.3.1.6 Determining the Pitch of a New Note

When you add a note, its pitch is initially determined by its staff position and the preceding key signature. After you add the note you can quickly add an accidental to it, such as a sharp or flat. You can also listen to the pitch of the note before you commit to adding it. While you hold down the mouse button, you can move the mouse up and down to hear different pitches before you release the mouse button to add the note. These and some other procedures for determining the pitch of a new note are described below.

1. Prepare to add the note by navigating to the Note Palette, selecting the note duration and voice, and then moving the mouse cursor to the measure and beat location where you want to add the note. The procedure for preparing to add the note is described in Adding Notes with the Mouse.

2. Move the cursor (note) to a position in the staff that determines the pitch of the note for the key signature of the measure.

As you move the mouse, the moving note at the cursor will snap to a position exactly on a staff line, or at the space between two staff lines. This snapping behavior of the mouse gives you certainty about what the pitch of the note will be when you finally click the mouse.

3. If you do not need to hear the pitch of the note before you commit to adding it, click the mouse button. Otherwise, press the mouse button down and you will hear the pitch of the note about to be added.

4. If you have not yet released the mouse button, you can move the mouse up and down to hear different pitches:

Drag mouse up and down to hear pitches in the current key signature.
It does not matter if you also move the mouse left and right; the note will remain at the measure and beat location you originally clicked.

5. Release the mouse button when you hear the pitch you want, or a pitch that is a half-step above or below the pitch you want if your desired pitch does not belong to the current key signature.

6. If you decide you do not want to add the note, you can hit the ESC key before releasing the mouse. You might find it easier, however, to just hit the `Del` key after the unwanted note is added.

7. If the note does not belong to the current key signature, then you can add an accidental as follows:
   - Type the NumPad `±` or `−` key one or more times to raise or lower the pitch one half-step at a time.
   - OR —
   - While holding the "P" key, hit the `↑` or `↓` key one or more times to raise or lower the pitch one half-step at a time.
   - OR —
   - Type one of the following commands:

     keyboard command       accidental
     "ss" or "#"              sharp
     "f" or "b"               flat
     "na"                    no accidental
     "ds" or "d#" or "x"      double sharp
     "df" or "db"             double flat

If you type P+`↑`, P+`↓`, CTRL+`↑` or CTRL+`↓` to specify the pitch of the note, Composer will automatically choose a "spelling" for the note based on its analysis of the surrounding harmony. For example, Composer will automatically choose between two alternative spellings of C# and Db. If Composer does not automatically choose the spelling you want, you can change the enharmonic spelling, as described in the topic on Accidentals.

5.3.1.7 Determining the Loudness of a New Note

The loudness of a note can range from 1 to 127. This is the MIDI note-on velocity. When you add a note, its loudness will be 64, by default. You can change this default by following this general procedure:

1. Click the Note Velocity tab.
2. In the "Loudness" menu choose the Set Loudness for New Notes command.
3. Enter the loudness value, and check the "Use the above loudness (MIDI velocity) for all newly added notes" option.
4. Click "Ok" to save and exit.
After this, any note that you subsequently add will have the loudness that you saved.

The above procedure is described in detail in Editing the Loudness of Notes.

5.3.2 Adding Notes Using Only Your Computer Keyboard

The method for adding notes described here is ideal if you prefer to do most of your work with the computer keyboard instead of the mouse.

The following example introduces how adding notes with only your computer keyboard works:

To add notes using the computer keyboard:

1. Enter Add Mode by clicking this button in the toolbar.
2. If the Note Palette is not already showing, type SHIFT+N to display it.
3. Select the note duration for the to-be-added note, as described in Selecting the Note Duration. You can use the mouse to choose a duration value from the above Note Palette. Or, you can use computer keyboard shortcuts, such as "4" for quarter note, "16" for sixteenth, or "833" for eighth triplet.
4. Move the mouse so that the red to-be-added note on the screen is close to where you want to add the first note.
5. Hit the or key one or more times to move the red to-be-added note to the measure and beat location where you want to add the note.
You might need to change the Beat Ruler to determine the resolution of the beats where notes can be added, such as every eighth note beat or every sixteenth note beat.

6. Hit the \( \text{[up]} \) or \( \text{[down]} \) key one or more times to move the red to-be-added note up or down one staff step at a time. If you need to add an accidental to the note, follow step #8.

7. Hit the \( \text{[ins]} \) key to insert (add) the new note at the location of the red to-be-added note. The newly added note will be shown in the score, and will be selected, as indicated with a blue highlight.

8. To add an accidental to the newly added note:
   - Type the NumPad \( + \) or \( - \) key one or more times to raise or lower the pitch one half-step at a time.
   - OR --
   - While holding the "P" key, hit the \( \text{[up]} \) or \( \text{[down]} \) key one or more times to raise or lower the pitch one half-step at a time.
   - OR --
   - Type one of the following commands:

<table>
<thead>
<tr>
<th>keyboard command</th>
<th>accidental</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ss&quot; or &quot;#&quot;</td>
<td>sharp</td>
</tr>
<tr>
<td>&quot;f&quot; or &quot;b&quot;</td>
<td>flat</td>
</tr>
<tr>
<td>&quot;na&quot;</td>
<td>no accidental</td>
</tr>
<tr>
<td>&quot;ds&quot; or &quot;d#&quot; or &quot;x&quot;</td>
<td>double sharp</td>
</tr>
<tr>
<td>&quot;df&quot; or &quot;db&quot;</td>
<td>double flat</td>
</tr>
</tbody>
</table>

If you type NumPad \( + \) or \( - \), or P+\( \text{[up]} \) or P+\( \text{[down]} \) to specify the pitch of the note, Composer will automatically choose a "spelling" for the note based on its analysis of the surrounding harmony. For example, Composer will automatically choose between two alternative spellings of C# and Db. If Composer does not automatically choose the spelling you want, you can change the enharmonic spelling, as described in the topic on Accidentals.

9. To add a note to a chord, use the \( \text{[up]} \) and \( \text{[down]} \) keys to move the red to-be-added note to another staff position at the same measure/beat, and hit the \( \text{[ins]} \) key.

### 5.3.3 Adding Notes Using Your Music (MIDI) Keyboard

If you have a music (MIDI) keyboard connected to your computer, there are two general ways you can use it to add notes:

1. **Record your performance of the notes on the music keyboard in real-time**, or perhaps at a slower tempo.
2. Use your music keyboard as a natural way to select pitches of notes or chords as you insert them one-by-one into the score. This is called **Step-Time Recording**.
3. Step-Time Recording offers an especially quick way to enter notes if you **use it together with the Sequential Note Method**.
These three methods of adding notes using your music (MIDI) keyboard are described in the topics that follow.

5.3.3.1 Recording Your Performance at MIDI Keyboard to Enter Notes

If you are skilled with a music keyboard, then you might find that the quickest way to enter notes it to record your live performance. (If you are not skilled with a music keyboard, then there are many other ways to enter notes with Composer.)

You do not need an expensive electronic keyboard for the purpose of entering notes via a music keyboard. The keyboard does not even need to be able to produce sound. You can use what is called a MIDI controller, which is just the keyboard without any sounds: Composer will "hear" the notes you play on the MIDI controller and play them back using whatever instrument sounds you assign. You can purchase a compact 49-key MIDI controller for as little as $100 (USD) or less, which will even detect and record how loud you play each key (the MIDI note velocity).

The procedures for recording notes from your MIDI keyboard are described in the section Recording from a Music Keyboard. The current topic does not describe the procedures for recording but, rather, offers some tips on how you can take advantage of Composer's recording capability in order to add notes to a score. Composer offers the option of recording with or without using a metronome. If you are more comfortable using a metronome to keep your timing and rhythm on track, then you have a very quick method of entering the notes for your song. If you prefer to play "with feeling", but still want a high-quality transcription, then you can play your song however you want and then use the Rebar feature to adjust the barlines and beats to accurately transcribe the sheet music for your song.

Tips for Entering Notes by Recording Your Performance at a MIDI Keyboard


One of the most difficult things about recording from a MIDI keyboard is keeping in time with the metronome. You can avoid this altogether with the Step-Time Recording Method. By that method, you still use your MIDI keyboard to tell Composer which notes you are adding. Play a note or chord on the music keyboard, and Composer will add it at the active location in the score. You can take as much time as you want before then playing the note or chord. With this method, however, you will sometimes need to go back and forth between your MIDI keyboard and either the mouse or your computer keyboard.

2. You don't have to play all of the notes at once.

Suppose you want to enter the notes for a piano piece. You don't have to record all of the notes at once. For example, you might record just the right hand first, and then the left hand. Or, you might record just the melody first, and then fill in the accompaniment in subsequent recordings. If you do this, you might want to add one or extra temporary staves for different "slices" of the music, and then merge two or more of them together into a single staff.

3. Record at a slower tempo and then later edit the tempo for a faster speed.

This is sort of cheating, but nobody has to know that you recorded at a slower tempo. If you care only about preparing the music score, and don't care about fine details in the performance interpretation of the score upon playback, then you can ignore the rest of this tip.
If you do care about the fine details of how the music sounds upon playback, then take care to perform the music with a "feeling" that takes into account that the tempo will be later sped up. This tip assumes that you are recording with a metronome. If you want a freer playing and performance style, then see Tip 6 below.

For example, suppose the final score has some fairly quickly played staccato notes. At a slower tempo, you'll play each note on a slower beat or sub-beat. That much is easy. However, you might be tempted to play the staccato note at a slower tempo with the same shortness that it would have at the finally adjusted faster tempo. A discriminating ear will hear that at the final faster tempo, the staccato note will then sound too short.

Here's some math to explain this. Suppose the final tempo is 120 quarter notes per minute, and there are some staccato 8th notes. Each quarter note is one-half second long, because if there are 120 quarter notes per minute, there are 2 for every second. Therefore, each 8th notes is 1/4 second long. Suppose you want each staccato 8th note to sound half as long as it is notated, so that the as-heard duration of each 8th note is therefore 1/8th second long. Your ear knows what that sounds like. Now, suppose you perform the music at your keyboard at half the tempo, so that it is easier for you to play the notes. At this half tempo, each 8th note is 1/2 second apart. Your ear might tell you, however, to play these slowed downed 8th notes with still the very abbreviated 1/8th second length. That might sound right as you're performing at the slower tempo. However, when you double the tempo back to the intended 120 quarter notes per minute, the 8th notes will sound for only half as long, that is, for 1/16th of a second. They will sound half as short as you want. They will then be played with too much staccato.

It takes a little bit of practice to learn how to compensate for this "tempo shift". Soon, you will find yourself naturally compensating for it. Or, alternatively, consider playing at a normal tempo and correct your performance mistakes later, as described in the next tip. If you want an even freer playing and performance style, see Tip 6 below.

4. Record at normal tempo; don't worry about some wrong notes; correct them later.

This method is advised only if you care a lot about the playback of the score. At first glance, this advice might seem self-contradictory, because why would you want to record wrong notes if you care a lot about the playback? The reason is that it is easier to fix the wrong pitch of a note than it is to adjust the rhythm of the note or its loudness. Using this method you can enter the proper rhythms of chords or single notes, then easily go back and adjust the pitches. This tip assumes you are recording with the metronome "on." If you want a freer style of playing, please see Tip 6 below.

If you care only about preparing the score, then we do not recommend recording at normal tempo. You might as well record at a slower tempo at which you will hit fewer wrong notes.

If you do care about how the music sounds upon playback, and you want it to follow your interpretation, then recording your interpretation--the precise rhythms the individual loudness of each note--is an ideal way to prepare the sound track. And, you might be able to produce the best musical interpretation of the music by performing it normal tempo. Or, record at almost normal tempo, and then speed up the tempo just somewhat for the final sound track.

5. Use Composer's Undo Command for Multiple Takes
After you record, say, 16 measures, you might think, "I could do better than that". Give it a try. Use 
CTRL+Drag to select the region that you are punching in, and record it again. Maybe your 
second attempt isn't even as good as the previous. No problem. Use the Undo command, and 
you're back to your first take. You can go back and forth between multiple takes this way, with 
Undo and Redo. However, be aware that if you return to a previous recording take, and then edit it 
in any way, then all subsequent takes will be discarded, given the way that Undo works.

6. Record your performance without using the metronome, and then use the Rebar 
feature to adjust the barlines and correctly notate the intended rhythms and 
durations.

Beginning with version 2.6, Composer gives you the flexibility to record notes using a MIDI 
instrument without using a metronome. You can use this feature if you have a lot of tempo changes 
that you want to preserve in the performance of the piece. Go ahead and record your performance, 
and then use the Rebar feature to adjust the barlines, and resulting notation, according to the 
beats or pulses of the performance. The tempo changes of your performance will be preserved, 
and you will have correctly notated rhythms and durations for your score. You can still use the 
various editing capabilities of Composer to fine-tune the performance and/or the notation if 
needed when you finish using the Rebar feature to adjust the barlines.

5.3.3.2 Adding Notes Using Step-Time Recording Mode

If you have a music keyboard or other MIDI input device, you can add notes using the Step-Time 
Recording Mode. Point the mouse at the measure and beat location, and then play the note or chord 
on your music keyboard. Composer will add the note or chord, and then automatically advance to the 
next location ready for you to play another note or chord.

This Step-Time Recording method differs from real-time recording in that you can enter notes at your 
own pace, without having to play accurate rhythms. The individual loudness of each note you record in 
Step-Time Recording Mode will be saved along with the pitch, and will be faithfully performed by 
Composer with the same degree of loudness during playback. The actually played duration of the 
note, however, will be determined by Composer according to the Note Duration Adjustment Table.

The following procedure describes how to use the Step-Time Recording Mode while using the Note 
Duration palette or keyboard shortcuts to select to-be-added note durations. You can also use the 
Step-Time Recording Mode in conjunction with the Sequential Note Entry Mode. When you use these 
two methods of note entry together, you can enter notes from you music keyboard, with different note 
durations, with relatively little use of your mouse and computer keyboard. For details, see the next 
topic Using Step-Time Recording and Sequential Note Entry Modes Together.

To add a note or chord using your music keyboard, at your own pace:

1. Click the Step-Time Record button in the toolbar:

   ![Step-Time Record button](image)
-- OR --

Type R + Enter. That is, while holding down the "R" key, hit the ENTER key. Composer will automatically display the Note Palette if it is not already displayed.

2. Choose the note duration from the Note Palette.
-- OR --

Type the one or more note duration commands, such as "41d" for a dotted quarter note.

The red to-be-added note cursor will show the note duration that will be added, as illustrated in the next step.

3. Move the mouse cursor to the measure and beat where you want to add a note or chord from your music keyboard, such as in this example:

![Musical notation example]

It does not matter where the mouse is located vertically on the staff, because the pitch of the new note(s) will be determined by what you play on the music keyboard. What does matter is that you move the mouse the measure and beat where you want the note(s) to be added.

5. Play the note or chord on your music keyboard.

Composer adds the note or chord you have played, and automatically advances the mouse to the location that marks the end of the note's or chord's duration. For example, if you play an F-major chord in the above example, it will be added with an eighth note duration. The mouse will automatically be moved to the eighth note rest following the newly added chord:

![Musical notation example]

6. You can continue playing notes and chords. They will be added sequentially in the score. You do not have to manually move the cursor to the new location. Composer will have already moved the cursor for you.

For example, having just played the F chord, you can play a Bb chord, and it will be added, as shown below:

![Musical notation example]

7. At any time you can change the duration of the next note or chord that you are about to add. Just select the new duration from the Note Palette, or type the keyboard command for the duration.

5.3.3.3 Using Step-Time Recording and Sequential Note Entry Modes Together

Composer's Step-Time Recording feature enables you to enter notes from your music keyboard at your own pace, without having to keep a rhythm.

Composer's Sequential Note Entry Mode enables you to quickly enter sequences of notes with varying durations. In this mode, you do not have to specify a note duration value in the Note Duration
Palette, or type a note duration shortcut, such as "4", before you add a note with a different duration than the previous.

Both the Step-Time Recording and Sequential Note Entry Mode features alone are quite useful. They can also be used together!

There is an extra benefit in using the Step-Time Recording and Sequential Note Entry Modes together. As you enter notes or chords from your music keyboard, Composer will remember the duration of the most recently entered note, and will advance the cursor by that amount for the next to-be-added note. This is quite convenient for adding, for example, runs of eighth notes or sixteenth notes.

When the run of same-duration notes is broken by a different note duration value, you can either move the mouse to the position of the next note, or you can use the or key to move the cursor one or more positions in the Beat Ruler.

The following exercise illustrates how this works.

To practice using the Step-Time Recording and Sequential Note Entry Modes together:

1. Click the Step-Time Record button in the toolbar:

   ![Step-Time Record button](image)

   -- OR --

   Type S + Enter. That is, while holding down the "S" key, hit the ENTER key. Composer will automatically display the Note Duration Palette if it is not already displayed.

2. Click the Sequential Note Entry button in the Note Duration Palette.

   ![Click this button to enter the Sequential Note Entry Method](image)

   The palette will then change to the Beat Ruler Palette, and the Sequential Note Entry button will be shown in the "down" position:
3. With the mouse, move the red to-be-added note to the measure and beat where you want to add the first note or chord. It does not matter where you place the to-be-added note vertically, because the pitch(es) of the new note (chord) will be determined by what you play at your music keyboard.

4. Play a note or chord at your music keyboard. Composer will add the note or chord at the location where the red to-be-added note cursor was located.

At this point, the red to-be-added note cursor will not automatically advance, because there is no previous note for Composer to determine what the duration for the anticipated sequence of same-duration notes should be.

5. With the mouse, move the red to-be-added note cursor to the position of the next note.

-- OR --

Hit the key one or more times. The red to-be-added note cursor will advance one Beat Ruler mark per each click. You can also use the key to move the cursor to the left.

6. Play the second note or chord at your music keyboard. As always in Step-Time Record Mode, Composer will add your newly played note or chord to the location where the note cursor is located.

The duration of the first note (chord) ends at the location of the newly added note.

The red to-be-added note cursor automatically advances by the same amount as the duration of the previous note, which is a quarter note in this example.

7. Play the third note or chord at your music keyboard. Notice how the cursor advances one quarter note at a time.
8. Now, prepare to add the fourth note one 8th note after the third note. You can do this by moving the mouse cursor to the proper location. But you will likely find it easier to simply hit the key. That moves the red to-be-added note cursor back one Beat Ruler position. In this example, the Beat Ruler marks occur every eighth note. You can optionally specify a different Beat Ruler resolution.

Here is what the example looks like after you have hit the key once:

8. Play the fourth note or chord at your music keyboard. Because the newly added note is one eighth note after the third note, Composer automatically changes the duration of the third note to an eighth note. Also, the red to-be-added note cursor advances by an eighth note rather than a quarter note, because the previous note is an eighth note.

9. Play two more notes. The result will look like this:

10. To make the last note an eighth note, ending at the first barline, use the Cut Duration Tool.

- Click the Cut Duration Tool button in the Beat Ruler Palette.
Type "cut".

The mouse cursor will change to a razor shape.

With the mouse, move the razor to the beginning of the second measure:

Click the mouse to cut the duration of the previous note:

That ends the exercise. Now just play around some, adding sequences of notes from your music keyboard with the same durations as well as differing durations. In a short time you will likely find this to be an efficient and fun way to enter notes.

5.4 Selecting, Editing and Deleting Notes

Composer offers convenient tools for editing the many details of notes in a score.

This section is organized as follows:

- Alternative Methods for Selecting Notes
- Selecting Notes and Advancing to the Next (or Previous) Note
- Automatically Playing Notes When Selected
- Deleting Notes
- Removing Silent Notes
- Editing Note Pitch
- 8va Octaves
- Editing Accidentals (Sharp, Flat, etc.)
- Editing the Rhythms of Notes
  - Editing Note Location (Attack)
  - Editing Note Duration
  - Editing Triplets and Quintuplets
  - Editing Swing Notation
- Editing Accent Marks
5.4.1 Alternative Methods for Selecting Notes

Notes are the most important element in a music score. Much of your work on a score will involve selecting and editing notes. Composer offers several ways that you can select notes.

To select a single note:
- In Select Mode, click the note with the mouse, or drag over it with the mouse.

To select several adjacent notes:
- Drag the mouse over the notes.
- OR —
- Add one or more new notes to the list of already selected notes by holding down the SHIFT key and clicking that note, or dragging the mouse over that note.

To select all of the notes across a range of locations in one or more adjacent staves, using CTRL+drag:
1. Enter Select Mode.
2. While holding down the CTRL key, drag the mouse over the range of locations and staves. The selected region will be highlighted with a blue background, as illustrated here:

![Highlighted Region](image)

(a)

If the Note Palette is already active, the notes will be automatically selected and highlighted in blue, as illustrated here:

![Highlighted Region](image)

(b)

3. If the Note Palette is not already active, then click the Notes and Rest palette tab. The notes will then be automatically selected and highlighted in blue, as illustrated in (b) above.

To select all of the notes in a staff (or multiple staves):

1. Enter Select Mode.
2. Among the four staff control buttons, click the Select Staff button.

The entire staff will be highlighted with a blue background to indicate the selection of staff as a region.

To select additional staves, hold down the Shift button while clicking the Select Staff button. This action selects all of the staves from the previous selection down (or up) through the staff you just selected.
3. If the Note Palette is not already active, then click the Notes and Rest palette tab.

To select all of the notes in the entire song:
1. Enter Select Mode.
2. Choose the Select All command in the Region menu.
   All of the measures in all of the staves will be highlighted with a blue background.
3. If the Note Palette is not already active, then click the Notes and Rest palette tab.

To select a range of notes in one or more adjacent staves, by specifying the range and staves in a dialog box:
1. Enter Select Mode.
2. Choose the Select Region command in the Region menu.
   Composer will present the Select Region dialog.
3. In the Select Region dialog box, specify the start and end measures and beats of the range, and specify the first and last of the adjacent staves.
4. Click the OK button in the Select Region dialog.
   The selected range of locations and staves will be highlighted with a gray background.
5. If the Note Palette is not already active, then click the Notes and Rest palette tab.

You can also select notes in a range of measures and beats, and range of staves, according to these selection criteria:

- all of the top melody notes in the selected staff
- the accompaniment notes in the selected staff, that is, all of notes except the top melody notes
- upper or lower voice notes
- notes with specified accent marks, such as staccato or tenuto

To select notes in a range of measures and beats, and range of staves, according to various selection criteria (melody, accompaniment, voice, or accent mark):

- In the Region menu, choose the command Filter Notes According to Selection Criteria, as described in the topic Filtering Notes Based on Notation.

5.4.2 Selecting Notes and Advancing to the Next or Previous Note

In Select Mode, once you have selected a note, chord, or rest, you can advance the selection to the next (or previous) note, chord, or rest in the same staff by using a keystroke instead of a mouse click. Or, you can select another note above or below in the same chord.

Also, in Add Mode, if you are entering notes on top of existing notes, you can advance the selection from the most recently added note to the next note that follows it.

To advance the selection to the note, chord or rest at the next or previous measure-beat location:

- Use the key to advance to the next note, chord or rest. Use the key to go back to the previous note, chord or rest.
  Composer automatically turns pages as necessary to advance to the next or previous chord or rest.

To advance the selection to the next higher or lower pitched note in the same chord:

- Use the or to select the next higher or lower pitched note in the same chord.
If there are upper and lower voice chords at the same location in the staff, Composer advances forward from the upper voice to the lower voice, and backward from the lower voice to the upper voice.

By default, Composer plays the newly selected note or chord, using the instrument sound and loudness (MIDI velocity) that would be used for the note or chord during normal song playback. You can optionally turn off the **automatic playing of notes when selected**.

### 5.4.3 Automatically Playing Notes When Selected

As you add and change notes, you may find it useful to hear the note pitches. By default, Composer plays a newly selected note or chord, using the instrument sound and loudness (MIDI velocity) that would be used for the note or chord during normal song playback. You can turn off this option so that newly selected notes and chords are not automatically played.

- To turn on or off the option to automatically play notes when they are selected:
  - Toggle the Play Notes When Selected option in the "Perform" or "Edit" menu.

### 5.4.4 Deleting Notes

The procedure for deleting notes is natural.

- To delete one or more selected notes:
  1. Select the note(s), as described in Alternative Methods for Selecting Notes.
  2. Hit the `Del` key.

### 5.4.5 Removing Silent Notes

You can select and delete specific notes. Also, if you have recorded a performance at your music keyboard and accidentally played some extra notes very softly, or with very short durations, you can readily remove all of them with one command.

- To remove very soft or short notes:
  1. Enter **Select Mode**.
  2. Select a group of notes with the mouse. The group may include both notes that will be removed and notes that will not be removed.
     - OR --
     - **Select a region of the score**.
  3. Choose the Remove Silent Notes command in the Note menu or Region menu.
     - OR --
     - Type "rsn" for Remove Silent Notes.
Composer will display the Remove Silent Notes dialog box:

4. You can remove silent notes based on whether they are very short and/or very soft. Set a check mark for either or both of the options. Specify the threshold values for note length and loudness. By default, Composer will initially offer the values you most recently specified in this dialog box.

5. Click the OK button.

6. If Composer removes either fewer or more notes than you desire, then use the Undo command and try the Remove Silent Notes command again with a different threshold note duration and/or loudness.

5.4.6 **Editing Note Pitch**

When you add a new note with a mouse click, its pitch is determined by the vertical position of the mouse on the staff, and the key signature of the measure. If you hold the mouse button down and drag the mouse vertically up and down on the staff, Composer will play the pitches. You can release the mouse when you hear the pitch you want. For details, see Determining the Pitch of a New Note. You can also drag the pitch of an existing note with the mouse.

Composer also lets you easily raise or lower the pitches of existing notes.

To raise (or lower) the pitch of one or more note by one or more half-steps using the computer keyboard:

1. Enter **Select Mode**.

2. **Select one or more notes** by clicking or dragging the mouse cursor over them. (To select all the notes in a staff, you can click the Staff Select button for that staff. Then in the Region menu, select the “Convert Region to a selection of notes” command.)

3. Type the NumPad or key one or more times to raise or lower the pitch one half-step at a time.
   - OR -
   Type P+ (or P+) one or more times to raise (or lower) the pitch by that many half-steps. Composer will play the pitches of the notes as you raise or lower them, unless you have turned off this feature.
   - OR -
   While holding down the left mouse button, select the note and drag it up or down. If this does not work, be sure that the option for Enable Dragging of Note Pitches is selected in the Note menu.

To raise (or lower) the pitch of one or more notes by an octave:

- Hold down the SHIFT key as you type the NumPad or key.
You can also change the pitch of a note by **adding or removing an accidental**\(^{30}\), as described in the next topic.

### 5.4.7 8va Octaves

When a series of notes are too far above the top staff line, or far below the bottom staff line, they are difficult for a performing musician to read. The **8va**, **8va bassa**, and **15ma** symbols shift the annotated pitches by one or two octaves, to bring the notes into the easier reading range of the staff lines:

- **The 8va symbol** transposes the notes down one octave. The notes you see in the score will be performed and heard an octave higher, as illustrated below:

  ![8va Example](image)

- **The 8va bassa symbol** transposes the notes up one octave. It is usually used in the bass clef to bring very low notes up an octave higher in the staff.

- **The 15ma symbol** transposes the notes down two octaves. It is used for extremely high notes.

The following procedures describe how to:

- Add an **8va**, **8va bassa**, or **15ma** symbol.
- Change the range of measures and beats over which the symbol spans.
- Delete the symbol.
- Add notes within the span of the **8va**, **8va bassa**, or **15ma** symbol.

**To add an 8va, 8va bassa, or 15ma symbol:**

1. With the mouse, navigate to the Octave Palette, in either of the two ways shown below:

   ![Octave Palette](image)

   -- OR --

   Type `SHIFT+O`. If Composer displays the Ornament Palette first, then type `SHIFT+O` a second time for the Octave Palette.

   Composer will automatically enter **Add Mode**\(^{31}\), and the mouse cursor will change to this shape: \(\bigcirc\)
2. In the Octave Palette or menu, or with a keyboard shortcut, select the type of octave transposition you want:

- Click the \( \text{\textsuperscript{8}va} \) button, or type "\( 8\text{va} \)", to add the \( \text{\textsuperscript{8}va} \) symbol and transpose the as-notated notes down an octave.
- Click the \( \text{\textsuperscript{8}vb} \) button, or type "\( 8\text{vb} \)", to add the \( \text{\textsuperscript{8}vb} \) symbol and transpose the as-notated notes up an octave.
- Click the \( \text{\textsuperscript{15}ma} \) button, or type "\( 15\text{ma} \)", to add the \( \text{\textsuperscript{15}ma} \) symbol and transpose the as-notated notes up two octaves.

3. Click the mouse, but do not yet release the button, and point the mouse at the first to-be transposed note.

Composer will initially add the symbol, starting at the location where you clicked the mouse, and ending at the barline for that measure. Notice how the notes up to the end of the current measure are already transposed. The octave symbol will be highlighted in blue. You can use the red handles at the start and end of the symbol to change the starting and ending locations of the symbol.

4. While still holding down the mouse button, drag the handle to the end of the range of notes that you wish to transpose. The newly selected notes will not be transposed until you release the mouse button.

5. Release the mouse button. This completes the adding of the octave symbol and the as-notated transposition of the underlying notes. The as-heard playback pitches will remain unchanged.

To change the range of measures and beats over which the symbol spans:

1. In Select Mode, click anywhere on the octave symbol.

Composer will highlight the selected symbol in the color blue, and will display a pair of red handles at the start and end of the symbol, as illustrated in the above examples.

2. Click one of the two red handles while holding down the mouse button, and drag it to the right or left, to change the starting or ending location of the octave symbol. Release the mouse button.

-- OR --
To move the start or end of the symbol one measure to the right or left, click one of the following buttons, or type one of the keyboard shortcuts:

- Click the button, or type $S+$, to move the start of the octave symbol one measure to the left.
- Click the button, or type $S+$, to move the start of the octave symbol one measure to the right.
- Click the button, or type $E+$, to move the end of the octave symbol one measure to the right.
- Click the button, or type $E+$, to move the end of the octave symbol one measure to the left.

To delete an octave symbol:

1. In Select Mode, click anywhere on the octave symbol.
2. Hit the key.

Composer will remove the symbol, and the underlying notes will return to their original un-transposed locations in the staff.

To add notes within the span of the $8\text{va}$, $8\text{va bassa}$, or $15\text{ma}$ symbol:

- If you are adding the notes with the mouse, then add them as you normally would. The newly added note will be placed at the vertical staff location where you click the mouse. The as-heard pitch for the newly added note will be transposed according to the type of octave symbol.
- If you are using the Step-Time Recording Method of entering notes, then play the notes at your keyboard at the as-heard pitch you want for the notes.

### 5.4.8 Editing Note Accidental (Sharp, Flat, etc.)

You can change the pitch of a note by adding or removing an accidental. You can also change the enharmonic spelling of a note, such as from C# to Db, which raises or lowers the position of the note on the staff by a half-space, but leaves the pitch unchanged.

Composer automatically determines the spellings of notes, based on the key signature and surrounding harmony. Composer usually makes the correct decision about the enharmonic spelling of a note as, for example, Db versus C#. In some cases, however, Composer may make a mistake, or you may have a different opinion about the correct spelling. In such cases, you can override Composer’s choice of spelling, as described in the second procedure below.

**TIP:** When you change the pitches of notes, we recommend that you let Composer make a first guess at the spelling. For example, if you want to raise the pitch of a note by a half-step, then select the note and hit the $P+$ keys. Try this instead of, for example, dragging the note to the staff position above and explicitly inserting a flat accidental. Why? If you explicitly add the flat accidental, Composer will rigidly preserve that spelling of the note with a flat accidental. Even if you radically change the surrounding notes to sharps, this note will continue to be spelled with a flat, probably incorrectly, rather than with a sharp at the next lower staff line.

To change the accidental and corresponding pitch of a note:

1. Enter Select Mode.
2. Select the note by clicking it with the mouse.
3. Choose one of the accidentals in the Accidental submenu of the Note menu.  
-- OR --  
Type one of the following commands, which is easier than using the Note menu:

<table>
<thead>
<tr>
<th>Keyboard Command</th>
<th>Accidental</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ss&quot; or &quot;#&quot;</td>
<td>sharp</td>
</tr>
<tr>
<td>&quot;f&quot; or &quot;b&quot;</td>
<td>flat</td>
</tr>
<tr>
<td>&quot;na&quot;</td>
<td>no accidental</td>
</tr>
<tr>
<td>&quot;ds&quot; or &quot;d#&quot; or &quot;x&quot;</td>
<td>double sharp</td>
</tr>
<tr>
<td>&quot;df&quot; or &quot;db&quot;</td>
<td>double flat</td>
</tr>
</tbody>
</table>

To change the enharmonic spelling of a note:
1. Enter Select Mode.
2. Select the note by clicking it with the mouse.
3. In the Enharmonic Spelling submenu of the Note menu, choose the Raise or Lower command.  
-- OR --  
Type E+↑ (or E+↓) to raise (or lower) the enharmonic ("E") spelling. To "raise" the enharmonic spelling means to "move the note up one step on the staff". For example, Db is the raised enharmonic spelling for C#, because D is one step higher on the staff than C.

The following table illustrates the Raise and Lower Enharmonic Spelling commands:

<table>
<thead>
<tr>
<th>Original Spelling</th>
<th>Raise Enharmonic Spelling</th>
<th>Lower Enharmonic Spelling</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Db</td>
<td>B#</td>
</tr>
<tr>
<td>C#</td>
<td>Db</td>
<td>B##</td>
</tr>
<tr>
<td>Db</td>
<td>not available</td>
<td>C#</td>
</tr>
<tr>
<td>D#</td>
<td>Eb</td>
<td>not available</td>
</tr>
<tr>
<td>F</td>
<td>Gbb</td>
<td>E#</td>
</tr>
</tbody>
</table>
A "courtesy accidental" is an accidental that does not need to be displayed because it is already implied by the key signature or a preceding identical accidental in the same measure. The courtesy accidental is displayed to help the performer avoid possibly overlooking the accidental, or to assure the performer that the accidental is intended by the composer. A courtesy accidental is displayed in parentheses, as illustrated below:

![Notation Composer 3 User Guide](image)

To add a courtesy accidental:
1. Select the note for which you wish to add the courtesy accidental.
2. Type the parenthesis character '('.

   -- OR --

   Type "ca" for courtesy accidental.

   Composer will add the implied accidental with parentheses around it, as illustrated above.

To remove a courtesy accidental:
1. Select the note that has a courtesy accidental (with parentheses around it).
2. Type "rc" for remove courtesy accidental.

5.4.9 Editing the Rhythms of Notes

With Composer, you can edit the rhythms of notes, as displayed in the score, independently of how they are actually performed during playback. This way, you can preserve the "feeling" of your original live recording of the notes, or of the originally imported MIDI file. Alternatively, you can also choose to change the performance so that it exactly matches, or closely matches, the notation. Thus, Composer offers you a high degree of control over both the notation and the performance of notes.

Using the Piano Roll Notation option, you can explicitly:

- edit just the notated locations and duration of notes
- edit just the performed attacks and releases of notes
- edit both the notated and performed locations and durations of notes (this is the default setting)

The topics that follow describe procedures for editing the location and duration of notes:

- **Editing Note Location (Attack)**
- **Editing Note Duration**
- **Editing Triplets and Quintuplets**
- **Editing Swing Notation**
- **Combining Separate Notes into Chords**
5.4.9.1 Editing Note Location (Attack)

You can move the location of a note to the right or left. When you move the note, you can preserve the note's duration ("note value"), or you can move the attack of the note independently of its release (where the note ends). You can also move the attack location of multiple selected notes with a single command.

To move (shift) a note to the right or left without changing its duration:

1. Enter Select Mode
2. Select the note by clicking it with the mouse.
3. While holding down the SHIFT key (for "shifting" the note), press the or key to shift the note to the left or right.

For example, here is a quarter note before it is shifted to the right:

Here is the quarter note after it is shifted to the right:

To move the attack of the note, while leaving the release of the note unchanged:

- Type A+ to move the note attack to the right, and A+ key to move the note attack to the left.

The amount that Composer moves the note attack to the right or left depends on the context of the note. If there are no other notes nearby in the same staff, nor any other staff, then the attack will be moved by a sixteenth note beat. If the note is a member of a triplet or quintuplet, then the attack will be moved to an adjacent tuplet member position. If there is another note or rest, in the same staff or other staves, that lies closer than one sixteenth away from the current note's location, then the note's location will be moved to the same location of that other note or rest. This is illustrated in the following example.

The quarter note in the middle of the measure is selected with a mouse click:

In each of the subsequent pictures, the keys A+ have been used to move the attack one position at a time. The attack position moves 16th beat at a time until the note is adjacent to the 32nd rest. Then it moves by just a 32nd beat rather than a 16th beat:
To move the as-notated attack location only, while ensuring that the as-performed attack remains unchanged:

1. Enter Select Mode.
2. Click the Piano Roll tab in the main palette.
   -- OR --
   Type SHIFT+Y.
Composer will display the Piano Roll Palette:

3. Click the Edit As-Notated Only button.
   -- OR --
   Type "en" for edit notation only.

Now the piano roll rectangles will be white to indicate that the performed timings are temporarily locked, as illustrated in the next picture.

4. Select the note by clicking it with the mouse.
5. Type A+ or A+ key to move the as-notated attack to the left or right.
5.4.9.2 Editing Note Duration

The procedures below describe how to change the duration of a note by directly editing the note. You can also change the duration of a note by deleting the rest after it, or by dropping a rest on top of the start or end of the note. See Deleting Rests to Extend the Durations of Previous Notes and Using Rests to Erase Notes.

To change the duration of a note:

1. Enter Select Mode.
2. Select the note by clicking it with the mouse.
   
Composer will display the Note Palette:

4. Use the buttons in the Note Palette to change the duration of the selected note. For an explanation of the Note Duration Palette, see Selecting the Note Duration.
   
-- OR --

Type the equivalent keyboard commands for the buttons, such as "81d" for dotted eighth note.

-- OR --

Type D+ or D+ key one or more times to increase or decrease the duration of the note.

The procedure for changing the duration with D+ and D+ is similar to that for changing the attack location of a note with A+ and A+. The amount by which Composer increases or decreases the duration depends on the context of the note. If there are no other notes nearby in the same staff, nor any other staff, then the duration will be increased or decreased by one sixteenth (of a
whole note). If the note is not a member of a triplet or quintuplet, and if the original duration is not a multiple of a sixteenth note, then the duration will be rounded up or down to the nearest multiple of a sixteenth note. If the note is a member of a triplet or quintuplet, then the duration will be changed so that it aligns with an adjacent tuplet member position. If in the same staff or other staves there is another note or rest which lies closer than one sixteenth away from the current note’s as-notated release (end of note), then the note’s duration will be changed so that it ends where the nearby note or rest begins. This is illustrated in the following example. It is not really necessary for you to know all of these details. Try using D+ and D+ and you will quickly get a feel for how it works.

The quarter note is selected with a mouse click:

---

In each of the subsequent pictures below, the keys D+ have been used to increase the duration. The duration increases by one sixteenth at a time until the note ends at the 32nd note. Then the next D+ command extends the duration by only a 32nd beat rather than the normal sixteenth beat, so that the duration ends at the start of the next 32nd note.

---

By default, the as-performed duration of the changed note will be slightly less than the as-notated duration. The result of this is that sequential notes will play in a legato style, that is, with almost no gaps between them. Sometimes this is not what you will want. You may want a more crisp sound, with brief gaps of silence between them. You can individually adjust the as-performed duration of each note or of several selected notes at a time. Composer also enables you to set a default as-performed duration corresponding to each standard note size, so that whenever you add a note, its as-performed duration will automatically be adjusted. For example, you can set the as-performed duration of a quarter note to be the equivalent, of, say a dotted eighth note. For details, see Saving and Applying Note Duration Adjustments.

You also have the option to change the as-notated duration without changing the as-performed (heard) length of the note.

To change the as-notated duration, while ensuring that the as-performed duration remains unchanged:

1. Enter Select Mode.
2. Click the Piano Roll tab in the main palette.
   -- OR --
Type \texttt{SHIFT+Y}.

Composer will display the Piano Roll Palette:

3. Click the Edit As-Notated Only button.

\texttt{-- OR --}

Type "en" for edit notation only.

Now the piano roll rectangles will be white to indicate that the performed timings are temporarily locked, as illustrated in the next picture.

4. \texttt{Select the note} by clicking it with the mouse.

5. Type D+ or D+ key to make the as-notated duration shorter or longer.

The result of this last procedure is illustrated below:
5.4.9.3 Editing Triples and Quintuplets

Composer automatically recognizes triplets and quintuplets as it transcribes a MIDI file to notation, and also as you record live from your music keyboard. Composer also recognizes irregular triplets, such as with missing members. If Composer incorrectly detects a triplet or quintuplet, you can convert regular notes to the tuplet, or convert the tuplet notes to regular notes.

You can manually add triplets and quintuplets to a score using the note duration palette or equivalent keyboard commands. With a single command, you can convert non-tuplet groups of notes to triplets or quintuplets, or vise versa. You can combine adjacent two triplets or quintuplets of the same size into a single tuplet, or split a single tuplet into two equal, smaller tuplets.

The procedures for all of the above tasks are described in this topic.

To add triplet or quintuplet notes to a score:

1. Enter Add Mode
2. If you want to begin the tuplet with a note rather than a rest, then type SHIFT+N to display the Note Palette:
   ![Note Palette]
   If you want to begin the tuplet with a rest, then type SHIFT+R to display the Rest Palette:
   ![Rest Palette]
3. Select the round note or rest duration that represents the basic member of the tuplet, before choosing the tuplet type (triplet or quintuplet). For example, if you are adding eighth note triplet members, click the eighth note button first.
4. Click the triplet or quintuplet tuplet, after choosing the round note value: or -- OR --
   If you are adding the first note of a swing rhythm, such as this:
   ![Swing Example]
   then click the swing button. The rest of the swing rhythm procedure is described in Editing Swing Notation.
After you click the \( \frac{\text{r}^3\text{n}}{\text{r}^5\text{n}} \) button, the resolution of the Beat Ruler will temporarily change to the size of the tuplet member that you are adding, as illustrated here:

**Before selecting eighth triplet duration for new notes**

![Before selecting eighth triplet duration for new notes](image1)

**After selecting eighth triplet duration for new notes**

![After selecting eighth triplet duration for new notes](image2)

![When the eighth triplet duration is selected, the Beat Ruler temporarily changes to an eighth triplet resolution.](image3)

5. Click the mouse cursor where you want the tuplet to begin.

**Composer** will add the first note or rest in the tuplet, with additional rests for the remaining members of the tuplet. For example, if you choose an eighth note for the triplet member duration, and add it to the second beat of the measure, it will look like this:

![Example of eighth note added](image4)

If you choose an eighth rest for the triplet member duration, and add it to the beginning of the second beat of the measure, it will look like this:

![Example of eighth rest added](image5)

6. Add other members to the tuplet, taking advantage of the temporary tuplet resolution of the Beat Ruler. The following example such a second member added to the tuplet started above:

![Example of second member added](image6)

7. The notes in the tuplet do not have to be the exact duration of a tuplet member. From the note or Rest Palette, choose other note durations as desired.

For example, to add a sixteenth note after the eighth note member of the triplet, click the sixteenth note button in the Note Palette, and then the triplet button.
NOTE: Whenever you choose a different "round" note duration, the tuplet value automatically resets to "no tuplet", as indicated by the button.

Move the mouse cursor to the location where you want this note to be added:

When you click the mouse, the result will be:

To change the duration of a note in a triplet or quintuplet:

Follow the same procedure as for changing the duration of a non-tuplet note, as summarized here.

1. Enter Select Mode.
2. Select the note by clicking it.
3. Type SHIFT+N to display the note duration palette.
4. Click a duration and/or dotted note value in the Note Palette.
   -- OR --
   Type an equivalent keyboard command, such as "16" to change the note to a sixteenth duration in the tuplet.
   -- OR --
   While holding down the "D" key, hit the or key to increase or decrease the duration.

To convert non-tuplet notes to triplets or quintuplets:

1. Enter Select Mode.
2. Select the notes and rests that should be converted to a triplet or quintuplet group, as illustrated:
3. Type SHIFT+N to display the note duration palette.
4. Click the triplet or quintuplet button in the note duration palette.
   -- OR --
   Type "33" for triplet, or "55" for quintuplet.
Using the above example, if you convert the selected notes to a triplet, the result will be:

\[
\begin{array}{c}
\text{\textbf{3}} \\
\end{array}
\]

If the underlying performance of the notes is closer to an even triplet, Composer will convert the non-triplet members to this:

\[
\begin{array}{c}
\text{\textbf{3}} \\
\end{array}
\]

You can also convert the rhythm the other way, from a triplet or quintuplet to non-tuplet rhythm, as described next.

To convert a triplet or quintuplet to non-tuplet note durations:

1. Enter Select Mode.
2. Select at least one note or rest, but not necessarily all members, of the tuplet.
3. Type SHIFT+N to display the note duration palette.
4. Click the no-tuplet button.

-- OR --

Type "00" for no tuplet.

Composer will convert all of the members of the tuplet to the simplest rhythm of non-tuplet durations that most closely matches the tuplet rhythm.

To combine adjacent tuplets of the same size into one larger tuplet:

1. Enter Select Mode.
2. Drag the mouse over some, but not necessarily all, of the notes or rests in both tuplets, to select them. For example:

\[
\begin{array}{c}
\text{\textbf{3}} \\
\text{\textbf{3}} \\
\end{array}
\]

Note that the two sets of tuplets to be joined must span across a natural beat or sub-beat in the meter of the measure, rather than straddle a beat or sub-beat.

3. Choose the Join Pair of Triplets or Quintuplets command in the Triplets and Quintuplets submenu Note menu.

-- OR --

Type "jt" for join tuplet.

In this example, the result will be:
4. To beam the notes together, type \textbf{SHIFT+B} to display the Beam Palette, and choose the Beam Left and Right option.

\textit{-- OR --}

Type \\\”==\"

The result will be:

\begin{center}
\includegraphics[width=0.5\textwidth]{beam.png}
\end{center}

\textbf{To split a tuplet into two smaller, equal sized tuplets:}

1. Enter \textbf{Select Mode}.

2. Select at least one member of the tuplet, but not necessarily all members of the tuplet. For example:

\begin{center}
\includegraphics[width=0.5\textwidth]{tuplet.png}
\end{center}

3. Choose the Divide Triplet or Quintuplet In Two command in the note menu.

\textit{-- OR --}

Type "dt" for divide tuplet.

In this example, the result will be:

\begin{center}
\includegraphics[width=0.5\textwidth]{tuplet_split.png}
\end{center}

A beam is left between the two tuplets. You can easily remove it, as described in \textbf{Beams}.

\textbf{5.4.9.4 Editing Swing Notation}

A swing rhythm, when literally written out as two unequal members of a triplet, looks like this:

\begin{center}
\includegraphics[width=0.2\textwidth]{swing_lit.png}
\end{center}

In a jazz or "big band" music style, swing rhythms are typically not written out using triplets, such as in the above example. Instead, to simplify the notation, the swing rhythm is notated as though the notes are evenly played, with equal durations. The above as-performed notes are usually notated like this:

\begin{center}
\includegraphics[width=0.2\textwidth]{swing_not.png}
\end{center}

You can prepare a swing that will be heard with a triplet swing, but displayed with paired notes of equal durations.
If you are importing a MIDI file for a jazz or "big band" piece with a swing rhythm, then choose the "Swing Rhythm" transcription option. Composer will automatically notate the swing rhythms as illustrated in the above second example. Similarly, if you are recording swing rhythms at your music keyboard, then choose the "Swing Rhythm" transcription option.

To "write out" a swing rhythm, as in the first of the above two examples:

1. In the Note Duration Palette, select the "round" value of the first member of the swing rhythm by clicking, in this example, the quarter note button.

2. In the Note Duration Palette, click the triplet swing button.
   -- OR --
   Type "3s" for triplet swing.

3. Click the mouse cursor where you want to add the first member of the swing.

4. In the Note Duration Palette, select the "round" value for the second member of the swing rhythm by clicking, in this example the eighth note button.

5. Click the triplet button.
   -- OR --
   Type "33" for triplet.

6. Click the mouse cursor where you want to add the second member of the swing.

To add a swing rhythm that will be performed with the swing, but which will be displayed as a pair of equal duration notes:

1. Add the swing notes using the procedure described above, and then select the swing notes. For example, a section of swing notes might look like this:

2. Click the Piano Roll tab in the main palette.
   -- OR --
   Type SHIFT+Y.

Composer will display the Piano Roll Palette.

3. In the Piano Roll Palette, click the Edit As-Notated Only button.
   -- OR --
   Type "an" for as-notated.

4. Type SHIFT+N to display the Note Duration Palette.
5. Click the No Tuplets \(\text{\textsuperscript{23}}\) button in the Note Duration Palette.

All of the selected swing notes will now be displayed as paired notes of equal durations. The Piano Roll rectangles indicate that the performance of the second note of each pair occurs after its as-notated location. Thus, when the notes are played, you still hear the swing.

5.4.9.5 Combining Separate Notes into Chords

A MIDI file, or a recording of your performance at a MIDI keyboard, will finely specify the exact time at which each note is played. If the notes are played closely together, then Composer will display the notes as a single chord. If one note is played some significant amount of time before another note, then Composer will display that note as a grace note or as a normal note with a short duration, such as a 32nd or 64th note. It is challenging for Composer to determine with 100% accuracy whether notes played nearly together should be notated as separate notes or, alternatively, as a chord. Composer’s rate of accuracy is high, but sometimes it will make a mistake that you will want to correct. Also, you may at the same time want to change the actual performance of the notes so that they are played more closely together.

If Composer has displayed notes with two or more separate attacks, which you want to combine into a single chord, then you can very quickly make the correction. You could manually move the attacks of notes, and adjust the durations of the notes, but an even quicker way to make the correction is to use the Combine Chord command.

To combine separate notes into a chord:

1. Select the notes to be combined into a single chord. The order in which you select the notes is important. The first note you select determines where the location (attack) of the combined chord will be. You can also select a rest, to move the notes to the location of that rest.
2. After selecting the notes (and optional rest), choose the Combine Chord command in the Note menu.

-- OR --

Type "cc" for "combine chord".

If after making using the Combine Chord command you want to correct the performance, so that the notes are played at exactly the same time, then use the Snap to As-Notated command, or type A + % . For more information, see Quantizing the Performance of Notes.

5.4.10 Editing Accent Marks

With Composer you can add a variety of accent marks and other music symbols at noteheads, or at the ends of note stems. You can assign two accents to a single note or chord. You can add accent marks for several selected notes with a single command.

In Composer, the term "accent mark" is defined more generally than the musical definition of accent mark. Composer's term "accent mark" includes other types of annotations that are placed directly above or below notes and chords. These extra annotations include string bowings (up, down) and fermatas.

In Composer, accent marks do not affect the actual performance of the notes. Instead, you can directly edit the performance of the notes exactly as you want the accent marks to be interpreted during playback. For example, if the note has an "->" accent mark that you wish to be interpreted during playback, you can increase the loudness of that note. You can shorten the as-performed duration...
of a note if it has a staccato mark. For a given region, you can filter (select) all of the notes that have a staccato mark, and decrease their as-performed durations in one step.

Composer offers a special option that converts a written-out staccato into a note or chord with a staccato accent mark. For example, this option will convert an eighth note followed by an eighth rest to a quarter note with a staccato mark, or a sixteenth note followed by a dotted eighth rest to a quarter note with a staccato mark. See the procedure at the end of this topic.

To add one accent mark, or two accents, to one or more notes:

1. Enter Select Mode by clicking or dragging the mouse.
2. Type SHIFT+A to show the Accent Palette.
   -- OR --
3. Navigate to the Accent Palette from the top palette as shown:
   4. Click one or two of the accent mark buttons.
      -- OR --
   Type one or two of the equivalent keyboard commands shown above.
      -- OR --
   Select one or two of the accent mark types in the Accent Menu.
Composer will add the accent mark(s) to all of the selected notes.
By default, Composer places accents at the noteheads for notes in single voice and at the stem ends for notes in upper or lower voice. You can override this default.

To force the accent mark to be placed at the notehead or at the stem end:
1. Enter Select Mode. Select the note. Type SHIFT+A to display the accent palette.
2. Choose the Place At Notehead or Place at Stem End command in the Accent Menu.
   -- OR --
   Click the Place At Notehead or Place at Stem End button in the accent palette.
   -- OR --
   Type "n" for placement at the notehead, or "s" for placement at the stem end.

To remove an accent mark from one or more selected notes:
1. Enter Select Mode.
2. Select one or more notes by clicking or dragging the mouse. Then type SHIFT+A to display the accent palette.

The accent palette will show what accent, if any, is associated with the selected notes. If all of the notes have the same accent mark, then the accent mark button shown in a “full on” color. If some, but not all, of the notes have the same accent mark, then the button will be displayed in a “half on” color. The colors will depend on your Color Theme. This is illustrated below:

3. If all of the notes have the accent mark, then click the button once, or type its equivalent keyboard command once. That will toggle the palette button to off, and the accent mark will be removed from all of the notes.

If some, but not all, of the notes have the accent mark, then click the button once. That will add the accent mark to all of the notes. Then click the button a second time. That will remove the accent mark from all of the notes.

To convert a “note plus rest” (staccato performance) to a note or chord with a staccato mark:
1. Select the notes that you want to convert. It does not matter if you also select adjacent rests. Also, it does not matter if you select some notes that should not be converted to staccato notes, because Composer will intelligently determine which notes are staccato notes.

In the following, some notes that will be converted to staccato marks are selected, and some notes that will not be converted are selected. Also, some rests are selected, and some rests are not selected.
2. With the mouse, navigate to the Accent Palette, as described in the first procedure in this topic.
   -- OR --
   Type SHIFT+A.

3. Click the Replace Notes and Rests with staccato button in the Accent palette.
   -- OR --
   Type "r." (the letter "r" followed by a dot/period) for replace with staccato (dot).
   -- OR --
   Choose the Replace Notes and Rests with staccato command in the Accent Menu.

The result of the command for the above example is:

![Result of command](image)

Notice how a pair of sixteenth notes did not need staccato marks.

5.4.11 Editing Beams

Composer automatically determines how notes are beamed together, but you can change the beams if you disagree with any of Composer’s decisions.

You can add or remove a beam, or change the secondary beam. An example of changing a secondary beam is:

![Example of changing a secondary beam](image)

You can specify the beaming pattern for many measures at a time, if they share a common meter. For example, in a 4:4: meter, eighth notes are normally beamed together as four pairs of two eighth notes each. You can change this so that for every measure, eighth notes are beamed together in two groups of four eighth notes each. Instead of individually changing the beaming of eighth notes in every measure, you can change the beaming of notes in all of the measures in one step. The procedure for doing this is described at the end of this topic.

To add a beam from one note to the next:

1. Enter Select Mode.
2. Select the first of the two notes by clicking it with the mouse. For example:

3. Type SHIFT+B to show the Beam Palette:

4. Click the Beam Right and Left button in the Beam Palette:
choose the beam right and left command in the beam menu.

-- or --

type "==". the two equal sign characters (==) are intended to look like beams on the left and right side of a note stem.

in this example, the result is:

![Diagram of music notation with beams and flags.]

**To remove a beam between two notes:**

1. Enter Select Mode; select one of the notes; and type SHIFT+B to display the Beam Palette.

2. Select the first of the two notes, and click the Beam Right button, or type "r" for "right only".
   -- or --

   Select the second of the two notes, and click the Beam Left button, or type "l" for "left only".

**To remove beams on both sides of a note, so that it is left with only a flag:**

1. Enter Select Mode; select the note; and type SHIFT+B to display the Beam Palette.

2. Click the Flag button to replace the beam(s) with a flag.

**To change the secondary beam between two notes:**

1. Enter Select Mode; select the note; and type SHIFT+B to display the Beam Palette.

2. To remove a secondary beam that extends from the selected note to the next note:
   - Click the button.
   -- or --

   Type "=". the first "=" character suggests two beams; and the second dash "-" suggests one beam.

3. To remove a secondary beam that extends from a previous note to the selected note:
   - Click the button.
   -- or --

   Type "-=".

4. To add a secondary beam among one or more selected notes:
   - Click the button.
   -- or --

   Type "==".

**To restore composer's default choice for beams:**

1. Enter Select Mode; select the note; and type SHIFT+B to display the Beam Palette.
2. Drag the mouse over all of the notes for which you wish to reset the beams.

3. In the Beam Palette, click the `Def` ("default") button.
   
   -- OR --
   
   Choose the Default Beams command in the Beam Menu.

Suppose your song has a 4:4 meter. By default, Composer beams eighth notes in the 4:4 meter as four pairs of two eighth notes each, as illustrated below:

If you want to change the beaming to two groups of four eighth notes per measure, follow the next procedure.

To change the beaming pattern of notes for several measures at a time:

1. Navigate to the Meter Palette.
   
   -- OR --
   
   Type SHIFT + M.

2. Select a range of measures for which you wish to change the pattern of beaming. All of these measures must have the same meter. You can select the measures using the Select Region command in the Region menu. Or, select the range of measures by holding down the CTRL key and dragging the mouse over them. You can extend the range by holding down both the Shift and CTRL keys and clicking in some further measure in the score. It does not matter which staff you choose.

3. Click the meter button in the palette.
Composer will display the Meter dialog box, such as shown here:

4. In the dialog box, change the "From" and "To" measures if the pre-selected measures are not what you want.

5. In the Beam Groups section of the dialog box, enter the pattern for beaming notes in the meter of the selected measures. Enter one to four numbers, each separated by a plus "+" sign. The total of these numbers should add up to the total number of sub-beats in the selected meter. The sub-beat value initially displayed by Composer shows the beam group pattern for the first of the pre-selected measures.

In the above example, the Beam Group pattern "2+2+2+2" of eighth notes indicates that there are four pairs of two eighth notes each, such as was illustrated in the score example before the beginning of this procedure. In this example, if the beaming pattern is changed to "4+4", that is, two groups of four eighth notes each, the notes will be re-beamed as shown here:

5.4.12 Editing Ties

Composer lets you add or remove ties between notes. Composer automatically determines the arc direction, up or down, for ties. However, you can change the tie arc direction if you wish.

Composer also offers a command, Remove Overlaps of Notes, that can eliminate or simplify ties in a selected region of the score.

To add a tie between adjacent notes:

1. Enter Select Mode.

2. Select the first note, as described in Selecting Objects. The end of this first note must coincide with the beginning of the note to which it will be tied.

3. Choose the Tie to Next Note command in the Note menu.
Type "ti" for tie.

-- OR --

Type a dash "-", which suggests the role of a tie.

After the tie has been added, Composer will display the following Tie Palette:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Tie Palette Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>ti or - (dash)</td>
<td>Add tie</td>
</tr>
<tr>
<td>Del</td>
<td>Delete tie</td>
</tr>
<tr>
<td>ct</td>
<td>Collapse tie</td>
</tr>
<tr>
<td>u</td>
<td>Set tie arc up</td>
</tr>
<tr>
<td>d</td>
<td>Set tie arc down</td>
</tr>
<tr>
<td>a</td>
<td>Set tie to automatic (default) arc</td>
</tr>
</tbody>
</table>

You can then use the Tie Palette to change the arc direction of the tie, or delete the tie.

There is also a second way to add a tie:

To add a tie with the "point and click" method:

1. Type SHIFT+T to display the Tie Palette. If the Text Palette is displayed first, type SHIFT+T a second time.

2. Click the Add Tie button.

The mouse cursor will turn to the Add Mode shape:

However, when you move the mouse to a note that can be tied to another note, the shape will temporarily disappear, and a red tie will be displayed between the candidate notes to be tied:

3. Click the mouse to add the tie.

To remove a tie between two notes:

1. Click the mouse on the tie. The tie will be highlighted in blue, and the Tie Palette will be displayed.

2. Click the button in the Tie Palette to delete the tie.

-- OR --

Choose Delete Tie in the Tie Menu.

-- OR --

Hit the key.
To change the arc of a tie to upward or downward:

1. Click the mouse on the tie object.
2. In the Tie Palette, click the or button to change the arc of the tie.
   -- OR --
   Choose the Set Tie Arc Up or Set Tie Arc Down command in the Tie Menu.
   -- OR --
   Type "u" for an upward tie, or "d" for a downward tie.

To restore Composer's default for tie arc directions:

1. Drag the mouse over all of the ties for which you wish to reset the arc directions. The drag must start on some tie object.
2. In the Tie Palette, click the ("automatic") button.
   -- OR --
   Choose the Set Automatic Tie Arc Direction command in the Tie Menu.

To eliminate and simplify ties in a selected region of a score by removing overlaps of notes:

1. Select a region of the score by holding down the CTRL key and the left mouse button, and dragging the mouse.
   -- OR --
   Select a group of notes by holding down the left mouse button and dragging the mouse.
2. Choose the Remove Overlaps of Notes command in the Region menu or Note menu.
   -- OR --
   Type "qro" for Quick Remove Overlaps of Notes.

Another method of accomplishing this "clean up" procedure is the following:

1. Select some tied notes.
2. In the Clean Up Rests and Overlapping Notes sub-menu of the Notes menu, choose the Remove Overlaps of Notes command.
   -- OR --
   Type "ro" for Remove Overlaps of Notes.

**Before removing overlaps of notes:**

```
\( \) \( \) \( \) \( \)
```

**After removing overlaps of notes:**

```
\( \) \( \) \( \)
```
5.4.13 Editing the Note Voice (Stem Direction)

With Composer, the direction of stems attached to notes is determined by the voice of the notes. The term voice has musical meaning. The stem direction indicates the voice according to common music notation practice, as described below.

If a part in the score is for a single instrument or human voice, which can only play or sing one note at a time, then all of the notes in that part are said to have a single voice. If the part is played or sung by two or more individuals, but they all play the same notes, and only one note at a time, then that part is also said to have a single voice. The stem directions for notes in a single voice may be upward or downward. If a note is above the middle staff line, the stem direction is downward; if the note is below the middle staff line, the stem direction is upward.

If a part is for two players, and if the notes they play have different rhythms, then the part is said to be split with upper and lower voices. Upper voice notes always have upward stems, and lower voice notes always have downward stems.

Piano and keyboard parts also indicate upper and lower voices to clarify and simplify the notation of notes simultaneously played with different rhythms. When all of the notes have the same rhythms, they typically use stem direction rules for single voice. These rules for keyboard voice notation are illustrated below:

In Composer, you do not directly edit stem directions. Instead, you indirectly edit them by specifying the voice of notes.

To change the voice (stem direction) of one or more notes:

1. Enter Select Mode.
2. Select one or more notes with the mouse cursor.
3. Type SHIFT+N to display the Note Palette.
   The bottom part of the Note Palette has three buttons for voices:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Note Palette Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>sv</td>
<td>Single voice</td>
</tr>
<tr>
<td>uv</td>
<td>Upper voice</td>
</tr>
<tr>
<td>lv</td>
<td>Lower voice</td>
</tr>
</tbody>
</table>

Composer will indicate the voice(s) of the notes currently selected. If all of the notes have the same voice, then one of the buttons will be displayed in the down position. If the notes have two or more voices, then corresponding buttons will be shown in a half-down position.

4. Click one of the three buttons in the palette to choose the voice.
   -- OR --
Type "sv", "uv" or "lv" for single, upper or lower voice.

-- OR --

In the Voice submenu of the Note menu, choose the Single Voice, Upper Voice, or Lower Voice command.

Composer will change the voice of the selected notes. If you choose upper voice, and some of the selected notes were in a single voice, then Composer will change to lower voice any notes that were not selected but which had pitches below the newly assigned upper voice notes. It will also change to upper voice any notes that were not selected but which had pitches above the newly assigned upper voice notes. Composer will similarly change the voices of adjacent notes if you choose lower voice, and some of the selected notes were in the single voice.

In the following example, a quarter note is accompanied by two eighth notes. In a piano or keyboard part, the quarter note and eighth notes should be separated into upper and lower voices. In preparation, select the quarter note:

Use the Upper Voice command to change the selected quarter note to upper voice. This step will automatically change the accompanying eighth notes to lower voice:

If an upper and lower voice note share the same pitch and attack location, then Composer will automatically share the same notehead for the two voices, provided that there would be no ambiguity in the interpretation of the duration of either the upper or lower voice note. For example:

5.4.14 Editing Drum Notes

Most types of percussion instruments do not have discrete pitches. However, in Composer they have pseudo pitches.

If a staff is specified as a 5-line drum staff, then note drum notes might look something like this:
Each drum instrument has a distinct pseudo pitch.

**NOTE**: Starting in Notation Composer version 2.0, accidentals for pseudo drum pitches are now represented with distinct drum noteheads. The ♯ notehead is for no accidental; the upward pointing triangle ▲ notehead indicates a sharp; and the downward pointing triangle ▼ notehead indicates a flat. For example, the General MIDI pitch for Side Stick is C#, indicated in the above example with the upward pointing triangle ▲ notehead.

Usually, you will not want give a percussionist a drum part with such pseudo pitches. If you have imported a MIDI file with such a percussion staff, then you can use the Split Drums command, to produce individual 1-line staves for each distinct drum instrument, as illustrated here:

![Drum Staff Example](image)

In creating a new drum staff, you have the choice to create either a 5-line staff drum staff with pseudo pitches for multiple drum instruments, or a 1-line drum staff for just a single drum instrument. For details, see Changing the Instrument Sound of a Staff.

If the staff is a 5-line staff, then you add drum notes with the mouse, and assign them the pseudo drum pitches, just like normal note pitches. For example, you can drag the pseudo pitch of a drum note with the mouse, or change it by typing P+ or P+. As you change the pseudo pitch of the drum note, Notation Composer will audit the sound so that you can hear what type of drum instrument is associated with the pseudo pitch.

If the staff is a 1-line drum staff, then it has a specific pseudo pitch that you cannot change by moving the note up or down.

You can enter drum notes via a music keyboard via real-time recording or Step-Time Recording. You can associate various drum instruments with different keys on your music keyboard, independently of the pseudo pitches. This enables you to play the drum notes on your music keyboard using keys that are most convenient for you to play while recording a drum part. For more information, see Managing Drum Note Lists.

For a given 5-line or 1-line drum staff, you can specify what notehead shape will be used for the notes in the staff. By default, the notehead shape is an ♯. You can assign a different notehead shape among these choices: ♯, ♮, ▲, ▼, or ♡. You can also change the notehead shape of individual notes, as described in Editing Notehead Shape.

**5.4.15 Editing Notehead Shape**

For any single-line drum staff, you can specify one of several percussion notehead shapes. The notehead shape is applied to every note in the particular single-line drum staff, except those notes for which you specify a different notehead shape.

You can also assign special note head shapes to individual notes for other instruments.
The most common example of a special notehead shape is the diamond that is used to indicate a
harmonic, which is produced by placing a second finger lightly on a string, a fourth or fifth above
another fingered note on the same string. If the finger is placed a fourth above the lower note, then
the harmonic tone is two octaves above the lower note on the string. If the finger is placed a fifth above the
lower note, then the harmonic tone is an octave and a fifth above the lower note on the string.

To change the notehead shape for a single-line drum instrument to an x, +, ▲, ■, or ◆:
1. Click the Instrument Sound Selection staff control button.
   Composer will display the Staff Setup dialog box.
2. In the bottom left corner of the Staff Setup dialog box, turn off the check mark for Notehead
   Style / Use Default.
3. In the selection box next to the Notehead Style / Use Default option, choose the notehead
   shape.

To change the notehead shape for any note:
1. Enter Select Mode.
2. Select the note by clicking it with the mouse.
3. Navigate to the Notehead Shape Palette, as shown below.
   -- OR --
   Type SHIFT+H.
4. Choose one of the notehead shapes in the palette, or type one of the shortcuts:

   Shortcut
   ●  hn (normal notehead)
   ◆  hd or hh (for diamond or harmonic)
   ▲  ht
   ×  hx
   +  h+  
   □  hs
5.5 Transposing Notes

Composer offers commands for two kinds of transpositions. It is important that you understand the difference between the two types of transposition so that you choose the correct command in Composer.

If we begin with a file that has the following staves in the concert key of C, with Piano (a non-transposing instrument), Alto Saxes (Eb transposing instrument), and Tenor Sax (Bb, minus 1 octave transposing instrument), this is what the score looks like in "heard" key of C, which is the actual pitches that you hear when the instruments all play:

However, for each musician to play the correct heard notes, the saxes must have sheet music that is transposed for their particular instruments. For this type of transposition, you use Staff / Transpose to each instrument's key. Transposing to the Key of an Instrument shows each instrument's notation as the musician would need it to play the piece on their particular instrument, and is shown here:
Notice the key signature of C (no accidentals) for the RH and LH piano "hands" stays the same because the piano is not a transposing instrument. However, the Alto Sax parts and the Tenor sax have been transposed to reflect their notation requirements for their respective "natural tone".

The other kind of transposing changes the concert, or "heard", key of the entire song. Transposing Actual Pitches shifts the actual heard pitches of the notes. Thus, if we start with the same song which is in concert key of C, and use Staff / Transpose Actual Pitches to the concert key of D (two half-steps up, or one whole-step), we would see the concert pitches as shown here:

Notice how - when viewed in "Concert pitch", all staves have the key of D accidentals and the notated (and heard) pitches are raised two-half steps (a whole step) up from the original file (see the first screen shot above).
We can then Transpose the Instrument Keys for this new key-of-D file to give the following Instrument Transpositions for this song file which is now in the "heard" (concert) key of D:

5.5.1 Transposing Actual Pitches

Composer handles two kinds of transpositions. This topic describes how to transpose actual as-performed pitches in a song. If you do not want to change the actual as-performed pitches but, rather, want to change the key in which the pitches are notated, in order to match the key of an instrument, see Transposing to the Key of an Instrument.

When Composer transposes a song, it shifts the pitches of all of the measures in all of the staves up or down by some number of half-steps that you specify except for "drum staff" notes.

Most MIDI files adhere to the General MIDI specification. In the General MIDI specification, channel 10 is reserved for percussion ("drum staff") sounds. Different pitches on MIDI channel 10 produce different types of percussion sounds. To shift the pseudo pitch of a drum sound will entirely change the sound, such as from a Side Stick to an Acoustic Snare. You would not be happy with the results if Composer shifted "pitches" in drum staves. Therefore, Composer does not transpose the pitches of notes assigned to a drum staff. You can specify which MIDI channels produce drum sounds for a given device using the Device Properties command in the MIDI Device Configuration Window.

Normally you do not have to specify which MIDI channels produce drum sounds, because Composer by default assumes that a device adheres to the General MIDI specification.

When Composer transposes pitches, it also transposes the pitches of chord names. For example, if you transpose pitches up two half steps, Composer will change a "C7" chord to "D7". In the case of ambiguous chord root spellings, such as "F#7" versus "Gb7", Composer makes its best guess based on the surrounding harmony. Wherever Composer makes the wrong guess, you can quickly correct the error, as described in Editing Chord Names.

The procedure for transposing pitches is simple.
To transpose pitches for an entire song, or a range of measures in the song:

1. Optionally, select a region with the measures you wish to transpose by dragging the mouse over them while holding down the CTRL key. This will pre-select the measure range in Step 2 of the Transposition Wizard, as described below.

2. Choose the Transpose Actual Pitches command in the Staff menu.

   -- OR --

   Type "qtp" for Quick Transpose Pitches.

Composer will display Step 1 of a two-step Transposition Wizard:

The first step of this two-step wizard is intended to help you make sure that you understand the distinction between the two types of transposition, and have chosen the correct type.

3. Confirm that you intend to transpose actual pitches, and hit the Next button.
Composer will display Step 2 of the Transposition Wizard:

If you selected a range of the score in step #1 of this procedure, then the Range of Measures to Transpose will be pre-selected in the wizard step above.

5. Enter the range of measures for which you wish to transpose notes, if you did not pre-select the range.

6. Enter the number of half steps you wish to shift pitches up or down. There are 12 half steps in an octave. Choose "Up" or "Down".
   -- OR --
   Use the up and down arrows to choose a different number of flats or sharps in the key signature.
   -- OR --
   Choose the new major or minor key for the beginning of the song.

The key signature initially shown in the dialog box will be that at the beginning of the selected range, or at the beginning of the song if you did not pre-select the measures.

7. Click the Finish button.

5.5.2 Transposing to the Key of an Instrument

Composer handles two kinds of transpositions. This topic describes how to change the key in which pitches are notated, in order to match the key of a transposing instrument, without changing the actual as-performed (heard) pitches. If you want to change the actual as-performed pitches, then see Transposing Actual Pitches.

You can switch at any time between showing the conductor score or selected parts in either concert (actual as-heard) pitches or transposed pitches.

In addition to transposing parts, you can independently change key signatures and clefs anywhere within any staff.
When Composer transposes instrument key, it also transposes the pitches of chord names for the separately viewed or printed instrument part. It does this if, but only if: (1) the part has only one staff for the transposing instrument, or (2) all of the staves in the part have the same instrument transposition. For more information, see Transposing Chord Names.

Note that transposing to an instrument key does not affect the pitch of displayed chord names. Chord names almost always are read only by non-transposing instruments, such as the piano, guitar, and autoharp. Therefore, this is not a significant limitation. The reason that Composer does not transpose chord names for instrument transpositions has to do with the complications of ambiguous enharmonic spellings.

To review and change whether the score is currently notated in concert pitch or transposed pitch:

- Open the Staff or Format menu. If there is a check mark by the Show Concert Pitches menu item, then this means that the score is not currently notated using transposed pitches.

- If instead there is a check mark by the Show Instrument Transposed Pitches menu item, then the score is currently notated using as-heard concert pitches, provided that the transposition for each instrument has been previously specified. If you set the check mark for the Show Instrument Transposed Pitches menu item, then you should expect to see different key signatures for transposing instruments. If you do not see the different key signatures, then this means that you will need to specify the transpositions for the instruments, as described in the next procedure.

- To switch between showing concert (non-transposed) pitches and transposed pitches, set a check mark for Show Concert Pitches or Show Instrument Transposed Pitches.

To change the transposition of a staff (instrument part):

1. Choose Transpose Instrument Key command in the Staff menu.

   -- OR --

   Type "qti" for Quick Transpose Instrument.
Composer will display Step 1 of a two-step Transposition Wizard:

**Select Type of Transposition (step 1 of 2)**

There are two types of transpositions. Which type of transposition do you want?

- Transpose Actual Pitches.
  
  Transpose the heard pitches of notes, as well as the notation of the pitches, for all tracks, for a range or measures or for the entire score.

- Transpose Instrument Key.
  
  Transpose the displayed pitches of notes according to the transposing key of an instrument (such as for B-Flat clarinet or octave-transposed guitar), without changing the heard pitches of the notes.

The first step of this two-step wizard is intended to help you make sure that you understand the distinction between the two types of transposition, and have chosen the correct type.

2. Confirm that you intend to transpose instruments and hit the Next button.

Composer will display Step 2 of the Transposition Wizard:

**Transpose Instrument Key (step 2 of 2)**

Enter instrument key transposition for any or all of the staves.

<table>
<thead>
<tr>
<th>Staff (Instrument)</th>
<th>Look Up</th>
<th>Note read as 'C' actually sounds as:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flutes</td>
<td>Look Up</td>
<td>C Below minus 0 octaves</td>
</tr>
<tr>
<td>Oboes</td>
<td>Look Up</td>
<td>C Below minus 0 octaves</td>
</tr>
<tr>
<td>Clarinet Bb</td>
<td>Look Up</td>
<td>Bb Below minus 0 octaves</td>
</tr>
<tr>
<td>Bassoons</td>
<td>Look Up</td>
<td>C Below minus 0 octaves</td>
</tr>
<tr>
<td>Horns F</td>
<td>Look Up</td>
<td>F Below minus 0 octaves</td>
</tr>
<tr>
<td>Trumpets</td>
<td>Look Up</td>
<td>Bb Below minus 0 octaves</td>
</tr>
<tr>
<td>Timpani</td>
<td>Look Up</td>
<td>C Below minus 0 octaves</td>
</tr>
</tbody>
</table>

Click this button to guess transpositions of all of the instruments based on staff names.
3. In the row for the staff you wish to transpose, choose values under the column header "Note read as 'C' actually sounds as." For example, consider a Bb clarinet. When the musician sees a note written as a 'C' in the Bb clarinet part, and plays that note, it will actually sound two half-steps lower, as a Bb. Therefore, the correct entry for the Bb clarinet is "Bb Below plus 0 octaves".

4. If you are not sure what the transposition for a given type of instrument should be, click the Look Up button in the row for its staff. Composer will display a list of orchestra and band instruments that you can select from, as illustrated below:

Composer will pre-select one of the instrument types based on the staff name, but it might make a wrong guess. Confirm or change the instrument type. Then hit the OK button. Composer will then automatically set the values for "Note read as 'C' actually sounds as."

5. Follow the above procedure for one or more instruments.

6. Composer will pre-select the Show Instrument Transposed Pitches option, which is usually what you want if you are specifying instrument transpositions. However, you can optionally toggle this to the Show Concert Pitches option. The option in the dialog box is fully equivalent to the Show Concert Pitches menu item in the Staff menu.

7. Click the Finish button when you are done, or Cancel if you decide not to keep the new transpositions.

To automatically set the instrument transpositions for all of the staves:

1. Follow the same steps #1 through #3 in the previous procedure.

2. Click the Look Up All Instrument Transpositions button. Composer will examine each of the staff names to guess the type of instrument, and will accordingly assign the transposition for each staff. Using the Look Up All Instrument Transposition option is equivalent to accepting the pre-selected Look Up instrument type for each staff.

3. You should review the assigned instrument transpositions, because Composer can make mistakes if the staff names do not correctly match the instrument types. Make corrections to any of the transpositions according to the previous procedure.

4. Click the Finish button when you are done, or Cancel if you decide not to keep the new transpositions.

### 5.6 Doubling and Scaling Note Durations

Sometimes you might open a MIDI file in which the tempo is correct, but the note durations are too short, too difficult to read. You might want to double all of the durations.
For example, you might want to double all of the note durations here:

\[ \text{Note durations} \]

The result will be:

\[ \text{Scaled note durations} \]

Composer's Scale Meter command supports that. More generally, you can scale note values by any common ratio, such as 2-to-1, 1-to-2, 3-to-1, and 1-to-3, or even 3-to-2 and 2-to-3.

To scale note durations:

1. Navigate to the Meter palette, such as by typing SHIFT + M.
2. Choose the Scale Meter command in the Meter menu. It will display a dialog box such as the following:

![Scale Meter dialog box]

3. In the Scale Meter dialog, choose an example 'from' note duration that will be scaled to the 'to' note duration. The above dialog box illustrates the selection you would make for the example at the beginning of this topic.

   Note that all note durations will be scaled proportionally. The meter will not be changed. Therefore, half as many or twice as many (or other ratio of) notes will be displayed in resulting measures.

4. Click the OK button.
5. Composer will open a new copy of your song, without destroying the old copy. The new copy of the song will be saved in a temporary directory on your system. There will be a temporary file name for the song, based on the song title, plus some arbitrary numbers at end of the file name.

   If you are satisfied with the newly scaled song, then save with a new name in a directory of
your choose, using the File Save command. If you wish to save the file with the same name as the original file, then you will first need to close the original file.

5.7 Editing Rests

With Composer, you do not have to do much work to include rests in the score. Composer automatically adds rests wherever there are no notes.

For example, if you add a quarter note at the half-note beat in a 4:4 meter measure, Composer will place a half note rest before the note, and a quarter note rest after the note:

You can split larger rest durations into two or more smaller rests. You might want to do this to prepare for adding a note at the location of the second smaller rest, as explained in Dividing and Combining Rests, and illustrated here:

You can use rests as a means of editing the duration of notes and removing notes. You can delete a rest to extend the duration of previous notes. Also, you can drop rests on top of notes to erase note durations, as explained in Using Rests to Erase Notes.

After importing and transcribing a MIDI, or transcribing a recording, you might want to use Composer’s Clean Up Rests and Overlapping Notes command as a quick way to remove small unwanted rests that “over-notate” the score in too much detail. For details, see Eliminating Small Rests.

See Using Multiple Measure Rests for instructions in preparing multiple measure rests which look like this:

You can hide rests such in tests for music students, where you want to leave space for the student to add notes by pen or pencil:

Complete a melody and harmony progression that ends at a half cadence at the end of the fourth measure.
5.7.1 Deleting Rests to Extend the Duration of Previous Notes

If you delete a rest that follows a note or a chord, then the duration of that previous note or chord will be extended to fill in the place of the rest.

- **To extend the duration of a note or chord by deleting the rest after it:**
  1. Select the rest.
  2. Hit the `Del` key.

![Image of deleting a rest to extend note duration]

5.7.2 Dividing and Combining Rests

Composer automatically adds rests wherever there are not notes. Sometimes you may find it convenient to divide a rest into smaller rests. This is particularly useful if you want to add a note in the middle of a rest, where there is not a Beat Ruler location.

For example, suppose you want to add a sixteenth note following a 16th rest. You could change the resolution of the Beat Ruler to 16th notes, and then directly insert the note at the exact 16th Beat Ruler position:

![Image of inserting a note into a rest]

Alternatively, you can add a sixteenth rest at the beginning of the half note rest, and then add the sixteenth note on top of the second sixteenth rest that Composer automatically places after the first one:

![Image of dividing a rest into two smaller rests]

This topic describes how to add rests to divide larger rests, and how to do the reverse, that is, to combine smaller rests into larger rests.

The procedure for adding rests is similar to that for adding notes. In **Add Mode**, select a rest duration value from the Rest Palette. Then click the mouse where you want to add the rest.

Like notes, rests also have voices: single voice, upper voice, or lower voice. Use the voice palette to specify the voice of a rest.

The procedures for these various ways of editing and using rests are described below.

- **To split a rest into multiple smaller rests:**
  1. Type `SHIFT+R` to show the Rest Palette:
2. Select a rest duration that is smaller than the rest you wish to split. The smaller rest, plus one or more remaining rests that make up the difference, will replace the original rest.

The Rest Palette offers options from 64th rests to whole rests; a single dotted rest; and triplet or quintuplet member rests. As with notes, you can use keyboard commands, such as "4" for quarter note rest, or "81d" for dotted eighth rest.

The mouse cursor will in the shape of a rest, with the duration you select, colored red.

3. Move the rest cursor to the Beat Ruler position where you wish to split a larger rest, and click the mouse.

The following example shows the result of "adding" a 16th rest on top of an half rest:

To add a note in the middle of a rest and between Beat Ruler marks:

1. Follow the above procedure, to split a rest into a part that is smaller than the Beat Ruler resolution.

2. Type SHIFT+N to display the Note Palette, and select the duration of the note you want to add between the Beat Ruler beats. Continuing with the above example, choose a sixteenth note duration.

3. Move the mouse over the rest that you wish to replace with the note, as illustrated here:

4. Click the mouse to add the note.

Here is the result:
If you have been adding notes and rests in some voice and need to add the next rest with a different voice, then use the voice options at the bottom of the Rest Palette. Select single, upper lower voice from the voice palette, or use the equivalent keyboard command:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Note Palette Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>sv</td>
<td>Single voice</td>
</tr>
<tr>
<td>uv</td>
<td>Upper voice</td>
</tr>
<tr>
<td>lv</td>
<td>Lower voice</td>
</tr>
</tbody>
</table>

To consolidate two adjacent rests into one larger rest:
1. In the Rest Palette, choose the duration for the larger rest.
2. Click the mouse at the first of the two rests.

For example, suppose you had previously split the second half of the following measure with a sixteenth rest. Select a half-note rest from the palette, or type "22", and move the mouse on top of the first sixteenth rest:

When you click the mouse, the smaller rests are replaced with the half-note rest:

5.7.3 Changing the Voice of a Rest

If you open a MIDI file with the Split Voice option on for Transcription Options (in the Setup menu), then Composer will sometimes create upper and lower voice rests as well as upper and lower voice notes. Usually Composer will make the right decisions about whether to use single voice versus split voice for both notes and rests. However, it might make an error, or you might have a different preference about splitting the voices or not at some particular location in the song.

To change a single voice rest to a split voice rest, or vice versa:
1. Select a rest.

Composer will display the Rest Palette:
2. Select one or the other of the single voice or split voice rest buttons, as illustrated here:

![Rest Illustration]

5.7.4 Using Rests to Erase Notes

You can use rests to erase portions of notes, or entire notes.

- To use a rest to erase the beginning of some portion of a note or chord:
  1. Type SHIFT+R to show the Rest Palette.
  2. Decide how much of the beginning the note you want to erase, and select that duration in the Rest Palette.
  3. Click the mouse at the location of the beginning of the note or chord.

For example, suppose you choose an eighth rest and click the mouse on the half-note chord here:

![Example Rest Use]

Composer will replace the beginning of the half-note chord with an eighth rest, leaving a remainder dotted quarter note chord:

![Resulting Rest]

- To use a rest to erase the end of a note or chord:
  - After selecting the rest duration in the Rest Palette, click the mouse at end of the note or chord, as illustrated here:

![End Rest Illustration]

- To completely erase a note or chord with a rest:
  1. Type SHIFT+R to show the Rest Palette.
  2. Select a rest value that is at least as large as the note you wish to erase.
  3. Click the mouse at the location of the beginning of the note or chord.
Keep in mind that the rest will replace any notes that span its duration, not just the first note or chord where you add the rest.

To erase part or all of two or more notes at the same time:
1. From the Rest Palette, choose a rest duration equal to the total span of the note duration that you wish to erase.
2. Using the Beat Ruler, click the red to-be-added rest where you wish the erasure to begin (perhaps the middle part of the duration of the first note), as illustrated here:

   ![Illustration of rest to be added](image)

5.7.5 Eliminating Small Rests

If you have imported a MIDI file, or recorded a performance at your music keyboard, and you find that Composer has transcribed the performance to notation using too many small rests, there are a couple of options you have to eliminate the small rests.

One option is to re-transcribe the entire song or specified staves. The Re-Transcribe command in the Format menu lets you specify the minimum rest duration that will be notated. Rests smaller than the specified minimum duration will be eliminated by extending the duration of preceding notes.

A second option enables you to select the region of the score, or group of notes, among which the small rests will be removed. In this example, rests smaller than quarter rests are removed:

   ![Illustration of small rests removed](image)

To eliminate small rests for a selected region of the score:
1. First, select a region of the score by holding down the CTRL key and the left mouse button, and dragging the mouse.
   -- OR --
   
   Select a group of notes.

2. In the Region menu, open the submenu named Clean Up Rests and Overlapping Notes. In the submenu, open a second submenu name Remove Rests Smaller Than. In that second submenu, choose 16th Rest, 8th Rest, or Quarter Rest, to determine the size of rests that will be removed.
   -- OR --

   Type "r16r", "r8r" or "r4r" to remove rests smaller than a sixteenth, eighth, or quarter rest.
   -- OR --

   Type "rr" to remove rests smaller than the size you most recently specified in this or any previous session of Composer.
5.7.6 Using Multiple Measure Rests

Throughout a score, wherever there are two or more measures with only rests for all of the staves, you can specify whether each measure will be displayed with a whole measure rest, or whether all measures are collapsed into a multiple measure rest. The following is an example of a two-measure rest:

To display multiple measure rests:
- In the Format menu, turn on the check mark for Collapse Multiple Measure Rests.
  -- OR --
  Type "qcmmr" for Quick Collapse Multiple Rests.

To display each measure with its own whole measure rest:
- Turn off the check mark for Collapse Multiple Measure Rests in the Format menu.

5.7.7 Hiding Rests

Sometimes it is useful to hide rests. One common case is where you want to force the stem direction of a note in the opposite of its natural direction. For example, in a vocal part, you might want to force the stem directions of all notes up, even though some of the noteheads lie above the middle staff line:

A second example where hidden rests are useful is in tests for music students, where you want to leave space for the student to add notes by pen or pencil:

Complete a melody and harmony progression that ends at a half cadence at the end of the fourth measure.
A third case is where you can use hidden rests to create extra horizontal space between two notes. (A future version of Composer will have direct support for spacing between two notes.) For example, you can add hidden rests in an upper or lower voice to create extra space for a note that appears to be in a single voice rather than opposite voice:

```
To hide rests:
1. Select one or more rests.
```

To select many rests in a region (a range of measures in one or more staves), first select the region, by using Ctrl + Drag, or by selecting an entire staff, or by using the Select Region command in the Region menu. Then choose the Convert Region to Selection of Rests command in the Region menu.

```
TIP: Whole measure rests cannot be selected. To hide a whole measure rest, first divide the whole measure rest by adding a smaller rest at the beginning of the measure. Then select the resulting divided rests in that measure and hide them according to the remaining steps of this procedure.
```

```
2. Choose the Hide Rest command in the Rest menu.
```

```
-- OR --
```

```
Click the Hide Rest button in the Rest Palette.
```

```
-- OR --
```

```
Type "h" for "hide rest".
```

```
The rest(s) will be temporarily revealed in gray rather than black:
```

```
4. To un-reveal the hidden notes, toggle off the check mark for Reveal Hidden Rests in the Rest menu.
```

```
-- OR --
```

```
Toggle of the Reveal Hidden Rests button in the Rest Palette.
```

```
-- OR --
```

```
Type "r" to toggle off "reveal hidden rests".
```
5.8 Editing Grace Notes

A grace note is displayed in a relatively small font size, and is performed by borrowing time from a longer note before or after it. A grace note looks like this:

Before you start working with grace notes in Composer, it is important that you understand the difference between two types of grace notes. One type of grace note borrows its time from a longer note that follows after it. The second type of grace note borrows its time from a longer note that precedes it.

In Composer, it is as easy to add grace notes as it is to add normal notes. Because a grace note so often has a slur to the note after it, or from the note before, Composer makes it easy for you to add a grace note with a slur in one step.

You can specify whether a grace note has a slash through the stem or not.

When you import a MIDI file, or record MIDI from your music keyboard, you can request Composer to automatically detect and display grace notes.

You can temporarily view the written-out performance of grace notes. For example, a written-out short note might be a 32nd note. When you view the written-out short note, you can also optionally adjust the performed timing of the grace note—its performed attack and release time—using Piano Roll Notation.

You can convert written-out short notes to displayed grace notes, such as changing a leading 32nd note to a grace note. Going the other way, you can convert a displayed grace note back to a written-out short note.

Procedures for all of the above tasks are described in the topics that follow. Additionally, to change the stem direction of a grace note, simply click the grace note to select it, then click the stem direction button you want.
5.8.1 Understanding the Two Types of Grace Notes

A grace note is displayed in a relatively small font size, and is performed by borrowing time from a longer note before or after it. A grace note looks like this:

Composer distinguishes two types of grace notes according to whether the grace note borrows time from the longer note before or after it.

In formal music language, different terms are sometimes used to distinguish these two types of grace notes that borrow time from the left or right. Other music terms related to grace notes include appoggiatura and acciacciatura. These other terms often carry more meaning than just whether the note borrows time from the left or right. These terms are sometimes also used differently in different countries, and for different periods (styles) of music. Much controversy surrounds the use of these terms. Composer intentionally avoids confusion and controversy by not using the terms appoggiatura and acciacciatura. Instead, Composer uses a single term grace note to describe any note that is (1) displayed in a smaller font size and (2) borrows time from either the left or right.

When you add a grace note, you must specify whether this is the type of grace note that borrows time from a note to its right, or borrows time from a note (or rest) to its left. That will determine how Composer performs the grace note during playback. The above chart indicates which buttons in the Grace Note Palette (SHIFT+G) create the two types of grace notes. The button for a grace note that borrows time from the left draws a leftward arrow above the grace note, in order to suggest that the grace note borrows time from the left; and similarly for the grace note that borrows time from the right.

5.8.2 Adding Grace Notes

In Composer, adding grace notes is similar to adding normal notes in these ways:

- Select the as-performed duration of the grace note. Even though the duration of the grace note is not displayed, your selection of the duration will determine how the grace note is played.
In Add Mode, move the to-be-added grace note cursor around with the mouse to determine the location and pitch where the note will be added.

Click the mouse to add the grace note.

Optionally, before releasing the mouse button, drag the note up or down to change its pitch.

The procedure for adding grace notes differs from adding normal notes in these ways:

- Use the separate Grace Note Palette (SHIFT+G) for adding grace notes, rather than the Note Palette (SHIFT+N).
- There is no Beat Ruler for determining the position of the grace note, as it is not necessary. For example, if you add a 32nd duration grace note in front of a quarter note, then the location of the 32nd duration grace note will be exactly a 32nd before the quarter note. You can finely adjust the timing of the grace note later, if desired, as described in Viewing and Editing the Timing of Grace Notes.
- You must specify whether the duration of the grace note is borrowed from the note on the right or from a note (or rest) on its left.

Composer supports series of grace notes, as well as grace note chords, as described in this topic.

To add a grace note in front of a longer note:

1. Navigate to the Grace Note Palette.
   
   -- OR --

   Type SHIFT+G.

   ![Grace Note Palette]

   **Shortcut**: Grace note command.

   - Show ornament and grace note symbols; otherwise show written-out notes
   - Backspace: Convert grace note to written-out performance
   - Del: Delete grace note and its performance
   - gl: Add or convert grace note that borrows time from left
   - gr: Add or convert grace note that borrows time from right
   - sl: Draw slur from grace note to next note
   - g'/: Add slash to grace note stem
   - gn/: Remove slash from grace note stem
   - gsa: Automatically determine stem direction
   - gsu: Set stem up
   - gsd: Set stem down
   - 16: Set grace note duration to 16th
   - 32: Set grace note duration to 32nd
   - 64: Set grace note duration to 64th
   - 00: Set grace note duration to no tuplet
   - r3: Set grace note duration to triplet
   - r5: Set grace note duration to quintuplet
You will find that you can skip most following steps, except the last (click the mouse to add the grace note), because the buttons will already be set as you want them from the previous time you added a grace note.

2. Enter Add Mode if you are not already in Add Mode.

The mouse cursor will turn into the same shape of a grace note, in the color red, as shown here:

3. Decide whether the grace note you are adding should borrow time from the note on its right, or borrow time from the note (or rest) on its left. This is important. If this issue is not clear to you, it is highly recommended that you read the previous topic Understanding the Two Types of Grace Notes.

4. Click one of the two buttons that determine whether the newly added grace note will borrow time from the right or left.

-- OR --

Type "gl" or "gr" for grace note borrow from left or right.

5. Specify the duration of the to-be-added grace note by clicking one of the buttons for 16th, 32nd, or 64th duration, and one of the buttons for no tuplet, triplet or quintuplet.

-- OR --

Type "16", "32", or "64" for the base duration, and optionally "33" or "55" for triplet or quintuplet.

For example, if you choose the combination of and , the grace note will be a 16th triplet member. A 16th triplet member has one third of the duration of an eighth note. A 16th quintuplet member has one fifth of the duration of a quarter note.

Even though the duration of the grace note is not displayed, your selection of the duration will determine how the grace note is heard on playback.

6. Click the grace note with slash button of without slash button.

7. Toggle on or off the grace note with slur button.

8. Move the to-be-added grace note slightly in front of the note before which it is to be played.

9. Click the mouse to add the grace note.
To add a grace note chord:

- Move the grace note cursor to another pitch (staff position) at the same location as another grace note, and then click the mouse to add the second one:

To add a series of grace notes:

- Add the grace notes in reverse order. Add the right-most grace note in front of the long note. Then add the second to last grace note in front of the right-most grace note. Continue adding grace notes this way from right to left:

-- OR --

- First add the grace notes as written-out notes, typically 32nds or 64ths. Select the to-be-converted grace notes. Open the Grace Note Palette with SHIFT+G. Click the button to convert the written-out notes to grace notes. For more details about this procedure, see Converting Short Notes to Grace Notes.

5.8.3 Viewing Grace Notes as Written-Out Notes

You can view the written-out performance of grace notes at any time. You might want to do this in conjunction with viewing the Piano Roll Notation for the grace notes so that you can finely edit the performed timing of the notes.

To view the written-out performance of a grace note:

1. Navigate to the Grace Note Palette.

-- OR --

Type SHIFT+G.

2. Toggle off the Show Ornaments and Grace Notes button in the Grace Note Palette.
Type "gsor" to toggle off Show Ornaments.
Composer will show the grace notes written out, highlighted in the color purple so that you can easily identify them.

Composer will show the grace notes written out, highlighted in the color purple so that you can easily identify them.

Once you have switched to viewing the written-out short notes, you can click the Piano Roll Notation button in the main toolbar to view the piano roll rectangles for the timings of the notes. You can also edit the timings of the notes independently of the notation of the grace note, as explained in Editing As-Performed Attack Location and Duration.

5.8.4 Editing the Slash on Grace Note Stems

A grace note can be displayed with or without a slash through the stem:

Usually grace notes are displayed with a slash through the stem, which is the default for Composer. You can remove the slash on any grace note or for many grace notes at a time. For some periods (styles) of music, and for some interpretations of the performance of grace notes, the presence or absence of a slash in the stem may have significance. There are different opinions among musicians and sheet music publishers about the use of grace note stem slashes. Composer does not attempt to musically interpret the presence or absence of a slash in the grace note stem. Rather, Composer simply offers you the option to include (by default) or not include the slash, as you prefer.

To add a grace note with a slash or without a slash:

1. Navigate to the Grace Note Palette with the mouse, or type SHIFT+G.

2. In the Grace Note Palette, choose the option for slash or no slash in the grace note stem.
5.8.5 Converting Short Notes to Grace Notes

In Composer, it is easy to add grace notes with the "point and click" method described in Adding Grace Notes. Another way to add grace notes is to enter them first as written-out notes with short durations, and then convert them to grace notes.

You might also want to write out the short note performances first, before converting them to grace notes. One reason you might want to do this is so that you can precisely determine how the grace notes will be performed. However, this is usually not necessary, because when you add a grace note, you specify its duration, which in turn determines how soon it is played before the long note. For example, you might choose the combination of the and buttons for a 16th triplet member, which is one third of an eighth note. In addition, you can finely adjust the timing of grace notes using Piano Roll Notation, as described in Viewing and Editing the Timing of Grace Notes.

There are several ways that you can convert written-out short notes to displayed grace notes:

- Before you import a MIDI file, you can instruct Composer to automatically detect and convert written-out short notes into grace notes, as described in Transcribing MIDI Files and Recordings to Notation. If Composer does not detect all of the grace notes in the MIDI file, then you can individually convert the remaining ones using the procedure below.

- Before you record from your music keyboard, you can instruct Composer to automatically detect and convert written-out short notes into grace notes, as described in Setting Up Transcription Options for Recording.

- Use the Transcribe Grace Notes command in the Grace Note Menu, as described in the first procedure below. This is a convenient way to convert several grace notes at one time. For a range of measures and staves that you specify, Composer will automatically detect and convert written-out short notes to displayed grace notes.

- Individually select the written-out short notes and use the Grace Note Palette buttons or keyboard shortcuts to convert them to displayed grace notes. This method is described in the second procedure below.

- You can also convert a series of two or more written-out short notes to grace notes, as described in the last procedure below.

To automatically detect and convert written-out short notes to displayed grace notes:
In detecting grace notes, Composer uses the same analysis for the Transcribe Grace Notes command as it does if you choose the grace note transcription option when you are importing a MIDI file, recording from your MIDI keyboard, or using the Re-Transcribe command.

1. Navigate to the Grace Note Palette, as described in Adding Grace Notes.
   -- OR --
   Type SHIFT+G.

2. Select a region by holding down the CTRL key while you drag the mouse. The region should be the range of measures and beats, and one or more staves, for which you wish to convert the grace notes. For example:

   ![Image of music notation]

   --- OR ---

   Instead of step #2, follow the remaining steps #3 and #4.

   Composer will display the Transcribe Grace Note dialog box.

4. In the Transcribe Grace Notes dialog box, select the range of measures and beats, and the range of staves, for which you wish to convert the grace notes.

To convert a written-out short note to a displayed grace note:

It is suggested that you use the Transcribe Grace Notes command, as described in the previous procedure, instead of the following procedure, unless you have a good reason. The above Transcribe Grace Notes command lets you convert many grace notes at once, very quickly.

1. Select the written-out short note.

2. Navigate to the Grace Note Palette, as described in Adding Grace Notes.
   -- OR --
   Type SHIFT+G.

3. In the Grace Note Palette, select one of the following buttons to convert the written-out short note to a grace note, and to optionally add a slur at the same time:

   ![Images of buttons for converting written-out notes]
Note that if the written-out version of the grace note borrows time from the long note that follows, then Composer will convert the written-out short note to that type of grace note, even if you choose the option for the opposite type of grace note, which borrows time from the left.

4. If the written-out version of the grace note borrows time from the right or left, and you wish to change the direction from which the time is borrowed, then you can do so for the now selected grace note. Click the button for the desired option, as illustrated here:

5. If the written-out performance of the grace note does not exactly describe how you want the grace note to be played, you can further refine the timing of the grace note by editing its Piano Roll Notation. See Viewing and Editing the Performance of Notes.

To convert a series of two or more written-out short notes to a grace note group:

1. Select the multiple written-out short notes.

2. In the Grace Note Palette, click the Grace Note Borrow From Right button (or Borrow From Left button).

   -- OR --

   Type "gr" for grace note borrowing from right (or "gl" for grace note borrowing from left).
5.8.6 Editing the Timing of Grace Notes

Just as you can view and edit the performed timing of normal notes, you can also view and edit the performed timing of grace notes, using Piano Roll Notation.

To view and edit the performed timing of grace notes:

1. In the Grace Note Palette, toggle off the Show Grace Notes and Ornaments button. The grace notes will be displayed as written-out notes, highlighted in the color purple, as illustrated below, and as described in Viewing Grace Notes as Written-Out Notes.

2. Click the Piano Roll tab:

   -- OR --

   Type SHIFT+Y.

   Composer will display the Piano Roll Notation for the written-out short notes, as illustrated below:

3. Follow the procedures for editing the performed timing of notes, as described in Viewing and Editing the Performance of Notes.

   For example, to move the performed attack of a grace note to the right or left:
   - Select the written-out short note.
   - Click the Edit Performed Timing button in the Piano Roll Palette.
     -- OR --
   - Type "ep" for edit performance.
   - While holding down the "A" key (for attack), click the or key one or more times, or hold down the Arrow key.
5.8.7 Reverting Grace Notes to Written-Out Notes

A grace note is a short-hand way of writing a brief note that precedes a longer note, as illustrated here:

Grace note written out is...

You can convert a written-out short note to a displayed grace note, as described in Converting Short Notes to Grace Notes. You can also do the reverse, that is, convert a displayed grace note to a written-out short note.

To convert one or more displayed grace notes to written-out short notes:

1. Select the grace notes.

2. Click the Convert Grace Note Back to Normal Note button.
   -- OR --
   Hit the BACKSPACE key.

To completely delete a grace note and its performance:

1. Select the grace note.

2. Click the Delete Grace Note button.
   -- OR --
   Hit the Del key.
5.9 Editing Ornaments

In addition to grace notes, Composer supports the following types of ornaments:

<table>
<thead>
<tr>
<th>Trill</th>
<th>Turn</th>
<th>Mordent</th>
<th>Arpeggio</th>
<th>Tremolo</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Trill Notation" /></td>
<td><img src="image2.png" alt="Turn Notation" /></td>
<td><img src="image3.png" alt="Mordent Notation" /></td>
<td><img src="image4.png" alt="Arpeggio Notation" /></td>
<td><img src="image5.png" alt="Tremolo Notation" /></td>
</tr>
</tbody>
</table>

The above chart shows how the various types of ornaments might be performed, although you can precisely specify alternative durations for the individual performance notes. For example, you can specify the individual trill notes to have any duration such as 32nd, 64th or 16th triplet. Or, you can write out the notes of an accelerated trill, starting with 16th notes and ending in 32nd triplets, and then convert the written-out trill notes to a trill ornament symbol.

The chart shows the corresponding buttons in the Ornament Palette for each type of ornament, and the keyboard shortcuts. Type SHIFT+O to show the Ornament Palette. Or, follow the procedure in Adding Ornaments for navigating to the Ornament Palette with your mouse.

In most books and literature on music notation, you will find that grace notes are classified as ornaments, among the other types that are named "ornaments" in Composer. We agree that grace notes are ornaments. But because the procedures for editing grace notes are inherently different that these other types of ornaments, Composer provides a separate Grace Note Palette and Grace Note Menu, as described in Editing Grace Notes.

The procedures for editing ornaments are generally the same for all types of ornaments. Once you learn how to edit one type of ornament, you will be able to quickly learn how to edit the other types of ornaments. The following topics describe procedures that are shared in common by all types of ornaments:

- Adding Ornaments
- Converting Written-Out Performances to Ornaments
- Reverting Ornaments to Written-Out Notes
- Deleting an Ornament
- Viewing and the Written-Out Performance of Ornaments

Remaining topics in this section provide procedures for editing special characteristics of each type of ornament:

- Editing and Transcribing Trills
- Editing Turns
5.9.1 Adding Ornaments

The general procedures for adding an ornament are the same for all types of ornaments: trills, turns, mordents, arpeggios, and tremolos. Once you have added a few ornaments of a given type, you will know how to add ornaments of any type.

There are three alternative procedures for adding ornaments:

- In Add Mode, use the "point and click" method. Select a type of ornament, and click the mouse where you want to add it.
- In Select Mode, first select the note to which you wish to add the ornament. Then select the ornament you wish to add. Using this method, you can add the same type of ornament to several notes in a single step.
- If the ornament is already written out as notes, then select those notes and convert them to a displayed ornament. This procedure is described in Converting Written-Out Performances to Ornaments.

The Add Mode and Select Mode procedures are described below.

To add an ornament in Add Mode with the "point and click" method:

1. Navigate to the Ornament Palette with the mouse.
   -- OR --
   Type SHIFT+O. If Composer displays the Octave Palette, then type SHIFT+O a second time for the Ornament Palette.

2. In the Ornament Palette, select the type of ornament you wish to add. See the chart of ornament types in Editing Ornaments for an explanation of each of the ornament type buttons in the palette.

3. Specify the duration of the ornament members by clicking one of the buttons for 16th, 32nd, or 64th duration, and one of the buttons for no tuplet, triplet or quintuplet.
   -- OR --
   Type "16", "32", or "64" for the base duration, and optionally "33" or "55" for triplet or quintuplet.

For example, if you choose the combination of and , each member of the ornament will be a 16th triplet. A 16th triplet member has one third of the duration of an eighth note. A 16th quintuplet member has one fifth of the duration of a quarter note.

4. Move the Add Mode mouse cursor to the note where you want to add the ornament. The mouse does not need to be vertically positioned exactly on the pitch of the note. It need only be positioned horizontally at the exact measure and beat where the ornament should be added.

5. Click the mouse button.
6. After adding the ornament, you can optionally change its accidental. Click the Edit Accidental button, or type “ac” for accidental. Composer will display a dialog box in which you can specify the accidental. The details for this option depend on the type of ornament, and are described in the specific topics for trills, turns, and mordents.

To add an ornament to one or more selected notes:

1. In Select Mode, select the note(s) to which you wish to add the ornament.

2. With the mouse, navigate to the Ornament Palette as described in the first procedure above.

   -- OR --

3. In the Ornament Palette, select the type of ornament that you wish to add to the selected note(s).

5.9.2 Converting Written-Out Performances to Ornaments

In Composer, it is easy to add an ornament with either the "point and click" method or the "select note and add ornament" method, both described in Adding Ornaments. Another way to add an ornament is to enter it first as a written-out performance, and then convert it to a displayed ornament symbol.

The most common reason that you might want to convert a written-out ornament is that most types of ornaments are initially written out in an imported MIDI file, or in a recording from a music keyboard. After you import a MIDI file, or record from the keyboard, you will likely want to manually convert the written-out performances to ornament symbols. In the case of trills and tremolos, however, you can instruct Composer to automatically detect them when transcribing a MIDI file or a recording from your keyboard.
Another reason that you might want to convert a written-out ornament performance is for more control over the exact timing of the notes. When you add a trill, for example, you can specify that the trill members should be, say, 32nd notes or 16th triplets. However, if you want the trill to accelerate from 32nd notes to 16th triplets or 64ths, then you can write out the detailed performance of the trill notes first, and then convert the series of trill notes into a trill symbol. For even finer control over the timing of the performance ornament notes, you can edit the Piano Roll Notation for the notes.

To convert a written-out performance of an ornament to its symbol:

1. In Select Mode, select the notes that you wish to convert.
2. With the mouse, navigate to the Ornament Palette as described in the first procedure above.
   -- OR --
3. In the Ornament Palette, select the ornament symbol that will replace the performance of the notes.

5.9.3 Reverting Ornaments to Written-Out Notes

An ornament symbol is a short-hand way of writing out a performance of several short notes, such as illustrated for all of types of ornaments supported by Composer in the chart of ornament types.

You can convert a written-out (as-performed) ornament to a displayed ornament, as described in Converting Written-Out Performances to Ornaments. You can also do the reverse, that is, convert a displayed ornament to a written-out ornament, as described in this topic.

If you want to just temporarily view the written-out performance of an ornament, then turn off the View Ornaments and Grace Notes button in the Ornament Palette, as described in Viewing and the Written-Out Performance of Ornaments.

To convert one or more displayed ornaments to written-out performances:

1. In Select Mode, select the ornament.
2. Click the Convert Ornament to Written-Out Performance button.
   -- OR --
3. Hit the BACKSPACE key.
5.9.4 Deleting an Ornament

Deleting an ornament removes the performance of the ornament, but preserves the note that was ornamented. This is illustrated in the procedure below.

If you want to remove the ornament symbol, but preserve the performance of the ornament, then use the Convert Ornament to Written-Out Performance command with the button or BACKSPACE key, as described in the previous topic, Reverting Ornaments to Written Out Notes.

To delete an ornament:

1. In Select Mode, select the ornament.
2. Click the Delete Ornament button.
   -- OR --
   Hit the key.

5.9.5 Viewing and Editing the Written-Out Performance of Ornaments

You can view the written-out performance of ornaments at any time. You might want to do this in conjunction with viewing the Piano Roll Notation for the grace notes so that you can finely edit the performed timing of the notes.

To view the written-out performance of an ornament:

1. Navigate to the Ornament Palette, as described in Adding Ornaments.
   -- OR --
   Type SHIFT+O. If Composer displays the Octave Palette, then type SHIFT+O a second time for the Ornament Palette.

2. Toggle off the Show Ornaments and Grace Notes button in the Ornament Palette.
   -- OR --
   Type "qsgo" to toggle off Show Ornaments.
   Composer will show the ornaments written out, highlighted in the color purple so that you can easily identify them.
Once you have switched to viewing the written-out short notes, you can click the Piano Roll Notation button in the main toolbar to view the piano roll rectangles for the timings of the ornament notes. Then you can edit the timings of the notes independently of the ornament symbol.

5.9.6 Editing and Transcribing Trills

A trill is performed as a rapid alternating between two pitches that are a whole step or half step apart.

The trill \textit{tr} symbol can be displayed with or without the squiggle line. The squiggle line has no extra musical meaning. In general, the squiggle line is used when the trill spans over a relatively long duration, or when it spans across a shorter time when accompanied by several other relatively short notes.

In the Ornament Palette, the buttons for the two types of trills look like this:

\[ \text{tr} \quad \text{and} \quad \text{tr}^{\infty} \]

The following general procedures apply to the editing of trills:

- \textbf{Adding Ornaments.} The Adding Ornaments procedure explains how you can specify the duration of the trill members, such as 32nd notes or 16th triplets.
- \textbf{Converting Written-Out Performances to Ornaments.}
- \textbf{Reverting Ornaments to Written-Out Performances.}
- \textbf{Deleting an Ornament.}
- \textbf{Viewing and the Written-Out Performance of Ornaments.}
The following procedures, unique to trills, are described in this topic:

- Add or remove the line extension of the \textit{tr} symbol.
- Add an accidental to the trill.
- Automatically transcribe trills when importing a MIDI file, or after recording a performance from your MIDI keyboard.

**To add or remove the line extension of the \textit{tr} symbol:**

1. Select the trill symbol in the score.
2. Click the \textit{tr} or \textit{t~} button in the Ornament Palette to change the trill symbol.

**OR**

Type "tr" or "t~".

A trill can optionally have an accidental. The accidental is displayed between the \textit{tr} symbol and line, or if there is no line, then above the \textit{tr} symbol. The accidental is necessary only if the upper note of the trill does not fall within the key signature, or if in the same measure there is a previous note that would change the inherited accidental for the upper note of the trill. The procedure for adding an accidental to a trill is described in this topic.

**To add an accidental for the upper note of a trill:**

1. If the trill has not already been added, then add it, as described in Adding Ornaments. You always add an accidental to an ornament after the ornament has been added.
2. In the Ornament Palette, click the Edit Accidental button.

**OR**

Type "ac" for accidental.

Composer will display the Trill Accidental dialog box:

![Trill Accidental dialog box](image)

3. Select the accidental, or perhaps "no accidental" to remove an already existing accidental.
4. If you want the accidental to apply to the actual performance-- which you usually will want to do-- then leave a check mark by "Change pitch according to new accidental."
Composer can automatically transcribe trills when it imports a MIDI file or transcribes your performance at the music keyboard.

To automatically transcribe trills in an imported MIDI file:

- Before you open the MIDI file, click the Transcription Options button in the File Open dialog box. Composer will present the Transcriptions Options dialog box. In the Transcription Options dialog box, turn on the check mark for Transcribe Ornaments / Trills. For further details, see Transcribing MIDI Files to Notation.

To automatically transcribe trills in a performance that you record at your music keyboard:

- Before you begin recording, choose the Transcription Options command in the Setup menu. Composer will present the Transcription Options dialog box. In the Transcription Options dialog box, turn on the check mark for Transcribe Ornaments / Trills. For further details, see Setting Up Transcription Options for Recording.

5.9.7 Editing Turns

A turn, indicated with the symbol above the ornamented note, is performed as three notes preceding the final performance of the ornamented note. The first note of the turn starts a whole step or half step above the ornamented note. The second note has the same pitch as the ornamented note. The third note is one whole step or half step below the ornamented note.

In a delayed turn, the three notes follow some time after the ornamented note is first played, and are followed by the final performance of the ornamented note. For a delayed turn, the symbol is displayed after the ornamented note rather than immediately above the ornamented note.

In the Ornament Palette, the buttons for the two types of turns look like this:

- The buttons for the two types of turns look like this: 

The following general procedures apply to the editing of turns:

- Adding Ornaments. The Adding Ornaments procedure explains how you can specify the duration of the turn members, such as 32nd notes or 16th triplets.
- Converting Written-Out Performances to Ornaments.
Reverting Ornaments to Written-Out Performances

Deleting an Ornament

Viewing and the Written-Out Performance of Ornaments

The following procedures, unique to turns, are described in this topic:

- Change the type of turn, that is, whether the turn starts at the beginning of the ornamented note or after a delay.
- Add an accidental for the note above and/or below the ornamented note.

To change the type of turn:

1. Select the turn symbol in the score.
2. Click the \( \text{\text{f}} \) or \( \text{\text{fe}} \) button in the Ornament Palette to change the turn symbol.

-- OR --

Type "tu" or "td" for turn or delayed turn.

Composer will change not only the symbol but also the performance of the turn.

A turn can optionally have one or two accidentals for the two notes above and below the ornamented note. These accidentals are displayed above and below the turn \( \text{\text{o}} \) symbol. The ornament accidental is necessary only if the upper or lower note of the turn does not fall within the key signature, or if in the same measure there is a previous note that would change the inherited accidental for the upper or lower note of the turn.

To add an accidental for the upper and/or lower note of a turn:

If the turn has not already been added, then add it, as described in Adding Ornaments. You always add an accidental to an ornament after the ornament has been added.

1. In the Ornament Palette, click the Edit Accidental \( \text{\text{ac}} \) button.

-- OR --

Type "ac" for accidental.

Composer will display the Turn Accidental dialog box:

2. For the note above, and/or the note below the ornamented note, select an accidental, or perhaps "no accidental" to remove an already existing accidental.
3. If you want the accidental to apply to the actual performance—which you usually will want to do—then leave a check mark by "Change pitches according to new accidentals."

5.9.8 Editing Mordents

A mordent, indicated with the \( \overset{\text{\textbullet}}{\text{\textbullet}} \) or \( \overset{\text{\textbullet}}{\text{\textbullet}} \) symbol above the ornamented note, is performed as two notes preceding the final performance of the ornamented note. The first note of the mordent has the pitch of the ornamented note. The second note is a half step or whole step above or below the note. The more common mordent, represented with the \( \overset{\text{\textbullet}}{\text{\textbullet}} \) symbol, plays the second note below the ornamented note. The mordent represented with the \( \overset{\text{\textbullet}}{\text{\textbullet}} \) symbol plays the second note above the ornamented note.

In the Ornament Palette, the buttons for the two types of mordents look like this:

In the Ornament Palette, the buttons for the two types of mordents look like this:

The following general procedures apply to the editing of mordents:

- Adding Ornaments[387]. The Adding Ornaments procedure explains how you can specify the duration of the mordent members, such as 32nd notes or 16th triplets.
- Converting Written-Out Performances to Ornaments[387].
- Reverting Ornaments to Written-Out Performances[387].
- Deleting an Ornament[387].
- Viewing and the Written-Out Performance of Ornaments[387].

The following procedures, unique to mordents, are described in this topic:

- Change the type of mordent, that is, whether the mordent plays a note below or above the ornamented note.
- Add an accidental for the note above or below the ornamented note.
To change the type of mordent:

1. Select the mordent symbol in the score.
2. Click the \(\uparrow\) or \(\downarrow\) button in the Ornament Palette to change the mordent symbol.
   -- OR --
   Type "md" or "mu" for downward or upward mordent.
   Composer will change not only the symbol but also the performance of the mordent.

A mordent can optionally have an accidental for the note above or below the ornamented note. This accidental is displayed below the \(\uparrow\) symbol or above the \(\downarrow\) symbol. The ornament accidental is necessary only if the upper or lower note of the mordent does not fall within the key signature, or if in the same measure there is a previous note that would change the inherited accidental for the upper or lower note of the mordent.

To add an accidental for the upper and/or lower note of a mordent:

If the mordent has not already been added, then add it, as described in Adding Ornaments. You always add an accidental to an ornament after the ornament has been added.

1. In the Ornament Palette, click the Edit Accidental button.
   -- OR --
   Type "ac" for accidental.
   Composer will display the Mordent Accidental dialog box:

   ![Mordent Accidental dialog box]

2. Enter the accidental for the note below or above the ornamented note, depending on whether the mordent symbol is \(\uparrow\) or \(\downarrow\).
3. If you want the accidental to apply to the actual performance -- which you usually will want to do -- then leave a check mark by "Change pitch according to new accidental."
5.9.9 Editing Arpeggios

An arpeggio is a chord whose notes are played in rapid succession rather than together. An arpeggio symbol is a short-hand notation for indicating that the succession of notes accumulate as tied notes to form a chord held for some duration. The arpeggio chord notes are usually played starting at the lowest note and ending at the highest note. But the notes can be played in the reverse direction, starting at the highest note. Two different arpeggio symbols distinguish the direction of the “rolled” chord.

In the Ornament Palette, the buttons for the two types of arpeggios look like this:

```
might be played as:
```

The following general procedures apply to the editing of arpeggios:

- **Adding Ornaments**. The Adding Ornaments procedure explains how you can specify the duration of the arpeggio members, such as 32nd notes or 16th triplets.
- **Converting Written-Out Performances to Ornaments**.
- **Reverting Ornaments to Written-Out Performances**.
- **Deleting an Ornament**.
- **Viewing and the Written-Out Performance of Ornaments**.

To change the type of arpeggio:

1. Select the arpeggio symbol in the score.
2. Click the or button in the Ornament Palette to change the arpeggio symbol.

--- OR ---
5.9.10 Editing and Transcribing Tremolos

A tremolo is the rapid repeating of notes. The tremolo can repeat a single note or chord. Or, it can repeat back and forth between two different notes, or between two different chords. If the tremolo repeats for a single note or chord, then it is notated with angular slashes through the stem. If the tremolo alternates between two notes or chords, then broken beams are displayed between the notes or chords, as shown below.

In the Ornament Palette, the buttons for the two types of tremolos look like this:

The following general procedures apply to the editing of tremolos:

- **Adding Ornaments**. The Adding Ornaments procedure explains how you can specify the duration of the tremolo members, such as 32nd notes or 16th triplets.
- **Converting Written-Out Performances to Ornaments**.
- **Reverting Ornaments to Written-Out Performances**.
- **Deleting an Ornament**.
- **Viewing and the Written-Out Performance of Ornaments**.

Composer can automatically transcribe tremolos when it imports a MIDI file, or transcribes your performance at the music keyboard.

To automatically transcribe tremolos in an imported MIDI file:

- Before you open the MIDI file, click the Transcription Options button in the File Open dialog box. Composer will present the Transcription Options dialog box. In the Transcription Options dialog box, turn on the check mark for Transcribe Ornaments / Tremels. For further details, see **Transcribing MIDI Files to Notation**.

To automatically transcribe tremolos in a performance that you record at your music keyboard:

- Before you begin recording, choose the Transcription Options command in the Setup menu. Composer will present the Transcriptions Options dialog box. In the Transcription Options dialog box, turn on the check mark for Transcribe Ornaments / Tremels. For further details, see **Setting Up Transcription Options for Recording**.
5.10 Editing Staff Symbols

In Composer, the following symbols are grouped together in the Staff Palette:

- **Brackets and braces**

![Brackets and braces](image)

- **Clefs**

![Clefs](image)

- **Key signatures**

![Key signatures](image)

- **Meters (time signatures)**

![Meters (time signatures)](image)

- **Barlines**

![Barlines](image)

- **Repetition marks**

![Repetition marks](image)

- **8va octaves**

![8va octaves](image)

- **Rehearsal Marks**

![Rehearsal Marks](image)
These staff symbols all have the general property that they affect the interpretation or organization of notes that are within their relatively large scope. The scope of their effect is generally larger than, for example, the effect of an accidental or ornament on an adjacent notehead.

To add a staff symbol, first navigate to the Staff Symbol Palette, or type one of the SHIFT+Letter shortcuts, as shown below:

<table>
<thead>
<tr>
<th>Notes and Rests</th>
<th>Text</th>
<th>Staff Symbols</th>
<th>Expressions</th>
<th>Lines</th>
<th>Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 5.10.1 Brackets and Braces

You can add brackets or braces to one or more adjacent staves. The bracket or brace will be applied to every system (line of music) throughout the score. You can add secondary brackets or braces to group together instrument sections, choirs, or keyboard staves within the overall conductor score.

The brackets and braces that you add to the conductor's score will also be used for parts that you manually extract. For example, if the conductor's score includes braces for the right- and left-hand staves of a piano part, then the manually extracted piano part will also have braces.

You can specify an instrument or instrument/vocal group name that is displayed to the left of the brace or bracket.

For any given part, you can hide the brackets and braces. This is particularly desirable for extracted parts for single-staff instruments.

**To add a bracket or brace:**

1. With the mouse, navigate to the Bracket Palette.

   -- OR --
Type the bracket character ( [ ) or brace character ( { ) to display the bracket palette:

[Image of bracket palette]

Composer will automatically enter Add Mode.

The mouse cursor will turn into this shape:

2. Click the mouse somewhere on the first staff where you wish the new bracket or brace to begin. You must click inside the staff, rather than to the left of the staff.

Composer will display a new brace or bracket that initially extends only for the height of this first staff:

[Image of musical notation with brackets added]

4. At this point the newly added bracket is selected for further editing. You can extend the bracket across additional staves, or change the bracket to a brace, by following one of the procedures below.

To change the extent of a bracket or brace to more or fewer staves:

1. (If the bracket or brace is already selected because you have most recently added it, then skip this step.

Click somewhere on the bracket or brace to select it.)

Composer will highlight the selected bracket or brace in blue, as illustrated in the above example. The blue square boxes above and below the bracket are called handles, which are used for changing the vertical extent of the bracket.
2. To change the vertical extent of the bracket or brace, move the mouse cursor to a handle, and press down on the left mouse button. While holding the left mouse button down, drag the bottom edge of the bracket to somewhere in the final staff where you wish the bracket to start or end.

3. hit the ENTER key to complete the editing and to unselect the newly added brace or bracket.

- To change a bracket to a brace, or a brace to a bracket:
  1. Click somewhere on the bracket or brace.
  2. Click the other brace or bracket button to change the shape of the object.
  3. hit the ENTER key to complete the editing and to unselect the brace or bracket.

- To delete a bracket or brace:
  1. Click the bracket or brace.
  2. Hit the Del key.

- To create a conductor's bracket across instrument or voice groups:
  1. First add the brackets and braces for each instrument group, choir, or keyboard part. Change the extent of each brace to include the desired staves.
  2. Add another bracket and change its extent to include all of the staves, so that it becomes the conductor's score bracket. The instrument and voice group brackets and braces will automatically be moved to the left of the conductor's score bracket.
To add an instrument name or instrument group name to the left of a brace or bracket for multiple staves:

1. Add the brace or bracket, and extend it vertically across all of the staves it belongs to.
2. If the brace or bracket is not already selected, then click it in Select Mode.
3. In the Bracket Palette, click the Bracket Group Name button. Composer will display the Bracket Staff Group Name dialog box.
4. In Bracket Staff Group Name dialog, enter the "long" name and the abbreviation for the instrument or instrument group.

In determining whether to display the long or abbreviated name at the left of the bracket or brace, Composer applies the same rules as it does for determining whether the long or abbreviated name of individual staves are displayed, as described in Showing and Hiding Instrument Names.
5.10.2 Clefs

You can add clef changes anywhere within the score, including in the middle of measures.

If you import a MIDI file, Composer automatically determines the clefs for staves, because MIDI files do not include clef information. If you find that Composer has incorrectly determined any clefs, you can easily change them.

To insert a clef:

1. With the mouse, navigate to the Clef Palette.
   -- OR --
   Type the SHIFT+C. This is also the keyboard short for the Chord Name Palette. If Composer displays the Chord Name Palette, then type SHIFT+C a second time to display the Clef Palette, as shown below:

   ![Clef Palette](image)

   The mouse cursor will turn into this shape:

2. Click at a position in the measure of a staff where you want the new clef to be inserted.

   Composer will add the clef where you clicked the mouse. Composer will also apply that clef to additional measures in the same staff, up to the next measure where there is a different clef, or to the end of the song if there are no other clef changes.

To change a clef:

1. Click the mouse cursor on a clef symbol.

   Composer will indicate that the clef has been selected by highlighting in blue. Composer will also indicate the type of clef you have selected in the clef palette.

2. Click of the buttons in the clef palette to change the type of clef.
   -- OR --
Choose one of the clefs listed in the Clef Menu.

-- OR --

Use one of the keyboard short-cuts, such as "t" for treble clef, or "b" for bass clef.

-- OR --

Click the clef selection button in the palette. Composer will display a dialog box where you can select the type of clef.

To set the clef for a range of measures:

1. Navigate to the Clef Palette, as in step #1 of the first procedure above.
2. In the Clef menu, choose the command Set Clef in Range of Measures.
3. In the Set Clef in Range dialog box, choose a staff, measure range, and clef.

5.10.3 Key Signatures

You can add key signature changes at the beginning of any measure of any staff in the score.

In transcribing a MIDI file, Composer examines whether the file includes key signatures. If it does, then Composer uses the key signatures saved in the file. Otherwise, Composer analyzes the harmony of the song to determine the key signature. This analysis does not account for possible mid-song key signature changes. Composer determines a single key signature for the whole song.

Composer optionally transposes instrument parts according to their native keys. For more information, see Transposing to the Key of an Instrument.

After Composer transcribes a song, you can update the key signature at the beginning of the song, as well as at the beginning of any measure. Composer applies the key signature to all staves, or to a single selected staff, according to your specification.

If you want to add a key signature change in the middle of a measure, you should insert a double barline or dotted barline at the beginning of the new key signature. The procedure for doing this is described at the end of this topic.

To insert a key signature at the beginning of a measure:

1. With the mouse, navigate to the Key Signature Palette.

-- OR --

Type SHIFT+K.

It would be impractical for Composer to display a palette of every possible key signature. Instead, the Key Signature Palette has just the one button.
When you navigate to the Key Signature Palette, Composer will automatically enter Add Mode. The mouse cursor will turn into this shape: ▲.

2. Click the mouse anywhere in the measure where you want the key signature to be added or changed.

Composer will present you with the following dialog box:

![Key Signature Dialog Box]

3. Choose the key signature from the dialog box by using the up and down arrows to spin through 0 to 7 flats or sharps, or select the key signature by major or minor key name.

4. If you wish the key signature change to be applied to all parts, rather than to just the part where you clicked the mouse, then choose "Apply key signature to all parts".

5. Add or remove a check mark in the last box, according to whether you want the new key signature to be preceded with natural accidentals for each accidental removed in the new key signature. For example, if the previous measure has a key signature of four sharps, and the new key signature is two sharps, then this option produces the following key signature with two cancellation natural accidentals:

![Key Signature Example]

6. By default, the key signature will be applied to the entire range of measures in the song. Choose a smaller range of measures, if desired.

7. Click the OK to complete the change.

Composer will apply the new key signature from your selected measure up to the next measure where there is a different key signature, or to the end of the song if there are no other key signature changes.
To change a key signature:

1. Enter Select Mode.
2. Click the mouse on a key signature object.
   Composer will indicate that the key signature has been selected by highlighting it with the color blue. Composer will also display the Key Signature Palette.
3. Click the key signature button in the palette.
   -- OR --
   Type SHIFT+ENTER, that is, while holding down the SHIFT key, hit the ENTER key.
   Composer will then present you with the Key Signature dialog box, as shown above.
4. Continue with step #3 in the first procedure, to select the new key signature and options for applying the new key signature to the score.

To insert a key signature in the middle of a measure:

In this example, the key signature will be changed from three flats (E-flat major) to one sharp (G major) in the last beat of the second measure:

Note that we do not necessarily advocate the practice of inserting key signatures in the middle of measures. In this example, the harmony change from the second to the third measure might be just as clearly, or even more clearly, represented by postponing the key signature change until the beginning of the third measure.

1. Insert a barline in the middle of the measure, as described in the topic Editing Barlines:
   Optionally, change the barline style from double barline to a dotted or dash style, as described in the topic Editing Barlines.
2. Hide the meters in the newly divided measure, as described in the topic Editing Meters (Time Signatures):
3. Insert a new key signature after the newly added barline:

![Key Signature Diagram]

5.10.4 Meters (Time Signatures)

You can insert meter changes anywhere within a score. Composer will replace barlines to match the new length of measures, according to the meter you choose. You can change the meter for measures even if the measures already have notes, lyrics, and music annotations. You can also show or hide meters at specific measures in the score.

Composer will not change the meter in any series of measures if a newly placed barline would divide a triplet or quintuplet. If Composer informs you that it cannot change the meter for this reason, convert the triplets or quintuplets to regular notes before attempting again to change the meter.

To change the meter in one or more measures:

1. With the mouse, navigate to the Meter Palette.  
   -- OR --  
   Type the SHIFT+M.

2. Optionally select a range of measures for which you wish to change the meter by holding down the CTRL key and dragging the mouse over them. You can extend the range by holding down both the Shift and CTRL keys and clicking in some further measure in the score. It does not matter which staff you choose.

3. Click the meter button in the palette.

If you selected a range of measures in step #2, Composer will display the Meter dialog box, as illustrated below. Otherwise, the mouse cursor will turn into this shape: In that case, click the mouse somewhere in the first measure where you want to change the meter.
Composer will display the Meter dialog box, such as shown here:

If you pre-selected a range of measures in step #2, then the Measure Range in the dialog box will reflect your selection. If you clicked some measure, then Composer will search for the first measure after the one you clicked where there is a change in meter; for the Measure Range, Composer will assign the measure you clicked as the "From" measure; and Composer will assign the last measure before a change in meter, or the last measure of the score, as the "To" measure.

4. In the dialog box, change the "From" and "To" measures if the pre-selected measures are not what you want. The numbers of these measures are those for the current measures in the score, as counted before applying the meter change rather than afterwards.

5. Choose the new meter. If it is not one of the standard meters offered, then click the "Other" button, and enter the numerator and denominator of the meter.

6. Normally, you can accept the default Beam Group pattern that Composer proposes. For instructions in overriding Composer's default beaming of notes, see the topic Editing Beams.

7. Click the OK button to commit the change in meter for the selected measures.

Composer automatically shows or hides meters (time signatures) according to the following rules:

- Always show the meter for the first measure of the score.
- Always show the meter in a measure when the meter has changed from that of the previous measures.
- Otherwise, do not show the meter.

For any specific measure or range of measures, you can override the above rules for automatic showing or hiding of meters.

To force the showing or hiding of the meter, or to set automatic showing of the meter, in one or more measures:

1. Follow steps #1 through #4 in the first procedure, selecting the measures for which you wish to show or hide the meters.
2. In the Change Meter dialog box, choose one of the three options for Show or Hide. The default option is “Automatically show or hide”.

5.10.5 Barlines

This topic describes how you can change the style of a barline to a double, dotted, or dashed barline, or start-of-section or end-of-section barline.

For instructions in adding repeat marks to barlines, see Editing Repeats.

If you have imported a MIDI file, or made a MIDI recording, in which the barlines are out of alignment with the downbeat of measures, then you can shift the barlines, as described in Shifting Barlines.

You can split a measure by inserting a barline in the middle of it, as described in Splitting Measures.

To change the style of a barline:

1. Select a barline by dragging the mouse cursor over it. A barline is usually so narrow that it is difficult to select it by directly clicking it. So, dragging the mouse over the barline is an easier way to select it.

Composer will highlight the newly selected barline in blue, and will display the Barline Palette:

The Barline Palette will indicate the type of barline you have selected.

2. Click one of the barline types in the palette, or type the keyboard short-cut.

Composer will change the style of the selected barline(s) according to your palette (or shortcut) selection.
For explanations of other buttons in the Barline Palette, see Splitting Measures, Joining Measures, Splitting Barlines, Editing Repeat Marks, and Editing Endings.

5.10.6 Repetition Marks

Composer supports a variety of ways indicating that a section should be repeated, or that the performance should continue at another place in the score:

- **Barline repeat marks**

- **Endings**

- **D.S. and other "go to" marks**

Composer automatically plays any repeat marks and endings as displayed in the score, unless you disable them with the Ignore Repeats and Endings command.

Composer does not automatically interpret "go to" performance marks such as "D.S." (Dal Segno) or "D.C." (Da Capo). However, you can instruct Composer exactly how to play such "go to" marks using the Repeat Instructions command in the Measure and Barline Menus.

5.10.6.1 Barline Repeat Marks

You can add start- and end-repeat marks to barlines. A barline for the end of a repeat can also mark the beginning of a second repeat section.

By default Composer performs a single repeat of a repeat mark during playback.

If a pair of start- and end-repeat marks span across a vocal part with three or more verses, then Composer does not automatically count the verses to determine how many times it should repeat the section. However, you can instruct Composer to repeat the section for as many times as there are verses, using the Repeat Instructions command in the Measure and Barline Menus. For details, see Repeat Instructions for Performances.

You can instruct Composer to ignore repeats during playback.

The MIDI file format does not provide for repeats. Therefore, authors of MIDI files must write out repeats. For example, if measures 16 to 31 of a score are repeated, then the MIDI file actually writes out the same notes again in measures 32 to 45. Although this works fine for playback purposes, written-out repeats are usually undesirable for printed scores. Composer enables you to replace the written-out repeated measures with repeat marks. First, you can delete the written-out repeat measures, as described in Deleting Measures. Then you can add repeat marks following the instructions below.

In some cases, repeats start in the middle of a measure. Even in this case, Composer enables you to replace the written-out repeated measures with repeat marks. First, you must split the starting and ending measures where the repeat marks are to be added. Then delete the written-out repeat measures. Finally, add the repeat marks following the instructions below.
To add a repeat mark to a barline:

1. Select a barline by dragging the mouse cursor over it. Composer will display the Barline Palette.

2. Click the Start Repeat or End Repeat button. 
   
   -- OR --

   Or type "sr" for Start Repeat, or "er" for End Repeat.

3. If the barline serves as both the end of one repeated section and the start of a second repeated section, then select the barline once and set the Start Repeat. Then select the barline a second time and set the End Repeat. The Barline Palette will indicate that the barline has both a Start Repeat and an End Repeat mark:

To remove a repeat mark from a barline:

- Follow the same instructions as for adding a repeat mark. If the repeat mark is already present, you can:
  
  Toggle the palette button for the repeat mark.

- OR --

  Toggle the Start Repeat or End Repeat check mark in the Barline Menu.

- OR --

  Type the "sr" or "er" keyboard command to toggle whether the repeat mark is displayed or not.

5.10.6.2 Endings

Composer enables you to specify alternative endings (1, 2, etc.) for repeats, such as this "closed" ending:

or this "open" ending:

Composer supports alternating or non-sequential endings. In the following example, the sequence of performed measures is 2 through 5, 2 through 3, 6 through 7, 2 through 5, and then continuing with 8:

Please note that for later sets of endings, those endings need to also have a beginning "1" and then consecutive ending numbers. This is good practice for "real" musicians who you may be printing a score, as well as ensuring proper playback of the song file. For example:
By default Composer performs repeats and endings during playback. However, you can instruct Composer to ignore them.

To add an ending:

1. With the mouse, navigate to the Barline Palette.
   -- OR --
   Type the vertical line character "|", which suggests the shape of a barline.

Composer will display the following Barline Palette:

Composer will automatically enter Add Mode. The mouse cursor will change to the Add Mode shape: .

3. Click the Ending button.
   -- OR --
   Type "en" for ending.

4. Click anywhere in the measure where you want to add the ending.
Composer will display the Ending dialog box:

![Ending Dialog](image)

In the dialog, the Ending at Measure indicates the measure you clicked to add the ending.

5. In the Ending dialog, specify the following:
   - One or more Ending Numbers. In this example, it is the fourth ending. For the non-sequential ending example near the beginning of this topic, ending numbers 1 and 3 would be selected.
   - The Ending Length, counted in measures.
   - Open Ending or Closed Ending, as illustrated in the first two examples at the beginning of this topic.

To remove an ending:

1. In the score, select the ending object above the measure.
   - Composer will highlight the selected ending object in the color blue.
2. Hit the `Del` key.

To change the ending number(s), measure length, or style (open or closed) of an ending:

1. Enter `Select Mode`.
2. In the score, select the ending object above the measure.
   - OR —
   - Type `SHIFT+Enter`. That is, while holding down the `SHIFT` key, hit the `ENTER` key.
   - This will bring up the Ending dialog, as illustrated above.
4. Enter new values for the Ending Number, Ending Length, or style (Open Ending or Closed Ending). Then hit the OK button.

### 5.10.6.3 D.S. and Other Go-To Marks

Formal music notation includes a rich vocabulary of Italian words and abbreviations to indicate that the musician should continue the performance at another location in the score, such as at the beginning of the score, or at some a segno (sign), usually `©` or `†`. 
Composer supports the notation and playback of such "go to" instructions in the following ways:

- Enter segno marks \( \text{\textcopyright} \) or \( \text{\textcopyright} \) using the Symbol Palette, as described in Special Symbols.
- Use the free text feature to enter instructions that include Italian terms such as Dal Segno (D.S.), Da Capo (D.C.) and Fine.
- Use the Repeat Instructions command in the Measure and Barline Menus to specify exactly how the "go to" instructions should be performed during playback.

Even in contemporary music, the segno marks and Italian instructions are sometimes used, but you can certainly write out instructions in your preferred language, or mix it with symbols, such as "Return to \( \text{\textcopyright} \).

For your reference, here are some of the most common Italian "go to" instructions:

- D.S. (dal segno) means "to the sign".
- D.C. (Da Capo) means "to the beginning (head)" of the song.
- Fine means "end" of the song, even if this mark is not at the last measure of the song.
- al means "then to". For example, D.S. al Fine means "to the sign and then to the end" of the song.
- Coda means "ending" of the song. The start of the Coda is usually indicated with double barlines, and the ending extends to the last measure of the score.

5.10.6.4 Repeat Instructions for Performances

Composer will automatically play repeats and endings as notated. If the measures (bars) between a pair of start- and end-repeat barlines includes more than two verses, then the repeat will be played as many times as there are verses.
Although Composer does automatically interpret repeats, verses, and endings, Composer does not automatically interpret other more complex "go to" instructions, such as D.C. al Segno. But Composer offers you complete control over the repeats, and which verse of lyrics is played during each repeat.

To control how Composer plays repeats and verses, use the Repeat Instructions command in the Measure menu.

To specify which verse of lyrics is to be sung in each repeat:

Consider the following example where the first verse is supposed to be sung twice, and the third verse the last time:

1. Choose the Repeat Instructions command in the Measure or Barline Menu.
   -- OR --
   Type "qri" for Quick Repeat Instructions.

![Diagram showing Repeat #1, Repeat #2, Repeat #3, Ending #1, Ending #2, Ending (#3) with musical notation and instructions on how to specify verses for repeats.]

Sing first verse for first and second
Sing second verse on the third repeat.
Composer will display the following Repeat Instructions dialog box:

Notice that in row 5, for Repeat #3, the Repeat Instructions indicates that verse #3 is sung for the third repeat, even though there is not a third verse. You can correct this, and also assign the second repeat to the first verse rather than the second.
2. Change the verse assignments in the Repeat Instructions dialog box, as illustrated below:

To specify relatively complex "go to" instructions in the score:

Consider the following example with four endings, a segno \( \text{segno} \) mark, a D.C. al Segno instruction, and a Coda:
1. Choose the Repeat Instructions command in the Measure or Barline Menu.

-- OR --

Type "qri" for Quick Repeat Instructions.

Composer will display the following Repeat Instructions dialog box:
Composer has correctly prepared the repeat instructions for the endings and repeats, as illustrated here:

However, Composer did not interpret the segno \( \text{\textcopyright} \) mark, D.C. al Segno and Coda:

2. Add instructions in the Repeat Instructions dialog box for the interpretation of the other "go to" marks, as illustrated in rows #10 and #11 below:

<table>
<thead>
<tr>
<th>From</th>
<th>Thru</th>
<th>Verse</th>
<th>Comment</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>5</td>
<td>6</td>
<td>1</td>
<td>Ending #1</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>4</td>
<td>2</td>
<td>Repeat #2</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>6</td>
<td>2</td>
<td>Ending #2</td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>4</td>
<td>3</td>
<td>Repeat #3</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>8</td>
<td>1</td>
<td>Ending #3</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>4</td>
<td>4</td>
<td>Repeat #4</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>15</td>
<td>1</td>
<td>Ending</td>
</tr>
<tr>
<td>10</td>
<td>1</td>
<td>4</td>
<td>1</td>
<td>D.C. al Segno</td>
</tr>
<tr>
<td>11</td>
<td>14</td>
<td>16</td>
<td>1</td>
<td>Coda</td>
</tr>
</tbody>
</table>
The last two instructions for the D.C. al Segno and Coda are performed as follows:

**D.C. al Segno**

---

**Coda**

---

5.11 **Editing Music Annotations**

Composer supports the following types of annotations:

- **Accents and articulations**

- **Dynamic marks**

- **Hairpin crescendo marks**

- **Special music symbols** in Composer's own Harmony font, or in another music font.
- **Slurs (phrase marks)**

![Slur Example]

- **Sustain pedal marks**

![Sustain Pedal Example]

Procedures for adding and editing each of these types of annotations are described in the topics that follow.

### 5.11.1 Accents and Articulations

One of the most common annotations in a score is the accent mark, such as the following:

![Accent Example]

Other types of annotations, such as the fermata, are technically neither accent marks nor articulations. However, for editing purposes, they are handled the same way in Composer. Such "accents" all have their symbols displayed immediately above or below notes.

![Fermata Example]

The procedures for adding and editing accent marks, articulations and fermata symbols are described in the topic [Editing Accent Marks](#).

Sometimes you might want to view the Piano Roll Notation as you are annotating the score. For example, as you are adding staccato marks for notes, you can view the piano roll rectangles to see...
which notes are performed with a short duration relative to their as-notated duration. Those are the notes for which you might want to add staccato marks:

You might also want to see how loud the notes are as you are annotating the score. For example, as you are adding accent marks for notes, you can view the velocity vectors of notes to see which ones are relatively loud and therefore should have "strong accent" (>) marks:

A velocity vector is a line pointing about 45 degrees up and to the right from the notehead. The length of the line indicates the loudness of the note. The longer the line (vector), the louder the note.

5.11.2 Dynamic Marks

With Composer, you can add a variety of dynamic marks to a score, such as $f$ and $p$. You can specify the placement of a dynamic mark above or below a staff, or immediately above or below a note or chord. Composer will automatically align the dynamics vertically in each staff. However, you can also enter dynamic marks as free text, which you can move anywhere you want.
Composer does not directly interpret dynamic marks during playback. Instead, you can directly edit the loudness of notes, and you can graphically edit the staff volume level for regions of the score. This offers you a high degree of control over the interpretation of dynamic marks in the score.

When exporting a file as a MusicXML filetype, Composer will also export the MIDI volume at dynamic marks, so that the exported file will also play the volume differences that you have set up using the "graphing" capability just mentioned.

To add a dynamic mark:

1. With the mouse, navigate to the Dynamic Mark Palette.
   -- OR --
   Type SHIFT+D.

   Composer will automatically enter Add Mode. The mouse cursor will turn to this shape:

   2. Click one of the dynamic mark buttons, such as $mf$ or $pp$.

   3. Click one of the five buttons at the bottom of the palette to determine the placement of the dynamic mark above or below the staff, or immediately above or below an adjacent note or chord.

      A dynamic mark is placed closer to the notes or chord if you choose Above Chord or Below Chord rather than Above Staff or Below Staff.

   4. Click the mouse where you want to add the dynamic mark.

To change the type of dynamic mark, such as from $mf$ to $pp$:

1. Enter Select Mode.

2. With the mouse, click the dynamic mark you wish to change.

3. In the Dynamic Mark Palette, click the new dynamic mark.
   -- OR --
Type the short-cut for the dynamic mark you want:

<table>
<thead>
<tr>
<th>Dynamic Mark</th>
<th>Keyboard Short-Cut</th>
<th>Dynamic Mark</th>
<th>Keyboard Short-Cut</th>
</tr>
</thead>
<tbody>
<tr>
<td>f</td>
<td>f1</td>
<td>p</td>
<td>p1</td>
</tr>
<tr>
<td>ff</td>
<td>f2</td>
<td>PP</td>
<td>p2</td>
</tr>
<tr>
<td>fff</td>
<td>f3</td>
<td>PPP</td>
<td>p3</td>
</tr>
<tr>
<td>ffff</td>
<td>f4</td>
<td>PPPP</td>
<td>p4</td>
</tr>
<tr>
<td>mf</td>
<td>mf</td>
<td>mp</td>
<td>mp</td>
</tr>
<tr>
<td>fz</td>
<td>fz</td>
<td>sp</td>
<td>sp</td>
</tr>
<tr>
<td>fp</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>sf</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>sfz</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Once you have selected the piano or forte marks, you can cycle through values by typing "P" or "F" one or more times. For example, to go from \(PP\) to \(PPP\), just type "P" once.

To change the placement of the dynamic mark:

1. Enter Select Mode.
2. With the mouse, click the dynamic mark you wish to change. Composer will display one of the Dynamic Mark Palettes, depending on the first letter of the dynamic mark you selected.
3. Choose one of the placement options listed in the first procedure in this topic, such as Above Staff or Above Chord. Choose the option by either clicking the palette button or by typing one of the keyboard short-cuts:

```
pppp  PPP  PP  P  mp  mf  f  ff  ffff  sp  sf  sfz  f2  fp  \(\text{short-cuts}\)
```

### Shortcut Placement
- ac: Above chord
- bc: Below chord
- as: Above staff
- bs: Below staff
- bts: Between staves

When one of the placement options Above Staff, Below Staff, or Between Staves is applied to multiple dynamic marks in the same staff, then they will be aligned vertically, which is easier for
musicians to read. The Above Chord and Below Chord options result in placement of the dynamic marks immediately above or below chords.

For all five of these options, the placement of the objects is automatic. Composer does not offer you a way to finely adjust the positions of the dynamic marks. If you wish to finely control the placement of a dynamic mark, then add the dynamic mark as free text, as described in the last procedure in this topic.

NOTE: If you plan to export your score as a MusicXML file please be aware that the MusicXML protocol ONLY associates dynamic marks with specific notes. Because Composer offers the option to associate dynamic marks with notes OR staves, please be sure that you use the option for dynamic mark association to be either Above Chord or Below Chord (as indicated above) if you plan to export a MusicXML file. Associating your dynamic marks with chords will help other programs that import your MusicXML file to read the file more accurately.

To delete a dynamic mark:
1. Enter Select Mode [ Select].
2. With the mouse, click the dynamic mark you wish to delete.
3. Hit the Del key.

To add or change a dynamic mark using a dialog box:
1. Type SHIFT+D to enter Add Mode for dynamic marks.
2. Click the mouse where you want to add the dynamic mark, or select an existing dynamic mark that you want to change.
3. Type SHIFT+Enter to display the Dynamic Mark Properties dialog box:

   Dynamic Mark Properties

<table>
<thead>
<tr>
<th>Type of Dynamic Mark</th>
<th>Vertical Position</th>
</tr>
</thead>
<tbody>
<tr>
<td>pppp</td>
<td>mf</td>
</tr>
<tr>
<td>ppp</td>
<td>f</td>
</tr>
<tr>
<td>pp</td>
<td>ff</td>
</tr>
<tr>
<td>p</td>
<td>fff</td>
</tr>
<tr>
<td>mp</td>
<td>ffff</td>
</tr>
<tr>
<td>sp</td>
<td>fz</td>
</tr>
<tr>
<td>sf</td>
<td>fp</td>
</tr>
<tr>
<td>sfz</td>
<td></td>
</tr>
<tr>
<td>cresc</td>
<td>dim</td>
</tr>
</tbody>
</table>

4. In the dialog box, select the type of dynamic mark that you wish to add or change, and its relative vertical position.
5. Click the OK button to complete the adding or changing of the dynamic mark.

To add a dynamic mark as free text, so that you can freely move it anywhere in the score:
1. Follow the instructions in General Procedures for Editing Free Text to add a new free text object.
2. Click the Free Text Properties button in the Free Text Palette.
   -- OR --
Type SHIFT+Enter.

Composer will display a dialog box entitled Add Mix of Ordinary Text and Symbols.

3. In the dialog box, choose one or more symbols, such as \textit{mf}, followed by \textit{f}, for mezzo forte \textit{mf}.

4. Click OK in the dialog box.

5. Using the mouse, drag the dynamic mark to the exact position you desire.

To draw a dotted line between "cresc" or "dim" and a dynamic mark:

1. Add the starting "cresc" or "dim", and add the ending dynamic mark, such as \textit{f}.

2. Assign the "cresc" or "dim" mark, and the ending dynamic mark, to "above staff", "below staff", or "between staves", by clicking one of the buttons: \textit{mp}, \textit{mf}, or \textit{pap}.

   -- OR --

   Type "as", "bs", or "bts" for above staff, below staff, or between staves.

3. Add a dotted line between the starting "cresc" or "dim" mark and the ending dynamic, as described in Adding Lines and Glissandos

4. In adding the dotted line, choose the line option for "line between dynamic marks above staff", "line between dynamic marks below staff", or "line between dynamic marks centered between staves". In the Line Palette, buttons are similar to the corresponding Dynamic Palette buttons:

5.11.3 Hairpin Crescendo Marks

With Composer, you can add to a hairpin crescendo or decrescendo mark to a score such as in the following example:

The word "hairpin" is commonly used in the vocabulary of music notation to suggest the shape of the symbol.
If a hairpin crescendo mark crosses a barline into a measure that is on a subsequent staff, Composer automatically divides the hairpin mark, as illustrated below:

Composer does not directly interpret hairpin crescendo marks or dynamic marks during playback. Instead, you can directly edit the loudness of notes and you can graphically edit the staff volume level for regions of the score. This offers you a high degree of control over the interpretation of dynamic marks in the score.

To add a hairpin crescendo or decrescendo mark:

1. With the mouse, navigate to the Crescendo Palette.
   -- OR --
   Type the less-than sign "<" or greater-than sign ">" character on your keyboard for crescendo or decrescendo.

Composer will display the Crescendo Palette:

Composer will change the mouse cursor to indicate Add Mode.

2. Click the mouse in the score where you want the crescendo or decrescendo to begin.

Composer will insert the crescendo or decrescendo in the score. It will extend horizontally from the point where you clicked the mouse to slightly past the end of that measure. Composer highlights the newly added crescendo mark to indicate that it is selected so that you can immediately edit it:
3. To change the position, length, or height of the hairpin crescendo mark, click one of the three handles illustrated in the above picture, and hold down the left mouse button. Now drag the handle to its new position. Then release the left mouse button.

If you wish to move the end of the hairpin right or left without changing the angle of the hairpin, then hold down the SHIFT key while you drag the top of the two handles.

The following example shows the result of dragging the top, right handle down and to the left:

4. Optionally center the start of the hairpin mark by choosing Vertically Center in Middle command in the Hairpin Menu.

   -- OR --

   Click the Vertically Center in Middle button in the Crescendo Palette:

   -- OR --

   Type "c" for center.

The following example shows the result of the Middle command:
5. Before attempting to add another crescendo mark, press the ENTER key to complete the editing of the newly added crescendo mark.

The following example shows the result of unselecting the newly added crescendo mark:

To change the position, length, or height of a crescendo or decrescendo mark:
1. Enter Select Mode.
2. With the mouse, click the crescendo or decrescendo mark you wish to edit.
3. Drag any of the three handles, as explained in the previous procedure.

-- OR --

Move the start or end of the crescendo mark using one of the following palette buttons or keyboard short-cuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>S + Left Arrow</td>
<td>Move start to previous measure</td>
</tr>
<tr>
<td>S + Right Arrow</td>
<td>Move start to next measure</td>
</tr>
<tr>
<td>E + Right Arrow</td>
<td>Move end to next measure</td>
</tr>
<tr>
<td>E + Left Arrow</td>
<td>Move end to previous measure</td>
</tr>
</tbody>
</table>

4. Optionally, vertically center the start or end of the crescendo or decrescendo mark using the Vertically Center in the Middle button.

5. Press the ESC or ENTER key to complete the editing of the selected object.

To change a crescendo mark to a decrescendo mark or vice versa:
1. Enter Select Mode.
2. Using the mouse, click the crescendo or decrescendo mark you wish to edit.
   The mark will be highlighted in blue, and Composer will display the crescendo palette, as shown before.

3. Click the crescendo or decrescendo button.
   -- OR --
   Type the less-than "<" or greater-than ">" key.

4. Press the ESC or ENTER key to complete the editing of the selected object.

### 5.11.4 Special Symbols

You can insert any symbol in Composer's True Type font, named Harmony, anywhere in the score.

You may have another music software product that has a music font with symbols you like, or it may have symbols missing in Composer's Harmony font. You can also insert symbols from another music font set anywhere in the Composer score.

To insert a music symbol from Composer's Harmony font anywhere in the score:

1. With the mouse, navigate to the Symbol Palette.
   -- OR --
   Type "%" (percent symbol) or "$" (the dollar sign), which are intended to suggest the idea of symbol.

Composer will automatically enter Add Mode, and the mouse cursor will change to this shape:

2. Click the mouse where you want to add the symbol.
Composer will display the Select Symbol dialog box:

Initially, the Select Symbol dialog box shows all of the symbols available in Composer's Harmony font. You can look through all of the symbols for the one you want, but it is easier to narrow down search by selecting a Symbol Category.

3. In the Symbol Category list, select the type of symbol you are looking for, such as "Rhythms and Tempo Units" or "Ornaments".

   The dialog box will then display only symbols for the category you have selected.

4. Among the displayed symbols, select one, and then click the OK button.

   The symbol will be added where you had clicked the mouse in the score.

5. Optionally, adjust the location of the symbol in the score by dragging it with the mouse.

This procedure is just a different way of adding free text. In a free text object, you can mix ordinary text with one or more music symbols from Composer's Harmony font. The above procedure is somewhat faster, but is limited to adding one music symbol at a time, and that symbol must be in Composer's Harmony font. To add a symbol from another music font, you will need to add it as free text, as described below.

To insert a music symbol from a music font other than Composer's Harmony font:

   We will illustrate this procedure using Composer's own Harmony font, as though it were some other music font.

1. Follow the procedure for Adding International Characters in Text. Instead of adding an international character from a text font, you will be adding a music symbol character from some music font.

   Start the Windows Character Map utility in the Accessories / System Tools folder.

   - Select the music font you want to use.

   - Find the symbol in the music font by clicking different symbols. In many music fonts, the symbols are difficult to find. Some are even difficult to find in Composer's Harmony font, such as the segno character. Click different symbols to get a full view, as illustrated below, until you find the one you need.
Double-click the symbol you want to use. Now the character is in the Windows clipboard, ready for insertion into the score.

2. Navigate with the mouse to the Free Text Palette.
   -- OR --
   Type SHIFT+F.
Composer will automatically enter Add Mode, and the mouse cursor will change to this shape:

3. Click the mouse where you wish to add the symbol.
Composer will display a blinking text cursor.

4. Type CTRL+V to paste the music symbol at the text cursor position.
At this point, it may not look like this works, because the symbol does not look correct.

5. Click the Font button in the Free Text Palette.
-- OR --

Type CTRL+F.

Composer will display the Select Font for Free Text dialog box.

6. In the dialog box, select the music font that you referred to in step #1 with the Windows Character Map utility. Then click the OK button. The symbols should now display correctly.

\[ \text{Symbols} \]

5.11.5 Slurs (Phrase Marks)

The terms "slur" and "phrase mark" refer to a music symbol that is a curved line extending over two or more notes. The slur indicates a musical phrase, similar to a spoken sentence. In vocal music, the singer takes a breath at the end of the phrase. Wind instruments similarly take a breath at the end of the phrase. Performers of other instruments simulate taking a breath by briefly disconnecting the last note of the phrase from any notes that follow.

A slur is not a tie. A tie is not a slur. They may look similar, because they are both curved lines. But a slur and a tie are two different things. A tie joins the durations of two notes of the same pitch, so that the first note is heard for the total duration of the two tied notes. A slur does not tie notes together. A slur groups the notes together into a musical phrase that is interpreted, to some degree subjectively, by the performer.

It is important that you understand the difference between a tie and slur in Composer. If you attempt to draw a slur between two notes, hoping that this will tie the durations of the two notes together, the two notes will not really be tied, even though there is a curved line between them as though they have been tied. The two notes will still sound separately rather than as one continuously played note. To tie two same-pitched notes together, you should use commands in the Note Palette or Tie Palette, or corresponding menus, as described in Editing Ties. To add a slur, you should use commands in the Slur Palette or Slur Menu.

The remaining topics in this subsection describe how to:

- Add a slur
- Delete a slur
5.11.5.1 Adding Slurs

Composer offers a convenient method for initially drawing a slur across notes. All you have to do is drag the new slur across the notes, and Composer will automatically fit the curve above or below the notes so as to avoid crossing through them. The result is almost always a visually pleasing curve. You can refine the shape of the curve afterwards, if desired.

Composer also offers a convenient "point and click" method for adding a slur between two notes. Just click the mouse near the first of the two notes, and Composer will automatically place the slur. An option lets you add a ">" accent mark at the first of the two notes, at the same time you add the slur between the two notes.

To add a slur across multiple notes using the mouse drag method:

1. With the mouse, navigate to the Slur Palette:

   -- OR --
   Type SHIFT+S. If Composer displays the Sustain Pedal Palette first, then type SHIFT+S a second time for the Slur Palette.
   Composer will automatically enter Add Mode, and the mouse cursor will change to this shape:

2. Click the button to choose the mouse dragging method for adding a slur across multiple notes.
   -- OR --
   Type "m" for the multiple note method of adding a slur.

3. Start the multiple-note slur by clicking the mouse, above or below the starting note of the slur, and hold down the button. Click above the note to add a slur above the notes, or click below the note to add a slur below the notes.

Initially, Composer will extend the newly added slur to the end of the measure, as illustrated below. You will be able to drag the end of the slur to the right or left until you release the mouse button.
4. While holding down the mouse button, drag the slur to the right across the tops or bottoms of the notes. It does not matter where you position the end of the slur vertically, because Composer will automatically adjust the vertical position and shape of the curve according to the underlying notes. You just need to position the end of the slur horizontally at the note where you wish the slur to end.

5. Release the mouse button where you want to end the slur. If you want the slur to continue to the next system, then initially drag the slur just to the end of the first staff. Then follow the procedure later in this topic for extending the slur to additional measures.

As you drag the new slur, it might not initially have the correct shape, and might incorrectly cross through notes. However, as soon as you release the mouse button, Composer will automatically fit the newly added slur above or below the notes. Most likely you will not need to adjust its position. However, you can finely tune the position and curvature of the slur, as described later in this topic.

This is what the example above looks like after the mouse is released:

Notice how Composer automatically adjusts the end position of the slur so that it pleasingly spans across the notes.
To add a slur between a pair of notes using the point and click method:

1. Follow step #1 in the above procedure.

2. Click the Slur Between Pair of Notes \( \text{button} \) to choose the point-and-click method for adding a slur between a pair of notes.

   -- OR --

   Type "p" for adding a slur between a pair of notes.

3. Move the mouse cursor to the first of the two notes:

4. Click the mouse button.

   Composer will add the slur between the two notes and automatically adjust the shape of the slur.

5. Hit the ESC key to unselect the newly added slur, unless you wish to adjust its position by dragging its handles.

To add a phrase mark between a pair of notes, including an "\( > \)" accent mark on the first note:

Follow the same steps as in the above procedure, except click the Slur and Accent \( \text{button} \) instead of the Slur Between Pair of Notes \( \text{button} \).

5.11.5.2 Deleting a Slur

To delete a slur:

1. In Select Mode \( \text{click anywhere on the phrase mark curve.} \)

   Composer will highlight the phrase mark in blue to indicate that it is selected.

2. Hit the Del key.

5.11.5.3 Changing the Shape and Extent of a Slur

Composer offers several options for adjusting the extent and shape of a slur. For the finest control over the extent and shape of the slur's curve, you can drag its four handles with the mouse. For most adjustments, however, you can use one-click or one-letter shortcut commands to do the following:

- Move the slur from above the note(s) to below the note(s), or the vice versa.
To finely adjust the position and shape of the slur's curve:

1. In **Select Mode**, click anywhere on the slur. Composer will highlight the selected slur in the color blue, and will display four red handles that you can drag with the mouse to adjust the position and shape of the slur.

2. Drag any of the four handles of the slur's curve to change its starting and ending points and shape. When you drag the starting or ending point of the slur, the adjacent "control" handle, which determines the shape of the curve at the start or end, will move along with the starting or ending point. Release the mouse button when you are done with a particular handle.

   The following chart shows some examples of different curve shapes that you can make by arranging the handles in different relative positions. You can even draw a curve that turns up, then down, and then back up.

To move the slur from above the note(s) to below the note(s), or vice versa:

1. Select the slur.
2. Click the Fit Slur Above Notes button or Fit Slur Below Notes button.

-- OR --
Type "a" for above notes, or "b" for below notes.

Composer will adjust the start and end positions of the slur so that they start at appropriate locations relative to the notes at the start and end of the slur. Also, Composer will adjust the arc of the slur so that it clears all of the notes without crossing through any noteheads or stems.

To automatically refit the slur to the contour of notes beneath or above it.

- Follow exactly the same procedure as the one above. For example, if you have added a note in the middle of a slur, such that the slur now crosses through the note or its stem, you can select the slur and click the or button to refit the slur to the new contour of notes, as illustrated here:

![Image of slur refit example]

Note that if you do anything to a note at the start or end of a slur, Composer will automatically refit the curve to accommodate the change. Only if you change the notes in the middle of the slur might it be necessary for you to follow the above refit procedure.

If you transpose the pitches of notes, so that they are raised or lowered on the staff, Composer will also automatically recalculate the position of slurs over or under those notes.

To move the entire slur up, down, right or left:

1. Select the slur.

2. Click the , , , or button one or more times.

   -- OR --

   Hit the Up, Down, Left or key one or more times.
To increase the bowing of the slur's curve in an outward direction, or decrease the bowing of the curve in an inward direction:

1. Select the slur.
2. Click the Bow Curve Out button or Bow Curve In button one or more times.

-- OR --

Type "o" or "i" for bow out or bow in one or more times.

To move the start or end of the curve to another measure, even on a separate system or page:

1. Select the slur.
2. Click one of the following buttons, or type one of the keyboard shortcuts:
   - Click the button, or type S, to move the start of the slur one measure to the left.
   - Click the button, or type S+, to move the start of the slur one measure to the right.
   - Click the button, or type E+, to move the end of the slur one measure to the right.
   - Click the button, or type E-, to move the end of the slur one measure to the left.

To adjust the position of a slur that spans across multiple systems:

1. Adjust the handles at the start of the slur, on the first system, to influence the position of the slur across not only that system but also the next system(s).
2. Adjust the handles at the end of the slur, on the last system, to influence the position of the slur across not only that system but also the previous system(s).
5.11.6 Lines and Glissandos

Composer supports the drawing of:
- solid lines
- dotted lines
- dashed lines
- wavy lines for glissandos and portamento, with optional "Gliss." or "Port." text written above the line

Here is an example of a dotted line and a glissando:

![Example of dotted line and glissando](image)

The topics in this subsection describe how to:
- add lines and glissandos
- delete a line or glissando
- change the extent or angle of a line or glissando

5.11.6.1 Adding Lines and Glissandos

To add a line or glissando:

1. With the mouse, navigate to the Lines and Shapes Palette:

   ![Lines and Shapes Palette](image)

   **Shortcut** | **Line Command**
   --- | ---
   da | Draw above staff
   db | Draw below staff
   dc | Draw centered between staves
   h or c | Draw horizontally
   v or c | Draw vertically
   S + ← | Move start of barline to previous measure
   S + → | Move start of barline one measure to right
   E + ← | Move end of barline one measure to left
   E + → | Move end of barline to next measure

   OR
Type the underline (‘_’) character (Shift + dash).

Composer will automatically enter Add Mode, and the mouse cursor will change to this shape:

2. From the palette, choose one of the types of lines you wish to draw, such as a solid line or dotted line.

-- OR --

Type the shortcut for the line type, as shown in the above diagram.

3. To draw a horizontal line, typically a dotted line, between two dynamic marks, as in "cresc ...... mf", click one of the three buttons for "draw line between dynamic marks", depending on whether the dynamic marks have been previously added with one of the corresponding three options: above staff, below staff, or between staves. This option offers the advantage that if the vertical positions of the dynamic marks change when you added other music symbols between them and the adjacent staff, then the dotted line between the dynamic marks will move by the same amount.

4. Click the mouse where you wish to start the line. While holding down the mouse button, drag the mouse where you wish to end the line. Then release the mouse button.

To force the line to be drawn horizontally or vertically, hold down the SHIFT key while you drag the mouse.

5. Adjust the placement of the line by dragging the start or end handle.

5.11.6.2 Deleting a Line Or Glissando

To delete a line or glissando:

1. In Select Mode, click anywhere on the line or glissando.

Composer will highlight the line in blue to indicate that it is selected.

2. Hit the Del key.

5.11.6.3 Changing the Extent or Angle of a Line or Glissando

Composer offers the following options for adjusting the extent and angle of a slur:

- Change the position of the start or end of the line.
- Horizontally or vertically align the line.
- Move the start or end of the line to another measure, even on a separate system or page.

To change the position of the start or end of the line:

1. In Select Mode, click anywhere on the line.

Composer will highlight the selected line in the color blue, and will display two red handles that you can drag with the mouse to adjust the position and shape of the line.
2. Drag either of the two handles to move the starting or ending location of the line or glissando.

TIP: If you need to make space between two notes to make room for a glissando, then use some hidden rests, as illustrated here:

To horizontally or vertically align the line:
1. Select the line.
2. Click the Center Horizontally button or Center Vertically button.
   -- OR --
   Type "h" for horizontal alignment, "v" for vertical alignment, or "c" to center (align) horizontally or vertically, whichever is already closest.

To move the start or end of the line to another measure, even on a separate system or page:
1. Select the line or glissando.
2. Click one of the following buttons, or type one of the keyboard shortcuts:
   - Click the button, or type $S_{\leftarrow}$, to move the start of the line one measure to the left.
   - Click the button, or type $S_{\rightarrow}$, to move the start of the line one measure to the right.
   - Click the button, or type $E_{\rightarrow}$, to move the end of the line one measure to the right.
   - Click the button, or type $E_{\leftarrow}$, to move the end of the line one measure to the left.

5.11.7 Sustain Pedal Marks

With Composer, you can add a pedal mark to a score, drawn as a line, typically below the left-hand staff of a keyboard part, as in the following example:
If a pedal mark crosses a barline into a measure that is on a subsequent staff, Composer automatically divides the pedal mark, as illustrated below:

Composer does not directly interpret pedal marks during playback. Instead, you can quickly convert pedal marks to MIDI pedal performance and convert MIDI pedal performance to pedal marks. You also can graphically edit the MIDI sustain pedal control for regions of the score.

To add a pedal mark:

1. With the mouse, navigate to the Sustain Pedal Palette.
   -- OR --
   Type SHIFT+S to display the Sustain Pedal Palette. SHIFT+S also displays Slur Palette. If the Slur Palette is displayed first, then type SHIFT+S a second time to display the Sustain Pedal Palette.
2. Choose the style of pedal by clicking the Bracket Style button or the Text Style button.

-- OR --

Type "b" or "t" for the bracket or text style of button.

3. Click and hold the mouse in the score where you want the pedal mark to begin.

Composer will insert the pedal mark in the score. It will extend horizontally from the point where you clicked the mouse to slightly past the end of that measure. Composer highlights the newly added pedal mark in blue to indicate that it is selected so that you can immediately edit it.

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Pedal Mark Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>Use bracket as pedal mark symbol</td>
</tr>
<tr>
<td>t</td>
<td>Use &quot;Ped.&quot; as pedal mark symbol</td>
</tr>
<tr>
<td>S + ↑</td>
<td>Move start of pedal mark to previous measure</td>
</tr>
<tr>
<td>S + ↓</td>
<td>Move start of pedal mark one measure to right</td>
</tr>
<tr>
<td>E + ↑</td>
<td>Move end of pedal mark one measure to left</td>
</tr>
<tr>
<td>E + ↓</td>
<td>Move end of pedal mark to next measure</td>
</tr>
<tr>
<td>p</td>
<td>View graph of pedal performance</td>
</tr>
<tr>
<td>m</td>
<td>Convert pedal mark to pedal performance</td>
</tr>
<tr>
<td></td>
<td>Convert pedal performance to pedal mark</td>
</tr>
</tbody>
</table>
3. While holding down the mouse button, drag the end of the pedal mark to where you want it to end. Then release the mouse button.

4. Before attempting to add another pedal mark, press the ESC key to complete the editing of the newly added pedal mark.

To change the starting or ending position of a pedal mark:

1. Enter Select Mode.
2. With the mouse, click the pedal mark you wish to edit.
3. Drag one of the two handles at the start or end of the pedal mark, as explained in the previous procedure.

-- OR --

Move the start or end of the pedal mark using one of the following palette buttons or keyboard short-cuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>S + Left Arrow</td>
<td>Move start to previous measure</td>
</tr>
<tr>
<td>S + Right Arrow</td>
<td>Move start to next measure</td>
</tr>
<tr>
<td>E + Right Arrow</td>
<td>Move end to next measure</td>
</tr>
<tr>
<td>E + Left Arrow</td>
<td>Move end to previous measure</td>
</tr>
</tbody>
</table>

4. Press the ESC key to complete the editing of the selected object.

5.11.7.1 Converting Pedal Performance to Pedal Marks

The previous topic describes how you can convert pedal marks to performances. This topic describes how you can do the converse, converting pedal performances to pedal marks. The need for this can arise if you have imported a MIDI file with pedal performances that you would like to have
notated. Or, if you use a MIDI pedal controller while you perform at your MIDI keyboard, you can convert your pedal actions into pedal marks.

Composer avoids overzealously notating pedal marks. For example, if the performance includes a rapid series of up and down pedal actions, Composer ignores these in converting the pedal performances to pedal marks.

To convert pedal performances to pedal marks:

1. With the mouse, navigate to the Sustain Pedal Palette (Expressions tab, Pedal mark button), or type SHIFT+S, as described in the procedure for adding pedal marks.

Composer will change the mouse cursor to indicate Add Mode:

2. Select the region for which you wish to convert pedal performances to pedal marks. Use the Select Region command in the Select menu. Or while holding down the CTRL key, drag the mouse over the region you wish to select. The selected region will be highlighted in gray, as shown below.

3. Click the Convert Pedal Performance to Pedal Mark button in the Sustain Pedal Palette.

-- OR --

Type "m" to convert to pedal mark.

5.11.7.2 Converting Pedal Marks to Pedal Performance

Composer does not automatically perform pedal marks, but you can very easily convert pedal marks into MIDI sustain pedal events that are performed during playback. If desired, you can finely adjust the exact start and end times of any performed pedal mark.

To convert pedal marks to pedal performances:

1. In Select Mode, select one or more pedal marks.

2. In the Sustain Pedal Palette (Expressions tab, Ped. button), click the View Graph button to view the graph of performed pedal marks.
Initially, the graph might not show the graph of any pedal mark performances, because none have been added yet. But the graph will show red dotted lines marking the "on" and "off" positions of the sustain pedal.

3. Select the pedal marks that you wish to convert to pedal performances.

4. Click the Convert Pedal Mark to Performance button.

-- OR --

Type "p" for convert to performance.

5. To further edit the pedal graph, navigate to the GraphOverNotes™ Palette, or type SHIFT+G. Follow instructions in Sustain Pedal Control for editing the MIDI performance of the sustain pedal.
6 Editing Types of Text

Composer distinguishes between the following types of text, which have different roles in a score, and different methods for placement and formatting in the score:

- **Lyrics**
  Lyrics line up underneath the notes to which they belong. Composer supports an unlimited number of verses. The lyrics in each verse are centered underneath each corresponding sung note, such as illustrated here:

- **Free Text**
  Free text can be freely placed anywhere within the body of the score. Examples of free text include tempo markings and expressive directives, such as illustrated here:

- **Page Text**
  Page text appears at the header or footer of every printed page, or every left or right page, or just the first page of the score. Some common examples of page text are the song title and composer name on the first page, and page numbers displayed in headers or footers, such as illustrated here:
- **Chord Names**

  Chord names are displayed above the top staff of each system of the score. Composer offers an option to automatically analyze an imported MIDI file to determine and display chord names. You can edit chord names just as you do other text, except some special characters such as "b" and "#" are interpreted as flat and sharp. Here are some examples of chord names:

  \[
  \begin{align*}
  \text{C} & \quad \text{G7} \\
  \end{align*}
  \begin{align*}
  \text{F7(b9)} & \quad \text{C7(b9#5)}
  \end{align*}
  \]

- **Rehearsal Marks**

  Rehearsal marks help to quickly direct ensemble musicians to important locations in the score during their practice sessions. In Composer, rehearsal marks can similarly be used to define the start and end locations of practice loop sessions, in which you can sing or practice your solo instrument while reading notes from the screen with accompaniment from Composer. Rehearsal marks are always presented in boxes. You can enter any number of letters or numbers for the rehearsal mark text. In this example, an upper-case letter is used:

  \[
  \begin{align*}
  \text{J}
  \end{align*}
  \]

### 6.1 General Procedures for Editing Text

The procedures by which you add and edit text are similar for each of the types of text supported by Composer. The common procedures are briefly described in these topics:

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size and Properties
- Showing and Hiding Types of Text
- Adding International Characters in Text

Detailed procedures for editing each type of text are described in separate sections for each:

- lyrics
- free text
- page text
- chord names
- rehearsal marks

### 6.1.1 Adding Text

To add text:

1. With the mouse, navigate to the Text Palette.
Type SHIFT+T. If Composer displays the Tie Palette first, then type SHIFT+T a second time to display the Text Palette.

2. Click one of the buttons in the text type palette to display a specific palette for that type of text.

-- OR --

Skip step #1, and go directly to one of the text palettes by typing one of the short-cuts, such as SHIFT+L for the Lyrics Palette.

<%PROD%> changes the mouse cursor to \(\) to indicate Add Mode.

3. Click the mouse approximately where you want to add the text.

Composer will display a blue box surrounding the area in which you will type in text, and will display a blinking cursor where you can start adding the text.

4. Type in the text, which will be inserted at the location of the blinking cursor. If you make any errors typing in the text, you can correct them before completing the entry of the text, following the procedures described in the next topic Editing Text.

5. If you are adding lyrics or chord names, hit the TAB key to advance to the next note to prepare to enter the next word or syllable of the lyric or next chord name. Or, if you are adding lyrics, you can also use the SPACE key instead of the TAB key to advance to the next note.
6. For free text and page text objects, you can enter multiple lines of text. Press the ENTER key to begin a new line of text.

7. Hit the ESC key when you are done entering the text.

The ESC key tells Composer that you are no longer entering text. Composer will then interpret your subsequent keyboard input as Composer commands rather than as text to be added.

6.1.2 Editing Text

The techniques for editing text in Composer are the same as for other typical Windows programs that support text editing.

One difference in editing text in Composer is that text is organized into objects. For example, a chord name is an object, just like a notehead or clef is an object. To edit a text object you must first select it, typically by clicking it, just as you must select a notehead before changing the pitch of the note, or a clef object before changing it from a treble clef to a bass clef.

When you are done editing a text object, then you must hit the ESC key, or select another text or non-text object. If you forget to unselect a text object, and then type in a command, such as SHIFT+N for the Note Palette, you will add the letter 'N' to the text you have been editing. You can quickly correct this mistake, which you may make a few times before you get used to the procedure. Just hit the BACKSPACE key to remove the characters you mistakenly entered. Then hit the ESC key to complete the text entry.

To change text:

1. Enter Select Mode.

2. Click a text object lyric, free text, page text, chord name, or rehearsal mark.

Composer will highlight the selected text in blue. A blinking cursor will indicate the current insertion point for characters you want to type.

3. Edit the text in the same way that you would edit text in other Windows applications. Here are some of the most common text editing techniques:

   - Click the mouse to move the blinking cursor within the text object, to determine where characters that you type will be inserted.

   - Hit the BACKSPACE key to delete the character to the left of the cursor. Hit the DEL key to delete the character to the right of the cursor.

   - Hit the ENTER key to start a new line of text. This works only for lyrics (to add more verses), and for free text and page text. The other types of text (chord names and rehearsal marks) are limited to one line only.

   - Use the arrow keys to move the cursor right and left, and up and down, within the text object.

   - While holding down the mouse button, drag the mouse to select text. Hit the DEL key to delete the selected text. Or drag the text to another position in the text object. Type CTRL+C to copy the selected text to the clipboard.
Type CTRL+V to paste previously copied text from the clipboard. The text might have been added to the clipboard by Composer, or by another program such as the Windows NotePad text editor.

4. You might notice that Composer does not immediately adjust the spacing of surrounding notation and other text as you enter new text.

As you type in text, adjacent text objects or non-text objects might be temporarily obscured.

This happens only temporarily. As soon as you complete the entry of the text, Composer will automatically reformat the area around the newly edited text to make room for it.

5. To complete the editing of the text, hit the ESC key.

--- OR ---
In Select Mode, select another text item to work on it.

--- OR ---
In Select Mode, select another non-text item to work on.

--- OR ---
In Select Mode, click the mouse in an empty space in the score.

--- OR ---
In Add Mode, click the mouse at another location to start a new text object there, thus completing the editing of the currently selected text object.

6.1.3 Deleting Text

To delete text:

1. Enter Select Mode.

2. Click a text object. Or select multiple objects by dragging the mouse over them.

3. Hit the Del key.

If you are already "inside" the text object, that is, editing text within it, then the Del key will only remove the character immediately after the text cursor. If you are already editing text inside the object and decide to delete the entire text object, then unselect the text object first. Then follow the above procedure for deleting the text object.
6.1.4 Selecting Font Type, Size, and Properties

You can edit the font type, size, and properties for any of the types of text supported by Composer (lyrics, free text, page text, chord names, and rehearsal marks), in the following ways:

- Change the default font type (such as Arial), size (such as 10 point), and properties (such as bold) that are applied to each object. You can specify a separate default font for each of the categories of text (lyrics, free text, etc.).

Further, for a given type of text, such as lyrics, you can specify a different font size for different score parts.

- For any given text object, override the default font assignment using a Font dialog.
- For any given text object, override the default font assignment using palette buttons or keyboard shortcuts.

To specify the default font style and point size for one of the five types of text objects, and for a given part or all parts of the score:

1. Choose the Text Fonts command in the Format menu.
Composer will display the Fonts dialog.

2. Follow the instructions in the topic Font Size for Types of Text.

To override the default font type, size, and bold or italic property for individual text objects using a font dialog:

1. Enter Select Mode.
2. Select one or more text objects of the same type (lyrics, free text, etc.)
Composer will highlight the selected text objects in the color blue, and will display the palette for that type of object, such as the Lyrics Palette.

3. In the text palette, click the format text button.
-- OR --
Type CTRL+F.
Composer will display a font dialog, such as the following one for lyrics:

```
Select Font for Lyric

[ ] Use the font that is the default for Lyrics

Font Type
[ ] Use default font type

Arial

Point Size
[ ] Use default point size

10

Bold
[ ] Use default
[ ] Bold

Italic
[ ] Italic
```

Type CTRL+F.
4. Choose options in the dialog box as follows:

- Set a check mark for "Use the font that is the default for (type of text you are editing)", to use the default font for that type of text. To specify the default font for a type of text (lyrics, free text, page text, etc.), following the procedure in Font Type and Size for Types of Text.

- Set a check mark for "Use default font type", "Use default point size", or "Use default bold"), to use the default property for the category of text, as determined by the Text Fonts command in the Format menu. (See the first procedure above.)

- Turn off the check mark for "Use default" for any of the characteristics to enter an overriding value.

   The point size can have an optional single digit after decimal point, such as 8.5.

To override the default font type, size, and bold or italic property for individual text objects using palette buttons or keyboard shortcuts:

1. Enter Select Mode.
2. Select one or more text objects of the same type (lyrics, free text, etc.).

   Composer will highlight the selected text objects in blue, and will display the palette for that type of object, such as the Lyrics Palette.

3. Use one of the following text palette buttons or corresponding keyboard shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + NumPad + (plus)</td>
<td>Increase size</td>
</tr>
<tr>
<td>Ctrl + NumPad - (minus)</td>
<td>Decrease size</td>
</tr>
<tr>
<td>Ctrl + B</td>
<td>Bold</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Italic</td>
</tr>
</tbody>
</table>

### 6.1.5 Moving a Text Object

Two of Composer's five types of text objects can be freely moved around on the page: free text and page text.

The positions for the other three types of text-- lyrics, chord names, and rehearsal marks, are automatically determined by Composer in order, for example, to vertically align multiple objects of the same type. If you find it too confining that a given lyric, chord name, or rehearsal mark cannot be freely moved, then you might want to replace it with a free text object that can be freely moved.

You can move a free text or page text object either by dragging it with the mouse, or by selecting it and using the arrow keys on your keyboard.

To move a free text or page text object by dragging it with the mouse:

1. Enter Select Mode.
2. Click the text object you want to move.
The text will be highlighted in blue to show that it is selected. A red handle will be displayed at the top left corner of the text:

```
3. Click the mouse on the handle, and while holding down the mouse button, drag the text to a new position.
```

To move a free text or page text object by using the arrow keys on your keyboard:

1. Enter Select Mode.
2. Click the text object you want to move.
3. Type the Up, Down, Left, or keys one or more times to move the text.

### 6.1.6 Copying and Pasting Text

You can use the Windows clipboard to copy text from one text object in Composer to another, or to copy text between a text object in Composer and text that you edit in an external text editor, such as Windows NotePad. The procedure below describes how to do this.

For lyrics, you can copy multiple lyrics and verses at a time, as described in Copying and Pasting Lyrics. You can also use an external editor to prepare lyrics and then paste them into a score, as described in Editing Lyrics Using an External Text Editor.

To copy text from one object to another:

1. Enter Select Mode.
2. Click the text object you want to copy.
   - The text will be highlighted in blue. Do not click the text object a second time to "open" it for editing.
3. Copy the text to the Windows clipboard by using the Copy command in the Edit menu.
   - OR
   - Type CTRL + C.
4. Enter Add Mode.
5. Click the mouse where you want to add the new text object.
   - In the score, a blue box and a blinking caret inside it will be displayed, indicating where you could start typing text.
6. Paste text from the Windows clipboard into the new text object by using the Paste command in the Edit menu.
   - OR
   - Type CTRL + V.

### 6.1.7 Showing and Hiding Types of Text

For a given score part, you can hide any of the following types of objects: lyrics, chord names, and rehearsal marks. For example, you might want to remove the chord names from the top of staves.
except for piano and guitar parts. Another reason you might want to hide these text objects is to temporarily create more room in the Composer window to view and edit other types of objects.

To toggle whether a type of object is hidden or shown in the currently viewed part:

1. With the mouse, navigate to the palette for the type of text.
   -- OR --
   Type SHIFT+L, SHIFT+C, or SHIFT+R for the Lyrics, Chord Names, or Rehearsal Mark Palette.

2. In the text palette, toggle the Show/Hide Type of Object \( \text{\textbullet}\) button.
   -- OR --
   Type "qsl", "qscn", or "qsm" for Quick Show (or Hide) Lyric, Chord Name, or Rehearsal Mark.

6.1.8 Adding International Characters in Text

If you are preparing scores in a language other than English, then you may need to include international characters in lyrics or other text. For example:

\[ \text{è à} \]

If your keyboard supports the international characters you need, then you can simply type them. Or, if you already have developed your own techniques for entering international characters, then you will not need to follow the procedure described below.

The procedure described here uses the Character Map utility which is included in the Windows Accessories folder.

This procedure has the limitation that a given text object in Composer can use only one font. The exception is that free text objects can mix ordinary text with Composer's Harmony font music symbols. There are a number of fonts have international characters, so this limitation should not present a problem.

To insert an international character in lyrics or text:

1. Follow the usual procedure for adding text, such as for a lyric or free text object.

2. Specify the font name for the text.

   You can specify a font name for all text objects of a given type, such as all lyrics, or all free. For instructions, see Font Type and Size for Types of Text.

   You can also specify the font name for a specific text object, as described in Selecting Font Type, Size, and Properties.

3. Type normal text up to the point where you want to add the international character.

4. If you know the numeric code for the character in the font, then while holding down the ALT key, type the 3-digit number of the character. If the character has only two digits, then type a leading zero '0' character, such as in ALT+060.

   If you choose this method of entering the numeric code for the character, then skip the remaining steps of this procedure.

5. If it is not already running, start the Windows Character Map utility, as follows:
Click the \texttt{start} or \texttt{windows} button in the left bottom corner of the screen.

Windows will display a pop up menu.

In the pop-up menu, choose All Programs / Accessories / System Tools / Character Map.

The Character Map utility window will be displayed, as shown here:

6. In the Character Map utility, select the same font that you are using for the text in Composer. If you are not sure what the font is in Composer, then while you are adding the text, click the Font Style button. A simple dialog box will display the current font face name, such as Times New Roman.

7. In the Character Map utility, preview the letter you wish add to the text in Composer, by clicking its box.

The character that you click will be displayed in a larger size, as illustrated for the \texttt{ñ} character, illustrated above.

8. Click the Select button in the Character Map window.

Character Map will show the character you have selected:

9. Switch back to Composer by clicking the top of its window, or by using ALT+Tab. Do not click the mouse inside the score, because that will start a new text object.
The text cursor should still be blinking, as you had temporarily left it to use the Character Map utility:

10. Type CTRL+V to paste the international character (ñ in this example) at the current text cursor position:

11. Continue adding normal characters. Repeat steps #3 through #8 to add other international characters, as needed.

6.2 Lyrics

With Composer, you can add lyrics to a song, with multiple verses [lines of text], such as illustrated below:

Composer automatically centers each word or syllable under the note to which it belongs.

Composer imports lyrics from MIDI and Karaoke files. You can quickly create a vocal part that combines lyrics with a melody, if the melody has its own staff. For more information, see Sing-Along Part. You can also quickly create a "fake book" lead sheet that includes the melody, chord names, and lyrics. See Fake Book Lead Sheet Part.

For several useful tips related to lyrics, see Preparing a Vocal Part.

The topics that follow describe various procedures for editing lyrics:

- Adding and Editing Lyrics
- Advancing to the Next or Previous Lyric
- Adding and Editing Multiple Verses
- Lyric Hyphen and Melisma Characters
- Copying and Pasting Lyrics
- Correcting the Misalignment of Lyrics with Notes
- Editing Lyrics Using an External Text Editor
- Working with Karaoke (.kar) Files


6.2.1 Adding and Editing Lyrics

The procedures for adding and editing lyrics are generally the same as for all types of text supported by Composer. See the preceding General Procedures for Editing Text:

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size, and Properties
- Showing and Hiding Types of Text
- Adding International Characters in Text

Here are some special details about adding and editing lyrics that differ from other types of text:

- The keyboard shortcut for the Lyrics Palette is SHIFT+L.
- Use the SPACE key or TAB key to readily advance to the next note while you are adding lyrics.
- To add a space character inside a lyric (e.g., "My love"), hold the "Shift" key while typing the space.
- For a given staff, lyric text will be automatically centered under their respective notes. It is not possible to move individual lyric objects in the way that you can move free text and page text objects.
- To enter a second verse of lyrics, select the first word in the line; move the text cursor to the end of that word; and hit the ENTER key to begin the second line (verse). You can enter the second verse word and advance in the same manner as entering and advancing in the first verse of the lyrics.
- Type two or more dash "-" characters in sequence to produce a lyric melisma symbol that looks like this:

```
\begin{align*}
\text{So long} & \quad \text{a-go}
\end{align*}
```

- You can use an external text editor, such as Windows Notepad, to quickly type the text for lyrics. Copy the text to the Windows clipboard. Then in Composer, use the Paste Lyrics command to insert the lyrics across a range of notes. This works even for multiple verses. Before you try this, make sure you understand how the text needs to be formatted in the text editor. See Editing Lyrics Using an External Text Editor.
- You can prepare lyrics for especially formatted Karaoke files, so that a Karaoke player program reading the file will be able to correctly display one phrase of lyrics per line.
6.2.2 Advancing to the Next (or Previous) Lyric

As you are adding or editing lyrics, you can advance to the next note or previous note or lyric in the following ways:

- Type the Space or TAB key to advance to the next note or lyric, which ever comes first.
- Type SHIFT+Tab to go back to the previous note or lyric, which ever comes first.
- If you are adding lyrics and advance to a next or previous note that does not already have a lyric, then you can start typing in the new lyric at that note.
- As you advance to the next or previous lyric, the text cursor will remain positioned in the current verse that you are editing.
- If a note is tied from the previous note, then the cursor will skip over that tied note as you advance. However, if you want to add a lyric at a tied note, just click the mouse below that note.

6.2.3 Adding and Editing Multiple Verses

To add a new verse in a line of lyrics below a staff:

1. Select the first lyric in the line.
   
   Whichever verse of the lyric you clicked will be highlighted:

   ```
   \[ \text{Oh my, Oh my.} \]
   \[ \text{Oh dear, Oh dear,} \]
   ```

2. With a second mouse click, click any verse of the lyrics for the first note.

   This will open a text editing area, and a blinking text caret will be display, as shown here:

   ```
   \[ \text{Oh my, Oh my.} \]
   \[ \text{Oh dear, Oh dear,} \]
   ```
3. Hit the \( \downarrow \) key until the text cursor is located in the last verse.

4. Hit the ENTER key to start the new verse.

5. Type in the text for the new lyric.

   After you start the new verse on the first lyric of the line, you can continue adding the lyrics for the same verse below subsequent notes by hitting the Space or TAB key between each lyric. Composer will keep the text cursor in the same verse.

6.2.4 Lyric Hyphen and Melisma Characters

   In Composer, you can enter a long extended line at the end of a lyric word or syllable, which looks like this:

   The purpose of the extended line, sometimes called a melisma, is to show that a word or syllable is sung across two or more different pitches, as in the above example.

   The purpose of the hyphen is to separate two syllables of a lyric word.

   ▶ To add a hyphen at the end of a lyric syllable:
     1. Add the lyric syllable.
     2. Type a single dash "-" character at the end of the syllable.

   ▶ To add a long dash (melisma) after a lyric:
     1. Add the text portion of the lyric.
     2. Before advancing with the SPACE or TAB key to enter the next lyric, type two or more dash "-" characters. The number of dash characters you enter will determine the length of the melisma. As you type in the dash characters, you will initially just see the dash characters.
     3. Complete the entry of the lyric by hitting the ESC key, or by typing SPACE or TAB to advance to the next note. At that point, the separate dash characters will turn into a continuous line.
4. You will not be able to rely on the length of the multiple dash characters as being the same as the resulting continuous line. It will take a little practice on a couple of these before you will get a feel for how many dash characters you need to enter to achieve a certain line length. The number of dashes needed may also vary with the font style.

To insert a hyphen in the middle of a lyric and shift the second syllable to the next note:

1. Select the lyric:

2. Click the mouse in the lyric, and move the text cursor to the position where you want to insert the hyphen:

3. In the Lyric menu, choose the command Add Hyphen And Move Second Syllable To Next Note.
   -- OR --
   Type Ctrl + dash ( - )
   -- OR --

   Click the Add Hyphen And Move Second Syllable To Next Note button in the Lyric Palette.

6.2.5 Copying and Pasting Lyrics

Sometimes you can save time entering lyrics that are repetitive by copying them from one part of the score to another. Two alternative procedures for copying lyrics are described below.

When you copy lyrics from one part of a song to another, it is important that the rhythms of the sung notes are basically the same, or more specifically, that the number of notes are the same in the two regions. If the number of notes do not match, then the copied lyrics might not be aligned correctly with the destination melody notes. If this happens, there is a convenient way for you to correct the problem. You can shift one or more lyrics to the right or left, as described in the next topic.
When Composer copies lyrics, it recognizes if some of the "from" notes do not have corresponding lyrics. If so, then Composer will skip over corresponding "to" notes, as illustrated here:

In matching notes in the "from" and "to" regions, Composer ignores the right note of any pair of tied notes. This limitation is rarely a problem, because it does not make sense that a distinct lyric can be sung at the division of a tied note. A distinct lyric (or syllable) requires a distinct note, even if that note is of the same pitch.

To copy lyrics from one section of a song to another location, using the clipboard:

1. Select an entire staff or select some region of a staff, that contains the lyrics you wish to copy.

Here is an example of what the selected region looks like:

2. Copy the region to the clipboard using the Copy command in the Edit menu. This copies everything in the selected region to the clipboard, including the lyrics.

-- OR --
Type CTRL+C, which is the standard Windows keyboard shortcut for Copy to Clipboard.

3. Select the new region to where you wish to copy the lyrics.

4. Type SHIFT+L to display the Lyrics Palette. In the Lyric Menu, choose the Paste Lyrics command.

-- OR --
Choose the Paste Lyrics command in the Edit menu.

-- OR --
Type "qpl" for Quick Paste Lyrics.
To copy lyrics from one section of a song to another location, using a dialog box:

1. **Select an entire staff** or **select some region** of one staff, that contains the lyrics you wish to copy.

2. Type **SHIFT+L** to display the Lyrics Palette and menu.

3. In the Lyric Menu, choose the Copy Lyrics Between Staves command.

   -- OR --

   Type "qcl" for Quick Copy Lyrics.

Composer will display the Copy Lyrics Between Staves dialog box, such as illustrated below.

The region (staff and range of locations) that you selected in step #1 will be pre-selected in the above dialog box.

3. In the dialog box, select the staff to which you wish to copy the lyrics.

4. Click the OK button to complete the task.

### 6.2.6 Correcting the Misalignment of Lyrics with Notes

You can quickly enter lyrics by typing one word or syllable at a time, and hitting the Space or TAB key to advance to the next note. If you are in a hurry to enter the lyrics, you may find that at some point the lyrics you have entered fall out of alignment with the melody notes. Fortunately, you do not have to erase the misaligned lyrics and re-enter them. Instead, you can select the misaligned lyrics and shift all of them one note to the right or left, with a single command.

Another example where shifting lyrics to the right or left is handy is when **copying and pasting lyrics** from one section of a song to another. If the rhythms and number of notes do not match in the “from” and “to” regions, then the lyrics might become misaligned with the notes in the destination “to” region.

Yet another example where shifting lyrics to the right or left is handy is when you are importing **lyrics that you have entered in an external text editor**. If you do not count the notes exactly (and remember to skip over tied portions of notes), then the imported lyrics might become misaligned with the notes.

In all of these cases, you can easily correct the situation. The first procedure below shifts to the right or left a lyric and all of the lyrics that follow it. That procedure is particularly useful for the case where you entered lyrics in a text editor, such as NotePad, and then **copy the lyrics via the Windows clipboard** into the score, but the lyrics are misaligned by one or more notes.

The second procedure below shifts to the right or left one or more selected lyrics. That procedure is particularly useful for the case where you were rapidly typing in lyrics and did not notice that the lyrics had become misaligned with the notes.
Finally, the third procedure below describes a global Align Lyrics with Notes command that moves all lyrics to the closest notes.

- To shift a lyric and all following lyrics to the right or left:

Consider the following example, where the lyrics are misaligned with the notes, starting in the second measure, and they need to be shifted to the left:

1. Select the lyrics that you wish to shift.

If there are multiple verses, then click the lyric of the verse that you wish to shift. The verse of the lyric you selected will be indicated with a yellow-brown background:

2. Choose the Shift Lyrics And Following Lyrics Right (or Left) command in the Lyric Menu.

-- OR --

Click the Shift Lyrics and Following Lyrics Right or Left button in the Lyrics Palette.

-- OR --

Type SHIFT+CTRL+ or SHIFT+CTRL+. 

- To shift one or more selected lyrics to the right or left:

1. Select the lyrics that you wish to shift. To select multiple lyrics in a verse, click the mouse on the first lyric in the desired verse, and then drag the mouse across beats and measures, up to the last lyric you wish to select in that verse.

2. Choose the Shift Lyrics Right (or Left) command in the Lyric Menu.

-- OR --

Click the Shift Lyrics Right or Left button in the Lyrics Palette.

-- OR --
To globally align all lyrics with nearby notes:

1. Navigate to the Lyrics Palette, such as by typing SHIFT+L.

2. In the Lyrics menu, choose the Align Lyrics with Notes command.

The command will display this dialog box:

![Align Lyrics With Notes dialog box]

3. Choose the maximum horizontal distance (in ticks) that Composer will move the lyrics. There are 480 ticks in a quarter note.

4. Choose the OK button.

### 6.2.7 Editing Lyrics Using an External Text Editor

Although it is easy to enter lyrics in Composer by typing in each word and advancing to the next note with the Space or TAB key, you might find it even easier to enter lyrics by first typing them into an external text editor. You can use the Windows clipboard to copy the text from the external text editor, and then paste the text into the score as lyrics.

Consider the following pub song:

The second verse of the song continues with "Ninety-nine bottles of beer on the wall". The third verse continues with "Ninety-eight bottles of beer".

You can use an external editor, such as Windows Notepad, to quickly enter the additional verses. In this example, two more verses instead of 99 more verses should be sufficient for illustration purposes.

We will start by copying the first verse of the song to the Windows clipboard, and then view the lyrics in a text editor. By viewing the lyrics in the external text editor, you will be able to quickly understand how you need to format the text so that it can be transferred via the clipboard back into Composer. In the external text editor, we will add the extra two verses to the song. Then, returning to Composer, we will replace the single verse with the three verses transferred via the clipboard from the external text editor.
To copy lyrics from Composer to the Windows clipboard and view the lyrics in an external text editor:

1. Select a region of the song that has the lyrics you wish to view and later edit in the external text editor. In this step, be sure to select a region, such as by dragging the mouse over the measures while holding down the CTRL key. The selected region will be highlighted with a gray background. This step will not work if you select the lyrics, highlighted in blue.

2. Choose the Copy Lyrics command in the Lyric Menu.

   -- OR --

   Type "qcl" for Quick Copy Lyrics.

   -- OR --

   Type CTRL+C, which is the standard Windows keyboard shortcut for Copy to Clipboard.

3. Open a text editing program, such as Windows Notepad. Use its File New command to create an empty text document. Then use the Edit Paste command, or CTRL+P, to paste the lyrics from the Windows text clipboard into the text document.

   In this example, the text will look like this:

   Each verse starts on a new line with "Verse>>", a space, the verse number, and a colon ":".

   Verse>> 1: One hun<>red bot- tles of beer on the wall, One hun-<>red bot- tles of beer. Take one off, and pass it a- round, Nine- ty nine bot- tles of beer on the wall.

   The "<>" characters indicate that a note (not tied) does not have a lyric beneath it.

   You can include line breaks anywhere. Line breaks are not interpreted when imported back into the score.

To prepare lyrics in an external text editor, for transfer back into Composer:

The above illustration explains how Composer formats the lyrics as text in the Windows text clipboard. This simple format is expected by Composer when you transfer lyrics via the Windows text clipboard back into Composer.

Continuing with the example, you can use the external editor's own Copy and Paste commands to clone the next two verses of the song, and the "One hun-dred" to "nine-ty nine" and "nine-ty eight". But notice that the syllables for "One hun-dred" and "nine-ty nine" are sung with different notes. This example offers you a good illustration about how you can use the special "<>" characters to indicate where no lyric is assigned to a note.
Here is what the text should look like in the external text editor, ready for transfer back to Composer:

Verse 2: \textit{Nine-ty nine bottles of beer on the wall,} \textit{Take one off, and pass it a-round,} \textit{Nin-ty eight bottles of beer on the wall.}

Verse 3: \textit{Nine-ty eight bottles of beer on the wall,} \textit{Take one off, and pass it a-round, Nin-ty seven bottles of beer on the wall.}

In the second and third verses, there are no lyrics for the pick-up beats before the first and second measures.

If you do not include the first verse in the text that you copy to the clipboard, then you can append the two new verses after the already existing first verse in the song in Composer. On the other hand, if you do include the first verse in the text that you copy to the clipboard, then in Composer you will first need to remove the existing lyrics (first verse in this example) before you copy all of the verses from the clipboard.

\textbf{To import lyrics from the external text editor into Composer:}

1. In the external text editor, select all of the text, and use the Copy command in the text editor's Edit menu; or type CTRL+C, the standard Windows shortcut for Copy to Clipboard.

2. In Composer, \textbf{select the region} to which you wish to copy the lyrics. You might find that the region is already selected, by the first step in the first procedure in which you originally copied the lyrics to the Windows clipboard.

3. In the Lyric Menu, choose the Paste Lyrics command.
   -- OR --
   In the Edit menu, choose the Paste Lyrics command.
   -- OR --
   Type "qpl" for Quick Paste Lyrics.

The final result in this example is:

\begin{verbatim}
One hundred bottles of beer on the wall, One hundred bottles of beer,
Nine-ty nine bottles of beer on the wall, nin-ty nine bottles of beer,
Nine-ty eight bottles of beer on the wall, nin-ty eight bottles of beer,

Take one off, and pass it a-round, Nin-ty nine bottles of beer on the wall.
Take one off, and pass it a-round, Nin-ty eight bottles of beer on the wall.
Take one off, and pass it a-round, Nin-ty seven bottles of beer on the wall.
\end{verbatim}

\textbf{TIP:} If after pasting the lyrics from the clipboard you find that some portion of them are misaligned under notes, then you can correct the problem in one of two ways. First, you can use the Edit / Undo command to remove the newly added lyrics; go back to your text editor and correct the text editing error there; and repeat the above procedure for copying and pasting the lyrics.
6.2.8 Working with Karaoke (.kar) Files

With Composer, you can create Karaoke (.kar) files that can be played and viewed by third party Karaoke player programs, such as VanBasco’s Karaoke Player™.

A Karaoke (.kar) file is almost exactly the same as a MIDI file. The only differences between a Karaoke and MIDI file are:

- Karaoke files always include lyrics.
- There are a few special formatting characters used in Karaoke lyrics:
  - A back slash "\" character marks the end of a line of lyrics, as displayed by a Karaoke viewer/player program.
  - A forward slash "/" character marks the end of a "paragraph" of lyrics. Some Karaoke viewer/player programs interpret this to mean that the screen should be refreshed starting with the next line of lyrics at the top.
  - Dash characters at the end of syllables are removed by the Karaoke viewer/player program, and the syllables are joined together.
- A Karaoke file has a .kar filename extension; whereas a MIDI file has a .mid filename extension.

To open a Karaoke file:

- In the File menu, use the Open command. Open a Karaoke file, which must have a .kar filename extension.

To edit the lyrics for a Karaoke file:

1. With the mouse, navigate to the Lyrics Palette.
   -- OR --
   Type SHIFT+L.
2. To view Karaoke formatting, such as line breaks for phrases of lyrics, choose the Show Karaoke Line Breaks command in the Lyric Menu.
   -- OR --
   In the Lyrics Palette (SHIFT+L), click the Show Karaoke Line Breaks button.
3. Follow the normal procedures for Adding and Editing Lyrics.
4. Add the back slash "\" character for Karaoke line breaks, and the forward slash "/" character for paragraph breaks. Add these characters at the end of the last lyric in the line, or at the beginning of the first lyric in the next line. If the song has multiple verses, then include the "\" and "/" characters at the end of each verse, as illustrated here:
The following example shows how the special Karaoke line formatting characters are interpreted by the popular VanBasco’s Karaoke Player (tm).

To export a Karaoke file:

- Use the Export as MIDI or Karaoke File command in the File menu. Export the file as a Karaoke file type, which has a `.kar` filename extension.
- If the lyrics in the song have multiple verses, then set a check mark by the File Save dialog option “Write out repeats and separate lyric verses in saved MIDI file”

6.2.9 Hiding Lyrics

In Composer, you can temporarily hide all of the lyrics in the song.

You can also select individual lyrics and hide them. But why would you want to hide just one or a few lyrics? The main reason is that many MIDI files add lyrics at the beginning of one or more empty tracks (staves) for the purpose of displaying song titles, composer and arranger information, and copyright notices. Although it’s a good idea to preserve this information in the MIDI file, you may not want to display or print it.
Because this need is so common, Composer offers an option to automatically hide individual lyrics which are longer than a certain number of characters. The default is 12 characters. That is, any lyric that is longer than 12 characters is probably not actually a lyric but, rather an informational notice displayed in the MIDI track. In the Setup menu's Transcription Options dialog, you can specify the minimum lyric length that will be automatically hidden.

To view the hidden lyrics in a song, you can turn on the Reveal Hidden Lyrics button in the Lyrics palette, as illustrated here:

If you wish to manually rather than automatically hide lyrics, then follow the procedure below.

To hide or unhide a specific lyric:

1. Navigate to the Lyric palette, as shown above.
   
   -- OR --
   
   Type SHIFT + L.

2. Select the lyric you wish to hide or unhide.

3. Toggle the Hide Lyric button.
   
   -- OR --
   
   Type "h".

   -- OR --

6.3 Free Text

With Composer, you can add "free" text anywhere in the score. The term "free" refers to the fact that you can freely determine the exact position of the text, in contrast to some other types of text. Lyrics are always lined up across a staff, and so are chord names. Free text does not have to line up with any other text or symbols in the score.

You can use free text for several types of annotations in a score, including:

- Tempo markings, such as Adagio or rallentando.
- Expression directives, such as "with feeling" or "con espressione".
- Playing directives, such as "R.H." for right hand.
The following example, from the main theme of George Gershwin’s Rhapsody in Blue, illustrates the use of free text:

Composer formats a score so that free text objects belonging to one staff do not overlap any objects in an adjacent staff. However, within a given staff, Composer does not attempt to avoid the overlapping of a text object with other objects. Thus, when you place a free text object in the score, you may need to find a free space for it. However, if you place the object above or below other objects in the staff, Composer will always move the adjacent staves to make room.

6.3.1 Adding and Editing Free Text

The procedures for adding and editing free text are generally the same as for all types of text supported by Composer. See the preceding topic, General Procedures for Editing Text.

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size, and Properties
- Showing and Hiding Types of Text
- Adding International Characters in Text

Here are some special details about adding and editing free text that differ from other types of text:

- The keyboard shortcut for the Free Text Palette is SHIFT+F.
- A free text object can have multiple lines. While adding or editing the free text, hit the ENTER key to begin a new line.
- In a single free text object, you can mix ordinary text with music symbols, such as the following tempo mark:
  
  \textit{Allegro} \quad (\textit{\textbf{\textit{j}} = 124})

- You can vertically align a selection of multiple free text objects.
6.3.2 Mixing Music Symbols and Normal Text

In a single free text object, you can mix ordinary text and music symbols, such as the following tempo mark:

![Tempo Mark Example](image)

To create a mixed free text object:

1. With the mouse, navigate to the Free Text Palette.
   -- OR --
   Type SHIFT+F.

2. Click in the score where you wish to add the free text object.
   Composer will display a blinking text cursor.

3. Click the Free Text Properties button.
   -- OR --
   Type SHIFT+Enter.
Composer will display the Enter Mix of Ordinary Text and Symbols dialog:

4. In the "Enter free text" area of the dialog box, type in the ordinary text. As you type in the text, you will see it displayed in the "Displayed as" portion of the dialog box.

5. To insert a music symbol, find it in the symbol list and click. When you add the symbol, you will see it displayed in the "Displayed as" portion of the dialog box. In the "Enter free text area", you will see the Harmony music font character number for that symbol, preceded by a slash "\" character.

To edit a free text object:

1. Select the free text object with the mouse.

2. Click the Free Text Properties button.
   -- OR --
   Type SHIFT+ENTER.

Composer will present the Enter Mix of Ordinary Text and Symbols dialog box, as illustrated above.
3. In the "Enter free text" area of the dialog box, edit the ordinary text as usual.

To remove a music symbol, delete all four characters of the symbol's font character number. For example, to delete the quarter note symbol in the above example, delete the characters "\213".

To insert a music symbol, click the mouse at the text position, in the "Enter free text" area, where you wish to insert the symbol. Then click the symbol in the list in the bottom area of the dialog box.

6.3.3 Vertically Aligning Free Text

Composer always vertically aligns chord names and rehearsal marks, thus saving you the effort of manually aligning them. The basic nature of free text objects is that you can freely place them anywhere in the score. Sometimes, however, you may want to vertically align multiple free text objects in a staff. For example, you might want to align tempo markings.

To vertically align free text objects:

1. Select the multiple free text objects by dragging the mouse over them.

   -- OR --

   Select the first free text object with a mouse click, and select additional free text objects by holding down the SHIFT key as you select them.

   \begin{center}
   \begin{tabular}{c}
   \textbf{Andante (d=72)} \hspace{1cm} \textbf{\textit{accel.}} \hspace{1cm} \textbf{d = 90} \hspace{1cm} \textbf{\textit{a tempo}}
   \end{tabular}
   \end{center}

   Composer will automatically display the Free Text Palette.

2. In the Free Text Palette, click the Align Top Edges \( \uparrow \) or Align Bottom Edges \( \downarrow \) button.

   -- OR --

   Type CTRL+\( \uparrow \) or CTRL+\( \downarrow \) to align the top or bottom edges.

6.4 Page Text

Page text appears at the header or footer of every printed page, or every left or right page, or just the first page of the score. Some common examples of page text are the song title and composer name on the first page, and page numbers displayed in headers or footers, such as illustrated here:
The above example shows the use of two standard page text items: the song title and page number. You can also add any other text that you type in, instead of these standard page text items.

Page text is displayed only in Page View, not in Window View. This is because page text is intended for the printed page. Page View shows on the screen what the printed page looks like.

Page text is different from free text. Free text is located within the score, and is placed relative to a staff and measure and beat within the measure. A given piece of free text is displayed only once in the score. In contrast, the page text may appear multiple times, at the same place on each page of the score, or optionally, on just the right or left pages of the score, or on just the first page of the score.

IMPORTANT: To reserve space for a title, page header or footer, specify top and bottom margins with the Page Setup command in the Format menu. To reserve space for the page title on the first page only, there is a special option in the Page Setup dialog box for Margin / First Composer offers convenient options for horizontally aligning page text at the left, right, or center of a page, and for vertically aligning multiple selected page text objects.

Standard page text objects are defined for the song title, part name, file name, and page number. Page text is applied to every score part. Thus, when you set up a page title or page header, it will be applied to each extracted part. Each part can have a unique part name, which you can enter with the Edit Part Name command in the Part menu. To display the unique part name in each separately printed part, use the standard page text for "part name".

6.4.1 Adding and Editing Page Text

The procedures for adding and editing free text are generally the same as for all types of text supported by Composer. See the preceding topic, General Procedures for Editing Text:

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size, and Properties
- Showing and Hiding Types of Text
- Adding International Characters in Text

The Page Text Detail Palette
Here are some special details about adding and editing page text that differ from other types of text:

**IMPORTANT**: To reserve space for a title, page header or footer, specify top and bottom margins with the Page Setup command in the Format menu. To reserve space for the page title on the first page only, there is a special option in the Page Setup dialog box for Margin / First Page Top.

- Page text is shown only in Page View and on the printed page. Page text is not shown in Window View.
- When you navigate with the mouse to the Page Text Palette, or type SHIFT+P, Composer will automatically switch to Page View.
- SHIFT+P is also the shortcut for the Page Layout Palette. If you type SHIFT+P once and the Page Layout Palette is displayed, then type SHIFT+P a second time for the Page Text Palette.
- A page text object can have multiple lines. While adding or editing the free text, hit the ENTER key to begin a new line.
- You can specify which pages show the page text for all pages, the first page only, left pages only, right pages only, or all pages except the first page. These options are convenient for distinguishing title text on the first page, and header and footer text on subsequent pages.
- Composer defines the following standard page text items: page number, song title, file name, and part name. The text displayed in these objects will vary according to, for example, what the page number is on a given page of the score. Note, however, that you can enter any text you want as page text, if you do not want to use one of the standard page text objects.

### 6.4.2 Determining What Pages Show the Page Text

You can specify which of the following pages show the page text: all pages, the first page only, right pages only, left pages only, or all pages except the first page. These options are convenient for distinguishing title text on the first page, and header and footer text on subsequent pages.

**NOTE**: The options described here refer to "left" and "right" pages. You can determine whether the first page of the score part starts on a left or right page with the Page Setup command in the Format menu. In the Page Setup dialog box, set a check mark or not for "Odd-numbered pages on left".

To specify which pages of the score should show a given page text object:

1. If Composer is not already in Page View, then choose the Page View command in the View menu.

-- OR --
Type "qpv" for Quick Page View.

2. Select the page text object.

Composer will display the Page Text Palette. Depending on whether you are viewing the first page, a left page, or a right page of the score part, the Page Text Palette will offer these options:

Options available if you are viewing the first page:

Options available if you are viewing left-side page:

Options available if you are viewing a right-side page:

3. Click one of the Page Text Palette buttons, as shown above.

-- OR --

- Type CTRL+1 for first page only.
- Type CTRL+A for all pages.
- Type CTRL+2 for all pages except the first page.
- Type CTRL+L for all left pages except the first.
- Type CTRL+R for all right pages except the first.

After you change the page side option, Composer might change the currently viewed page. For example, if you change the setting for some page text from "display on left pages only" to "display on right pages only", Composer will automatically turn to the next or previous page so that you will still see the same page text, but now on its newly assigned page.
The page side options do not include an option to display the page text on every left-only or right-only page, including the first page. There is a presumption here that the first page is formatted differently with a page title. If that presumption is incorrect, then you can add a duplicate page text item for the first page.

### 6.4.3 Aligning Page Text

You can align a page text object horizontally with the left or right margin of the page, or the center of the page. You can also align multiple page text objects vertically at their top or bottom edges.

**To align a page text object horizontally at the right, left, or center of the page:**

1. Enter `Select Mode`.
2. In the View menu, select the Page View command so that you can view the page text.
   - OR -
   Type "qpv" for Quick Page View.
3. Select a page text object.
   Composer will display the Page Text Palette.
4. Click one of the page alignment buttons in the Page Text Palette.
   - OR -
   Type `CTRL+L`, `CTRL+M` (middle), or `CTRL+R` to align the page text object with the left, center, or right side of the page.

**To align two or more page text objects vertically:**

1. Follow steps #1 and #2 in the above procedure.
2. Select the two or more page text objects you wish to align.
3. In the Page Text Palette, click the Align Top Edge or Align Bottom Edge button.
   - OR -
   Type `CTRL+U` or `CTRL+D` to align the top or bottom edges.

### 6.4.4 Standard Page Text Such as Page Number

A page text object can include any of the following four standard page text references:

- **Song title** -- the song title that you specify with the `Edit Song Title and Authors` command in the Score menu.
- **Part name** -- the part name that you specify for each part in the `Edit Part Name` command in the Part menu. When a particular part is printed, its own part name will be shown.
- **File name** -- the full hard drive path of the song, except that the file name extension (.not, .mid, or .kar) is removed.
To add a standard page text item on a page:

1. With the mouse, navigate to the Page Text Palette.
   -- OR --
   Type SHIFT+P. If the Page Layout Palette is displayed instead of the Page Text Palette, then type SHIFT+P a second time.
   Composer will automatically enter Add Mode, and the mouse cursor will change to this shape:

2. Click the mouse where you want to add the standard page text.
   Composer will display a blinking text cursor where you can type in the new page text or add a standard page text reference.

3. Type any unvarying text that you want to include with the standard page text reference. For example, if you want the page text object to be "page 1" for the first page, and "page 2" for the second page, etc., then first type the text "page" at the cursor:

4. In the Page Text Palette, click the button for the type of standard page text item you wish to insert at the text cursor.
   Composer will then insert a placeholder reference for the type of standard text item you selected, such as "<page>" for page number:

5. Hit the ESC key to complete the entry of the page text.
   Composer will then replace the placeholder reference with the page number for the current page, or the song title, part name, or file path.

```
page 1
```

### 6.4.5 Specifying Page Text in Templates

When you create a new song file, you can use the New Using Template command in the File menu, to borrow the staff setup from a standard template file, or from a custom template file that you have previously prepared. The template is actually just a Notation .not file, from which the staff setup
is copied. In addition, the newly created song file copies any page text that is included in the template .not file.

When you import a MIDI file, Composer copies page text from a special template named MidiFileDefault.not, which by default resides in the C:\Users\Public\Documents\Notation_3\Templates directory on your system. The initially installed version of the MidiFileDefault.not template automatically inserts the following page text in the score transcribed from your newly imported MIDI file:

- Song title, in point size 20, at the top of the first page.
- Song title, using the default page text font and size, at the left top corner of every page except the first page.
- Page number, using the default page text font and size, at the right top corner of every page except the first page.

You can change the page text in any template. When you subsequently create a new file using a template, or import a MIDI file using the MidiFileDefault.not template, the page text will automatically be copied from the template to your new song or newly opened MIDI score.

To add page text to a template:

1. Use the Open command in the File menu, and choose a .not file in the C:\Users\Public\Documents\Notation_3\Templates directory.
2. Edit the page text in the template file, just as though you were editing the page text in a normal song. Follow the instructions in Adding and Editing Page Text.
3. Save the template file using the Save command in the File menu.

6.5 Chord Names

Notation Composer offers many tools for adding and editing chord names. The Chord Name Palette is included in the Text tab palette.

With Composer, you can add chord names as simple as:

\[
\begin{align*}
C & \quad G7
\end{align*}
\]

or as complex as:

\[
\begin{align*}
F7(b9) & \quad C7(b9\flat5)
\end{align*}
\]
Composer can also analyze the harmony in a song and automatically display chord names (transcribe chord names).

Composer will also show you any problems with chord names that may not be compatible with certain types of MIDI or MusicXML export.

The topics that follow provide detailed descriptions of various procedures for adding and editing chord names:

- Adding and Editing Chord Names
- Analyzing (transcribing) Chord Names
- Advancing to the Next (or Previous Beat) While Editing Chord Names
- Shifting Chord Names to the Right or Left
- Formatting Chord Names
- Temporarily Hiding or Permanently Removing Chord Names

6.5.1 Adding and Editing Chord Names

The procedures for adding and editing chord names are generally the same as for all types of text supported by Composer.

You can add chord names to your score using a variety of methods:

- Have Composer analyze and automatically add chord names for you
- Open a .mid file you have saved from your Yamaha keyboard (or other device) which contains the XF format chord names. Composer will automatically display those chord names for you.
- Manually type in chord names
- Use the Chord Builder to add chord names
- Copy chord names from another part of your score or another song file, and paste them into your current song file.

Many of the editing features for chord names are covered in the preceding General Procedures for Editing Text.

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size, and Properties
- Showing and Hiding Types of Text

There are some special details about adding and editing chord names that differ from other types of text:

- The keyboard shortcut for the Chord Name Palette is SHIFT+C. If the Clef Palette is displayed, type SHIFT+C a second time for the Chord Name Palette.
- When you type certain special characters, such as "#" and "b", Composer will redisplay them as music symbols, such as the sharp and flat accidentals.
When you are manually typing in chord names, hit the TAB key to advance to the next major beat in the measure, or the first beat of the next measure, where you can enter the next chord name.

If a chord name is not lined up with the desired chord, you can shift it to the next or previous chord.

If you want to add a chord name manually "between notes", you can use your mouse to click on the location where you want to add the chord name.

Copying and pasting chord names works a bit differently than other text objects. You can re-transcribe the chord names in a file at any time after adding or editing notes, and the chord names will reflect the changes in the notes.

Chord names when transposing song note pitches or an instrument key: If you transpose the actual pitches of a song (i.e. change the key of the song), then the chord names also transpose to reflect the correct key of the newly transposed song.

If the song file has transposing instruments and you select to display the part for a transposing instrument from the drop list, the chord names for that part will show in the instrument key's transposition. In other words, if you have a song in C, and have selected to show Instrument Transposed Pitches for your score, then if you choose to display a Bb clarinet part, an "Ab" chord in the Conductor's Score (concert pitch) will display as a "Bb" chord in the Clarinet part (instrument transposed pitch).

When you click on a chord name, the chord notes will sound just as when you click on a note in the score.

You can change the enharmonic spelling of chord names, for example from a Db to a C#.

You can select the Chord Name Styles you would like to have displayed in your score.

Notation Composer can export chord names in Yamaha XF format in the .mid filetype, to use with Yamaha keyboards and other devices that use the XF chord name format.

When saving your song file, Notation Composer will analyze the song file and compare the notes in the score with the chord names. If there is a discrepancy or any implausible situation with the chord names, those names will be highlighted with brackets (e.g. [B/G]) so that you can quickly find them and fix them using the Chord Name tools. You can turn off this feature in the Chord Name Styles dialog.

Manually typing chord names into a score.

If you are creating a score and want to manually enter the chord names before adding notes and other score elements, then you can type in the chord names first. To use this method of entering chord names, you can do the following:

1. Click on the Text palette
2. Then click the Chord Names button (or you can use the keyboard shortcut "Shift + C"; if you get the Clef palette, press "Shift + C" again)
3. Click in the score where you want to add chord names, and start typing.
4. Hit the TAB key to **advance to the next major beat** in the measure, or the first beat of the next measure, where you can enter the next chord name.

Adding chord names using the Chord Builder:

Composer's Chord Builder lets you see and hear the notes of a chord before adding the chord name to the score.

The Chord Builder can be found in the Text -> Chord Names palette

Clicking the Chord Builder button (or using the keyboard shortcut "Shift + Enter") will open the Chord Builder dialog, as shown here (well, without all the annotations):
Location of chord names in the score: You can click anywhere in the score either before or after opening the Chord Builder to choose a location for a chord name. Also, after entering a chord name, you can click the "Next" button to move the chord name entry box to the next beat location for a new chord name. Clicking the "Previous" button will likewise move the chord name entry box to the previous beat location.

Chord name options: Select the Root of the chord, the type of chord, or extensions for your chord name by using the radio buttons to mark your selection. In the screenshot above, the "C6" chord has a slash bass note "A", which gives a C6/A chord name.

Hearing the chord: If you check the "Play chord each time you change it" box, then each time you click on a radio button, the chord will sound with the new change. Otherwise, you can click the "Play" button at any time to hear how the current chord sounds. You can also click on a chord name in the score to hear it played.

Changing the instrument sound of the chord: To change the instrument that plays the chord, click the "Select sound" button and choose the instrument you prefer to hear. The device will initially show your Default MIDI Playback Device. You can select from any of your available devices and instruments.

Copying and pasting chord names: Composer allows you to copy and paste chord names between sections of your score, so you don't have to spend time separately entering repeating chord progressions.
1. Using Region select click-drag your mouse to select the range of measures with the chord names you wish to copy.

2. Now click Edit -> Copy

   -- OR --

   type "Ctrl + C" (the Windows "copy to clipboard" keyboard shortcut)

3. Use Region select and click-drag your mouse to select the range of measures where you wish to paste in the chord names.
4. Now click in the Chord menu, Chord -> Paste chord names

-- OR --

Edit -> Paste special -> Paste chord names
Now the chord names that you copied and pasted will appear in the target region of your score.

Enharmonic spelling of chord names:

Composer allows you to change the enharmonic spelling of chord names. This allows you to raise the enharmonic spelling, for example, of a Bb chord to an A#, or other varieties of enharmonic spelling differences. A different enharmonic spelling may be more familiar to you or your band members, so you can change the enharmonic spelling of such chord names when printing out a score, fake sheet, or chord chart. For example, you may want to change an Fm to an E#m if you use barre chords for guitar, as the Em chord shape is a common minor chord barre shape.

1. In the score, click on the chord name for which you wish to change the enharmonic spelling.

2. Click the "Lower enharmonic spelling" button.
6.5.2 Analyzing (Transcribing) Chord Names

Composer can analyze a song to determine what chords are used, and then display the chord names, such as C7 and Dm, above the staff. Composer also lets you add, remove, or change chord names.

Here is an example of the chord names automatically analyzed by Composer for the country tune "Dixie":
MIDI files do not generally include chord name information. Sometimes the author of a MIDI file will enter chord names where lyrics are normally displayed. In this case, Composer will display the chord names as though they are lyrics.

In most cases, however, MIDI files do not include chord names at all. You are still in luck, though. Composer can analyze the harmonies in the song and automatically display chord names. This is a difficult task, and Composer cannot promise 100 percent accuracy. But Composer transcribes chord names remarkably well, considering the complexity of the task. In addition, since Composer lets you edit chord names, you can easily correct any mistakes Composer might make in its analysis.

To have Composer analyze the song for chord names and display them:

1. Decide which staves you want to analyze for harmonies. If you are not sure, you can just use all of the staves. However, if you notice that a few of the staves contain the notes that define "vertical" harmonies of the song, and other staves are more melodic or "horizontal", then you should instruct Composer to analyze chord names only using those staves that contain the vertical harmonies of the song. If the MIDI file happens to include a chord staff, typically with the staff name "Chords", then use just that staff. Note that Composer always ignores channel 10 drum staves, since the pitches in a MIDI drum staff have nothing to do with the real harmonies of the song.

2. Choose the Transcribe Chord Names command in the Format menu or Chord menu.
   -- OR --
   Type "qtc" for Quick Transcribe Chords.
   -- OR --
   Click the "Analyze chord names" button in the Chord Names palette.

Composer will display a Chord Name Transcription dialog box;

The bottom half of this window shows the chord types Composer will detect. Depending on the style of music, you may want to either include or exclude a certain type of chord. For example, a C7(#9) chord (C chord with a 7th and raised 9th) is unlikely to be used in a classical piece, so you would want to turn off the check mark for "9th, 11th, and 13th" if you are working with a classical piece.
Different music styles tend to use different chords. To make it easy for you to choose the right kinds of chords for the music style of your song, Composer defines various chord styles, such as Rock, Classical, and Jazz. You can also define your styles, or change Composer's definition of a given chord style, as explained later in this topic.

3. In the "Select staves" section of the dialog box, select the staves that you identified in step #1, and unselect all other staves.

4. Composer analyzes and displays chord names on a per-beat basis, such as every quarter note, half note, or dotted quarter note. Composer uses the meter (time signature) of the song to determine what beat value is used.

5. To choose one of Composer's predefined chord styles, or one that you have previously defined, select it from the Music Style dropdown list box:

Composer will then update the check marks for the various chord types in the bottom half of the window.

6. To specify whether a certain type of chord (such as Cmaj7) is to be detected or not, add or remove a check mark by the type (eg. Major 7th) name. Some types of chord names are always detected, such as major and minor, full- and half-diminished and 7th chords.

7. You can select to have slash bass notes analyzed along with the chord names (eg. G/B). Simply check the "Find slash chords using bass notes in this staff:" and select the staff you want to use from the drop list.

8. By default, Composer will analyze the entire score for chord names, and will replace any chord names previously analyzed or those manually entered or edited by you. If you want to
analyze the score only for a range of measures, then specify them at the top of the Chord Name Transcription window.

Select measure range
From: 1  To: 81

9. Click the OK button when you are ready for Composer to analyze the score for chord names. Note that this is a fairly time-consuming task for Composer, which will show you the progress in the progress bar.

If the chord name transcription seems “stuck” or if you change your mind about the types of chord names you want, then just click the “Cancel Execution” button and change your selections.

To change the type of chords associated with a “chord style”, or to define your own custom chord style:

1. To add a new style, in the “Detect types of chords” section of the dialog box, hit the Add button. Composer will display a simple Add Chord Style dialog box. Enter a name for the new chord style.

2. Add or remove check marks next to the types of chords that you want Composer to include or not include it in the analysis of chord types for this style.

3. After editing the types of chords for this chord style, hit the Save button.

If you are not happy with the results of Composer’s chord analysis, there are a couple of things you can try:

- Composer might display chord names that seem overly complex. For example, it might display Csus4 and Fsus4 everywhere that you expected just C and F to be displayed. In this case, use the Transcribe Chord Names command again. This time, uncheck the chord type “sus4”.

- Composer might display chord names that seem unrelated to the harmonies you hear. This can happen when Composer places too much weight on a staff that tends to have relatively few notes landing on the chord harmonies and relatively more “passing” notes between chords. In this case, use the Transcribe Chord Names command again, and do not include in the staves that have a large percentage of notes outside of the chord harmonies.

- You can try checking (or unchecking if it’s checked first) the “Activate Chord Progression Analysis” option to see which setting gives you the chord names that sound better to you. To change the setting, (1) click the “Activate Chord Progression Analysis” box then (2) click the “Save Chord Progression Setting” button to save the change. Then try your chord name analysis again to see if you like the results better. You can change this setting back as often as you like in the same session.
6.5.3 Advancing to the Next (or Previous) Beat While Editing Chord Names

As you are adding or editing chord names, you can advance to the next (or previous) note or chord name in the following ways:

- When manually typing in Chord Names, hit the TAB key to advance to the next major beat in the meter or chord name, whichever comes first. The location of major beats in a measure is determined by the meter. For example, the major beat in a 4:4 meter is a quarter note; and the major beat in a 6:8 meter is a dotted quarter note.
- Type SHIFT+TAB to go back to the previous major beat or chord name, whichever comes first.
- If you are using the Chord Builder, you can simply click the "Next" or "Previous" button to advance forward or backward to the next major beat.
- If you are adding chord names and advance to a next or previous major beat that does not already have a chord name, then you can type in a new chord name at that location. If there is already a chord name present, you can then edit it.
- You do not have to add a chord name at every major beat, of course. If you do not want to add a chord name at a beat, skip over it by hitting the TAB key (when manually typing) or the "Next" button (when using the Chord Builder) to advance to the next beat.

6.5.4 Shifting Chord Names to the Right or Left

If a chord name is not located above the note you intend, you can shift the chord name to the right or left, to the next nearest note or chord.

To shift a chord name to the right or left to the next nearest note or chord:

1. In Select Mode, select the chord name.
2. In the Chord Name Palette, click the Shift Chord to Right button or Shift Chord to Left button.

-- OR --

Type SHIFT+→ or SHIFT+←.

6.5.5 Formatting Chord Names

You can change font style, size, and bold and italic attributes of chord names. You can also specify how certain types of chord names should be displayed, such as Cdim versus C−.
To change the font type, size of the text, or to change it to bold or italics:

- In the **General Procedures for Editing Text**[1103], see the procedure for **Selecting Font Type, Size, and Properties**[833].

To specify how diminished, augmented, and other types of chords are displayed:

1. With the mouse, navigate to the Chord Name Palette.

2. Type **SHIFT+C**. If the Clef Palette is displayed, type **SHIFT+C** a second time for the Chord Name Palette.

3. In the Chord Name Menu, choose the Chord Name Display Styles command.

   **Composer** will display the Chord Name Styles dialog box, as illustrated below:

   ![Chord Name Styles](image)

   3. For each of the types of chords, choose the way you want the chord to be displayed.

   4. Click the Save As Default button if you wish the styles to be applied to all songs that you later create or import as MIDI files.

   5. Click OK to apply the changes to the currently viewed score.

**Chord Name Verification**

When saving a file, **Composer** can verify that chord names are valid for MIDI export. If it is not, then the chord name will be displayed with brackets around like this “[Abm7912]”. You can either use the **Chord Builder**[833] to fix such chord names, or you can turn off the feature by selecting “Disabled” as illustrated in the above screen shot if you do not need this verification for your work.

If you have the Band-in-a-Box® plugin, there is also a verification for chord names that are compatible with the plugin. If a chord name is not viable, it will be shown in red, like **D7sus411**. You can use the **Chord Builder**[833] to fix such chord names, or double-click the chord name to edit it manually.

For a list of chord name types that are compatible with the Band-in-a-Box® plugin please see the compatibility chart on PG Music’s website at [www.pgmusic.com/tutorial_chordlist.htm](http://www.pgmusic.com/tutorial_chordlist.htm)

### 6.5.6 Temporarily Hiding or Permanently Removing Chord Names

You can temporarily hide chord names so that they are not displayed. **Composer** shows or hides chord names independently in each score part[836]. For example, you can show chord names in a keyboard or piano part and hide them in a vocal part.
You can also permanently remove chord names from the song.

- To hide chord names in the current score part:
  1. With the mouse, navigate to the Chord Palette.
     -- OR --
     Type SHIFT+C. If the Clef Palette is displayed, type SHIFT+C a second time for the Chord Palette.
  2. In the Chord Name menu, turn off the check mark by the Show Chord menu item.
     -- OR --
     Click to toggle off the Show Chord Names button in the Chord Name Palette.
     -- OR --
     Type "qscn" for Quick Show (or Hide) Chord Name.

- To show chord names that have been hidden:
  - Repeat the above procedure to toggle on the Show Chord Names check mark in the Chord menu, or click to toggle on the Show Chord Names button.

- To permanently remove all chord names from the song:
  - Choose the Remove Chord Names command in the Chord menu.

6.5.7 Transposing Chord Names

Composer automatically transposes chord names in these two circumstances:

1. When you transpose the pitch of the entire song or some range of measures in the song, Composer automatically transposes the chord names.
2. For an instrument part which has a transposed instrument key, Composer automatically transposes the chord names for all of the measures for that part. This is done if, and only if: (a) the part displays only one staff, or (b) the multiple staves in the part all share the same instrument key transposition.

The transpositions of chord name keys is automatic. This is generally good. However, in rare cases where the spelling of a chord name is ambiguous, such as F#7 versus Gb7, and Composer makes a choice opposite of the one you would choose, Composer currently does not offer an option for you to change that decision.

If you change the notes in a chord, Composer will not automatically change the chord name. However, you can re-transcribe the chord names for any range of measures at any time.

6.6 Rehearsal Marks

Rehearsal marks are used by ensemble musicians to refer to a natural starting point for rehearsing some section of the score. A rehearsal mark looks like this:

![Rehearsal Mark]

You might also find rehearsal marks useful for your own purposes:

- To specify the start and end of practice loops.
As a temporary bookmark when you are working on a section of the score. You can then quickly return to it using the Go To Rehearsal Mark command (shortcut “qgr”) in the View menu.

### 6.6.1 Adding and Editing Rehearsal Marks

The procedures for adding and editing rehearsal marks are generally the same as for all types of text supported by Composer. See preceding General Procedures for Editing Text:

- Adding Text
- Editing Text
- Deleting Text
- Selecting Font Type, Size, and Properties
- Showing and Hiding Types of Text

### 6.6.2 Using Rehearsal Marks as Editing Bookmarks

One normally thinks of rehearsal marks as a notation to help ensemble musicians refer to the same score location while rehearsing together. You can also use rehearsal marks, however, as your own private aid when you are preparing the score. You can use rehearsal marks as bookmarks for locations in the score that you are currently editing.

Add any number of bookmarks at different locations in the score where you are currently working. You can give relatively long names, to help you later recall the location. For example, if you are working on a musical, you might enter “Alice’s Glance”:

![Music notation](image)

Later, to quickly return to the "Alice’s Glance" bookmark in the score, type “qgr” for Quick Go to Rehearsal Mark, or choose that command in the View menu. Composer will display the Go To Rehearsal Mark dialog box as shown below. Select the rehearsal mark that you previously added as a bookmark.

![Go To Rehearsal Mark dialog box](image)

Before you finalize your score, you can quickly go through it to remove your bookmarks.

### 6.6.3 Using Rehearsal Marks for Practicing Music

Rehearsal marks are used routinely by ensemble musicians. You can also use rehearsal marks for your own private practicing sessions. If you are a music teacher, you can create rehearsal marks that will be used by your students, who can use the practice loop feature in Notation Musician. Musician can display, play, and print the Notation .not files that you create with Composer.
Add any number of rehearsal marks in the score, following the general procedure for Adding Text. Once you have added the rehearsal marks, you can refer to them in the Practice Setup dialog, as described in Setting Up Practice Loops.
7 Recording from a Music Keyboard

With Composer, you can record music live from your music keyboard. By “music keyboard”, we mean a MIDI keyboard, or any MIDI input device such as a MIDI guitar.

If you have good keyboard skills, you can record directly from your keyboard with one or two hands at a comfortable tempo.

You can alternatively use your music keyboard to enter notes via the Step-Time Recording Method. With the Step-Time Recording Method, you can enter notes at your own pace without regard to rhythms or tempo. The rhythms of the notes that you enter in step-time will be determined by where you point the mouse before you play the notes on the keyboard.

The topics that follow describe various procedures for recording in step-time or real-time from your music keyboard:

- Setting Up Your Music Keyboard
- Recording in Step-Time
- Setting the Tempo for Real-Time Recording with a Metronome
- Setting Up Pickup Beats
- Setting the Instrument Sound for Recording
- Setting Up Transcription Options for Recording
- Recording Without Using the Metronome
- Starting and Ending the First Recording
- Recording Into a Selected Region (Punch-In)
- Recording from a Keyboard with One or Two Hands
- Recording Multiple Alternative "Takes"
- Recovering an Interrupted Recording
- Cleaning up the Performance or Notation after a Recording

See also:

- Setting up the Metronome

7.1 Setting Up Your Music Keyboard

The instructions here for setting up a music keyboard apply to any MIDI input device, such as a MIDI keyboard (or “controller”) or MIDI guitar. These instructions refer to the MIDI input device as a music keyboard.

TIP: We highly recommend using the default Notation Software Synth as the Playback device, and using the ASIO driver for recording into Composer. The ASIO technology allows for near zero-latency real-time recording to help you make the most accurate play-recording possible.

Connect your music keyboard to the computer, and install its MIDI device driver:

- Follow the instructions for Installing a USB or MIDI Cable Between Your Sound Card and Keyboard.
- If you have not done so already, install in Windows the MIDI device driver software that came with your MIDI keyboard.
To test whether Composer is correctly configured to receive notes from your music keyboard:

- Open Composer, then just start playing on your music keyboard. You do not have to click Composer’s Record button. If you hear the notes you play, then Composer is ready to record notes from your MIDI keyboard into your computer.

- If you do not hear any notes as you play on your music keyboard, then determine whether the problem is with your keyboard connection, your MIDI sound card or MIDI USB hub, or with your MIDI input device driver:
  - Follow the instructions in What to Do If Recording Does Not Work [257].

### 7.2 Recording in Step-Time

If you have good keyboard skills, you can record directly from your keyboard with one or two hands at the full tempo of the song.

Alternatively, you can use your music keyboard to enter notes via the Step-Time Recording Method, playing one note or chord at a time. Click the Step-Time Recording [318] button. Choose the note duration you want to add. Then just point the mouse to the location where you want the note or chord to be added, and play it on your music keyboard.

With the Step-Time Recording Method, you can enter notes at your own pace without regard to rhythms. The rhythms of the notes that you enter in step-time will be determined by where you point the mouse before you play the notes on the keyboard.

**Comparison of Real-Time and Step-Time Recording Methods**

<table>
<thead>
<tr>
<th></th>
<th>Real-Time Recording</th>
<th>Step-Time Recording</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyboard skill required</strong></td>
<td>Intermediate or advanced keyboard skill required.</td>
<td>Only basic keyboard skill required.</td>
</tr>
<tr>
<td><strong>Speed of note entry</strong></td>
<td>Fast note entry, at song tempo, or whatever is comfortable.</td>
<td>Slower note entry at your own pace, without regard to rhythm.</td>
</tr>
<tr>
<td><strong>Switching back and forth</strong></td>
<td>You do not have to leave the music keyboard until the recording &quot;take&quot; is completed.</td>
<td>Sometimes you have to go back to the mouse or computer keyboard to choose a new duration, or choose a new note entry location. But you can often rely on automatic advancing of the note entry location.</td>
</tr>
<tr>
<td><strong>Control over expressiveness of note playback</strong></td>
<td>Your notes will be played back with exactly the same loudness and timings as you originally recorded them.</td>
<td>Your notes will also be played back with exactly the same loudness as you originally recorded. But, the notes will be played back exactly at their as-notated locations. The as-performed durations will be determined by the Note Duration Adjustment Table [328], which you can customize.</td>
</tr>
</tbody>
</table>
Further, you can combine the Step-Time Recording method with the Sequential Note Entry method. This way, do you not have to choose note duration values. Just move the mouse to the position where you want the next note or chord to be entered, and play it at your keyboard. The duration of the previous note or chord will end where you enter the next note or chord. For sequences of notes with the same duration, you do not even have to leave your keyboard: just play them one after another, at your own pace.

The Step-Time Recording method offers an easy way to enter notes without requiring a high level of music keyboard skill. You can enter the notes at your own pace without regard to rhythm. As you add notes with the Step-Time Recording method, you can include expression by playing the notes with different degrees of loudness. Composer will play back the notes with the same individual loudness.

The Step-Time Recording method has the disadvantage, however, that you cannot finely record the timing of the notes. Composer will play back the notes exactly at the locations where you added them. The as-performed duration of the notes played back will not be literally the full notated duration; the as-performed duration of the notes will be determined by Composer’s Note Duration Adjustment Table, which you can customize. Even so, with the Step-Time Recording method you have relatively little control over the as-performed duration of the note, as well as its attack.

If you use the Step-Time Recording Method, and you do want the playback to include subtle timings for notes, then you can edit them while viewing the Piano Roll Notation for the notes, as described in Editing As-Performed Attack Location and Duration.

7.3 Setting the Tempo for Real-Time Recording with a Metronome

Recording into Composer and keeping tempo with the metronome is the quickest way to enter notes with your keyboard if you are comfortable with improvisational playing or playing from memory. Before you start recording a new song, you should set the tempo for the song. If you want to record the song at a slower tempo than that at which you wish the song to be played back, then you should still set the tempo for the song according to how you want it played, rather than the tempo at which you wish to record. You can use Composer’s tempo slider control in the main toolbar to temporarily slow down the tempo for recording purposes.

The following procedure describes how to set the playback tempo at the start of the song. If the song already has tempo changes throughout and you wish to change the tempo, then follow instructions in the topic Editing the Tempo.

To set the playback tempo of a new song:

1. Click the Tempo button in the toolbar as shown below:
Composer will display the Set Tempo dialog:

The tempo unit value will usually be a quarter note, dotted eighth note, or eighth note, depending on the meter. For example, in a 4:4 meter, the tempo unit will be quarter notes per minute. In a 6:8 meter, the tempo unit will be dotted quarter notes per minute if the tempo is fast, or eighth notes per minute if the tempo is slow.

2. Change the numeric value for the Initial Tempo.
   -- OR --
   Use the slider to change the Initial Tempo.

3. Optionally enter an Ending Tempo value by entering a numeric value or using its slider. You can have a continuous accelerando or decelerando, by specifying a different Ending Tempo than the starting tempo.

4. Click the Audition button to hear the song played according to your newly entered tempo. If you want to re-adjust the tempo, click the Audition or Cancel button, or stop the playback in the score window, to cancel the audition. You can then enter another tempo value and audition it.

5. Hit the OK button to save your most recently entered tempo. Hit the Cancel button to restore the tempo as it was before you used the Set Tempo command.

To prepare for recording at a tempo slower than the intended playback tempo:

- Enter a percentage tempo adjustment value that is less than 100 in the tempo adjustment control:
In the above example, the temporary recording tempo will be 80% of the normal playback tempo.

-- OR --

- Use the up and down spin buttons in the above tempo adjustment control to set the percentage value.

-- OR --

- While holding down the "T" key, type the \( \downarrow \) or \( \uparrow \) keys to adjust the percentage tempo value down or up.

### 7.4 Setting Up Pickup Beats

When you record or play from your music keyboard, you will usually want Composer to play some lead-in measures or metronome beats. If you are recording or playing at the beginning of the song, Composer will play the metronome for the number of lead-in measures and beats that you specify. If you are recording into or playing a selected region of the song, Composer will play the portion of the song immediately preceding this region, for the number of lead-in measures and beats that you specify.

The pickup beats that you specify are saved independently for each song.

To specify the pickup (lead-in) beats for recording:

1. In the Perform menu, choose the Record Start Pickup Beats command. Composer will display the following Pickup Beats dialog:

   ![Pickup Beats Dialog](image)

2. Turn on the check mark for "Play the pickup beats even if metronome is silent thereafter."

3. Enter a value of 1 or more for "Count full measures before starting measure".

4. If you want these Pickup Beat values to be applied not only to the currently opened song, but also to any other new song file or transcribed MIDI file, then click the Save As Default button.

5. If you have previously used the Save As Default option and want to apply those saved pickup beat values to the currently opened song, then click the Restore Default button.

6. Click the OK button to apply the pickup beats to the currently opened song.

### 7.5 Recording Without the Metronome

If you enjoy improvising on your MIDI instrument, or you want to play piece with lots of tempo changes or "feeling" but still get readable sheet music, then you will enjoy Composer's "metronomeless recording" capability. If you wish to use this method of recording, you will first record your music, and then use Composer's Rebar feature to set the barlines and adjust the meter(s) for the final score.
This "metronomeless" technique is also useful for creating "live" feeling backing tracks for performances, and also create the sheet music for accompanying musicians or vocalists.

When you record into a new song, the song does not need to have as many measures as you might record. Composer will automatically add measures during your recording.

After you have completed the first recording, Composer will automatically determine the key signature based on its analysis of the harmonies you have played. If Composer incorrectly determines the key signature, you can easily change it, as described in Key Signatures.

To record the notes live from your music keyboard into a new song:

1. If you are using both your right and left hands to play the keyboard, and you wish Composer to automatically distribute the notes into right- and left-hand staves, then pre-select the two staves you wish to record into.

2. To start recording, click the Record button in the toolbar:

   -- OR --

   Type CTRL + Space (hold down the CTRL key while hitting the Space bar).

   By default Composer will play the metronome for a two-measure lead-in before the beginning of the portion of the song to be recorded. To specify a different number of pickup measures and beats, follow the instructions in Setting Up Pickup Beats.

3. After allowing the time indicator in the upper left to reach "0" and turn green, start playing your MIDI keyboard.

   During the recording, Composer advances a blue vertical playback cursor to indicate the position in the song. Also, it displays red rectangles that represent the pitch and durations of the notes you have recorded:

4. Complete the recording by clicking the Record button again, by clicking the Stop button, or by hitting the SPACE key.

   Composer will immediately transcribe your recording to notation, including determining the key signature, as illustrated below:
5. The notation will probably look quite sloppy at this point, but you can adjust the barlines and meters to show the appropriate notation while still preserving your performance by using the Rebar feature. You can also use this technique to create "live" feeling backing tracks for performances, and also have high quality sheet music for accompanying musicians or vocalists.

7.6 Setting the Instrument Sound for Recording

Before you start recording notes into a staff, you should set the instrument sound for that staff. Follow the procedure described in Changing the Instrument Sound of a Staff.

**NOTE**: In choosing the instrument sound, it is important that you choose a MIDI output device that does not have a playback delay. Many MIDI output devices that are software synthesizers have playback delays of 100 milliseconds (1/10th of a second) or more. If you use one of these devices, then as you play on your music keyboard, there will be a delay from the time you press a key to the time you hear its sound. This delay will make it impractical for you to record a performance. Instead, you should temporarily assign to the staff a MIDI output device that has no delay.

To determine if the MIDI output device for a staff has a playback delay:

1. Follow the procedure for Setting Up Your Music Keyboard.
2. Play a note on your keyboard. Is it immediately responsive to your action on the keyboard? Or do you feel like you want to press your fingers deep into the keys to make them sound sooner? The latter approach will not work. If there is a delay, it is probably not that your computer is slow. It is very likely that there is a built-in delay in your MIDI output device. For more information about this, see Anticipating the Delay on Some MIDI Output Devices.

If you find that the staff that you want to record into has a playback delay, then follow the next procedure.

To work around the problem that a staff uses a MIDI output device with a playback delay:

- Assign a different MIDI output device to the staff that you are recording into. Be sure that it does not have a playback delay.
- OR --
  - Create a temporary staff for recording. Assign a MIDI output device to it that does not have a playback delay. When you have completed a successful recording, copy that staff (or regions of it) to the staff that has the MIDI output device that you want to hear during playback.

Before you start recording, you might want to improvise some musical ideas on your keyboard before you attempt to commit them in a recording. If so, then you will want to select the instrument sound of the staff which you are about to record.
To assign the instrument sound of a staff to your music keyboard, and play notes on the keyboard using that sound before you start recording:

1. While holding down the "R" key (for "record", even though you are postponing recording), click anywhere in the staff of the staff you intend to record into.

Composer indicates that this staff has been selected for recording by drawing a red arrow right before the beginning of the first staff shown in the window for this staff:

2. Optionally hit some keys on your MIDI keyboard. You will hear the instrument sound of the staff that you selected.

At this point you have set up the staff as though you were about to practice the part with your music keyboard. If you were to start playback by pressing the playback button, or by hitting the SPACE key, Composer would mute (silence) the selected staff. Any notes that you play at your music keyboard would be assigned the instrument sound of the selected staff.

3. While holding down the "R" key, click anywhere in the staff of the staff again.

Composer will remove the red arrow next to the staff, and will change the solo button from play-along to no solo.

The instrument sound for the staff will continue to serve as the sound for notes that you play on your music keyboard prior to recording. It is necessary to change the solo option for the staff from play-along to no solo, so that when Composer later plays the song, the notes in this staff will be heard rather than muted.

### 7.7 Setting Up Transcription Options for Recording

Before you start recording, use the Transcription Options command in the Setup menu to determine how Composer transcribes your recording into music notation. The transcription options determine whether:

- Standard versus jazz (swing) rhythm notation will be used.
- Single voices or split (upper and lower) voices will be detected and notated.
- Overlaps of notes will be removed to reduce the number of ties in the score.
- Rests smaller than a specified size (quarter, eighth, or sixteenth) will be removed.
- Graces, trills, and tremolos will be detected and notated.

Composer remembers the transcription options you most recently specified. Therefore, you need to use the Transcription Options command only if you want to change the options.

If, after Composer has transcribed your recording, you are not satisfied with the transcription, you have some options available for improving or cleaning up the notation:

- Use the Re-Transcribe command in the Format menu to apply different transcription options to selected staves.
Use the Remove Overlaps of Notes command to eliminate and simplify ties.

Eliminate small rests by selecting a region of the score and using one of the Remove Rests commands in the Region menu. Or, select a group of notes and rests, go to the Note menu, and use one of the Remove Rests commands in the Clean Up Rests and Overlapping Notes submenu.

Use the Transcribe Grace Note command, if you did not choose the grace note option when you first recorded.

7.8 Starting and Ending the First Recording (Using the Metronome)

If you have just started a new song and you wish to record notes from your music keyboard, you should first make sure that the song has the right meter (time signature). If it does not, set the desired meter in the first measure, as described in Meters (Time Signatures). Then set the tempo for the song, as described below.

When you record into a new song, the song does not need to have as many measures as you might record. Composer will automatically add measures during your recording.

After you have completed the first recording, Composer will automatically determine the key signature based on its analysis of the harmonies you have played. If Composer incorrectly determines the key signature, you can easily change it, as described in Key Signatures.

To record the notes live from your music keyboard into a new song:

1. If you are using both your right and left hands to play the keyboard, and you wish Composer to automatically distribute the notes into right- and left-hand staves, then pre-select the two staves you wish to record into.

2. Choose a tempo at which you are comfortable playing the melody, as described in Setting the Tempo for Recording.

3. To start recording, click the Record button in the toolbar: -- OR --

Type CTRL + Space (hold down the CTRL key while hitting the Space bar).

By default Composer will play the metronome for a two-measure lead-in before the beginning of the portion of the song to be recorded. To specify a different number of pickup measures and beats, follow the instructions in Setting Up Pickup Beats.

4. While listening to the metronome, and after waiting for the pickup beats, start playing at your MIDI keyboard.

During the recording, Composer advances a blue vertical playback cursor to indicate the position in the song. Also, it displays red rectangles that represent the pitch and durations of the notes you have recorded:
5. Complete the recording by clicking the Record button again, by clicking the Stop button, or by hitting the SPACE key. Composer will immediately transcribe your recording to notation, including determining the key signature, as illustrated below:

7.9 Recording Into a Selected Region (Punch-In)

You can record into a selected region of a song. This task is referred to as "punch-in" in music studios. If there are any notes in the selected region, they will be erased as soon as you start recording into the region.

The region can be any number of measures. The region can start and/or end in the middle of a measure. Composer will play the metronome and a portion of the song that leads into the section you are recording, so that you can synchronize the beginning of your recording with the beat of the song.

You can optionally select and record into two adjacent keyboard staves. Composer automatically distributes the notes you play between the right- and left-hand staves.

To record into a selected region:

1. Select the region by holding downing the CTRL key and dragging the mouse across any number of measures and beats. See Selecting and Editing Regions of a Score. You can record into two staves at a time by selecting two staves and playing at your keyboard with both your right and left hands.

2. Press the Record button in the toolbar.
-- OR --

Type CTRL+SPACE.

Composer erases the region that you are punching in with a new recording. If you do not record anything, and toggling off recording, then the original notes will be restored. Or, if you do not want to keep your punch-in record, just use the Edit Undo command (CTRL+Z).

3. Listen for Composer to play the number of lead-in measures that you have set with the Pickup Beats command. Start playing at your music keyboard when the lead-in measures and beats have completed.

Just as with a first-time recording, Composer temporarily displays your recorded notes as red rectangles:

Composer will automatically stop recording at the end of the selected region. Then it will transcribe your recording into the selected region of the score. Composer will use the same key signature as the one preceding the recorded region.

7.10 Recording from a Keyboard with Two Hands

When you record from the music keyboard, you can record into a single staff, or alternatively, into two separate staves that are displayed as right- and left-hand keyboard staves. If you record into two separate staves, Composer automatically distributes the notes between them using the same logic as it uses for the Split Hands command.

To record into a pair of right- and left-hand keyboard staves:

1. While holding down the CTRL key, drag the mouse to select a region that spans a pair of right- and left-hand keyboard staves, such as illustrated below:
NOTE: The region that you select will be replaced by your punch-in recording.

2. Follow the normal procedure for recording. Click the **Record button** or type **CTRL+SPACE**, to start recording. See **Recording into a Selected Region (Punch-In)**.

### 7.11 Recording Multiple Alternative Takes

After you have completed recording, the region you record will remain selected. Composer indicates the selected region with a gray background. If you are not happy with your recording and want to try again, just press the **Record button** again, or type **CTRL+SPACE** again. Composer will erase your previous recording and will record your new performance. This is sometimes called a second "take". You can do as many "takes" as you want. And they will be temporarily saved.

If after you have made two or more takes you decide you would like to keep some previous take, use the Undo command in the Edit menu, or type **CTRL+Z**, to restore some previous take. Or, use the Redo command, or type **CTRL +Y**, to restore some later take. This way you can review each take and save the one you like best before going on to other recording or editing tasks.

This is what the Edit menu looks like after you have recorded three takes:

![Edit Menu](image)

If you use the Undo command once, the score will be restored to what it looked and sounded like after your second take. If you use the Undo command again, the score will be restored to what it looked and sounded like after your first take.

Note that Composer's capacity for saving and restoring recording takes is limited to this use of the Undo command. This is a quick and easy way to manage takes, but there is an important limitation. After you have committed to a take and start making other changes to the song, you will not usually be able to review and restore other takes. If this limitation is a problem for you, then you may want to manually save each take as a separate song file. This is easy to do. And Composer lets you open and view multiple songs at a time, so that you can easily compare your different recording takes.
### 7.12 Recovering an Interrupted Recording

Suppose you have recorded three minutes of an inspirational improvisation, but upon completion of the recording your system is interrupted or Composer abnormally terminates for some reason. There is a good chance that you will be able to recover your recording. Composer saves your most recent recording as a temporary MIDI file before Composer attempts to transcribe it to notation.

**To recover your most recent recording:**

1. In the File menu, choose the Open command.
2. In the File Open dialog, navigate to the C:\Users\Public\Documents\Notation_3\Songs directory.
3. Open the file named recordng.mid. Note that this filename is intentionally missing the letter "i" in "recording".
4. If you wish to save this recording, save it as a Notation .not file.
5. If this recording was a new staff for a song, or part of an existing staff, copy the notes from the recording to the clipboard, and then paste them into the song you were working on. For details, see Using the Clipboard [546].

### 7.13 Cleaning up the Performance and/or Notation after a Recording

After you have made a recording, it is likely that there will be details in your performance that you will want to change—both the sound and the notation. A wealth of tools are available in Composer to "clean up" your recording. Listed below are some of the most common tools you might want to use.

Some of these tasks are best done through trial and error. If you try a certain way to clean up the performance and are not happy with the results, just use the **Undo command** [563], and try something else. Your original performance will not be lost.

**To adjust the barlines, meter(s) and notation for a newly recorded performance done without using the metronome ("metronomeless" recording):**

- The first step you should do after you have recorded a "metronomeless" recording is to use the **Rebar** feature to set the proper barlines and meter(s) for your score. This feature will move your score much closer to a readable piece of music. You can then use the following tips to fine-tune the score.

**To clean up the notation of a newly recorded performance if you have used the metronome or have finished using the Rebar feature to set the proper barlines for a metronomeless recording:**

- If the notation looks too complicated, with too many ties, overlapping notes, dotted note values, and small rests, try using the "Reduce number of ties" and "Remove rests smaller than" options in the **Re-Transcribe command** [563]. You might be able to eliminate other overlapping notes by choosing the "Split (Upper and Lower) Voices" option in the **Re-Transcribe command** [563].

- If grace notes, trills, or tremolos are written-out in difficult-to-read detail, then use the Transcribe Ornaments option in the **Re-Transcribe command** [563] so that the efficient short-hand music symbols for these ornament are displayed rather than the written-out notes.

You can also convert individual written-out short notes to notated grace notes [563]. You can convert individual written-out trills or tremolos to notated trills or tremolos [563].
If you accidentally played a few extra notes very lightly or with very short durations, you can easily remove them with the Remove Silent Notes command.

If you played some incorrect note pitches, you can change them by dragging the notes or type P + Up (or Down) Arrow. For details, see Editing Note Pitch.

If Composer spells the pitch and accidental of a note differently than what you would like, then you can change the enharmonic spelling by selecting the note and typing E + Up (or Down) Arrow.

If you played a note too early or late, you can shift its notated and performed attack at the same time. Or, if you are happy with the as-performed timing of the attack of the note, but want to change its notated location so that it is lined up on a stronger beat, then you can shift only the as-notated attack. For details, see Editing Note Location (Attack).

If you played the note with a longer or shorter duration than you intended, you can change the notated and performed duration of the note. Or, if you are happy with the as-performed duration of the note, you can change just the as-notated duration without affecting the performed duration of the note. See Editing Note Duration.

To clean up the actual performance of a new recording if you have used the metronome, or have used the Rebar feature on a "metronomeless" recording:

- If you would like your performance to have a more crisp, on-the-beat sound, then you can "quantize" the performance to match the notated locations (attacks) of the notes. You can quantize the note attacks while preserving their as-performed durations. Or, you can also quantize the performed duration of the notes. For details, see Quantizing the Performance of Notes.

- If your recording lacks expressiveness because you were performing in synchronization with a fixed metronome tempo, you can graphically edit the tempo, to add such features as pauses (fermatas) and accelerandos.

- You can graphically edit the overall volume throughout the staff.

- You can edit the individual loudness of specific notes.

- As mentioned above, if you accidentally played a few extra notes very lightly or with very short durations, you can easily remove them with the Remove Silent Notes command.
8 Viewing and Editing the Music Performance

Preceding sections of this Composer documentation describe how to edit the notation of a song. This section describes how to edit the musical performance of a song.

Composer offers you a high degree of control over both what the song looks like--its notation--and what the song sounds like--its performance. The sound editing capabilities of Composer are comparable to the MIDI recording and editing capabilities of a good MIDI sequencer. A major difference between Composer and most MIDI sequencers is that the tools for editing the notation and the MIDI performance are highly integrated in Composer. You can always see a graphical representation of the performance drawn on top of the notes, so that you can clearly see the relationship between the notation and the performance.

You can view the exact performance of notes in the form of Piano Roll Notation, as illustrated below. The left and right edges of the rectangles indicate the timings of the performed note attacks and releases.

The Piano Roll Notation offers you a fairly accurate visual view of the timing of notes. For greater accuracy, you can move the mouse cursor over a note for a report of its exact timing, represented as offsets of the performed attack and release times from the as-notated location and end of the note.

You can easily adjust the exact performed attack and/or release of a note by selecting it and using keyboard shortcuts such as D+ to increase the performed duration of the note.

You can view the individual loudness of notes, such as illustrated here:

To increase or decrease the loudness of one or more selected notes, type L+ or L-. To gradually increase or decrease the loudness over a range of notes, while preserving individual relative differences in note loudness, type C+ or C- (where "C" is for "crescendo").

Many types of musical performance data can be of a continually changing nature, such as a continually changing volume level, tempo, or guitar pitch bend. For such kinds of continually changing music data, Composer offers a graphical way to view and edit the performance, which is quite intuitive.
The following example illustrates the graph of the rubato (expressively changing) tempo in the main theme of George Gershwin's Rhapsody in Blue.

You can edit the graph with GraphOverNotes™ Palette tools such as Draw Curve 
Draw Sloped Line 
and Erase 

Also, if your MIDI recording instrument includes controls for volume, sustain pedal, pitch bend, and general MIDI controllers, you can record these types of musical performances live, and merge them with previously recorded notes. This is illustrated in the procedures for editing Note Pitch Bend 

Composer also supports mid-staff instrument sound changes which are technically "MIDI program changes". For example, somewhere in the middle of a violin part, you can switch from a bowed string sound to a pizzicato sound. Or, in a horn part, you can switch to a muted horn sound.

The high degree of integration of notation and performance editing in Composer means that you do not have to compromise the quality of one (notation or the performance) for the other. You will find that you can productively refine both the notation and performance with the insight you gain by seeing both together. The following example illustrates how you might add a hairpin crescendo mark to match the increasing slope of the volume graph.
If prior to using Composer, you have only been working with the notation, or only working with the MIDI sequencing, you will discover in Composer the rich unified world of both sound and notation of music.

8.1 Viewing and Editing the Performance of Notes

Whether you have imported notes from a MIDI file, or entered notes into a score by recording them from a music keyboard, or by manually entering them with the mouse, Composer offers you many ways to edit how the notes are performed during playback.

With convenient commands that you can apply to one or more selected notes at a time, you can:

- **Change the exact time that a note is played without necessarily changing where the note is located in the score** (edit only the "as notated" score).
- **Change the exact duration that a note is played without necessarily changing its note value in the score** (edit only the "as performed" performance of notes).
- Request Composer to **analyze the differences between as-notated durations and as-performed durations of notes** in one region of a song and apply these differences as note duration adjustments to another region of the song.
- **Edit the loudness of individual notes**. Create crescendos and decrescendos across a range of notes. Increase or decrease the contrast of loudness between notes.
- **Add pitch bends to notes**, to simulate the musical effect achieved, for example, by a guitarist when he stretches a fretted string by pushing against it sideways with his fingers.

Procedures for accomplishing all of the above note editing tasks are described in the topics that follow.

If you wish to only view the performance aspects of notes so that you can annotate the score to give live musicians the directions for recreating the performance, you can use the "Show Piano Roll" command in the View menu (keyboard shortcut Ctrl + Shift + Y). You can then use the Piano Roll to help you add performance annotations to the score that will help your "real" musician(s) to perform the piece as you intend.

8.1.1 Viewing and Editing the Attack and Release of Notes

8.1.1.1 Understanding Piano Roll Notation

One of the main ways you can give "feeling" to the performance of notes, that you have previously entered with the mouse and keyboard, is to adjust the exact as-performed timing of the notes. That is, you can adjust the as-performed attack and release times of the notes.

Composer’s Piano Roll Notation helps you visualize the as-performed timing of notes:

![Piano Roll Notation](image)

The rectangles drawn on top of the notes show the actual performed timing of the notes. These rectangles are called "Piano Roll Notation" because they resemble the hole cutouts for notes in piano rolls of mechanical player pianos that were popular in the late 1800’s and early 1900’s. The left and right edges of the rectangles indicate the as-performed timing of the notes. Because normal spacing of notes in a score is not exactly proportional to actual note durations, the lengths of the rectangles are not totally precise. Nevertheless, the rectangles serve to clearly show you where notes start and stop.
Defining a few terms associated with the Piano Roll feature.

All these terms can refer to the notated (as-notated) or performed (as-heard) aspect of the note, and which can be edited separately in Composer:

- **Attack** - the beginning of a note
- **Duration** - the length of time a note sounds
- **Release** - the end of a note
- **"As performed"** - what you actually hear when playing the song file in Composer
- **"As notated"** - what you see as the sheet music displayed in Composer

The color of rectangles may be yellow (below) instead of white (above):

If the piano roll rectangle is white it will not be edited. If it is yellow it will be edited.

If the color of the notation is gray then the notation will not be edited. If it is black then it will be edited.

There is some variation in the "as performed" durations and attacks of notes that give "life" to a performance. Composer's transcription of .mid or .kar files is optimized to give you an easy-to-read score while keeping the "life" in the performance. Conversely, if you have a very "robotic" file, you can use Composer's Piano Roll tools to create a more humanized performance of the song.

8.1.1.2 **Viewing Piano Roll Notation While Annotating a Score**

Sometimes you might want to view the Piano Roll Notation as you are annotating the score. For example, as you are adding staccato marks for notes, you can view the piano roll rectangles to see
which notes are performed with a short duration relative to their as-notated duration. Those are the notes for which you might want to add staccato marks:

8.1.1.3 Using the Piano Roll Palette

To edit the piano roll rectangles of notes rather than just view them, you need to use the Piano Roll Palette:

To begin editing the as-performed locations and durations of notes:

- Navigate to the Piano Roll Palette.
- OR
- Type SHIFT + Y.
Composer enables you to independently edit the notation of notes and the as-performed timing of the notes.

To tell Composer whether you want to edit just the as-notated locations and durations of notes, or the as-performed locations and durations, or both:

- Click the Edit Both As-Performed and As-Notated button if you want the editing of note locations and durations to affect both the notation that you see and the performance of the notes that you hear.
  -- OR --
  Type "pn" or "np" for as-performed equals as-notated.

- Click the Edit As-Notated Only button if you want the editing of notes to effect only what you see in the score but not the actual performance of the notes.
  -- OR --
  Type "en" for edit notation.

- Choose the Edit As-Performed Only option if you want the editing of notes to effect only the timing of the notes as you hear them played back, without changing the way they are notated in the score.
  -- OR --
  Type "ep" for edit performance.

When you click one of the three Piano Roll Palette buttons to choose a combination of editing the notation and/or performance of notes, Composer will display the piano roll rectangles and notes differently, according to which option you choose:

- If your editing affects the notation, then the notes are shown in normal black color. If your editing does not affect the notation, then the notes are de-emphasized with the gray color.

- If your editing affects the performance, then the piano roll rectangles are filled with a bright yellow color. If your editing does not affect the performance, then the piano roll rectangles are de-emphasized with a white interior.
Once you have chosen one of the options for Edit Both As-Notated and As-Performed, Edit As-Notated Only, or Edit As-Performed Only, then you can edit notes in the following ways:

- Move the attack (start location) of the note.
- Move the release of the note, thus changing its duration.
- Shift both the attack and release of the note at the same time, so that the duration of the note is preserved but the note starts at a different location.
- Quantize ("snap") the as-performed attack and/or release of the note to its notation location or duration.

The following diagram shows what the Piano Roll Palette buttons look like, depending on which option you have chosen for Edit Both As-Notated and As-Performed, Edit As-Notated Only, or Edit As-Performed Only.
You can find out the purpose of each of the editing buttons in the palette by briefly holding the mouse over the button. Composer will display a short message explaining what that button does, and what the keyboard short-cut for the command is. You can also learn what the Piano Roll Notation buttons do by understanding the meanings of the small drawings on the button faces.

The graphics on the piano roll palette buttons follow a consistent convention, which is summarized in the following diagram:

**Shift note left, both as-notated and as-performed.**

For example, the above button has the following effect on the selected note:

Each of the four corners of the button may or may not have an arrow that points to the left or right. The two arrows on the top half of the button indicate the effect of the button on the notation of the note. The two arrows on the bottom half of the button indicate the effect of the button on the as-performed timing of the note. The direction of the arrow indicates whether the attack or release of the note is to be moved to the left or the right. In the above example, the button shifts the entire note, both its notation and its as-performed timing, to the left.

If the button only affects the notation of the note, and not its as-performed timing, then there are no arrows in the bottom half of the button face, and the piano roll icon in the button is displayed in a faded color. Also, the button may affect only the attack, not the release, in which case there is an arrow only on the left side of the button, not the right side. The following diagram illustrates these cases:
Move as-notated attack right.

Leave As-Performed Timing Unchanged

For example, the above button has the following effect on the selected note:

![Diagram showing the effect of moving the as-notated attack right.](image)

If the button only affects the as-performed timing of the note, and not the notation, then there are no arrows in the top half of the button face, and the quarter note icon in the button is displayed in a faded color. The button may affect only the release, not the attack, in which case there is an arrow only on the right side of the button, not the left. The following diagram illustrates these cases:

Move as-performed release right.

Leave As-Notated Attack and Release Unchanged

For example, the above button has the following effect on the selected note when it is clicked several times:

![Diagram showing the effect of moving the as-performed release right.](image)

To see specific examples of how these buttons affect the notation and performance of notes, see Editing As-Performed Attack Location and Duration[^4].
See Displaying As-Performed Attack and Release Offset Data for an explanation of the Save and Apply Duration Adjustments command.

8.1.4 Displaying As-Performed Attack and Release Offset Data

Sometimes you may need to edit the timing of notes with greater accuracy than is graphically displayed by the Piano Roll Notation. If so, you can also display numeric information for notes that indicates how much the as-performed timing deviates from the as-notated representation. This is called the timing “offset”.

To display numeric data for the timing of notes:

1. Navigate to the Piano Roll Palette.
   -- OR --
   Type SHIFT + Y.
2. In Select Mode, move the mouse over any note (without clicking).
   Composer will display the offsets of the as-performed from the as-notated attack and release, as illustrated below:

   ![Illustration of offset display]

   There are two numbers separated by a slash (/) character. The first number indicates how many ticks the as-performed attack of the note differs from the as-notated attack. The second number indicates how many ticks the as-performed release (end) of the note differs from the as-notated release.

   In Composer, there are 480 ticks per quarter note. Thus, there are 60 ticks in a 32nd note, because there are eight 32nd beats in a quarter note, and 480 ticks divided by 8 is 60.

   In the example above, the quarter note is actually played 28 ticks before its notated location at the third quarter note beat of the second measure. Thus, the note is played about a 64th note early. The end of the note is played 67 ticks after its notated value. Thus, the end of the note is released about a 32nd note later than its notated duration indicates. This means that the note was played with some legato, overlapping the next note.
3. Click a single note to display its timing information in the status bar.
   For example, this is what the status bar looks like if the highlighted third quarter note in the second measure above is clicked:

   ![Status bar example]

   The status bar displays the same timing offset information (-28/+67) for the note as that which is displayed when you move the mouse over the note. The status bar also shows the measure, beat, and sub-beat for the as-notated attack and release of the note. In this example, the note begins at the third beat of the second measure, and ends at the fourth beat. The first beat in a measure is indicated as 0 rather than 1.
4. To display the average timing of several notes, drag the mouse over the notes to select them.
In the status bar, Composer displays the average deviations of the as-performed attacks and releases from the as-notated attacks and releases of the notes.

For example, this is what the status bar looks like when these five notes are selected:

![Status Bar Example](image)

The five notes are played at an average of 23 ticks late. The as-performed releases of the notes are an average of 35 ticks later than the as-notated durations.

Some ways that you can use this information are:

- Learn about whether your performed recordings on the keyboard tend to lag behind the metronome. You can use this as a tool for improving your performance skills.
- If the attack offset is large, you might want to "snap" (quantize) the as-performed to as-notated attacks to create the musical effect of "crisp" rhythms. Or, you might want to shift the attacks to the left or right so that the natural human feel (per-note offsets) of the performance is preserved, but the notes overall are played closer to the beat.
- You can preview the duration offset information before saving and applying the offsets to another selection of notes.

8.1.1.5 Editing As-Performed Attack Location and Duration

The as-performed attack location and duration of a note can differ from its as-notated location and duration. Composer offers several commands that enable you to change the as-heard timing of the note independently of its notated location and duration. You can also "snap" (quantize) the as-performed attack and/or release of a note to be exactly the same as its as-notated location.

As you edit the as-performed attack and duration of a note, Composer enables you to clearly see the results in Piano Roll Notation. You can also use the Show Attack and Release Offsets command to see a numeric comparison between the as-performed and as-notated attacks and releases of notes.

To change the as-performed duration of one or more selected notes, while leaving the as-notated duration of the notes unchanged:

1. Navigate to the Piano Roll Palette.
   - OR -
   Type SHIFT + Y.

2. Click the Edit As-Performed Only button in the piano roll editing palette, as illustrated above.
   - OR -
   Or type "ep" for edit performance.
3. As you move the mouse over a notehead, Composer will display the offsets of the as-performed attack and release from the as-notated attack and release, as illustrated below. The as-performed attack is 24 ticks after the as-notated attack; and the as-performed release is 19 ticks before the as-notated release:

![Diagram of note with offsets](image)

In Composer, there are 480 ticks per quarter note. Thus, there are 32 ticks in a 64th note. In the above example, the attack of the first note of the triplet is somewhat less than a 64th note after the as-notated location of the note at the fourth beat of the 4:4 meter measure.

4. Drag the mouse to select the notes for which you wish to edit the as-performed durations. The color of the piano roll for the selected notes changes from yellow to blue.

![Selected notes with piano roll](image)

5. Decrease or increase the as-performed duration of the notes by doing one of the following:

   (a) Click the Decrease Duration or Increase Duration button in the piano roll palette, one or more times:

![Decrease and Increase Duration buttons](image)

   -- OR --

   (b) While holding down the "D" key (for duration), type the ← or → key one or more times to decrease or increase the duration. Hold down the arrow key to continually decrease or increase the duration until you release the key. This method is far more convenient than using the menu commands.

   -- OR --

   (c) Use any of the following keyboard shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>d+{ticks}</td>
<td>Increase duration</td>
<td>d+20</td>
</tr>
<tr>
<td>d-{ticks}</td>
<td>Decrease duration</td>
<td>d-12</td>
</tr>
<tr>
<td>d={ticks}</td>
<td>Set duration</td>
<td>d=202</td>
</tr>
</tbody>
</table>
NOTE: There are 480 ticks in a quarter note. For example, an 8th note has 240 ticks. The shortcut "d=202" sets the performed duration of the note(s) to somewhat less than the full duration of an 8th note.

In the following example, three notes in a triplet are selected:

The status bar reports that the as-performed attacks are an average of 10 ticks after the as-notated attacks. The as-performed releases are an average of 28 ticks before the as-notated releases.

After typing D+ several times, or after typing "d-28" to decrease the duration by 28 ticks, the as-performed durations of the three notes are shortened and look like this:

The above status bar reports that the as-performed releases are an average of 56 ticks before the as-notated releases instead of 28 ticks. The as-performed attacks have remained unchanged.

To change the as-performed attack of one or more selected notes, while leaving the as-notated location of the notes unchanged:

1. Follow steps #1 and #2 above.
2. Move the attacks of the notes left or right by doing one of the following:
   
   (a) Click the Move As-Performed Attack Left or Move As-Performed Attack Right button in the piano roll palette, one or more times:

   
   (b) While holding down the "A" key (for attack), type the < or > key one or more times. Hold down the arrow key to continually move the attack to the left or right until you release the key. This method is far more convenient than using the menu commands.

-- OR --
Use one of these keyboard shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>a+{ticks}</td>
<td>Move attack to right</td>
<td>a+20</td>
</tr>
<tr>
<td>a-{ticks}</td>
<td>Move attack to left</td>
<td>a-12</td>
</tr>
</tbody>
</table>

Using the same example as above, the as-performed attacks of the three notes look like this after typing A+ several times, or by typing "a-15":

To shift both the as-performed attack and duration of one or more selected notes to the left or right, while leaving the as-notated location of the notes unchanged:

1. Follow steps #1 and #2 in the first procedure in this topic.
2. Shift the notes left or right by doing one of the following:
   (a) Click the Shift Note Left or Shift Note Right button in the piano roll palette, one or more times:

   -- OR --

   (b) While holding down the SHIFT key (for "shift"), type the ← or → key one or more times. Hold down the arrow key to continually shift the note to the left or right until you release the key. This method is far more convenient than using the menu commands.

   -- OR --

(c) Use one of these keyboard shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>s+{ticks}</td>
<td>Shift note (attack and release) to right</td>
<td>s+20</td>
</tr>
<tr>
<td>s-{ticks}</td>
<td>Shift note (attack and release) to left</td>
<td>s-12</td>
</tr>
</tbody>
</table>
8.1.1.6 Quantizing the Performance of Notes

The term "quantize" was introduced many years ago in MIDI sequencing hardware and software. Historically, the term "quantize" has meant: "round off the note locations to nearest beat or subbeat". The user would be able to choose the resolution of quantization, such as 16th notes or 32nd notes.

Composer offers a far more powerful method of quantizing notes than merely rounding off their locations to the nearest beat or subbeat. Because Composer integrates MIDI sequencing and notation, Composer can offer you a way to quantize notes based on the notation.

Composer does an excellent job transcribing the rhythms of notes, based on analysis that is far more musical and careful than simply rounding note locations to the nearest, say, 16th note beat. Once Composer has transcribed the performance of notes to notation, you can then "clean up the performance" so that the notes are played exactly at the locations as notated. If Composer does not perfectly transcribe the rhythms, you can correct the notation of the rhythms before requesting Composer to adjust the performance to match the notation.

Thus, in Composer, "quantize" means "play the notes as notated". To avoid the association of this feature with older music technology's definition of the term "quantize", Composer uses the term "snap" instead. In Composer, you can snap the performance of a note to its notation.

To set the as-performed attack, or release, or both attack and release of one or more selected notes to coincide exactly with the as-notated locations:

1. Navigate to the Piano Roll Palette.
   -- OR --
   Type SHIFT+Y.

2. Snap the as-performed attacks and/or releases to the as-notated locations by doing one of the following:
   (a) In the Piano Roll Palette, click one of three Snap-To buttons in the piano roll palette, one or more times:
   
   ![Snap buttons](image)

   -- OR --

   (b) To snap only the attack, type A+. To snap only the release, type R+. To snap both the attack and the release, type S+. 
Using the same example in the previous topic, the piano roll for the three notes looks like this after typing S+\text{\textdownarrow} (or both A+\text{\textdownarrow} and D+\text{\textdownarrow}): 

\begin{center}
\includegraphics[width=0.5\textwidth]{piano_roll.png}
\end{center}

Notice how the status bar reports that the average offsets for the attacks and releases are both zero. This means that indeed the as-performed attacks and releases have been set to exactly the as-notated locations.

8.1.1.7 Changing Only the As-Notated Location and Duration

The previous topics describe how you can change the exact as-performed timing of a note—its attack and release—while leaving its notated location and duration unchanged. This topic describes the converse case, that is, how you can change the as-notated location and duration of the note without changing the as-performed timing of the note.

The procedures for changing the as-notated location and duration of a note are quite similar to those for changing the as-performed attack and release of a note. The main difference is that you select the As-Notated palette before you use commands such as Move Attack Right, or their keyboard shortcuts (A+\text{\textdownarrow}).

To change the as-notated duration of one or more selected notes, while leaving the as-performed duration of the notes unchanged:

1. Navigate to the Piano Roll Palette.
   -- OR --
   Type SHIFT+Y.

2. Click the Edit As-Notated Only button in the piano roll editing palette, as illustrated above.
   -- OR --
   Or type "en" for edit notation.

3. Drag the mouse to select the notes for which you wish to edit the as-notated durations.

4. Decrease or increase the as-notated duration of the notes by doing one of the following:
(a) Click the Decrease Duration or Increase Duration button in the Piano Roll Palette:

![Decrease or Increase Duration buttons](image)

-- OR --

(b) While holding down the "D" key (for "duration"), type the left or right key to decrease or increase the duration.

The following example shows the effect of decreasing the as-notated duration of a note. Notice how the as-performed duration of the note remains as a full quarter note duration:

![Decrease duration example](image)

To move the as-notated attack of one or more selected notes, while leaving the as-performed attack of the notes unchanged:

1. Follow steps #1 through #3 above.
2. Move the attacks of the notes left or right by doing one of the following:
   (a) In the Note menu, select the Attack and Release submenu and its Move Attack Only submenu. Choose the Move Attack Left or Move Attack Right command.
   -- OR --
   (b) Click the Move Attack Left or Move Attack Right button in the Piano Roll Palette:

![Move attack buttons](image)

(c) Type A+ left or A+ right.

The following example shows the effect of moving the as-notated attack of a note to the right. Notice how the performed attack of the note remains at the beginning of the measure:
To shift the note to the right or left, while leaving its as-notated duration unchanged, and leaving its as-performed timing unchanged:

1. Follow steps #1 through #3 above.
2. Shift the note left or right by doing one of the following:
   (a) Click the Shift Note Left or Shift Note Right button in the piano roll palette:

   ![Shift Note Left and Right Buttons](image)

   -- OR --

   (b) Type `SHIFT+→` or `SHIFT←`.

The following example shows the effect of shifting the note to the right. Notice how the as-performed start of the note still lies at the beginning of the measure, and the duration extends to the end of the first quarter note beat of the measure, rather than to the end of the newly shifted note.

8.1.1.8 Saving and Applying Note Duration Adjustments

As you add a new note to a score, its as-notated duration is determined by your prior selection of a duration value in the Note Palette (or by an equivalent keyboard command). What determines the as-performed duration of a newly added note? By default, the as-performed duration is slightly less than the as-notated duration. Notes that follow one another will play with only slight gaps between them. Often this is not what you will want. You may want a more crisp sound, with longer gaps of silence between them. Or, alternatively, you might want the notes to be played as legato, so that the as-performed duration of one note somewhat overlaps the beginning of the next note.

After you add a note, you can individually adjust its as-performed duration. You can also select several notes and change their as-performed durations all together with a single series of `D+→` or `D+←` commands. See Editing As-Performed Attack Location and Duration. That method can become somewhat tedious, however, if you find that you typically want to shorten or extend the as-performed durations by the same amount.

Composer offers a convenient shortcut for determining the as-performed duration of notes as you add the notes. You can request Composer to memorize how as-performed durations differ from as-notated durations for different note duration values. For example, maybe newly added quarter notes should always have an as-performed duration that is roughly a sixteenth note duration (120 ticks) shorter than the full 480-ticks duration of the quarter note. The difference between the as-performed duration and as-notated duration is called a note duration adjustment. You can specify note duration adjustments for note durations ranging from a 64th note to a whole note, including triplets.

You can use Composer’s Note Duration Adjustment dialog box to manually enter the note adjustment values for different as-notated durations. In the example below, the note duration adjustments are all
approximately one fourth of the as-notated durations. For example, the adjustment for a 480-tick quarter note is -118 ticks. Later in this topic, the procedure for using this dialog box will be described.

As you add notes to a score, you may want to apply different note duration adjustments depending on whether, for example, the passage is for staccato versus legato playing. This is easy to do with Composer. The first time you add notes for a staccato passage, you will manually edit their as-performed durations. Then you select all of the notes in the passage and ask Composer to memorize the average note duration adjustment for the various note sizes found in the passage. This, in effect, fills in values in the above dialog box. (Actually, you will rarely need to directly use the Note Duration Adjustment dialog box.) The next time you add notes, they will be added with staccato durations. Also, as you change the as-notated durations of notes, Composer automatically applies the memorized note duration adjustments.

Once Composer has memorized the note duration adjustments, you can select another group of notes and apply the memorized note duration adjustments to those selected notes. This feature essentially provides edit copy/paste functionality for just note duration adjustments.

The most recently memorized note duration adjustments are saved in a song’s Note (.not) file. While editing one song, you can borrow the note duration adjustments saved in another song.

All of the above features are described in the procedures below.

To directly view and edit the note duration adjustment table:

1. Navigate to the Piano Roll Palette.
   -- OR --
   Type SHIFT+Y.

2. Click the Apply and Save Duration Adjustments button in the Piano Roll Palette:
In the Piano Roll Palette, click the Edit Note Duration Adjustments Table button.

-- OR --

In the Note menu, choose the Attack and Release submenu. In the submenu choose the Edit Note Duration Adjustments Table command.

-- OR --

Type "eda" for Edit Duration Adjustment.

Composer will display the Note Duration Adjustment table, such as illustrated earlier in this topic.

4. For different as-notated durations (indicated with note symbols), enter values that represent the offset of the as-performed duration from the as-notated duration. Often these values are negative, so that the as-performed durations are shorter than the as-notated durations.

5. To set all of the note duration adjustments to zero, click the Clear button.

6. To borrow the note duration adjustments saved in another Note (.not) file, click the Import button.

To apply the memorized note duration adjustments to a selection of notes:

1. Enter Select Mode.

2. Select one or more notes.

3. Optionally choose a Piano Roll Notation option that lets you see the as-performed durations of the notes displayed as piano roll rectangles.

4. In the Note menu, choose the Attack and Release submenu. In the submenu choose the Apply Note Duration Adjustments command.

-- OR --

Type "ada" for "Apply Duration Adjustments".

Composer will apply different duration adjustments to the selected notes according to their distinct as-notated durations.

In the following example, several notes are selected with different as-notated durations. Initially, their as-performed durations are exactly the same as their as-notated durations:

The note duration adjustment table shown earlier is now applied to the above selected notes. Recall, the note duration adjustment table shortens the length of each note by approximately one quarter. Here is the result of applying the note duration adjustments:
To memorize the note duration adjustments for a selection of notes:

1. Open the Piano Roll Palette, following step #1 in the first procedure of this topic.
2. Enter Select Mode.
3. **Select one or more notes**
4. In the Note menu, choose the Attack and Release submenu. In the submenu choose the Save Note Duration Adjustments command.

--- OR ---

Type "sda" for Save Duration Adjustments.

Composer will identify all of the different as-notated note lengths among the selected notes. For each distinct as-notated note length, rounded to the nearest common duration (such as an eighth note or quarter note, or triplet value), Composer will compute the average offset of the as-performed duration from the as-notated duration. It will save these values in the note duration adjustment table that is displayed by the Note Duration Adjustment dialog box. For as-notated durations that are not included among the selected notes, Composer leaves the adjustment values unchanged in the table.

In the following example, several notes are selected with different as-notated durations:

After choosing the Save Note Duration Adjustments command, or typing "sda", the note duration adjustment table looks like this:

![Note Duration Adjustment Table](image)

Tip: Note duration adjustments should usually be negative, so that the as-performed durations are shorter than the as-notated durations.
In this example, the note duration adjustment table had been cleared (with zero adjustment values) before the Save Note Duration Adjustments command was applied. Notice that there are entries in the table only for note durations that were found among the selected notes.

Once you have saved the note duration adjustments for one selected group of notes, you can apply them to another group of notes. For example, shown below is a second group of notes newly selected. These notes happen to have as-performed durations that are exactly as long as the as-notated durations:

The Apply Note Duration Adjustment command changes the as-performed durations of the selected note according to the previously saved table values. The result looks like this:

8.1.2 Viewing and Editing the Loudness of Notes

8.1.2.1 Viewing the Loudness of Notes While Annotating the Score

Sometimes you might want to see how loud the notes are as you are annotating the score. For example, as you are adding accent marks for notes, you can view the velocity vectors of notes to see which ones are relatively loud and therefore should have "strong accent" (>) marks.

To view the loudness (velocity vectors) of notes while you are annotating a score:

- In the View menu, click "Show loudness (note velocity)"
- OR --

Type CTRL + SHIFT + V. (Note: SHIFT + V is the shortcut for the Velocity Vector Palette).

Composer will display note velocity vectors, such as illustrated here:

A velocity vector is a line pointing about 45 degrees up and to the right from the notehead. The length of the line indicates the loudness of the note. The longer the line (vector), the louder the note.
8.1.2.2 Editing the Loudness of Notes

Sometimes the notation for a song will look great, but on playback it will sound rather mechanical and lack feeling. With Composer, you can easily view and edit the loudness of one or multiple selected notes, to add "feeling" to the performance. Technically, the loudness of a note is its MIDI note-on velocity—a value that ranges from 1 to 127.

**NOTE:** In Composer, you can set the velocity of a note to zero (0) so that it will be silent.

If you click the Note Velocity tab in the main palette, Composer will display the loudness of each note as a vector, that is, a line pointing about 45 degrees up and to the right from the notehead. The length of the line indicates the loudness of the note. The longer the lines, the louder the notes:

![Note Velocity Illustration]

The status bar indicates how much the loudness of the notes increases or decreases over the selected range. Also, it reports the "contrast" of the note loudness. The contrast of note loudness is somewhat similar to the contrast of colors on a television. On a television, if the contrast is low, there is less of a difference between light and dark. Similarly, if the contrast of loudness is low, then there is less of a difference between soft and loud notes. If the contrast is high, the notes have a wide variety between soft and loud.

You can also point the mouse (without clicking) at any note to see what its exact loudness is, as illustrated:

![Mouse Point Illustration]

Composer offers a variety of commands to:

- Increase or decrease the loudness of one or more selected notes.
- Increase the loudness of just the melody notes (highest notes in chords), or decrease the loudness of non-melody notes.
- Gradually increase or decrease the loudness of selected notes over their range in the score; that is, create a crescendo or decrescendo.
- Set the default loudness that will be applied to newly added notes.
- For a selection of notes, change the loudness of all of the notes to the average of their loudness.
- Increase or decrease the contrast of loudness among notes, so that the difference in loudness between the notes is emphasized or deemphasized.

These commands are described below.
Composer offers several types of music symbols that denote the loudness of notes: dynamic marks, crescendo marks, and accents. These music annotations do not, however, affect the as-performed loudness of notes.

Often it is useful to temporarily increase the loudness of notes in a staff while you are editing them. You want to hear these notes more distinctly over notes in other staves. For that purpose, use the Select Staff command. Then use the volume control in the toolbar, or type V+ several times (see Controlling Overall Volume Level).

Composer also lets you edit the graph of a staff's overall volume level. Editing a staff's overall volume level is similar to turning a volume knob on a radio, except it is applied to one instrument (staff) at a time. The distinct loudness of each note is preserved, but the overall volume level of all of the notes is increased or decreased by the staff's volume level. Sometimes you may find that you cannot achieve sufficient contrast between loud and soft sections of a song by editing note loudness. In this case, you should consider editing the staff volume level, rather than individual note loudness, in the soft versus loud sections of the song. For details, see Editing Per-Staff Channel Volume Level.

The remainder of this topic describes procedures for editing the specific loudness of one or more selected notes.

To increase or decrease the loudness of one or more selected notes:

1. Enter Select Mode.

2. Navigate to the Note Velocity Palette.
   -- OR --
   Type SHIFT+V.

Composer will display the Note Velocity Palette:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Set constant velocity (loudness) for notes</td>
</tr>
<tr>
<td>C + Down Arrow</td>
<td>Decrease loudness contrast among notes</td>
</tr>
<tr>
<td>C + Up Arrow</td>
<td>Increase loudness contrast among notes</td>
</tr>
<tr>
<td>L + Left Arrow</td>
<td>Gradually decrease loudness among selected notes</td>
</tr>
<tr>
<td>L + Right Arrow</td>
<td>Gradually increase loudness among selected notes</td>
</tr>
<tr>
<td>L + Down Arrow</td>
<td>Decrease loudness</td>
</tr>
<tr>
<td>L + Up Arrow</td>
<td>Increase loudness</td>
</tr>
</tbody>
</table>

3. Select one or more notes.

4. Decrease or increase the loudness (note velocity) of the notes by doing one of the following:

   (a) Click the Increase Loudness or Decrease Loudness button in the Note Velocity Palette.

   -- OR --

   (b) Type L+ or L+ one or more times to increase or decrease the loudness. Or hold down the two keys together for a short time to continually increase or decrease the loudness of the notes. It is much more convenient to use the keyboard shortcuts than the menu commands.
(c) Use any of the following keyboard shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>v+{velocity}</td>
<td>Increase loudness</td>
<td>v+20</td>
</tr>
<tr>
<td>(use the ‘+‘ key on the main keyboard, not NumPad ‘+‘)</td>
<td></td>
<td>Increase velocity by 20 units</td>
</tr>
<tr>
<td>v-{velocity}</td>
<td>Decrease velocity</td>
<td>d-12</td>
</tr>
<tr>
<td>(use the ‘-‘ key on velocity the main keyboard, not NumPad ‘-‘)</td>
<td></td>
<td>Decrease velocity by 12 units</td>
</tr>
<tr>
<td>v={velocity}</td>
<td>Set velocity</td>
<td>v=105</td>
</tr>
<tr>
<td>v%{percent}</td>
<td>Change velocity by percentage</td>
<td>v%120</td>
</tr>
</tbody>
</table>

**NOTE:** The value for note loudness (MIDI velocity) ranges from 0 to 127.

To increase the loudness of just melody notes (the highest notes in chords):

1. Follow steps #1 and #2 in the above procedure.
2. **Select a region of the score** by dragging the mouse while holding down the CTRL key.

---

**Select a list of notes** by dragging the mouse without holding down the CTRL key.

In the following example, a region is selected for the first two measures of the right hand of the piano arrangement of George Gershwin’s Rhapsody in Blue:

3. In the Filter Notes in Current Region submenu of the Region or Note menu, choose the Filter Top Melody Notes command.
Continuing with the above example, the result is:

4. Type \( L+ \) key one or more times, or hold down the two keys together for a short time to continually increase the loudness of the selected notes.

Notice how the loudness vectors for the selected melody notes are now longer, and the average loudness value, reported in the status bar, has increased:

To decrease the loudness of non-melody notes:

- Follow the same procedure as above, except choose the Filter Non-Melody Accompaniment Notes in the Range or Note menu, and use \( L+ \) to decrease the loudness of the non-melody notes.

To add a crescendo or decrescendo over a range of selected notes:

1. Follow steps #1 and #2 in the first procedure, except select at least two notes.
2. If you want to add a crescendo, and you see in the status bar that the average loudness of the notes is already high (close to 127), then you should first use the Decrease Loudness (\( L+ \)) procedure to decrease the overall loudness of the notes. Otherwise, there will be no “room” for the crescendo.
3. In the Note menu, select the Loudness submenu. In the submenu, choose the Crescendo Across Selected Notes or Decrescendo Across Selected Notes command.

-- OR --
Type L+→ (or L+←) key one or more times for a crescendo (decrescendo).

-- OR --

Click the Crescendo ← or Decrescendo → button in the Note Velocity Palette.

In applying the crescendo or decrescendo, Composer preserves the relative loudness between notes.

For example, suppose we start with the following selection of notes:

![Music notation image]

The status bar reports a crescendo value of -47. That means that over the range of the selected notes, the loudness of the notes decrease by 47 out of the total of 128 units of loudness. You can visually confirm that there is a decrescendo across the notes by observing that the velocity vectors get shorter across the range.

After first using the Decrease Loudness command some to lower the overall loudness, and then the Crescendo Across Selected Notes command, the notes look like this:

![Music notation image]

The status bar now reports a higher crescendo value of 16, as compared to -47 before. Notice how the loudness vectors, on the average, get slightly longer going from the first measure to the second.

To set the default loudness for newly added notes:

1. Click on the Note Velocity tab.
2. In the Loudness menu, select the "Set loudness for new notes" command.
3. Enter the numerical value (if different) and check the "Use the above loudness (MIDI velocity) for all newly added notes" and click "Ok" to save.
4. Add any number of notes. They will all be assigned the loudness value that you saved.

To change the loudness of a selected group of notes to their average loudness:

1. Follow steps #1 and #2 in the first procedure, selecting one or more notes.
2. In the Note menu, select the Loudness submenu. In the submenu, choose the Set Loudness to Average command.

-- OR --

Type "la" for loudness average.

To change loudness of a selected group of notes to some specific value:

1. Follow the above procedure for changing the loudness of the notes to their average. The notes will then all have the same loudness value, although perhaps not the value you desire.
2. Use the Increase Loudness or Decrease Loudness command to increase or decrease the loudness for all of the selected notes at once, until the status bar reports the desired loudness value.

-- OR --

Click the Constant Velocity (Loudness) button in the Note Velocity Palette, or type "v". Composer will display a simple dialog box in which you enter the note velocity value for the selected notes.

To increase or decrease the contrast of loudness between two or more selected notes:

1. Follow steps #1 and #2 in the first procedure, selecting two or more notes.

2. In the Note menu, select the Loudness submenu. In the submenu, choose the Increase Loudness Contrast or Decrease Loudness Contrast command.

-- OR --

Type C+↑ or C+↓ key one or more times ("C" suggests "crescendo").

-- OR --

Click the Increase Contrast or Decrease Contrast button in the Note Velocity Palette.

The following example shows the result of increasing the contrast for the notes in the original example. The contrast has been increased from 10 to 24:

Notice how the loudness vectors for soft notes are shorter than before, and the loudness vectors for loud notes are longer than before. The contrast between the soft and loud note has increased.

8.1.2.3 Filtering Notes Based on Notation

As you edit the as-performed attack and duration of notes or edit the loudness of notes, you may find it useful to select notes based on their musical roles and how they are notated:

- top melody notes -- the top note of chords
- non-melody accompaniment notes -- all but the top note of chords
- upper voice notes
- lower voice notes
- accent mark

An example of this is demonstrated in the previous topic, Editing the Loudness of Notes. In that example, top melody notes were first selected, and their loudness was increased, and the loudness of the non-melody accompaniment notes was left unchanged.

Another example is a case where you want to shorten the as-performed duration of all notes in a region that have a staccato mark. You can easily select just the staccato notes, and then follow the instructions in Editing As-Performed Attack Location and Duration to decrease the as-performed duration of the notes.
Selecting notes in a region based on the criteria listed above is called "filtering" in Composer. If you have used a MIDI sequencing program, then you may have used a filtering function in it. But that filtering function is based on the performance (MIDI) data for the notes, rather than the notation or musical role of the notes. Composer has a filtering function that removes very soft or short notes. This is the Remove Silent Notes command. However, Composer also enables you to filter notes based on their musical role or how they are notated.

To select just the melody, accompaniment, upper voice, or lower voice notes in a region:

1. Select the region, by holding down the CTRL key while dragging the mouse over a range of measures and beats.
   The selected region will be highlighted with a gray background.

2. In the Region menu, open the submenu for Filter Notes in Current Region, and choose any one of the commands for Top Melody Notes, Non-Melody Accompaniment Notes, Upper Voice, or Lower Voice.
   The selected notes will be highlighted in blue. Edit whatever aspect of the selected notes you wish.

To select notes that have a specific type of accent mark:

1. Select the region, by holding down the CTRL key while dragging the mouse over a range of measures and beats.
   The selected region will be highlighted with a gray background.

2. In the Region menu choose the Filter Notes According to Selection Criteria command.
   -- OR --
   Type "qfn" for Quick Filter Notes.
   Composer will display the Note Selection Filter dialog box:

3. In the Note Selection Filter dialog box, choose "Notes With Accent Mark", and select the type of accent. Click the OK button.
The selected notes will be highlighted in blue. Edit whatever aspect of the selected notes you wish, typically the **as-performed duration and/or attack** or the **note loudness**.

## 8.2 Inserting a Sound Change in the Middle of a Staff

For most MIDI files that you might download from the Internet, each staff is assigned a single instrument sound. Technically, each staff is assigned to a particular MIDI program (patch) and perhaps MIDI bank. Some MIDI files may include mid-staff sound changes, that is, mid-staff MIDI program changes. In general, you will not find mid-staff MIDI program changes for General MIDI (GM) files. But you might find mid-staff MIDI program changes in MIDI files that have been prepared for specific MIDI keyboards, sound modules, or sound libraries.

A common example where you might find a mid-staff sound change is where a violin or string instrument switches from normal bowing to pizzicato.

If you have a MIDI output device that includes, for example, pizzacaio string sounds, then you will likely enjoy enhancing the performance of your piece by including mid-staff sound changes.

Here is an example of what a mid-staff sound change looks like in Composer:

![Example of a mid-staff sound change](image)

Normally, the instrument sound change symbol is not displayed in the score, and there is no text for a sound change.

If there is text associated with an instrument sound change, and you turn off the display of instrument sound change symbols, then just the instrument sound change text is displayed, as illustrated here:

![Example of a mid-staff sound change with text](image)

To view the mid-staff instrument sound change symbols and MIDI details:

1. Click the Sound Changes tab in the main palette.
   -- OR --
   Type **SHIFT+i** (upper-case "i").

2. Click the **Show Instrument Sound** button in the Instrument Sound Palette.
   -- OR --
   Type "qsis" for Quick Show Instrument Sounds.
Composer will show the instrument sound symbol, as illustrated here:

3. To view the MIDI details for the instrument sound change, namely the MIDI bank and MIDI program change, move the mouse over the symbol. The MIDI details will be shown at the mouse cursor:

To add a mid-staff instrument sound change:

1. With the mouse, navigate to the Instrument Sound Change Palette, or type SHIFT+I, as described in step #1 in the above procedure.

Composer changes the mouse cursor to indicate *Add Mode* with this shape: 

2. Click the mouse at the location where you want to add the mid-staff instrument sound change. Composer will display the Instrument Sound Change dialog.

![Instrument Sound Change dialog](image)

3. In the Instrument Sound Change dialog, choose any MIDI bank and instrument sound (MIDI program) available for the MIDI device to which the staff is assigned.

To move an instrument sound change:

1. Select the instrument sound change object.

2. In the Instrument menu, select the Shift Instrument Sound Change Right (Left) to move the instrument sound change to the next (previous) note.
-- OR --

Click the Instrument Sound Change Right \[→\] (or \[←\] Left) button.

-- OR --

Type Shift + \[→\] (or \[←\]).

You can optionally associate text with the instrument sound change. Even when the instrument sound change symbol is hidden (i.e. when the Show Instrument Sound \[→\] button is not selected), the instrument sound change text will be displayed in the score, just like normal text. You can choose a font face and size, and bold or italic characteristic. The example used in this topic provides a good illustration of where it is useful to assign the text "pizz" to the instrument sound change for string pizzicato.

In this version of Composer, you cannot freely move the instrument sound change text as you can free text objects. If you need the flexibility to move the text associated with an instrument sound change, then you can create a separate free text object, which is independent of the instrument sound change object.

To associate text with an instrument sound change, and to format that text:

1. As you add the new instrument sound change, enter the text in the first field of the Instrument Sound Change dialog box.

2. To change the font face, size, or bold or italic characteristic of the text, follow the procedure for Selecting Font Type, Size, and Properties. The procedure for editing the font properties for the instrument sound change text is the same as for other types of text.

8.3 Viewing and Editing Graphs of the Musical Performance

In Composer, you can graphically edit the following types of music performance data:

- tempo
- per-staff channel volume level
- left-to-right pan
- note pitch bend
- sustain pedal control
- other MIDI controller data

These performance data controllers (MIDI cc events) can tremendously alter the performed sound of a song file and help you to achieve a more "real life" type of performance or create various effects for the different instruments. Most playback devices, sound libraries, and soundfonts respond similarly to some common controllers such as Volume, Sustain Pedal, Pan, and Pitch Bend. However various devices, and even different soundfonts, can be affected differently with other controllers such as Modulation Wheel or Expression. Because of this variety, you should experiment with the different controllers using the MIDI playback device that you intend to use for playing back your file. You can use the GraphOverNotes(tm) tools described in this section to get the performance that you want from the MIDI controllers that your MIDI device responds to the best.
Composer provides a GraphOverNotes™ Palette with a set of drawing tools for editing any of the above types of music performance data. For example, a crescendo (a gradual increase in volume) is displayed as an upward sloping line or curve in the graph of volume level plotted against time in the song.

The procedures below introduce how to turn graphs on and off, and how to select the type of graph. It is recommended that you read the next topic, Tutorial On Graphic Music Editing, after reading this introduction.

You might want to display the graph of, for example, the tempo in your song, even though you don't intend to edit the tempo graph. For example, as you are adding tempo marks, you might observe an upward slope in the graph of the tempo and decide to add a corresponding accelerando mark in the score.

To display one of the musical performance graphs as you are annotating the score:

1. In the View menu, select one of the "Show ...." types which corresponds to the graph you wish to see
   -- OR --

   Type one of the "q" shortcut commands for the graph type.
2. Set a check mark next to the type of performance graph you wish to view.

3. If you wish to see other types of MIDI controller data, such as Mod wheel, or Expression, click the "MIDI controller" option as shown in the above screen shot, and the following option dialog will appear.
4. Select the type of graph you wish to view, and click "Ok." The MIDI data graph will now display on top of the score, so you can see exactly where the performance changes occur with respect to the notation.

The following example shows how you might use the tempo graph to determine where an Accel tempo mark is needed:

The horizontal red line in the score is the graph of the tempo throughout the song. At the beginning of the song, the line slopes upward, indicating an increase in tempo. If you wish to see numerical information for a graph, then follow click the GraphOverNotes™ tab in the main palette, as described in a procedure below.
To view a graph during playback of the song:

- Just leave the View Graph checkmarked in the View menu command list. During playback, you can also change the view among any of the six different types of graphs by clicking one of the graph type buttons, such as the Tempo button.

To turn off the display of the graph:

- Toggle the View Graph checkmark "off" in the View command list.

If you wish to edit the graph, rather than just view the graph, then you will need to click the GraphOverNotes tab in the main palette.

To prepare to edit the graph of some type of musical performance (MIDI) data:

1. Click the GraphOverNotes tab in the main palette.

   -- OR --

   Type SHIFT+X.

2. In the GraphOverNotes Palette, choose the type of musical performance (MIDI) data you wish to edit; or type its shortcut.

   For example, click the Volume button to view the graph of the volume level for staves.

   -- OR --

   Type "v" for staff volume.

8.3.1 Tutorial on Graphical Music Editing

Composer offers graphical drawing tools for editing these six types of music data: tempo changes, volume level, left-to-right pan, note pitch bend, sustain pedal, and MIDI controller data.

Composer’s graphical editing tools operate consistently, regardless of the type of music data. A few exceptions are noted in topics for the specific types of graphical music data.

The following tutorial shows you how to use Composer’s graphical editing tools. The tutorial makes a variety of changes to the volume level graph for a staff. The results of this tutorial are admittedly not
very interesting from a musical point of view. The purpose of this tutorial is to demonstrate how to use the graphical editing tools rather than why to use them. There are separate topics for each of the six types of graphical music data that explain the use of the graphical editing tools in the context of why you might use them to accomplish certain musical results.

In this tutorial, it is not necessary that you draw the graphs exactly as shown. If you do not find it convenient to follow the tutorial steps while running Composer, you will still probably find it useful to read this tutorial.

**Procedure 1 -- To start the tutorial:**

1. Using the Open MIDI or Note File command in the File menu, open the file GraphicalEditingTutorial.not in Composer's Song directory: C:\Users\Public\Documents\Notation_3\Songs.

2. Save a copy of the file with a new name, such as GraphicalEditingTutorial2.not, and continue working with the copy instead of the original file, in case you or another person sharing your computer wants to work through the tutorial. For this purpose, use the Save Song File As command in the File menu.

The song is very simple. It has only one staff and eight measures:

A single GraphOverNotes\textsuperscript{tm} Palette supports editing for each of the five types of graphical music information.

**Procedure 2 -- To display the GraphOverNotes\textsuperscript{tm} Palette and choose a type of music information to edit:**

1. Click the GraphOverNotes\textsuperscript{tm} tab in the main palette.

-- OR --

Type SHIFT+X.

2. In the first of the two groups of buttons in the GraphOverNotes\textsuperscript{tm} Palette, click one of the six buttons for the type of music information you wish to edit.
In this tutorial, click the Volume \( \text{Vol} \) button if it is not already selected. 

-- OR --

Type "v" for staff volume.

Composer draws a graph of the selected music information type (staff volume level):

The thick red line is the graph of the staff volume level throughout the song. At the beginning of the song, the line slopes upward, indicating an increase in volume level, that is, a crescendo. If you play the song now, you will hear the volume level increase over the first two measures.

The dotted red lines mark the minimum and maximum values. In the case of volume level, the minimum and maximum values are 0 and 127, which is the range of volume levels defined by MIDI.

At first, it may concern you that the graph is drawn without any indication of the scale and range of values. It may also concern you that the short distance on the screen between the minimum and maximum value might not offer you sufficient precision for editing the graph. The next two procedures show you how you can gain visibility and precision in editing the graph.

**Procedure 3 -- To determine the value of the graph at any location in the song:**

- To view the current value at a particular location, move the mouse cursor there.

In the status bar, Composer displays the location of the mouse as a measure/beat/tick, and displays the exact value of the graph at that location. In the above example, the volume level is 95 at measure 6, beat 1, tick 225.

When you are viewing rather than editing the graph, it does not matter what the vertical position of the mouse is.

- While editing the graph according to one of the procedures below, the vertical position of the mouse on the score determines what the newly applied value will be. The report in the status bar tells you the exact value corresponding to the vertical position of the mouse.

**Procedure 4 -- To increase the precision of the graph:**

- Use the Zoom In command in the View menu.
Viewing and Editing the Music Performance

-- OR --

Click the Zoom In \( \text{button one or more times.} \)

-- OR --

Type \( Z+ \) one or more times.

The score and graph are now magnified on the screen so that you can more precisely edit the graph, as shown here:

If you are viewing or editing the tempo graph, you can also temporarily specify a narrow range for the minimum and maximum values of the graph, such as 80 to 120 quarter notes per minute. For details, see "Editing the Tempo Graphically".

Procedure 5 -- To draw a curve on the graph:

1. Choose the Draw Curve command in the Graph Menu.
   -- OR --
   Type "d" for draw.
   -- OR --
   
   Click the Draw Curve \( \text{button in the GraphOverNotes}^{\text{tm}} \text{ Palette.} \)

2. Move the mouse to where you want to start drawing the curve.

3. Press down the left mouse button.

4. While holding down the left mouse button, drag the mouse around on the graph. You can move the mouse back and forth horizontally to change a portion of the curve, or to extend the beginning or end of the range of locations that you are editing.

5. While still holding down the mouse button, you can move it to a different staff for the same instrument. Composer will continuously update the graph as you move the mouse. Changes
you make to the volume level will propagate to the next location where there is another change of volume level. Thus, sometimes you will observe the graph to the right of the mouse shifting up or down as you move the mouse up and down. Further, you may see the graph for other staves of the same instrument shift up or down as you move the mouse.

For example, draw a curve similar to the one shown below. Notice how the graph drawn to the right of the mouse moves up and down as you move the mouse up and down and to the right. Notice also how the graph in the second staff also moves up and down:

6. If, while still holding down the mouse button, you need to move the mouse across staves of other instruments to reach another staff for the one you started with, Composer will wait until you move the mouse into another staff for the same instrument.

7. If, while still holding down the mouse button, you need to continue drawing on another page, hit the PAGEDOWN or PAGEUP key. (This might require using your second hand to type the PAGEDOWN or PAGEUP key.) Composer will still continuously update the graph as you move the mouse on the other page.

8. Release the mouse button when you are done drawing the volume level curve.

Procedure 6 -- To draw a sloped line on the graph:

This procedure describes how to draw a sloped line with the mouse. You can also use the numeric value tool to specify a starting and ending value for a selected region. By that alternative method, you enter the exact values in a dialog box. See Procedure 10 below.

1. Choose the Draw Sloped Line command in the Graph Menu.

-- OR --

Type "l" (lower-case) for line.

-- OR --

Click the Draw Sloped Line button in the GraphOverNotes™ Palette.
2. Follow the same instructions as above for drawing a continuous curve. The only difference is that the Draw Sloped Line tool draws a straight line rather than a continuously curved line. For example, draw an upward sloping line in the fifth measure. Since you are editing the staff volume level, the musical result is a crescendo in the fifth measure:

Procedure 7 -- To draw a horizontal segment in the graph:

1. Choose the Draw Horizontal Line command in the Graph Menu.
   -- OR --
   Type "h" for horizontal line.
   -- OR --
   Click the Draw Horizontal Line button in the GraphOverNotes™ Palette.

2. Move the mouse to where you want to start the horizontal line. The vertical position where you click the mouse determines the height of the horizontal line on the graph.

3. Press down the left mouse button.

4. While holding down the left mouse button, drag the mouse around on the graph. You can move the mouse back and forth horizontally to extend the line to the left or right. The horizontal line moves up or down as you move the mouse.

5. Release the mouse button when you are done drawing the horizontal line.
   For example, draw a horizontal line across the portion of the graph for which you had previously drawn a curve:
There are two ways to erase a portion of a graph: (1) by dragging the mouse over an area of the graph with the erase tool, and (2) by selecting a region and hitting the *Del* key. Both methods are described below.

Procedure 8 -- To erase a portion of the graph using the erase tool:

1. Choose the Erase command in the Graph Menu.
   -- OR --
   Type "e" for erase.
   -- OR --
   Click the Erase button in the GraphOverNotes Palette.

2. While holding down the left mouse button, drag the mouse over the portion of the graph you wish to erase.

<%PROD%> will draw a horizontal line across the portion that you have erase. The staff volume level value for the region that you erase will be that value immediately preceding the erased region.

For example, if you erase the staff volume level in the second measure, the staff volume level graph will look like this:
Procedure 9 -- To erase a selected region of a graph:

1. **Select a region** of the staff by holding down the CTRL key and dragging the mouse across the region.

2. Hit the **Del** key.

To try out this method of erasing, use the Undo command in the Edit menu to reverse the erasing you did in the previous step. Select the second measure by dragging the mouse over it while holding down the CTRL key. Then hit the DEL key. The result will be the same as shown above.

Procedure 10 -- To specify an exact numeric value for some region of a staff:

1. **Select a region** of the staff by holding down the CTRL key and dragging the mouse across the region.

   For example, select the last two measures 7 and 8 of the song.

2. Choose the Enter Numeric Value command in the Graph Menu.

   -- OR --

   Type "n" for numeric value.

   -- OR --

   Click the Constant Numeric Value button in the GraphOverNotes™ Palette.

Composer will display a dialog box such as the following:
The above dialog box will indicate the staff and region (From Location and To Location) that you selected. You can optionally change the selection in the dialog box. The dialog box also shows the current volume level value at the beginning of the selected region. It is 70 in this example.

3. Enter a new volume level (such as 70 here) that will be applied to the selected region. Volume level values ranges from 0 to 127, as defined by MIDI.

The result is shown here:
To achieve certain musical intentions, you can stretch a graph to make it wider or narrower, horizontally or vertically; shift a graph to the right or left; and uniformly raise or lower the graph. For example, you can horizontally stretch the graph for a crescendo so that it extends over a greater number of beats in the song. You can vertically stretch a graph for a note pitch bend to make the pitch go higher or lower over the same duration. The procedures for stretching and shift graphs all include a step in which you select the region to be stretched or shifted.

Procedure 11 -- To stretch a selection portion of the graph horizontally, thus extending the curve over a longer or shorter range of beats in a staff:

1. Select a region in a staff by dragging the mouse while holding down the CTRL key. Start the mouse drag at the beginning of the region you wish to stretch. If you want to stretch the selected portion of the graph so that it spans more time, then end the mouse drag at the location where you would like the stretch to end when you are done. If you want to stretch the selected portion of the graph so that it spans less time, then end the mouse drag at the end of the portion of the graph that you want to shrink.

For example, prepare to stretch the crescendo in the middle of the fifth measure so that it will extend to the end of the sixth measure:

2. To stretch the graph to the right or left, hold down both the CTRL key and key. Composer will continuously stretch the graph until you release the key. Or, while holding down the CTRL key, hit the or key one or more times.

For example, hold down the CTRL and keys until the crescendo in the fifth measure extends to the end of the selected region in the end of the sixth measure:

Procedure 12 -- To stretch a selected portion of the graph vertically:

Follow the previous procedure, except while holding down the CTRL key, use the or key, instead of the or key.

A particularly useful application of this procedure is for pitch bend. (In fact, it is the only graphical data you can stretch vertically.) You can stretch a pitch bend so that it changes the pitch higher or lower, over the same duration of time, while preserving the overall contour of increasing and decreasing pitch. For details, see Editing the Pitch Bend of Notes.

Procedure 13 -- To shift a selected portion of the graph to the right or left:

1. As in the previous procedure, select a region of the graph that you wish to shift, including the area to the right or left into which you wish to shift the graph.
The previous tutorial step resulted in a crescendo that extends from the middle of measure 5 to the end of measure 6. Prepare to shift the first part of the crescendo to the left, so that it will start at the beginning of measure 5:

2. Hold down the \( \rightarrow \) or \( \leftarrow \) key to shift the graph to the right or left. Or, hit the \( \rightarrow \) or \( \leftarrow \) key one or more times.

For example, hold down the \( \leftarrow \) key until the crescendo shifts backward a half measure:

Procedure 14 -- To shift a selected portion of the graph up or down:

1. Follow the same steps as in the previous procedure, except select the exact region for which you wish to raise or lower the graph.

2. Hold down the \( \uparrow \) or \( \downarrow \) key to shift the graph upward or downward. Or, hit the \( \uparrow \) or \( \downarrow \) key one or more times.

You can also copy portions of a graph from one region to another. For example, you can copy a pitch bend from one note to another in the same staff, or to another staff. You can copy the graphs for multiple staves at a time. For example, you can copy the volume level graph for all staves from one section of the song to another. You can even copy graphs from one song to another.

Procedure 15 -- To copy a graph from one region to another:

1. Select the region you wish to copy.

For example, select measures 5 and 6, as shown below:

2. In the Graph Menu, choose the Copy Graph from Region command.

   -- OR --

   Type CTRL+C, which is the standard Windows keyboard command for Copy to Clipboard.

3. Select the region you wish to copy the graph into.

   For example, select measures 7 and 8, as shown below:

4. Choose the Paste Saved Graph Into Region command in the Graph Menu.

   -- OR --
Type CTRL+V, which is the standard Windows keyboard command for "paste from the clipboard".

The result is shown below. Notice how the shape of the graph in measures 7 and 8 is exactly the shape of the graph that it was copied from in measures 5 and 6:

8.3.2  Tempo

At any number of locations in a song, you can specify changes in tempo that will be performed during playback. The tempo changes can be gradual or sudden.

With Composer, you can view and edit the tempo graphically. The following example shows the graph of the tempo for a central theme in George Gershwin's *Rhapsody in Blue*, which is included as the file `RhapsodyInBlue.not` in the installed `C: \Users\Public\Documents\Notation_3\Songs` directory:

For details in viewing and editing the tempo graphically, see the next topic following this introduction.

During playback, you can view the current tempo in the toolbar:
During playback you can also dynamically decrease or increase the tempo by changing the tempo adjustment percentage in the toolbar:

\[ \text{Tempo at current playback position} \]

You can also speed up or slow down the playback by typing T+ or T-. Any adjustments that you make to the tempo during playback are temporary; that is, they do not affect the permanently recorded tempo in the score. After you have adjusted the tempo by some percentage, you can permanently save the revised tempo by using the Keep Adjusted Tempo command in the Tempo submenu of the Perform menu. For more details about dynamically changing the tempo during playback, see Viewing and Adjusting the Tempo.

As an alternative to editing the tempo graphically, you can enter a constant tempo over any range of the song that you select. You can audition the tempo before you apply it to the range of the song you have selected. To edit the tempo this way, double-click the tempo indicator in the toolbar with the mouse. For details, see Applying a Constant Tempo, Accelerando, or Decelerando.

When Composer imports a MIDI file, it preserves any tempo changes recorded in the song.

When you create a song from scratch, you can specify the initial tempo and edit any tempo changes after the start of the song. When you record a portion of a song from your music keyboard, the tempo is determined not by how fast or slowly you play, but, rather, by the tempo that you have previously specified in the score. When recording from your music keyboard, you listen to Composer's metronome, or listen to previously recorded staves, in order to synchronize your performance.

You can annotate the score with tempo markings, such as Allegro. Just add them as free text, as described in the topic FreeText. However, these annotations do not affect the tempo as performed by Composer. Therefore, you will typically want to edit the tempo performance to match the tempo marking.

### 8.3.2.1 Editing the Tempo Graphically

With graphical editing tools, you can:

- Set a constant tempo throughout any portion of the song.
- Add the performance of a fermata (long hold of a note).
- Set a gradual tempo acceleration or deceleration over some number of measures or beats.
- Extend a tempo acceleration or deceleration over a longer range, or compress it into a shorter range in the song.
- Remove tempo changes for any portion of the song.
- Uniformly increase or decrease the tempo over some region of the song.
- Shift the tempo curve to the right or left.
- Copy a tempo curve from one section of a song to another section.

For an overview of using graphical editing tools, see [Tutorial on Graphical Music Editing](#).

Please note that any time you select and copy a Region to the clipboard, the Tempo is copied as well. You can quickly paste that tempo graph into a new region by selecting it and using Edit/Paste/Paste Special/Paste tempo - only the tempo will be pasted to the selected region. If you select to paste only other elements from the selected region (eg. Chord Names), the Tempo will NOT be pasted in those situations.

To prepare for editing of the tempo graph:

1. Click the GraphOverNotes™ tab in the main palette.
   -- OR --
   Type SHIFT+X.

2. Click the Tempo button in the GraphOverNotes™ Palette.
   -- OR --
   Type "t" for tempo.
Composer will display a graph of the tempo, such as shown here:

To find out what the tempo is at any location in the song:

- Move the mouse cursor to the location in the song.

In the status bar Composer will display the tempo at the location of the mouse cursor. See the above illustration.

As you draw the tempo curve with the mouse, you can view the tempo value in the status bar to see exactly what the value is. For greater precision while editing the tempo, you can zoom in. You can also customize the scale of the tempo graph, as described below.

The tempo graph is drawn on top of the first two staves of each system of the score. If there is only one staff, then the tempo graph is drawn on top of that one staff. The scale for the graph is linear, between a pair of minimum and maximum values. The dotted red lines mark the minimum and maximum values. If actual tempo values for the song fall outside of this range, then the graph will be drawn above or below the dotted lines. By default, the minimum and maximum values for the graph are 20 and 240 beats per minute. You can change the scale of the graph on a per-song basis. You can also change the default scale of the tempo graph for newly imported MIDI files or for newly created songs.

To set the scale of the tempo graph:

1. In the Graph Menu, choose the Tempo Graph Min and Max command.

- OR -

Type "m" for minimum and maximum.
Composer will display this dialog box:

![Tempo Graph Min and Max Values](image)

2. Enter the minimum and maximum values that will be used for the scale of the graph.

3. Click the Save for Current Song button to apply the new scale values to the currently viewed song.

4. Click the Save As Default button to apply the new scale values to any newly created song and any newly imported MIDI file.

To set a constant tempo for a small portion of the song:

To set a constant tempo for a relatively large portion of the song, follow the procedure in Applying a Constant Tempo, Accelerando or Decelerando.

The general method for using the horizontal line drawing tool is described in Procedure 7 of the Tutorial on Graphical Music Editing. The procedure below applies the general method to the tempo.

1. Choose the Draw Horizontal Line command in the Graph Menu.
   
   -- OR --

   Type "h" for horizontal line.

   -- OR --

   Click the Draw Horizontal Line button in the GraphOverNotes Palette.

2. Move the mouse to where you want to start the new tempo. The vertical position where you move the mouse determines the tempo value.

3. Press down the left mouse button.

4. While holding down the left mouse button, drag the mouse around on the graph. You can move the mouse back and forth horizontally to extend the constant tempo value to the left or right.

5. Release the mouse button when you are done drawing the horizontal line.

To add the performance of a fermata (long hold of a note):

Use the previous procedure to change the tempo graph to a lower value for the duration of the note.

To set a gradual tempo acceleration or deceleration over some number of measures or beats:

1. Select a region of the staff by holding down the CTRL key and dragging the mouse across the region.

2. Choose the Enter Numeric Value command in the Graph Menu.
   
   -- OR --
Type "n" for numeric value.

-- OR --

Click the Constant Numeric Value button in the GraphOverNotes™ Palette.

Composer will display the Set Tempo in Region dialog box.

3. In the Set Tempo in Region dialog box, enter the starting and ending values for the tempo.

Instead of entering the starting and tempo values from the keyboard, you can use the mouse to draw an increasing or decreasing tempo line, as follows:

1. Choose the Draw Sloped Line command in the Graph Menu.

--- OR --

Type lower-case "L" for line.

-- OR --

Click the Drawi Sloped Line button in the GraphOverNotes™ Palette.

2. While holding down the left mouse button, drag the mouse across some range of the score.

To add a tempo acceleration, the slope of the line that you draw should be upward. To add a tempo deceleration, the line should slope downward.

To extend a tempo acceleration or deceleration over a longer range in the song, or compress it into a shorter range in the song:

1. Select a region in a staff by dragging the mouse while holding down the CTRL key. Start the mouse drag at the beginning of the region you wish to extend or compress. If you want to extend the acceleration or deceleration, then end the mouse drag at the location where you would like the acceleration or deceleration to end when you are done. If you want to compress the acceleration or deceleration so that it spans less time, then end the mouse drag at the end of the current acceleration or deceleration.

2. While holding down the CTRL key, hold down the or key to stretch the graph to the right or left. Composer will continuously stretch the graph until you release the key. Or, while holding down the CTRL key, hit the or key one or more times.

The general method for horizontally stretching a region of a graph is described in Procedure 11 of Tutorial on Graphical Music Editing.

To remove tempo changes for any portion of the song:

1. Choose the Erase command in the Graph Menu.

--- OR --

Type "E" for erase.

-- OR --

Click the Erase button in the GraphOverNotes™ Palette.

2. While holding down the left mouse button, drag the mouse across the desired region of the score.

As you erase the tempo curve, you will see Composer apply the tempo value immediately preceding the range that you have erased.

The general method for erasing a region of a graph is described in Procedure 8 of Tutorial on Graphical Music Editing.
To uniformly increase or decrease the tempo over some region of the song:

1. Select the region in the song for which you wish to increase or decrease the tempo.
2. Hold down the or key to shift the tempo graph upward or downward. Or, hit the or key one or more times.

To shift the tempo curve to the right or left:

1. Select the region in the song for which you wish to shift the tempo graph, including the area to the right or left into which you wish to shift the graph.
2. Hold down the or key to shift the tempo graph right or left. Or, hit the or key one or more times.

The general method for horizontally shifting a region of a graph is described in Procedure 13 of Tutorial on Graphical Music Editing.

To copy a tempo curve from one section of a song to another section:

For an illustration of copying a region of a graph, see Procedure 15 at the end of the Tutorial on Graphical Music Editing.

1. Select the region from which you wish to copy the tempo graph.
2. Choose the Copy Graph from Region command in the Graph Menu.
   -- OR --
   Type CTRL+C, which is the standard Windows keyboard command for Copy to Clipboard.
3. Select the region you wish to copy the tempo curve into.
4. Choose the Paste Saved Graph Into Region command in the Graph Menu.
   -- OR --
   Type CTRL+V, which is the standard Windows keyboard command for Paste from the Clipboard.

8.3.2.2 Applying a Constant Tempo, Accelerando, or Decelerando

As an alternative to editing the tempo of a song graphically, you can select some range of the song and enter the exact tempo value from your keyboard. You can specify a constant tempo value for a selected range in the song, or a continually increasing or decreasing tempo (accelerando or decelerando) for the selected range. You can hear a preview of the tempo before you apply it to the song.
To set a constant tempo, accelerando, or decelerando for some range of the song:

1. **Select a range** of the song by holding down the CTRL key and dragging the mouse, as illustrated here:

2. With the mouse, double-click the tempo button in the toolbar:

   \[
   \begin{array}{c}
   \text{Tempo} = 78 \\
   \end{array}
   \]

   -- OR --

   If you are viewing the **tempo graph**:
   
   - Choose the Enter Numeric Value command in the Graph Menu.
     -- or --
   
   - Type "n" for numeric value.
     -- or --
   
   - Click the Constant Numeric Value button in the GraphOverNotes™ Palette.
Composer will display the Set Tempo dialog, as illustrated here:

The dialog indicates the range of the song that you have selected, and the current tempo at the start and end of the selected range. The starting tempo is 80 quarter notes per minute, and the ending tempo is 128 quarter notes per minute.

4. Change the "From Location" and "To Location" if you decide to set the tempo for a different range than the one you selected.

5. Enter a value for the Initial Tempo at the start of the selected range.
   - OR -
   Use the slider control to change the value.

6. To apply a constant tempo across the selected range, keep the default choice for "Ending tempo is same as initial tempo". To apply a continually increasing or decreasing tempo across the selected range, choose "Ending tempo is different than initial tempo", and specify an ending tempo value.

7. Alternatively to steps #5 and #6, select a percentage by which you wish to adjust the tempo in the selected region. If, prior to entering this dialog box you had use the Tempo Adjustment control, such as illustrated below to temporarily change the playback tempo, then the value in the dialog box for the tempo percentage adjustment will be pre-selected (to, in this example, 75%):

8. You can hear what the tempo actually sounds like by clicking the Audition Tempo button.
Composer will temporarily apply the new tempo values to the graph that you see, and Composer will start playing the song at the beginning of the selected range.

To stop the audition:

- Click the Audition Tempo button a second time.
  -- OR --
- Click the Cancel button.
  -- OR --
- Hit the SPACE key.
  -- OR --
- Click the Stop Playback button.
  -- OR --
- Toggle the Playback button.

If you are not pleased with the audition, enter some other values, and try another audition. After the audition has stopped, hit the Cancel button if you do not wish to save your most recently entered tempo values.

9. Click the OK button to save the new tempo values.

8.3.3 Per-Staff Channel Volume Level

With Composer, you can edit the overall volume level of a staff. The staff volume level is uniformly applied to the individual loudness of all notes. The relative loudness of notes in a staff do not change as the staff volume level changes.
The following example shows the staff volume graph for the right- and left-hand piano staves for the main theme in George Gershwin's *Rhapsody in Blue*, (which is included as file `RhapsodyInBlue.not` in the installed `C:\Users\Public\Documents\Notation_3\Songs` directory):

![Staff volume graph for *Rhapsody in Blue*](image)

Notice above how the slopes of the volume level curve match the notated "hairpin" crescendo and decrescendo marks in the score.

The volume level of a staff ranges from 0 to 127. Technically, this is MIDI channel volume.

With graphical editing methods introduced in the [Tutorial on Graphical Music Editing](#), you can:

- Set a single volume level for an entire staff, from the start to the end of the song.
- Create crescendos and decrescendos.
- Create abrupt changes in volume level, corresponding to notated dynamic markings such as piano or forte.
- Copy the volume level changes, such as crescendos and decrescendos, from one region or staff to another.
- Remove volume level changes from a region of the song.
- Stretch the duration of a crescendo or decrescendo to extend it over a longer or shorter range of beats in a staff.
- Shift a crescendo or decrescendo to an earlier or later position in the staff.
- Uniformly increase or decrease the overall volume level for a region of the score.

Procedures for accomplishing each of the above musical goals are described later in this topic.
You can make any notes in a staff sound louder or softer either by changing the individual loudness of the notes, or by changing the staff volume level. Which way should you do it? A good way to answer this question is to consider the difference between (1) singing a note very softly and later amplifying its volume and (2) singing a note very loudly and later decreasing its volume. The end result is the both notes "sound" equally loud; but the qualities of the two notes sound quite different. The same thing holds true for notes played by acoustic instruments. Also, the same thing may hold true for sounds produced by your MIDI equipment. The more closely your MIDI equipment simulates real acoustical instruments, the more apparent will be the distinction between note loudness and volume level.

Many instruments have the ability to increase or decrease the loudness of a held note as it is played. This effect is particularly dramatic, for example, with bowed strings and brass instruments. To simulate this effect, you can increase or decrease the volume of the staff over the duration of the long note.

In general, you should attempt to edit the individual loudness of notes so that the quality of the sound seems right when played at a medium staff volume level. Later, if you want to adjust the relative volume levels between staves, then you can do so using the procedures described below. The adjustment of relative staff volume levels is called "mixing" in professional sound studios.

Sometimes, however, you may not be able to achieve sufficient contrast between loud and soft sections of a song by changing the loudness of notes. In such cases, you can increase the volume contrast by setting different staff volume levels in the loud and soft sections of the song.

The remainder of this topic describes procedures for various types of editing of volume level in a song. These procedures refer to general graphical editing techniques introduced in the topic Tutorial on Graphical Music Editing.

To set a single volume level for an entire staff, from the start to the end of the song:

1. If the staff controls are visible, click the Instrument Sound button. To display the staff controls, choose the Show Staff Controls command in the View menu, or type "qssc" for Quick Show Staff Controls.
   - OR --
   While holding down the "T" key, click the mouse anywhere on one of the staves. Composer will display a pop-up menu. Choose the Instrument Sound command in the pop-up menu.
   Composer will display the Staff Setup dialog box.

   If the staff has at least one change in the volume somewhere, then the Staff Setup dialog box will report the Volume level as "var" for varying. Otherwise, it will report the constant volume level currently assigned to the staff.

2. In the Volume field, enter the constant volume value (0 to 127) which you wish to apply to the staff.

   Note that you can also assign a constant volume level to an entire staff, or a range within a staff, following a procedure described later in this topic.

   All of the remaining procedures in this topic for editing the staff volume level begin with these two steps:

   1. Click the GraphOverNotes tab in the main palette.
Viewing and Editing the Music Performance

Type SHIFT+X.

2. Click the Volume button in the GraphOverNotes Palette.

-- OR --

Type "v" for volume.

To set a single volume level, or crescendo or decrescendo, for some range of locations in a staff:

1. Select a region of the staff by holding down the CTRL key and dragging the mouse across the region.
2. Choose the Enter Numeric Value command in the Graph Menu.

-- OR --

Type "n" for numeric value.

-- OR --

Click the Numeric Value button in the GraphOverNotes Palette.

Composer will display the Set Volume in Region dialog box.

3. Enter the start and end volume level numbers in the dialog box, as described in Procedure 10 in the Tutorial on Graphical Music Editing.

-- OR --

Instead of the above procedure, click the Draw Horizontal Line button in the GraphOverNotes Palette, and draw a constant tempo for some range of the staff's volume graph. Or, click the Draw Sloped Line button in the GraphOverNotes Palette, and draw an upward or downward sloping line in the staff's volume graph for a crescendo or decrescendo.

To create an abrupt change in volume level, such as for a piano or forte marking:

1. Choose the Draw Horizontal Line command in the Graph Menu.

-- OR --

Type "h" for horizontal line.

-- OR --

Click the Draw Horizontal Line button in the GraphOverNotes Palette.

2. While holding down the left mouse button, draw a line starting at the location where you want the volume level to be suddenly higher or lower. For more details, see Procedure 7 in the Tutorial on Graphical Music Editing.

To copy a crescendo or decrescendo from one region or staff to another:

For an illustration of copying a crescendo, see Procedure 15 at the end of the Tutorial on Graphical Music Editing.

1. Select the region from which you wish to copy the graph.
2. Choose the Copy Graph from Region command in the Graph Menu.
-- OR --
Type CTRL+C, which is the standard Windows keyboard command for Copy to Clipboard.

3. Select the region to which you wish to copy the graph.

4. Choose the Paste Saved Graph Into Region command in the Graph Menu.

-- OR --
Type CTRL+V, which is the standard Windows keyboard command for Paste from Clipboard.

To remove volume level changes from a region of the song:

1. Choose the Erase command in the Graph Menu.

-- OR --
Type "e" for erase.

-- OR --
Click the Erase button in the GraphOverNotes Palette.

2. While holding down the left mouse button, move the mouse across the region for which you wish to remove the volume level changes, as described in Procedure 8 in the Tutorial on Graphical Music Editing.

To stretch the duration of a crescendo or decrescendo, thus extending it over a longer or shorter range of beats in a staff:

1. Select a region in a staff by dragging the mouse while holding down the CTRL key. Start the mouse drag at the beginning of the region you wish to stretch. If you want to stretch the selected portion of the graph so that it spans more time, then end the mouse drag at the location where you would like the stretch to end when you are done. If you want to compress the selected portion of the graph so that it spans less time, then end the mouse drag at the end of the portion of the graph that you want to shrink.

2. While holding down the CTRL key, hold down the or key to stretch the graph to the right or left. Composer will continuously stretch the graph until you release the keys. Or, while holding down the CTRL key, hit the or key one or more times.

For an illustration of stretching a crescendo, see Procedure 11 in the Tutorial on Graphical Music Editing.

To shift a crescendo or decrescendo to an earlier or later position in the staff:

1. Select a region of the graph that you wish to shift, including the area to the right or left into which you wish to shift the graph.

2. Hold down the or key to shift the graph to the right or left. Or, hit the or key one or more times.

For an illustration of shifting a crescendo to an earlier or later position in the staff, see Procedure 13 in the Tutorial on Graphical Music Editing.

To uniformly increase or decrease the overall volume level for a region of the score:

1. Select a region of the graph for which you wish to change the overall volume level.

2. While holding down the CTRL key, hold down the or key to stretch the graph upward or downward. Or, while holding down the CTRL key, hit the or key one or more times.

For an illustration of uniformly increasing or decreasing the overall volume for a region of the score, see Procedure 14 in the Tutorial on Graphical Music Editing.
8.3.4 Left-to-Right Pan

Controlling the left-to-right pan is similar to adjusting the left-to-right balance of speakers on a stereo system. An important difference is that with Composer pan is controlled on a per-staff basis.

If your MIDI keyboard or other MIDI input device provides a method of controlling pan as you record, Composer will accurately record the left-to-right pan changes.

The following example shows changes in the pan across three measures. In the first measure, the pan in the two staves are in the center (exactly between right and left). In the next two measures, the pan in the first staff gradually moves all the way to the right, and the pan in the second staff gradually moves all the way to the left.

The range of pan values are 63 to the left, to 63 to the right. Exact center is a pan value of 0.

With graphical editing methods introduced in the Tutorial on Graphical Music Editing, some of the common ways you can edit left-to-right pan are:

- Set a single pan level for an entire staff, from the start to the end of the song.
- Create gradual changes in pan between left and right.
- Stretch the duration of a gradual pan change to extend it over a longer or shorter range of beats in a staff.
- Shift a gradual pan change to an earlier or later position in the staff.
- Uniformly increase or decrease the overall pan level for a region of the score.

Procedures for accomplishing each of the above musical goals are described below. Additional procedures for editing the left-to-right pan graph are described in terms of general graph editing techniques in the Tutorial on Graphical Music Editing.
To set a single pan level for an entire staff, from the start to the end of the song:

1. If the staff controls are visible, click the Instrument Sound button. To display the staff controls, choose the Show Staff Controls command in the View menu, or type "qscc" for Quick Show Staff Controls.

   - OR --

   While holding down the "T" key, click the mouse anywhere on one of the staff's staves. Composer will display a pop-up menu. Choose the Instrument Sound command in the pop-up menu.

   Composer will display the Staff Setup dialog box:

   ![Staff Setup dialog box]

   If the staff has at least one change in the pan somewhere, then the Staff Setup dialog box will report the Pan level as "var" for varying. Otherwise, it will report the constant pan level currently assigned to the staff.

2. In the Volume field, enter the constant pan value (0 to 127) which you wish to apply to the staff. The center value is 64. The full left pan value is 0, and the full right pan value is 127.

   Note that you can also assign a constant pan level to an entire staff, or range within a staff, following a procedure described later in this topic.

All of the remaining procedures in this topic for editing the staff pan level begin with these two steps:

1. With the mouse, navigate to the GraphOverNotes Palette.

   -- OR --

   Type SHIFT+X.

2. Click the Pan button in the GraphOverNotes Palette.

   -- OR --

   Type "pa" for pan.

To set a single pan level, or gradual left-to-right or right-to-left pan for some range of locations in a staff:

1. Select a region of the staff by holding down the CTRL key and dragging the mouse across the region.

2. Choose the Enter Numeric Value command in the Graph Menu.

   -- OR --

   Type "n" for numeric value.
-- OR --

Click the Numeric Value button in the GraphOverNotes™ Palette.

Composer will display the Set Pan in Region dialog box.

3. Enter the start and end pan level numbers in the dialog box.

-- OR --

Instead of the above procedure, click the Draw Horizontal Line button in the GraphOverNotes™ Palette, and draw a constant pan level for some range of the staff's volume graph. Or, click the Draw Sloped Line button in the GraphOverNotes™ Palette, and draw an upward or downward sloping line in the staff's pan graph for a gradual left-to-right or right-to-left pan.

To stretch the duration of a gradual pan change to extend it over a longer or shorter range of beats in a staff:

1. Select a region in a staff by dragging the mouse while holding down the CTRL key. Start the mouse drag at the beginning of the region you wish to stretch. If you want to stretch the selected portion of the graph so that it spans more time, then end the mouse drag at the location where you would like the stretch to end when you are done. If you want to stretch the selected portion of the graph so that it spans less time, then end the mouse drag at the end of the portion of the graph that you want to shrink.

2. While holding down the CTRL key, hold down the or key to stretch the graph to the right or left. Composer will continuously stretch the graph until you release the key. Or, while holding down the CTRL key, hit the or key one or more times.

For an illustration of stretching a region of a graph horizontally, see Procedure 11 in the Tutorial on Graphical Music Editing.
To shift a gradual pan change to an earlier or later position in the staff:

1. **Select a region** of the graph that you wish to shift, including the area to the right or left into which you wish to shift the graph.

2. Hold down the \( \rightarrow \) or \( \leftarrow \) key to shift the graph to the right or left. Or, hit the \( \rightarrow \) or \( \leftarrow \) key one or more times.

For an illustration of shifting a region of a graph to an earlier or later position in the staff, see Procedure 13 in the *Tutorial on Graphical Music Editing*.

To uniformly increase or decrease the overall pan level for a region of the score:

1. **Select a region** of the graph for which you wish to change the overall pan level.

2. Hold down the \( \uparrow \) or \( \downarrow \) key to stretch the graph upward or downward. Or, hit the \( \uparrow \) or \( \downarrow \) key one or more times.

For an illustration of this, see Procedure 14 in the *Tutorial on Graphical Music Editing*.

### 8.3.5 Note Pitch Bend

The pitch of a note can be continuously raised or lowered as it plays by degrees much smaller than normal scale half-steps. This is called pitch bend. The most common example of pitch bend is with electric guitars, where the guitarist stretches the string by pushing against it sideways with the fretting fingers. The stretching of the string raises the pitch. The same musical result of pitch bend can be accomplished with a variety of acoustical instruments, such as other string instruments, saxophones, harmonicas, and clarinets. Pitch bend is also quite often used with electronic keyboards.

If your music keyboard has a pitch bend wheel, Composer will record any pitch bends that you perform and will play them back.

You can also "punch in" pitch bends. That is, you can first record notes, and then in a second recording pass, record pitch bends on top of the previously recorded notes.

You can enter pitch bends using graphical editing tools. With just a little practice you will find that you can draw pitch bend curves that sound as though they were performed live.

Or, if you have captured a live pitch bend and wish to apply it to other notes, you can copy and paste the pitch bend on top of the other notes.

In the following example, a pitch bend starts as the \( \text{G above middle-C} \). At the lowest point in the pitch bend, it reaches about 30% of the maximum allowed pitch bend.
You should be aware that the pitch bend applies to all notes under the graph. If a chord is playing in a given staff, then any pitch bend in that staff applies equally to all of the notes in the chord.

If you have recorded or graphically created a pitch bend, there are a variety of ways in which you can further edit it and copy it to other regions in a staff, as described below.

All of the remaining procedures in this topic for editing pitch bend begin with these two steps:

1. With the mouse, navigate to the GraphOverNotes\textsuperscript{tm} Palette.
   -- OR --
   Type SHIFT+X.

2. Click the Pitch Bend \(\text{\textsuperscript{B}}\) button in the GraphOverNotes\textsuperscript{tm} Palette.
   -- OR --
   Type "b", "pi" or "pb" for pitch bend.

The following procedure also works for other types of graphical music data that can be recorded from your keyboard or MIDI pedal controllers.
To record pitch bend on top of previously recorded notes, in a second recording pass:

1. Add a new staff, which will be used to record the new pitch bends. It will be most convenient if you add this staff immediately below the staff that has the notes to which the pitch bends will be applied.

2. If the staff with your notes of interest is assigned to the "Auto" MIDI channel, then assign the staff to a fixed MIDI channel.

3. Assign the new staff (added in step #1) to the same MIDI channel.

4. Select the new staff for recording, and start recording.

5. As you hear the notes played from the previously recorded staff, use the pitch bend control lever on your music keyboard to play the pitch bends. You do not need to play the notes on your keyboard. Only play the pitch bends.

Because you assigned both the new staff and the previously recorded staff to the same MIDI channel in steps #2 and #3, the pitch bends that you play on the keyboard will be merged in real time with the notes that Composer plays back. That is, you will hear your live performance of the pitch bends applied to the previously recorded notes.

6. Stop the recording.

If you followed the previous procedure, you will now see the newly recorded pitch bends in the Pitch Bend Graph, as illustrated below:

7. In the newly recorded staff, select a region that has the pitch bends that you want to copy to the first staff with the previously recorded notes.

8. Type CTRL+C to copy the selected pitch bend graphs to the clipboard.

9. In the original staff with the notes, select a region for the measures and beats.
10. Type CTRL+V to paste the pitch bend graphs from the clipboard.

11. **Delete the temporary staff** in which the pitch bends were recorded.

To insert a new pitch bend in a staff:

1. In the Graph Menu, choose the Draw Curve command.
   -- OR --
   In click the Draw Curve button in the GraphOverNotes™ Palette.
   -- OR --
   Type "d" for draw.

3. While holding down the mouse button, drag the mouse to draw the curve of the pitch bend. Then release the mouse button.

To erase a pitch bend curve:

1. In the Graph Menu, choose the Erase command.
   -- OR --
   Click the Erase button in the GraphOverNotes™ Palette.
   -- OR --
   Type "e" for erase.

2. Move the mouse right before the beginning of the pitch bend curve you want to erase. It does not matter where you place the mouse vertically. It only matters where you place the mouse horizontally, to choose the starting point for erasing. While holding down the mouse button, drag the mouse to the right. Composer will remove the graph for the pitch bend as you drag the mouse to the right.

To move a pitch bend forward or backward, or to stretch the duration of a pitch bend so that it extends over a longer or shorter range of beats in the staff:

1. **Select a region** in a staff by dragging the mouse while holding down the CTRL key. Pitch bends usually apply to a single note or chord. So drag the mouse from the start of the note to the end of the note, even if the pitch bend does not span the entire note or chord.
In the example below, a region has been selected in preparation for extending the pitch bend further to the right:

2. Hold down the $\rightarrow$ or $\leftarrow$ key to stretch the graph to the right or left. Or, hit the $\rightarrow$ or $\leftarrow$ key one or more times. To shift the graph to the right or left, without stretching it, hold down the SHIFT key while holding down or hitting the $\rightarrow$ or $\leftarrow$ key. Composer will continuously stretch or move the graph until you release the key.

The following illustration shows the result of stretching to the right the graph in the above example. Because the curve did not start at the beginning of the region, it was necessary to use a combination of stretch commands and shift commands.

To stretch a pitch bend, so that it changes the pitch by a greater or lesser amount over the same duration:

1. Select a region in a staff, as in the previous procedure.

2. Hold down the $\downarrow$ or $\uparrow$ key to increase or decrease the extent of the pitch bend.

The following illustration continues from the previous example with stretching the pitch bend downward:

To copy a pitch bend from one note, chord, or range of notes to another:

1. Select the region from which you wish to copy the graph, by holding down the CTRL key and dragging the mouse. Typically the region starts at the beginning of a note or chord that has a pitch bend, and ends at the end of that note or chord.

2. Choose the Copy Graph From Region command in the Graph Menu.

-- OR --

Type CTRL+C, which is the standard Windows key combination for Copy to Clipboard.

3. Select the region to which you wish to copy the graph.

4. Choose the Paste Saved Graph Into Region command in the Graph Menu.

-- OR --

Type CTRL+V, which is the standard Windows key combination for Paste from Clipboard.
The sustain pedal MIDI control is equivalent to the right-most pedal on a piano, which holds the sound of a note until you release the pedal. An important difference is that the MIDI sustain pedal control only allows for completely up or down. Half-pedal techniques on acoustic pianos cannot be simulated with the MIDI sustain pedal control.

If your MIDI keyboard or controller includes a connection to a MIDI sustain pedal, then Composer will record your pedal actions along with your keyboard performance.

The sustain pedal is applied on a per-staff basis. A keyboard part is typically divided into right- and left-hand staves. If you wish a sustain pedal action to apply to both the right- and left-hand staves, then you will need to separately add that sustain pedal action to the same region in both staves.

The following example shows how a sustained arpeggiated (rolled) chord can be notated and performed two alternative ways. First, the sustained notes can be written out with note values and note ties that span the full duration of the chord. Second, the sustained notes can be written using short note values, and the sustain can be accomplished with the sustain pedal:

Only two values are possible for the sustain pedal: on (or "pedal down") and off (or "pedal up").

With graphical editing methods introduced in the Tutorial on Graphical Music Editing, you can:

- Set the sustain pedal to the "on" or "off" position for a particular range of a given staff.
- Copy the sustain pedal action for some range of locations in a right-hand keyboard staff to the same range of locations for the left-hand staff.

You can convert pedal mark annotations to performances, and sustain pedal performances to pedal mark annotations, as illustrated below. For instructions, see Converting Pedal Marks to Pedal Performance and Converting Pedal Performance to Pedal Marks.
All of the procedures for editing the sustain pedal control begin with these two steps:

1. With the mouse, navigate to the GraphOverNotes™ Palette.
   -- OR --
   Type SHIFT+X.

2. Click the Sustain Pedal button in the GraphOverNotes™ Palette.
   -- OR --
   Type "s" for sustain pedal.

To set the sustain pedal to the "on" or "off" position for a particular range of a given staff:

1. In the Graph Menu, choose the Draw Curve command.
   -- OR --
   Click the Draw Curve button in the GraphOverNotes™ Palette.
   -- OR --
   Type "d" for draw.

2. While holding down the left mouse button, move the mouse over the range for which you wish to change the sustain pedal position to "on" (pedal down) or "off" (pedal up). If you move the mouse above the middle of the staff, the drawing will jump to the top of the staff to indicate the "on" position. It will jump to the bottom for "off" when the mouse is below the middle of the staff.
To copy the sustain pedal action for some range of locations in a right-hand keyboard staff to the same range of locations for the left-hand staff:

1. **Select the region** in the right-hand keyboard staff, as illustrated below (note that the selection will be pink rather than gray):

2. Choose the Copy Graph from Region command in the Graph Menu.
   -- OR --
   Type Ctrl+C, which is the standard Windows keyboard command for Copy to Clipboard.

3. Select the same range of locations in the left-hand staff.

4. Choose the Paste Saved Graph Into Region command in the Graph Menu.
   -- OR --
   Type CTRL+V, which is the standard Windows keyboard command for Paste from Clipboard.

Here is the result:

---

8.3.7 **MIDI Controller Data**

There are a variety of ways that you can control the sound of a MIDI device other than the most common ways described in the previous topics: channel volume, pan, pitch bend, and sustain pedal.
The following example shows the modulation wheel applied to the second note. The modulation wheel typically produces a vibrato effect.

To view and edit MIDI controller data:

1. With the mouse, navigate to the GraphOverNotes™ Palette.
   -- OR --
   Type SHIFT+X.

2. Click the MIDI Controller Data button in the GraphOverNotes™ Palette.
   -- OR --
   Type "c" for controller data.
Composer will display the following dialog box:

![Select Type of Controller Data dialog box](image)
9 Configuring Your Soundcard and MIDI Equipment

When Composer runs for the first time after installation, the default Notation Software Synth allows you to immediately start playing MIDI files that you have opened. You should hear sound through the speakers connected to your sound card.

If you do not hear sound, then use the Quick MIDI Device Setup command in the Setup menu. Use it to test the playback of alternative MIDI playback devices on your system, and choose a device for which you do hear sound. If that does not work, then follow the advice in What To Do If You Do Not Hear Sound.

If your sound card is connected via a cable to a MIDI keyboard, then you should also be able to play at your keyboard and hear sound through the speakers connected to your sound card. If you do not, then follow the advice in What To Do If Recording Does Not Work.

If the MIDI playback and recording capabilities of your system are simple, Composer makes it very easy for you to set up your MIDI devices. See Procedures for Common MIDI Configuration Tasks. The topics in that section are:

- Assigning Device Names That Make Better Sense to You
- Changing the Default Playback Device
- Installing a MIDI Cable Between Your sound card and Keyboard
- Adding a New MIDI Keyboard to Your Configuration
- Deciding Whether or Not Your Keyboard Should Directly Produce Sound

Composer has been carefully designed to avoid overwhelming music enthusiasts with many of the underlying technical details of MIDI. However, if you have a sophisticated MIDI studio, Composer provides a powerful, but intuitive MIDI Device Configuration Window in which you can describe to Composer exactly how your MIDI studio is arranged. Common tasks for managing MIDI studios that are more complicated than a single sound card and keyboard are described in the section Procedures for Advanced MIDI Configuration Tasks, which includes these sub-topics:

- Installing a Software Synthesizer
- Anticipating the Delay on Some MIDI Output Devices
- Configuring a New External MIDI Sound Module
- How to Handle Devices Connected with MIDI Thru Cables
- How to Save Effort If You Rearrange Your MIDI Equipment Often

The final section of this chapter provides a detailed guide to using all of the features in the MIDI Device Configuration Window. Again, if your music equipment consists of no more than a sound card and a keyboard, then you will find it easier to use the Quick MIDI Device Setup window. However, if you want to utilize the full performance capabilities of Composer on your computer, then these topics will be interest to you.

The topics in this chapter's final section, Using the MIDI Device Configuration Window, are:

- Understanding the Details of the MIDI Device Configuration Window
- Testing Playback and Recording Devices
- Managing MIDI Ports
- Managing MIDI Devices
- Assigning Bank and Patch Names to a MIDI Device
- Managing Alternative MIDI Device Configurations
Please note that the release of Version 3 of Notation Composer made it necessary to change the format of the older MIDI Device Configuration files (MidiDev.cfg). If you are installing Notation Composer after having used a previous version, you will need to reimport any INS (Cakewalk filetype) device descriptions that you may have had previously.

9.1 Notation Software Internal Synthesizer

With version 3.0.3 Notation Software introduced its own Notation Software Synth, an internal synthesizer that uses soundfont technology and eliminates the need for any external or installed MIDI playback or recording device(s). The Notation Software Synth is based on the FluidSynth soundfont synth, and is used under the appropriate license.

Notation Composer allows you to select whichever General MIDI (GM) SF2 or SF3 soundfont you would like to use. Composer’s installation includes the FluidR3Mono_GM.sf3, which is used under the appropriate license for free distribution. There are many excellent quality soundfonts that are available for free on the internet. Use your favorite search engine to look for "general MIDI soundfont" to find them. See the instructions below for using those in Notation Composer.

To select which options you wish to use for the Notation Software Synth, you will need to access its Device Properties dialog. You can do this by clicking "Setup -> MIDI Devices...Configuration" to see the MIDI Devices that are on your machine. Notice that the Notation Software Synth is highlighted in green, indicating that it is the current default playback device:

![MIDI Device Configuration dialog](image)

By double-clicking the Notation Software Synth device listing, you can access its Properties dialog:
Selecting a General MIDI (GM) soundfont

Notation Composer installs a soundfont that is ready to go when you first run the software. However, you may wish to explore other soundfonts as well. Notation Composer can use either sf2 or sf3 type soundfonts. If you have other soundfonts that you would like to use with Notation Composer, just do the following:

1. Click the "Soundfont" button in the Device Properties dialog (see above)
2. Click the "Select Soundfont" button.
3. Navigate to the soundfont's location on your machine.
4. Click on the soundfont file you want to select.
5. Click the "Open" button in the dialog to save the change, which you will see shown in the Soundfont field. Notation Composer saves a copy of the soundfont into the C:\Users\Public\Documents\Notation_3\Soundfonts folder so that next time you want to use your soundfonts they will be readily available without having to navigate to other locations on your machine.

Please note that since changing soundfonts is a Device Property, the selected soundfont will be used for all instruments that use the Notation Software Synth as their playback device in any open song(s). If you have a variety of soundfonts that you would like to incorporate in the same song file, then you may need to use a third-party soundfont library editor to pull together those various instruments into a single soundfont. Please visit our Users Forum and search for "soundfont editor" for more information.
Selecting the audio driver

The Notation Software Synth has the flexibility to offer excellent sound and superior real-time playalong and recording capability. It supports the ASIO Driver Technology by Steinberg Media Technologies as well as standard Windows DirectSound. For most playback situations DirectSound will be sufficient for good quality sound. If you wish to playalong with or record into Notation Composer in real-time without latency issues, though, you should probably select to use the ASIO driver.

To change the selection of the sound driver, click the "Driver" button in the Device Properties dialog above to get the following Dialog:

![Driver Options Dialog]

Click the radio button for the Audio Technology you wish to use, then click "Ok" to save the change.

Selecting the Sample Rate

Most CD and other digital recording media is recorded at 44,100 Hz rate, and this is the default setting for the Sample Rate in the Notation Software Synth. You should be fine to leave it at that.

If you are working with high-end audio recording, or are mixing exported .wav audio files from Notation Composer with other audio files that have a sample rate of 48,000 Hz then you should change the Sample Rate to match the other audio sample rates of your project.

Selecting the Buffer Size and Buffer Count

The default Buffer settings represent a moderate setting that should work on most machines. However, due to various factors you may need to change the Buffer settings. For example, if you hear static, crackling, "echoes," or other audio distortions when playing back a file in Composer then you may want to try changing the buffer settings.

Briefly, to keep the latency low, the buffer settings should be such that the multiplied number (size x count) is kept as small as possible while still yielding good sound. If you are experiencing static, crackling, or other audio artifacts, try changing the Buffer Size first to a higher number and see if that fixes the problem.

1. Click the "Manually enter buffer size and count..." button in the Driver Options dialog.
2. Click the drop list for the Buffer size and select the next "size" larger than the current setting:

![Sound Buffer Size and Count](image)

3. Click "Ok" to save the change.

4. Test the playback of your song file to see if the new setting fixes the problem.

5. Alternatively you can enter a higher number in the Buffer count field, click "Ok" to save the change, and then test the playback of your file.
Setting Audio Parameters for Playback or Exporting Audio Files

Notation Composer can export WAV, MP3, OGG, and FLAC audio files using the internal Notation Software Synth as the playback device for sounds. The default gain levels for playback and exports have been carefully calibrated to give a high quality exported audio file using the default soundfont that is installed with the software. These levels may or may not be the best for other soundfonts, or if you find that the default levels cause any audio issues or artifacts, you may want to change the gain level for the filetype that you are exporting.

To adjust the gain for an exported audio filetype:

1. In the top menu click "Setup", then "MIDI Devices...configuration."
2. In the MIDI Device Configuration dialog box, (1) right-click the Notation Software Synth and (2) select "Properties."
3. Now click the "Soundfont" button.
4. The current settings are displayed under "Gain" and "Gain for Audio Export." To change any of the gain settings, click the "Adjust Gain" button.
5. Enter the value(s) you want to change, then click "Ok" to save your changes.

Now try your export or playback again to see if the audio issues are resolved.

9.2 Quick MIDI Device Setup

Most computer systems include MIDI sound cards and alternative synthesizers (which we call MIDI devices) for creating instrument sounds for MIDI playback. You might find it helpful to think of a synthesizer (MIDI device) as an orchestra ready to play various kinds of instrument sounds at your request. Your system most likely has a couple of MIDI devices, which are like different orchestras with different personalities or sound qualities.

The Quick MIDI Device Setup command in the Setup menu lets you quickly select and test the alternative MIDI devices. You should use the Quick MIDI Device Setup command especially if you do not hear any sound when you first run Composer, or after you have installed a new sound card.
The MIDI playback device that you select in the Quick MIDI Device Setup window will be the default playback device assigned to any new song you subsequently create, or any song you import as a MIDI file.

If your sound card is externally connected via a MIDI cable to a MIDI keyboard (or MIDI guitar or other input device), then the Quick MIDI Device Setup command also lets you quickly test whether the connection to your MIDI keyboard is working.

Most MIDI devices offer a list of 128 different instrument sounds, and certain drum sounds, which together are called the "General MIDI" sounds. Many MIDI devices also offer one or more additional "banks" of sounds, where each bank can have up to 128 sounds. If your MIDI device has additional banks of sounds besides General MIDI sounds, you can also use the Quick MIDI Device Setup command to inform Composer about what particular MIDI device manufacturer and model you are using. With that information, Composer lets you select instrument sounds by meaningful names, such as "pizzicata violin" instead of MIDI "patch" numbers.

The Quick MIDI Device Setup command also provides a way for you to change difficult-to-read device names to ones that make sense to you. For example, if you have a Casio™ keyboard connected via a MIDI cable to a SoundBlaster Live!™ sound card in your computer, the Casio keyboard will be identified as "SB Live! MIDI UART". It is not possible for Composer (nor any other MIDI program) to detect the name of the keyboard connected via the MIDI cable to the sound card. However, you can quickly tell Composer the name of the external device. For example, you can change the name from "SB Live! MIDI UART" to "Casio" or simply "Keyboard". Once you rename a device this way, you will find it easier to refer to it later in other parts of the Composer program.

To test and select a MIDI playback device on your system:

1. Choose the Quick MIDI Device Setup command in the Setup menu.
   -- OR --
2. Type "qqds" for "Quick Quick Device Setup".
   Composer will display the Quick MIDI Device Setup window, as illustrated here:

   ![Quick MIDI Device Setup Window]

2. To test the sound for a playback device, select one in the dropdown list, and then click the Test Playback button.
   Composer will display and play a 12-note chromatic scale. The notes will be highlighted as they play. Also, the green playback indicator in the Quick MIDI Device Setup window will
display a bright green color as the notes are played. Upon completion of the playback, Composer will close the window that displays the notes.

If the device is an "internal" device on your Windows system, then you should hear sound through the speakers connected to your sound card. If the device is "external", such as a MIDI keyboard capable of producing its own sound, then you should hear that device play the sound.

3. If you do not hear sound for a device when you choose the Test Playback option, then some possible explanations and remedies are discussed in What To Do If You Do Not Hear Any Sound

4. If you wish to rename the playback device, click the Rename Device button next to the playback device name.

Composer will present a Rename MIDI Device dialog box, in which you can specify the new name.

5. Click the OK button when you have selected the desired playback device.

6. After you click OK, if you have already opened a song, Composer will display a simple dialog box that offers you the option to reassign all of the staves of that song to the newly assigned default device.

If you have more than one song already opened, and you want to reassign staves for the other songs, follow the instructions for Changing the Instrument Sound of a Staff.

To test and select a MIDI recording device on your system:

1. Choose the Quick MIDI Device Setup command in the Setup menu. Composer will display the Quick MIDI Device Setup window, as shown earlier.

2. To test whether Composer is detecting notes that you play at your MIDI keyboard, simply play on some of its keys.

The Quick MIDI Device Setup window will automatically display the name of the MIDI recording device:

Also, as you play on your MIDI keyboard, the red recording indicator in the Quick MIDI Device Setup window will light up in a bright red color. Further, if your recording device is configured with "Echo MIDI Input to Output", then as you play on your MIDI keyboard, your selected MIDI Playback Device will produce sound for the notes as you play them, and the green light will
indicate so. Composer always initially configures recording devices with "Echo MIDI Input to Output". To review or change the echo option, see Specifying Properties of a Device.

If you experience a problem where the keyboard produces its own sound at the same time that you also hear sound through your sound card, then there are some alternative ways you can turn off sound for one or the other. See Determining Whether or Not Your MIDI Keyboard Should Produce Sound.

If your recording device is not indicated in the Quick MIDI Device Setup window, then some possible explanations and remedies are discussed in What To Do If Recording Does Not Work.

3. If you wish to rename the playback device, click the Rename Device button next to the playback device name.

Composer will present a Rename MIDI Device dialog box, in which you can specify the new name.

For example, if you have a Casio keyboard connected to your computer, you are unlikely to think of it as the "In-A USB MidiSport 2x2", illustrated in the above example. The "In-A USB MidiSport 2x2" name unattractively identifies a "MIDI port" inside of Windows. Since this Windows MIDI port is uniquely associated with, or essentially connected to, your Casio keyboard, it would make a lot more sense to you if this recording device were instead named "Casio". You can do that in the Rename MIDI Device dialog box:

4. In the Quick MIDI Device Setup dialog box, click the OK button when you have selected the desired recording device.

If your MIDI device has additional MIDI sound banks besides the General MIDI sounds, then it is a good idea to import the sound names, as described in the next procedure. Once you have done this, you can refer to instrument sounds according to names, such as "pizzicata violin", rather than MIDI patch numbers.

You can import instrument sound names from either of two types of files: (1) a Cakewalk Instrument Description (.ins) file, or (2) a Notation Software MIDI Device Description (.mdd) file. INS and MDD files are available at the web site of, respectively, Cakewalk and Notation Software, as described in the procedure below. An INS or MDD file usually is named according to a MIDI device manufacturer's name, as in yamaha.ins or roland.ins. The file typically has descriptions for several MIDI device models offered by the manufacturer.

To set up sound names for a device that has additional MIDI sound banks besides the General MIDI sounds:

1. Find a Cakewalk INS file for the manufacturer of your MIDI keyboard or device. This is most easily accomplished by using your favorite search engine to search the internet for .ins files for your keyboard or device.

2. In your Internet browser, download the INS file to a directory that you should remember.

3. In the Quick MIDI Device Setup dialog, select a MIDI output port under Select MIDI Playback Device.
A MIDI output port will include "MIDI Out" or "Out" in its name. If your device is connected via a USB cable, then the MIDI output port will also have "USB" in its name.

4. Click the Import Sound Names button.

Composer will display the Import Sound Names from File dialog box:

5. In the dialog box, navigate to the directory where you downloaded the INS or MDD file, and select the file. Click the Open button.

Composer will display the Select Manufacturer and Model dialog box:

6. Select your particular manufacturer / model in the list, and click the OK button.

Composer will then display the Select MIDI Port dialog box:
Make sure that the newly imported device is associated with ("connected to") the correct MIDI output port. The MIDI output port will probably have "Out" or "External" in its name.

7. Click the OK button in the Select MIDI Port dialog box.
8. Click the OK button in the Quick MIDI Device Setup dialog box.

For additional information about setting up instrument sound names, see Preparing Bank, Patch, and Drum Note Names for a MIDI Device.

9.3 What To Do If You Hear Static or Crackling

If you hear static, crackling, or other audio artifacts and are using the Notation Software Synth, please see the section on adjusting the buffer settings for tips on correcting this problem.

If you are exporting audio files from Composer and are hearing audio artifacts, you may also want to try adjusting the gain setting(s) in the Notation Software Synth for audio export.

If you are using a different MIDI playback device, you will need to consult the user's manual for your device and/or the manual for your sound card. You can typically find these by visiting the manufacturer's website and searching for "user's manual" and the model or name of your device or sound card.

9.4 What To Do If You Do Not Hear Any Sound

If you do not hear any sound during playback of a song, you should use the Quick MIDI Device Setup to try out alternative MIDI playback devices that are available on your system.

NOTE: Selecting the Notation Software Synth as your playback and recording device should automatically allow you to hear your song files on any system as long as the system volume is "on".

If you are hearing static or crackling during playback, please see the section on adjusting the buffer settings.

However, if you prefer to use a different MIDI device, this topic offers several possible explanations and remedies for the problem of no sound. Some explanations and remedies are not specific to Composer. It is quite possible that you will not hear MIDI playback in any MIDI program, not just Composer. If you have explored several possible explanations and remedies within Composer,
and still do not hear sound, it is a good idea to determine whether the problem is just with using Composer, or whether the problem is common to any MIDI program on your system. A good way to do this is to try playing a MIDI file using another MIDI program. We recommend using the Windows Multimedia Player, which is almost always installed on a Windows system. For detailed instructions on testing MIDI playback using the Windows Multimedia Player, see the procedure at the end of this topic.

The first test you should do within Composer is to try the Test Playback option in the Quick MIDI Device Setup window. If you unexpectedly do not hear sound for a particular device, then several possible explanations and remedies are offered below. The most common explanations, and the easiest ones to solve, are listed first:

- Another application is using the MIDI output device.
  In this case, exit the other application and try the MIDI device again in Composer. It may be necessary to also exit Composer and then start Composer again.

- The volume level in Composer is set to zero.
  In this case, increase Composer’s volume level.

- The Windows sound volume level is set to zero, or is muted. In this case, click the following icon in the Windows taskbar at the bottom of the screen:

  ![Speaker icon](image)

  OR

  Make sure that the volume level is above the lowest setting, and that there is no "X" over the speaker icon, or a check mark for Mute.

- The specific volume level for MIDI playback is muted or set to an inaudible level.
  On some versions of Windows, the volume level for playback of MIDI can be controlled separately from the volume level for playback of other types of audio. Make sure that the volume level for MIDI playback is not zero and not muted, as follows.

  Click the Windows Start menu at the bottom, left corner of the screen. Windows will display a pop-up menu. Choose the Settings / Control Panel option. In the Control Panel folder, choose the option named "Sounds and Audio Devices" or "Sounds and Multimedia":

  ![Sounds and Audio Devices](image)  -- OR --  ![Sounds and Multimedia](image)
Windows XP will display the Sounds and Audio Devices dialog box. Click the Volume tab. Under "Device Volume", click the Advanced button.

Windows will display the Playback Control panel. It looks like the following on Windows XP, and similar to this on earlier versions of Windows:

![Playback Control Panel](image)

Observe that there is a separate volume control for MIDI. Make sure that the MIDI volume level is above the lowest setting, and that there is no check mark for Mute. These separate MIDI volume controls are not present in newer Windows audio settings. Alternatively if you have a specialized sound card configuration your control panel may look different.

- You selected an external playback device, but there is no external MIDI device, such as a MIDI keyboard, connected via a MIDI cable to the MIDI Out connector of your sound card.

  In this case, choose an internal playback device instead of an external device. The MIDI Device Configuration Window indicates whether a device is internal or external.

- There is a problem with the external MIDI device or cable connecting it to your computer.

  If the output device is an external MIDI synthesizer or sound module connected via a MIDI cable to the MIDI output connector of your sound card, then there are a couple of reasons why you may not hear any sound.

    -- Make sure that the output device power is turned on.

    -- Make sure that the cable is connected to the MIDI connector of the sound card. The other end of the cable should be connected to the MIDI In connector of the external MIDI device.

    -- Make sure that the volume level of the external device is at an audible level.

- The device driver for the MIDI device is not installed correctly.

  To determine if this is the case, explore whether this MIDI device can be used by another MIDI application, such as the Windows Multimedia Player, as described in the last procedure of this topic.

  If the device cannot be used in other MIDI applications, then try re-installing the device drivers for your MIDI sound card.

  Sometimes problems with non-responsive MIDI devices can be resolved by updating the driver to the most recent one available from its manufacturer. Search the Internet for the manufacturer's web site. Look for the "download" or "drivers" section of its web site. Find and
download the driver that matches the model of your MIDI device and the version of Windows you are using (Windows 98, Me, 2000, XP, etc.)

To test the playback of MIDI files using another MIDI program on your system, and using a specific MIDI playback device:

**NOTE:** Although the names of the Windows options, folders, and dialog boxes vary among different versions of Windows, the following instructions are still basically the same.

1. Review, and optionally change, the default MIDI playback device that Windows chooses for playing MIDI files:
   
   (a) With the left mouse button, click the Start button in the lower, left corner of the screen.
   
   Windows will display the Start menu.
   
   (b) Choose Settings in the Start menu, and Control Panel in the Settings submenu.
   
   Windows will display the Control Panel folder.
   
   (c) In the Control Panel folder, choose Sounds and Multimedia.
   
   Windows will display the Sounds and Multimedia Properties window.
   
   (d) In the Sounds and Multimedia Properties window, choose the Audio tab.
   
   The window will look like this:

   ![Sounds and Audio Devices Properties](image)

   (e) Make note of the MIDI Music Playback default device.

2. Run the Windows Multimedia player, as follows:
(a) With the left mouse button, click the Start button in the lower, left corner of the screen. Move the cursor to the "All Programs" listing. Windows will display a menu.

(b) In the menu, choose Accessories.

(c) In the Accessories submenu, choose Entertainment.

(d) In the Entertainment submenu, choose Windows Media Player.

This will start the Windows Media Player program.

3. In the Windows Media Player, play the minuet.mid MIDI file that is installed with "%PRODCOLON%"

(a) In the File menu of the Windows Media Player, choose the Open command.

(b) In the File Open dialog box, navigate to this directory, if it is not already opened as the default directory:

   C:\Users\Public\Documents\Notation_3\Songs

(c) Double-click the file name minuet.mid.

4. Play the MIDI file by pressing the play control in the Windows Media Player, or by choosing the Play command in the Play menu.

5. If you do not hear sound from Windows Media Player, then repeat the following steps until you find an available MIDI device by which you can hear sound in the Windows Media Player:

   (a) Exit the Windows Media Player.

   (b) Repeat all of the steps in this procedure, starting at step #1, except as noted next.

   (c) After step 1(d), select another available MIDI playback device.

6. Once you have found a MIDI device that works with the Windows Media Player, select that device in the Quick MIDI Device Setup.

7. If you do not find a MIDI device that works with the Windows Media Player, then there may be a problem with the installation of the sound card and/or its drivers on your system.

9.5 What To Do If Recording Does Not Work

First, find out whether Composer is actually recording notes that you play on your MIDI keyboard.

To determine whether Composer is actually recording notes:

1. Follow the procedure for Starting and Ending the First Recording.

   You should see red piano roll rectangles drawn in the current staff as you play notes on your keyboard.
2. If you see the red rectangles as you play at the keyboard, then you know that Composer is detecting what you are playing. In that case, as soon as you stop the recording, Composer will transcribe your recording to notation.

If Composer fails to transcribe your recording into displayed notes, then you might still be able to recover the recording. It is saved in a file named `recording.mid`, as explained in Recovering an Interrupted Recording. If you open the `recording.mid` file, and your recording has been transcribed to notation, then the source of the problem is not exactly known at this point, but at least you know that Composer was recording the notes from your keyboard, and you will have recovered your otherwise lost recording.

3. If you do not see the red rectangles as you play at the keyboard, then follow the next procedure, even if you do hear the notes as you attempt to record them.

   - If you do not hear any notes as you play on your music keyboard, then set up Composer to recognize it:
     1. Choose the Quick MIDI Device Setup command in the Setup menu.
     Composer displays the Quick MIDI Device Setup dialog:

       ![Quick MIDI Device Setup dialog]

       2. Play a note on your music keyboard. You should see the red recording button light up. Also, the name of your MIDI recording device should be reported, as shown here:

         ![Quick MIDI Device Setup dialog with notes played]

         The MIDI device on which you played the notes is reported here.

         Recording button is shown in bright red as you play a note.
3. If the red recording button does not light up in the Quick MIDI Device Setup window, then make sure that the MIDI keyboard is included in Composer's MIDI Device Configuration. (The device might be awkwardly named unless you have specifically changed its name.) Choose the MIDI Device Configuration command in the Setup menu, and confirm that the MIDI keyboard is listed as a MIDI input device. If you do not find the MIDI keyboard device listed, then add it to Composer's MIDI Device Configuration, following the instructions for Adding a New MIDI Keyboard to Your Configuration.

4. If the red recording button does light up, and the green light for the playback device also lights up as you play on the keyboard, but you do not hear sound, then the problem is not with recording but, rather, with the playback device. Try selecting a different playback device in the Quick MIDI Device Setup window. Choose a playback device for which you know you can hear sound. Create a new song, and assign that working playback device to the first staff. Enter a few notes in the staff. Then play the song. If you do not hear sound, then you should explore this problem further as a playback problem rather than as a recording problem. See What To Do If You Do Not Hear Any Sound.

If the red light in the Quick MIDI Device Setup window does not light up when you play the keyboard after correctly setting up up your MIDI keyboard in Composer, then you should explore some possible external problems:

1. If you have another music software program capable of recording MIDI, see if you can successfully record with it. If recording does not work in other MIDI programs either, check the connection of your MIDI keyboard to your computer. Also check the installation of the MIDI drivers for your MIDI sound card device, or perhaps MIDI USB hub, that handles the MIDI input. If the problem is only with Composer, then you should focus your efforts in Composer's MIDI Device Configuration.

2. Make sure that your MIDI keyboard is connected via a MIDI cable or USB cable to your sound card, a USB MIDI hub, or USB port.

3. Make sure that the device driver for the MIDI input device is correctly installed.

Sometimes problems with non-responsive MIDI devices can be resolved by updating the driver to the most recent one available from the manufacturer. Search the Internet for the manufacturer's web site, and look for the "download" or "drivers" section. Find and download the driver that matches the model of your MIDI device and the version of Windows you are using (Windows 98, Me, 2000, XP, etc.) You might also be able to find the driver at the Microsoft Windows Update web site.

4. Make sure that another MIDI application is not attempting to simultaneously use the same MIDI recording device (Windows MIDI input port). If so, then exit the other application and try recording again in Composer. It may be necessary to also exit Composer and then start Composer again.

If the red light in the Quick MIDI Device Setup window does light up when you play at the keyboard, then turn on the echo option for your MIDI input device:

When "echo" is enabled for a MIDI keyboard device, then whatever you play on the keyboard is routed to some MIDI output device for simultaneous playback. The notes you play on your keyboard are immediately "echoed" on the MIDI output device.
1. Play some notes on your keyboard and observe whether the green playback light in the Quick MIDI Device Setup window lights up brightly:

When the notes you playback at the keyboard are echoed to the playback device, this light turns to bright green.

If the green light does not light up, that means that "echo" is not enabled for your MIDI keyboard device.

Note that it is not necessary that you enable echo for your MIDI keyboard device. If you do not enable echo for your MIDI keyboard device, then your MIDI keyboard should be responsible for producing the sound as you play. If your keyboard is just a MIDI controller, which means that it does not itself produce sound, then you must enable echo in order to hear what you are recording.

However, even if you normally want your MIDI keyboard to assume responsibility for producing sound as you play, it is a good idea to temporarily enable echo while you troubleshooting the recording problem in the steps that follow.

2. In the Setup menu, choose the MIDI Device Configuration command.

3. In the Port or Device column of the MIDI Device Configuration Window, find the name of the MIDI input device, such as "In-A USB MidiSport 2x2" in an above example of the Quick MIDI Device Setup window. For a MIDI input device, the MIDI Device Configuration Window reports "In" in the left-most column, and displays a Record light in the "Rec" column.

4. Double-click on "External Device" (not "External Port") or the name of the external device.
Composer will display the Device Properties dialog for the external device.

5. In the Device Properties dialog box, set a check mark for "Echo MIDI Input to Output". Click the OK button.

6. Repeat the second procedure in this topic, to confirm whether the notes you play on the keyboard are now echoed to the MIDI playback device.

9.6 Procedures for Common MIDI Configuration Tasks

This section of the chapter, Configuring Your sound card and MIDI Equipment, describes simple procedures for the most common MIDI configuration tasks:

- Assigning Device Names That Make Better Sense to You
- Changing the Default Playback Device
- Installing a MIDI Cable Between Your sound card and Keyboard
- Adding a New MIDI Keyboard to Your Configuration
- Deciding Whether or Not Your Keyboard Should Directly Produce Sound

If the task you need to accomplish is not in the above list, then see also Procedures for Advanced MIDI Configuration Tasks.

9.6.1 Assigning Device Names That Make Better Sense to You

You will probably often refer to MIDI device names as you assign instrument sounds to staves of songs. In choosing whether the instrument sound is, for example, a flute or clarinet, you must also specify which MIDI device in your configuration produces that sound. Because you might need to refer
to MIDI device names often, Composer offers you a way to assign devices names that make sense to you.

When Composer runs for the first time, it detects the various MIDI "ports" on your system. A MIDI port is a somewhat abstract entity defined by Windows to identify choices for MIDI sound output and input. MIDI ports have names that are defined by the manufacturer of your sound card or MIDI keyboard or other MIDI device. The names are usually long and somewhat difficult to understand. If you have a music keyboard connected to the computer, you are likely to think of it as "Keyboard" or "Yamaha\textsuperscript{tm} Keyboard" or "Yamaha", rather than as "the device that is connected to my Soundblaster Live! MIDI UART port". This would be especially true if you do not know (very few people do know) what "UART" means (universal asynchronous receiver/transmitter). Recent versions of Creative Lab's sound cards have a more friendly name for the external MIDI port, such as "Creative SB Live! External MIDI".

Composer lets you assign device names that make sense to you. You cannot change the name of the Windows MIDI ports. But you can change the names of the devices that are connected to them. It is a particularly good idea to rename external devices. An external device is one that is physically located outside of your computer and is connected via a MIDI cable to your sound card (or perhaps a special MIDI port card).

By default, Composer assigns a "placeholder" external device to any MIDI external port that it detects. It gives the device the same name as that of the corresponding Windows MIDI port.

The following example illustrates how you would specify that a staff should be played back on an external device, such as a Yamaha\textsuperscript{tm} keyboard, which is connected to the "Creative SB Live! External MIDI" port. The Yamaha keyboard would be connected to your computer via a USB or perhaps MIDI cable.

![Staff Setup](image)

This device is internally identified in Windows as "Creative SB Live! External MIDI", but you probably think of this external device as "Yamaha Keyboard".
When you use the Staff Setup command to assign a MIDI device and instrument sound to a staff, you will probably find it easier to refer to the name of your keyboard, such as "Yamaha keyboard" rather than "Creative SB Live! External MIDI", as illustrated here:

With one short procedure, described below, you can rename the device from "Creative SB Live! External MIDI" to "Yamaha Keyboard". Thereafter, you can always refer to the external device as "Yamaha Keyboard", when assigning staves to any song.

The procedure for changing the name of a MIDI device is the same whether it is external or internal, but the procedure is slightly different for an output (playback) device versus input (recording) device.

To change the name of a MIDI output (playback) device:

1. Choose the Quick MIDI Device Setup command in the Setup menu OR type the shortcut "qqds."

Composer will display the Quick MIDI Device Setup window, as illustrated here:

2. In the list, select the MIDI playback device you wish to rename.

3. Click the Rename Device button next to the playback device name.
Composer will present you with the Rename MIDI Device dialog box.

4. In the Rename MIDI Device dialog box, enter the new name for the playback device, and click the OK button.

To change the name of a MIDI input (recording) device:

1. Choose the Quick MIDI Device Setup command in the Setup menu.
   Composer will display the above Quick MIDI Device Setup window.

2. Play a few notes on the recording device. The name of the recording device will be reported in the Quick MIDI Device window. If it is not, then see the procedure “To test and select a MIDI recording device” in the topic Quick MIDI Device Setup.

3. Click the Rename Device button next to the recording device name.
   Composer will present you with the Rename MIDI Device dialog box.

4. In the Rename MIDI Device dialog box, enter the new name for the recording device, and click the OK button.

9.6.2 Changing the Default Playback Device

Even if your computer has only one sound card, there are likely at least a couple of alternative internal playback devices available. The internal playback devices actually correspond to MIDI device drivers that are installed with your sound card. There might be additional internal playback devices available if, for example, you have downloaded from the Internet and installed a MIDI “software synthesizer”.

The alternative internal playback devices are distinguished by the different types of engineering techniques they use for simulating instrumental sounds. For example, some internal playback devices play back actual sampled sounds of recorded instruments. Other internal playback devices simulate instrument sounds via sound wave formulas designed by engineers. It probably will not matter to you how the instrument sounds are created. You probably just care about how they sound to you.

It is a good idea for you to try out the various internal playback devices that are available on your computer. Choose the playback device that sounds best to you as a default. Then, whenever you open a new MIDI file, or create a new song, your chosen default playback device will be assigned to the staves of the song.

To change the default playback device:

- Follow the procedure “To test and select a MIDI playback device on your system” in the topic Quick MIDI Device Setup.

What happens if you have previously saved a Notation .not file, in which some or all of the staves were assigned to the MIDI playback device that has been replaced by your new default playback device? If the old MIDI device is no longer available on your system, Composer will automatically reassign the
staves to your new default MIDI playback device.

But what happens if your old default MIDI device is still available on your system? For example, perhaps you have installed a new MIDI software synthesizer that you prefer, but you still want to keep the old MIDI device on your system. In this case, do you want to reassign the staves in the song from the old MIDI device to the new one, or do you want to leave them unchanged? There is no way that Composer can read your mind to determine what you want. Instead, Composer will ask you what you want to do, as illustrated here:

Once you instruct Composer to automatically update the MIDI device assignments for previously saved songs, the above dialog box will no longer be displayed. But what if you want to change your preference? In that case, follow the next procedure.

To change Composer's rule for reassigning staves from an old MIDI device to the new default MIDI device:

1. Choose the MIDI Device Configuration (not the Quick MIDI Device Setup) command in the Setup menu.
2. Open the Device Properties dialog box for the old MIDI device.
3. In the Device Properties dialog box, add a checkmark for "Was Previously the Default MIDI Output Device" if you wish Composer to review the assignment of staves to that old MIDI device when you open Notation .not files. Remove the checkmark if you wish Composer to no longer do that.

4. If you do wish Composer to either automatically reassign staves to the new MIDI playback device, or ask you for each reopened Notation .not file whether you wish to reassign the staves, then click the Option To Reassign Songs to New Default Device button in the Device Properties dialog box:

Composer will then display the following dialog box:

5. Choose one of the options in the above dialog box.

9.6.3 Installing a USB or MIDI Cable Between Your Soundcard and Keyboard

Your external MIDI keyboard needs to be connected to your MIDI sound card via one of these two types of cables:

- USB (Universal Serial Bus) cable
- MIDI cable with joystick connector

You might also need to connect a USB MIDI interface device between your computer and keyboard. To determine which kind of cable you need, and whether you will also need to add a USB MIDI interface between your computer and keyboard, you should examine what kind of cable connectors are available on your keyboard and computer's sound card.
Determine what kind of connector your MIDI keyboard has:

- Examine the back side of your MIDI keyboard for one or possibly both of the following two types of connectors:

  **Keyboard MIDI Connector**

  ![Keyboard MIDI Connector](image1)

  **Keyboard USB Connector**

  ![Keyboard USB Connector](image2)

If your MIDI keyboard has a USB connector and no MIDI connector(s), then connect a USB cable between it and your computer:

1. Find an available USB female connector on the back side of your computer. It will look like this:

   ![USB Female Connector](image3)

2. Find the USB cable that came with your USB MIDI keyboard, or else purchase one. The two ends of the USB cable look like this:

   ![USB Cable Ends](image4)

   - Connect this end of the USB cable to your keyboard, or to a MIDI USB hub.
   - Connect this end of the USB cable to your computer.

3. Connect the first of the above two ends of the USB cable to the USB connector on your MIDI keyboard.

4. Connect the second of the above two ends of the USB cable to the USB connector on your computer.
Determine whether your computer's sound card has a joystick connector:

- Find the sound card on the backside of your computer. It might have a joystick connector and look like this:

![Soundcard on back side of computer](image)

However, your sound card might have only the connectors for speakers, headphone, and microphone, and no joystick connector.

If your MIDI keyboard has one or two MIDI connectors and no USB connector, and if your sound card has a joystick connector, then connect your keyboard to your sound card with MIDI cables:

1. If you do not already have one, obtain a MIDI joystick cable, which looks like this:

![MIDI joystick cable](image)

The above picture probably seems confusing because it has two joystick connectors, and two MIDI connectors. This is really just one cable. The second joystick connector is included in the cable so that a game joystick can share the same joystick connector on the sound card with the external MIDI device. The two MIDI connectors at the other end are for MIDI In and MIDI Out, but there might not be labels indicating which connector is for MIDI In versus MIDI Out. In that case you will need to figure out which cable connector is for MIDI In versus MIDI Out experimentally.

2. Attach the cable's joystick male connector to the sound card's female joystick connector. At the other end of the cable, connect the round 5-pin male connector labeled MIDI In to the keyboard's round 5-pin female connector labeled MIDI Out. If the cable has two unlabeled 5-pin MIDI connectors, then you will have to experiment, by trying one, and if it does not work, then try the other.
3. If your keyboard is capable of playing back MIDI sent to it from the computer, then connect the cable’s other round 5-pin male connector to the keyboard round 5-pin female connector labeled MIDI In.

4. If the MIDI joystick cable is not long enough to reach your keyboard, you may need to add one or a pair of MIDI extension cables, with a female connector on one end and a male connector on the other.

If your MIDI keyboard has one or two MIDI connectors and no USB connector, and if your sound card has no joystick connector, then add a physical MIDI USB interface between your computer and keyboard:

The following diagram shows how you would connect an E-MU Xmid unit between your computer and your MIDI keyboard:

1. Connect a USB cable between your computer and the MIDI USB interface.

2. If your MIDI USB interface has female MIDI connectors rather than cables (as illustrated for the above E-MU midiX), then follow this step. A common example of such a MIDI USB interface is the Midisport 2x2 by Midiman.

   Connect one or two MIDI cables between the MIDI USB interface and your MIDI keyboard. The MIDI cable will have male connectors on both ends, and look like this:

3. If you have not done so already, install the MIDI device driver for the MIDI USB interface on your Windows system.
Adding a New MIDI Keyboard to Your Configuration

If you have purchased a MIDI keyboard so that you can record notes into Composer, then congratulations on a good decision! You will enjoy Composer even more with a music keyboard.

If you have not done so already, then connect your computer to your new MIDI keyboard via a USB or MIDI cable, as described in Installing a USB or MIDI Cable Between Your Sound Card and Keyboard.

If your MIDI keyboard is a USB device, then install the MIDI device driver for your MIDI keyboard, according to the keyboard's installation instructions.

Once you have connected your keyboard to the sound card with the MIDI cable, and have installed its MIDI device driver (if it is a USB device), then it is a good idea to immediately test it using the Quick MIDI Device Setup command.

If the recording test is successful, then you should consider renaming the keyboard device. By default, Composer gives it the name of the external Windows port. This is usually a complicated name, such as "SB Live! MIDI UART". Since the device name is referred to in various parts of the Composer program, you will probably be happier if you rename the device to something that makes better sense to you. You might just rename it to "Keyboard". Or, you might rename it to the manufacturer of the keyboard, such as "Casio" or "Yamaha". For instructions in renaming the recording device, use the Rename Device button in the Quick MIDI Device Setup window.

If, while running Composer, you do not hear sound as you play your keyboard, then explore the possible explanations and remedies described in What To Do If You Do Not Hear Any Sound.

If your keyboard is capable of not only recording but also producing sound, then you might hear sound simultaneously coming out of both your keyboard and your computer speakers as you record or play at the keyboard. That is probably not what you want. To fix that problem, follow the instructions in Deciding Whether or Not Your Keyboard Should Directly Produce Sound.

If your keyboard is capable of producing sound, then you might want to assign staves of your song to that device for playback. If your keyboard has standard General MIDI (GM) sounds, then you will be able to take advantage of the fact that, by default, Composer assigns General MIDI sound (patch) names to a newly identified external device. For example, the first three sounds are "Acoustic Piano", "Bright Acoustic Piano", and "Electric Grand Piano." If your keyboard does not offer the General MIDI sounds, then you will want to inform Composer about the names of the various sounds available on your keyboard. The instructions for doing this are the same as for configuring an external MIDI sound module that only plays MIDI and does not record. For these instructions, see Preparing Bank, Patch, and Drum Note Names for a MIDI Device.

Deciding Whether or Not Your Keyboard Should Directly Produce Sound

If your keyboard can produce its own sound, then you can decide whether:

1. The keyboard will be used only for input.
   
   While Composer is playing back a song, you can play along on your MIDI keyboard, as described in Playing Along with Your MIDI Instrument. Composer will produce whatever instrument sound you choose to be played back among those available on your output device.

   -- OR --

2. The keyboard will be used for both input and output.
   
   In this case, as you perform and record on the keyboard, the sound will be produced by your keyboard rather than another MIDI device in your MIDI setup.

Some keyboards do not produce sound. Such keyboards are commonly called "MIDI controllers". For such keyboards, only option #1 above is available.
Using Your Keyboard for Input (Recording) Only

If you wish to use your keyboard only for input (recording) and not playback, or if the keyboard is a MIDI controller only, then you can configure it as illustrated here:

![Diagram of MIDI Device Configuration]

If your keyboard is capable of producing sound, it very likely has a "local off" option. When the "local off" option is active, the keyboard does not produce sound as you perform. Instead, the notes you perform are sent to the computer. It is the computer's job or, rather, Composer's job, to play the notes on some MIDI output device. If your keyboard is a MIDI controller, then it has no option except "local off".

The "echo on" option specifies whether Composer should instantly replay the notes you perform on your keyboard. If you are recording a staff, Composer will echo the notes on the device to which the staff is assigned, as described in Setting the Instrument Sound for Recording. If you wish to practice or play along with your keyboard while Composer provides accompaniment, Composer will echo the notes on the device that you specify with the Select Play-Along Sound command in the Perform menu.

The "echo on" option is one that you must specify in Composer for the MIDI keyboard device. Although the above diagram shows "echo on" below the computer, the "echo on" option is really associated with the MIDI device that Composer defines for the keyboard.

To turn the "echo on" option on or off for a MIDI keyboard:

1. Choose the MIDI Device Configuration command in the Setup menu.

   -- OR --

   Type "qdc" for "Quick Device Configuration".

   This opens the MIDI Device Configuration Window.

2. In the MIDI Device Configuration Window, find the output device that represents your keyboard.

   The easiest way to do this is to first assign a new name to the placeholder device for your keyboard. Follow the procedure "To change the name of a MIDI input (recording) device" in Assigning Device Names That Make Better Sense to You. If you follow that procedure, then your keyboard device will be listed in the MIDI Device Configuration Window, as illustrated here:
If you do not follow that procedure for renaming the keyboard device, then search through the MIDI Device Configuration Window for the MIDI Input port that you are using for your keyboard. The placeholder device will have the same name as the MIDI port listed above it.

3. Click the name of the keyboard device to select it; and then choose Properties in the Device menu.

-- OR --

Double-click the device name in the window.

Composer will present you with the Device Properties dialog:

4. In the Device Properties dialog box, turn the check mark on or off for "Echo MIDI Input to Output" in the Recording Properties section of the dialog box.

5. Click the OK button in the dialog box to commit the newly assigned echo on option.

Using Your Keyboard for Both Input (Recording) and Output (Playback)

If you want your keyboard to be used not only for input (recording) but also output (playback), then you can configure it as illustrated here:

In this case, the keyboard still does not actually play the notes immediately as you perform them. Rather, the notes you perform are sent to the computer, and Composer then immediately replays them on your keyboard. There should be no noticeable delay between the time you perform a note and the time you hear it, even though the note is "going through the computer".
The advantage of configuring your keyboard as illustrated above is that you can assign staves in your song to sounds that are produced by your keyboard. This option may be especially attractive to you if your keyboard produces better sounds than those produced by other output devices, such as your MIDI sound card devices.

To exercise this option, you must specify the keyboard device as both a MIDI input and output device in the Device Properties dialog box:

In the Device Properties dialog box for the keyboard, you still set a check mark for "Echo MIDI Input to Output". The difference is that you assign your staves, or your play-along sound, to your keyboard device, rather than to some other device in your MIDI configuration, as illustrated in the following Staff Setup dialog box:

Letting Your Keyboard Locally Produce Sound As You Play

A third configuration alternative is available, as illustrated here:

In this case, your keyboard directly produces the sound for notes as you perform them. You do not activate the "local off" option on your keyboard. Also, you turn off the "echo on" option for your keyboard device. If you do not turn off the "echo on" option, then you will hear each note you perform twice: the note will be played back by your keyboard as well as the other device to which the note is
echoed. Worse, if your keyboard is set up as the output device for the echoed notes, then it will be forced to play the notes twice, with unpredictable results.

This third configuration option is somewhat less useful than the previous configuration option (Using Keyboard for Both Input and Output). When you practice or record, you will hear the same thing—sounds from your keyboard. However, when you later play back the recorded staff, the sound will be played by a different device than that which you heard when you were recording, namely, the keyboard device itself.

9.7 Procedures for Advanced MIDI Configuration Tasks

This section describes some of the most common MIDI configuration tasks for MIDI equipment arrangements that include more than one external MIDI device, or which include an extra software synthesizer that you might install to supplement the sounds normally provided with your sound card. For instructions in more common MIDI configuration tasks, see Procedures for Common MIDI Configuration Tasks.

The procedures described in this section are:

- Installing a Software Synthesizer
- Adjusting for the Delay of Some MIDI Output Devices
- Preparing Bank, Patch, and Drum Note Names for a MIDI Device
- Configuring a New External MIDI Sound Module
- How to Handle Devices Connected With MIDI Thru Cables
- How to Save Effort if You Rearrange Your MIDI Equipment Often

9.7.1 Installing a Software Synthesizer

A software synthesizer is a MIDI device driver that produces sound using the computing powers of your computer, as opposed to using specialized sound-creation circuitry in a sound card or external device. Sound cards that are pre-installed on computers, and sound cards that you can purchase and install yourself, usually include multiple MIDI device drivers. Some of these MIDI device drivers are for the sound card’s internal sound-creation circuitry. One or more software synthesizers, provided as additional MIDI device drivers, might be included with the sound card.

Software synthesizers are also available as software products that can be purchased, or in some cases freely downloaded from the Internet, independently of which sound card you have.

After you install a software synthesizer, Composer will automatically detect it as a new Windows MIDI output port the next time you run the program. The software synthesizer will automatically become available as a new device.

Many software synthesizers have a built-in delay between the time a software program (such as Composer) requests a note to be played, and the time that the sound is actually produced. This requires special attention on your part. See the next topic, Adjusting for the Delay of Some MIDI Output Devices.

9.7.2 Preparing Bank, Patch, and Drum Note Names for a MIDI Device

Some MIDI devices—software synthesizers or physical devices such as a sound-producing MIDI keyboard—offer a standard set of General MIDI (GM) instrument sounds. More capable MIDI devices also, or instead, offer an extended set of instrument sounds in one or more MIDI banks. A MIDI bank is a collection of up to 128 different instrument sounds, commonly called MIDI patches. Also, a given patch in a MIDI bank may provide a “drum kit” of up to 128 different drum instrument sounds, each associated with a pseudo drum pitch.
MIDI banks and patches are identified with bank and patch numbers by default. Drum instruments are identified by pseudo drum pitch numbers by default. These numbers would generally be difficult for you to use when assigning instrument sounds to staves, because you would have to know that, for example, on your Roland JV-90 keyboard, the bank for MIDI controller 0 value 84 and controller 32 value 1, patch 12 is the "Thick Violas" sound. It will be much easier for you to assign an instrument sound to a staff by referring to the names of the banks and patches, such as the "Thick Violas" patch in the "Orchestral" bank of your Roland JV-90 keyboard.

In order to offer you instrument names instead of bank, patch, and drum note pitches, Composer needs to learn what the instrument names are. There are two ways it can do this. The easiest way is for you find a Cakewalk Instrument Definition (.ins) file or Notation Software MIDI Device Description (.mdd) file for your particular MIDI device. That INS or MDD file will have the various instrument names...
for your device. You can quickly "import" the INS MDD file into Composer. The other, more difficult way, is for you to manually enter the instrument names yourself.

- To import instrument names for your MIDI device:
  - Follow the instructions in the topic "Quick MIDI Device Setup" for "setting up sound names for a device that has additional MIDI sound banks besides the General MIDI sounds."

- To manually enter instrument names for your MIDI device:
  - Follow the instructions in the topic "Assigning Bank, Patch, and Drum Note Names to a MIDI Device".

9.7.2.1 Adjusting for the Delay of Some MIDI Output Devices

An important aspect of many software synthesizers is that they have a fixed built-in delay between the time a software program (such as Composer) requests a note to be played, and the time that the sound is actually produced. This delay is necessary because of the many calculations that a software synthesizer makes to simulate instrument sounds.

If your software synthesizer has such a delay, then you will not be able to use it to echo your performance on a MIDI keyboard. If you use such a device, then as you hit keys on your music keyboard, you will hear them played only after some annoying delay. We recommend that you use some other device to echo your performance on the keyboard. See "Deciding Whether or Not Your Keyboard Should Directly Produce Sound" for instructions on setting the playback device that echoes your performance at the keyboard. Note that after you have recorded using "echo" on another device, you can then reassign the staves to your software synthesizer device for playback.

If you want to play back songs that have staves that are assigned to both the delayed software synthesizer and other non-delayed devices, then it is important that you tell Composer exactly what the delay time is in milliseconds for the software synthesizer, or that you use the "Tap in Device Delay" feature so Composer can automatically enter that value. Composer needs this information in order to synchronize the output to the delayed and non-delayed devices. If you do not do this, you will hear the notes for the delayed software synthesizer lag behind those notes assigned to other devices.

Some acoustic pianos, such as the Yamaha Disklavier, and pianos retrofitted with a PianoDisc system, have a MIDI playback mechanism. Such acoustic MIDI pianos also have a built-in delay between the time that the software program requests a note to be played, and the time that the note sounds. The reason for this is that it takes several milliseconds for the hammer to travel from its resting position to the time it hits the string; and that travel time varies according to how soft or loud the note is. (Pianists subconsciously account for this in their playing.) In order to produce accurate timing of note attacks, independently of the softness or loudness of the notes, an acoustic MIDI piano must employ a minimum delay that is at least as long as that for the most softly played note. Some acoustic MIDI pianos offer you at least two choices for the delay it uses: (1) the minimum necessary delay, or (2) some much larger but "round number" delay, such as 500 milliseconds (one half second).

You may find the delay information in your device's product documentation. If you do not find it there, you might find that information through good searching on the Internet. Otherwise, you can use the "Tap in Device Delay" feature as explained below.

- To specify the numerical millisecond delay for an output device when you know the number:
  1. In the Setup menu, choose the MIDI Device Configuration command.

     -- OR --

     Type or "qdc" for "Quick Device Configuration".

     Composer will display the MIDI Device Configuration Window.

  2. In the MIDI Device Configuration Window, click the name of the output device to select it. Then in the Device menu choose Properties.
-- OR --

With the mouse, right-click the name of the output device.
Composer will present you with the Device Properties dialog.

3. In the Device Properties dialog box, enter the millisecond delay value in the Playback Properties section.

4. Click the OK button in the dialog box to commit the newly assigned delay value.

To "Tap in" the Device Delay using the "Insert" (INS) key on your computer keyboard:
1. In the Setup menu, choose "MIDI Devices Quick Setup", and the following dialog will appear:

2. Click the "Tap in Device Delay" button and the following dialog will appear:
3. Select the Playback Device from the drop list of Step 1 (all available MIDI playback devices will be listed there) that you want to calibrate.

4. Now click the Step 2 “Listen and tap with INS key” (it may be labeled “Insert” key on your keyboard). A test track will then appear, and playback will begin. As you hear the notes, tap your Insert (Ins) key on your computer keyboard. It is ok if you miss the first few notes - Composer makes an allowance for a “getting in rhythm” time. It may help to close your eyes during this step, and just tap when you hear the notes play. When you are done with this step, you will see the calculated latency value in the “Delay (in msecs):” box. Alternatively, you can manually enter the number value here if you know it.

5. Now you can click the Step 3 “Listen and verify” button. The same scale will play again, and now you should watch and listen to verify that the notes highlight precisely when the notes sound. If they do not, you may want to repeat Step 2 for a more accurate measurement.

6. When you are satisfied that the notes highlight at the same time they sound, you can click the Step 4 button to “Accept delay value”. The dialog will close, and Composer will then save the delay time (latency) value for that MIDI playback device.

### 9.7.3 Configuring a New External MIDI Output Device

The most common example of an external MIDI output device is a MIDI keyboard. You might think of a MIDI keyboard as just an input device for recording; but many MIDI keyboards can also serve as output devices, playing back MIDI sent to it from the computer. This topic describes how you can set up your MIDI keyboard as an output device if it has extended sounds or “instrument patches” available in multiple or extended banks.

Another type of external MIDI output device is called a "sound module", which is hardware that specializes in playing back MIDI that is sent to it.
When you install a new external MIDI sound module, you will need to help Composer learn the names of the instrument sounds that this device can produce. The procedure below, for configuring a new external MIDI device, applies equally to MIDI keyboards and MIDI sound modules.

To configure a new external MIDI sound module:

1. Determine whether your MIDI device offers only the General MIDI (GM) sounds, or whether it offers a different set of sounds.

   A fairly good way to determine whether your device offers the GM sounds is to explore sound options using the front panel of the device, or refer to its documentation. Note whether these arbitrarily listed GM sounds match those of your instrument:

   - Patch #1 (or 0) -- Acoustic Grand Piano
   - Patch #7 (or 6) -- Harpsichord
   - Patch #23 (or 22) -- Harmonica
   - Patch #41 (or 40) -- Violin
   - Patch #57 (or 56) -- Trumpet

   If your MIDI device has the standard GM sounds, then you can just refer to the Quick MIDI Device Setup to set up your device and you're done!

   If your MIDI device does not have the standard GM sounds, or it has extended sounds that you wish to use, then you'll want to continue.

2. Choose the MIDI Device Configuration command in the Setup menu.

   Composer will display the MIDI Device Configuration Window, such as illustrated here:

3. Identify the external output port to which you wish to connect the external device. All of the external output ports on your Windows system are indicated with the combination of "Out" and "External Port" in the second and third columns of the window. In the above example, there is an external output port, named "1. Internal MIDI" that is the current default MIDI output device.

4. Note whether there is already an external output device listed below the external output port. In the above example, the external output device "1. Internal MIDI" is listed below the external output port with the same name.

   When Composer first initializes a MIDI device configuration, it assigns placeholder devices to each external port. A placeholder device initially as the same name as the corresponding port. It is a good idea to rename the device to that of the MIDI keyboard or external MIDI sound module that you are connecting, such as "Yamaha Keyboard".

5. If you noted in step #4 that there is already an external device listed below the external output port, then do one of the following:
(a) If you determined in step #1 that your device uses the General MIDI sounds, then rename the device to something meaningful to you, such as the manufacturer and model of the keyboard or sound module. To rename the device, select it in the window, then choose Device Properties in the Device menu. In the Device Properties window, enter the new name for the device. After that you do not need to follow any additional steps in this procedure.

-- OTHERWISE --

(b) Remove the device listed below the external output port by selecting it and choosing Remove from the Device menu. Skip to step #7 and then connect the device to the external output port, as described in step #8.

6. If you noted in step #1 that the device you are adding uses the General MIDI set of sounds, then do the following:

(a) Choose the New External Device command in the Device menu.

Composer will display the Device Properties dialog:

(b) In the Device Properties dialog, enter a name for the device, such as the manufacturer and model of your MIDI keyboard or sound module.

(c) For almost all external (hardware) General MIDI devices, the default values for the rest of the options in the dialog box are appropriate. You can review the purpose of each option in Specifying Properties of a Device.

(d) If “General MIDI” is not listed under Banks, then click the Set General MIDI button.

Composer will display "(000)* = General MIDI" in the Banks list, and will display 10 in the Drum Channel Number(s) field.
(e) Click the OK button in the Device Properties dialog. Composer will add the new device at the bottom of the MIDI Device Configuration Window, under the heading Unassigned Device(s).

(f) Skip step #7 and continue with step #8.

7. If you noted in step # that the device you are adding does not use the General MIDI set of sounds, then do the following:

(a) Attempt to import the device description from a Cakewalk Instrument Definition (.ins) file or from a Notation Software MIDI Device Description (.mdd) file. This will save you a lot of effort that you will otherwise spend manually entering the names of the sounds for your device. If you are able to import the device description, then skip the rest of this step.

(b) Follow the instructions in step #6, except skip step #6(d), since your device is not a General MIDI device.

(c) If your MIDI device has multiple banks, then use the Add Bank button in the Device Properties dialog to add each bank.

(d) If your device has only one bank, then use the Add Bank button just once. You can give that bank any name you want, such as "Instruments". Leave the bank value as 0.

(e) For each bank, you can enter the MIDI patch names, that is, up to 128 instrument sound names. Click the name of the bank in the list, and then click the Edit Patch Names. Composer will display the Patch Names dialog. Read the names of the instrument sounds off the front panel of your device, or from the manufacturer's manual for the device, and enter them into the Patch Names dialog.

For further instructions, see Assigning Bank and Patch Names to a MIDI Device.

Also, for each bank, optionally enter drum note names, as described in Assigning Drum Note Names for a MIDI Device or Bank of a Device.

8. To connect the newly added device to the external output port:

(a) At the bottom of the MIDI Device Configuration Window, under the heading "Unassigned Devices", click the name of the newly imported or added device to select it.

(b) Choose the Connect to External Port command in the Device menu. Composer will display the Connect External Device to Port dialog box.

(c) In that dialog box, choose the external port to which you wish to connect the external device.

For further instructions, see Connecting and Disconnecting Devices from an External Port.

9. If your device relies on System Exclusive Events, you can check the appropriate boxes ("Record" if you will be using the device to record into Notation Composer; to "Send SysEx to this Device". Checking this box will also make sure that any MIDI files that you export contain the proper SysEx events as well.

10. If your device relies on SysEx Events, then for optimal performance of sounds for your device you should check the following parameter values, which you will need to get from your device manual:

    SysEx Buffer Count
    SysEx Buffer Size (bytes)
    GM Reset adjustment time (msec)
    GM2/GS/XG Reset adjustment time (msec)
    Delay between SysEx packets (msec)
9.7.4 How to Handle Devices Connected with MIDI Thru Cables

The physical MIDI Thru connector of a MIDI device enables that device to forward MIDI performance data on to a second device, as illustrated here:

If you have physically configured your devices with MIDI Thru, then you probably want one device to play back MIDI received on certain channels, and the second device to play back MIDI received on other channels.

You will need to inform Composer about such a MIDI Thru configuration, so that Composer can correctly play back MIDI on the two devices. The following screenshot shows the part of Composer's MIDI Device Configuration Window that represents the above configuration:

The physical MIDI Out connector at the computer will be associated with an external output port, such as a "Creative SB Live! External MIDI".

To configure external devices that are connected via MIDI Thru:

1. Choose the MIDI Device Configuration command in the Setup menu.
   - Composer will display the MIDI Device Configuration Window.

2. If the devices are not already included in the configuration, then add them using the New External Device command in the Device menu. For an introduction to adding a new device, see Configuring a New External MIDI Sound Module.
   - The new devices will be listed under a heading "Unassigned Device" at the bottom of the MIDI Device Configuration Window.

3. In the MIDI Device Configuration Window, identify the external output port that corresponds to the physical MIDI Out connector, to which you have physically connected the first device. An external output port is listed in bold text, and has "Out" and "External Port" in the second and third columns.

4. If a placeholder device is already connected to that external output port, then disconnect it. A placeholder device has the same name as the MIDI output port to which it is connected. To disconnect the placeholder device, click its name to select it. Then choose the Disconnect From External Port command in the Device menu.

5. Click the name of the first device to be connected, in order to select it. (The order in which the two devices are connected or listed does not need to reflect how they are physically ordered with MIDI cables.) Then choose the Connect To External Port command in the Device menu. In the Connect External Device to Port dialog, select the external output port that you identified in step #3. For further details, see Connecting and Disconnecting Devices from an External Port.

6. Repeat step #5 for the second device.
Normally, when you connect two devices using MIDI Thru, you will want one device to play notes received on only certain MIDI channels, and the second device to play notes received on other MIDI channels. To do this, you will probably need to use either the front panel controls, or some software tool that accompanies your device, to “tune” the device to certain channels, and to have it ignore other channels.

For a given song, you can assign specific channels to each staff. For example, suppose you have tuned My Keyboard to channels 1 through 8, and My Sound Module to channels 9 through 16, using manual controls available on the two physical devices. Using the **Staff Setup** command in theStaff menu, you will need to assign channel numbers to the staves that are consistent with the devices to which they are assigned, as illustrated below:

![Staff Setup](image)

### 9.7.5 How to Save Effort if You Rearrange Your MIDI Equipment Often

If you have two or more external input and output MIDI devices, then there are a variety of ways that you might physically configure them. Each different way that you physically configure your MIDI devices usually requires a different setup in Composer. Or, more specifically, each different physical configuration requires a different arrangement of MIDI ports and devices in the **MIDI Device Configuration Window**.

It would be inconvenient if you had to make corresponding changes in the MIDI Device Configuration Window each time you changed the physical arrangement of your MIDI devices. To spare you this
Configuring Your Soundcard and MIDI Equipment

inconvenience, Composer enables you to save alternative configurations in the MIDI Device Configuration Window.

The options available to you for managing alternative MIDI device configurations are all offered in the Config menu of the MIDI Device Configuration Window. Commands in the Config menu include: Initialize, New, Clone To, and Select. For details, see Managing Alternative MIDI Device Configurations.

9.8 Using the MIDI Device Configuration Window

The MIDI Device Configuration Window shows you how Windows MIDI ports and devices are configured in Composer.

For simple MIDI configurations that consist of no more than a sound card and MIDI keyboard, you can use the Quick MIDI Device Setup window to quickly test MIDI playback and recording, and to inform Composer which MIDI output device you wish to use. In this case, you may not need to use the MIDI Device Configuration Window.

You will probably want to use the MIDI Device Configuration Window if your MIDI studio consists of more than one external MIDI device-- such as a MIDI keyboard plus one or more MIDI sound modules. In this case, the extra complexity of your MIDI studio will require some corresponding extra complexity in informing Composer about the physical arrangement of your MIDI equipment. Composer's MIDI Device Configuration Window offers you an intuitive way to provide Composer this information.

To use the MIDI Device Configuration Window effectively, you will need to understand the distinction between MIDI port and device. The term MIDI port is something that is defined by Windows, and something that you find references to in most other MIDI programs. In contrast, the term MIDI device has a special definition in Composer, even though the word device is also used in many ways by other programs. It is important that you understand how Composer defines the term device, and the relationship between a port and a device. This is discussed in the topic Understanding the Difference Between a Port and a Device. We highly recommend that you review that topic before using the MIDI Device Configuration Window.

To open the MIDI Device Configuration Window:

- Select the MIDI Device Config command from the Setup menu.

When you open the MIDI Device Configuration, you may find that the text in the MIDI Device Configuration Window is too small to read. You can change the text size, as described below.

To increase (or decrease) the font size of text in the MIDI Device Configuration Window:

- Increase (decrease) the size of the window by dragging one of the corners of the window outward (inward) with the mouse. The size of the text will expand to fit the new size of the window if you make the window larger.

- OR -

- Choose Zoom In (Out) from the View menu.

- OR -

- Type Z+ or Z- for Zoom Out or Zoom In

If you decrease the size of the window, the same text size will be preserved, and scrollbars will be added to the window. You can zoom back out by choosing Zoom Out from the View menu, or by typing Z+. 

Another option is also available:
To change the font size of the text in the MIDI Device Configuration Window to fit the current size of the window:

- Choose Scale to Fit from the View menu.
- OR --
  - While holding down the 'Z' key, hit the ENTER key.

The remainder of this chapter is organized as follows:

- **Understanding the Details of the MIDI Device Configuration Window**
- **Testing Playback and Recording Devices**
- **Managing MIDI Ports**
- **Managing MIDI Devices**
- **Assigning Bank, Patch, and Drum Note Names to a MIDI Device**
- **Managing Alternative MIDI Device Configurations**

### 9.8.1 Understanding the Details of the MIDI Device Configuration Window

The topics below provide an overview of the details that you see in the MIDI Device Configuration Window:

- **Understanding Ports and Devices in the MIDI Device Configuration Window** — Before you attempt to change any of your MIDI configurations in Composer, it is essential that you understand the distinction between Windows MIDI ports versus Composer-defined devices.

- **Common MIDI Device Configurations** — There is a good chance that one of the typical device configurations in this topic can serve as a very close example of how you can set up your MIDI configuration in Composer.

- **Recording Indicator in the MIDI Device Configuration Window** — This topic explains the recording indicator that looks like this:

- **Menus in the MIDI Device Configuration Window** — This topic explains the menus in the window:

### 9.8.1.1 Understanding Ports and Devices in the MIDI Device Configuration Window

To use the MIDI Device Configuration Window effectively, you will need to understand the distinction between **MIDI port** and **device**, both of which refer to software or hardware that produces instrument sounds. The term MIDI port is something that is defined by Windows, and something that you find references to in most other MIDI programs. In contrast, the term MIDI device has a special definition in Composer, even though the word device is also used in many ways by other programs. It is important that you understand how Composer defines the term **device**, and the relationship between a port and a device.

A MIDI port is something that Microsoft Windows abstractly defines. Basically, a MIDI port identifies the "place" where a MIDI application, such as Composer, "talks" to a particular MIDI sound-producing device. A device is some mixture of MIDI driver software and hardware circuity residing on your computer and on your sound card or external physical MIDI device.
Composer defines a device to represent something generally more physically concrete than a Windows MIDI port. There are external and internal devices. External devices are particularly easy to understand, because they are things you can see, such as a MIDI keyboard or a rack-mount MIDI sound module.

Internal devices are somewhat more difficult to visualize than external devices, because they reside somewhere inside your computer, where you do not really see them. A good way to think about an internal MIDI device is to realize that it basically does the same thing as an external MIDI device— it makes instrument sounds, through some combination of software and hardware (sound card) computations.

There are two types of internal devices: hardware-based and software-based. An internal hardware-based device is sound card circuitry that simulates instrument sounds. An internal software-based device is software that uses the general computing powers of your computer to calculate the sound waves that are then played through your sound card. Such an internal software-based device is usually called a software synthesizer.

If you think about a Composer-defined MIDI device as something that makes instrument sounds, then it should be easier for you to understand a device than a Windows MIDI port. Except for when you are configuring MIDI devices in Composer, you will not have to think about the abstract Windows MIDI ports. Whereas you cannot change the usually difficult-to-understand names of Windows MIDI ports, you can give whatever name you want to a corresponding device, such as, "Keyboard" or "Casio".

The following diagram provides a general illustration of the relationship between Windows MIDI ports and devices:

The above diagram illustrates these important relationships:

- A Windows internal output port is always associated with a Composer-defined internal output device.
- A Windows external output port is always associated with a physical connector. In this example, the physical connector is the joystick connector, to which a joystick MIDI cable is connected. In other examples, the physical connector might be one of the computer's USB connectors.

The next diagram is almost the same diagram as the above, except it shows the names of MIDI ports and devices that are initially assigned by Composer when it detects the MIDI ports on your system. The port names are highlighted in yellow, and the device names in light blue.
The next diagram also differs from the one above because a single external port, named "SB Live! External", handles both MIDI input and output.

NOTE: For some Soundblaster sound cards, the name of the external MIDI port is "SB Live! External UART" instead of "SB Live! External MIDI". Some older versions of Soundblaster sound cards have separate external MIDI input and output ports, named "SB Live! MIDI In" and "SB Live! MIDI Out", or "AWE32 MIDI In" and "AWE32 MIDI Out".

The above diagram illustrates that Composer initially assigns the placeholder device the same name as the corresponding port. You can rename the devices, as described in Assigning Device Names That Make Better Sense to You.

The following MIDI Device Configuration Window shows how the above configuration is represented in Composer's MIDI Device Configuration Window, after you have renamed the external device "Create SB Live! External MIDI" to "Yamaha Keyboard":

Some important details in this window are explained here:

- Windows MIDI ports are indicated in bold text.
- Composer-defined devices are listed in normal text.
- The default device is indicated by green text.
The first two columns indicate whether a port or device provides MIDI input or output. In this example, the external port serves both MIDI input and output, and the external device, a MIDI keyboard, is both a playback (output) and recording (input) device.

An external device is listed below an external port, when that external device is physically connected via a MIDI cable to the MIDI connector corresponding to the port.

An internal device is listed below the internal port with which it is associated.

### 9.8.1.2 Common MIDI Device Configurations

Most modern MIDI devices are "plug and play" using USB connections that do not require any manual manipulations or much attention on the part of the user. If you have older devices, however, you may need to check out this section.

This topic shows diagrams and corresponding MIDI Device Configuration Windows for some common MIDI device configurations. Your configuration might exactly or closely match one of these configurations. If not, you may find similarities that will help you correctly inform Composer about your MIDI equipment in the MIDI Device Configuration Window.

All of the examples illustrate two versions of MIDI drivers for Soundblaster sound cards. Recent Soundblaster sound cards define a single "SB Live! External MIDI" or "SB Live! MIDI UART" external port that handles both MIDI In and MIDI Out. Somewhat older Soundblaster sound cards define two separate external ports, one for MIDI In and one for MIDI Out. Sound cards by other manufacturers similarly have either a single external port for MIDI In and MIDI Out, or else separate MIDI In and MIDI Out ports.

Most of the examples illustrate the connection of a joystick-MIDI Y-cable to the sound card joystick connector. The last example illustrates a USB MIDI connector box, which connects to a USB connector of the computer. In that case, the MIDI drivers for the USB MIDI connector box provide the MIDI input and output ports; and the external input and output ports of the sound card remain unused.

All of the examples of MIDI Device Configuration Windows show two internal output ports, named "A: SB Live! MIDI Synth" and "B: SB Live! MIDI Synth". Through these two internal output ports, the Soundblaster sound card offers a total of 32 MIDI channels for playback through its software synthesizer. The diagrams in this topic do not show these internal ports; they show only the external ports and connected external devices. For a diagram of internal ports, see Understanding Ports and Devices in the MIDI Device Configuration Window.

### 1. Single sound card external port for MIDI In and MIDI Out; joystick-MIDI Y-cable; and MIDI keyboard that can play back MIDI.

This diagram is the same as part of the diagram shown in Understanding Ports and Devices in the MIDI Device Configuration Window.

---

**Diagram:**

- **Windows:**
  - **External Port:** SB Live! MIDI UART
- **Soundcard:**
  - **MIDI Out**
  - **MIDI In**
  - **Joystick Connector**
  - **Pair of MIDI Cables**
- **Keyboard**
2. Two separate sound card external ports for MIDI In and MIDI Out; joystick-MIDI Y-cable; and MIDI keyboard that can play back MIDI.

In this example, "B000" is the Windows port address, which is not information you would normally need to know.

3. Two separate sound card external ports for MIDI In and MIDI Out; joystick-MIDI Y-cable; MIDI controller keyboard that can produce sound only through the computer.

In this example, the external output port is not used. Composer initially assigns a placeholder external device to the external port, with a name that starts with the words "External Device Connected to", followed by the name of the external port. In this example, the placeholder external output device would be named "External Device Connected to SB Live! IMIDI Out (B000)". If your MIDI controller keyboard is not capable of playing back MIDI, then it is a good idea to delete this placeholder external output device. Then you will not see it listed as an option for assignments of output devices to the staff. For instructions in deleting a device, see Removing a Device.
4. USB MIDI connector; MIDI keyboard that can play back MIDI

In this example configuration, the sound card's external MIDI In and MIDI Out ports are not used. The MidiSport (tm) 2x2 USB MIDI connector box provides two MIDI In connectors and two MIDI Out connectors, but in this example, only one MIDI In and one MIDI Out connector are used.

In this example, placeholder devices have been deleted for the ports "SB Live! MIDI UART", "Out-B USB MidiSport 2x2" and "In-B USB MidiSport 2x2". See the explanation for deleting placeholder devices in the previous example.
**Configuration: Default Configuration**

<table>
<thead>
<tr>
<th>In</th>
<th>Out</th>
<th>Port or Device Name</th>
<th>Rec</th>
<th>Play</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Out</td>
<td>Internal Port</td>
<td>A: SB Live! MIDI Synth</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out</td>
<td>Software Synth</td>
<td>A: SB Live! MIDI Synth Internal Device</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>B: SB Live! MIDI Synth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out</td>
<td>B: SB Live! MIDI Synth Internal Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In</td>
<td>Out</td>
<td>External Port</td>
<td>SB Live! MIDI UART</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out</td>
<td>External Port</td>
<td>Out-A USB MidiSport 2x2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out</td>
<td>External Device</td>
<td>Keyboard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out</td>
<td>Out-B USB MidiSport 2x2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
9.8.3 Recording Indicator in the MIDI Device Configuration Window

An external MIDI input device has a red recording indicator in the MIDI Device Configuration Window, as shown here:

The MIDI Device Configuration Window displays a recording indicator for a given device if there is a check mark for "Is MIDI Input Device" in the Device Properties dialog box for that device. See Specifying Properties of a Device.

When you are actively playing on the MIDI recording device (typically a MIDI keyboard), you will see the recording indicator light up with a bright red color. This is a good way to confirm if Composer is detecting your performance, as described in What To Do If Recording Does Not Work. Note that you can also monitor device recording activity in the Quick MIDI Device Configuration Window.

9.8.4 Menus in the MIDI Device Configuration Window

The purpose of each menu in the MIDI Device Configuration Window is summarized below:

- **Config** -- Options for managing multiple alternative configurations. These options are useful if you have two or more external MIDI devices, and find that you frequently rearrange their physical connections or settings. You can use the "Configuration to clipboard command" to copy a text report of your configuration to paste into a text editor or email for review or help. Also see Managing Alternative MIDI Device Configurations.

- **Port** -- Options for hiding or showing Windows MIDI ports in a configuration, and for connecting or disconnecting external ports from external devices. See Managing MIDI Ports.

- **Device** -- Options for adding or removing devices from a configuration; setting the properties of devices, including MIDI bank and patch names; and connecting or disconnecting external devices from external ports. See Managing MIDI Devices.

- **Test** -- For a currently selected output device, this command plays back a 12-note chromatic scale, so that you can monitor the device activity shown by the playback channel indicators. See Testing Playback and Recording Devices.

- **View** -- Options for zooming in or out, to increase or decrease the font size used in the window. See Using the MIDI Device Configuration Window.

9.8.2 Testing Playback and Recording Devices

If a staff is assigned to a device, and you hear no sound for that staff during playback, then it is a good idea to directly test the playback for the device.
To test the playback for a MIDI output device:

1. Choose the MIDI Device Configuration command in the Setup menu.
   -- OR --
   Type "gds" or "gdc" for Quick Device Setup or Quick Device Configuration.
2. In the MIDI Device Configuration Window, select a MIDI device by clicking its name. MIDI device names are displayed in normal text, whereas MIDI port names are displayed in bold text.
3. Choose the Test command in the main menu of the MIDI Device Configuration Window.
4. Composer will display and play back a 12-note chromatic scale.
5. If you unexpectedly do not hear sound for a device when you choose the Test command, then some possible explanations and remedies are suggested in What To Do If You Do Not Hear Any Sound.

To test recording or play-along of a MIDI input device:

1. Choose the MIDI Device Configuration command in the Setup menu.
   -- OR --
   Type "gds" or "gdc" for Quick Device Setup or Quick Device Configuration.
2. Perform some notes on your MIDI input device (typically a MIDI keyboard). Observe whether the recording indicator lights up in a bright red color.
3. If you unexpectedly do not observe recording activity for that input device, then some possible explanations and remedies are suggested in What To Do If Recording Does Not Work.

9.8.3 Managing MIDI Ports

Before reading this topic, you should review Understanding Ports and Devices in the MIDI Device Configuration Window.

A MIDI port is something that Microsoft Windows abstractly defines. Basically, a MIDI port identifies the "place" where a MIDI application, such as Composer, "talks" to a particular MIDI sound-producing device. Except in the MIDI Device Configuration Window, Composer always refers to devices, not ports. The MIDI Device Configuration Window is the place where you inform Composer how external devices are connected to ports.

When Composer runs for the first time, or whenever it detects the presence of a MIDI port, it detects whether each MIDI port is an internal or external port. For an explanation of internal versus external, see Understanding Ports and Devices in the MIDI Device Configuration Window. This detection is based on information provided by the MIDI driver for the port. A few MIDI drivers incorrectly report this information. Therefore, Composer offers you the option to correct the specification of whether a port is internal or external. See Specifying Whether a Port is Internal Or External.

Composer enforces a rule that an internal MIDI port must always be associated with a corresponding internal device.

An external input or output port can be connected to one or more external devices. You can use the Connect to External Device command in the Port menu to establish the connection between an external port and an external device. See Connecting and Disconnecting Devices from an External Device.
9.8.3.1 Connecting and Disconnecting Devices from an External Port

It is important that you understand the information in Understanding Ports and Devices in the MIDI Device Configuration Window before you attempt to connect or disconnect external devices from an external port.

There is a good chance that your MIDI configuration will exactly or closely match one of the configurations described in Common MIDI Device Configurations. It is highly recommended that you review those common configurations. They will probably help you determine how you will want to connect external devices to external ports, as described here.

To connect an external device to an external port.

1. In the MIDI Device Configuration Window, select the external device by clicking its name. It must be an external device, as indicated by the word "External" in the Port or Device column. If the port is an input port, then the device must not already be assigned to another input port. If the port is an output port, then the device must not already be assigned to another output port. If the port is an input port, the device already may be assigned to an output port, and conversely. That is, an external device (e.g., MIDI keyboard) that supports both recording and playback can be assigned to two different ports— one that is an input port, and another that is an output port.

2. Choose the Connect To External Port command in the Device menu. Composer will display the Connect External Device to Port dialog box, such as the following:

   ![Connect External Device to Port dialog box](image)

   The external device that you selected in the MIDI Device Configuration Window will already be selected as the External Device.

3. In the dialog box, select the external port to which you wish to connect the external device.

4. Click the Connect button.

To disconnect an external device from an external port.

1. In the MIDI Device Configuration Window, select the external device by clicking its name.

2. In the Device menu, choose the Disconnect From External Port command.

9.8.3.2 Specifying Whether a Port Is Internal or External

For most MIDI sound cards and devices, Composer is able to correctly detect whether any corresponding Windows MIDI port is for an internal MIDI device or an external MIDI device. However,
for a few MIDI sound cards or devices, Composer cannot correctly detect the device status when the MIDI device driver reports incorrect information. For such unusual cases, Composer provides a way to correct the inaccurate determination of whether the port is internal or external.

If you know that a listed Windows MIDI port is for an external port, but Composer reports it as an internal port, then you will find that you are not able to assign an external MIDI device, such as a MIDI keyboard, to the listed port. This is because Composer only allows external MIDI devices to be connected to external ports.

Conversely, you might find that Composer incorrectly reports an internal port as an external port.

The way to correct either of these problems is to follow the procedure below for changing the property of the Windows MIDI port from internal to external.

To change whether a Windows MIDI port is internal or external:

1. In the MIDI Device Configuration Window, select the MIDI port by clicking its name with the mouse.
2. In the Port menu, choose the Properties command.
   
   -- OR --
   
   Instead of selecting the port and choosing the Port Properties command, double-click or right-click the port name.

Composer will display the Port Properties dialog, such as the following:

![Port Properties dialog](image)

3. If the operating system has incorrectly detected the port as Internal, you can click to select "External" (or vice versa).
4. Composer will warn you if "Your assignment" for Internal or External differs from Composer’s detection for the port. In the confirmation dialog, choose "Yes" if you are fairly certain that you have correctly specified whether the port is internal or external. Note, however, that you can later change the specification again if you have made the wrong choice.

9.8.4 Managing MIDI Devices

Before reading this topic, you should review Understanding Ports and Devices in the MIDI Device Configuration Window.

MIDI devices play a central role in the assignment of sounds to staves in a song. Specifically, for any particular staff, you can specify which MIDI device the staff will be played back on. For the same song, you can assign some staves to one device, and other staves to another device.
Each MIDI device has a unique set of properties that you can specify in Composer. Some of the properties of a device answer the following questions:

- Is the device an output device and/or an input device?
- Is the output device the default device to which staves for a newly opened MIDI file are assigned?
- Does the device have multiple banks of sounds available; and how are these defined?
- What are the MIDI patch (instrument) names for the device?
- If the device has drum kits, what are the names of the drum notes?

The following topics describe procedures for adding, removing, and renaming devices, and editing the properties of devices:

- Importing from a MIDI Device Description (.mdd) File
- Importing from a Cakewalk Instrument Description (.ins) File
- Adding an External Device
- Removing a Device
- Renaming a Device
- Specifying Properties of a Device
- Specifying the Default MIDI Output Device
- Specifying a General MIDI (GM) Device
- Exporting to a MIDI Device Description (MDD) File

9.8.4.1 Importing from a MIDI Device Description (.mdd) File

A quick way to specify the patch names for your MIDI device, and other properties of the device, is to import this information from a MIDI Device Description (.mdd) file, which has a format defined by Notation Software. Notation Software offers MDD files at its web site that have been contributed by users of its products.

There are two ways to import the patch names for your MIDI device from a Notation Software MDD file. The easier of the two ways is to use the Quick MIDI Device Setup command in the Setup menu. Use the Import Sound Names option in the Quick MIDI Device Setup dialog box. For details, see the topic Quick MIDI Device Setup.

Another less convenient way to import the patch names from your MIDI device from an MDD file is described below. There are two minor advantages to using this method. First, you can preview the list of MIDI bank names and patches for a device that you are about to import. Second, this method offers an option that you can import a single bank of patches for a device rather than all of the banks.

To import a device description from a MDD file:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.
   -- OR --
   Type "qdc" for Quick Device Configuration.
2. In the MIDI Device Configuration Window, choose the Import command from the Device menu.
Composer will present the Import MIDI Device Description from File dialog box:

3. In the above dialog box, navigate to the directory to which you downloaded the MDD file, or to the directory where you saved the MDD file that you have exported from another computer running Composer.

4. In the dialog box, select the MDD file, and click the Open button.

Composer will display the Import MIDI Device Description window, as illustrated here:

5. In the panel at the right side of the window, click the model number (the name, not the ‘+’ symbol) of the device description you want to import.

6. To optionally review the list of MIDI banks and patch names for a device, click the ‘+’ symbol next to the device name.
Composer will display a list of the MIDI banks for that device. If you click the "+" symbol next to one of the MIDI bank names, then Composer will display the patch names for that bank in the lower half of the window. You can selectively import patch names for a specific bank of a device, but there is usually no need to do this.

You can optionally preview the patch names for a given bank of a device by selecting the bank in the right panel.

7. In the left panel, select the MIDI output port that sends the MIDI output to the MIDI output device.
8. Click the Import button.

Composer will list the newly imported device below the MIDI output port to which it is "connected".

When you assign a staff to the external output device connected to an output port, you can refer to each the name of the port, or the name of the external device. In this example, you can refer to either "Out-A USB MidiSport 2x2" or "Korg M1". You will find it preferable to refer to the device name because then you can assign a sound to the staff by referring to the name of a MIDI bank and patch (instrument) rather than refer to the bank and patch numbers.

8. Click the Exit button.

Composer will add the newly imported device in the MIDI Device Configuration Window.

To import a single MIDI bank from an MDD file into a previously added device:

- Follow the same procedure as above, except select a MIDI bank in the right panel, and a device in the left panel.

### 9.8.4.2 Importing from a Cakewalk Instrument Description (.ins) File

A Cakewalk(tm) Instrument Description (.ins) file contains most of the information needed for a MIDI device description in Composer. The information is the list of MIDI bank and patch names for that device. If you own a Cakewalk software product, then you can borrow instrument descriptions that Cakewalk maintains in INS files installed on your computer. If you do not own a Cakewalk software product, you can download an INS file from Cakewalk’s web site, as described below.

The procedure for importing a device description from a Cakewalk INS file is similar to the procedure for importing a device description from a Notation Software MDD file.

There are two ways to import the patch names for your MIDI device from a Cakewalk INS file. The easier of the two ways is to use the Quick MIDI Device Setup command in the Setup menu. Use the Import Sound Names option in the Quick MIDI Device Setup dialog box. For details, see the topic Quick MIDI Device Setup.

Another less convenient way to import the patch names for your MIDI device from a Cakewalk INS file is described below. There are two minor advantages to using this method. First, you can preview the list of MIDI bank names and patches for a device that you are about to import. Second, this method offers an option that you can import a single bank of patches for a device rather than all of the banks.
To download an INS file:

1. Some of our users have collected and shared INS files which can be found on our User Forum at http://www.notation.com/vb-forum/showthread.php?t=3891 or by searching the User Forum for "Cakewalk INS". If you do not see your device listed there, you can use your favorite browser to search the internet for "cakewalk INS" and list your device name in the search.

2. However you find it, download the INS file(s) for your device(s).

3. Make note of the directory to which the file(s) has been downloaded.

4. Once you have downloaded the .ins file, follow the instructions below for importing the .ins file into Composer.

To import a device description from a Cakewalk INS file:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.

2. In the MIDI Device Configuration Window, choose the Import command from the Device menu. Composer will present the Import MIDI Device Description from File dialog box:

3. In the above dialog box, navigate to the directory to which you downloaded the INS file.

4. In the dialog box, select the INS file, and click the Open button.
Composer will display the Import MIDI Device Description window, as illustrated here:

5. In the panel at the right side of the window, click the model number (the name, not the ‘+’ symbol) of the device description you want to import.

6. To optionally review the list of MIDI banks and patch names for a device, click the ‘+’ symbol next to the device name.

Composer will display a list of the MIDI banks for that device. If you click the “+” symbol next to one of the MIDI bank names, then Composer will display the patch names for that bank in the lower half of the window. You can selectively import patch names for a specific bank of a device, but there is usually no need to do this.

You can optionally preview the patch names for a given bank of a device by selecting the bank in the right panel.

7. In the left panel, select the MIDI output port that sends the MIDI output to the MIDI output device.

8. Click the Import button.

Composer will list the newly imported device below the MIDI output port to which it is "connected".
When you assign a staff to the external output device connected to an output port, you can refer to each the name of the port, or the name of the external device. In this example, you can refer to either "Out-A USB MidiSport 2x2" or "Korg M1". You will find it preferable to refer to the device name because then you can assign a sound to the staff by referring to the name of a MIDI bank and patch (instrument) rather than refer to the bank and patch numbers.

8. Click the Exit button.

Composer will add the newly imported device in the MIDI Device Configuration Window.

To import a single MIDI bank from an MDD file into a previously added device:

- Follow the same procedure as above, except select a MIDI bank in the right panel, and a device in the left panel.

9.8.4.3 Adding an External Device

In the MIDI Device Configuration Window, you can add only external devices, not internal devices. This is because Composer automatically adds and connects an internal device to any internal Windows MIDI port that it detects. For a description of the difference between internal device and external device, see Understanding Ports and Devices in the MIDI Device Configuration Window.

If you intend to identify a new external device not previously defined in any configuration, you should first explore whether you can import the device description. See Importing from a MIDI Device Description (.mdd) File and Importing from a Cakewalk Instrument Description (.ins) File.

To add a device to a MIDI device configuration:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.
   OR
2. Use the Select command of the Config menu if the current configuration is not the one to which you wish to add the device.
3. If the device you want to add to the configuration has already been added or imported, then it will be listed under "Unassigned Devices", as illustrated below. In that case, skip to step #5.

4. If the device is not listed under "Unassigned Devices", then add it as a new device by choosing the New External Device command in the Device menu.
Composer will present the following Device Properties dialog box:

5. In the dialog box, assign a meaningful name to the device. Specify the properties of the new device, as described in [Specifying Properties of a Device](#). Then click the OK button.

Composer will list the new device under "Unassigned Devices" in the MIDI Device Configuration Window.

6. In the MIDI Device Configuration Window, select the device by clicking its name.

7. Choose the Connect to External Port command in the Device menu.

Composer will present the Connect to External Port dialog.

8. In the Connect to External Port dialog, specify the external port to which the new device should be attached.

9. Click the OK button in the Connect to External Port dialog to complete the task.

**9.8.4.4 Removing a Device**

Removing a device normally removes it only from the current configuration. If it is present in other configurations, it will remain in those configurations. If it is no longer present in other configurations, then Composer will offer you the option to delete the description altogether.

To remove a device from a MIDI device configuration:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.

-- OR --
Type "qdc" for Quick Device Configuration.

2. Select the device by clicking its name in the window.

3. In the Device menu, choose the Remove from Configuration command.

-- OR --
Hit the DEL key.

4. If the device is no longer present in any other configurations, Composer will ask you whether you want to delete the device permanently. Respond with "no" if you anticipate possibly using the device description later in another configuration.

9.8.4.5 Renaming a Device

When you assign instrument sounds to staves, you refer to the name of the device, a MIDI bank on the device (or "General MIDI"), and a MIDI program patch. In assigning the instrument sounds to a staff, you will refer to device names rather than Windows port names. You cannot change the names that Windows uses for the MIDI ports, which are generally awkward to read, but you can change the names of devices so that the names make sense to you.

When Composer initially detects a MIDI port, Composer creates a "placeholder" device that is "connected" to the port. Composer assigns that placeholder device the same name as the port (such as "SB Live! External MIDI") to which is connected, or with which it is associated. You can change the name of the device to something like "Keyboard", or perhaps "Casio", to reflect the specific manufacturer and model of your keyboard or external MIDI sound module.

To rename the external MIDI device:

1. In the Setup menu, choose the MIDI Device Configuration command.

-- OR --
Type "qdc" for Quick Device Configuration.

Composer will display the MIDI Device Configuration Window.

2. Select the device by clicking its name in the window.

3. In the Device menu, choose Properties.

Composer will present the Device Properties dialog box.


5. Hit the OK button to complete the task.

9.8.4.6 Specifying Properties of a Device

The Notation Software Internal Synth has some additional settings that are available besides the "common" ones detailed below. Please see the topic "Notation Software Internal Synthesizer" for details on those specialized settings.

You can view and edit the properties of a MIDI device in the Device Properties dialog. The various properties of a device are described later in this topic.

If you intend to identify a new external device not previously defined in any configuration, you should first find out if you can import the device description. See Importing from a MIDI Device Description (.mdd) File and Importing from a Cakewalk Instrument Description (.ins) File.

To view and change the properties of a device:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.
2. Select a device by clicking its name in the MIDI Device Configuration Window, and then choose the Properties command in the Device menu.

-- OR --

Right-Click the device's name with the mouse, and select “Properties” from the list there.

Composer will display the Device Properties dialog, such as the following:

![Device Properties Dialog](image)

3. Change values in the dialog as described below.

4. Click OK to commit the changes.

The remainder of this topic describes the various properties of a MIDI device.

A MIDI device can be an output device, an input device, or both an input and output device. Some MIDI keyboards are input-only. That is, they only send MIDI as input into the MIDI application, such as Composer. Such MIDI keyboards are also called “MIDI controllers”. Other MIDI keyboards are also capable of playing MIDI output sent from the MIDI application.

**Playback Properties (of an Output Device)**

- **Is MIDI Output Device**
  
  Add a check mark to this checkbox if the device is a MIDI output device.
Is Default Output Device

Add a check mark to this checkbox if the device is the default MIDI output device. See also Specifying the Default MIDI Output Device.

Was Previously the Default MIDI Output Device

Use this option and the Option to Reassign button below it to determine how Composer should reassign staves to an old MIDI device output device that used to be the default MIDI playback device but has since been replaced with a new default MIDI output device. See Changing the Default Playback Device.

MIDI banks

A device can have one or more MIDI banks. Each MIDI bank consists of one set of up to 128 MIDI patches, which can be thought of as distinct instrument sounds. Some MIDI devices support multiple alternative banks of patches. If the device has multiple banks of patches, then you must specify the Bank Select Method (see below). In the above example, the Roland M-SE1 device has two banks named "Strings" and "Extras".

Sound cards typically have one or more software-based synthesizers that implement the standard General MIDI (GM) patches. Some external MIDI sound modules also implement General MIDI. To assign the set of General MIDI patches to a device, follow the instructions for Specifying a General MIDI (GM) Device.

For general instructions in adding, editing, renaming, and removing banks, see Managing MIDI Banks and Patches.

Bank Select Method

If the device has only one MIDI bank, then the Bank Select Method for this device is "None". Otherwise, the Bank Select Method will likely be the most difficult property of a device to find listed in your device owner's manual. You will need to search in the section of the owner's manual that is intended for software programmers, rather than normal users. Look under a section of the manual that describes "MIDI Messages". Under that section, look for a subsection that describes "Changing Patches", "Bank Changes", "Bank Selection", or "Bank Select Method".

When a MIDI program sends a MIDI message to a device to change the MIDI bank, the message can be formatted in a couple of different ways, depending on the expectation of the particular device. Each of the alternative MIDI industry standard methods for formatting the messages are listed below. No harm will come to your device if you choose the wrong Bank Select Method; you simply might not hear the right instruments played. The names of the Bank Select Method listed below are exactly as presented in the choice box in the Device Properties dialog box:

Normal: This is the default setting. Controller Number 0, followed by a value that specifies the particular bank to be selected, followed by Controller Number 32, followed typically by the value 0 but perhaps by a number that further specifies which bank is to be selected. This Bank Select Method is the most common one.

CTRL 0: Controller Number 0, followed by a value that specifies the particular bank to be selected.

CTRL 32: Controller Number 32, followed by a value that specifies the particular bank to be selected.

Patch 100 to 127: Patch numbers 100 to 127 select one of up to 28 alternative banks. For a given bank, only 100 patches will be available, numbered 0 to 99, since numbers 100 through 127 are reserved for bank selections.
Patch Names

Each MIDI bank has a set of MIDI patches, alternatively called "MIDI programs". The MIDI patches consist of up to 128 different instrument sounds, each identified within MIDI as simply a number from 0 to 127. When you assign an instrument sound to a staff, you must specify both the bank and a MIDI patch. (Note that if the staff includes mid-song MIDI program changes, Composer will correctly change the instrument sound in real-time during playback.) Because it is difficult and inconvenient to remember what MIDI program numbers are associated with which instrumental sounds, Composer shows you meaningful patch names, such as "Acoustic Guitar". For a given device, you can specify the wording of the patch names.

The patch names for one of the banks (or the only bank) of a device are typically listed in the device owner's manual in a section name "Patch List", or "Tone List", or "MIDI Programs". If the device has multiple MIDI banks, then the heading for the list of patches for a given bank will show the bank value and perhaps the controller values mentioned above under Bank Select Method.

For instructions in adding, editing, and renaming patches, see Managing MIDI Banks and Patches.

System Exclusive Events

If your device relies on System Exclusive Events, you can check the appropriate boxes ("Record" if you will be using the device to record into Notation Composer; to "Send SysEx to this Device". Checking this box will also make sure that any MIDI files that you export contain the proper Sys Ex events as well.

If your device relies on SysEx Events, then for optimal performance of sounds for your device you should check the following parameter values, which you will need to get from your device manual:

SysEx Buffer Count
SysEx Buffer Size (bytes)
GM Reset adjustment time (msec)
GM2/GS/XG Reset adjustment time (msec)
Delay between SysEx packets (msec)

Anticipate Playback Delay

Some MIDI software synthesizers, such as the Roland Virtual Sound Canvas, delay the performance of MIDI. The delay is necessary so that the software synthesizer can dynamically prepare the sound wave data during playback. Also, some acoustic player pianos, such as the Yamaha Disklavier, provide an option to delay playback by a specified number of milliseconds. The delay allows piano hammers traveling at different speeds (faster for louder notes) to hit the strings at more precise relative times.

If your MIDI software synthesizer has such a delay, or if your acoustic player piano is set for such a delay, then the millisecond duration of the delay must be specified so that Composer can synchronize other output devices and visual information, such as highlighting of notes, during playback.

Tap in Delay

Clicking this button will open the Tap in Delay dialog which will let you listen to the playback of a scale on the selected device, and tap in the notes as you hear them. Composer will then determine the Playback Delay for you, and save it so that it will correctly coordinate the highlighting of notes with their sound during playback.
NOTE: If a MIDI output device has a delay, the device cannot be successfully used to echo your live performance on a MIDI input device. You will experience a frustrating delay between the time you hit a note and the time you hear it. This is not Composer's fault. It is just the nature of your MIDI output device if it has a built-in delay.

For further information, see Adjusting for the Delay of Some MIDI Output Devices.}

Drum Channel Numbers

Some MIDI devices dedicate specific channel numbers to drum sounds. On drum channels, MIDI pitches are interpreted not as real pitches but, rather, as different types of drum sounds. The special MIDI device called "General MIDI", defines channel 10 as the drum channel. You should specify the drum channel(s) when defining a device so that when Composer transposes the pitches of a song to another key, it knows that it should not attempt to transpose the pitches in the drum channels. Otherwise, snare drum sounds might end up sounding like bells.

Enter the drum channel numbers separated by commas, such as in "10,12".

Recording Properties (of an Input Device)

Is MIDI Input Device

Add a check mark to this checkbox if the device is a MIDI input device.

Echo MIDI Input to Output

If echo is turned on, then your performance on the MIDI input device will be routed to a MIDI output device. Use the Select Play-Along Sound command in the Perform menu to determine which output device will be chosen for echoing the input.

For an overview of MIDI "echo", see Deciding Whether or Not Your Keyboard Should Directly Produce Sound.

9.8.4.7 Specifying the Default MIDI Output Device

When you first open a MIDI file, Composer assigns all staves to a default MIDI output device. Initially this is the Notation Software Synth.

To review which device is the default MIDI output device:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.

-- OR --

Type "qdc" for Quick Device Configuration.

2. The default MIDI output default is highlighted in green. In the example below, the device "Creative SB Live! Synthesizer" is the default output device.
To change the default MIDI output device:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Config command from the Setup menu.
   -- OR --
   Type "qdc" for Quick Device Configuration.

2. Select the desired default MIDI output device by clicking its name, and then choose the Set as Current Playback Device command in the Device menu.
   -- OR --
   Double-click the name of the MIDI output device.

After opening a MIDI file, if you go to the Staff Setup window, you will notice that all of the staves are assigned to the default MIDI output device that you have specified. In the Staff Setup window you can change the device assignment for any of the staves.

9.8.4.8 Specifying a General MIDI (GM) Device

General MIDI (GM) is a standard specified by the MIDI Manufacturers Association (MMA). The General MIDI standard defines 128 distinct instrument sounds and a collection of drum sounds. Most sound cards that support MIDI also implement the General MIDI standard. Thus, you can play the same MIDI file on two different manufacturer's versions of GM sound cards and hear roughly the same instrument sounds. The actual instrument sounds can differ significantly, so that a song that sounds good on one sound card might not sound quite as good on another. Nevertheless, if there are four different instruments playing together in the MIDI source, for example, you will usually be able to identify what kind of instruments are playing, regardless of what sound card is used.

When Composer runs for the first time, it detects the software-based synthesizers for your sound card, and automatically creates corresponding devices for each. Also, Composer automatically specifies these to be General MIDI devices. This means that Composer assigns a single MIDI bank to the device, and names that bank "General MIDI".

Composer assigns standard General MIDI patch names to the General MIDI bank.

To view the General MIDI patch names for a device that is already configured:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command in the Setup menu.
   -- OR --
   Type "qdc" for Quick Device Configuration.

2. Click the name of a "Software Synth" device. If this device was initially configured by Composer, then Composer will assume that the device uses the General MIDI standard.

3. Choose the Properties command in the Device menu. Composer will display the Device Properties dialog box.

4. In the Device Properties dialog box, click the line "0 = General MIDI" that is listed under "Banks".
5. Click the Patch Names button. Composer will then display the following dialog box:

![Patch Names dialog box](image)

6. If you only want to view the General MIDI patch names, then click the OK button when you are done to exit the Patch Names dialog box, and click the OK button of the Device Properties dialog to exit that dialog box.

You might need to create a new device with the General MIDI specification. You will need to do the following procedure if this GM device is not already associated with the Windows MIDI output port of a software-based synthesizer automatically detected by Composer.

To create a new General MIDI device:

1. Follow the procedure for Adding an External Device, even if your device is an internal device.
2. In the Device Properties dialog, click the Set General MIDI button. A "General MIDI" bank will now be listed under "Banks", as illustrated:

```
Device Properties

Device Name: New Device

External MIDI Device

Playback Properties

[ ] Is MIDI Output Device
[ ] Is Default Output Device

Bank Select Method:
None

Anticipate Playback Delay: 0 msecs

Drum Channel Number(s): 10

Recording Properties

[ ] Is MIDI Input Device
[ ] Echo MIDI Input to Output

Banks:

1000 General MIDI

[ ] Add Bank
[ ] Edit Bank
[ ] Delete Bank

[ ] Edit Patch Names
[ ] Edit Drum Notes

Set General MIDI
```

3. You can review the newly added General MIDI patch names by clicking the Edit Patch Name buttons.

4. Specify other properties of the new device, as described in Adding an External Device even if your device is an internal device.

5. Click the OK button to complete the task.

9.8.4.9 Tuning a Device to Specific MIDI Channels

Some external devices have the capability to "tune in" to specific MIDI channels, while ignoring incoming MIDI events for other MIDI channels that are intended for, and passed on, to other MIDI devices connected via MIDI Thru connectors. Such devices typically provide front panel options for tuning into channels. By specifying which MIDI channels a given device is tuned to, you can help Composer determine which channels are intended to be performed by a given device.

In particular, if you assign a staff to the "Auto" MIDI channel of a "tuned" device, then Composer will play back that staff using only one of the channels that the device is tuned to. For details about assigning a staff to the Auto MIDI channel, see Assigning MIDI Channels.

In the following example, the 16 channels of MIDI performance sent from the SoundBlaster Live! MIDI Out port are first received by the Korg M1 device. The Korg M1 device forwards all of the MIDI performance, via its MIDI Thru connector, to the second device, a Roland M-SE1 sound module. The Korg M1 device is intended to respond only to channels 9 through 16; and the Roland M-SE1 device is intended to respond only to channels 1 through 8.
The MIDI Device Configuration for the above setup looks like this:

```
<table>
<thead>
<tr>
<th>In</th>
<th>Out</th>
<th>Port or Device Name</th>
<th>Name</th>
<th>Rec</th>
<th>Playback Channels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Out</td>
<td>External Port</td>
<td>SB Livell MIDI Out (8000)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Out</td>
<td>External Device</td>
<td>Korg M1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In</td>
<td>Out</td>
<td>External Device</td>
<td>Roland M-SE1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In</td>
<td>External Part</td>
<td>SB Livell MIDI In (8000)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Notice that the first eight channel buttons are green for the Roland M-SE1, and the last eight channel buttons are gray. For the Korg M1, the first eight channel buttons are gray, and the last eight channel buttons are green. This means that the Roland M-SE1 is "tuned into" the first eight channels (1-8), and the Korg M1 is tuned into the last eight channels (9-16).

To tune a device into specific MIDI channels:

1. Open the **MIDI Device Configuration Window** by choosing the MIDI Device Configuration command from the Setup menu.

   -- OR --

   Type "qdc" for Quick Device Configuration.

2. For the desired device, click channel buttons, which are arranged in four groups of four buttons, to toggle whether the channel is tuned into or not.

   -- OR --

   Drag the mouse over the channel buttons to toggle several at a time.

It is important to understand that "tuning into" channels is intended to instruct Composer about your intentions for using MIDI channels on the devices, but it does not directly force the external devices to accept, or conversely, ignore incoming MIDI data on the specified channels. To accomplish this latter purpose, you must typically choose options on the control panel of the external device to tune that device to specific MIDI channels, and to ignore other channels. For details specific to your device, please refer to its owners manual.
By importing a MIDI Device Description (.mdd) file or a Cakewalk Instrument Definition (.ins) file, you can spare yourself a lot of effort manually entering the patch names and other properties of a device. However, perhaps there was no device description yet available for your device, and you had to enter it manually. If you need to install Composer on a second computer at your home, then you can save yourself the effort of re-entering the same device information on your second computer. Instead, you can export the device information from Composer running on your first computer, into a MIDI Device Description (.mdd) file, and then import it into Composer running on your second computer.

Also, if you have manually entered a device description, we hope you will consider sharing it with other Composer users. You can export the device description into an .mdd file and send it to us. We will publish it at our web site so that other Composer users can make use of your contribution. These other Composer users and Notation Software will greatly appreciate your generosity. For details, see the instructions below.

Note that the format of the .mdd file is defined by Notation Software. Other music software companies are welcome to use this file format, and to refer users of their music software programs to the .mdd files available at our web site.

To export a MIDI device description:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.

   -- OR --

   Type "qdc" for Quick Device Configuration.

2. Choose Export from the Device menu. You do not have to previously select a device. Composer will present you with an Export MIDI Device Description dialog box, such as the following:

3. Under "Devices in Your MIDI Device Configuration", select the device that you wish to export.

4. In the panel on the right, select New Manufacturer, unless the manufacturer for your device happens to be listed already.
5. Click the Export button. Composer will display the Export New Manufacturer dialog box.

6. Enter the name of the manufacturer, for example:

![Export New Manufacturer dialog box](image)

Composer will then show the newly exported device in the right panel of the Export MIDI Device Description dialog box:

![Manufacturers/Devices/Banks](image)

7. If there are additional device descriptions you want to export, repeat steps 4 and 5.

8. Click the Save As button. Composer will present a Save As dialog box.

9. In the Save As dialog box, navigate to the directory where you want to save the MDD file. Give the file a name. And click the Save button.

To send your .mdd file to Notation Software

1. Use your favorite email program to prepare an email.

2. Give the email a subject line that identifies the manufacturer and model of the device, such as "Korg M1 MDD file".

3. Use the file attachment option in your email program to attach the .mdd file that you have saved according to the previous procedure.

4. Send the email to support@notation.com. We will really appreciate your contribution! And so will other Composer customers who use the same MIDI equipment that you do.

9.8.5 Assigning Bank, Patch, and Drum Note Names to a MIDI Device

When you specify an instrument sound for a staff in a song, you use a Staff Setup window to identify the playback device, a MIDI bank on the device (many devices have only one bank), and the identification of some instrument sound that the device offers.

A patch, also called a "MIDI program" produces an instrument sound for a MIDI device. When a MIDI program change instruction is sent to the device on a given MIDI channel, the device subsequently
uses the specified instrument sound to play notes on that channel. The patch, or MIDI program, is identified with a number between 1 and 128.

The General MIDI (GM) standard specifies a standard set of 128 instrument sounds. If your playback device supports the GM standard, then you will not need to follow procedures in this section on Assigning Bank and Patch Names to a MIDI Device. Instead, you should follow the procedures in Specifying a General MIDI (GM) Device.

Some sound cards and most external MIDI devices offer alternative sets of instrument sounds, which do not adhere to the General MIDI standard. Also, some MIDI devices offer more than one alternative set of 128 patches, for a larger palette of instrument sounds. The palette of instrument sounds is divided into MIDI banks, each defining up to 128 instrument sounds. For such devices, when you use the Staff Setup dialog to specify an instrument sound for a staff, you must specify not only the device and patch number but also the bank number.

If you add a new, non-General MIDI external playback device to your MIDI configuration, Composer does not have any way of knowing the names of the instrument sounds that the device offers, unless you inform Composer what the names are. The easiest way to provide Composer the names of instrument sounds is to import them from a MIDI Device Description (.mdd) file or Cakewalk Instrument Description (.ins) file. However, if you are not able to find a MIDI Device Description file or Cakewalk Instrument Description file for your device, then you will need to manually identify the one or more MIDI banks available for the device, and enter the names of the instrument sounds for each MIDI bank.

The procedure for identifying MIDI banks on a device is described in Assigning a Bank to a MIDI Device.

For each MIDI bank of a device, you can enter the names of the instrument sounds in a Patch Names dialog, as described in Assigning Patch Names for a MIDI Device or Bank of a Device. You only have to enter the patch names for a device once. After that, the patch names will be shown in the Staff Setup dialog as instrument sound names.

The following diagram shows the relationship between the Staff Setup window and the Patch Names dialog box. You will use the Staff Setup window many times as you assign sounds to staves in songs. You will use the Patch Names dialog box only once per device, to inform Composer about the instrument sounds provided by your playback device.
9.8.5.1 Assigning a Bank to a MIDI Device

If this is the first MIDI bank that you are specifying for a device with multiple banks, make sure that you specify the Bank Select Method. See Specifying Properties of a Device.

For devices with multiple MIDI banks, each bank has a distinct bank value. You will need to refer to your device owner’s manual to determine the bank value, as well as to find the patch names for that bank.

Determining the bank value from the information in the device owner’s manual can be somewhat difficult. The bank value should be presented in a heading at the top of the list of patch names for the bank.

- If the Bank Select Method for your device is "Normal", then the heading for the patch names should indicate two numbers, one for Controller 0 and one for Controller 32, such as the following:
CC0: 80; CC32: 0

- If the Bank Select Method is CTRL 0 or CTRL 32, then there will be a single value for CTRL 0 or CTRL 32. That value will be between 0 and 127.
- If the Bank Select Method is Patch 100-127, then use the bank select patch value, which is a number between 100 and 127.

The most common Bank Select Method is "Normal", with values for CTRL 0 and CTRL 32.

**To add a MIDI bank to a device:**

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.
   -- OR --
   Type "qdc" for Quick Device Configuration.
2. Select a device by clicking its name in the MIDI Device Configuration Window.
4. In the Device Properties dialog box, click the Add Bank button. Composer will display the Bank Properties dialog box.

   If the bank select method is "normal", then the Bank Properties dialog box will look like this:

   ![Bank Properties Dialog Box](image)

5. Assign the bank a name, consistent with the name that the device manufacturer assigns to the bank, and click the OK button.

   The newly added bank will now be listed under Banks in the Device Properties dialog box.
6. Click the OK button to exit the Device Properties dialog box.

**9.8.5.2 Removing a Bank from a MIDI Device**

It is rare that you will need to remove a MIDI bank from a device. This might be necessary if you mistakenly added a bank.

**To remove a MIDI bank from a device:**

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.
   -- OR --
   Type or "qdc" for Quick Device Configuration.
2. Select a device by clicking its name in the MIDI Device Configuration Window.
4. In the Banks portion of the Device Properties dialog box, click the name of the bank you wish to remove.

5. Click the Delete Bank button.

6. Confirm that you wish to remove the bank.

7. Click the OK button to exit the Device Properties dialog box.

9.8.5.3 Assigning Patch Names for a MIDI Device or Bank of a Device

Patch names, which are meaningful substitutes for patch numbers, 0 to 127, are primarily used in the following way. When you assign an instrument sound to a staff in the Staff Setup dialog, you select the instrument sound from your list of patch names rather than from a list of numbers, 0 to 127. It is much more convenient to refer to patch names than to have to remember or look up the meaning of the 128 patch numbers in some manual.

For any given device and its bank(s), you can choose the wording for each of the 128 patches.

To specify patch names for a MIDI bank:

1. Open the MIDI Device Configuration Window by choosing the MIDI Device Configuration command from the Setup menu.

-- OR --

Type or "qdc" for Quick Device Configuration.

2. Select a device by clicking its name in the MIDI Device Configuration Window.


4. Under Banks in the Device Properties dialog box, select the bank whose patches you wish to edit.

   If you have not yet added the bank, then follow the instructions in Assigning a Bank to a MIDI Device.

5. Click the Patch Names button.

   Composer will display a Patch Names dialog, such as the following:
6. Add or change text for any of the patch names in the table. If the patches in this MIDI bank adhere to the General MIDI (GM) standard, click the General MIDI button. Click the Copy From Other Bank button if you wish to copy the patch names from another bank of this device or from another device.

7. Click the OK button to complete the editing of the patch names.

9.8.5.4 Managing Drum Note Lists

Most MIDI devices, including General MIDI devices, have one or more drum kits. A drum kit provides a set of various percussion instrument sounds.

General MIDI devices include a standard drum kit for drum sounds that are played on MIDI channel 10. The pseudo pitch of a General MIDI drum note determines its instrument sound. For example, middle-C (MIDI pitch 60) produces a "High Bongo" sound, and C# (pitch 61) produces a "Low Bongo" sound.

Many MIDI devices offer multiple drum kits. Each drum kit is associated with a unique combination of a MIDI bank and patch (program). For example, the Yamaha Tyros keyboard has a bank (CTRL 0 = 127, CTRL 32 = 0) with several different drum kits. Each drum kit is assigned a different MIDI patch (program) number. For example, patch 17 is the "Rock Kit" and patch 28 is the "Dance Kit". In the Rock Kit, pitch 38 is "Snare Rock", and pitch 40 is "Snare Rock Tight". In the Dance Kit, pitch 38 is "Snare Clap" and pitch 40 is "Snare Dry". The Yamaha Tyros has hundreds of drum sounds assigned to different pitches for different MIDI programs on this particular drum bank (CTRL 0 = 127, CTRL 32 = 0).

With a General MIDI device, you must assign the drum staff to channel 10. For other devices with drum kits, you can usually assign any MIDI channel.
When you add a new drum staff for a non-General MIDI device using the Staff Setup command, you will need to specify its bank and program, as illustrated here:

The rest of this topic explains how you can configure your MIDI device with drum note names. In the above example, "Snare Dry" is the drum note name for pitch 40 for MIDI program 28 on the Yamaha Tyros Drums bank. If you do not configure your MIDI device with drum note names, then you will be able to refer only to pitch and program numbers, which are difficult to remember, since any given device might have hundreds of different drum sounds.

The easiest way to configure your MIDI device with note names is to import a MIDI Device Description (.mdd) or Cakewalk Instruction Definition (.ins) file for the device. For instructions, see Importing from a MIDI Device Description (.mdd) File and Importing from a Cakewalk Instrument Description (.ins) File. Only if you cannot find and import the note names should you spend the effort to manually enter them.

Before we describe the procedure for adding drum notes, we will describe how you can review the list of drum notes that already exist for a device. This will give you a better idea of where you are headed before you start preparing a new drum note list.

To review currently configured drum note lists for a device:

1. Choose the MIDI Device Configuration command in the Setup menu.
   -- OR --
   Type for Quick Device Configuration.
   Composer will display the MIDI Device Configuration Window, such as illustrated below.

Pitch 40 plays the "Snare Dry" sound on a track that is assigned to the "Dance Kit" (MIDI program 28 on the bank selected with Ctrl 0 = 127, Ctrl 32 = 0).

MIDI patches (programs) that select drum kits show a "d" (drum) after the patch number.

MIDI patch (program) number 28 selects the "Dance Kit".

The bank selected by Ctrl 0 = 127, and Ctrl 32 = 0 has various drum kits.
2. Double-click the name of the device for which you wish to review the drum note list(s). Composer will display the Device Properties dialog box, as illustrated here:

3. In the Banks list, select a bank that has a "d" after the bank selection number. The "d" indicates that the bank contains drum kits.

   In the above selection, the Yamaha Tyros Drums kit indicates a "d" after the bank selection values (CTRL 0 = 127, CTRL 32 = 0).

4. Click the Edit Drum Notes button. Composer will display the Drum Notes dialog, which shows the names of all of the drum note pitches defined for the particular MIDI program (patch) on the specified MIDI bank:
5. Select the Patch (MIDI program) for a drum kit whose drum note names you wish to review, as illustrated above.

6. Optionally, click the Show Playback Pitches or Show Recording Pitches to view the drum note pitches graphically in a simulated score for which each distinct drum note is played once as a quarter note. The concept of recording pitches is explained later in this topic.

Continuing with the above example, this is what the score looks like when you choose the Show Playback Pitches option for the Yamaha Tyros Dance Kit:

**Drum Note Playback Pitches**

To specify the drum note names for a device:

Note that you will need to refer to the user's manual, or perhaps the front panel, of your MIDI keyboard or sound module, to determine the MIDI bank, patches (program numbers) and drum note pitches for the various drum kits available for playback on that device.

1. Choose the MIDI Device Configuration command in the Setup menu.

   -- OR --
Type "qdc" for Quick Device Configuration.

Composer will display the MIDI Device Configuration Window.

2. Double-click the name of the device for which you wish to specify the drum note names.

Composer will display the Device Properties dialog box.

3. In the Device Properties dialog box, select the MIDI bank that provides the drum kit(s). (If the MIDI bank is not listed, then add it, as described in Assigning a Bank to a MIDI Device.)

4. Click the Edit Drum Notes button.

Composer will display the Drum Notes dialog, as illustrated in step #4 in the previous procedure.

5. In the Drum Notes dialog, select the Patch (MIDI program) that selects a drum kit among those available for the bank of the device. (If the patch (MIDI program) is not listed, then add it, as described in Assigning Patch Names for a MIDI Device or Bank.)

6. In the Drum Notes dialog, click an existing drum note. The new drum note will appear above the selected drum note, as illustrated below:

The drum notes do not need to be listed in the same order as their pitches. You can organize the drum notes in any order that will make the most sense to you when you later assign drum notes to song staves. You can also change the order of the drum notes in the list at any time, using the Move Up and Move Down buttons.

7. Click the Add Drum Note button.

Composer will insert a new row in the Drum Notes list. Initially, the name of the drum note will be empty. Also, the Playback Pitch and Recording Pitch will probably not be the value you want.
8. In the new row of the Drum Notes list, enter the name, Playback Pitch, and Recording Pitch of the new drum note, as illustrated below:

Drum Note Recording Pitch
When you record drum notes on your MIDI keyboard, in real-time or step-time, you may find it inconvenient to record those notes using the pitches assigned to the notes. If so, you can "map" the drum notes to different pitches for recording purposes. For example, if you use only five drum sounds in a given kit, you might want to assign two of them to two adjacent black keys, C# and D#, in the left, and three adjacent black keys (F#, G# and A#) in the right hand. To do this, specify the desired Recording Pitch for these five drum notes.

Often the manufacturer of MIDI equipment establishes standard drum kits that are shared among several models of MIDI keyboards and sound modules. Also, sometimes different drum kits for the same device have drum notes with different sounds, but the same names. In these cases, you can save effort in entering drum note names by copying a list from another device, bank, or patch (MIDI program).

To copy a list of drum notes from one device, bank, or patch to another:
1. Follow steps #1 through #5 in the above procedure for selecting the device, bank, and patch of a drum kit.

2. In the Drum Notes dialog, click the Copy From Other Patch button.

   The title of the dialog box will change from "Drum Notes" to "Copy Drum Notes from Another Device/Bank/Patch".

3. In this new dialog box, select the device, bank, and patch from which you wish to copy the entire list of drum notes. You can preview the list of drum notes before you commit to copying them.

4. Click the Copy From Other Patch button a second time.

### 9.8.6 Managing Alternative MIDI Device Configurations

**NOTE:** If your system includes only a single sound card and at most one external MIDI device, such as a MIDI keyboard, then you likely do not need to define more than one configuration. You can manage your sound card ports using the single "Default Configuration" that Composer originally creates for you, and you do not need to refer to this section.

If your music studio includes at least a couple of external MIDI devices, then there are likely multiple ways that you might want to arrange your devices, depending on the orchestration requirements for a given type of song. This might require that you reconnect MIDI cables, or change settings on the front panels of your devices.

Each time you change the physical arrangement of your devices, you will need to update the corresponding representation in the **MIDI Device Configuration Window**. This task is made easy by Composer, because you can name and save alternative configurations. If it takes you a couple of minutes to rearrange your physical devices, it will still take you only a few seconds to recall the corresponding configuration in Composer.

#### 9.8.6.1 Saving a Configuration

**To Save or Back up a configuration:**

1. In the **MIDI Device Configuration Window**, choose the Save/Backup command from the Config menu.

2. Enter the name for the configuration in the dialog box that Composer presents to you.

3. Click the "Save" button to save the configuration and exit the dialog.

#### 9.8.6.2 Selecting a Configuration

**To select a configuration that you have previously saved:**

1. Choose the MIDI Device Configuration command from the Setup menu.

   -- OR --

   Type "qdc" for Quick Device Configuration.

2. In the **MIDI Device Configuration Window**, choose the Select command from the Config menu. Composer will display the MIDI Device Configuration dialog box.

3. In the dialog box, select one of your previously saved configurations.

If you have a song currently opened, then Composer will be able to fully play all of the song staves only if the device assignments for the staves are supported by the new configuration. If some of the staves are assigned to a device no longer in the current configuration, then you will need to use the **Staff Setup** window to reassign staves to devices in the new configuration.
9.8.6.3 Creating a New Configuration

To create an entirely new configuration:

1. Choose the MIDI Device Configuration command from the Setup menu.
   -- OR --
   Type or "qdc" for Quick Device Configuration.
2. In the **MIDI Device Configuration Window**, choose the New command from the Config menu.
3. Enter the name of the new configuration in the dialog box that **Composer** presents to you.

The new configuration will initially include no ports or devices. Usually it is more convenient to create a new configuration by cloning an existing configuration.

9.8.6.4 Re-Initializing a Configuration

If you change the sound card of your system or add a new one, **Composer** will also automatically detect it the next time you run the program. **Composer** will deactivate any Windows MIDI ports that are no longer in your Windows system. You can completely re-initialize the configuration based on the current Windows MIDI ports in your system, as though **Composer** were just installed for the first time.

To re-initialize the configuration, follow the procedure below.

To re-initialize the current configuration:

1. Choose the MIDI Device Configuration command from the Setup menu.
   -- OR --
   Type or "qdc" for Quick Device Configuration.
2. Optionally make a backup of the configuration following the procedure for Cloning a Configuration.
3. Select the configuration you wish to re-initialize if it is not already selected.
4. Choose the Initialize command in the Config menu.

9.8.6.5 Cloning a Configuration

You can make a copy of a configuration. Two good reasons for doing so are:

1. to back up a configuration before making changes that you are uncertain you will want to keep
2. to create a variation of an existing configuration.

To clone a copy of a configuration:

1. In the **MIDI Device Configuration Window**, choose the Clone To command in the Config menu.
2. Enter the name of the newly cloned configuration in the dialog box that **Composer** presents to you.

9.8.6.6 Renaming a Configuration

To rename a configuration:

1. In the **MIDI Device Configuration Window**, choose the Rename command from the Config menu.
2. Enter the new name for the configuration in the dialog box that **Composer** presents to you.
9.8.6.7 Deleting a Configuration

To delete a configuration:

1. In the MIDI Device Configuration Window, choose the Delete command from the Config menu.
2. Composer will ask you to confirm your intention to delete the configuration.

9.8.6.8 Restoring A Configuration

To Restore a previously saved configuration:

1. In the MIDI Device Configuration Window, choose the Restore command from the Config menu.
2. In the navigation dialog box, find the configuration you wish to restore and click on it to select it.
3. Click the "Open" button to restore the configuration and exit the dialog.
10 Band-in-a-Box® Plugin: Summary and QuickStart

The Band-in-a-Box® plugin for Notation Composer gives you the capability to automatically add or change the accompaniment to your songs with a few simple steps. The trial plugin comes with 25 styles in a variety of genres - the full plugin comes with 150 styles and variants. You can also use styles that you have purchased from PG Music® or obtained from other sources. The trial version is free to try fully for 60 days, and any files that are created using the plugin can be opened in any of Notation Software’s products.

The main steps for using the The Band-in-a-Box® plugin to automatically generate accompaniment are:

1. **Song file**: Open or create your song file.
2. **Style**: Use the Style Picker to select the style/substyle that you wish and click in the score where you want the accompaniment to begin (eg. measure 1 beat 1).
3. **Chord names**: Enter the chord names manually, or have Composer automatically analyze the chord names for the existing accompaniment.
4. **Intros and endings**: Decide if you would like to have a special “intro” for your song, and select the number of measures of intro for the song (you may need to add extra measures to the beginning of the song so things sound good). You can also select to have the last 2 measures of the song played as a “finale” finish; again you may want to add a couple of measures to the end of the song for it to sound perfect.
5. **Takes**: Click the “Generate” button to have accompaniment generated automatically for your song. You can select different styles and create multiple takes to have a variety to select from or to combine using Composer’s editing tools.

Note: There are a few requirements that the song file must meet for the Band-in-a-Box® plugin to work properly:

- The song must be in 4/4 or 3/4 time. You can generate accompaniment for other time signatures, but you must first change the time signature to 4/4 or 3/4 using Staff Symbols/Meter/Change Meter, generate the accompaniment, and then change the meter back to your original meter.
- Some chord names are not recognized by the Band-in-a-Box® plugin. If this is a problem for your file, you will need to change the problematic chord name, generate the accompaniment, and then change the chord name back if needed. Using Notation Composer's note editing tools you can "tweak" any note pitches in the accompaniment to give you the exact sound you want for
those chords. You can find a list of supported chord name types at http://www.pgmusic.com/tutorial_chordlist.htm

* The Band-in-a-Box® plugin is only available for Notation Composer, and is an additional license purchase.

10.1 Using the Band-in-a-Box® Plugin to Generate Auto-accompaniment

Maybe you have just a melody line and some chord names and you want to create some accompaniment for an audio file or for printing sheet music for your group. Or maybe you've found a MIDI file of a song you like but would like different accompaniment for it. You can use the Band-in-a-Box® plugin to automatically create accompaniment for your music quickly and easily. Try out lots of different styles - you can keep track of them with <%%PROD%%>'s Parts feature, where each "take" is kept as its own Part. If you decide you like a particular take for the verse but want a different style for the chorus, use Composer's editing tools to mix and match the different sections to get the exact composition that you want.

If you just want a "QuickStart" guide to get going with the Band-in-a-Box® plugin please go to the Summary and QuickStart page.

For more details about particular tasks you can do with the Band-in-a-Box® plugin, you can learn more below about:

- Working with Styles
- Adding chord names if your file does not yet have them
- Setting up Intros and Endings for your song
- Generating "Takes", multiple takes, and editing

Working with Styles

The trial plugin comes with 25 styles in a variety of genres - the full plugin comes with 150 styles and variants. You can also use styles that you have purchased from PG Music® or obtained from other sources.

If you have multiple folders of Styles on your computer, you may want to use the Style File dialog to find the style you want to use in your song. If all your styles are in one folder, you'll probably want to use the Style Picker instead.

To set the default folder for your Style files, you can use the Style File button in the Band-in-a-Box® "Style" palette.

1. Click the "Sty" button on the Band-in-a-Box® palette
2. Click the "Sty File" button
3. Click in the score where you want the Band-in-a-Box® accompaniment to start.
The following dialog box will open:
You can select a style from the default folder location, or navigate to where your desired style is located on your computer. You can also click the "Set this directory as default folder for Band-in-a-Box styles" if you wish. For the best results, you may want to put all your Band-in-a-Box® styles in a single folder and set that as your default folder. Doing this will allow the Style Picker to get the description information to help you decide which style you would like to use for your song.

If you use the Style File button to find your style, click to select the sub-style A or B, then click "Select" and Composer will insert that style into your song where you clicked your mouse.

Selecting a style for the accompaniment using the Style Picker. The full Band-in-a-Box® plugin comes with 150 different styles to choose from, and each of those styles has an "A" and a "B" substyle that vary slightly from each other. You can also use any Band-in-a-Box® style files (.STY) that you may have on your computer. The Style Picker can give you some information on each of the styles that are available to help you decide which one you want to use for a particular "take" to generate accompaniment for your song.

To open the Style Picker dialog, click the Style Picker button in the Band-in-a-Box® "Style" palette.
The following dialog will open, and you can select the different options as shown here:

1. Choose a genre
2. Choose a Style
3. Choose a Sub-style

This text gives you a bit of information about the style that is selected.

After selecting your options, click "Ok" to save those and have the selected style and substyle saved in the score.
Tip: If you have acquired new style (.sty) files, or moved style files from one folder to your default folder, you can use the "Rebuild List of Styles..." button to add all the styles into the Style Picker so that you can easily sort through them by genre and have the Descriptions available in the Style Picker dialog.

After clicking "Ok", the information for all the styles in the selected folder will be available in the Style Picker to help you choose the best style for your song.
Changing a style or different sub-style after it is inserted in the score

If you decide you want to try a different style, either because you've changed your mind or because you want to try a new "take", simply double-click the Style Name that is in the score and the Style Picker dialog will be displayed.

Now you can select a different Sub-style (A or B), or select a totally different Style just as explained above.

Hiding style names so they don't print in the score.

If you wish to print your scores for live musicians after generating the sheet music, you probably do not want the Style names to appear in the score. Simply click the "eyeglasses" toggle button "Off" to hide the Style names.

To view the styles so you can edit them, simply click the "eyeglasses" toggle "On" again.
Adding chord names if your file does not yet have them.

You can either enter chord names manually, or use the Chord Analysis Wizard to analyze the existing accompaniment and add the transcribed chord names to the score automatically for you.

Note that the Chord Name tools are present in the Band-in-a-Box tab and the Text tab for your convenience.

Tip: Make sure that you have a chord name at the beginning of your song, otherwise Band-in-a-Box® will generate the accompaniment for a C chord until it comes to the first chord name.

Note: Some chord names are not recognized by the Band-in-a-Box® plugin. If this is a problem for your file, you will need to change the problematic chord name, generate the accompaniment, and then change the chord name back if needed. Using Notation Composer's note editing tools you can "tweak" any note pitches in the accompaniment to give you the exact sound you want for those chords. You can find a list of supported chord name types at http://www.pgmusic.com/tutorial_chordlist.htm

Setting up Intros and Endings for your song

Just as you might have an "intro lick" or particular way to start a song, you can have the Band-in-a-Box® plugin create an "intro" for your song as well as an "outro" or "ending." These options will help the accompaniment automatically sound more "finished" than just abruptly starting or stopping. Of course using Composer's note editing tools you can always make it sound just the way you want it to. You can also set up two count-in measures to give you the tempo for performing "live" along with your song.

Setting a simple two-measure count-in

1. In your song file with the Band-in-a-Box tab open, click on the "Intro" button, then check the "Add two count-in measures" toggle button.

2. By default the "Add two count-in measures" is on. If you do not want the count-in measures to be generated, click the button to toggle it "off."

3. When this option is "on", the plug-in will add 2 measures to the beginning of your song with a count-in drum "rim shot" sound. This is helpful when creating files to play with "live." If you are using the plug-in to generate sheet music, you may want to turn this option "off."

Setting an Intro

If you would like your song to have a distinctive "intro", you can have the Band-in-a-Box® plugin generate one for you.

1. In your song file with the Band-in-a-Box tab open, click on the "Intro" button. You can generate 2, 4, or 8 bar (measure) intros.
Be sure that you have the number of measures you want before your melody line starts. For example, if you want a 2 bar intro before the measure where your melody starts, be sure you have those 2 measures already inserted in your song. You can start the intro wherever you want, just be aware that the intro will be created in the first 2, 4, or 8 measures (depending on how many you selected) of the song. You can experiment with this using multiple takes.

You can also enter different chord names for the intro if you want to add a particular feel to the intro.

3. Click the appropriate button for the number of intro bars (measures) you want to have. For this example, click the "2 bar" button.

Now when you generate the accompaniment, an "intro" will be created in the first 2 measures of the song (in this example).

Setting an Ending

If you would like your song to have a distinctive "ending" to finish off your song, you can have the Band-in-a-Box® plugin generate one for you. "Endings" work similarly to "Intros."

1. In your song file with the Band-in-a-Box tab open, click on the "Ending" button. You can generate 2 bar (measure) endings.

2. Be sure that you have the number of measures you want. For example, if you want a 2 bar ending, be sure you have 2 measures already inserted at the end of your song after the melody ends. If you want the "ending" to coincide with the melody that will work, too. Just be aware that the last 2 measures are the ones that will have the special "ending" accompaniment. You can experiment with this using multiple takes.
Band-in-a-Box® Plugin: Summary and QuickStart

3. Click the "2 bar" button to set the song for having a 2 bar ending.

Now when you generate the accompaniment, an "ending" will be created in the last 2 measures of the song.

Working with Takes: generating "Takes", multiple takes, and editing

Generating a "Take."

After making sure that your file has chord names, selecting and adding a style and choosing any intros or endings, you may want, it’s time to create a "take."

1. In the Band-in-a-Box® tab click the "BB" button.

2. Now click the "Generate Band-in-a-Box parts...." button.

3. The software may take a moment, but you should then see extra staves labeled with a "BB" at the beginning of the name as well as the Style name that was used for the particular staff. These are the accompaniment staves that the Band-in-a-Box® plugin created.
4. You will also see that a new Part has been created and is shown in the Part Drop Down list in the main menu bar.

Generating multiple "Takes" of the same song.

Composer's Band-in-a-Box® plugin allows you to create multiple "takes" for the same or different Styles for the same song, giving you multiple different accompaniments to choose from, or to "mix and match" to get the exact sound you're looking for.

To generate a second "take" of a style, simply click the "Generate" button again.

A fresh "take" is created, and Composer keeps track of each "take" by creating a Part with the Style name and take number, as well as putting the Style name in each staff.
Viewing and working with the various "Takes" of a song

A few notes about multiple takes for a song:

- All the staves that are generated over the course of creating multiple takes are saved. Composer creates new staves for each "take", and does not overwrite the previously generated staves.

- The particular staves that are generated as part of a given "take" are included in a particular Part that is created for that particular "take".

- For clarity in working with the various Parts, no Band-in-a-Box® plug-in generated staves are added to the original Conductor's Score. You can use the "Part/Display or Define a part" command to manipulate the staves that are assigned to various Parts.

- Deleting a "take's" Part in Part/Display or Define a part does not delete the staves that were created. Those staves can be deleted quickly by using the plug-in's "Sel" (select) and "Del" (delete) commands (see below), or by using Staff/Setup to delete a staff or staves.

To view any "take" that has been created for a song:

1. In the Band-in-a-Box® tab, click the "BB" button.

2. Click the "Sel" (select) button to view the different "takes" and select one.
3. Click "Ok" to view the selected "take."

To quickly delete any "take" that has been created for a song:
After selecting the "take" using the above steps, simply click the "Del" (delete) button to remove the "take" completely, including the Part that was created and all the staves that were created for the "take."

Next Steps
To work with the staves that have been generated using the Band-in-a-Box® plug-in, you can use Composer's powerful editing tools to get just the performance and sheet music that you want.
# 11 Appendices

**Appendix A: Notation Composer Keyboard Shortcuts**

**Appendix B: What is MIDI?**

**Appendix C: Technical Support**

**Appendix D: Notation Composer License Agreement**

## 11.1 Appendix A: Notation Composer Keyboard Shortcuts

### Shortcuts Using Special Keys

<table>
<thead>
<tr>
<th>Keystroke (Combinations)</th>
<th>Context</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ENTER</strong></td>
<td>Viewing or editing the score.</td>
<td>Toggle between <strong>Select Mode and Add Mode</strong>.</td>
</tr>
<tr>
<td><strong>SHIFT+ENTER</strong></td>
<td>Viewing or editing the score.</td>
<td>For some types of objects, open the Properties dialog box.</td>
</tr>
<tr>
<td><strong>Ins</strong></td>
<td>Add Mode for notes.</td>
<td>Add a new note where the red to-be-added note is currently shown.</td>
</tr>
<tr>
<td><strong>SPACE</strong></td>
<td>Almost any time except when editing text.</td>
<td><strong>Start or stop playback</strong> and <strong>stop recording</strong> to continue adding the next lyric.</td>
</tr>
<tr>
<td><strong>SPACE</strong></td>
<td>A lyric is selected.</td>
<td><strong>Advance to the next note or chord</strong> to continue adding the next lyric.</td>
</tr>
<tr>
<td><strong>CTRL+SPACE</strong></td>
<td>A staff or region has been selected for recording.</td>
<td><strong>Start recording</strong>.</td>
</tr>
<tr>
<td><strong>ALT+SPACE</strong></td>
<td>You have previously specified section that you want to practice.</td>
<td><strong>Start a practice loop</strong>.</td>
</tr>
<tr>
<td><strong>PAGEUP</strong> (or PAGEDOWN)</td>
<td>Vertical scrollbars are displayed in Page View or Window View.</td>
<td>Scroll up or down the page by a window's worth. If the page is already at the top (or bottom), advance to the top of the next page (or bottom of the previous page).</td>
</tr>
<tr>
<td><strong>SHIFT+PAGEUP</strong> (or <strong>SHIFT+PAGEDOWN</strong>)</td>
<td>Window View or Page View.</td>
<td><strong>Go to the top of the next (or previous) page</strong>.</td>
</tr>
<tr>
<td><strong>CTRL+HOME</strong></td>
<td>Window View or Page View.</td>
<td><strong>Go to the beginning of the score</strong>.</td>
</tr>
<tr>
<td><strong>CTRL+END</strong></td>
<td>Window View or Page View.</td>
<td><strong>Go to the end of the score</strong>.</td>
</tr>
<tr>
<td><strong>TAB</strong> or <strong>SHIFT+TAB</strong></td>
<td>A lyric or chord name is selected.</td>
<td>Advance to the next (or previous) note or chord to continue adding or editing the...</td>
</tr>
</tbody>
</table>
### Shortcuts Using Arrow Keys

<table>
<thead>
<tr>
<th>Keystroke (Combinations)</th>
<th>Context</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>← or →</td>
<td>A note or chord selected.</td>
<td>Advance the selection to the next (or previous) chord in the same staff.</td>
</tr>
<tr>
<td>↑ or ↓</td>
<td>A note selected.</td>
<td>Advance the selection to the note above (or below) in the same chord in the same staff.</td>
</tr>
<tr>
<td>← or →</td>
<td>Add Mode for notes.</td>
<td>Move the red to-be-added note to the next or previous position.</td>
</tr>
<tr>
<td>↑ or ↓</td>
<td>Add Mode for notes.</td>
<td>Move the red to-be-added note to the next staff pitch position above or below the current one.</td>
</tr>
<tr>
<td>Key Press</td>
<td>Selected Notes</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>CTRL + ‣, ✈, ➥, or ➤</strong></td>
<td>Vertical or horizontal scrollbars are displayed along the side of the window.</td>
<td>Scroll the score by a small amount in the window.</td>
</tr>
<tr>
<td><strong>SHIFT + ‣ or SHIFT + “</strong></td>
<td>One or more notes selected.</td>
<td>Shift the selected notes to the staff immediately above (or below)</td>
</tr>
<tr>
<td><strong>A + ‣ or A + “</strong></td>
<td>One or more notes selected.</td>
<td>Move the notated and/or performed attack of the notes to the right (or left)</td>
</tr>
<tr>
<td><strong>A + ‣</strong></td>
<td>One or more notes selected.</td>
<td>Snap (“quantize”) the as-performed attack of the selected notes to their notated locations</td>
</tr>
<tr>
<td><strong>C + ‣ or C + “</strong></td>
<td>Show the velocity vectors (loudness) of notes, using SHIFT + V. Then select three or more notes.</td>
<td>Increase (or decrease) the contrast in loudness between the selected notes</td>
</tr>
<tr>
<td><strong>C + ‣ or C + “</strong></td>
<td>Show the velocity vectors (loudness) of notes, using SHIFT + V. Then select three or more notes.</td>
<td>Gradually increase (or decrease) the loudness of notes over the range of selection while preserving the accents of notes. (“C” suggests crescendo.)</td>
</tr>
<tr>
<td><strong>D + ‣ or D + “</strong></td>
<td>One or more notes selected.</td>
<td>Increase (or decrease) the notated and/or performed duration of the selected notes</td>
</tr>
<tr>
<td><strong>E + ‣ or E + “</strong></td>
<td>One or more notes selected.</td>
<td>Raise (or lower) the enharmonic spelling of a note such as from C# to Db.</td>
</tr>
<tr>
<td><strong>F + ‣ or F + “</strong></td>
<td>Page layout view.</td>
<td>Increase (or decrease) the music font size</td>
</tr>
<tr>
<td><strong>L + ‣ or L + “</strong></td>
<td>Show the velocity vectors (loudness) of notes, using SHIFT + V. Then select one or more notes.</td>
<td>Increase (or decrease) the loudness of the selected notes</td>
</tr>
<tr>
<td>**P + ‣ or P + “ or **</td>
<td>One or more notes selected.</td>
<td>Increase (or decrease) the pitch of the selected notes</td>
</tr>
<tr>
<td><strong>CTRL + ‣ or CTRL + “</strong></td>
<td>One or more notes selected.</td>
<td>Snap (“quantize”) the as-performed release of the selected notes to their notated locations</td>
</tr>
<tr>
<td><strong>R + ‣</strong></td>
<td>One or more notes selected.</td>
<td>Snap (“quantize”) the as-performed attack and duration of the selected notes to their notated rhythms (Use A + ‣ to snap the attack and R + ‣ to snap the release.)</td>
</tr>
<tr>
<td><strong>S + ‣</strong></td>
<td>One or more notes selected.</td>
<td></td>
</tr>
</tbody>
</table>
**Palette Shortcuts**

<table>
<thead>
<tr>
<th>Keystroke Combination</th>
<th>Palette</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT+A</td>
<td>Accents and articulations</td>
</tr>
<tr>
<td>SHIFT+B</td>
<td>Beams</td>
</tr>
<tr>
<td>SHIFT+C (once or twice)</td>
<td>Clefs or chord names</td>
</tr>
<tr>
<td>SHIFT+D</td>
<td>Dynamic marks</td>
</tr>
<tr>
<td>SHIFT+E</td>
<td>Expressions (master palette for other palettes)</td>
</tr>
<tr>
<td>SHIFT+F</td>
<td>Free text</td>
</tr>
<tr>
<td>SHIFT+G</td>
<td>Graphical data: tempo, staff volume, staff pan, pitch bend, sustain pedal, and MIDI controller data</td>
</tr>
<tr>
<td>SHIFT+I</td>
<td>Instrument sound (mid-staff MIDI program change)</td>
</tr>
<tr>
<td>SHIFT+K</td>
<td>Key signature</td>
</tr>
<tr>
<td>SHIFT+L</td>
<td>Lyrics</td>
</tr>
<tr>
<td>SHIFT+M</td>
<td>Meter</td>
</tr>
<tr>
<td>SHIFT+N</td>
<td>Notes</td>
</tr>
<tr>
<td>SHIFT+O (once or twice)</td>
<td>Ornaments or 8va octaves</td>
</tr>
<tr>
<td>SHIFT+P (once or twice)</td>
<td>Page text or page layout</td>
</tr>
<tr>
<td>SHIFT+R (once or twice)</td>
<td>Rests or rehearsal marks</td>
</tr>
<tr>
<td>SHIFT+S (once or twice)</td>
<td>Slurs or sustain pedal marks</td>
</tr>
<tr>
<td>Keyboard Sequence</td>
<td>Menu / Submenu</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>qam or qim</td>
<td>Score</td>
</tr>
<tr>
<td>qas</td>
<td>Staff</td>
</tr>
<tr>
<td>qcl</td>
<td>Lyric</td>
</tr>
<tr>
<td>qcmr</td>
<td>Score</td>
</tr>
<tr>
<td>qcrf</td>
<td>Region</td>
</tr>
<tr>
<td>qcm</td>
<td>Region</td>
</tr>
<tr>
<td>qdf</td>
<td>File</td>
</tr>
<tr>
<td>qcrs</td>
<td>Region</td>
</tr>
<tr>
<td>qcuh</td>
<td>Edit</td>
</tr>
<tr>
<td>qdc</td>
<td>Setup</td>
</tr>
<tr>
<td>qdm or qrm</td>
<td>Score</td>
</tr>
<tr>
<td>qds</td>
<td>Staff</td>
</tr>
<tr>
<td>qdpn</td>
<td>Part</td>
</tr>
<tr>
<td>qfn</td>
<td>Note / Filter or Region</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>qfs</td>
<td>Part</td>
</tr>
<tr>
<td>qgm</td>
<td>View / Go to</td>
</tr>
<tr>
<td>qgp</td>
<td>View / Go to</td>
</tr>
<tr>
<td>qgr</td>
<td>View / Go to</td>
</tr>
<tr>
<td>qhrs</td>
<td>Part</td>
</tr>
<tr>
<td>qim or qam</td>
<td>Score</td>
</tr>
<tr>
<td>qin</td>
<td>Part</td>
</tr>
<tr>
<td>qkte or qktm</td>
<td>Perform / Tempo</td>
</tr>
<tr>
<td>qmet</td>
<td>Perform</td>
</tr>
<tr>
<td>qmn</td>
<td>Score</td>
</tr>
<tr>
<td>qms</td>
<td>Staff</td>
</tr>
<tr>
<td>qpc</td>
<td>Setup</td>
</tr>
<tr>
<td>qpdf</td>
<td>File</td>
</tr>
<tr>
<td>qpgs</td>
<td>Part</td>
</tr>
<tr>
<td>qpl</td>
<td>Edit or Lyric</td>
</tr>
<tr>
<td>qpnr</td>
<td>Perform</td>
</tr>
<tr>
<td>qppr</td>
<td>Perform</td>
</tr>
<tr>
<td>qpra</td>
<td>Perform</td>
</tr>
<tr>
<td>qps</td>
<td>File</td>
</tr>
<tr>
<td>qpt</td>
<td>Edit</td>
</tr>
<tr>
<td>qpv</td>
<td>View</td>
</tr>
<tr>
<td>qqs</td>
<td>Setup</td>
</tr>
<tr>
<td>qrc</td>
<td>Chord Name</td>
</tr>
<tr>
<td>qrfp</td>
<td>Edit</td>
</tr>
<tr>
<td>qrfp</td>
<td>Edit</td>
</tr>
<tr>
<td>qri</td>
<td>Score</td>
</tr>
<tr>
<td>Code</td>
<td>Category</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td>qrm or qdm</td>
<td>Score</td>
</tr>
<tr>
<td>qro</td>
<td>Note / Filter</td>
</tr>
<tr>
<td>qrr</td>
<td>Note / Filter</td>
</tr>
<tr>
<td>qrt</td>
<td>Staff</td>
</tr>
<tr>
<td>qsas</td>
<td>Part</td>
</tr>
<tr>
<td>qsbr</td>
<td>Bracket</td>
</tr>
<tr>
<td>qscn</td>
<td>Chord Name</td>
</tr>
<tr>
<td>qscp</td>
<td>Staff</td>
</tr>
<tr>
<td>qsgc</td>
<td>View</td>
</tr>
<tr>
<td>qsgpa</td>
<td>View</td>
</tr>
<tr>
<td>qsgpb</td>
<td>View</td>
</tr>
<tr>
<td>qsgs</td>
<td>View</td>
</tr>
<tr>
<td>qsgt</td>
<td>View</td>
</tr>
<tr>
<td>qsgv</td>
<td>View</td>
</tr>
<tr>
<td>qsh</td>
<td>View</td>
</tr>
<tr>
<td>qsin</td>
<td>Part</td>
</tr>
<tr>
<td>qsl</td>
<td>Lyric</td>
</tr>
<tr>
<td>qsor</td>
<td>Ornament</td>
</tr>
<tr>
<td>qsob</td>
<td>Part</td>
</tr>
<tr>
<td>qspld</td>
<td>Staff</td>
</tr>
<tr>
<td>qsplh</td>
<td>Staff</td>
</tr>
<tr>
<td>qsplm</td>
<td>Staff</td>
</tr>
<tr>
<td>qspp</td>
<td>View</td>
</tr>
<tr>
<td>qsreg</td>
<td>Edit</td>
</tr>
<tr>
<td>qssb</td>
<td>View</td>
</tr>
</tbody>
</table>
### 11.2 Appendix B: What is MIDI?

MIDI (Musical Instrument Digital Interface) is an industry standard for passing musical performance information among electronic musical instruments and computers. There are very few details about MIDI that are necessary for you to understand in order to use Composer. However, a general understanding about MIDI will help you to more quickly understand how Composer lets you create and edit both the music you see as notation and the music that you hear.

Most audio equipment that we are familiar with—such as CD players and radios—receive and send sound in the form of sound waves, such as shown below.

\[
\text{MIDI does not look like this.}
\]

In contrast, MIDI instruments receive and send music data as specific actions to be performed, such as "play a Middle C note softly using the clarinet sound, for a duration of a quarter note at the current tempo." The MIDI instrument receiving such an instruction then produces the sound wave such as the one shown above.

When Composer (or any MIDI program) records a performance on a MIDI keyboard, Composer does not record the actual sound waves, such as shown above. Instead, Composer simply records what keys are played by the at what times, and with what loudness.

The following diagram illustrates MIDI note performance data. Each rectangle represents a single note that is to be performed using some instrument sound, such as a clarinet. The left edge of each rectangle marks the starting time of the note, and the right edge marks the ending time of the note. The
vertical position of the rectangle represents the pitch of the note. This diagram does not illustrate the additional MIDI information for the loudness of the note.

A diagram of a MIDI performance, such as shown above, is commonly called "Piano Roll Notation" because it looks quite similar to piano rolls that were used in mechanical player pianos that were popular in the early 1900's. Each rectangle in the above diagram is like a hole in a piano roll. As the piano roll is scrolled during the performance, the player piano plays a key on the piano when it detects the hole, and releases the key when it detects the end of the hole.

Piano Roll Notation is an ideal way to visualize the performance of notes. Composer offers you the option to see (and edit) both the Piano Roll Notation and standard music notation, at the same time, as illustrated here:

For further information about Piano Roll Notation in Composer, see the topic Displaying Piano Roll Notation.

A MIDI file is a saved recording of a MIDI performance. For a given song, a MIDI file is much smaller (as measured in bytes) than an equivalent audio recording of the song, saved in a .WAV or .MP3 file format or CD audio format. This is because only a few numbers are needed in the MIDI format to describe a note: its starting and ending times, pitch, loudness, and instrument sound. In contrast, tens of thousands of numbers are needed to describe the audio sound waves for just one second of music.

11.3 Appendix C: Technical Support

If while using Notation Composer you have questions about how to use the program, or experience difficulties using the program, there are several ways for you to receive assistance. Also, we would highly appreciate your suggestions for improving Composer (see #5 below).

1. Use this User Guide (Help).
   
   This User Guide provides detailed procedures for how to accomplish various tasks in Composer. We encourage you to give this User Guide a try, since it is probably better organized, more thorough, and easier to read than many User Guides that you have read.

2. Check whether a free update of Notation is available.

   Notation Software provides free updates for maintenance releases of Notation <% PROCOMMA%> fixing known bugs as well as providing new features and enhancements to the software. To check whether a new update is available, choose the Check for Latest Software Update command in the Help menu.
3. Visit the Notation Users Community Forum.

   Notation Software offers the Notation Users Community Forum, where Notation Composer users can trade tips with each other and the developer, ask questions, report software bugs, and request new features. You can visit the forum directly at:


4. Refer to Frequently Asked Questions (FAQs) or our KnowledgeBase at Notation Software’s web site.

   To visit our FAQ page you can go to http://www.notation.com/FAQs.php

   To find answers in our KnowledgeBase you can go to https://notation.kayako.com/category/1-knowledgebase

5. Send a question or comments to Notation Software using the online form, or via email

   If after exploring the above options your question still remains unanswered, then you can Submit a Question or Comment by visiting our Helpdesk directly at https://notation.kayako.com/conversation/new. You will receive a response within 24 hours, but typically much sooner.

   Alternatively, send your questions or comments via email to: support@notation.com

11.4 Appendix D: Notation Composer License Agreement

The License Agreement is available in English, Deutsch, and Español.

For information about Notation Software Germany GmbH, our Privacy Policy and Disclaimer, please visit our Imprint Page.

License Agreement

English

License Agreement for Notation Software Germany's products

In this document the term “Software” is defined as the Notation Musician or Notation Composer Trial Version software program and all language variants, or the purchased Notation Musician, Notation Composer or Notation Composer BBPlugin Full Version software programs and all language variants. By installing or otherwise using this Software, you agree to be bound by the terms of this License Agreement. If you do not agree to the terms of this License Agreement, you must immediately terminate your use of this Software and you must delete it completely from your computer system (including any backup storage device).

1. Grant of License and Term

The Software is licensed, not transferred or sold, to you by Notation Software Germany GmbH (the term “Notation Software” further used in this document stands for Notation Software Germany GmbH) or its licensed marketing agents, and is protected by German copyright and intellectual property laws, and the laws of other countries under international treaty. The program Band-in-a-Box® (including the logo, music and text incorporated into the program) is owned by PG Music Inc., and is protected by international copyright laws and international treaty provisions. The installation package contains open source software libraries in the form of Dynamic Link Libraries (DLL libraries) and a soundfont file. The LGPL license applies to these libraries and to the soundfont file. The Software uses the ASIO compatible driver software. ASIO is a trademark and software of Steinberg Media Technologies GmbH.
This license agreement remains effective for any potential legal successor of Notation Software Germany GmbH.

The License terminates automatically if you fail to comply with the limitations described herein. On termination, you must destroy any copy (including archived backups) of the Software and its documentation.

### 1.1 Notation Musician and Notation Composer - Trial Version

For the Notation Musician and Notation Composer Trial versions, Notation Software grants you a license to use the Software free of charge for evaluation purposes, for a period of 30 days. If you wish to use Notation Musician or Notation Composer past the trial period, you may purchase a full version of Notation Musician or Notation Composer. (Visit www.notation.com for ordering instructions.)

### 1.2 Notation Musician, Notation Composer and Notation Composer BBPlugin - Full Version

In case you are under 18 years of age and wish to purchase a license of one of our products, please ask your parent or guardian to act as principal.

For the Notation Musician, Notation Composer and Notation Composer BBPlugin Full Versions, Notation Software (and for the BBPlugin PG Music Inc.) grants you a license to use the Software for as long as you want to use the Software. The installation of a license of the Software is limited to one single computer at a time. Computer also stands for a single virtual machine. Any virtual machine requires a separate license. The installation setup is such that multiple users of the same computer can use the Software license. In case the Software needs to be installed on another computer than the original computer (e.g. in case the original computer is broken and a new computer is bought, or the license is given away to somebody else), you can transfer your personal license to a new computer by touching base with Notation Software. You will need to send your name and full address which you used when purchasing the license, the license number, the log file of the setup program and the log file of the Software itself. In addition it is required to precisely describe the reason why you want to port the Software to another computer.

You should send this request from your email address which you used when purchasing the product. Notation Software has prepared a form for that. Both log files are created by the Software automatically and stored on your computer. Details like the location of these log files, where the license number is displayed etc. will be presented by the Software in the case of attempting a new installation. Notation Software will validate your request as soon as possible and reactivate the license for the new computer accordingly. Permanently transferring a license back and forth between different computers is not possible. In this case each computer requires a separate license.

When the license is reactivated for the new computer, the Software needs to be uninstalled from the former computer as described above for the case of non-acceptance of the license agreement. An installation on a new computer is only possible with the originally received Software installation program which you received from Notation Software. There is no limit in the number of consecutive installations on the computer which holds the license, and such reinstallations can be done without a reactivation of the Software by Notation Software.

### 2. Redistribution

#### 2.1 Trial Version of Notation Musician and Notation Composer

You are only allowed to download the Trial Version Setup program from the website of Notation Software www.notation.com. Redistribution of the Trial Version Setup program is not allowed in any form via electronic means (Internet, bulletin boards, shareware distribution libraries, CD-ROMs, etc.). Anyone who installs the Software will be subject to the terms and conditions of this License Agreement.

#### 2.2 Notation Musician/Composer/BBPlugin Full Version
You may transfer your rights under this Agreement to only one (1) other individual or entity such as a corporation, provided that the recipient agrees to the terms of this License Agreement, and provided that you completely destroy any copies (including archives) of the Software and its documentation. The transfer of the license to the new licensee needs to follow the same scenario as for the reactivation described above in section 1.2. Notation Software will re-distribute a new installation program of the Software and reactivate the newly transferred license with the information of the new licensee.

3. Restrictions

You may not reverse engineer, decompile, re-package or disassemble the Software, except and only to the extent that such an activity is expressly permitted by Notation Software in a written form in every respect for applicable law, notwithstanding this limitation. You may not use any copy of Notation Musician Trial or Notation Composer Trial Version in anyway by circumventing the 30-days trial period or other limitations of the trial version. Even in this case you violate the law. The Software will detect possible illegal altered code through a continuous software verification process. The license will terminate if any illegal handling or modification of the Software is detected. The Software will terminate any further execution of the Software. Juridical measures will be initiated accordingly by Notation Software.

4. Support

Notation Software provides support according to the announced lifetime of the products. In case of issues the licensee agrees to send requested log files to Notation Software for further analysis.

5. Privacy Policy

You consent to the privacy and data security policy which can be obtained from Notation Software’s website.

6. No Liability

To the maximum extent permitted by applicable law, Notation Software or PG Music Inc. are not liable for any indirect, special, incidental, or consequential damages, including, but not limited to damages for loss of business, loss of revenue or profit, loss of damaged data or other commercial or economic loss, which arise out of your use or inability to use the Software.

In addition Notation Software is not liable when copyrighted music sheets may be illegally handled.

7. General

When you present or review the Software on a website you must clearly represent to the visitor that Notation Software is the publisher of the Software and that you are not selling the Software. Furthermore you need to indicate that a full license can be obtained from Notation Software’s website www.notation.com.

This Agreement represents the complete agreement concerning this license, and may not be changed except by a signed amendment. If any provision of this Agreement is held to be unenforceable, such a provision shall be reformed only to the extent necessary to make it enforceable and the other provisions shall remain in full force and effect. This Agreement shall be governed by the law of the Federal Republic of Germany. Place of jurisdiction is Landsberg am Lech, Germany. Band-in-a-Box® is a registered trademark of PG Music Inc. Band-in-a-Box® is protected under US Patents 5990407, 8097801, 8581085, and 8680387.

We reserve the right to display advertising on the opening portal of the software.

8. License Agreement is stored

This License Agreement is saved and stored on your computer during the installation process in the Notation Documents directory for your records. No further special saving of this document is necessary.

Notation Software Germany GmbH
Deutsch

Lizenzvereinbarung

Durch Klicken auf 'Ich stimme zu' vor der Installation eines der Produkte von Notation Software Germany GmbH erklären Sie sich damit einverstanden, an alle Punkte dieser Lizenzvereinbarung gebunden zu sein. Stimmen Sie nicht allen Bedingungen ausnahmslos zu, klicken Sie auf 'Stimme ich nicht zu' und dann auf Abbrechen. Der Installationsprozess wird daraufhin beendet.

Lizenzvereinbarung für Produkte von Notation Software Germany

In diesem Dokument steht der Begriff "Software" für die Notation Musician- oder Notation Composer Test-(Trial-) Versionsprogramme sowie entsprechende Sprachvarianten, für gekaufte Voll-Versionsprogramme Notation Musician oder Notation Composer und deren Sprachvarianten. Durch die Installation bzw. anderweitiger Nutzung der Software stimmen Sie zu, dass Sie an diese Lizenzvereinbarung gebunden sind. Sollten Sie dieser Lizenzvereinbarung nicht zustimmen, müssen Sie unmittelbar die Benutzung der Software beenden und die Software komplett von Ihrem Computersystem inklusive aller Sicherungs(Backup-)kopien löschen. Die Löschung muss über die Systemsteuerung des Betriebssystems erfolgen. Ebenso sind sämtliche Installationsprogramme endgültig und nicht mehr korrigierbar zu entfernen.

1. Zur-Verfügungsstellung einer Lizenz


Diese Lizenzvereinbarung behält ihre Gültigkeit auf für einen möglichen Rechtsnachfolger von Notation Software Germany GmbH.

Die Lizenz erlischt automatisch, wenn Sie gegen die Bedingungen, die in dieser Lizenzvereinbarung beschrieben sind, verstoßen. Bei Beendigung der Lizenzgewährung müssen Sie sämtliche Kopien der Software löschen (inklusive Sicherungskopien auf externen Medien sowie entsprechende Dokumentation).

1.1 Notation Musician und Notation Composer – Test-(Trial-) Version

Für die Test-(Trial-)Versionen von Notation Musician und Notation Composer gewährt Ihnen Notation Software eine Lizenz, die Software ohne Gebühren und Kosten für Ihre Bewertung für eine Zeitdauer von 30 Tagen zu nutzen. Wenn Sie darüber hinaus (über die Dauer von 30 Tagen) die Lizenz benutzen möchten, müssen Sie eine Lizenz der Vollversion von Notation Musician oder Notation Composer käuflich erwerben. Bitte weitere Instruktionen für einen Kauf auf der Website www.notation.com einsehen.

1.2 Notation Musician und Notation Composer – Vollversion
Für den Fall, dass Sie unter 18 Jahre alt sind und eine Vollversion erwerben möchten, muss der Erwerb über Ihre Eltern oder Ihren Vormund getätigt werden.


Sie sollten diese Email von der Email Adresse schicken, die Sie beim Erwerb dieser Lizenz verwendet haben. Notation Software hat für diesen Fall ein Formular vorbereitet. Die beiden Log-Dateien werden von der Software automatisch erzeugt und auf dem Computer gespeichert. Details wie z.B. der Ort, wo die Log-Dateien gespeichert sind, wie die Lizenznummer angezeigt wird etc. wird Ihnen die Software anzeigen, wenn eine neue Installation vorgenommen wird. Notation Software wird Ihr Anliegen so schnell wie möglich bewerten und entsprechend die Lizenz für den neuen Computer aktivieren.


2. Weiterverteilung

2.1 Notation Musician und Notation Composer Test-(Trial-)Version


2.2 Notation Musician und Notation Composer Vollversion

Sie können Ihre Rechte unter dieser Lizenzvereinbarung genau an eine (1) andere Person oder Organisation transferieren, vorausgesetzt der Empfänger stimmt diesen Lizenzvereinbarungen zu und vorausgesetzt dass Sie jegliche Kopien der Software inklusive Sicherungskopien der Software sowie jeglicher zusätzlichen Dokumentation vernichten. Der Transfer der Softwarelizenz an einen anderen Lizenznehmer muss nach dem gleichen Verfahren wie die Reaktivierung (oben beschrieben in Abschnitt 1.2) erfolgen. Notation Software wird in einem solchen Fall dem neuen Lizenznehmer ein neues Installationsprogramm zur Verfügung stellen und wird die Lizenz für den neuen Lizenznehmer aktivieren.

3. Einschränkungen

Sie dürfen die Software nicht nachbauen, reverse engineeren, neu-paketieren, de-compilieren oder disassemblieren außer es sei denn, Notation Software gewährt Ihnen schriftlich explizit das Recht zu, dieses

Zur deutschen Softwarevariante gibt es online die Dokumentation in englischer Sprache. Diesem Sachverhalt stimmen Sie zu.

4. Service


5. Haftungsausschluss

Entsprechend maximaler Auslegung nach anwendbaren Gesetzen ist Notation Software nicht haftbar oder verantwortlich zu machen für irgendwelche direkte oder indirekte, spezielle oder zufällige Schäden, weder bezüglich Verlust an Geschäft, Umsatz oder Geschäftsergebnis, weder Verlust oder Beschädigung an Daten oder anderen geschäftlichen Verlusten oder Schäden, die sich aus der Verwendung der Software oder einer fehlerhaften Verwendung der Software ergeben könnten.

Ferner ist Notation Software in keiner Weise haftbar zu machen, sollten die Produkte von Notation Software dazu verwendet werden, illegale, dem Urheberrecht widersprechende, Veränderungen an Musiknoten zu erzielen.

6. Allgemeines


Diese Vereinbarung beinhaltet die komplette Vereinbarung zu dieser Lizenz und darf nicht geändert werden sei denn in Form einer unterschriebenen Zusatzvereinbarung von beiden Seiten. Sollte eine Maßnahme dieser Vereinbarung nicht vollstreckbar sein, darf eine solche Maßnahme nur zu dem Maße ersetzt werden, um die Maßnahme umsetzbar zu machen. Alle anderen Punkte dieser Lizenzvereinbarung bleiben davon unberührt. Angewendet wird das Recht der Bundesrepublik Deutschland. Gerichtsstand ist Landsberg am Lech, Deutschland.

Español

Contrato de licencia

Al hacer clic en "Aceptar" antes de instalar el programa de Notation Software Germany GmbH, declara su conformidad con los términos de este acuerdo. Si no está de acuerdo con todos los términos, haga clic en "No acepto" y, a continuación, en Cancelar. El proceso de instalación finalizará.

Contrato de licencia de productos de Notation Software Germany

En este documento, el término "Software" se define como el programa de software de la versión de prueba de Notation Musician o Notation Composer y todas sus variantes idiomáticas, o el programa de software de la
versión completa de Notation Musician o Notation Composer y todas sus variantes idiomáticas. Al instalar o utilizar el Software declara su conformidad con los términos del presente contrato de licencia. Si no acepta los términos del presente contrato de licencia, deberá finalizar el uso de este Software y borrarlo por completo de su sistema informático (incluida toda copia realizada en cualquier dispositivo de almacenamiento de copia de seguridad).

1. Garantía de la licencia y finalización

Notation Software Germany GmbH o sus agentes comerciales autorizados otorgan una licencia del Software y en ningún caso se entenderá dicha licencia como transmisión ni venta de los derechos de propiedad del mismo que estarán sujetos a la legislación en materia de derechos de propiedad intelectual nacional y a los tratados internacionales aplicables. El paquete de instalación contiene bibliotecas de Software de código abierto en forma de Dynamic Link Libraries (librerías DLL) y un archivo de fuentes de sonido. La licencia LGPL se aplica a estas bibliotecas y al archivo de fuentes de sonido. El Software utiliza la tecnología de controlador ASIO de Steinberg Media Technologies bajo el Contrato de licencia de Steinberg ASIO SDK.

Este acuerdo de licencia permanece vigente en caso de un posible sucesor legal de Notation Software Germany GmbH.

La licencia finalizará automáticamente en caso de incumplimiento de las limitaciones señaladas en el presente documento. A su finalización, debe destruir cualquier copia (incluidas las copias de seguridad archivadas) del Software y de su documentación.

1.1 Notation Musician y Notation Composer - Versión de prueba

Con las versiones de prueba de Notation Musician y Notation Composer, Notation Software le concede una licencia para usar el Software gratis con fines de evaluación durante un período de 30 días. Si quiere usar Notation Musician o Notation Composer después del periodo de prueba, quizá quiera comprar la versión completa de Notation Musician o Notation Composer. (Visite www.notation.com para instrucciones sobre cómo hacer el pedido.)

1.2 Notation Musician y Notation Composer - Versión completa

En caso de que tenga menos de 18 años y quiera comprar una licencia de uno de nuestros productos, pídale a su padre o tutor que actúe como titular.

Con las versiones completas de Notation Musician y Notation Composer, Notation Software le concede una licencia para usar el Software todo el tiempo que quiera usarlo. La instalación del Software está limitada a un solo equipo a la vez. Equipo también es sinónimo de una sola máquina virtual. Cualquier máquina virtual requiere una licencia independiente. La configuración de instalación permite que varios usuarios del mismo equipo puedan usar la licencia de Software. En caso de que haya que instalar el software en otro equipo distinto al original, puede trasladar su licencia personal al nuevo equipo gratis poniéndose en contacto con Notation Software. Tendrá que enviar el nombre y la dirección completa que usó para comprar la licencia, el número de licencia, el archivo del registro del programa de instalación y el archivo de registro del propio Software. Además, se necesita una descripción precisa del motivo por el que quiere trasladar el Software a otro equipo.

Debería enviar esta solicitud desde la dirección de correo electrónico que usó al comprar el producto. Notation Software ha preparado un formulario para ello. El Software crea ambos archivos de registro automáticamente y los guarda en su equipo. Datos como la ubicación de estos archivos de registro, en los que aparece el número de licencia, etc. aparecen en el Software en caso de intentar una nueva instalación. Notation Software aprobará su solicitud en cuanto sea posible y volverá a activar la licencia para el nuevo equipo.

Después de volver a activar la licencia para el nuevo equipo, será necesario desinstalar el Software del equipo antiguo tal y como se indica anteriormente en caso de no aceptar el contrato de licencia. La instalación en el
nuevo equipo solo será posible con el programa de instalación del software recibido originalmente de Notation Software. No existe límite de instalaciones consecutivas en el equipo original, y cada una de las reinstalaciones se puede realizar sin la reactivación del software por parte de Notation Software.

2. Redistribución

2.1 Versión de prueba de Notation Musician y Notation Composer

Solo puede descargar el programa de instalación de la versión de prueba en el sitio web de Notation Software www.notation.com. No se permite la redistribución del programa de configuración de la versión de prueba de ninguna manera ni por medios electrónicos (Internet, tablones de anuncios, bibliotecas de distribución de software compartido, CD-ROM, etc.). Todo el que instale el Software estará sujeto a los términos y condiciones de este contrato de licencia. Usted debe indicar claramente al destinatario que Notation Software es el editor del Software. Además, debe indicar al destinatario que puede comprar una licencia completa en el sitio web de Notation Software, www.notation.com.

2.2 Versión completa de Notation Musician y Notation Composer

Puede transferir los derechos que le otorga este contrato solo a (1) otro individuo o entidad como una empresa, siempre y cuando el destinatario acepte los términos de este contrato de licencia y siempre que destruya por completo cualquier copia (incluidos archivos) del Software y de su documentación. La transferencia de la licencia al nuevo titular debe seguir los mismos pasos que la reactivación descrita anteriormente en la sección 1.2. Notation Software redistribuirá un nuevo programa de instalación del Software y reactivará la licencia recién transferida con la información de la nueva licencia.

3. Restricciones

No puede utilizar técnicas de ingeniería inversa, descompilar o desensamblar el Software, excepto y únicamente en la medida en que ello esté expresamente permitido por Notation Software por escrito y de acuerdo con la ley vigente, independientemente de su limitación. No puede usar ninguna copia de la versión de prueba de Notation Musician o Notation Composer en forma alguna una vez superado el período de prueba de 30 días o cualquier otra limitación de la versión de prueba. Incluso en este caso, infringe la ley. El Software detectará un posible código alterado ilegalmente por medio de un proceso de verificación de Software continuo. La licencia se interrumpirá si se detecta algún uso o modificación ilegal del Software. El Software se interrumpirá si se produce una ejecución posterior del Software. Notation Software iniciará medidas legales en consecuencia.

4. Asistencia

Notation Software ofrece asistencia en función de la vida útil indicada de los productos. La información aquí suministrada Notation Software para un soporte óptimo. En caso de problemas, el titular acepta enviar los archivos de registros solicitados a Notation Software para su posterior análisis por su parte.

5. Ausencia de responsabilidad

Dentro de los límites que permite la ley, Notation Software no será responsable de ningún daño indirecto, especial, accidental o secundario, incluyendo, pero sin limitarse a, daños por pérdida de actividad, pérdida de ingresos o beneficios, pérdida de datos dañados o cualquier otra pérdida comercial o económica que surja de un uso indebido o incapacidad de usar el Software.

Además, Notation Software no es responsable de un posible uso ilegal de partituras musicales con derecho de autor.

6. General
Este contrato representa el acuerdo completo relacionado con esta licencia y no se puede cambiar salvo con una enmienda firmada. Si alguna disposición de este contrato resulta ser no aplicable, dicha disposición deberá ser modificada solo el mínimo necesario para que pueda ser aplicable y las demás disposiciones seguirán teniendo plena vigencia. Este contrato se regirá por las leyes de la República Federal de Alemania. La sede de la jurisdicción es Landsberg am Lech, Alemania.

11.5 Appendix E: 3rd Party Libraries and Acknowledgements

<table>
<thead>
<tr>
<th>Library</th>
<th>License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prof-UIS</td>
<td>purchased license from Foss Software, Inc</td>
</tr>
<tr>
<td>QTHM</td>
<td>purchased license from GipsySoft</td>
</tr>
<tr>
<td>Ultimate Grid</td>
<td>Code Project Open License (CPOL) 1.02</td>
</tr>
<tr>
<td>TinyXML</td>
<td>zlib/libpng License</td>
</tr>
<tr>
<td>Haru PDF</td>
<td>zlib/libpng License</td>
</tr>
<tr>
<td>libfluidsynth(-pl).dll</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>glib</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>portaudio.dll</td>
<td>MIT license</td>
</tr>
<tr>
<td>libsndfile.dll</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>libglib-2.0-0.dll</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>libgthread-2.0-0.dll</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>lame_enc.dll</td>
<td>LGPL v2.1 or later (<a href="http://www.mp3dev.org">www.mp3dev.org</a>)</td>
</tr>
<tr>
<td>libogg.dll</td>
<td>BSD-Style Source License</td>
</tr>
<tr>
<td>libvorbis.dll</td>
<td>BSD-Style Source License</td>
</tr>
<tr>
<td>libFLAC.dll</td>
<td>LGPL v2.1 or later</td>
</tr>
<tr>
<td>Smtp</td>
<td>special license agreement by PJ Naughter (<a href="http://www.naughter.com">www.naughter.com</a>)</td>
</tr>
<tr>
<td>contains QHTM code</td>
<td>QHTM is copyright (c) 1999 Russ Freeman</td>
</tr>
</tbody>
</table>
For Linux and Mac Notation Software uses the concept of WineHQ (www.winehq.org), in particular for Mac we use the Wine package built by Mike Kronenberg (http://winebottler.kronenberg.org/).

The **libs with the LGPL license are built according to the license agreement in separate dll files. In that set-up they are available for distribution in commercial applications like Notation Software products. The source code can be downloaded from the according distributor. All libs are built using the instructions of the distributor.**

---

ASIO is a registered trademark of Steinberg Media Technologies GmbH (www.steinberg.net)

Steinberg ASIO SDL Licensing Agreement signed between Notation Software Germany and Steinberg Media Technologies GmbH on Dec. 3rd, 2018

**Soundfont License**

- TimGm6mb.sf2 LGPL v2.1 or later
- FluidR3Mono_GM. agreement with owners, license included in the package sf3
- MusicXML MusicXML Public License 3.0

The **Band-in-a-Box® plugin for notation composer** is licensed from PG Music, Inc. (www.pgmusic.com).

**Acknowledgements**

Thanks to the open source community for all their work, and that Notation Software Germany GmbH can use the dll libraries under the LGPL license.

Thanks to Steinberg Media Technologies for signing the license agreement so that Notation Software can use the ASIO compatible driver inside of **notation musician** and **notation composer**.

In particular we appreciate the great support from many people which we have received during our development efforts.
Index

- . -
  .musicxml import 82
  .mxl import 82
  .xml import 82

- 8 -
  8va
    Window menu 131

- A -
  acciacatura 376
  accelerando 565
  accent marks
    adding 345
    filtering (selection) of notes based on 540
    tutorial 69
    viewing piano roll notation while editing 516
  accidental
    cautionary 330
    changing pitch of note by changing 312
    courtesy 330
    editing 330
    tutorial 41
  accompaniment 155
  accompaniment - split from melody in same staff 217
  accompaniment, Band-in-a-Box® 672
  acknowledgements 702
  add measure 287
  add mode
    toolbar button 175
  adding
    notes 297
  adding objects
    overview 275
    using palettes 277
  align
    chords 494
    lyrics with notes 465
  Alt key commands 180
  annotations
    dynamic marks 423
    hairpin crescendo marks 427
    overview 421
    pedal marks 443
    slurs 437
    special symbols 431
    text 473
    tutorial 69
    viewing piano roll notation while editing 516, 534
  annotations, show or hide 246
  appoggiatura 376
  arc direction of ties 351
  arpeggios 397
  arranging music
    for your musical group 27
    for your own instrument or voice 27
    MidiNotate Composer as a tool for 26
  arrow
    green playback location marker 135
    green staff focus arrow 142
  arrow key commands 180
  articulations 345
  ASIO 598
  ASIO logo and acknowledgement 703
  ASIO settings 587
  ASIO technology 702
  as-notated
    changing as-notated without changing as-performed 528
    snap as-performed rhythm to 527
  as-notated in Piano Roll 515
  as-performed
    displaying as-performed notes 522
    editing as-performed notes 523
    locking of timing 332
    snap rhythm to as-notated 527
  as-performed in Piano Roll 515
  assignment 658
  association of .mid file names with Notation Composer 88
  attack
    as-performed offset from as-notated time 522
    changing as-notated without changing as-performed 528
    editing as-performed 523
    moving note attack 333
    quantize 527
    snap as-performed to as-notated 527
  attack of note 515
  audio driver setting 587
  audio export 49, 55, 122, 592
  audio export gain control 587
  audio export settings 587
  audio file formats (Composer only) 128
audio levels for export 592
audio parameters 592
audio wave compared to MIDI 692
auto channel 209
automatic accompaniment, Band-in-a-Box® 672
Auto-Save 129

- B -
backup
  manually done 286
  Recover Auto-Saved File 286
  using Auto-Save feature 129
backup Notation Composer 16
backup your installation files 17
balance left and right 212
Band in a Box, chord names 679
Band in a Box, endings 679
Band in a Box, intros 679
Band in a Box, takes 681
Band-in-a-Box, main palette screenshot 672
Band-in-a-Box, Style Picker 675
Band-in-a-Box® plug-in 673
Band-in-a-Box® plug-in, chord names 673
Band-in-a-Box® plug-in, endings 673
Band-in-a-Box® plug-in, styles 673
Band-in-a-Box® plug-in, multiple takes 673
Band-in-a-Box® plug-in, takes 673
Band-in-a-Box®, Quickstart 672
bank 658
bank (see MIDI bank) 660
barline
  adding barline in middle of measure 289
  adjusting for metronomeless files 100, 101, 103, 104
  edit barline style 410
  join measures 290
  move 265
  rebar 100, 101, 103, 104
  remove 290
  repeat marks 411
  shifting multiple barlines to right 295
types 410
bars
  fixed number of bars per line 259
beams
  editing 348
beat ruler
  for adding notes 303
beep sound
  removing 139
bmp export 52
bookmarks
  in score for editing references 497
bow marks (string) 345
brace or bracket
  name displayed in left margin 203
  braces and brackets 400
  named displayed in left margin 202
bracketed chord names 494
breaks
  line and page breaks 259
  line breaks 259
browsing the Internet for MIDI files
  initial web page 90
  Notation Composer's built-in Internet browser 89
buffer count 587, 590
buffer size 587, 590
buffers 598
buy Notation Composer 25

- C -
cable MIDI 611
CakeWalk Instrument Definition (INS) file 643
calibrate
  MIDI device 621
CD-ROM
  audio on CD-ROM compared to MIDI 692
  transcription to music 79
channel
  assignment to track 209
  auto channel assignment 209
  tune MIDI device to 655
channel volume 568
channel, MIDI 209
chart
  chord chart 228
chord
  chord chart 228
  combining separate notes into 344
chord builder 483, 485
Chord menu 495
  Chord Name Display Styles 495
  Show Chord Names 495
  Transcribe Chord Names 490
chord name transcription options 490
chord name transcription settings 490
chord names 483
  add 483
chord names 483
adding and editing 483
advancing to the next or previous 494
builder 483
copy 483, 486
default styles 494
edit 485
enharmonic spelling 489
ter 485
entering by typing 484
fake book preparation 228
formatting 494
hear 483, 485
hide 246
introduction 482
moving 494
paste 483, 486
show/hide 456
transcribe 490
transpose 496
chord names delete 495
chord names red 494
chord names show or hide 495
chord names verification for MIDI export 494
chord names with Band in a Box 679
chord names with brackets 494
chord names, analyzing a file for 490
chord names, Band-in-a-Box® 672
chord names, Band-in-a-Box® plug-in 673
Chord names, Band-in-a-Box® plug-in 673
Chrome 89
clearing region of score 283
clefs 404
clipboard 467
copy cut paste 282
creating new song from 284
importing lyrics from a text file via 467
lyrics 463, 467
clone
track 210
clone staff 210
color customization
overall color theme 167
playback highlighting 167
commands 180
Alt and Ctrl key commands 180
arrow key commands 180
learning 180
Quick ("Q") commands 180
remote from MIDI keyboard 163
shortcuts 685
commands from MIDI instrument 184
comparison of features
Notation Musician and Notation Composer 29
composer name
displayed as lyrics 471
composing 28
computer keyboard
entering notes using only 314
conductor's score
formatting 236
reduction to piano score 232
configuration of MIDI devices
copying 670
creating 670
deleting 671
managing alternative MIDI setups 669
re-initializing 670
renaming 670
saving 669
selecting 669
connecting devices to ports 639
context-sensitive help (F1)
for buttons 15
for menus 170
continuously on note 144
controller (MIDI) data 583
controller MIDI (see keyboard) 499
convert staccato performance to accented notes 345
copy and paste 282
copy and paste (see clipboard)
loop 282
copyright notices
displayed as lyrics 471
copyright of Notation Composer 694
courtesy accidental 330
crackle 590, 598
crackling audio 587
creating a new song
formatting of new song 252
from clipboard 284
tutorial 60
crescendo
editing loudness of notes 535
graphical editing of 568
hairpin crescendo marks 427
Ctrl drag mouse 280
Ctrl key commands 180
custom part preparation 230
cut note duration 305
- D -

D.C. and D.S. 414

dash character in lyrics 462
delay of playback 648
  on acoustical/MIDI player piano 648
  on some MIDI software synthesizers 648
delete staff/staves 201
deleting objects 275
deleting region of score 283

Deutsch lisenz 697

device 646
  adding to MIDI device configuration 623
  bank (MIDI) 661
  calibrate 621
  configuration 633
  connecting to port 639
  default playback device 609, 652
delay 621
echo 615
  explained 630
  General MIDI (GM) 653
  latency 621
  managing 640
  MIDI Thru 627
  patch (MIDI program) names 619
  properties 648
  quick setup 20
  removing 647
  renaming 648
  testing playback on 637
trouble-shooting 602
tune to MIDI channels 655
device delay 622
device description (importing and exporting)
  importing from a MIDI Device Description (MDD) file 641
  importing from a CakeWalk INS file 643
device renaming 630
different machine, transfer license 25
directory (program folder) for Notation Composer 19
disc jockey feature (playlist) 152
documentation
  printed 16
  using this 15
dotted note value 301
double note durations 365
downloading MIDI files and zip files 89
drag mouse
  note pitch 327

drivers 598
drum 658
  assignment of staff to drum instrument 204
  editing of notes 355
  loop 282
  preparation of part (tips) 233
  special percussion symbols 233
  split drum staff into single drum instrument staves 215
drum kit note names
  importing drum note names 619
duration 523
duration of note 515
duration of notes
  changing 335
  changing as-notated without changing as-performed 528
  double note durations 365
  editing as-performed 523
  new notes 301
  note duration adjustment table 530
  quantize 527
  scale note durations 365
  sequential note entry mode 305
  snap as-performed to as-notated 527
dynamic mark association for MusicXML export 423
dynamic markings and MusicXML 69
dynamic marks 423
  tutorial 69

- E -

Easy Notes 227
  in a part 251
  in one or more staff/staves 251
echo 615

Edit menu
  Clear 283
  Clear Undo History 284
  Copy 282
  Paste 282
  Paste Lyrics 467
  Paste Special 282
  Redo 284
  Undo 284

editing the score in large regions 274
education (music)
  easy notes part 227
  practicing music 154
  preparing music lessons 27
  self-study and enjoyment 26
  elapsed time during playback 172
end of song toolbar button 172
endings
  editing 412
  ignoring endings during playback 143
endings in Band in a Box 679
endings, Band-in-a-Box® plug-in 673
English license 694
enharmonic spelling 41, 330
ENTER key
to toggle add and select mode 175
erase 513
eraser 513
eraser-graphical 548
Español license 699
export
  Karaoke file 121
  MIDI file 121
export .wav 55
export audio 49, 55, 122, 592
export audio settings 587
export FLAC 122
export image 49
export Karaoke 122
export MIDI 49, 122
export MP3 122
export MusicXML 49, 55
export MusicXML (Composer only) 122
export OGG 122
export PDF 49, 52, 122
export WAV 122
export, bmp 52
export, gif 52
export, image 52
export, jpg 52
export, png 52
external versus internal port 639
extract part from score
  easy notes part 227
  fake book lead sheet 228
  Karaoke part 227
  vocal part 227
  with customized options 230

- F -

F1 help
  for buttons 15
  for menus 170
fake book preparation 228
fast forward playback 137
feature comparison

Notation Musician and Notation Composer 29
fermata 345
file
  automatic backup and recovery (Auto-Save) 129
  creating new 116
  opening 34, 80
  saving 121
  viewing multiple songs at a time 131
file export Karaoke 51
file export MIDI 51
file formats 79
  alternative ways to share your music with others 128
  Karaoke (.kar) 79
  MIDI (.mid) 79
  MidiNotate (.not) 79
  MP3 79
  MusicXML 79
  wave (.wav) 79
File menu
  Auto-Save Options 129
  Browse Internet for MIDI Files 89
  New 116
  New Song from Clipboard 284
  Open 130
  Print 132
  Print Parts 224
  Recover Auto-Saved File 129
  Save As 121
  Set Auto-Save Frequency 286
  Song Title and Authors 121
filtering
  of accompaniment notes 540
  of melody notes 540
  of notes based on accent mark 540
  of upper or lower voice notes 540
  silent notes 326
  small rests 372
find MIDI files 89
fine (end of score) 414
Firefox 89
flac (Composer only) 128
FLAC export 122
flag on note stem 348
fluidsynth 702
focus during playback 142
fonts
  for individual text objects 454
  international characters 457
  mixing music symbols and normal text 474
fonts
overall font size 240
setting overall font size 257
setting size and face for types of objects 243
fonts, MusicXML import options 82
footer (page) 239, 476, 477, 480
Format menu
Collapse Multiple Measure Rests 373
Copy Formatting to Other Parts 254
Font Size and Spacing 240
Format Part Using Template 252
Hide Empty Staves 250
Instrument Names Display Options 248
Page Setup 239
Re-Transcribe 98
Show or Hide Instrument Names 248
Show or Hide Types of Objects 246
Text Fonts 243
Transcribe Chord Names 490
formatting
copying format of one part to another 254
default 270
default horizontal and vertical spacing 266
font size 257
hide instrument names 248
hide types of annotations 246
lyrics alignment with notes 465
margins of page 237
measure numbers 296
move barline 265
move measure to previous system 261
move system to previous page 264
overview 236
page breaks and system breaks 259
page header and footer 480
page layout 254, 256
page numbers 237
page size and orientation 237
page text 481
template 252
title page 480
vertical spacing between individual staves and systems 257
forum (Notation Users Community Forum) 12
free player
Notation Player for viewing, printing, and playing Notation .not files 128
free text
adding and editing 473
introduction 472
mixing music symbols and normal text 474
vertically aligning 476
freeze page layout 269
- G -
gain control 587
General MIDI (GM) 653
generate accompaniment, Band-in-a-Box® 672
generate accompaniment, Band-in-a-Box® plug-in 673
getting started 14
gif export 52
glissandos 441
adding 441
editing 442
go to next or previous page 193
rehearsal mark 194
go to measure 193
go to page 193
grace notes
adding 376
borrow time from left or right 376
converting short notes to 381
converting to written-out short notes 385
editing performance of 384
overview 375
slash on stem 380
viewing as written-out short notes 379
graph erasing 548
Graph menu 548
graphical editing 544
controller (MIDI) data 583
left to right pan 573
note loudness (velocity vectors) 535
overview 544
overview of viewing and editing MIDI data 513
piano roll notation 515
pitch bend 576
show/hide graph 544
sustain pedal control 581
tempo 560
track volume 568
tutorial 548
GraphOverNotes
graphical editing 544
tutorial 548
green arrow, horizontal 142
green arrows 135
grid
beat ruler 303
GS Wavetable activation 20
GS Wavetable Synth 20
GTHM 702
guitar 235
  chord names 483
  harmonic mark 345
  pitch bend 576
  preparation of part (tips) 235
  tablature 235

- H -
hairpin crescendo marks 427
harmonic mark 345
Haru PDF 702
header (page) 239, 476, 477, 480
help
  for buttons 15
  for menus 170
hide
  chord names 246, 456
  empty staves 250
  instrument names 248
  lyrics 246, 456
  lyrics individually 471
  parts of the Composer window 169
  rehearsal marks 246
  rest 373
  track controls 185
highlighting active notes and lyrics 143
horizontal spacing 242, 257
horizontal spacing between notes 373
hyphen in lyrics 462

- I -
image export 49, 52
import MusicXML filetypes 82
importing a device description 619
  from a CakeWalk INS file 643
  from a Notation Software MDD file 641
importing MIDI or Karaoke file 80
INS Cakewalk Instrument Definition file 643
Ins(ert) key for adding notes 314
insert
  measures from clipboard 282
insert measure 287
install, Windows 16
installing Notation Composer 16
instrument 658
  instrument name
    changing staff name 202
  displayed left of brace or bracket 203
  formatting options 248
  importing 619
  long versus short instrument names 248
  show and hide 248
  instrument settings 137
  instrument sound (MIDI patch)
    assignment to staff 204
    for recording 505
    mid-track sound changes 542
    show/hide instrument sound change marks 246
  instrument sound selection 188
  instrument transposition (key) 362
  internal versus external port 639
  international characters 457
  internet 89
  Internet Explorer 89
  internet MIDI 89
  introduction to Notation Composer 14
  intros in Band in a Box 679
  intros, Band-in-a-Box® plug-in 673

- J -
jamming along with a song 155
jazz
  swing rhythm 342
join measures 290
jpg export 52
jukebox 149, 152
jump
  to another location during playback 142

- K -
Karaoke export 122
Karaoke file 470
  .kar file name association with Notation Composer 88
  export 121
  opening 80
  what is a 79
Karaoke part
  part extraction from score 227
  preparation of (tips) 232
karaoke export 51
Keep Measure With Previous command 261
Keep System With Previous command 264
key of instrument 362
key signature 405
keyboard
keyboard
  add both right- and left-hand staves in one step 198
  MIDI controller 316, 318, 319
  recording from 499
  two-hand recording 509
  using music keyboard for entering notes by recording 316
  using music keyboard for entering notes via step-time recording 318, 319
keyboard (computer) commands 180
  arrow key commands 180
  Ctrl and Alt key commands 180
  palette selection 180
  Quick ("Q") commands 180
keyboard (MIDI) 20
  accompaniment 155
  adding to MIDI device configuration 623
  delay 621
  echo 615
  practicing with your MIDI keyboard or MIDI instrument 161
  remote control of MidiNotate 163
  setup 615
keyboard part
  preparation of (tips) 230
  reduction of score 232
  split single staff into right- and left-hand staves 214

- L -

latitude 622
  calibrate 621
latency, keep low 590
latency, recording 20
Layout menu
  Increase or Decrease Font Size 257
  Keep Measure With Previous 261
  Keep System With Previous 264
  Page Break 259
  System Break 259
layout of page (see page layout) 254, 256
lead sheet preparation 228
lead-in beats (see pickup beats) 157
legato 523
lessons
  using Notation Composer to prepare 27
license, Spanish 699
license agreement 694
license transfer 25
license, English 694
license, English 694
line break 259, 261
  freezing all in part or score 269
lines 441
  adding 441
  deleting 442
  editing 442
location
  changing as-notated without changing
  as-performed 528
  editing as-performed 523
  moving note attack 333
lock
  note performance 332
loop
  paste 282
  playing a list of songs (or just one) in a practice 157
  using rehearsal marks 160
loudness of notes
  changing 535
  of new notes 313
loudness of notes, viewing 534
lyrics 462
  adding (tutorial) 47
  adding and editing 460
  advancing to next or previous 461
  alignment with notes 465
  color used for highlighting during playback 167
  copy and paste 463, 467
  copyright notices, composer, and arranger name
displayed as 471
  hide all lyrics 246, 471
  hide individual lyrics 471
  highlighting during playback 143
  hyphen in 462
  international characters 457
  introduction 459
  melisma 462
  show/hide 456
  verses 461
  verses and repeats 415
lyrics using an external text editor 467

- M -

Mac installation 16
manual
  in Adobe Acrobat PDF file format 16
margins 237
measure
  add 287
measure
delete 288
editing 287
fixed number of measures per line 259
join by removing barline 290
move to previous system 261
numbers 296
repeat marks 411
split with barline 289
upbeat 291
viewing range of measures 192
Measure menu
Add Measure 287
Delete Measures 288
Insert Measure 287
Measure Numbers 296
Repeat Instructions 415
View Measures 192
measure number
specifying frequency of display 296
measure, go to 193
melisma 462
melody 217
filtering melody or accompaniment notes 540
melody - split from accompaniment in same staff
split staff into melody and accompaniment 217
menu, Alt+letter shortcut 170
menu, keyboard shortcuts 170
menus
customizing color of 167
overview 170
merge staves 211
meter 408
scale 365
metronome 139
pickup beats 503
recording 139
setting and auditing metronome sound 139
toolbar button 173
turning on and off 173
metronomeless 100, 101, 103, 104, 503
Microsoft Internet Explorer 89
MIDI
graphs of MIDI data 544
overview of viewing and editing MIDI data 513
MIDI bank
assignment to staff 204
bank selection method 648
importing bank and patch names 619
mid-track bank selection 542
MIDI cable
versus USB cable 611
MIDI cc 544
MIDI channel 209
assignment to track 209
auto channel assignment 209
tune device to 655
MIDI controller data
converting MIDI sustain pedal events to pedal marks 446
converting pedal marks to MIDI sustain pedal events 447
ingiding of 583
MIDI device 658
MIDI device (see "device") 568
MIDI device configuration
copying 670
creating 670
deleting 671
introduction 669
managing alternative MIDI setups 669
re-initializing 670
renaming 670
saving 669
selecting 669
MIDI device configuration window
example configurations 633
menus 637
overview 630
MIDI Device Description (MDD) File
exporting 657
MIDI device, default 652
MIDI export 49, 51, 122
MIDI file
.midi file name association with Notation Composer 98
export 121
opening 80
what is a 79
MIDI file search 89
MIDI keyboard 20
echo 615
recording from 499
remote control of MidiNotate 163
setup 615
MIDI note velocity
default assigned to new notes 313
editing 535
versus volume level 568
MIDI note-on and note-off events
editing 523
viewing piano roll notation of 515
<table>
<thead>
<tr>
<th>MIDI port</th>
<th>638</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIDI program (patch)</td>
<td></td>
</tr>
<tr>
<td>assignment to staff</td>
<td>204</td>
</tr>
<tr>
<td>importing patch names</td>
<td>619</td>
</tr>
<tr>
<td>initialization of patch names for a device</td>
<td>593</td>
</tr>
<tr>
<td>mid-track change in</td>
<td>542</td>
</tr>
<tr>
<td>MIDI thru</td>
<td>627</td>
</tr>
<tr>
<td>mistakes</td>
<td></td>
</tr>
<tr>
<td>cleaning up recording</td>
<td>511</td>
</tr>
<tr>
<td>modulation</td>
<td>583</td>
</tr>
<tr>
<td>mordents</td>
<td>395</td>
</tr>
<tr>
<td>mouse</td>
<td></td>
</tr>
<tr>
<td>adding notes with</td>
<td>299</td>
</tr>
<tr>
<td>Ctrl drag</td>
<td>280</td>
</tr>
<tr>
<td>double right click</td>
<td>175</td>
</tr>
<tr>
<td>drag note pitch</td>
<td>327</td>
</tr>
<tr>
<td>right click</td>
<td>175</td>
</tr>
<tr>
<td>with Shift key</td>
<td>278</td>
</tr>
<tr>
<td>move</td>
<td></td>
</tr>
<tr>
<td>barline</td>
<td>265</td>
</tr>
<tr>
<td>free text and page text</td>
<td>455</td>
</tr>
<tr>
<td>measure to previous system</td>
<td>265</td>
</tr>
<tr>
<td>notes between staves</td>
<td>219</td>
</tr>
<tr>
<td>palette</td>
<td>177</td>
</tr>
<tr>
<td>staves or systems up or down on page</td>
<td>266</td>
</tr>
<tr>
<td>system to previous page</td>
<td>265</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>89</td>
</tr>
<tr>
<td>MP3</td>
<td></td>
</tr>
<tr>
<td>compared to MIDI</td>
<td>692</td>
</tr>
<tr>
<td>file format</td>
<td>79</td>
</tr>
<tr>
<td>mp3 (Composer only)</td>
<td>128</td>
</tr>
<tr>
<td>MP3 export</td>
<td>122</td>
</tr>
<tr>
<td>multiple files, open all at once</td>
<td>85</td>
</tr>
<tr>
<td>multiple measure editing</td>
<td>274</td>
</tr>
<tr>
<td>multiple measure rests</td>
<td>373</td>
</tr>
<tr>
<td>multiple object selection</td>
<td>278</td>
</tr>
<tr>
<td>multiple takes in Band in a Box</td>
<td>681</td>
</tr>
<tr>
<td>multiple takes, Band-in-a-Box® plug-in</td>
<td>673</td>
</tr>
<tr>
<td>multiple verses of lyrics</td>
<td>461</td>
</tr>
<tr>
<td>music keyboard</td>
<td></td>
</tr>
<tr>
<td>for entering notes by recording</td>
<td>316</td>
</tr>
<tr>
<td>for entering notes via step-time recording</td>
<td>318, 319</td>
</tr>
<tr>
<td>MIDI controller</td>
<td>316, 318, 319</td>
</tr>
<tr>
<td>MusicXML (Composer only)</td>
<td>128</td>
</tr>
<tr>
<td>MusicXML and dynamic mark association</td>
<td>423</td>
</tr>
<tr>
<td>MusicXML export</td>
<td>49, 55</td>
</tr>
<tr>
<td>MusicXML export (Composer only)</td>
<td>122</td>
</tr>
<tr>
<td>MusicXML file type</td>
<td>79</td>
</tr>
<tr>
<td>MusicXML import</td>
<td>82</td>
</tr>
<tr>
<td>MusicXML, export of dynamic markings</td>
<td>69</td>
</tr>
<tr>
<td>MusicXML, fonts</td>
<td>82</td>
</tr>
<tr>
<td>MusicXML, open</td>
<td>82</td>
</tr>
<tr>
<td>mute a staff</td>
<td>185</td>
</tr>
<tr>
<td>mute staff</td>
<td>186</td>
</tr>
<tr>
<td>track control button</td>
<td>147</td>
</tr>
</tbody>
</table>

- N -

| Netscape | 89 |
| new in version 3 | 12 |
| new machine, transfer license | 25 |
| new song |     |
| creating a | 116 |
| creating from clipboard | 284 |
| formatting of | 252 |
| tutorial | 60 |
| next page | 193 |
| Notation (.not) file |     |
| file format | 79 |
| open | 130 |
| save | 121 |
| Notation Musician and Composer |     |
| feature comparison | 29 |
| Notation Software (the company) |     |
| Notation Users Community Forum | 12 |
| Notation Software Synth | 587 |
| Notation Software Synth default | 20 |
| note |     |
| name letters in noteheads | 251 |
| note durations - change all | 365 |
| note letters in noteheads | 251 |
| Note menu |     |
| Add Note Duration submenu | 301 |
| Combine Chord | 344 |
| Convert Selection of Notes to Region | 280 |
| Crescendo Across Selected Notes | 535 |
| Enharmonic Spelling | 330 |
| Loudness submenu | 535 |
| Notehead Shape submenu | 356 |
| Pitch submenu | 312 |
| Remove Silent Notes | 326 |
| Save Loudness for New Notes | 313 |
| Staff Assignment submenu | 219 |
| Triplets and Quintuplets | 338 |
| Voice submenu | 354 |
| note names for drum kits | 663 |
| notehead |     |
| shape | 356 |
| shared between upper and lower voice | 354 |
| with both stem up and stem down | 309 |
| notes | 345 |
Index

notes 345
accent marks 345
accidental 330
add (tutorial) 62
adding (alternative methods) 297
adding by recording live with MIDI keyboard 316
adding using mouse point-and-click 299
adding using the mouse 298
advancing selection to next or previous note 325
articulations 345
as-performed duration of new notes 530
automatically playing when selected 326
beams 348
combining separate notes into chord 344
deleting 326
displaying as-performed notes 522
double note durations 365
drum 355
duration 301, 371
duration adjustment table 530
editing (introduction) 323
editing as-performed notes 523
enharmonic spelling 330
entering notes using only computer keyboard 314
filtering 540
flags 348
grace notes 385
location 333
loudness 535
loudness of new notes 313
moving attack 333
moving between staves 219
notehead shape 356
ornaments 386
percussion 355
performance of (overview) 515
pitch bend 576
pitch changing 327
pitch of new notes 312
removing silent notes 326
scale note durations 365
selecting 324
sequential note entry mode 305
stem direction 309
step-time recording 500
ties 351
transposing 358
using rests to erase notes 371
voice 309

NoteSoft file saving 50

- O -
object
adding 277
properties 279
selecting 278
terminology 274
Object menu 170
octaves
8va 328
change pitch of note by 327
offset of as-performed from as-notated note rhythm 522
ogg (Composer only) 128
OGG export 122
open multiple files at once 85
open source libraries 702
opening a MIDI or Karaoke file
automatically launching Notation Composer 88
opening one already on your system 80
openSUSE installation 16
order of staves 218
organ
add both right- and left-hand staves in one step 198
orientation of page
portrait and landscape 237
ornaments
adding 387
arpeggios 397
converting to written-out performances 389
converting written-out performances to 388
deleting 390
grace notes 375
mordents 395
transcription of 94
tremelos 398
trills 391
turns 393
viewing the written-out performance of 390
overlapping notes
transcription option to remove 94

- P -
page
next and previous page toolbar button 172
start and end of song toolbar button 172
page break 259, 264
freezing all in part or score 269
Notation Composer 3 User Guide

page layout 254, 256
font size 257
header and footer 480
horizontal spacing 257
move barlines within a system 265
move measure to the previous system 261
move system to the previous page 264
page breaks and system breaks 259
page numbers 480
restore default pagination 270
song title 480
vertical spacing between staves and systems 266

page number
as page text 480
changing the first 237
odd-numbered pages on right or left 237

page numbering 477
page scroller 193
page setup 237, 239
page skip to last 193
page slider 193
page text
adding and editing 477
aligning 480
assignment to multiple pages 478
introduction 476
specified in templates 481
standard page text types 480

page turns
advance timing of 143
page view 184
toolbar button 174
page, go to 193
pagination 270
freeze 269

palette
Rebar 103, 104

palettes
adding objects using 277
computer keyboard commands for 180
customizing color of 167
editing objects using 279
hierarchy of 177
moving 177
piano roll palette buttons explained 517

pan left and right
graphical editing of 573
initial staff setting of 212

paper size 237
parentheses

around notes 232
courtesy accidental 330

customized part options 230
delete 224
drum (preparation tips) 233
easy notes part (preparation of) 227
fake book lead sheet (preparation of) 228
format 330
freezing layout of 269
guitar (preparation tips) 235
hide empty staves 250
layout of 254, 256
name of 223
piano (preparation tips) 230
print 224
select 222
sing-along part (preparation of) 227
transpose 330
tutorial 56
versus staff (terminology) 195
vocal (preparation tips) 232

part creation wizard 225

Part menu
Delete Part 224
Display Easy Notes for Selected Staves 251
Display or Define Part 223
Edit Part Name 223
Part Preparation Wizard 230
Prepare Easy-Notes Part 227
Prepare Fake Book Lead Sheet 228
Prepare Piano Reduction 232
Prepare Sing-Along Part 227
Select Part 222

paste 282
patch 658

patch (see MIDI program)
assignment to staff 204
initialization of patch names for a device 593
mid-track change 542
patch names for device 662

pause playback 172

PDF
printable version of documentation 16
saving a part or score as a PDF file 128
PDF export 49, 52, 122

pedal control 581
Index

pedal marks
  converting MIDI sustain pedal events to 446
  converting to pedal performance 447
  editing 443

percussion
  drum kits 663
  editing of notes 355
  preparation of part (tips) 233
  special symbols 233
  split drum staff into individual drum instrument staves 215

Perform menu
  Hear Metronome 139
  Ignore Repeats and Endings 143
  Metronome Setup 173
  Pickup Beats 173
  Playback Page Turns 143
  Practice Setup 157
  Set Play-Along Sound 155
  Start Playback 136
  Start Practice 159
  Stop Playback 136
  Turn Off Stuck Notes 144
  Volume 148

performance (MIDI)
  overview of viewing and editing MIDI data 513
  performance sound, GraphOverNotes 544

phrase marks (see slurs) 434

piano part
  add both right- and left-hand staves in one step 198
  preparation of (tips) 230
  reduction of score 232
  split single staff into right- and left-hand staves 214

piano reduction of band/orchestra score 232

piano roll
  displaying as-performed attack and release offsets 522
  explained 515
  historical reference 692
  piano roll palette buttons explained 517
  tutorial 74
  viewing it while annotating a score 516

pickup beats
  creating upbeat measure 291
  shifting barlines to account for 295
  used in practice loops 157
  used in recording 503

pitch
  edit 327
  letters in noteheads 251
  of new notes 312
  transpose 360

pitch bend 576

pitch name letters in noteheads 251

Pitch-to-command 163, 184

pizzicata mark 345

play-along 186
  sound selection 155
  trouble-shooting 602

playback 360
  automatic playing of notes when selected 326
  changing position during playback 135
  default playback device 652
  fast forward 137
  highlighting active notes and lyrics 143
  highlighting colors 167
  indicator in quick MIDI setup window 593
  jamming with your MIDI instrument during 155
  mute staff 147
  overview 134
  page turns during 143
  pause 172
  playback marker 142
  playing a list of songs 152
  playing multiple songs (or just one) in a look 152
  repeats 143
  scrolling during 190
  solo staff 147
  song time indicator 172
  staff focus during playback 142
  start and stop 136
  start at green playback location marker 135
  stuck notes 144
  tempo changes during 145
  testing 637
  toolbar buttons 172
  tutorial 36
  volume level changes during 148

player
  free Notation Player for viewing, printing, and playing Notation .not files 128

playlist
  .ply file format 154
  adding songs to 150
  changing order of songs in 150
  moving playlists and their song files 154
  overview 149
  playing songs in 152
  tutorial 38
playlist
   viewing songs in 150
png export 52
point size
   overall point size for score 257
   versus zoom 191
point-and-click method of adding notes 299
port
   connecting to external device 639
   disconnecting from external device 639
   explained 630
   internal versus external port 639
   managing 638
portamento 441
portaudio 702
practicing options
   loops (repeats) 157
   overview 26
   practicing while singing or playing a non-MIDI instrument 160
   practicing with your MIDI keyboard or MIDI instrument 161
   rehearsal marks 497
   starting and stopping a practice session 159
previous page 193
print preview 184
printing
   page setup 237
   parts 132, 224
   preview 184
   range of measures 132
   score 132
printing this documentation 16
Prof-UIS 702
program (see MIDI program) 662
program folder (directory) for Notation Composer 19
punch-in recording 508
purchase Notation Composer 25
purpose of Notation Composer 25

- R -
range of measures
   selecting 280
   viewing 192
razor for cutting note duration 305
rebar 100, 101, 103, 104
   barline correction 100, 101, 103, 104
   details 104
   finalize 115
   keep changes 115
   overview 103
   palette 103, 104
   review adjustments 114
rebar lines, edit 111
rebar lines, make barlines editable 105
rebar lines, record 105
rebar, lines 105
recording
   cleaning up 511
   indicator in MIDI Device Configuration Window 637
   indicator in Quick MIDI Setup Window 593
   instrument sound 505
   introduction to real-time recording from music keyboard 499
   metronome 139
   no metronome 100, 101, 103, 104
   pickup beats 503
   punch-in (in a region) 508
   real-time as a way to enter notes 316
   recovery from interrupted 511
   setting up your MIDI keyboard 499
   starting and stopping 507
   step-time 318, 319, 500
   takes 510
tempo 501
transcription options for 506
trouble-shooting 602
two-hand (keyboard) 509
   versus real-time 500
recording, no metronome 503
recovery
   from interrupted recording 511
   from interrupted song file editing 129, 286
redo
toolbar button 176
redownload 16
redownload 16
reduction of score into piano part 232
region 274
   convert to selection of entire staff 280

- Q -
q commands (keyboard shortcuts) 180
quantization
   snap as-performed to as-notated rhythm 527
tutorial 74
Quick ("Q") keyboard commands 180
quick start tutorial 34
quintuplets 301, 338
QWERTY keyboard
   entering notes using only 314
region 274
clean up rests and overlapping notes 372
clean up rests and overlapping notes defined 280
region selection mode 175
selecting 280
region menu
   clean up rests and overlapping notes 372
   convert region to selection of rests 373
   convert selection to entire staff 280
   filter notes according to selection criteria 540
   filter notes in current region 540
   remove silent notes 326
rehearsal marks
   adding and editing 497
   advancing to next or previous 160
go to 194
   introduction 496
   show/hide 246
   used as bookmarks 497
   used in practice loops 497
reinstall notation composer 16
release
   as-performed offset from as-notated time 522
   changing as-notated without changing as-performed 528
   editing as-performed 523
   note duration adjustment table 530
   snap as-performed to as-notated 527
release of note 515
remote control from MIDI instrument 184
remote control of MidiNotate from MIDI keyboard 163
repeated loop
   paste 282
repeats
   D.C. and D.S. 414
   endings 412
   ignoring repeats during playback 143
   instructions (manual control of) 415
   practice loops 160
   repeat marks 411
   repetition marks 411
   segno 414
resize song window 191
restore from program interruption 286
rests
   deleting 368
   dividing and combining 368
   eliminating small rests 372
   hiding 373
   multiple measure rests 373
overview 367
selecting whole measure rest 373
transcription option 94
using rests to erase notes 371
voice 370
re-transcribe 98
rewind 135
rhythm
   editing notes 335
   rhythm style used in transcription 94
   swing 342
right and left hand split of single keyboard staff 214
right mouse click 175
ruler
   for adding notes 303
-S-
sample rate selection 587
save as .not file 50
save file tutorial 49
scale note durations 365
score
   formatting 236
   freeze layout of 269
   layout of 254, 256
   part 195
   reduction to piano part 232
scroll window
   automatic scrolling during playback 190
scrolling pages 190
scrolling the window 190
search for MIDIs 89
searching the Internet for MIDI files
   initial web page 90
   secondary web page 90
segno
   used in performance of repeats 415
select
   advancing selection to next or previous note 325
   automatically playing notes when selected 326
   entire staff 188
   notes 324
   region 280
   selecting objects 278
   select a staff 185
select mode
   toolbar button 175
selecting whole measure rest 373
sequential notes from two-note chords 217
setup 586
MIDI equipment 586
soundcard 586
uninstalling 24
Setup menu
  Associate with .MID Files 88
  Enable Pitch-to-Command 163
  Set Up Pitch-to-Command 163
  Transcription Options 94
setup Notation Composer 16
shape of notehead 356
share your music files with others 128
shared notehead between upper and lower voice 354
shift notes between staves 219
shortcuts
  keyboard 180
  list of 685
  remote control of MidiNotate from your music keyboard 163
show
  graphs of MIDI data 544
  piano roll 515, 516
show or hide annotations 246
sing-along part 227
single-note instrument lines 217
slash on stem of grace note 380
slurs
  adding 435
  deleting 437
  length of 437
  overview 434
  shape of 437
  ties are not the same thing as 434
  tutorial 69
snap as-performed to as-notated rhythm 527
software
  free updates for Composer 23
software libraries 702
software synthesizer
  delay in playback 621
  setup 619
solo a staff 147, 185
solo instrument
  correcting double-played notes 217
solo notes 217
solo staff 186
song
  copyright notice 121
  creating new 116
creating your own templates 120
saving 121
terminology 195
title 239
viewing multiple songs at a time 131
song time indicator 172
sound
  for recording 505
  no sound heard 598
  overview of viewing and editing MIDI data 513
  selection of instrument sound for staff 188
sound changes 542
sound module 20
  configuring 623
sound names, import 593
soundcard (see device) 20
soundfont, selection 587
spacing
  creating horizontal space with hidden rests 373
  default horizontal spacing 257
  default vertical spacing between staves and systems 242
  vertical spacing between individual staves and systems 266
Spanish license 699
spelling (enharmonic) 330
split
  keyboard staff into right and left hand staves 214
split drum staff 215
split measure 289
split staff into melody and accompaniment 217
splitting chord notes to solo notes 217
splitting double-played notes 217
staccato 523
staccato performance to accented notes 345
harmonic mark
staff 201, 204, 217
  add 198
  channel assignment 209
  clone 210
  delete 201
  drum staff into single instrument staves 215
  editing 198
  focus during playback 142
  hide empty staves 250
  instrument sound 204
  keyboard right and left hand staves 214
  left to right pan 573
  melody and accompaniment 217
  merge 211

Index

staff  201, 204, 217
  MIDI device assignment  204, 609
  name  202
  order in score  218
  pan  212
  part preparation  222
  remove  201
  select  188
  Setup  195, 198, 201, 204, 209, 211, 212, 505, 568, 573
  show and hide  223
  sound assignment to  542
  split  217
  sustain pedal control  581
  symbols for  399
  track controls  185
  versus part (terminology)  195
  vertical spacing  266
  volume level  212, 568

staff controls  185
  instrument sound selection  188
  mute button  147
  overview  185
  select staff  188
  show and hide track controls  185
  solo button  147

Staff menu
  Add Staff  198
  Clone Staff  210
  Delete Staff  201
  Merge Staves  211
  Show Concert Pitches  362
  Split Drums  215
  Split Hands  214
  Split Melody and Accompaniment  217
  Staff Setup  198
  Transpose Actual Pitches  360
  Transpose Instrument Key  362

staff order  137
staff select  185

Staff Setup  137, 188, 198, 204, 209, 573, 658
  staff, instrument  137
  staff, instrument sound  137
  staff, mute  186
  staff, notehead display  137
  staff, pan  137
  staff, solo  186
  staff, volume  137
  start of song toolbar button  172
  start playback  136
  static  590, 598

static audio  587

staves, merge  211

stem direction
  changing stem direction of notes  354
  force stem direction  373
  of new notes  309
  stem up and stem down for same notehead  309

step-time recording  318, 319
  compared to real-time recording  500
  step-time record button  175

stop playback  136

string  345
  bow marks  345
  pitch bend  576

stuck notes  144

studying music with Notation Composer  154

style names, hide for printing  673

styles  673
  styles, Band-in-a-Box® plug-in  673
  styles, changing  673
  styles, default folder  673
  styles, editing  673
  styles, show or hide (composer only)  246
  support  693
  sustain pedal control  581

swing rhythm
  editing notation for  342
  transcription  94

symbols  431
  synthesizer  20

  delay of playback on some MIDI software
  synthesizers  648
  software synthesizer  619

SysEx  623, 648

system
  brackets and braces  400
  move to previous page  264
  system break  261
  terminology  195
  vertical spacing  266

System Exclusive events  623, 648

- T -

tablature guitar notation  235

takes (recording)  510

takes in Band in a Box  681

takes, Band-in-a-Box® plug-in  673

tap in delay  622

tap in device delay  622

tap in latency  622
technical support 693
template 619
copying format attributes 254
creating new song template 120
creating your own 120
formatting a part using 252
page text 481
tempo 145
changing during playback 145
graphical editing 560
graphical viewing 559
marks 473
recording 501
saving the tempo change 145
toolbar button 174
tempo mark
tutorial 69
terminology used in Composer 195
text
adding 450
chord names 483
deleting 453
editing 452
font size and style for categories of text 243
font size and style of individual objects 454
footer 480
free text 472
header 480
international characters 457
lyrics 459
mixing music symbols and normal text 474
moving 455
overview 449
page text 476
rehearsal marks 496
show/hide lyrics and chord names 456
tempo markings 473
title of song 480
vertically aligning 476
text, assigning page text to a page/pages 478
ties
adding and removing 351
arc direction 351
reducing number of 94
slurs are not the same thing as 434
time signature 408
TimGM6mb.sf2 soundfont 702
TinyXML 702
title 476, 477
title of song 239, 480
toolbar
add and select mode buttons 175
metronome button 173
overview 171
show and hide 171
toolbar buttons
next and previous page 172
playback 172
start and end of song 172
tempo control 174
undo and redo 176
volume level 174
Window View and Page View 174
zoom in and zoom out 176
track
is called a staff in Composer 195
transcription 91, 94
chord names 490
correcting errors 274
how it works 91
of new recording 506
options 94
ornaments 94
re-transcribing 98
rhythm style 94
viewing with piano roll notation 91
transfer license 25
transpose
as-heard pitches 360
chord names 496
instrument key of a staff versus all of the pitches in a staff 213
instrument key transposition 362
understanding two types of transposing 358
tremelos 398
trial version of Notation Composer 15
trills 391
triplets 301
editing 338
swing rhythm 342
trouble-shooting
play-along 602
playback 598
recording 602
turns (ornament) 393
tutorial
graphical editing 548
quick start tutorial 34
tutorial video 14
two-hand split of single keyboard staff 214